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1 Tekla EPM 2021

Welcome to Tekla EPM 2021!

See the links below to find out about the new features and improvements in
this version:

• Tekla EPM 2021 release notes (page 19)

• Tekla EPM Go 2021 release notes (page 22)

• Tekla EPM 2021 fixlist

See also

Update Tekla EPM (page 26)

1.1 Tekla EPM 2021 release notes
Tekla EPM 2021 introduces several improvements, including user interface
updates and new production control integrations.

Production Control: DSTV+ export added for cut lists
You can now export cut lists from Tekla EPM as DSTV+ files. The DSTV+ export
is a simple nesting solution export that communicates to machinery which
parts should be cut out of a given bar. You can export DSTV+ files directly to
the relevant machine.

The new DSTV+ integration simplifies working with machinery. First, Tekla EPM
mults or nests the parts. After that, you can simply export the cutting pattern
as a DSTV+ file and send it to the relevant machine. The machine will then cut
the parts according to the cutting pattern in the DSTV+ file.

The DSTV+ integration is especially helpful for users who are working on a
shop floor that already uses software that is compatible with DSTV+ files.
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These users will no longer need to download individual CNC files and organize
them to match a cut list in Tekla EPM.

To enable the DSTV+ integration:

1. In the Maintenance menu, select Integrations --> DSTV+.

2. Select the Enable DSTV+ Export check box.

3. In the Local Directory Designation list, select the suitable option.

4. Click Save.

See also

Manage cut lists (page 709)

Manage job-specific cut lists (page 741)

Production Control: Copying the properties of the latest
inspection test record for another record
When you add inspection test records, you can now save time by saving the
properties of the current record for the next records. To do so, select the
Carry Over check box in the lower-left corner of the New Inspection Test
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Record dialog box. The properties remain in the original fields when you save
the current record.

Note that if you close the New Inspection Test Record dialog box, the
properties of the latest inspection test record will no longer be available for
future records.

Integrations: Trimble ViewPoint integration enabled
The Trimble Viewpoint integration is now automatically enabled in the default
(North America) and Australia environments. The Trimble Viewpoint
integration allows you to manage your purchase orders more efficiently.

To set up the Trimble Viewpoint integration, in the Maintenance menu, select
Integrations --> Trimble Viewpoint.
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For detailed instructions, see Manage purchase orders with Trimble Viewpoint
(page 92).

User interface improvements
The Tekla EPM interface has been improved in several ways:

• Several dialog boxes have been redesigned to improve your productivity
and user experience.

• Filtering options have been improved for several dialog boxes. For
example, the navigation trees added on the left side of dialog boxes allow
you to quickly select which types of items you want to see in the display
area.

• A new interface language, French, is now available for Tekla EPM.
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1.2 Tekla EPM Go 2021 release notes
Tekla EPM Go 2021 introduces both new features and some improvements.
The new production dashboard view allows you to quickly view the status of
your workshop operations. In addition, you can now update the information in
Tekla EPM Go simply by making changes in Trimble Connect for Browser, and
copy the properties of the latest inspection test record for new records.

New production dashboard page
Tekla EPM Go now has a high-level dashboard to quickly view the current
status of your shop floor production.

You can:

• switch between different types of charts

• select which data sets are shown in the charts

• select further details to see in the charts

• adjust the time frame and time units

• filter the chart data

Administrators can switch on the dashboards individually for each user in the
Administration dialog box:
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Using a Trimble Connect model to update Tekla EPM Go
When you have opened Trimble Connect for Browser from Tekla EPM Go, you
can now use the Trimble Connect model to update information in Tekla EPM
Go.

For example, you can change the production statuses of items in the Trimble
Connect model. The status changes are automatically updated to the Tekla
EPM database and shown in Tekla EPM Go.

Copying the properties of the latest inspection test record
When you add multiple inspection test records in one session, you can now
use the properties of the latest added record. Do one of the following:

• For job-specific inspection test records, tap Restore last.

Note that the Restore last option only works for tests with the same test
category in the same job. The Restore last option is not available if you
have left the job or added records to other test categories after adding the
record.
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• For general inspection test records, tap Copy from previous test.
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2 Update Tekla EPM

Administrators can either update Tekla EPM automatically for all users in their
company, or update Tekla EPM manually for each workstation in the company.

For more information, see the following links:

Update Tekla EPM automatically (page 26)

Update Tekla EPM manually (page 28)

2.1 Update Tekla EPM automatically
Each time Tekla EPM is started on any client workstation, Tekla EPM looks for
automatic updates in the Update default folder, set in the Default
Directories dialog box. Administrators need to download the available
updates to the Update folder and install the update. Once the update has
been installed on the server computer and any database structure changes
have been run, all users can update Tekla EPM automatically by simply clicking
OK.

NOTE To enable automatic updates:

• All workstations must have the same version of Tekla EPM as the
server computer to connect and share the same data. Otherwise,
errors will occur.

If these types of errors occur, contact the Tekla EPM support.

• All computers need to have the same path in the Update field in
the Default Directories dialog box. Otherwise, the automatic
update will not succeed.

Before you begin updating Tekla EPM, ensure that all users have closed Tekla
EPM, and that the Tekla EPM Remote Monitor has been stopped on the server
computer.

1. Verify where the Update default directory points to:
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a. Click the File ribbon tab in the upper-left corner of the Tekla EPM
window.

b. On the File menu, select Default Directories.

c. In the Default Directories dialog box, check the file path in the
Update field. 

This is the location where you need to save the update.

If the Update field is empty, click ..., browse to find the desired folder,
select the folder, and click OK.

d. Click OK to close the Default Directories dialog box.

2. Download the desired update from downloads.tekla.com to the correct
folder.

3. Close Tekla EPM.

4. Go to the location where you downloaded the update, and double-click
the update.

5. In the Tekla EPM License Agreement wizard, review the license
agreement.

6. Select Accept.

7. At the bottom-right corner, click Next >.

8. Select Update as the install type, and ensure that Update Existing
Program Files is selected.

9. At the bottom-right corner, click Next >.

10. In the Destination Folder field, check the location where the update will
be installed.

11. To install the update, click Install.

12. If Tekla EPM asks you to close Tekla EPM and stop the remote server, click
Yes to both.

13. When the update has been installed, click Close to close the installation
window.

14. Sign in to Tekla EPM. 

Note that sometimes when you log in to Tekla EPM after an update, you
may get the following messages:

a. A message saying that the current database needs to be updated.

Click OK.

b. A message confirming that the database should be updated.

Click Yes.
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c. A message asking you to allow creating a backup copy of the current
database.

Click OK, create a backup, and save it to the desired location.

15. Open a client workstation and log in to Tekla EPM. 

A message appears, advising you to update Tekla EPM.

16. Click OK. 

The program update starts immediately.

The Tekla EPM Remote Server automatically starts on the server computer
after Tekla EPM has been updated.

See also

Set the default folders for saving files (page 69)

Update Tekla EPM manually (page 28)

2.2 Update Tekla EPM manually
If the Update folder has not been defined in the Default Directories dialog
box, users need to update Tekla EPM on each client workstation manually.

Before you update any client workstation, note that:

• The server computer needs to be already updated and the Tekla EPM
Remote Server needs to be stopped. While the server computer is
updating, Tekla EPM has to be closed on all client workstations.

• Signing in to Tekla EPM on the server computer needs to be done, so that
any necessary database structure changes are run.

• To connect and share information, all workstations in your company need
to have the same version of Tekla EPM as the server computer.

1. Download the desired update from downloads.tekla.com.

2. Close Tekla EPM.

3. Go to the location where you downloaded the update, and double-click
the update.

4. In the Tekla EPM License Agreement wizard, review the license
agreement.

5. Select Accept.

6. At the bottom-right corner, click Next >.

7. Select Update as the install type, and ensure that Update Existing
Program Files is selected.

8. At the bottom-right corner, click Next >.
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9. In the Destination Folder field, check the location where the update will
be installed.

10. To install the update, click Install.

11. If Tekla EPM asks you to close Tekla EPM and stop the remote server, click
Yes to both.

12. When the update has been installed, click Close to close the installation
window.

13. Sign in to Tekla EPM. 

Note that sometimes when you log in to Tekla EPM after an update, you
may get the following messages:

a. A message saying that the current database needs to be updated.

Click OK.

b. A message confirming that the database should be updated.

Click Yes.

c. A message asking you to allow creating a backup copy of the current
database.

Click OK, create a backup, and save it to the desired location.

Tekla EPM will continue to update any information that needs to be updated.

You can now start working in the updated version of Tekla EPM.
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3 Configure Tekla EPM

As an administrator, you need to define your company information, automatic
backup settings, and administration settings, add the necessary users, and
otherwise set up Tekla EPM, so that other users can start working in Tekla
EPM.

After setting up Tekla EPM, administrators can:

• Download and install updates, so that the updates are installed
automatically for other Tekla EPM users in your company.

• Create backup copies of the Tekla EPM database to restore the database if
it is compromised.

• Optimize and compress the information in the Tekla EPM database.

• Clear extra logs from particular actions performed by Tekla EPM users in
the company.

• Export labor information from a Tekla EPM database, and import the labor
information to another Tekla EPM database.

• Recover deleted combining, estimating, and production controls jobs, and
recover import backup files.

• Find and repair program errors in Tekla EPM.

NOTE These instructions contain actions that can only be performed by Tekla EPM
users with administrative rights. If you do not have administrative rights,
contact your administrator for help.

For more information, see the following links:

Install Tekla EPM (page 31)

License Tekla EPM (page 35)

Manage users and workstations (page 40)

Adjust settings and company information (page 62)

Update Tekla EPM (page 26)

Set up and work with integrated software (page 71)
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Export labor information (page 432)

Manage the Tekla EPM database (page 98)

Repair program errors (page 106)

3.1 Install Tekla EPM
To install a new version of Tekla EPM or a Tekla EPM service pack, see the
following requirements and instructions. The instructions for installing Tekla
EPM vary depending on the computer onto which you are installing Tekla EPM:
different instructions apply to the server computer and the client
workstations.

The content installed with Tekla EPM
The following items are included in the full installation of Tekla EPM:

• Tekla EPM is the actual application.

• The MySQL database contains the information used by Tekla EPM. You can
have multiple sets of data within the database.

Note that the MySQL database is usually only installed on the server
computer.

• Crystal Report viewer opens the report template files and uses an ODBC
connection to populate information in reports.

• Tekla EPM Remote Server allows performing functions remotely. For
example, the Tekla EPM Remote Server allows running automated events
and using the Tekla EPM Go mobile application if you have purchased the
application.

Tekla EPM connects to the Tekla EPM database, and the connection can be
selected by machine and by port.

Normally, the Tekla EPM database is installed on the server computer, and the
connection information is the IP address or the computer name of the
computer running the server installation. However, the server machine is
connected to the local host.

The information that you need to install Tekla EPM
To install Tekla EPM, you need:

• The installer for the correct version or service pack of Tekla EPM

The installers and program updates are available in https://
download.tekla.com/tekla-powerfab/tekla-epm.
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• The server name or IP address

The server name or IP address is needed to set the connection to the
server when you first log in to a client workstation. We recommend that
you write down your server name and IP address for the future.

• Suitable locations for the default folders in Tekla EPM

The default folders are the folders where Tekla EPM saves information by
default.

We recommend that each Tekla EPM user on each workstation sets the
same folders on the Tekla EPM server as default folders, so that sharing
information is easy. For more information on the default folders, see Set
the default folders for saving files (page 69).

For example, you can use the following locations:

Backup C:\Users\Public\Documents
\Tekla\Tekla EPM\Backup

Export C:\Users\Public\Documents
\Tekla\Tekla EPM\Export

Import C:\Users\Public\Documents
\Tekla\Tekla EPM\Export

Log C:\Users\Public\Documents
\Tekla\Tekla EPM\Log

Document Index \\Server\SharedFolder
Drawing \\Server\SharedFolder
Update \\Server\SharedFolder
Custom Report \\Server\SharedFolder

Install Tekla EPM
1. Go to https://download.tekla.com/tekla-powerfab/tekla-epm.

2. Download the installer for the desired Tekla EPM version or service pack.

3. Double-click the installer to run the installation.

4. On the first page of the installation wizard, review the license agreement
and accept it.

5. On the second page, select the installation type:

• Select the Server option to install Tekla EPM on the server computer.

• Select the Client option to install Tekla EPM on a client workstation.
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• Select the Update option if you have a version of Fabsuite or Tekla
EPM installed on your computer and want to update the existing
program files.

If you select the Server option, the MySQL database is installed. If you
select the Client option, the MySQL is not installed. If you select the
Update option, only updates to existing program files are automatically
installed.

6. On the third page, select the folder where you want to install Tekla EPM. 

We recommend installing Tekla EPM to the default folder (C:\Program
Files (x86)\Tekla\Tekla EPM) shown in the installation wizard.

7. Click Install.

Tekla EPM is installed.

Connect to the MySQL database
The following instructions only apply to client workstations, not the server
computer.

1. Open Tekla EPM on the client workstation.

2. To connect to the database of your company, in the Connection Settings
dialog box, type the IP address or name of your server. 

You do not need to change the port number from the default value 3306.

3. Click OK.

4. Sign in to Tekla EPM. 

The default Tekla EPM sign-in information is:

• username: admin
• password: fab
When you have logged in, Tekla EPM may ask you to update the OBDC
connection for the report viewer.

5. Click Yes.

6. Set the default folders for saving Tekla EPM information. 

For detailed instructions, see Set the default folders for saving files
(page 69).

After setting the default folders on the first client machine, you can configure
the other client workstations by copying the settings file of the first client
workstation in the C:\Users\Public\Documents\Tekla\Tekla EPM
\Settings folder to the same location on the other client workstations.
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Set up the Tekla EPM Remote Server
The Tekla EPM Remote Server allows you to perform Tekla EPM actions
remotely. In practice, the Tekla EPM Remote Server enables running
automated events and using the Tekla EPM Go mobile application.

Install the Tekla EPM Remote Server
The Tekla EPM Remote Server is installed when you install Tekla EPM. You can
also install the Tekla EPM Remote Server separately, if necessary.

The Tekla EPM Remote Server is typically installed on the Tekla EPM server
computer. To use Tekla EPM Go, a TCP port needs to be forwarded to the
computer on which you install the Tekla EPM Remote Server.

To install the install the Tekla EPM Remote Server, do the following:

1. Go to C:\Users\Public\Documents\Tekla\Tekla EPM\Backup.

2. Double-click the TeklaEPMRemoteServerSetup.exe file to install the
Tekla EPM Remote Server.

3. Use the default options for the installation.

The Tekla EPM Remote Monitor window opens automatically after the
installation is finished. The Tekla EPM Remote Monitor window is the user
interface where you can manage the settings of the Tekla EPM Remote Server.

Next, define the remote server settings.

Start the Tekla EPM Remote Server
1. In the Tekla EPM Remote Monitor window, click Settings to see the IP

address and port for the database connection. 

You do not need to type a username or password.
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2. In the upper-right section of the window, click Sign in and sign in with a
Trimble Identity that has access to all the Trimble Connect projects of your
company. 

The Trimble Identity with which you sign in needs to have a Tekla EPM Go
license. If you do not sign in with a Trimble Identity, the Tekla EPM Remote
Server will fail to start because it does not have the necessary license
information.

Note that if the Trimble Identity cannot access all Trimble Connect
projects, the status information of Trimble Connect projects cannot be
synced.

3. If a TCP port other than the default port (9154) has been set up for
forwarding, in the Socket section, enter the port number in the Port field.

4. Save the settings.

5. In the Tekla EPM Remote Monitor window, click Start Service.

If the settings have been defined successfully, the Tekla EPM Remote Server
starts running.

You can always check if the Tekla EPM Remote Server is running in the Tekla
EPM Remote Monitor window.

3.2 License Tekla EPM
All users need a valid Tekla license and a reliable internet connection to use
Tekla EPM.

The Tekla licenses used for Tekla EPM are user-specific and are not tied to
particular workstations. The licenses of each Tekla EPM user are tied to the
user's Trimble Identity. For this reason, users always need to sign in to Tekla
EPM with their Trimble Identity. Since the licenses are managed online, you
need to have a reliable internet connection to use Tekla EPM.

To obtain a Tekla license, contact your organization's administrator.

The Tekla licenses and user accounts are assigned and managed in the Tekla
Online Admin Tool.

In companies that are moving from using Fabsuite to using Tekla EPM,
administrators need to migrate the company licensing from Fabsuite licensing
to Tekla licensing.

See also

Migrate to Tekla licensing (page 35)

Manage Trimble Identities and Tekla Online licenses (page 36)
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Migrate to Tekla licensing
When moving on to using Tekla EPM, administrators need to migrate their
company from Fabsuite licensing to Tekla licensing.

Note that once you have migrated to Tekla licensing, the users in your
company will not be able to log in to Tekla EPM without a Trimble Identity. For
more information, see Trimble Identity for Tekla Online Services.

1. Sign in to Tekla EPM.

2. In the License Migration dialog box, click Start Conversion to Tekla
Licensing. 

3. Click Convert to Tekla Licensing Now. 

When the license conversion is completed, Tekla EPM asks you to restart
Tekla EPM.

4. Click OK to close the message.

5. Go to https://account.tekla.com and add users to your organization.

6. Close and restart Tekla EPM to use Tekla licensing.

Manage Trimble Identities and Tekla Online licenses
As an administrator, you manage your organization's user accounts and
ensure that your users have access to Tekla Online.

The tool you use to manage these account settings for Tekla products is called
the Tekla Online Admin Tool.
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Organization administrator responsibilities
Tekla Online administrators manage the access of the organization's users to
Tekla Online services and licenses. One or more people in your organization
can be administrators. The first user is invited to your organization group by a
Trimble representative and given administrator rights and that person is then
responsible for adding other users and administrators as necessary.

As an administrator, you are responsible for:

• Inviting employees to your organization group to allow them access to the
following services:

• Tekla Online licenses, which are licenses connected to a Trimble Identity
login. Tekla services and features that use Tekla Online licenses include
Tekla Model Sharing, Tekla EPM, Trimble Connect, Tekla Structures
Partner configuration, and Tekla Structures elearning courses.

• Tekla discussion forum.

• Part of the content in Tekla User Assistance and Tekla Warehouse.

• Removing people from your organization group when they no longer
belong to your organization.

Add users to your organization group
User action is required, so if your users are not familiar with Trimble Identities
and the account creation process, we recommend that you inform them
before you send any invitations.

Users can only be employees in one organization group at a time. If a user is
already an employee in some other organization group, joining your
organization group removes the user from the other organization group. You
can add the user as an external license user to just give the user access to a
license. Adding a user as an external license user does not change the user's
employee or external license user status with any other organizations.

There are alternative methods for adding the users:

• You can invite users by adding their email addresses yourself. The users
need to click a link on a confirmation email.

• You can make a link available to your users, who can use it to request
employee membership in your organization. The users must make the
request and you must approve the requests.

• On the user account page, users can search for and request to join
organizations as employees. The organizations that users can see are
limited based on their email address. The users must be instructed to do
this and you must approve the request.
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1. Administrator: Log in to the Tekla Online Admin Tool and switch to the
Employees or External license users tab.

2. Administrator: Invite users to join or make a membership request link
available to them:

a. At the top of the table, click Invite employees or Invite users to
enter the e-mail addresses and send the invitations. 

• You can enter several addresses at the same time, for example:
user1@example.com,user2@example.com

• It is not necessary for the users to have a Trimble Identity; new
accounts are created based on your invitations if necessary.

• Trimble's system sends an e-mail to the invited users. Each user
must click on the e-mail link to accept the invitation within one
week (if the invitation expires, a new invitation must be sent). If a
new account is created for a user, the user must fill in the
mandatory profile information before proceeding.

b. To add users as employees, you can alternatively Copy a link to
request invitation. 

• The link can be used by multiple people and it does not expire.
You can for example email the link to multiple users or place it on
your intranet.

• By following this link, users can only request to join your
organization. You must approve the requests on the Requests
and Invitations tab in the Tekla Online Admin Tool.

After an invited user has confirmed the invitation or an administrator has
approved a user's request to join the organization:

• If you added the user as an employee, the organization's maintenance
status is extended to the user for access to additional content and
services.
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• The user account appears on the user list and can now be given
administrator privileges (employee users) or assigned a Tekla Online
license (all users).

Resend an expired invitation
If the invited user does not accept the invitation within a week, the invitation
link stops working. To be able to join the organization, the user must receive a
new link.

1. Log in to the Tekla Online Admin Tool and switch to the Requests and
invitations tab. Invitation statuses are:

• New: invitation is valid; the user has taken no action yet.

• Rejected: the user rejected the invitation.

• Expired: the user did not accept the invitation within one week.

• When the user accepts the invitation, it is removed from this list.

2. Find the expired invitation for the user and click Resend. A new invitation
e-mail is sent to the user with a new link that is valid for one week.

NOTE The previously expired link still does not work. The user must click
the new link.

Remove users from your organization
1. Log in to the Tekla Online Admin Tool and switch to the Employees tab.

2. Click the user account you want to remove. 

Additional information and options are shown on the user's row.

3. Click Remove from organization to remove the user from your
organization group. 

The user is taken off your list, can no longer use your Tekla Online licenses
and is no longer covered by your organization's maintenance.

Assign user rights or licenses
If your organization has a maintenance agreement, all users in your
organization group have access to content and services which require
maintenance. As an administrator, you can additionally assign other users
administrator rights or give users access to your organization's Tekla Online
licenses.

1. Add the users to the Employees or External license users group as
explained above.
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2. Activate administrator status (employees only) or license for the user in
the Tekla Online Admin Tool by selecting the checkbox on the user's row.
Administrator rights allow a user to manage other users in the Tekla
admin tool. 

NOTE You are responsible for following the terms governing the use of
each license, for example, geographic restrictions may apply and
you must take this into account when assigning licenses to users.

Check Tekla Online license usage and expiry date
Tekla Online licenses are purchased and managed separately from Tekla
Structures licenses.

1. Log in to the Tekla Online Admin Tool and switch to the License details
tab.

2. Check the license details. There are two views you can cycle through by
using the button above the license information table. 

• By default, you are in the License view. You can click each license to
see details, such as the subscription period for your subscription
licenses.

• Click the Usage view button to switch the view and see a summary of
license counts, number of assigned licenses, and the current usage.

• Licenses are used by the specific named users that you select on
the other tabs.

• License expiration warnings are also displayed to users in Tekla
Structures when the expiration date is nearing for licensed features
such as Tekla Model Sharing.

Related information

See also

Frequently asked questions: Trimble Identity for Tekla online services
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3.3 Manage users and workstations
In the Administration dialog box, administrators can add and delete Tekla
EPM users in their company, modify the users' permissions, and add, modify,
or delete workstations.

To access the Administration dialog box, do the following:

1. Click the File ribbon tab in the upper-left corner of the Tekla EPM window.

2. On the File menu, select Administration.

For more information, see the following links:

Add, modify, and delete Tekla EPM users (page 41)

Manage user permissions (page 44)

Manage remote user permissions (page 47)

Add, modify, and delete Tekla EPM users
On the Tekla EPM Users tab of the Administration dialog box, administrators
can add new users, modify the properties of the existing users, and delete any
unnecessary users. The users' passwords can also be reset.

To manage Tekla EPM users, do the following:

1. Click the File ribbon tab in the upper-left corner of the Tekla EPM window.

2. On the File menu, select Administration.
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Add a user
1. On the Tekla EPM Users tab of the Administration dialog box, click New.

2. Define the user properties. 

The properties marked with an asterisk (*) are mandatory information.

Option Description
Username * The username with which the user logs in to Tekla

EPM.

Type the username in the Username field.

Note that the user name cannot be changed after
the user has been added.

Role The user role assigned to the user. A role
determines which permissions the users with that
role have in Tekla EPM. For more information, see
Add, modify, and delete user roles.

You can also modify the permissions individually
for users. For more information, see Manage user
permissions (page 44).

Click the arrow on the right side of Role list and
select a role in the list.
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Option Description
Group The group which the user belongs to. For example,

you can define groups for estimators and project
managers.

Note that groups do not allow you to automatically
assign permissions to the user.

Type the user group in the Group field.
First Name, Last Name The first and last name of the user.

Type the appropriate names in the First Name
and Last Name fields.

Trimble Identity The email address that has been registered as the
user's Trimble Identity.

The Trimble Identity is a user account that allows
the user to access various Tekla Online services
and other Trimble products.

For more information, see Trimble Identity for
Tekla Online services.

Type the appropriate email address in the Trimble
Identity field.

3. Click Add.

The user is added to Tekla EPM.

When the users log in to Tekla EPM for the first time, they need to leave the
Password field blank. Then, they need to set the new password in the Change
Password dialog box.

Note that if you have not assigned roles to new users, they have no access to
any information in Tekla EPM. You need to modify users' permissions to give
them access to the necessary information and modules. For more information,
see Manage user permissions (page 44).

Reset a user's password
If necessary, you can reset a user's password, so that they can create a new
one the next time they log in to Tekla EPM.

Note that if the user remembers their current password, they can change the
password by themselves at any time.

1. On the Tekla EPM Users tab of the Administration dialog box, select the
user whose password needs to be reset.

2. Click Reset Password.
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3. To confirm resetting the password, click Yes in the confirmation dialog
box.

When the user logs in after the password has been reset, they need to leave
the Password field blank. Then, they need to set the new password in the
Change Password dialog box.

Modify a user
1. On the Tekla EPM Users tab of the Administration dialog box, select the

user that you want to modify.

2. Modify the user's role, group, first and last name, and Trimble Identity
according to your needs.

3. Click Save.

Delete a user
1. On the Tekla EPM Users tab of the Administration dialog box, select the

user that you want to delete.

2. Click Delete.

3. To permanently delete the user, click Yes in the confirmation dialog box.

Manage user permissions
When administrators create a new Tekla EPM user, the user does not have any
permissions in the Tekla EPM. This means that they cannot access, view, or
modify any information in any module in Tekla EPM. Administrators can
manage the user permissions in their company either separately for each
user, or by creating user roles and assigning them to users. To modify the
permissions of an individual user, do the following:

1. Click the File ribbon tab in the upper-left corner of the Tekla EPM window.

2. On the File menu, select Administration.

3. On the Tekla EPM Users tab of the Administration dialog box, select the
user whose permissions you want to modify.

4. Click Edit Permissions. 

Note that if the user has been assigned a role, their permissions cannot
be modified individually, so the Edit Permissions button is inactive.

5. At the top of the User Permissions dialog box, select the Allow Tekla
EPM Login check box. 
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When logging in to Tekla EPM has been allowed for the user, you can
modify the other permissions.

The User Permissions dialog box has multiple tabs that represent the
different modules and features of Tekla EPM. This way, the user
permissions can be set separately for each module.

The tabs are divided into sections that represent different parts of the
module or feature. This allows you to give the user permissions to only
perform particular actions related to the module.

All sections contain check boxes that determine what the user can do in
that part of the module. The available check boxes are:

• Select: When selected, allows the user to select and filter information,
such as material items.

• Insert: When selected, allows the user to add new information.

• Update: When selected, allows the user to modify existing
information.

• Delete: When selected, allows the user to delete information.

For example, to allow the user to select items and add items in a
combining job, select the Select and Insert check boxes in the
Combining Items section of the Combining tab. If only the Select and
Insert check boxes were selected, the user could not modify or delete
combining items, so the Edit and Delete buttons would not be available.
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6. To modify the user permissions, do any of the following: 

To Do this
Select the permissions
one by one

a. Click a tab at the top of the User Permissions
dialog box to open it.

b. Select check boxes next to the permissions
that you want to give to the user.

You can also click the A (all) and N (none)
buttons to select or clear all check boxes in a
section. This way, you can quickly give the user
all or no permissions to that part of the
module or feature.

c. Repeat steps a to b on all necessary tabs.
Select multiple
permissions at once

• Do one of the following:

• To allow the user to perform an action
anywhere in the selected module, click the
desired button at the bottom of the current
tab.

• To allow the user to perform an action
anywhere in Tekla EPM, click the desired
button at the bottom of the dialog box.

For example, when the Update All check box is
selected at the bottom of a tab, the user can
modify information in all parts of the module.

However, if the Update All check box is selected at
the bottom of the User Permissions dialog box,
the user can modify information in all modules of
Tekla EPM.

Copy the permissions of
another Tekla EPM user

a. At the lower-right corner of the dialog box,
click the arrow on the right side of the Copy
Permissions From list.

b. Select the desired user in the list.

c. Click OK.
Give all possible
permissions

• At the lower-left corner of the dialog box, select
the Administrator check box.

7. Click Save to save the permissions.

8. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

View the user permission report (page 47)
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View the user permission report
Administrators can view a report that shows the permission settings of the
Tekla EPM users in their company. Administrators can select between two
commands: View User Permissions Report - All and View User Permissions
Report - Selected. The View User Permissions Report - All displays the
permissions of all Tekla EPM users, whereas the View User Permissions
Report - Selected allows the administrators to select which users' permissions
they want to view.

To manage Tekla EPM user permissions, see Manage user permissions
(page 44).

View the permissions of all users

1. Click the File ribbon tab in the upper-left corner of the Tekla EPM window.

2. On the File menu, select Administration.

3. Click the Administration ribbon tab.

4. On the menu, select View User Permissions Report - All.

The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
EPM Report Viewer window to email the report via Microsoft Outlook.

You can also export the report and save it in another file format.

View the permissions of a selected user

1. Click the File ribbon tab in the upper-left corner of the Tekla EPM window.

2. On the File menu, select Administration.

3. In the Administration dialog box, select the user whose permissions you
want to view.

4. Click the Administration ribbon tab.

5. On the menu, select View User Permissions Report - Selected.

The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
EPM Report Viewer window to email the report via Microsoft Outlook.

You can also export the report and save it in another file format.

Manage remote user permissions
Administrators can allow remotely using Tekla EPM Go for any internal or
external Tekla EPM users to access particular information. The users that have
been assigned remote permissions can access Tekla EPM Go through a remote
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link when they are out of the office, and modify the information in Tekla EPM
Go according to the permissions they have been given.

1. On either the Tekla EPM Users tab or the External Users tab, select the
user whose remote permissions you want to modify.

2. Click Remote Permissions. 

3. At the top of the Remote Permissions dialog box, select the Allow
Remote Login check box. 

When you have allowed logging in to Tekla EPM Go, you can modify the
other remote permissions.

Note that the Remote Permissions has two tabs: Production Control/
Project Management and Inventory/Inspection/Time Tracking. You
need to modify the information on both tabs separately.

• On the Production Control/Project Management tab, you can select
which production jobs the user can access remotely, and what
information they can view or modify.

• On the Inventory/Inspection/Time Tracking tab, you can select what
the user can do in the inventory, which inspection test they can view or
modify, and what kind of time tracking records they can add. Users can
be allowed to only add records for themselves or for all employees,
and records that have a late start or end time.
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4. On the Production Control/Project Management tab, select which
production control jobs the user can access. The options are:

• None: the user cannot access the information of any production
control job remotely.

• Selected: allows you to select the control jobs that the user can access
remotely.

To select the jobs, click Edit in the Select Jobs section of the
Production Control/Project Management tab.

You can also create job groups in Production Control to allow the
users to only access jobs in particular job groups. For example, you
could create a job group called Active, and allow the users to access
all jobs in the Active job group. You could also create a job group
called Inactive and store all jobs that you do not want users to
access in Tekla EPM Go in the Inactive job group.

• All: the user can access the information of all production control jobs
remotely.

5. On the Inventory/Inspection/Time Tracking tab, select which inspection
tests the user can access remotely:

a. Click Select Inspection Tests.

b. Click the arrow buttons to move the items tests that the user needs
to access remotely to the Included list.

c. Click OK.
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6. To modify the user permissions further, do any of the following: 

To Do this
Select the permissions
one by one

a. Click a tab at the top of the Remote
Permissions dialog box to open it.

b. Select check boxes next to the permissions
that you want to give to the user.

Repeat steps a to b on both tabs of the
Remote Permissions dialog box.

c. To only allow access to particular drawing
types, stations, or inspection tests:

1. Click the Select Drawing Types, Select
Stations, or Select Inspection Tests
button.

2. Use the arrow buttons to move the
accessible items to the Included list.

3. Click OK.

Configure Tekla EPM 50 Manage users and workstations



To Do this
Copy the remote
permissions of another
user

a. In the upper-right corner of the dialog box,
click the arrow on the right side of the Copy
Permissions From list.

b. Select the desired user in the list.

c. Click Copy.
Select or remove
multiple permissions at
once

• Do one of the following:

• To allow the user to view, but not modify, all
information listed on the current tab, click
View All at the bottom of the dialog box.

• To remove all permissions that the user has
on the current tab, click Clear All.

Select or remove the permissions on both tabs of
the Remote Permissions dialog box.

Give all remote
permissions on the
current tab

• In the lower-left corner of the dialog box, click
All.

Note that to give all available remote permissions,
you need to click All on both tabs of the Remote
Permissions dialog box.

7. Click Save Remote Permissions.

The user can now view and modify the information according to the remote
permissions you gave them.

See also

Add, modify, and delete external users (page 51)

Add, modify, and delete external users
Any users who work remotely in your company should be added to Tekla EPM
as external users. Administrators can add, modify, and delete external users
on the External Users tab of the Administration dialog box. The passwords
of the external users can also be reset.

To manage external Tekla EPM users, do the following:

1. Click the File ribbon tab in the upper-left corner of the Tekla EPM window.

2. On the File menu, select Administration.

3. In the Administration dialog box, open the External Users tab.
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Add an external user
1. On the External Users tab of the Administration dialog box, click New.

2. Define the user properties. 

The properties marked with an asterisk (*) are mandatory information.

Option Description
Username * The username with which the external user logs in

to Tekla EPM.

Type the username in the Username field.

Note that the username cannot be changed after
the external user has been added.

Group The group to which the external user belongs. For
example, you can define groups for estimators and
project managers.

Note that groups do not allow you to automatically
assign permissions to the user.

Type the user group in the Group field.
First Name, Last Name The first and last name of the external user.

Type the appropriate names in the First Name
and Last Name fields.

3. Click Add.
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4. Do any of the following: 

To Do this
Generate and send an
email with the external
user's user name and
password

a. In the confirmation dialog box, click Yes.

Microsoft Outlook opens and generates a new
email containing the username and password.

b. Add the recipient.

c. If necessary, modify the default email content.

d. Send the email.
Continue without
generating and sending
an email

a. In the confirmation dialog box, click No.

A message appears, displaying the password
that the user needs to log in to Tekla EPM.

b. Highlight and copy the password to send it to
the external user.

c. Click OK to close the message.

d. Send the password to the external user in the
desired communication channel.

The external user is added to Tekla EPM.

Note that initially, the external user has no access to any information in Tekla
EPM. You need to modify the user permissions to give them access to the
necessary information and modules. For more information, see Manage
remote user permissions (page 47).

Reset the password of an external user
1. On the External Users of the Administration dialog box, select the

external user whose password you want to reset.

2. Click Reset Password.

3. To confirm resetting the password, click Yes in the first confirmation
dialog box.

4. Do any of the following: 

To Do this
Generate and send an
email that contains the
username and new
password of the external
user

a. In the second confirmation dialog box, click
Yes.

Microsoft Outlook opens and generates a new
email containing the username and new
password.

b. Add the recipient.

c. If necessary, modify the email content.
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To Do this
d. Send the email.

Continue without
generating and sending
an email

a. In the second confirmation dialog box, click
No.

A message appears, displaying the password
that the user needs to log in to Tekla EPM.

b. Highlight and copy the password to send it to
the external user.

c. Click OK to close the message.

d. Send the password to the external user in the
desired communication channel.

Modify the information of an external user
1. On the External Users tab of the Administration dialog box, select the

external user whose information you want to modify.

2. Modify the group, first name, and last name according to your needs.

3. To modify the user permissions, click Remote Permissions. 

For more information, see Manage remote user permissions (page 47).

4. Click Save to save the changes.

Delete an external user
1. On the External Users of the Administration dialog box, select the

external user that you want to delete.

2. Click Delete.

3. To permanently delete the external user, click Yes in the confirmation
dialog box.

Add, modify, and delete user roles
User roles allow the administrator to quickly assign the same permissions to
multiple users. On the Roles tab of the Administration dialog box, you can
add user roles, manage the permissions of the roles, and delete any
unnecessary roles. After you have added the necessary user roles and
modified the permissions according to your needs, you need to assign the
roles to the desired users on the Tekla EPM Users tab.

To manage user roles, do the following:

1. Click the File ribbon tab in the upper-left corner of the Tekla EPM window.

2. On the File menu, select Administration.
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3. Open the Roles tab.

Add a user role
1. On the Roles tab of the Administration dialog box, click New.

2. In the Role field, type a name for the user role. 

For example, Project managers.

3. Click Save to create the role.

4. To manage the permissions of the new user role, click Edit Role
Permissions. 
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The User Permissions dialog box opens.

The User Permissions dialog box has multiple tabs that represent the
different modules and features of Tekla EPM. This way, the user
permissions can be set separately for each module.

The tabs are divided into sections that represent different parts of the
module or feature. This allows you to give the user group permissions to
only perform particular actions related to the module.

All sections contain check boxes that determine what the user group can
do in that part of the module. The available check boxes are:

• Select: When selected, allows the user group to select and filter
information, such as material items.

• Insert: When selected, allows the user group to add new information.

• Update: When selected, allows the user group to modify existing
information.

• Delete: When selected, allows the user group to delete information.

For example, to allow the user group to select items and add items in a
combining job, select the Select and Insert check boxes in the
Combining Items section of the Combining tab. If only the Select and
Insert check boxes were selected, the user group could not modify or
delete combining items, so the Edit and Delete buttons would not be
available.
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5. According to your needs, do any of the following: 

To Do this
Select the permissions
one by one

a. Click a tab at the top of the User Permissions
dialog box to open it.

b. Select check boxes next to the permissions
that you want to give to the user role.

You can also click the A (all) and N (none)
buttons to select or clear all check boxes in a
section. This way, you can quickly give the user
role all or no permissions to that part of the
module or feature.

c. Repeat steps a to b on all necessary tabs.
Select multiple
permissions at once

• Do one of the following:

• To allow the user role to perform an action
anywhere in the selected module, click the
desired button at the bottom of the current
tab.

• To allow the user role to perform an action
anywhere in Tekla EPM, click the desired
button at the bottom of the dialog box.

For example, when the Update All check box is
selected at the bottom of a tab, the user role can
modify information in all parts of the module.

However, if the Update All check box is selected at
the bottom of the User Permissions dialog box,
the user role can modify information in all
modules of Tekla EPM.

Copy the permissions of
a Tekla EPM user

a. In the lower-right corner of the dialog box,
click the arrow on the right side of the Copy
Permissions From list.

b. Select the desired user in the list.

c. Click OK.
Give all possible
permissions

• In the lower-left corner of the dialog box, select
the Administrator check box.

6. Click Save to save the permissions.

7. To close the User Permissions dialog box, click the Close button (X) in the
upper-right corner.

8. In the Administration dialog box, click Save to update the permissions.
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Assign a user role to a user
1. Open the Tekla EPM Users tab of the Administration dialog box.

2. Select the user for whom you want to assign a user role.

3. Click the arrow on the right side of the Role list and select the user role in
the list.

4. Click Save.

Modify a user role
1. On the Roles tab of the Administration dialog box, select the role that

you want to modify in the left-hand pane.

2. In the Role field, modify the name of the user role.

3. To manage the permissions of the user role, click Edit Role Permissions. 

The User Permissions dialog box opens.

The User Permissions dialog box has multiple tabs that represent the
different modules and features of Tekla EPM. This way, the user
permissions can be set separately for each module.

The tabs are divided into sections that represent different parts of the
module or feature. This allows you to give the user group permissions to
only perform particular actions related to the module.

All sections contain check boxes that determine what the user group can
do in that part of the module. The available check boxes are:
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• Select: When selected, allows the user group to select and filter
information, such as material items.

• Insert: When selected, allows the user group to add new information.

• Update: When selected, allows the user group to modify existing
information.

• Delete: When selected, allows the user group to delete information.

For example, to allow the user group to select items and add items in a
combining job, select the Select and Insert check boxes in the
Combining Items section of the Combining tab. If only the Select and
Insert check boxes were selected, the user group could not modify or
delete combining items, so the Edit and Delete buttons would not be
available.

4. In the User Permissions dialog box, do any of the following: 

To Do this
Select the permissions
one by one

a. Click a tab at the top of the User Permissions
dialog box to open it.

b. Select check boxes next to the permissions
that you want to give to the user role.

You can also click the A (all) and N (none)
buttons to select or clear all check boxes in a
section. This way, you can quickly give the user
role all or no permissions to that part of the
module or feature.

c. Repeat steps a to b on all necessary tabs.
Select multiple
permissions at once

• Do one of the following:

• To allow the user role to perform an action
anywhere in the selected module, click the
desired button at the bottom of the current
tab.

• To allow the user role to perform an action
anywhere in Tekla EPM, click the desired
button at the bottom of the dialog box.

For example, when the Update All check box is
selected at the bottom of a tab, the user role can
modify information in all parts of the module.

However, if the Update All check box is selected at
the bottom of the User Permissions dialog box,
the user role can modify information in all
modules of Tekla EPM.
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To Do this
Copy the permissions of
a Tekla EPM user

a. In the lower-right corner of the dialog box,
click the arrow on the right side of the Copy
Permissions From list.

b. Select the desired user in the list.

c. Click OK.
Give all possible
permissions

• In the lower-left corner of the dialog box, select
the Administrator check box.

5. Click Save to save the permissions. 

The changed permissions are immediately applied to all users that have
been assigned the role.

6. To close the User Permissions dialog box, click the Close button (X) in the
upper-right corner.

7. In the Administration dialog box, click Save to update the permissions.

Delete a user role
Note that deleting a user role is permanent and cannot be undone.

1. On the Roles tab of the Administration dialog box, select the role that
you want to delete in the left-hand pane.

2. Click Delete.

3. To permanently delete the user role, click Yes in the confirmation dialog
box.

Add, modify, and delete workstations
On the Workstations tab of the Administration dialog box, you can add new
workstations, modify existing workstations, or delete unnecessary
workstations. Defining workstations allows creating replicas: when you set up
a slave computer, you need to connect one of the previously defined
workstations to the slave computer.

For more information on creating replicas, see Create replicas (page 70).

To manage workstations, do the following:

1. Click the File ribbon tab in the upper-left corner of the Tekla EPM window.

2. On the File menu, select Administration.

3. Open the Workstations tab.
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Add a workstation
1. On the Workstations tab of the Administration dialog box, click New.

2. In the Station field, type the workstation name or the computer ID.

3. Click Add.

Modify a workstation

1. On the Workstations tab of the Administration dialog box, select the
workstation that you want to modify.

2. In the Station field, modify the workstation name or the computer ID.

3. Click Save to save the changes.

Delete a workstation
1. On the Workstations tab of the Administration dialog box, select the

workstation that you want to delete.

2. Click Delete.

3. To permanently delete the workstation, click Yes in the confirmation
dialog box.
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View the users that are signed in
Administrators can use the Users Currently Logged In command to view the
Tekla EPM users that are currently signed in. This can be useful when trying to
run an update from one Tekla EPM version to another, which requires that
other users exit Tekla EPM. Administrators can also close other users' Tekla
EPM sessions and sign them out.

1. Click the File ribbon tab in the upper-left corner of the Tekla EPM window.

2. On the File menu, select Administration.

3. Click the Administration ribbon tab.

4. On the menu, select Users Currently Logged In.

5. In the Users Currently Logged In dialog box, view the users that are
currently signed in. 

For users within the office, you can see the IP address of the computer on
which the user is signed in and the time that the user has signed in.

6. If necessary, do either of the following:

• To close a user's Tekla EPM session and sign them out, select the user
and click Force Shutdown.

• To cancel closing the user's Tekla EPM session and signing them out,
click Cancel Shutdown.

7. To close the Users Currently Logged In dialog box, click the Close button
(X) in the upper-right corner.

Note that you can also use the Remote Users Currently Logged In command
to view the remote users that are currently signed in.

For remote users, you can see the time that they have signed in and the time
of their last activity in Tekla EPM Go. However, you cannot close remote users'
Tekla EPM Go sessions or sign the users out.

3.4 Adjust settings and company information
Administrators are responsible for adjusting the settings that define how Tekla
EPM can be used, defining the company information, and deciding on the
default folders for saving Tekla EPM files. Administrators can also create
replicas by connecting to off-site computers.

For more information, see the following links:

Define and modify company information (page 63)

Define the administration settings (page 66)

Set the default folders for saving files (page 69)

Create replicas (page 70)
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Define and modify company information
In the Company Information dialog box, you can define the name and
contact information of your company. The company information is used in all
Tekla EPM modules when you create reports. You can also add multiple
companies, if necessary.

1. Click the Maintenance ribbon tab.

2. On the menu, select Company Information.

The Company Information dialog box opens.

Add company information
1. In the Company Information dialog box, click New.

2. Add a description for the company. 

For example, Main.

3. Define the company name, address, city, state, zip code, phone, and fax
according to your needs. 

The company name is mandatory information. All other details are
optional.

4. To add a logo for the company, do the following:
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a. According to your needs, click one of the following buttons: 

• To place the company logo at the top of the reports, click Top
Logo.

• To place the company logo at the bottom of the reports, click
Bottom Logo.

b. Click Load From File.

c. In the Open dialog box, browse to find the logo file, and select it. 

Note that the logo file needs to be a .bmp, .jpg, or .png file. We
recommend using the .jpg format because logo files in any other
format are converted to .jpg when you add them.

The maximum height for the logo file is 3 inches, or 76,2 mm, at 96
pixels per inch. A maximum width is not enforced, but we
recommend that you use a logo file that is narrower than the
standard paper size of your company.

d. Double-click the logo file, or click Open.

e. Select if the logo should be aligned left, center, or right.

The logo is added for the company.

Note that if you want to use another logo file instead, you need to click
Top Logo or Bottom Logo again, and click Clear in order to delete the
current logo file.

5. Click Add.

The company is added to the list.

Note that you can add multiple companies, if necessary. For example, if you
want the Shipped From location to be something other than the address of
your main company, you need to add another company with that name and
address. These can be the name and address of a vendor or a supplier.

You can change which one of the available companies is used in the Report
Types dialog box.

Set the default company
If you have added multiple companies, you should set one of the companies
as the default company used in reports.

Note that you can only set the default company for the current user.

1. In the Company Information dialog box, select the company that you
want to set as the default company.

2. At the bottom of the dialog box, click Set Selected As Default.

3. To confirm using the selected company as the default option, click Yes in
the confirmation dialog box.
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The selected company is set as the default company used in reports.

Note that the default company is shown in the Default field at the bottom of
the Company Information dialog box.

You can change which one of the available companies is used in the Report
Types dialog box.

Modify company information
1. In the Company Information dialog box, select the company that you

want to modify.

2. Modify the company description, name, address, city, state, zip code,
phone, and fax according to your needs.

3. To modify the logo for the company, do the following:

a. According to your needs, click one of the following buttons: 

• To modify the company logo at the top of the reports, click Top
Logo.

• To modify the company logo at the bottom of the reports, click
Bottom Logo.

b. Click Clear to delete the existing logo file.

c. Click Load From File.

d. In the Open dialog box, browse to find the logo file, and select it. 

Note that the logo file needs to be a .bmp, .jpg, or .png file. We
recommend using the .jpg format because logo files in any other
format are converted to .jpg when you add them.

The maximum height for the logo file is 3 inches, or 76,2 mm, at 96
pixels per inch. A maximum width is not enforced, but we
recommend that you use a logo file that is narrower than the
standard paper size of your company.

e. Double-click the logo file, or click Open.

f. Select if the logo should be aligned left, center, or right.

The logo is added for the company.

4. Click Save to update the company information.

Delete company information
1. In the Company Information dialog box, select the company that you

want to delete.

2. Click Delete.

3. To permanently delete the selected company and its information, click
Yes in the confirmation dialog box.
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Define the administration settings
In the Administration - Settings dialog box, administrators can define in
which way Tekla EPM can be used. For example, administrators can only allow
each user to have one Tekla EPM session open at a time. In addition,
administrators can define a password policy that all Tekla EPM passwords
need to follow.

1. Click the File ribbon tab in the upper-left corner of the Tekla EPM window.

2. On the File menu, select Administration.

3. Click the Administration ribbon tab.

4. On the menu, select Settings. 

5. On the General tab of the Administration - Settings dialog box, define
the settings according to your needs: 

Option Description
Restrict each user to a
single Tekla EPM
session

When selected, Tekla EPM users can only have one
Tekla EPM session open at the same time.

When cleared, Tekla EPM users can have multiple
Tekla EPM sessions open at the same time.
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Option Description
Tekla EPM idle session
timeout

Allows you to define the number of minutes that a
Tekla EPM user can remain inactive before the
user's session times out and the user is logged out.

Type the number of minutes in the Tekla EPM idle
session timeout field.

If you do not want sessions to time out, type 0 in
the Tekla EPM idle session timeout field.

True-Shape Dimension
Add-On

The symbol that is displayed after dimensions if a
plate item has a CNC file attached to it and the
actual shape of the item in the CNC file is not a
rectangle.

For example, if a plate is triangular, Tekla EPM will
know the true shape, although it cannot be shown
in the item dimensions.

You can replace the § symbol with [SQM] to display
the area of non-rectangular plates in square feet or
square meters.

Allow list of changes to
be cleared

When selected, allows administrators and other
users with the correct user permissions to clear the
list of changes in a particular Tekla EPM module.

When cleared, the list of changes cannot be cleared
in any module, even by administrators or users
that have the correct permissions.

_fs_rl_user account
enabled

When selected, the built-in user login is enabled, so
that the Tekla EPM Remote Server can connect to
the Tekla EPM database without the administrator
adding the username and password in the monitor
settings.

When cleared, the built-in user login is disabled, so
the Tekla EPM Remote Server cannot connect to
the Tekla EPM database without the administrator
adding the username and password in the monitor
settings.

_fs_backup_user
account enabled

When selected, the built-in username and
password are enabled, so that Tekla EPM can
perform scheduled backups from the server
computer without a username and password.

When cleared, Tekla EPM cannot perform
scheduled backups from the server computer
without a username and a password.

Enable extension
directory

When selected, users can use their own extensions
with Tekla EPM. User-defined extensions need to
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Option Description
be saved in the Extension default folder that is
defined in the Default Directories dialog box.

When cleared, users cannot use their own
extensions with Tekla EPM. Also, the Extension
option is not available in the Default Directories
dialog box.

6. On the Database Backup/Restore tab, define how the Tekla EPM
database can be restored and how often users should get reminders to
create backup copies of the database. 

Option Description
Allow database restore from any
workstation

When selected, allows administrators
to restore the Tekla EPM database
using any computer.

When cleared, the Tekla EPM
database can only be restored on the
server computer.

For more information, see Restore
the Tekla EPM database (page 99).

Show background message if
backup has not been run in 'x' days
(0 for no message)

The number of days after the
previous database backup when Tekla
EPM should remind users with a
background message about backing
up the Tekla EPM database.

You can type a different number of
days for users with administrative
rights and for regular Tekla EPM
users. If you do not want to give a
reminder message, type 0.

See an example of a background
message below.

For instructions on how to back up
the Tekla EPM database, see Save a
backup copy of the Tekla EPM
database (page 98).
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Option Description
Show popup message if backup has
not been run in 'x' days (0 for no
message)

The number of days after the
previous database backup when Tekla
EPM should remind users with a pop-
up message about backing up the
Tekla EPM database.

You can type a different number of
days for users with administrative
rights and for regular Tekla EPM
users. If you do not want to give a
reminder message, type 0.

See an example of a pop-up message
below.

For instructions on how to back up
the Tekla EPM database, see Save a
backup copy of the Tekla EPM
database (page 98).

7. On the Password Policy tab, define the minimum length for Tekla EPM
passwords and select the check boxes for the characters that all Tekla
EPM passwords need to contain. 

If no password policy is defined, any passwords can be used. Note that
Tekla EPM passwords are always case-sensitive.

8. Click Save to save the settings.

Set the default folders for saving files
Use the Default Directories dialog box to select the folders where Tekla EPM
saves information by default.

TIP To ensure that the default folders are consistent on all computers, you
can copy the settings.ini file from that first Tekla EPM installation to
C:\Users\Public\Documents\Tekla\Tekla EPM\Settings for all
later installations.

1. Click the File ribbon tab in the upper-left corner of the Tekla EPM window.

2. On the File menu, select Default Directories. 

The Default Directories dialog box opens. Here, you need to set the
default folders for the following content:
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• Backup: Tekla EPM database backup files

• Export: all exported files

• Import: all imported files, except for drawing files

• Log: import log and error log text files

• Document Index: all files saved in the Document Index

• Drawing: imported drawing files

• Update: Tekla EPM update files

• Custom Report: all customized report files

• Extension: extensions used together with Tekla EPM

You can use shared drives, IP addresses, or UNC file paths as default
folders.

3. To change the default folders, do the following:

a. Click ... on the right side of a field.

b. In the Browse For Folder dialog box, browse to find the folder that
you want to set as the default folder. 

If necessary, you can add a new folder under the currently selected
one by clicking Make New Folder.

c. Select the folder.

d. Click OK.

Repeat steps a to d to set all necessary default folders.

4. To update the default folders, click OK.

Create replicas
In the Replication dialog box, administrators can connect to workstations in
an off-site location to share Tekla EPM files and activity. Note that the off-site
workstation needs to have Tekla EPM installed in order to connect. The Tekla
EPM on the off-site workstation then becomes a slave to the server it is
connected to. You can also delete any existing slave workstations, if necessary.

1. Click the File ribbon tab in the upper-left corner of the Tekla EPM window.

2. On the File menu, select Administration.

3. Click the Administration ribbon tab.

4. On the menu, select Replication Administration.

5. In the Replication dialog box, click New Slave.

6. At the bottom right corner of the dialog box, click the arrow buttons to
move the workstations that you want to connect to the selected slave
workstation to the Stations Connecting list.
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7. To save the changes, click Save Stations.

3.5 Set up and work with integrated software
You can use Tekla EPM together with several integrated software products.
Software integrations save you time and work, because you do not need to
enter the same information to several software. Among other things, you can
use software integrations to mult and nest materials, and visualize IFC models.

For more information, see the following links:

Link Tekla EPM to Trimble Connect (page 71)

Use Tekla EPM together with Tekla Warehouse (page 76)

Use customized extensions for combining (page 77)

Manage inventory, cut lists, and nests with ProNest (page 79)

Mult and nest materials with Steel Projects PLM (page 90)

Link Tekla EPM to Trimble Connect
To use Trimble Connect for viewing IFC models for estimating and production
control jobs, you need to link Tekla EPM and Trimble Connect to each other. To
enable updating the statuses of Tekla EPM items to Trimble Connect, you also
need to set up status sharing.

Linked jobs in the Estimating, Production Control, and Project
Management modules can all be linked to a Trimble Connect project.

Note that if an estimating or production control job is linked to a project
management job, the Trimble Connect project is managed through the project
management job. In this case, you need to link the project management job to
Trimble Connect. The link is then applied to any linked estimating and
production control jobs. The Trimble Connect project cannot be modified
when you access it through the estimating or production control job.

See also

Add Trimble Connect projects (page 74)

Add users to Trimble Connect projects (page 75)

Link Tekla EPM to Trimble Connect
1. Click the Maintenance ribbon tab.

2. On the menu, select Integration Settings --> Trimble Connect . 
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3. If you have not yet migrated to Tekla licensing, in Trimble Connect
Settings dialog box, select the Use Trimble Connect Desktop To View
Models check box.

4. To invite users to participate in your Trimble Connect projects, type their
emails on separate lines in the Default Users for Trimble Connect
Project section. 

The users whose email addresses you type here can later be added to
existing Trimble Connect projects.

5. If necessary, click the arrow on the right side of the Default Server
Location list, and change the server location.

6. Click Save.

Note that you need to restart Tekla EPM to be able to use Trimble Connect for
viewing IFC models.

Set up status sharing with Trimble Connect
You can enable sharing the statuses of production control jobs to Trimble
Connect.

The available status types are:

• Purchasing: None, Started (on a purchase order but not yet received),
Completed

Configure Tekla EPM 72 Set up and work with integrated software



• Production: None (production not started), Started, Completed

• Station: can include all or any individual stations set up in Tekla EPM.

• Shipping: None, Started (at an intermediate shipping destination), or
Completed

• Destination: can include all or any individual destinations set up in Tekla
EPM.

• In Tekla EPM Production: items highlighted with green are in the
production control job.

• In Tekla EPM Estimating: items highlighted with green are in the
estimating job.

1. Click the Maintenance ribbon tab.

2. On the menu, select Integration Settings --> Trimble Connect Status
Share . 

3. In the Trimble Connect Status Share Mappings dialog box, create the
status types that can be shared to Trimble Connect:

a. Click New.

b. Click the arrow on the right side of Tekla EPM Status list, and select a
status.

c. Depending on the selected status, click the arrow on the right side of
the Station or Destination list, and select an option in the list.

d. In the Trimble Connect Status Action Name field, type the name
used for the status in Trimble Connect.
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e. Click Add.

Repeat steps a to e for each status that you want to add.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Add Trimble Connect projects
Use the Add New Trimble Connect Projects command to create Trimble
Connect projects based on the existing project management jobs.

1. Click the Maintenance ribbon tab.

2. On the menu, select Integration Settings --> Trimble Connect . 

3. In the Trimble Connect Settings dialog box, click Add New Trimble
Connect Projects.

4. In the Select Project dialog box, click the arrow buttons to move the
production control jobs that you want to add as projects to the Included
list.

5. Click OK.
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6. In the Add Users to Project dialog box, click the arrow buttons to move
the users that need access to the new project to the Included list. 

All users that are set as default Trimble Connect users are automatically in
the Included list.

7. Click OK.

8. In the Status dialog box, view the project creation process.

9. When the setup is completed, click OK to close the Status dialog box.

10. To attach an IFC model to the project, do the following:

a. Open Trimble Connect for Windows.

b. Double-click the new project to open it.

c. In the Explorer side pane on the left, click the Add File button.

d. In the Add Files dialog box, browse to find the IFC model.

e. Select the IFC model and click Open.

See also

Add users to Trimble Connect projects (page 75)

Add users to Trimble Connect projects
Use the Add Users to Existing Trimble Connect Projects command to invite
users to participate in specific Trimble Connect projects.

1. Click the Maintenance ribbon tab.

2. On the menu, select Integration Settings --> Trimble Connect . 
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3. In the Trimble Connect Settings dialog box, click Add Users to Existing
Trimble Connect Projects.

4. In the Add Users to Project dialog box, click the arrow buttons to move
the users that need access to the project to the Included list. 

The users in the Included list receive email invitations to the projects you
select.

5. Click OK.

6. In the Select Project dialog box, click the arrow buttons to move the
projects to which you want to add the selected users to the Included list.

7. Click OK.

8. In the Status dialog box, view the user invitation process.

9. When the setup is completed, click OK to close the Status dialog box.

The selected users have now been sent email invitations to the selected
Trimble Connect projects.

See also

Add Trimble Connect projects (page 74)
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Use Tekla EPM together with Tekla Warehouse
Tekla Warehouse is a service for collaboration, and for storing and sharing
content used for Tekla Structures and Tekla EPM.

Tekla Warehouse provides centralized access to a wide range of content that
you can use in Tekla Structures and Tekla EPM.

For example, you can download the Workflow Tools for Tekla Structures
application from Tekla Warehouse to allows showing the statuses of items
pushed from Tekla EPM to Trimble Connect in the related Tekla Structures
model. Similarly, downloading Workflow Tools for Trimble Connect Desktop
allow showing the statuses of items pushed from Tekla EPM to Trimble
Connect in Trimble Connect for Windows.

Note that you need to have a Trimble Identity to download content from Tekla
Warehouse.

To access Tekla Warehouse, go to https://warehouse.tekla.com/.

For more information on Tekla Warehouse, see Getting started with Tekla
Warehouse.

See also

Manage Trimble Identities and Tekla Online licenses (page 36)

Use Trimble Connect with an estimating job (page 435)

Use Trimble Connect with a production control job (page 810)

Sign in to Tekla EPM (page 109)

Use customized extensions for combining
You can create your own extensions that send multing and nesting requests
from Tekla EPM to other software. This way, using external multing or nesting
software becomes smoother.

NOTE Before you can use extensions with Tekla EPM, users with
administrator rights need to enable using extensions in the
Administration - Settings dialog box. For more information, see
Define the administration settings (page 66).

Add and save an extension
1. Create the extension with a suitable tool. 

For example, you can use Microsoft Visual Studio.

Remember to create the necessary error messages if something goes
wrong when you use or test the extension.
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2. To check where the extension needs to be saved, click the File ribbon tab
in the upper-left corner of the Tekla EPM window.

3. On the File menu, select Default Directories. 

4. Save your extension to the default folder for extensions.

Export materials for combining
To test and use your extensions:

1. Open a job and click the contextual ribbon tab. 

For example, in an open production control job, click the Production
Control tab.

2. On the menu, select Combine.

3. Select a combining command: Mult, Nest, or Mult & Nest.

4. Set the combining filters according to your needs.

5. Click Optimizations.

6. In the Combining Setup dialog box, set Multing Software or Plate
Nesting Software to Other.

7. Combine the necessary items.

8. Click the Combining Run ribbon tab.

9. In the menu, go to Export Parts for Nesting and select your extension.
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10. In the Export Parts for Combining dialog box, adjust the settings
according to your needs: 

• To include existing inventory materials in the export, select the
Include available inventory check box.

• To include inventory materials that are on order in the export, select
the Include orderable inventory.

• In the CNC files list, select how you want to include CNC files in the
export.

11. Click Send.

Manage inventory, cut lists, and nests with ProNest
You can use Tekla EPM and ProNest together to keep your inventory, cut lists,
and nests synchronized, so that you do not have to enter the same
information in both software.

Integration requirements
See the requirements for the ProNest integration below.

Software Required vdersion
Tekla EPM 2019 or newer
ProNest 2019 or newer
ProNest DataSync 2019 or newer

Note that the integration also requires:

• having particular ProNest licenses. For more information, contact your
ProNest representative.

• downloading the following files:

File name Description Download file to
FabSuite Inventory
Sync.xml

The inventory sync task
for ProNest DataSync.

On the ProNest
database server

Tekla EPM Work
Order.xml

Needed if you plan to
export items from Tekla
EPM in the work order
format.

C:\ProgramData
\Hypertherm CAM
\Data Sync
[version]\Tasks\

ProNest to Tekla
EPM Summary.fr3

The custom report to
import nested items
from ProNest back to
Tekla EPM.

C:\ProgramData
\Hypertherm CAM
\ProNest
2019\Reports
(FastReport)\Custom
Reports\
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• having DataSyncCMD installed on the Tekla EPM server.

• having DataSyncCMD and DataSync server running on the ProNest server.

To test the connection between Tekla EPM and ProNest DataSync:

1. On the start screen of the Tekla EPM server, type cmd into the search.

2. In the command prompt, copy and paste the following:

" "[Data Sync Path]" test1"
If you get the error message "The specified task name is unknown", DataSync
is running properly.

If you get the error message "Cannot find Data Sync Service", contact your
ProNest representative.

Set up Tekla EPM to work with ProNest
1. Click the Maintenance ribbon tab.

2. On the menu, select Integration Settings --> ProNest.

3. To allow sending inventory to ProNest and using ProNest for nesting
plates, select the Enable ProNest for Plate Nesting check box at the top
of the ProNest Settings dialog box.

4. In the Nesting Request Format list, select how you want to send nesting
requests: 

• Work Order: allows you to send the part list in a single click, and after
that, automatically imports to the part list in ProNest

• PNL/SNL: allows sending both the part list and the available inventory
to ProNest in two files with the same name. One of these files is a PNL
file, and the other is an SNL file. Opening the PNL file in ProNest
imports the parts, selects the imported parts for nesting, and sets the
available inventory for the nest to the plates within the related SNL file.

5. On the Database Connection tab in the dialog box, define how Tekla
EPM connects to the ProNest database to sync the inventory: 

Option Description
IP address The IP address of the ProNest database.

The default value is [Computer name]\PRONEST.
Note that the computer name needs to be the
name of the computer on which ProNest has been
installed. This might not be the computer on which
you are using Tekla EPM.

If you want to check if Tekla EPM can connect to
the ProNest database properly, click Test
Connection. If the connection is not successful,
open ProNest and ensure that the database is
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Option Description
networked, and that you have typed the right
computer name in the IP address field.

ProNest Version The ProNest version that you are using.

Note that the oldest available ProNest version is
version 2012, or version 10.

Use Windows
Authentication

If you want to use Windows Authentication to
connect to the ProNest database, select the Use
Windows Authentication check box.

If you do not want to use Windows Authentication,
clear the Use Windows Authentication check
box.

Username, Password Your username and password in ProNest.

6. On the Inventory Sync tab, define the inventory synchronization settings:

Option Description
Inventory Sync Folder The path to the folder in which inventory sync files

are stored.

Note that both Tekla EPM and ProNest need to be
able to read from and write to the inventory sync
folder. This means that if Tekla EPM and ProNest
are installed on different computers, the inventory
sync folder needs to be a shared folder.

Data Sync Command
Path

The path to the location on the Tekla EPM
workstation or the server where you have installed 
DataSyncCmd.exe.

Inventory Sync
Timeout

The time in minutes that Tekla EPM will wait for 
DataSyncCmd.exe to respond.

3 to 5 minutes is usually a sufficient time.
Material Display
Format

The material display format defined in ProNest
regional settings. Note that the format needs to
match the format used in ProNest.

Show File Location
Errors for Cut Lists

If you want to get notifications when ProNest cut
lists are located in unsuitable folders, select the
Show File Location Errors for Cut Lists check
box.

If you do not want to see these errors, clear the
Show File Location Errors for Cut Lists check
box.

Import Cut List before
Inventory Sync

To receive updates on which items have been cut
before synchronizing the inventory, select the
Import Cut List before Inventory Sync check
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Option Description
box. We recommend that you select the Import
Cut List before Inventory Sync check box.

If you do not want to receive updates on cut items
before synchronizing the inventory, clear the
Import Cut List before Inventory Sync check
box.

Sync Material On
Order

To send material that has not yet been received to
ProNest, select the Sync Material On Order check
box.

To avoid sending material that has not yet been
received to ProNest, clear the Sync Material On
Order check box.

Sync Combined
Material

To synchronize inventory stock material that has
been used in combining, select the Sync
Combined Material check box.

To prevent synchronizing inventory stock material
that has been used in combining, clear the Sync
Combined Material check box.

Enable Automatic
Inventory Sync

If you want to allow Tekla EPM to automatically
synchronize the inventory with ProNest, select the
Enable Automatic Inventory Sync check box.

If you do not want to allow Tekla EPM to
automatically synchronize inventory with ProNest,
clear the Enable Automatic Inventory Sync check
box.

NOTE If you have created an automated event
(page 189) for synchronizing the inventory
between Tekla EPM and ProNest, you
should clear the Enable Automatic
Inventory Sync check box. We
recommend creating an automated event
instead of selecting the Enable Automatic
Inventory Sync check box.

Automatic Inventory
Sync Interval

The time in minutes after which Tekla EPM
automatically synchronizes the inventory with
ProNest.

The synchronization should happen frequently
enough to keep your inventory up to date. We
recommend using an interval between 10 and 60
minutes.
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7. On the Transfer Settings tab, select to which ProNest fields you want to
map the following Tekla EPM fields: 

Option Description
Tekla EPM Remnant ID
Field

The unique, unchanging ID that EPM assigns to
each remnant.

If you want to see the remnant ID in ProNest as
well, select the ProNest field in which you want to
show the remnant ID.

Heat Serial Number
Field

The heat serial number of each inventory item.

Note that the heat number of each inventory item
is automatically mapped to ProNest.

If you use a heat serial number in Tekla EPM and
want to see the heat serial number in ProNest as
well, select the ProNest field in which you want to
show the heat serial number.

PO Number Field The purchase order on which the inventory item
has been added.

If you want to see the purchase order information
in ProNest as well, select the ProNest field in which
you want to show the purchase order number.

Bill of Lading Field The bill of lading number, or the shipment number
that the inventory item was received on.

If you want to see the bill of lading number in
ProNest as well, select the ProNest field in which
you want to show the bill of lading number.

Secondary Location
Field

The secondary location of each inventory item.

Note that the primary location of each inventory
item is automatically mapped to ProNest.

If you want to see the secondary location in
ProNest as well, select the ProNest field in which
you want to show the secondary location.

ProNest Name Field This setting corresponds to the information in the
Name field in ProNest plate inventory.

We recommend that you select the Shape Grade
Thickness option. However, if you have used Tekla
EPM and ProNest together without the integration
before, you can also select the PartNumber
option.

Dimension Units Select if you want to show dimension lengths in
imperial or metric units.

Blank Class To ensure compatibility with ProNest, select an
option for items without a class:
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Option Description
• Three Spaces: use this option with newer

versions of ProNest

• Empty: use this option only with older versions
of ProNest

Use Full Path for CNC
Filename

To ensure that the ProNest integration works,
select this check box if you use version 2021 of
ProNest or newer.

8. Click Save.

Synchronize inventory information with ProNest
Use the Sync with ProNest command to synchronize Tekla EPM inventory
information with ProNest and update the cut lists in ProNest. We recommend
that you synchronize the two software regularly.

Before you begin, ensure that:

• DataSyncCmd.exe is running

• Tekla EPM can access the ProNest database

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Export --> Sync with ProNest . 

The inventory information in Tekla EPM is exported to ProNest to
synchronize the two software. You can view the process in the Status
dialog box.

3. When the synchronization process is completed, click OK to close the
Status dialog box.

In the synchronization process, Tekla EPM checks the ProNest database for
new items and links each new item in the ProNest inventory to the appropriate
piece in the Tekla EPM inventory. When synchronization is complete, ProNest
has all the inventory items that Tekla EPM has.

Note that inventory items that have previously been in ProNest but have not
been linked to Tekla EPM are not affected by the synchronization.

Import ProNest inventory to Tekla EPM
1. In ProNest, print the plates that you want to export into an HTML file.

2. In Tekla EPM, open the Inventory module.

3. Click the Inventory ribbon tab.

4. On the menu, select Import --> Inventory from HTML.

5. Browse to and select the inventory HTML file from ProNest.

6. Click Open. 
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The selected ProNest plates are imported into the Tekla EPM inventory.
The import creates a link between Tekla EPM and ProNest, so that the
imported plates can be used in nests.

Existing plates in the Tekla EPM inventory are updated, but their quantity
is not decreased.

7. See the progress of the import in the Import dialog box. 

To see more details on the import, click Open Import Log.

8. When the import is complete, click the Close button (X) in the upper-right
corner to close the Import dialog box.

Import ProNest cut lists to Tekla EPM
Before sending cut lists to Tekla EPM, send the nest to CNC in ProNest.

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Import --> ProNest Cut List . 

Tekla EPM imports the cut lists that are available in ProNest.

3. See the progress of the import in the Import dialog box. 

To see more details on the import, click Open Import Log.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Update the inventory using a cut list
After you have imported a ProNest cut list to Tekla EPM, you can update the
inventory as follows:

1. Open a production control job.

2. Click the Production Control ribbon tab.

3. on the menu, select Review --> Cut Lists.

4. At the bottom of the Cut Lists dialog box, click New.

5. Click Make Report.

6. In the Report Selection dialog box, click Save Cut List.

7. Type a description and select a due date for the cut list.

8. Ensure that Share Cut List is selected.

9. Click Save To Cut List. 

The new cut list appears in the Cut Lists dialog box.

10. In the Cut Lists dialog box, double-click the new cut list.

11. To view the nest details of an item, double-click the item in the cut list.
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12. To see images of the nest, click Nest Image.

13. When an item in the cut list has been cut by a machine, in the Cut Lists
dialog box, select the item and click Cut.

14. Define the properties of the used inventory item.

15. Define the drop properties.

16. To remove the item from the Tekla EPM inventory and add the resulting
remnant to the inventory, click TFS. 

The status of the item in the cut list is now set to Complete and
highlighted in green.

The remnant item is linked to ProNest and can be used in ProNest for
further nesting.

You can see an image of the remnant, if you double-click the remnant
item in the Inventory dialog box.

Troubleshooting TFS

Sometimes, when you take an item from stock with the TFS command, you get
an error saying "External Nesting Result is not available". This occurs when the
cut list that was imported from ProNest to Tekla EPM could not be completed
during the import.

This can happen if:

• the ProNest job was sent to CNC with the initial nesting, but the material
items in Tekla EPM needed to be ordered. This means that the inventory
did not exist in Tekla EPM when ProNest marked this item as cut.

• The ProNest job was sent to CNC multiple times.

• The cut list was imported to Tekla EPM before the material that was being
cut had been received in the Tekla EPM inventory.

• Something in the nest changed in Tekla EPM, invalidating the nest. For
example, this can happen if the reserved inventory was used for something
else.

To fix the error, try the following:

1. Ensure that all inventory needed for the nest is in stock and received in
the Tekla EPM inventory.

2. In ProNest, re-send the job to CNC.

3. Import the cut list to Tekla EPM again.

If you continue to face the same error after this, contact support.

Export plates to be nested in ProNest
1. Open a combining, estimating, or production control job, a requisition, or

a purchase order.
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2. Click the contextual ribbon tab. 

For example, if you are working on a combining job, click the Combining
ribbon tab.

3. On the menu, select Combine.

4. In the Select Combining Run dialog box, click Nest.

5. It the lower-left corner of the Combining Run Filters dialog box, click
Optimizations.

6. On the Plate Nesting Settings tab, set Plate Nesting Software to
ProNest.

7. Click Save.

8. To combine the materials, click the button at the bottom of the
Combining Run Filters dialog box, or press F4. 

In the Combining Run Results dialog box, all parts show as not
combined.

9. Click Save Combining Run.

10. Click the Combining Run ribbon tab.

11. On the menu, select Export Parts for Nesting --> Export to ProNest.

12. Depending on the nesting request format that you have selected in the
ProNest Settings dialog box, do one of the following: 

If you have selected Do this
the Work Order format a. Click the arrow on the right side

of Work order due date, and
select a date in the calendar.

b. To allow ProNest to mirror plates
in the nesting process, select the
Mirror Plates check box.

c. To allow ProNest to rotate plates
in the nesting process, select the
Allow plate to be rotated check
box.

d. To include the job number in the
piece marks of items, select the
Include Job Number in
Piecemark check box.

For example, the piece mark
p1.dxf in job called Job123
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If you have selected Do this
would change into Job123-
p1.dxf.

This can help you to recognize
items with the same piece
numbers in different jobs.

e. Click Export Parts.

The work order is automatically
created and imported to ProNest.
The name and location of the
work order file are not important.

f. After the export is complete,
open ProNest and click Add
Parts, or select Job in the menu.

g. On the Home tab, select Edit
Part List --> Edit Part List.

h. On the Work Orders tab of the
Edit Part List dialog box, select
some or all of the newly
imported items, and drag them
to the part list.

i. Click the Close button (X) to
return to nesting.

the PNL/SNL format a. Click the arrow on the right side
of Work order due date, and
select a date in the calendar.

b. To allow ProNest to nest onto
current stock materials, select the
Include Sheets check box, and
define the priority for nesting
onto current stock material.

Priority 1 is the primary option
for nesting.

c. To allow ProNest to nest onto
remnants, select the Include
Remnants check box, and define
the priority for nesting onto
remnants.

Priority 1 is the primary option
for nesting.

d. To allow ProNest to nest onto
orderable inventory, select
Include Orderable Sizes check
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If you have selected Do this
box, and define the priority for
nesting onto orderable inventory.

Priority 1 is the primary option
for nesting.

e. To open the PNL file in ProNest
when the file has been created,
select the Automatically Open
PNL check box.

f. To include the job number in the
piece marks of items, select the
Include Job Number in
Piecemark check box.

For example, the piece mark
p1.dxf in job called Job123
would change into Job123-
p1.dxf.

This can help you to recognize
items with the same piece
numbers in different jobs.

g. To use the ProNest setup for
mirroring, select the Auto-Tab
check box.

h. Click Export Parts.

The export creates two files: a
PNL file, which contains the parts
to nest, and an SNL file, which
contains the inventory plates
currently available for combining.

i. If the PNL file is not automatically
opened in ProNest, on the Home
tab, select Edit Part List -->
Import Part List and select the
PNL file.

The matching SNL file is imported
automatically.

Import nesting results to Tekla EPM
1. In the Combining Run Results dialog box, click the Combining Run tab.

2. On the menu, select Import Nested Parts.

3. In the Open dialog box, browse for and select the nesting results file.
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4. Click Open.

Mult and nest materials with Steel Projects PLM
You can use Steel Projects PLM to mult and nest materials outside Tekla EPM.
You can also export cut lists from Tekla EPM to Steel Projects PLM.

Set up Tekla EPM to work with Steel Projects PLM
1. Click the Maintenance ribbon tab.

2. On the menu, select Integration Settings --> Steel Projects.

3. In the Steel Projects Settings, select the Enable Steel Projects
Integration check box.

4. If you want to allow Steel Projects PLM to reserve material to a job that
does not exist in Tekla EPM, select the Allow Nests without a Tekla EPM
Job check box.

5. Click Save.

6. If you use Tekla EPM Go, we recommend that you create an external user. 

For detailed instructions, see Add, modify, and delete external users
(page 51).

7. Give the external user the necessary remote permissions. 

For detailed instructions, see Manage remote user permissions (page 47).

8. Ensure that the Tekla EPM Remote Server is running. 

For detailed instructions, see Set up the Tekla EPM Remote Server
(page 33).

Note that you still need to set up Steel Projects PLM to work with Tekla EPM.
For detailed instructions, see the Steel Projects PLM documentation.

Send a work order to Steel Projects PLM
A work order is a nesting or multing request. A work order contains the CNC
files to be cut, and the available and orderable inventory on which you can
nest materials.

1. Open a combining, estimating, or production control job, a requisition, or
a purchase order.

2. Click the contextual ribbon tab. 

For example, if you are working on a combining job, click the Combining
ribbon tab.

3. On the menu, select Combine.
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4. In the Select Combining Run dialog box, click a desired combining option
to select it. 

The options are:

• Mult: combines linear items, like beams and angles.

• Nest: combines items that have area, like plates or gratings.

• Mult & Nest: combines all items.

5. In the lower-left corner of the Combining Run Filters dialog box, click
Optimizations.

6. Depending on which items will be combined, do one or both of the
following: 

• On the Mult Settings - Linear Material tab, set Multing Software to
SteelProjects.

• On the Plate Nesting Settings tab, set Plate Nesting Software to
SteelProjects.

7. Click Save.

8. To combine the materials, click the Mult, Nest, or Mult and Nest button
at the bottom of the Combining Run Filters dialog box. 

In the Combining Run Results dialog box, all parts show as not
combined.

9. Click Save Combining Run.

10. Click the Combining Run ribbon tab.

11. On the menu, select Export Parts for Nesting --> Export to Steel
Projects.

12. In the Export Parts for Combining dialog box, adjust the settings
according to your needs: 

• To include existing inventory materials in the export, select the
Include available inventory check box.

• To include inventory materials that are on order in the export, select
the Include orderable inventory.

• In the CNC Files list, select how you want to include CNC files in the
export.

13. Click Export Parts.

Tekla EPM exports the parts to be multed and nested.

You can now open Steel Projects PLM and import the XML file that has been
created by Tekla EPM. For detailed instructions on multing and nesting parts,
see the Steel Projects PLM documentation.
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After the parts have been nested in Steel Projects PLM, you can save the
nesting results. The results will be automatically imported back to Tekla EPM.

If the required material is not available in the Tekla EPM inventory, Steel
Projects PLM will ask you to create a requisition, which will then appear in the
Select Requisition/Purchase Order dialog box.

Export a cut list to Steel Projects PLM
1. Open a production control job.

2. In the Production Control dialog box, click the Production Control
ribbon tab.

3. On the menu, select Review --> Cut Lists.

4. In the Cut Lists dialog box, click New Cut List.

5. In the Enter Value dialog box, click the arrow on the right side of the
available field, and select the production control job for which you want to
create the cut list. 

When you are creating a new cut list, Tekla EPM by default filters the items
in the new cut list, so that only items that are not yet assigned to a cut list
are included.

6. In the Production Control Purchasing Report Filters dialog box, click
Make Report.

7. In the Report Progress dialog box, click Save Cut List.

8. In the Save Cut List dialog box, type a description and due date for the
cut list.

9. To allow importing the cut list to Steel Projects PLM, select the Share Cut
List check box.

10. Click Save To Cut List.

The cut list appears in the Cut Lists dialog box in Tekla EPM. You can now
import the cut list to Steel Projects PLM.

Manage purchase orders with Trimble Viewpoint
Use the Trimble Viewpoint integration to manage your Tekla EPM purchase
orders more efficiently. You can export your purchase orders or job costing
transactions to Trimble Viewpoint, or audit the inventory information between
Tekla EPM and Trimble Viewpoint.

Set up the Trimble Viewpoint integration
1. In the Maintenance menu, select Integrations --> Trimble Viewpoint.
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2. On the Global Settings tab of the Trimble Viewpoint Integration dialog
box, adjust the following settings: 

Setting Description
Viewpoint Software Select if you are using Trimble

Viewpoint Spectrum or Trimble
Viewpoint Vista.

Workflow Select if you want to perform job
costing when items are consumed, or
when items are purchased or
reserved.

Company Code Type the company code that you use
in Trimble Viewpoint.

If you want to ensure that the
company code is correct each time
you export purchase orders, select
the Prompt on export check box
below the Company Code field.

Cost Center Type the cost center that you use in
Trimble Viewpoint.

If you want to ensure that the cost
center is correct each time you export
purchase orders, select the Prompt
on export check box below the Cost
Center field.

3. To save the settings on the Global Settings tab, click Save Settings.

4. On the Receiving tab, to ensure that you only export the newest
transactions for receiving, click Set and enter the number of the last
exported transaction. 

Only the transactions after the last exported transaction will be exported.

5. On the Job Costing tab, do the following:

a. To ensure that you only export the newest transactions for job
costing, click Set and enter the number of the last exported
transaction. 

Only the transactions after the last exported transaction will be
exported.

b. Type the batch code, the GL debit account number, and the GL credit
account number. 

If you want to ensure that the batch code, GL debit account number,
or GL credit account number is correct each time you export
purchase orders, select the Prompt on export check box below the
related fields.
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c. To update the job costing settings, click Save Settings.

6. If you want to create customized reports to use with the Trimble
Viewpoint integration, do any of the following: 

To create a customized report for Do this
A purchase order a. On the Purchase Orders tab,

click Design.

b. In the Select Purchase Order
dialog box, double-click the
purchase order.

c. If you have selected the Prompt
on export check boxes for any
properties, ensure that the
values are correct, and click OK.

d. To confirm copying the report to
your custom report directory,
click Yes.

e. Use the Stimulsoft Report
Designer to customize the report.

For instructions, see the
Stimulsoft Reports user guide.

Receiving a. On the Receiving tab, click
Design.

b. If you have selected the Prompt
on export check boxes for any
properties, ensure that the
values are correct, and click OK.

c. To confirm copying the report to
your custom report directory,
click Yes.

d. Use the Stimulsoft Report
Designer to customize the report.

For instructions, see the
Stimulsoft Reports user guide.

Job costing a. On the Job Costing tab, click
Design.

b. If you have selected the Prompt
on export check boxes for any
properties, ensure that the
values are correct, and click OK.

c. To confirm copying the report to
your custom report directory,
click Yes.
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To create a customized report for Do this
d. Use the Stimulsoft Report

Designer to customize the report.

For instructions, see the
Stimulsoft Reports user guide.

Inventory summary a. On the Inventory Summary tab,
click Design.

b. Select the inventory date and
time in the available calendar and
lists and click OK, or click Use
Current Inventory to use the
current inventory values.

c. To confirm copying the report to
your custom report directory,
click Yes.

d. Use the Stimulsoft Report
Designer to customize the report.

For instructions, see the
Stimulsoft Reports user guide.

Saving the customized report in Stimulsoft Report Designer updates the
changes to Tekla EPM.

7. To close the dialog box, click the Close button (X) in the upper-right
corner.

You can now start working with the Trimble Viewpoint.

According to your needs, see any of the following instructions.

Export the selected purchase orders to Viewpoint
You can export purchase orders to both Trimble Viewpoint Vista and Trimble
Viewpoint Spectrum.

Before you export the purchase order, ensure that:

• The company code of the vendor in the Tekla EPM Address Book matches
the vendor in Trimble Viewpoint

• The job number of the Tekla EPM purchase order matches the job number
in Trimble Viewpoint

• The Cost Code field in Tekla EPM purchase orders is mapped to the phase
in Trimble Viewpoint purchase orders.

1. Do any of the following: 

a. At the top of the Tekla EPM window, click the Purchasing button.
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b. On the Maintenance menu, select Integrations --> Trimble
Viewpoint. Then, click Export on the Purchase Orders tab.

2. In the Select Requisition/Purchase Order dialog box, select the
purchase orders that you want to export. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

3. Click the Purchasing ribbon tab.

4. On the menu, select Export Purchase Orders --> Trimble Viewpoint -
Selected.

5. Click Yes to confirm exporting the selected purchase orders.

6. If you have selected the Prompt on export check boxes for any
properties in the Trimble Viewpoint Integration dialog box, ensure that
the values are correct, and click OK.

7. In the Save As dialog box, browse to the folder where you want to save
the exported purchase orders. 

By default, Tekla EPM saves the purchase orders in the Export folder.

8. If necessary, change the file name.

9. Click Save.

The exported purchase orders are saved as a .txt file in the folder that you
selected.

You can then import the .txt file to any Trimble Viewpoint solution according
to your needs.

Export purchase orders with receiving transactions to Viewpoint
You can export purchase orders to both Trimble Viewpoint Vista and Trimble
Viewpoint Spectrum.

Before you export the purchase order, ensure that:

• The company code of the vendor in the Tekla EPM Address Book matches
the vendor in Trimble Viewpoint

• The job number of the Tekla EPM purchase order matches the job number
in Trimble Viewpoint

• The Cost Code field in Tekla EPM purchase orders is mapped to the phase
in Trimble Viewpoint purchase orders.

1. Do any of the following: 

a. At the top of the Tekla EPM window, click the Purchasing button.

b. On the Maintenance menu, select Integrations --> Trimble
Viewpoint. Then, click Export on the Receiving tab.
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2. In the Select Requisition/Purchase Order dialog box, select the
purchase orders that you want to export. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

3. Click the Purchasing ribbon tab.

4. On the menu, select Export Purchase Orders --> Trimble Viewpoint -
Receiving.

5. In the Save As dialog box, browse to the folder where you want to save
the exported purchase orders. 

By default, Tekla EPM saves the purchase orders in the Export folder.

6. If necessary, change the file name.

7. Click Save.

The exported purchase orders are saved as a .csv file in the folder that you
selected.

NOTE To avoid errors, do not open an exported .csv file with Microsoft
Excel. If you do so, the formatting of information changes, and
the .csv file will fail to import to Trimble Viewpoint products.

Export job costing transactions
1. On the Maintenance menu, select Integrations --> Trimble Viewpoint.

2. On the Job Costing tab, click Export.

3. If you have selected the Prompt on export check boxes for any
properties in the Trimble Viewpoint Integration dialog box, ensure that
the values are correct, and click OK.

4. In the Save As dialog box, browse to the folder where you want to save
the file with exported job costing transactions. 

By default, Tekla EPM saves the file in the Export folder.

5. If necessary, change the file name.

6. Click Save.

The exported job costing transactions are saved as a .csv file in the folder
that you selected.

NOTE To avoid errors, do not open an exported .csv file with Microsoft
Excel. If you do so, the formatting of information changes, and
the .csv file will fail to import to Trimble Viewpoint products.
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View the inventory summary report
To audit the inventory information between Tekla EPM and Trimble Viewpoint:

1. On the Maintenance menu, select Integrations --> Trimble Viewpoint.

2. On the Inventory Summary tab, click View.

3.6 Manage the Tekla EPM database
Administrators can manage the Tekla EPM database in multiple ways: save
backup copies of the database, use a backup copy restore a compromised
database, compress the database, clear information on user activity from log
tables, or recover previously deleted jobs or import backup files.

For more information, see the following links:

Save a backup copy of the Tekla EPM database (page 98)

Restore the Tekla EPM database (page 99)

Compress the Tekla EPM database (page 100)

Clear all information from log tables (page 100)

Recover deleted files (page 101)

Save a backup copy of the Tekla EPM database
We recommend that administrators save backup copies of the Tekla EPM
database regularly. This way, you can restore a compromised database by
using a backup copy of the database.

NOTE The best way to ensure reliable database backups is using the
automated event for creating automatic backups.

1. Close all dialog boxes that you have open in Tekla EPM.

2. Click the File ribbon tab in the upper-left corner of the Tekla EPM window.

3. On the File menu, select Backup Database.

4. In the Save As dialog box, browse to the location where you want to save
the backup file.

5. If necessary, modify the name of the backup file.

6. Click Save.
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Tekla EPM copies all database information to the selected folder as a
compressed 7z file.

NOTE You can change the compression level of backup copies in the 
settings.ini file under the folder where Tekla EPM has been
installed. To do so:

1. Open the settings.ini file.

2. Find or add a section called [DatabaseBackup].

3. Below the [DatabaseBackup] line, type CompressionLevel, an
equal sign, and the compression value.

The compression values are from 1 (lowest level of compression,
fastest backup) to 5 (highest level of compression, slowest
backup).

For example, to save as compressed backup copies as possible,
type:

[DatabaseBackup]
CompressionLevel=5

4. Save and close the settings.ini file.

See also

Restore the Tekla EPM database (page 99)

Restore the Tekla EPM database
Administrators can use the Restore Database command to replace the Tekla
EPM database with a previously saved backup copy. This can be useful if the
database has been compromised, or if the database needs to be moved from
one server to another.

1. Ensure that all other users have logged out of Tekla EPM.

2. Close all dialog boxes that you have open in Tekla EPM.

3. Click the File ribbon tab in the upper-left corner of the Tekla EPM window.

4. On the File menu, select Restore Database.

5. In the Open dialog box, browse to find the backup file that you want to
use.

6. Select the file and click Open.

7. To replace all existing information in the Tekla EPM database with the
information in the backup file, click Yes in the confirmation dialog box. 

Tekla EPM restores the database.

8. In the Message dialog box, click OK to close Tekla EPM.
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9. To use the restored database, restart Tekla EPM and log in.

See also

Save a backup copy of the Tekla EPM database (page 98)

Compress the Tekla EPM database
Administrators can use the Optimize Tables command to compress the Tekla
EPM database.

1. Click the File ribbon tab in the upper-left corner of the Tekla EPM window.

2. On the File menu, select Administration.

3. Click the Administration ribbon tab.

4. On the menu, select Optimize Tables. 

The Optimize Tables dialog box opens, and the compression process
starts.

The more information is saved into Tekla EPM, the longer the
compression process takes.

5. In the Optimize Tables dialog box, review the result of the compression
process. 

• Optimized shows the number of files that were compressed.

• Optimization Not Required shows the number of files that did not
need to be compressed.

• Errors Found shows the number of errors that were found in the
compression process. The errors are also listed in the Optimize
Tables dialog box.

6. To close the dialog box, click the Close button (X) in the upper-right
corner.

Clear all information from log tables
All actions that are performed in Tekla EPM are saved in log tables.
Administrators can use the Clear Log Tables command to manually clear
extra logs from particular actions made by the Tekla EPM in the company.

1. Click the File ribbon tab in the upper-left corner of the Tekla EPM window.

2. On the File menu, select Administration.

3. Click the Administration ribbon tab.

4. On the menu, select Clear Log Tables.

5. To confirm clearing the log tables, click Yes in the confirmation dialog box.
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Recover deleted files
When a user deletes a combining job, estimating job, or a production control
job, Tekla EPM saves the jobs in the Tekla EPM database as KISS files.
Administrators can recover the deleted combining jobs, estimating jobs, and
production control jobs within 30 days of deleting the job.

To access the recovering options, do the following:

1. Click the File ribbon tab in the upper-left corner of the Tekla EPM window.

2. On the File menu, select Administration.

3. Click the Administration ribbon tab.

Recover jobs
1. On the menu, select any of the following depending on the job type:

• Recover Deleted Combining Jobs

• Recover Deleted Estimating Jobs

• Recover Deleted Production Control Jobs

2. In the recovering dialog box that opens, select the jobs that you want to
recover. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.
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3. Click Recover. 

A message opens, informing you that Tekla EPM will create KISS files for
the selected jobs. You can then import the KISS files back to Tekla EPM to
view and modify the recovered job again.

4. Click OK to close the message.

5. In the Save As dialog box, browse to the location where you want to save
the first KISS file for recovering the job.

6. If necessary, change the file name.

7. Click Save. 

Repeat steps 5 to 7 to select the saving location of all KISS files.

8. Close all open dialog boxes in the Tekla EPM.

9. To re-import the recovered job to Tekla EPM, click the File ribbon tab.

10. On the File menu, select Import.

11. In the navigation tree on the left of the Import dialog box, select the job
type (Combining, Estimating, or Production Control) and then, select
KISS. 

12. Click the ... button.
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13. In the Open dialog box, browse to find the KISS file that you want to
import.

14. Select the file and click Open.

15. Click Import.

16. In the job editing dialog box, modify the job information according to your
needs.

17. Click Save.

18. In the Import dialog box, view the status of the import process. 

If necessary, you can view the import details and errors in a text file by
clicking the Open Import Log button.

19. To close the dialog box, click the Close button (X) in the upper-right
corner.

The recovered job can now be opened and modified when you open the
related module in Tekla EPM.

Recover import backups
Tekla EPM creates import backup files automatically when information is
imported to a production control job. Import backup files contain the
information of a production control job before any new information was
imported. By recovering import backup files, you can revert a production
control job to the state before new information was imported.

1. On the menu, select Recover Import Backups.
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2. In the Recover Import Backup dialog box, select the import backup file. 

You can identify the correct backup file by the import date and time, the
user that imported the information, and the job number.

3. Click Recover. 

A message opens, informing you that Tekla EPM will create KISS files for
the selected import backups. You can then import the KISS files back to
Tekla EPM to revert the production control job to the state before
importing information.

4. Click OK to close the message.

5. In the Save As dialog box, browse to the location where you want to save
the KISS file.

6. If necessary, change the file name.

7. Click Save.

8. Close all open dialog boxes in Tekla EPM.

9. To revert the job to the state before new information was imported, Tekla
EPM, click the File ribbon tab.
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10. In the navigation tree on the left of the Import dialog box, select the
import file type and then, select KISS .

11. Click the ... button.

12. In the Open dialog box, browse to find the KISS file that you want to
import.

13. Select the file and click Open.

14. Click Import.

15. In the Job # list, select the job that you want to revert to its previous state.

16. Click Save.

17. To overwrite the current information with the import backup file, in the
Import dialog box, select Add & Replace.

18. Click OK. 

If you have selected the Prompt to confirm import fields in the
Company Standards dialog box for the Production Control module, the
Select the included fields dialog box opens.

19. In the Select the included fields dialog box, click the arrow buttons to
move the fields whose information that you want to replace to the
Included list. 
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20. Click OK.

21. Define other necessary information for the imported backup file.

22. Click OK.

23. In the Import dialog box, view the status of the import process. 

If necessary, you can view the import details and errors in a text file by
clicking the Open Import Log button.

24. To close the dialog box, click the Close button (X) in the upper-right
corner.

3.7 Repair program errors
Administrators can use the Check/Repair Tables commands on the server
computer to find and repair errors in Tekla EPM. When one of these
commands is executed, the program information is checked against the
MYSQL database and any corrupt files are repaired.

NOTE To repair errors, the administrator must execute the Check/Repair
Tables commands on the server computer. On other workstations,
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the Check/Repair Tables commands can help you find corrupted
files, but the files cannot be prepared.

1. Click the File ribbon tab in the upper-left corner of the Tekla EPM window.

2. On the File menu, select Administration.

3. Click the Administration ribbon tab.

4. On the menu, select one of the following commands:

• Check/Repair Tables: Quick (Fast)

• Check/Repair Tables: Medium (Recommended)

• Check/Repair Tables: Extended (Slow)

The Check/Repair Tables dialog box opens, and the check and repair
process starts.

The more information is saved into Tekla EPM, the longer the check and
repair process takes.

5. In the Check/Repair Tables dialog box, review the result of the check and
repair process. 

6. To close the dialog box, click the Close button (X) in the upper-right
corner.
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4 Start using Tekla EPM

Tekla EPM is a software solution designed for the needs of the steel
fabrication industry. Tekla EPM brings together various modules that integrate
seamlessly with each other, so the information that you enter in one Tekla
EPM module is available through the entire workflow.

Tekla EPM is built upon the industry best practices. However, the operations
and options in Tekla EPM can be customized to match your existing processes
and procedures.

Tekla EPM consists of the following modules:

• The Combining module allows you to create advanced bills of materials
while optimizing the use of material and minimizing the waste.

• The Estimating module allows you to create estimates with customizable
pricing based on multiple sources for material pricing and shop-specific
labor.

• The Inventory module allows you to track your entire inventory across all
jobs as material is received and consumed. The Inventory module also
allows you to track stock materials and non-steel items.

• The Project Management module allows you to easily share project
information to all users that participate in a project, and create and view
project schedules in order to track the progress of the project.

• The Production Control module allows you to view and manage the
fabrication process of material items.

• The Purchasing module allows you to create requisitions, and automate
and optimize creating and tracking purchase orders.

• The Order Entry module allows you to manage all tasks related to selling
material from your warehouse or shop, such as creating quotes and
orders, invoicing, and recording payments.

For more information, see the following links:

Sign in to Tekla EPM (page 109)

Set the default printer (page 166)
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Set the standard categories for attached documents (page 166)

Manage the address book (page 169)

Manage taxes and currencies (page 176)

Import files to Tekla EPM (page 182)

Create, modify, and delete automated events (page 189)

Customize Tekla EPM (page 206)

4.1 Sign in to Tekla EPM
To sign in to Tekla EPM for the first time, do the following:

1. Start Tekla EPM. 

2. In the Trimble ID section of the Log In dialog box, click Sign in. 
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If you do not have a Trimble Identity, see Create your Trimble Identity
(page 111).

3. In the Trimble Identity dialog box, type your email address and
password.

4. If you want to stay signed in with this Trimble Identity, select the Stay
signed in check box.

5. Click Sign in. 

The Trimble Identity dialog box closes automatically.

6. If necessary, in the Configuration list of the Log In dialog box, select
which configuration of Tekla EPM you want to use. 

Note that you only need to select a configuration if you have purchased
more than one configuration of Tekla EPM.

7. Type your Tekla EPM username and password. 

The username and password need to be created by an administrator in
your company.

The default Tekla EPM sign-in information for administrators is:

• username: admin
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• password: fab
If you have previously used Fabsuite, your username and password are
the same as in Fabsuite.

8. Click Log In.

9. In the Enter Value dialog box, do either of the following:

• To save your Trimble Identity and use it automatically when you sign in
to Tekla EPM, select Yes in the list.

• To not use your Trimble Identity automatically when you log in, select
No in the list.

See also

Tekla EPM configurations (page 111)

Create your Trimble Identity (page 111)

The Tekla EPM window (page 112)

Set or change your Tekla EPM password (page 113)

Tekla EPM configurations
Tekla EPM is available in different configurations that provide the opportunity
to use different Tekla EPM modules and features.

The Tekla EPM modules included in different configurations are:

Name Tekla EPM Full Tekla EPM
Production

Tekla EPM
Estimating

Combining ✔ ✔ ✔

Estimating ✔  ✔

Inventory ✔ ✔ ✔

Project
Management

✔ ✔  

Production
Control

✔ ✔  

Purchasing ✔ ✔ ✔

Order Entry ✔ ✔  

In addition to the Tekla EPM configurations in the table, there are specific
Tekla EPM configurations that replace the Fabsuite configurations used by
former Fabsuite customers.
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Create your Trimble Identity
You need a Trimble Identity to download and use Tekla EPM.

The licenses of each Tekla EPM user are tied to the user's Trimble Identity. For
this reason, users always need to sign in to Tekla EPM with their Trimble
Identity. In addition, each Tekla EPM user needs to be added to the company's
organization by a user with administrator rights.

If you are the named contact at your organization, Trimble automatically
creates an account for you or connects your existing Trimble Identity to your
organization. The named contact has administrator status and must add other
users into the organization to enable their access to content and services that
require a valid maintenance contract.

If you are the named contact, Trimble sends you an email with an invitation to
accept membership in the organization group and complete the profile
information if you did not have an existing Trimble Identity. You are then
responsible for managing the organization group together with other
administrators that you assign.

If you are not the named contact, you receive an email invitation to join the
organization group when an administrator from your own organization invites
you. You can also create a new Trimble Identity here.

If you are having problems using your Trimble Identity in Tekla Online services,
see the troubleshooting information on this page.

The Tekla EPM window
See the elements of the Tekla EPM window in the following image:

• The File menu contains all administrative commands.
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• The Maintenance menu allows you to adjust the settings of all Tekla EPM
modules and jobs.

• The About menu allows you to access the Tekla EPM release notes, and
configuration and version information.

• The Windows menu lists all your open Tekla EPM dialog boxes.

You can select a dialog box in the menu to open it on top of other dialog
boxes.

• A contextual menu is available when working in any Tekla EPM module.

When you open a Tekla EPM module, the related contextual ribbon tab
appears on the right side of the other ribbon tabs.

By clicking the contextual ribbon tab, you can access the commands in the
contextual menu. Any commands that you click in the contextual menu
only affect the job that is currently open.

• The buttons at the top of the Tekla EPM window represent the various
Tekla EPM modules.

You can access a module by clicking the desired button.

If you do not have rights to access a module, the module button appears
gray and cannot be selected.

Set or change your Tekla EPM password
Use the Change Password command to either create the password you will
use when you log in to Tekla EPM, or change your current password.

Note that passwords are case-sensitive.

If your initial password does not meet the company password policy, the
Change Password dialog box opens automatically when you first log in to
Tekla EPM.

1. Click the File ribbon tab in the upper-left corner of the Tekla EPM window.

2. On the File menu, select Change Password. 
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3. In the Change Password dialog box, type your old password in the Old
Password field. 

If you are setting your password for the first time, leave the Old Password
field blank.

4. Type your new password in the New Password and Confirm fields. 

The passwords in the New Password and Confirm fields need to be
identical.

You can verify your company's requirements for the password in the
Password Policy section of the dialog box. The password policy is set by
the Tekla EPM administrators of your company.

5. Click Save to update the password. 

A message appears, telling you that the password has been changed.

6. Click OK to close the message.

4.2 Adjust the initial settings
Before you start working in Tekla EPM, it is important to adjust the material
database and pricing to match those of your company. You can also set the
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default printer that you want to use, and define the standard categories that
you want to use for attaching documents to jobs in Document Index.

See also

Set up the material database (page 115)

Set up pricing (page 147)

Set the default printer (page 166)

Set the standard categories for attached documents (page 166)

Set up the material database
Tekla EPM contains a variety of different materials, which are stored in the
material database. These materials are the foundation of all material
calculations in Tekla EPM, so adjusting the material database according to the
needs of your company is extremely important.

You can also add any materials that you need to the material database. Note
that you can also add material items that are not steel, from equipment and
consumables to office supplies. Tekla EPM accepts a variety of property
formats used to assist with material calculations for weights, pricing, and
surface area for coating.

You can view and manage the materials that have been added to the material
database in the Shape / Grade / Size Maintenance dialog box. You can both
add new materials, and modify, deactivate, or delete existing materials.

Note that when you add new materials to the material database, the materials
still need to be added to the pricing database separately. The pricing database
is where Tekla EPM looks for the material dimensions and lengths for
combining materials.

If you add dimensions for shapes by importing, remember to check the
material database for dimensions that do not have complete properties. You
can easily find any dimensions with incomplete properties by creating a zero
weight report. For detailed instructions on creating material reports, see
Create material reports (page 144).

To start managing the materials in the Tekla EPM:

1. Click the Maintenance ribbon tab.

2. On the menu, select Shapes/Grades/Sizes.

The Shape / Grade / Size Maintenance dialog box opens. See the structure of
the dialog box in the following image:
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(1) The shape list shows all shapes in the material database. You can see the
shape abbreviation, the description of the shape, the number of material
grades and dimensions, and whether the shape is activated or not. When you
select a shape in the shape list, you can start managing its dimensions, grades,
and abbreviations.

For more information, see Manage shapes (page 117).

(2) Use the navigation tree to filter which shapes are shown in the shape list.
You can expand the categories in the navigation tree by clicking the + signs on
the left side of the categories. For example, if you only want to show shapes
that have material grades, click + on the left side of Has Grades, and select
Yes.

(3) On the Dimensions tab, you can add new dimensions, modify dimension
properties, add alternate dimensions and grade overides, show where
particular dimensions are used in Tekla EPM, and delete unnecessary
dimensions.

For more information, see Manage dimensions (page 134).

(4) On the Grades tab, you can add, modify, or delete grades, and add grade
substitutions or grade redirections.

For more information, see Manage grades (page 128).

(5) On the Shape Abbreviations tab, you can add new abbreviations for
shapes. By adding shape abbreviations, you can ensure that Tekla EPM
recognizes any shapes that you import, even if the imported shapes do not
use the Tekla EPM standard abbreviations.
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For more information, see Add, modify, and delete shape abbreviations
(page 124).

(6) When you have selected a shape, you can see the material group, weight
calculation method, and cost calculation method, and the cost display units
here. If necessary, you can change the cost display units.

See also

Find shapes, grades, dimensions, or shape abbreviations (page 117)

Find shapes, grades, dimensions, or shape abbreviations
Use the Find commands to find material shapes, grades, dimensions, and
shape abbreviations in the Shape / Grade / Size Maintenance dialog box
without scrolling.

1. In the Shape / Grade / Size Maintenance dialog box, do any of the
following:

• To find a shape, click Find Shape at the bottom of the dialog box.

• To find a material dimension, open the Dimensions tab. Then, select
the shape whose dimensions you want to view in the shape list, and
click Find Dimension.

• To find a material grade, open the Grades tab. Then, select the shape
whose grades you want to view in the shape list, and click Find Grade.

• To find a shape abbreviation, open the Shape Abbreviations tab.
Then, select the shape whose abbreviations you want to view, and click
Find Abbreviation.

2. In the Find dialog box, type the search term in the field. 

Note that when searching for a dimension, you need to leave a space on
both sides of x. For example, 3 x 3 x 1/4.

3. Click OK.

The shape, grade, dimension, or shape abbreviation that you searched for is
selected in the Shape / Grade / Size Maintenance dialog box.

Manage shapes
You can manage the shapes in the Tekla EPM material database in several
ways. You can add, delete, activate, and deactivate shapes. In addition, you can
add grades, dimensions, and abbreviations for shapes.

Note that the shape list also contains system shapes that users cannot modify.
Many of these system shapes may be missing some of the actual shape
information, such as material grades or dimensions. These shapes are added
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for user convenience. If necessary, you can add material grades or dimensions
for the shapes, or deactivate the shapes (page 124).

If you want to, you can use separate shapes for materials that may have the
same or similar shape but have different grades. You can use the Tekla EPM
system shapes for this purpose: just add the necessary dimensions or grades
for these system shapes.

The shape list in the Shape / Grade / Size Maintenance dialog box lists all
existing shapes in alphabetical order. You can see different details of shapes:
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• The Shape column lists the abbreviations for the material shape.

Abbreviations are common references that Tekla EPM uses to recognize a
particular shape. For example, when you import a bill of materials, Tekla
EPM searches for a match in the shape list. If no match is found, Tekla EPM
asks you to select one. For example, this could happen if flat bars were
referenced as FL instead of FB.

The material database also contains shapes that are identical but can be
found under two abbreviations, such as HSS and TS. Both abbreviations are
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available in the database to meet the needs of companies that use
different terminology. Note that even though the two options are available,
you should select one of them and use it consistently. This way, you can
avoid problems when combining materials.

The abbreviation is defined when adding a new shape. New abbreviations
can also be added to enable cross-referencing in Tekla EPM.

• The Description column shows the name of the shape.

• The Grades column shows the number of grades included for the shape.

• The Dimensions column shows the number of dimensions, or material
sizes, included for the shape.

• The Activated column shows whether a shape is active within Tekla EPM.

Deactivated shapes, marked with No, are not available for combining or
pricing.

See also

Add, modify, and delete shapes (page 120)

Activate or deactivate shapes (page 124)

Add, modify, and delete shape abbreviations (page 124)

Export shapes (page 126)

Add, modify, and delete shapes
The Shape Maintenance dialog box allows you to add new shapes to the
material database. You can also select which dimension properties are used
for the shapes, and permanently delete unnecessary shapes.
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Each shape in the Shape Maintenance dialog box belongs to one of the
following material groups:

• Angles

• Beams

• Plates

• Rods

• Tubes

• None

All material groups have their own dimension property sets that determine
how Tekla EPM calculates the dimension properties and estimates labor.

Each shape in Tekla EPM has the following properties:

Property Description
Description Each dimension property has a description in both

imperial and metric units.
Dynamic Determines what kind of entries the shape accepts.

If Dynamic is set to Yes, the shape accepts any
entry that the user enters as dimension. If
Dynamic is set to No, the dimensions of the shape
need to be added to the list.

Note that if you select Yes, you cannot assign
weights or other dimension properties for the
shape.

Length Shows if the dimension has length or if the
descriptions contain the length.

If the dimension descriptions contain the length or
the dimension does not have length, Length is set
to No. If the descriptions do not contain the length,
but the dimension has a length, Length is set to
Yes.

Property Shows the weight calculation format of the
dimension.

You can view the details of the format by
expanding the Dimension Format Properties
section and opening the Property Formats tab.

Sur. Area Shows the surface area calculation format of the
dimension.

You can view the details of the format by
expanding the Dimension Format Properties
section and opening the Surface Area Formats
tab.
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Note that some shapes also have qualified alternate dimension properties that
you can select to use. In this case, two or more lines are shown for the
selected shape.

• Select the line whose properties you want to use, and click Save Shape to
save the changes.

Add a shape

1. In the Shape / Grade / Size Maintenance dialog box, click the Shape /
Grade / Size Maintenance ribbon tab.

2. On the menu, select Shape Maintenance.

3. In the shape list of the Shape Maintenance dialog box, select a shape
that has as similar properties as possible to the shape that you want to
add. 

For example, when adding deformed bar anchors, you may want to select
the anchor bolts shape, whose properties are calculated in the same way.
This way, you do not have to modify the shape properties too much.

4. At the bottom of the dialog box, click New Shape.

5. In the Shape field, enter an abbreviation for the shape. 

You can use any abbreviation that is not currently used by another shape.

6. Enter a description for the shape.

7. In the Material Group list, select a suitable group for the shape. 

Note that if you select the None material group, Tekla EPM cannot
calculate labor for the shape in the Estimating module.

8. Select the price and weight format for the shape.

9. In the Combining list, select if the shape should be multed, nested, or not
combined at all.

10. If you want Tekla EPM to always look for a piece mark association when
importing items of the new shape, select the PDC - Piece Mark Required
check box. 

If piece marks are not used, you can leave the check box unselected.
Whether you use piece marks or not is defined in your company standard
settings for the Production Control module.

11. If you do not want to allow piece tracking for the shape, select the
Exclude from Instance Tracking check box. 

Selecting the Exclude from Instance Tracking check box is especially
useful for items like hardware.
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12. If you are adding a shape that is also used in the enterprise resource
planning (ERP) software, type the shape designation that is used in that
software in the ERP Designation field.

13. Click Save Shape. 

The new shape is added to the shape list.

Next, you can close the Shape Maintenance dialog box, and add dimensions
(page 136), grades (page 130), additional shape abbreviations, (page 124) and
other properties for the shape according to your needs.

Modify a shape

1. In the Shape / Grade / Size Maintenance dialog box, click the Shape /
Grade / Size Maintenance ribbon tab.

2. On the menu, select Shape Maintenance.

3. In the shape list of the Shape Maintenance dialog box, select the shape
that you want to modify.

4. Modify the shape properties according to your needs. 

For example, you can change how the shape should be combined, and
which price and weight formats are used.

5. Click Save Shape.

6. To confirm changing the shape properties, click Yes in the confirmation
dialog box.

Delete a shape
You can delete unnecessary shapes from the material database. For example,
you might need to delete a shape whose properties are incorrect. Note that
when you delete a shape in the Shape Maintenance dialog box, the shape
and its properties are permanently deleted from Tekla EPM. Shapes that are
currently used somewhere in Tekla EPM cannot be deleted.

NOTE We recommend that you deactivate shapes instead of deleting them.
If needed, you can easily start using deactivated shapes by activating
the shapes again.

1. In the Shape / Grade / Size Maintenance dialog box, click the Shape /
Grade / Size Maintenance ribbon tab.

2. In the menu, select Shape Maintenance.

3. In the shape list on the left side of the Shape Maintenance dialog box,
select the shape that you want to delete.

4. At the bottom of the dialog box, click Delete Shape.

5. To permanently delete the shape from Tekla EPM, click Yes in the
confirmation dialog box.
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Activate or deactivate shapes
In the Shape / Grade / Size Maintenance dialog box, you can activate and
deactivate shapes to enable or disable using the shapes in Tekla EPM. You can
also use the Activated/Deactivated list to select if you want to display
activated, deactivated, or all shapes.

According to your needs, see any of the following instructions:

Deactivate shapes

NOTE We recommend that you deactivate shapes instead of deleting them.
If needed, you can easily start using deactivated shapes by activating
the shapes again.

1. In the shape list, select the shapes that you want to deactivate. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Deactivate Selected Shapes.

3. To confirm deactivating the shapes, click Yes in the confirmation dialog
box.

The deactivated shapes are no longer available for Tekla EPM to use in
combining and pricing. You can re-activate deactivated shapes at any time.

Activate shapes

1. In the shape list, select the shapes that you want to activate. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Activate Selected Shapes.

3. To confirm activating the shapes, click Yes in the confirmation dialog box.

Add, modify, and delete shape abbreviations
Shape abbreviations allow Tekla EPM to identify a shape. By adding shape
abbreviations, you can ensure that Tekla EPM recognizes the shapes in any
files that you import, even if the files do not use the Tekla EPM standard shape
abbreviations.

If you are importing a file and Tekla EPM does not recognize an abbreviation in
the file, Tekla EPM automatically prompts you to select the shape and grade
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that the abbreviation should redirect to. Then, Tekla EPM asks you if you want
to add an abbreviation for the imported shape.

We recommend that you keep detailers up to date on the used shape
abbreviations, so that you can minimize the need to create new shape
abbreviations.

According to your needs, see any of the following instructions:

Add a shape abbreviation

1. In the shape list of the Shape / Grade / Size Maintenance dialog box,
select a shape.

2. Open the Shape Abbreviations tab. 

You can see the existing abbreviations for the selected shape in the
Abbreviation list.

3. At the bottom of the Shape Abbreviations tab, click Add Abbreviation.

4. In the Abbreviation field, type a letter combination or a number.

5. Click OK.

The abbreviation is added for the selected shape. If necessary, you can delete
previous abbreviations.

Modify a shape abbreviation

1. In the table of the Shape / Grade / Size Maintenance dialog box, select a
shape.

2. Open the Shape Abbreviations tab. 

The existing abbreviations for the selected shape appear in the
Abbreviation list.

3. In the Abbreviation list, select the item that you want to modify.

4. At the bottom of the Shape Abbreviations tab, click Edit Abbreviation.

5. Modify the abbreviation.

6. Click OK.

The abbreviation is updated.

Delete shape abbreviations

1. In the table of the Shape / Grade / Size Maintenance dialog box, select a
shape.

2. Open the Shape Abbreviations tab. 

The existing abbreviations for the selected shape appear in the
Abbreviation list.

3. In the Abbreviation list, select the item that you want to delete.
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4. At the bottom of the Shape Abbreviations tab, click Delete
Abbreviation.

5. To permanently delete the abbreviation, click Yes in the confirmation
dialog box.

Export shapes
Exporting shape information is useful for making shape identification changes
while keeping all of the information defined in Tekla EPM. You can export
either specific shapes or all shapes to the ASCII or XML format.

1. In the Shape / Grade / Size Maintenance dialog box, click the Shape /
Grade / Size Maintenance ribbon tab.

2. On the menu, select Export and the export format.

3. Depending on the export format, do any of the following: 

If you are exporting to Do this
ASCII format (.txt file) a. If you only want to export

particular shapes, in the Filter
dialog box, click the arrow
buttons to move the shapes that
you want to export to the
Included list.

b. Click OK

c. In the Save As dialog box,
browse to the folder where you
want to save the file.

By default, Tekla EPM saves the
file to the Export folder.

d. If necessary, change the file
name.

e. Click Save.
ProNest a. In the Save As dialog box,

browse to the folder where you
want to save the file.

By default, Tekla EPM saves the
file to the Export folder.

b. If necessary, change the file
name.

c. Click Save.

You can see the progress of the
export in the Status dialog box. After
the export has finished, you can close
the dialog box by clicking OK.
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If you are exporting to Do this
XML format a. In the XML Shapes Export

Options dialog box, select the
check boxes for the items that
you want to include in the export.

b. Click Export.

c. If you only want to export
particular shapes, in the Select
Shapes dialog box, click the
arrow buttons to move the
shapes that you want to export
to the Included list.

d. Click OK.

e. In the Save As dialog box,
browse to the folder where you
want to save the file.

By default, Tekla EPM saves the
file to the Export folder.

f. If necessary, change the file
name.

g. Click Save.

You can see the progress of the
export in the Status dialog box. After
the export has finished, you can close
the dialog box by clicking OK.

SigmaNest a. In the Select Supplier dialog box,
select the supplier warehouse of
the shapes to be exported.

b. Click OK.

You can see the progress of the
export in the Status dialog box. After
the export has finished, you can close
the dialog box by clicking OK.

For the Export To ASCII, Export To ProNest, Export To XML options, the
exported shapes are saved to the selected folder, where you can find them
and import them to the related software.

For Export to SigmaNest, the shapes are imported directly to SigmaNest
through SimTrans.
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Example: Changing the shape abbreviation FB to FL by exporting an
ASCII .txt file

For example, you could change a material shape abbreviation for FB (flat bar)
to FL (also an indicator for flat bar). This change can be made outside of Tekla
EPM, when you export the shapes into a .txt file. After the change, the .txt
file can be imported back to Tekla EPM.

To change the shape abbreviation, do the following:

1. In the Filter dialog box, only move the FB shapes to the Included list.

2. Name and save the file to the desired location.

3. Browse to find the saved file and open it in Microsoft Notepad.

4. Open the Edit menu in the upper-left corner of the Microsoft Notepad
window.

5. Click Replace.

6. In the Find what field, type FB.

7. In the Replace with field, type FL.

8. Click Replace All and save the file.

9. In Tekla EPM, click the File tab, and select Import on the File menu.

10. In the navigation tree of the Import dialog box, select Sizes --> ASCII .

11. Click ... to browse for and select the updated file.

12. Click OK.

13. Click Import.

Since the ASCII file only contains the flat bar shapes, you do not need to
filter the shapes. Instead, you can leave all shapes in the Included list.

14. Click OK.

The new shape list is imported to Tekla EPM, and the abbreviation of the flat
bars changes.

See also

Add, modify, and delete shapes (page 120)

Add, modify, and delete shape abbreviations (page 124)

Manage grades
In the Shape / Grade / Size Maintenance dialog box, you can manage the
material grades of shapes in multiple ways. You can add, modify, and delete
grades, set default grades for shapes, and add grade overrides, grade
redirections, grade substitutions, and grade abbreviations.

• To modify grade properties, select the shape whose grades you want to
modify, and open the Grades tab.
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The Shape / Grade / Size Maintenance dialog box shows the different grade
details of the shape:

(1) The Grade list shows all available material grades included for the selected
shape. To view the properties of a specific material grade, select it in the
Grade list.
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(2) The default grade of the selected shape. Each shape with grades has a
default grade that Tekla EPM uses for the shape by default. The default grade
of the shape is marked with an asterisk (*).

You can change the default grade by selecting another grade in the Default
list, and clicking Update.

(3) The Substitutions tab shows the existing grade substitutions of the
selected grade. Grade substitutions allow Tekla EPM to combine materials to
material grades in the inventory that do not match the material grades in bills
of materials. Grade substitutions can be useful when very little material of a
particular material grade is needed, so another grade can be used instead.

You can add and delete grade substitutions, and increase or decrease the
order of grade substitutions.

(4) The Redirections tab shows the existing grade redirections of the selected
grade. Grade redirections allow Tekla EPM to recognize material grades that
are imported to Tekla EPM with names that Tekla EPM does not initially
recognize. When you use grade redirections, the imported material grades are
redirected to the appropriate material grades.

(5) The Abbreviations tab shows the grade abbreviations added for the
selected grade. Grade abbreviations are alternative spellings that you can use
for your material grades in Tekla EPM.

See also

Add, modify, and delete grades (page 130)

Add grade substitutions (page 132)

Add grade redirections (page 133)

Add, modify, and delete grade abbreviations (page 132)

Add, modify, and delete grades
In the Shape / Grade / Size Maintenance dialog box, you can add material
grades for a selected shape, modify the properties of existing grades, or delete
unnecessary grades.

According to your needs, see any of the following instructions:

Add grades

1. In the Shape / Grade / Size Maintenance dialog box, open the Grades
tab.

2. In the shape list, select a shape.

3. At the bottom of the dialog box, click Add Grade.

4. In the Grade Details dialog box, type the new grade in the Grade field.

5. If necessary, modify the weight multiplier.
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6. If you use ProNest for nesting, type the ProNest shape to which you want
to associate the grade in the ProNest Shape Designation field.

7. To save the grade, click Save. 

The material grade is added to the Grade list of the selected shape.

Modify grades

1. In the Shape / Grade / Size Maintenance dialog box, select the Grades
option.

2. In the shape list, select a shape.

3. In the Grade list, select the grade that you want to modify.

4. At the bottom of the dialog box, click Edit Grade.

5. In the Grade dialog box, do one or more of the following to modify the
grade:

• In the Grade field, type a new name for the grade.

• Modify the weight multiplier value.

• To change the ProNest shape to which you want to associate the
grade, type a new name in the ProNest Shape Designation field.

6. Click Save.

The grade properties are updated.

Delete grades

1. In the Shape / Grade / Size Maintenance dialog box, select the Grades
option button.

2. In the shape list, select a shape.

3. In the Grade list, select the grade that you want to delete.

4. At the bottom of the dialog box, click Delete Grade.

5. To permanently delete the grade, click Yes in the confirmation dialog box. 

If a single grade that you are trying to delete is used somewhere else in
Tekla EPM, a dialog box opens, showing in which jobs the grade is used.

If multiple grades that you are trying to delete are used somewhere else
in Tekla EPM, notification messages appear, telling you that the grades are
used somewhere else in Tekla EPM. Then, deleting the selected grades is
canceled.

6. Do one of the following:

• View where the grades is used, and click OK to close the dialog box
without deleting the grade. You can then change the grade used in the
listed jobs, and delete the grade later.
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• If you are sure that you want to delete the grade now, click Force
Delete, select the new grade that will be used elsewhere in Tekla EPM
instead of the grade that you are deleting, and click Perform Force
Delete.

Add, modify, and delete grade abbreviations
Grade abbreviations are alternative spellings that you can use for your
material grades in Tekla EPM.

1. In the Shape / Grade / Size Maintenance dialog box, open the Grades
tab.

2. In the shape list, select a shape.

3. In the grade list, select the grade whose abbreviations you want to
manage.

4. Open the Abbreviations tab.

According to your needs, see any of the following instructions:

Add a grade abbreviation

1. At the bottom of the Abbreviations tab, click Add.

2. Type the abbreviation.

3. To save the abbreviation, click OK.

The new grade abbreviation is added in the Abbreviation list.

Modify a grade abbreviation

1. In the Abbreviation list, select the abbreviation that you want to modify.

2. At the bottom of the Abbreviations tab, click Edit.

3. Modify the abbreviation according to your needs.

4. To save the abbreviation, click OK.

The modified grade abbreviation is updated to the Abbreviation list.

Remove a grade abbreviation

1. In the Abbreviation list, select the grade abbreviation that you want to
modify.

2. At the bottom of the Abbreviations tab, click Delete.

3. To permanently delete the abbreviation, click Yes in the confirmation
dialog box.

Add grade substitutions
Grade substitutions allow Tekla EPM to combine materials to material grades
in the inventory that do not match the material grade in the bill of materials.
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Creating grade substitutions can be useful when very little material of a certain
grade is needed, so another grade can be used instead. Grade substitutions
need to be created separately for each job.

Note that you should only add grade substitutions that meet or exceed the
requirements of the current grade.

1. In the Shape / Grade / Size Maintenance dialog box, open the Grades
tab.

2. In the shape list, select a shape.

3. In the Grade list, select a grade.

4. On the right side of the Grades tab, open the Substitutions tab.

5. Click Add.

6. In the Select a substitute grade list, select a grade.

7. Click OK. 

The new grade substitution is added to the list.

8. Use the (+) Use Order and (-) Use Order to move the substitute grade up
or down in the list. This way, you can define the order in which Tekla EPM
uses the substitute grades.

If necessary, you can delete substitute grades by selecting them in the
substitution list and clicking Delete at the bottom of the Substitutions tab.

See also

Add, modify, and delete grades (page 130)

Add grade redirections (page 133)

Add grade redirections
Grade redirections allow Tekla EPM to recognize material grades that are
imported to Tekla EPM with names that Tekla EPM does not initially recognize.
When you use grade redirections, the imported material grades are redirected
to the appropriate material grades. For example, if an item to be imported has
the grade A500-GR.B, adding a redirection allows Tekla EPM to recognize the
grade and use the A500 grade from the material database.

1. In the Shape / Grade / Size Maintenance dialog box, open the Grades
tab.

2. In the shape list, select a shape.

3. In the Grade list, select the grade for which you want to add a redirection.

4. Open the Redirections tab.

5. At the bottom of the Redirections tab, click Add.

6. In the Shape list of the Grade Redirection dialog box, select the shape.
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7. In the Grade field, type the grade that should be redirected to the
selected grade.

8. Click Save.

See also

Add, modify, and delete grades (page 130)

Add grade substitutions (page 132)

Manage dimensions
You can manage material dimensions, or material sizes, in the Tekla EPM
material database in several ways. You can add, modify, and delete
dimensions, and add grade overrides or alternates for the dimensions.

• To view and modify dimension properties, open the Dimensions tab at the
top of the Shape / Grade / Size Maintenance dialog box.
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The Shape / Grade / Size Maintenance dialog box shows the different details
of dimensions:

(1) The Dimension list shows all available dimensions for the selected shape.
To view the properties of a specific dimension, select it in the list.

(2) On the Alternates tab, you can view, add, modify, and delete alternate
dimensions. When importing a dimension with a description that Tekla EPM
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does not recognize, alternate dimensions allow Tekla EPM to identify the
imported dimension.

(3) The Properties tab shows the properties of the selected dimension.

(4) On the Grade Overrides tab, you can view, add, modify, and delete grade
overrides. Grade overrides allow Tekla EPM to assign a specific unit weight for
a specific dimension. Grade overrides should only be used for shapes that do
not have linear unit weights, such as stainless steel.

See also

View the dimensions of a shape (page 136)

Add dimensions (page 136)

Modify dimension properties (page 138)

Modify the properties of multiple dimensions (page 140)

Add grade overrides (page 141)

Add alternate dimensions (page 142)

Show where grades and dimensions are used (page 142)

Delete dimensions (page 143)

View the dimensions of a shape

If necessary, you can hide shapes that do not have material dimensions. To do
so, in the navigation tree on the left, click + on the left side of Has
Dimensions. Then, select Yes.

1. In the shape list of the Shape / Grade / Size Maintenance dialog box,
select a shape.

2. Open the Dimensions tab. 

The existing dimensions for the shape are shown in the Dimension list.

Add dimensions
You can add material dimensions, or material sizes, to the shape list in the
Shape / Grade / Size Maintenance dialog box.

1. In the Shape / Grade / Size Maintenance dialog box, select a shape in
the shape list.

2. Open the Dimensions tab.

3. Click Add Dimension at the bottom of the dialog box.
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4. In the Dimension dialog box, define the dimension properties according
to your needs. 

Note that the available and mandatory fields the Dimension dialog box
vary according to the shape properties.

a. If you want to add a name for the dimension that is used in an
integrated software, type the designation in the ERP Desgn or
ProNest Desgn field.

b. In the Revaluation section, define the revaluation properties
according to your needs. 

The revaluation settings discount the drop material by length by
applying a percentage of the drop cost to the job using the stock
length.

You can set the revaluation calculation to either a percentage of the
original value or a price for each length by selecting an option in the
Calc list. We recommend using the % option because it is easier to
maintain.

For example, the revaluation of a 15'-0 drop might be considered
worth 80% of the original price, and 10'-0 might be worth 50%. These
values are then used for evaluating the remaining stock materials in
the inventory for accounting purposes.

If you want all the drop material below a particular length to be
charged to the job where the original length was used, you can type
the desired length in the Charge Length field. If you want all drop
material to be charged to the job, typing 60' in the Charge Length
usually covers all items.

c. In the Scrap section, set a scrap length. 

Use the scrap length settings to automatically keep your reserved
items and open stock clear of unusable lengths. The material at scrap
length or under is removed from the inventory and moved to the
inventory history. The scrap information is handy in evaluating a
project because it links to Project Summary report in Project
Management. Scrap settings may vary according to material size and
type.

d. In the Combining section, define the kerf, squaring amounts, and
clamp allowance according to your needs. 

Use the Combining settings to automatically calculate any material
length loss due to cutting and other manufacturing requirements.
The values defined in the Combining section are added to the cut
lengths for performing the combining run. Adding the waste involved
with managing materials may help to prevent material shortages.

Defining Combining settings is optional. If these settings are not
defined, return to stock lengths can be adjusted within the Take
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From Stock process while working in the Production Control
module or the Inventory module.

Select the Clamp Allowance from Part check box to allow the clamp
allowance to be included in any length of the part that exceeds the
clamp allowance. For example, if 6" pieces cut are cut from a 20' piece
that has a 24" clamp allowance, the 24" would be considered waste.
However, if there was a 36" piece cut with the 6" pieces, the 24" clamp
allowance would be part of the 36" piece.

NOTE The Valid Scrap % field should only be used in conditions
where extreme fine-tuning for the combining of materials is
necessary. This setting is connected to the combining
algorithms of Tekla EPM. Set Valid Scrap % to 0 unless the
Tekla EPM Support instructs you otherwise.

5. Click Save.

The new dimension is added to the Tekla EPM material database and shown in
the Dimension list for the selected shape.

See also

Modify dimension properties (page 138)

Modify the properties of multiple dimensions (page 140)

Modify dimension properties
In the Dimension dialog box, you can modify the different properties of
dimensions. These properties include the revaluation settings, the scrap
length, and the combining settings. The values that you set in the Dimension
dialog box are used for calculating material weight, pricing, and combining, so
accuracy is important.

1. In the shape list of the Shape / Grade / Size Maintenance dialog box,
select a shape.

2. Open the Dimensions tab.

3. In the Dimension list, select the dimension whose settings you want to
modify.

4. Click Edit Dimension.

5. In the Dimension dialog box, modify the dimension properties according
to your needs. 

Note that the available and mandatory fields the Dimension dialog box
vary according to the shape properties.

a. In the Revaluation section, modify the revaluation properties
according to your needs. 
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The revaluation settings discount the drop material by length by
applying a percentage of the drop cost to the job using the stock
length.

You can set the revaluation calculation to either a percentage of the
original value or a price for each length by selecting an option in the
Calc list. We recommend using the % option because it is easier to
maintain.

For example, the revaluation of a 15'-0 drop might be considered
worth 80% of the original price, and 10'-0 might be worth 50%. These
values are then used for evaluating the remaining stock materials in
the inventory for accounting purposes.

If you want all the drop material below a particular length to be
charged to the job where the original length was used, you can type
the desired length in the Charge Length field. If you want all drop
material to be charged to the job, typing 60' in the Charge Length
usually covers all items.

b. In the Scrap section, change the scrap length. 

Use the scrap length settings to automatically keep your reserved
items and open stock clear of unusable lengths. The material at scrap
length or under is removed from the inventory and moved to the
inventory history. The scrap information is handy in evaluating a
project because it links to Project Summary report in Project
Management. Scrap settings may vary according to material size and
type.

c. In the Combining section, modify the combining properties according
to your needs. 

Use the Combining settings to automatically calculate any material
length loss due to cutting and other manufacturing requirements.
The values defined in the Combining section are added to the cut
lengths for performing the combining run. Adding the waste involved
with managing materials may help to prevent material shortages.

Defining Combining settings is optional. If these settings are not
defined, return to stock lengths can be adjusted within the Take
From Stock process while working in the Production Control
module or the Inventory module.

Select the Clamp Allowance from Part check box to allow the clamp
allowance to be included in any length of the part that exceeds the
clamp allowance. For example, if 6" pieces cut are cut from a 20' piece
that has a 24" clamp allowance, the 24" would be considered waste.
However, if there was a 36" piece cut with the 6" pieces, the 24" clamp
allowance would be part of the 36" piece.

NOTE The Valid Scrap % field should only be used in conditions
where extreme fine-tuning for the combining of materials is
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necessary. This setting is connected to the combining
algorithms of Tekla EPM. Set Valid Scrap % to 0 unless the
Tekla EPM Support instructs you otherwise.

6. Click Save to update the dimension properties.

See also

Modify the properties of multiple dimensions (page 140)

Add dimensions (page 136)

Add grade overrides (page 141)

Add alternate dimensions (page 142)

Modify the properties of multiple dimensions
Use the Global Edit command to modify the settings of multiple dimensions
of a particular shape at once. For example, using the Global Edit command
can be useful when changing the revaluation settings for all dimensions of a
shape.

NOTE The Global Edit command is only available for shapes that belong to
the Plate and Angle material groups. For other material groups, you
need to modify each dimension separately.

1. In the Shape / Grade / Size Maintenance dialog box, click the Shape /
Grade / Size Maintenance ribbon tab.

2. On the menu, select Global Edit.

3. In the Shape list at the top of the Shapes / Grades / Sizes Global Edit
dialog box, select the shape whose dimensions you want to modify.

4. Click the arrow buttons to move the dimensions that you want to modify
to the Included list.

5. Modify any dimension properties according to your needs. 

For example, you can modify the scrap length or the kerf.

6. Select check boxes next to the properties that you want to update.

7. Click Update.

The dimensions in the Included list are updated according to the changes you
made.

See also

Modify dimension properties (page 138)
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Update dimension weights for newly added shapes
Use the Global Edit - Dimension Values command to update the unit weights
of material groups when material weight standards change. For example, you
can use the Global Edit - Dimension Values command to update the weights
of newly added shapes. Tekla EPM then calculates the weights based on the
existing dimensions.

1. In the Shape / Grade / Size Maintenance dialog box, click the Shape /
Grade / Size Maintenance ribbon tab.

2. In the menu, select Global Edit - Dimension Values.

3. In the list at the top of the Shapes / Grades / Sizes Global Edit -
Dimension Values dialog box, select the desired shape.

4. In the Material list, select the desired material group.

5. In the field on the right side of the Material list, define the weight of the
material.

6. Click the arrow buttons to move the dimensions whose weights you want
to update to the Included list.

7. Click Save.

Add grade overrides
Grade overrides allow Tekla EPM to assign a specific unit weight for a
particular dimension. Grade overrides should only be used for shapes that do
not have linear unit weights, such as stainless steel.

NOTE When you add a grade override, the cost to discount is still applied to
the job using the original length of the dimension.

1. In the shape list in the Shape / Grade / Size Maintenance dialog box,
select a shape.

2. Open the Dimensions tab.

3. In the Dimension list, select a dimension.

4. Open the Grade Overrides tab on the right side of the dialog box.

5. Click Add.

6. In the Grade list of the Grade Override dialog box, select a grade.

7. In the Override Unit Weight, type a weight.

8. Click Save.

The new grade override is added to the material database and shown in the
list on the Grade Overrides tab.

See also

Add dimensions (page 136)
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Add grade redirections (page 133)

Add alternate dimensions (page 142)

Modify dimension properties (page 138)

Delete dimensions (page 143)

Add alternate dimensions
If a dimension in a bill of materials that you want to import has a different
description than in Tekla EPM, problems might occur when importing the file.
Adding alternate dimensions enables Tekla EPM to cross-reference to the
same dimension, and that way, identify the dimension.

1. In the shape list in the Shape / Grade / Size Maintenance dialog box,
select the shape.

2. Open the Dimensions tab.

3. In the Dimension list, select a dimension.

4. Open the Alternates tab.

5. Below the existing alternate dimensions, click Add.

6. Type the description that will cross-reference to the selected dimension.

7. Click OK.

The new alternate dimension is added to the material database and shown in
the Dimension Alternate list.

See also

Add dimensions (page 136)

Add grade overrides (page 141)

Show where grades and dimensions are used
If you cannot delete a grade or a dimension from the material database
because it is used somewhere else in Tekla EPM, you can view the jobs in
which the grade or dimension is used.

1. In the shape list in the Shape / Grade / Size Maintenance dialog box,
select a shape.

2. Depending on whether you want to view the jobs that use a particular
grade or a particular dimension, open the Grades or Dimensions tab.

3. Select the grade or dimension.

4. Click the Shape / Grade / Size Maintenance ribbon tab.

5. In the menu, select Show Where The Selected Dimension/Grade Is
Used. 

A dialog box opens, listing the jobs where the grade or dimension is used.
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6. Once you have viewed the locations, click OK to close the dialog box.

You can change the grade or dimension used in the listed jobs, so that it is
safe to delete the selected grade or dimension from the material database.

If necessary, you can also delete the grade or dimension even if it is used
somewhere else in Tekla EPM by using the Force Delete command.

See also

Delete dimensions (page 143)

Delete dimensions
If necessary, you can delete existing dimensions from the Tekla EPM material
database.

1. In the shape list of the Shape / Grade / Size Maintenance dialog box,
select the shape.

2. Open the Dimensions tab.

3. In the Dimension list, select the dimensions that you want to delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

4. Click Delete Dimension in the lower-right corner of the dialog box.

5. To permanently delete the dimensions, click Yes in the confirmation
dialog box. 

If a single dimension that you are trying to delete is used somewhere else
in Tekla EPM, a notification message appears and allows you to see where
the dimension is used.

If multiple dimensions that you are trying to delete are used somewhere
else in Tekla EPM, notification messages appear, telling you that the
dimensions are used somewhere else in Tekla EPM. Then, deleting the
selected dimensions is canceled.

6. To view where the single dimension is used, click OK. 

A dialog box opens, displaying the jobs where the dimension is used.

7. Do one of the following:

• View where the dimension is used, and click OK to close the dialog box
without deleting the dimension.

• If you are sure that you want to delete the dimension, click Force
Delete, select the new dimension that will be used elsewhere in Tekla
EPM instead of the dimension that you are deleting, and click Perform
Force Delete.
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See also

Add dimensions (page 136)

Manage material reports
While in the Shape / Grade / Size Maintenance dialog box, you can create
various material reports, such as shape lists. After creating the reports, you
can view, print, email, or export them in Tekla EPM Report Viewer.

See also

Create material reports (page 144)

View material reports (page 145)

Print material reports (page 145)

Send material reports via email (page 146)

Export material reports (page 146)

Create material reports
You can create various types of material reports in Tekla EPM, such as shape
lists and size lists.

1. While in the Shape / Grade / Size Maintenance dialog box, click the
Shape / Grade / Size Maintenance ribbon tab.

2. In the menu, select Reports. 

The Report Filters dialog box opens.

3. To only include specific materials in the reports, in the Report Filters
dialog box, select a filter type in the Type list, and click Select.

4. In the Filter dialog box, click the arrow buttons to move the material
items that you want to include in the reports to the Included list.

5. Click OK. 

To further limit the included items, repeat steps 3 to 5 for all necessary
filter types in the Report Filters dialog box.

6. Click Make Report.

7. In the Report Selection dialog box, click the report that you want to
create.

Next, you can view the report, print or export the report, or send the report via
email in Microsoft Outlook.

See also

View material reports (page 145)

Print material reports (page 145)

Send material reports via email (page 146)
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Export material reports (page 146)

View material reports
Once you have created a material report, you can view it in Tekla EPM Report
Viewer.

1. Create a report. 

For detailed instructions, see Create reports (page 144).

2. In the Report Selection dialog box, click View.

3. In Tekla EPM Report Viewer, do any of the following according to your
needs: 

To Do this
Move between pages • Click the arrows at the top of

Tekla EPM Report Viewer.
Go to a specific page of the report • Type the page number in the

empty field at the top of Tekla
EPM Report Viewer.

Find a text in the report a. Click the binocular icon.

b. In the blank field, type the text
that you want to find.

c. Click Find Next.

Any matching text is highlighted
with a red box.

Zoom in or out • Click the magnifying glass icon and
select the zoom value in the list.

Once you have viewed the report, you can close Tekla EPM Report Viewer, or
print, email, or export the report.

See also

Print material reports (page 145)

Send material reports via email (page 146)

Export material reports (page 146)

Print material reports
To print a material report in Tekla EPM Report Viewer, do the following:

1. Create a report. 

For detailed instructions, see Create reports (page 144).

2. In the Report Selection dialog box, click View.

3. At the top of Tekla EPM Report Viewer, click Print Report.
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4. Select the printer that you want to use.

5. Define the pages that you want to print.

6. If necessary, modify other printer settings.

7. Click Print.

See also

Send material reports via email (page 146)

Export material reports (page 146)

Send material reports via email
You can send material reports via email as either Microsoft Excel workheets or
PDF files. Note that the Email Excel and Email PDF commands only work with
Microsoft Outlook. If you use some other email service, you need to export the
report and attach it to an email manually.

1. Create a report. 

For detailed instructions, see Create reports (page 144).

2. In the Report Selection dialog box, click View.

3. In the upper-right corner of Tekla EPM Report Viewer, click either Email
Excel or Email PDF. 

When the report is ready, the Microsoft Outlook icon appears at the
bottom of the screen.

4. Click the icon to open Microsoft Outlook.

5. Modify the email according to your needs.

6. Send the email.

Export material reports
You might need to export a report, such as a shape list, to send it to the steel
detailer. This way, they will have all the shape information used in Tekla EPM.
Having the shape list will minimize the need to create new shape descriptions
and abbreviations, grade abbreviations, substitutions, and redirections in
Tekla EPM.

1. Create a report. 

For detailed instructions, see Create reports (page 144).

2. In the Report Selection dialog box, click View.

3. In the upper-left corner of Tekla EPM Report Viewer, click Export
Report.

4. In the Save As dialog box, browse to the folder where you want to save
the file.

5. If necessary, change the file name.
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6. If necessary, select another file format in the Save as type list.

7. Click Save.

The report is saved to the selected location.

Change the display units of prices
Use the Change command to change the display units of a shape used in
pricing. Changing the display units is useful for items like HSS, as the pricing is
often by foot rather than by pound or hundredweight. Where applicable,
pricing by item is also available.

1. In the Shape / Grade / Size Maintenance dialog box, select the shape
whose display units you want to change.

2. In the upper-right corner of the dialog box, click Change.

3. In the New Display Units list, select the desired units.

4. Click OK.

The units used in the pricing of the shape are updated.

The selected pricing units are used in requisitions, purchase orders, and
inventory.

Set up pricing
The material database used in Pricing Maintenance contains a variety of pre-
loaded material shapes. However, only the most commonly used shapes are
available in Pricing Maintenance by default. Missing material shapes should
be added to Pricing Maintenance in order to combine materials in several
Tekla EPM modules. If the required material shapes, grades, sizes, and lengths
are not available in Pricing Maintenance, Tekla EPM cannot combine
materials. We recommend that you set up the Pricing Maintenance database
as early as possible, so that working in Tekla EPM becomes more seamless.

You can add new shapes, grades, sizes, lengths, and pricing information to the
Pricing Maintenance database.

Note that you can create and use multiple pricing data sets in Tekla EPM. The
pricing data sets are referred to as supplier warehouses in Tekla EPM. Despite
their name, supplier warehouses can also represent pricing that is for pricing
tiers or other purposes. Supplier warehouses they can be labeled in different
ways according to their purpose.

Note that the supplier warehouse labeled Warehouse is meant for items that
need to be purchased, not items that are in the company's warehouse.

You can update the pricing of multiple items by importing pricing information,
or by using the Global Edit and Global Edit Form commands. You can also
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update pricing while working in the Purchasing module, in the Estimating
module, or while creating pricing forms.

For more information, see the following links:

Open Pricing Maintenance (page 148)

Add a supplier warehouse (page 164)

Find shapes, grades, and dimensions in Pricing Maintenance (page 149)

Manage material dimensions in pricing (page 150)

Modify lengths and pricing (page 152)

Create pricing forms (page 158)

Create and manage pricing lists (page 160)

Open Pricing Maintenance
In Pricing Maintenance, you can add the material sizes and lengths that you
want to use when combining materials in Tekla EPM.

1. Click the Maintenance ribbon tab.

2. On the menu, select Pricing Maintenance.

3. In the Select Supplier dialog box, select a pricing warehouse.

4. Double-click the pricing warehouse, or click Open.

5. In the Pricing Maintenance dialog box, click the + signs to expand the
options in the navigation tree:

• Click + next to a material shape to view its grades.

• Click + next to a material grade to view its dimensions.

6. Select the material dimension that you want to view or modify.
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The properties of the selected material dimension appear on the right side of
the dialog box.

You can also see the shape and grade of the material dimension at the upper-
left corner, and the latest pricing updates at the upper-left corner.

Find shapes, grades, and dimensions in Pricing Maintenance
You can use the Find Shape/Grade/Size command in the Pricing
Maintenance dialog box to find a particular material shape, grade, or
dimension.

1. In the Pricing Maintenance dialog box, click Find Shape/Grade/Size.

2. In the Find dialog box, do one of the following:
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• Type the name of the material shape, grade, or dimension in the
related field.

• Click the arrow on the right side of the related field, and select the
desired material shape, grade, or dimension in the list.

3. Click Find.

The shape, grade, or dimension is selected in the shape list on the left side of
the Pricing Maintenance dialog box.

Manage material dimensions in pricing
You can manage material dimensions in the pricing database in several ways:
you can add material dimensions either one by one or as groups, copy
dimensions from one material grade to another, or remove unnecessary
material dimensions from the pricing database.

For more information, see the following links:

Add a single material dimension to pricing (page 150)

Add material dimensions to pricing (page 151)

Copy material dimensions from one grade to another (page 151)

Delete material dimensions from pricing (page 152)

Add, modify, and delete material lengths and pricing information for a
dimension (page 152)

Add a single material dimension to pricing
By default, only the most commonly used shapes are available in Pricing
Maintenance. However, you can add new shapes that you need when
combining materials in Tekla EPM.

NOTE Only material dimensions that are available in the material database
(page 115) can be added to pricing.

1. Below the Shape list in the Pricing Maintenance dialog box, select a
grade and click Add.

2. In the Shape list, select the shape whose dimensions you want to add.

3. Click the Dimensions field. 

The Shape dialog box opens, displaying the available material
dimensions.

4. Double-click the dimension that you want to add.

5. Ensure that the grade in the Grade list is correct. If not, select the correct
grade in the Grade list.

6. Click Save.
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The shape, grade, and dimension are added to the navigation tree and the
pricing database.

Now, you can add lengths and pricing information for the newly added
dimension. For more information, see Add, modify, and delete material
lengths and pricing information for a dimension (page 152).

Add material dimensions to pricing
By default, only the most commonly used shapes are available in the pricing
database and the Pricing Maintenance dialog box. However, you can add
new material dimensions to the pricing database, if needed.

NOTE Only material dimensions that are available in the material database
(page 115) can be added to pricing.

1. Below the Shape list in the Pricing Maintenance dialog box, click Add.

2. In the Shape list in the Select Shape dialog box, select the shape whose
dimensions you want to add.

3. In the Grade list in the Select Grade dialog box, select the material grade
whose dimensions you want to add.

4. In the Select the sizes to add dialog box, click the arrow buttons to move
the dimensions that you want to add to the Included list.

5. Click OK.

The selected dimensions are added to the pricing database and appear in the
Pricing Maintenance dialog box. Next, you need to add lengths and pricing
information for the added dimensions (page 152).

Copy material dimensions from one grade to another
Use the Copy Sizes command to copy a list of dimensions and their pricing
information from one material grade to another.

1. In the Pricing Maintenance dialog box, click the Pricing ribbon tab.

2. On the menu, select Copy Sizes.

3. In the Select the sizes to copy dialog box, click the arrow buttons to
move the dimensions that you want to add to the Included list.

4. Click OK.

5. In the New Grade list, select the material grade to which the dimensions
will be copied.

6. Click OK.

7. If the new grade already has dimensions in the current supplier
warehouse, select if you want to overwrite the existing dimensions (Yes)
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or only add dimensions that do not yet exist in the supplier warehouse
(No). 

A message appears, telling you that the selected dimensions have been
copied to the new grade.

8. Click OK to close the message.

The pricing of the dimensions in the new material grade matches the pricing of
the original material grade. If necessary, update the pricing either item by item
or by using the Global Edit command. For more information, see Add, modify,
and delete material lengths and pricing information for a dimension
(page 152) or Modify the pricing of multiple items (page 155).

Delete material dimensions from pricing
You can permanently delete unnecessary material dimensions and their
pricing information from the pricing database. Note that the dimensions are
not automatically deleted from the material database.

1. In the Shape list of the Pricing Maintenance dialog box, do one of the
following: 

• To delete one dimension, select the dimension.

• To delete all dimensions of a particular grade, select the grade.

• To delete all dimensions of a particular shape, select the shape.

2. Below the Shape list, click Delete.

3. To permanently delete the dimensions and their pricing information from
the pricing database, click Yes in the confirmation dialog box.

Note that the dimensions and the material grade need to be separately
deleted from the material database. For more information, see Delete
dimensions (page 143) and Add, modify, and delete grades (page 130).

Modify lengths and pricing
You can add, modify, and delete material lengths and pricing information in
two ways: either one dimension at the time, or by selecting multiple grades
and dimensions of a shape. If necessary, you can also add special prices for
lengths.

For more information, see the following links:

Add, modify, and delete material lengths and pricing information for a
dimension (page 152)

Add a special price (page 155)

Modify the pricing of multiple items (page 155)
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Add, modify, and delete material lengths and pricing information for a
dimension
You can add new purchasable material lengths or modify the existing lengths
in Pricing Maintenance. Ensure that you add all lengths that you need when
combining materials in the Tekla EPM modules. When adding lengths, it is
important to also define the pricing. Otherwise, Tekla EPM will consider the
material free. You can also delete any unnecessary lengths from the pricing
database.

NOTE To make wholesale changes to multiple dimensions by shape, use the Global
Edit command. For more information, see Modify the pricing of multiple
items (page 155).
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Add a material length and its pricing information

1. In the shape list in the Pricing Maintenance dialog box, select a shape
and a dimension. 

The existing lengths of the dimension are shown in the length list on the
right side of the Pricing Maintenance dialog box.

2. Below the length list, click New.

3. If only limited quantities of the material dimension are available, type a
value in the Quantity field. 

Otherwise, leave the Quantity field blank.

If you do not define a quantity, the Quantity column for the lengths of
the material dimension will show an asterisk (*). This means that Tekla
EPM allows an unlimited number of lengths.

4. In the Length field, type the material length. 

For some shapes, you may also need to define the material width.

5. In the Normal Price field, type a price for the dimension. 

TIP You can right-click the Normal Price field to change or convert the
pricing units and currencies.

6. If necessary, type a price in the Special Price field and click Save. 

Note that the price in the Special Price field overrides the price in the
Normal Price field.

7. To determine that the selected dimension is always bought from the
current supplier, select the Always Buy This Size From [Supplier] check
box. 

If you select the Always Buy This Size From [Supplier] check box for the
material dimension in another supplier warehouse, the Always Buy This
Size From [Supplier] check box is automatically cleared in the previous
supplier warehouse.

8. Click Add.

The length and price are added for the selected dimension.

Modify a material length and its pricing information

1. In the shape list in the Pricing Maintenance dialog box, select a shape
and a dimension. 

The existing lengths of the dimension are shown in the length list on the
right side of the Pricing Maintenance dialog box.

2. Select a length in the length list.

3. Modify the length, the quantity, and the pricing properties according to
your needs.
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4. To save the changes, click Edit below the length list.

Delete a material length and its pricing information

1. In the shape list in the Pricing Maintenance dialog box, select a shape
and a dimension. 

The existing lengths of the dimension are shown in the length list on the
right side of the Pricing Maintenance dialog box.

2. Select a length in the length list.

3. Below the length list, click Delete.

4. To permanently delete the selected length and its pricing information
from this supplier in the pricing database, click Yes in the confirmation
dialog box.

Add a special price
If you have selected the Use Special Price option for the selected supplier,
you can add a special price for a material dimension. Note that the special
price overrides the normal price that you have defined for the dimension.

TIP If you want to add the same special price for multiple dimensions at one
go, use the Global Edit command. For more information, see Modify the
pricing of multiple items (page 155).

1. In the shape list in the Pricing Maintenance dialog box, select a shape
and a dimension. 

The existing lengths of the dimension are shown in the length list on the
right side of the Pricing Maintenance dialog box.

2. Type a price in the Special Price field.

3. Under the length information, click Edit.

The special price is saved for the selected material dimension. Note that the
special price will be used instead of the normal price until you remove the
special price.

Modify the pricing of multiple items
Use the Global Edit command to modify pricing, available lengths for linear
items and available lengths and widths for nested items, and to select whether
a material dimension is always bought from a particular supplier.

NOTE When you are using multiple supplier warehouses in Pricing
Maintenance, you need to maintain the pricing of shapes in each
warehouse separately.

The pricing information is used for multing and nesting material in
multiple Tekla EPM modules. You can still combine the items with
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updated pricing to any inventory or purchase order items, or manually
combine the items in a requisition.

If you are combining material items to the specific supplier warehouse
and the items in the modules do not match with the items that are
available in the supplier's data set, Tekla EPM cannot combine the
materials.

1. In the Pricing Maintenance dialog box, click the Pricing ribbon tab.

2. On the menu, select Global Edit.

3. In the Shape list at the top of the Pricing Global Edit dialog box, select
the shape whose grades and dimensions you want to modify. 

The grades and dimensions of the shape appear in the dialog box.

4. In the Grades section, click the arrow buttons to move the grades that
you want to modify to the Included list.

5. In the Dimensions section, click the arrow buttons to move the
dimensions that you want to modify to the Included list.

6. In the Operation list in the lower-light corner, select an option: 

• Increase By Percentage: Increases the prices of the selected items by
a specific percentage.

Start using Tekla EPM 156 Adjust the initial settings



• Decrease By Percentage: Decreases the prices of the selected items
by a specific percentage.

• Increase By Amount: Increases the prices of the selected items by a
certain sum.

• Decrease By Amount: Decreases the prices of the selected items by a
certain sum.

• Set Amount: Sets the prices of the selected items to a specific sum.

• Set Quantity: Allows Tekla EPM to only use a specific number of the
selected lengths.

• Set Lengths: Allows you to add lengths for the selected items either
one by one or as a range.

• Set Lengths (No Price): Allows you to add lengths for the selected
items either one by one or as a range. No pricing information is added.

• Set Always Buy: Allows you to determine that the selected dimensions
are always bought from the current supplier. To do so, select the
Always Buy From [Supplier] check box.

If you select the Always Buy From [Supplier] check box for the same
dimensions in another supplier warehouse, the Always Buy From
[Supplier] check box is automatically cleared in the previous supplier
warehouse.

When you have selected the operations, the applicable fields are shown at
the bottom of the dialog box.

7. Depending on the operation you selected, modify the pricing information. 

TIP You can right-click the Amount field to change or convert the pricing
units and currencies.

8. Click Save.

Example: Set lengths

1. Select the Set Lengths option.

A length list appears on the left side of the dialog box.

2. Click New.

3. Do one of the following:

To Do this
Add lengths one by one a. If the lengths only apply to a fixed

quantity of items, type the
quantity in the Quantity field.
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To Do this
b. Define the length and the normal

price.

You can right-click the Normal
Price field to change or convert
the pricing units and currencies.

c. Click Add to add the length and
its pricing information to the list.

Add multiple lengths with the same
interval

a. Click Add Range.

b. In the Add Range dialog box,
define the start and end lengths.

c. Define the interval length.

d. If necessary, define the quantity
of items to which the range will
apply.

e. Define the normal price.

TIP You can right-click the
Normal Price field to
change or convert the
pricing units and
currencies.

f. Click Add Range.

4. When you have added all necessary lengths and pricing information, click
Save.

The length and pricing of the selected items are updated.

Create pricing forms
Use the Global Edit Form command to apply group-specific pricing for
different material dimensions. For example, when updating pricing for groups
of HSS shapes, the shapes that are either smaller or larger than the commonly
used dimensions may need different pricing updates. By creating and using
pricing forms, you can update each group of HSS shapes accordingly. You can
create one pricing form that contains multiple shapes whose pricing you want
to update in the current supplier warehouse, or pricing data set.

Creating pricing forms becomes even more efficient when you update the
pricing from a requisition or a purchase order, as you can update multiple
shapes and dimensions at one go.

1. In the Pricing Maintenance dialog box, click the Pricing ribbon tab.

2. On the menu, select Global Edit Form.
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3. At the bottom of the Global Edit Form dialog box, click New Form.

4. Type a name for the new form and click OK.

5. If another form already exists and you want to copy its content, click Yes
in the confirmation dialog box.

6. On the right side of the Global Edit Form dialog box, click New Price.

7. In the Shape list, select a shape.

8. Click the Start field, and double-click the smallest dimension to which the
new price applies.

9. Click the End field, and double-click the largest dimension to which the
new price applies.

10. In the Price field, type the price. 

TIP To change the units for the price, right-click the Price field and select
a suitable option.

11. To save the changes, click Save Form. 

Repeat steps 6 to 11 for different dimensions of the selected shape and
other shapes. You can see an example pricing form in the following
image.
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12. When you have added all the necessary forms and prices, click Perform
Global Edit.

The pricing of the selected items is updated. The pricing forms that you
created are saved for later use.

Create and manage pricing lists
You can view, email, or print the information in a supplier pricing database as
a pricing list. You can filter the pricing list by shape to see a list of pricing for all
dimensions of the selected shape, or leave the pricing list unfiltered to create a
list containing all pricing information.

See also

Import a pricing list (page 162)

Create a pricing list

1. In the Pricing Maintenance dialog box, click the Pricing ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. If you only want to display selected items in the report, select a filter type
in the Type list, and click Select.

4. In the Filter dialog box, click the arrow buttons to move the items that
you want to include in the pricing list to the Included list.

5. Click OK.

6. Click Make Report.

Tekla EPM creates the pricing list, and the Report Selection dialog box opens.
Here, you can view, print, or export the pricing list.

View the pricing list

1. In the Report Selection dialog box, click View.

2. In Tekla EPM Report Viewer, do any of the following according to your
needs: 

To Do this
Move between pages • Click the arrows at the top of

Tekla EPM Report Viewer.
Go to a specific page of the report • Type the page number in the

empty field at the top of Tekla
EPM Report Viewer.

Find a text in the report a. Click the binocular icon.

b. In the blank field, type the text
that you want to find.
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To Do this
c. Click Find Next.

Any matching text is highlighted
with a red box.

Zoom in or out • Click the magnifying glass icon and
select the zoom value in the list.

Print the pricing list

1. In the Report Selection dialog box, change the number of printed copies
by clicking the + and - buttons.

2. If necessary, click Select Printer, select which device you want to use for
printing, and click OK. 

You can also select Default Printer to always use the default printer with
this report, or No Printer to reset the used printer.

3. Click Print.

4. Click Yes.

Export the pricing list

1. Click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Browse to the location where you want to save the exported file, and click
Save.

5. Modify the file name according to your needs.

6. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email check box.

7. To open the file after exporting it, select the Open Exported Document
check box.

8. To export the pricing list and save it to the selected location, click Export.

Email the pricing list as an Excel worksheet or a PDF file

Note that the Email Excel and Email PDF commands only allow you to send
the pricing list via Microsoft Outlook email. If you use some other email
service, you need to export the pricing list and attach it to an email manually.

1. In the Report Selection dialog box, click View.

2. In the upper-right corner of Tekla EPM Report Viewer, click either Email
Excel or Email PDF. 

When the report is ready, the Microsoft Outlook icon appears at the
bottom of the screen.
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3. Click the icon to open Microsoft Outlook.

4. Modify the email according to your needs.

5. Send the email.

Import a pricing list
You can import a pricing list that has been revised by a supplier or that has
user-modified pricing. Pricing lists can be imported either from Microsoft Excel
or from an XML file. During the import, Tekla EPM overwrites the current
pricing of the material items in the imported file. The pricing of material items
that are not included in the file does not change.

We recommend that you start by exporting the pricing list from Tekla EPM,
modifying it, and importing it back to Tekla EPM. By doing so, you can ensure
that the format and header information will match the headers in Tekla EPM
when you import the modified pricing list back to Tekla EPM.

Note that the format of the pricing list that you import needs to match the
pricing format in the pricing list or in the pricing Pricing Maintenance dialog
box.

Import a pricing list from Microsoft Excel

1. Click the Maintenance ribbon tab.

2. On the menu, select Pricing Maintenance.

3. In the Select Supplier dialog box, click the Pricing ribbon tab.

4. On the menu, go to Import Pricing --> Import Pricing From Excel File.

5. In the Open dialog box, browse to find the Microsoft Excel worksheet that
contains the pricing list.

6. Select the file and click Open. 
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Tekla EPM reads the Microsoft Excel worksheet. Once the reading is
finished, the Verify Excel Import Data dialog box opens.

7. Review the items being imported, and click OK. 

The Import Field Map dialog box opens.

In the Import Field Map dialog box, the headings of the Microsoft Excel
worksheet need to be mapped to the standard Tekla EPM fields.

8. If the values of an item in the Import Field and Tekla EPM Field columns
are different, do the following:

a. Select the unmatched Import Field value.

b. On the right side of the dialog box, select a suitable field in the Tekla
EPM Field list.
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c. Click Set Field Mapping.

Repeat steps a to c for all import fields that are not matched.

9. Click OK to continue.

10. In the Select Supplier dialog box, select the supplier warehouse for which
the new pricing list is imported.

11. Click Import. 

The Import dialog box opens, and Tekla EPM continues importing the
information from the Microsoft Excel worksheet.

When the import is finished, the Import dialog box states that the import
is completed. A copy of the import log is automatically saved in the log file
location determined in the Default Directories dialog box.

12. To close the Import dialog box, click the Close button (X) in the upper-
right corner.

Import from an XML file

1. Click the Maintenance ribbon tab.

2. On the menu, select Pricing Maintenance.

3. In the Select Supplier dialog box, click the Pricing ribbon tab.

4. On the menu, go to Import Pricing --> From XML File.

5. In the Open dialog box, browse to find the XML file that contains the
pricing list.

6. Select the XML file and click Open.

7. In the Select Supplier dialog box, select the supplier warehouse for which
the new pricing list is imported.

8. Click Import. 

Tekla EPM imports the items from the XML file. The import process may
take some time.

When the import is finished, the Import dialog box states that the import
is completed. A copy of the import log is automatically saved in the log file
location determined in the Default Directories dialog box.

9. To close the Import dialog box, click the Close button (X) in the upper-
right corner.
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Add a supplier warehouse
Use the Pricing Type Maintenance command to add a supplier warehouse,
or pricing set, to the pricing database.

Note that you can also modify and delete existing supplier warehouses in the
Pricing Type Maintenance dialog box.

1. Click the Maintenance ribbon tab.

2. On the menu, select Pricing Maintenance.

3. In the Select Supplier dialog box, click the Pricing ribbon tab.

4. On the menu, select Pricing Type Maintenance.

5. At the bottom of the Pricing Type Maintenance dialog box, click New.

6. In the Description field, type the name of the new supplier. 

7. If you want the supplier warehouse to allow adding special prices for
material dimensions, select the Use Special Price check box.

8. To allow pricing material dimensions in an estimate that do not exist in
the selected supplier warehouse, select the Use next larger size if no
exact match check box.

9. If you are using multiple currencies in Tekla EPM, in the Currency list,
select the currency that the new supplier warehouse will use.
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10. Select the Copy Data From check box, and select which existing supplier
you want to use as the basis of the new supplier warehouse.

11. Click Add. 

The new supplier is added to the list.

12. To close the Pricing Type Maintenance dialog box, click the Close button
(X) in the upper-right corner.

The new supplier warehouse is now available in the Select Supplier dialog
box, and you can modify the pricing of the new supplier warehouse according
to your needs.

See also

Manage material dimensions in pricing (page 150)

Modify lengths and pricing (page 152)

Create pricing forms (page 158)

Set the default printer
You can set or change the default printer for the current workstation. Setting a
default printer for a workstation is optional.

1. Click the Administration ribbon tab.

2. On the File menu, select Default Printer.

3. To select or change the default printer, in the dialog box, click Change.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

6. To confirm using the selected printer as the default printer, in the Default
Printer dialog box, click OK.

Set the standard categories for attached documents
Document Index in Tekla EPM allows you to organize and save documents for
a job in the Combining, Estimating, Order Entry, Project Management,
Production Control, and Purchasing modules. The standard categories
where you can organize documents need to be set separately for each
module.

1. Click the Maintenance ribbon tab.

2. On the menu, go to Document Index, and select any of the following:

• Standard Categories - CMB: set the categories for organizing
documents related to combining jobs.
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• Standard Categories - EST: set the categories for organizing
documents related to estimating jobs.

• Standard Categories - ORD: set the categories for organizing
documents related to customer orders.

• Standard Categories - PRJ: set the categories for organizing
documents related to project management jobs.

• Standard Categories - PDC: set the categories for organizing
documents related to production control jobs.

• Standard Categories - REQ: set the categories for organizing
documents related to requisitions.

• Standard Categories - PO: set the categories for organizing
documents related to purchase orders.
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The Document Index - Edit Categories dialog box opens.

Add a category
1. In the Document Index - Edit Categories dialog box, select the category

under which you want to create the new category.

2. At the bottom of the dialog box, click New.

3. In the New Category dialog box, type a name for the category.

4. Click OK to add the category.
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Rename a category
1. In the Document Index - Edit Categories dialog box, select the category

that you want to rename.

2. Click Rename.

3. In the New Category dialog box, type a new name for the category.

4. Click OK to update the name.

Delete a category
Note that deleting a category is permanent and cannot be undone.

1. In the Document Index - Edit Categories dialog box, select the category
that you want to delete.

2. Click Delete.

3. To permanently delete the category, click Yes in the confirmation dialog
box.

4.3 Manage the address book
Use the Address Book to define and manage the companies and contacts
used in all Tekla EPM modules. We recommend that you set up the address
book as early as possible, so that working in Tekla EPM becomes more fluent
and efficient.

To access the Address Book, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Address Book.

The Address Book dialog box opens.
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The main components of the Address Book dialog box are:

(1) The navigation tree: allows you to only view specific companies.

Click + to expand and select options in the navigation tree. When you select an
option, only companies that match the selected option are displayed.

For example, you can expand Firm Type and select Supplier to only display
suppliers.

(2) The firm type: tells Tekla EPM where the company information should be
used.

For more information, see View firm types (page 171).

(3) Red cells: indicate companies that are over their assigned credit limit.

(4) The Properties button: allows you to view the current company properties
and credit settings and modify them.

(5) The Contacts button: allows you to switch to a view where the contact
persons of the companies are displayed.

Note that you can customize the layout of the Address Book dialog box. For
more information, see Customize the layout of a dialog box (page 214).

For more information, see the following links:

Find companies or contacts (page 171)

View firm types (page 171)

Add companies to the address book (page 172)

Add contacts to the address book (page 173)

Modify company or contact properties (page 174)

Import contacts to the address book (page 174)
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Export companies or contacts (page 175)

Delete companies or contacts from the address book (page 176)

Find companies or contacts
You can use the Find Company and Find Contact commands to quickly find
and select the correct company or contact in the Address Book dialog box.

Find companies
1. In the Address Book dialog box, click the Address Book ribbon tab.

2. On the menu, select Find Company.

3. Select if you want to search companies by name or by company code.

4. Type the company name or company code in the empty field, or click the
arrow on the right side of the field and select the company in the list.

5. Click OK.

The company is selected in the Address Book dialog box.

Find contacts
1. In the Address Book - Contacts dialog box, click the Address Book

Contacts ribbon tab.

2. On the menu, select Find Contact.

3. Type the contact name in the empty field, or click the arrow on the right
side of the field and select the contact in the list.

4. Click OK.

The contact is selected in the Address Book - Contacts dialog box.

View firm types
The various firm types in the address book are used in different modules in
Tekla EPM. Use the Firm Types command to quickly view the different firm
types and where they can be used.

1. While in the Address Book dialog box, click the Address Book ribbon tab.

2. On the menu, select Firm Types.

3. In the Firm Types dialog box, review the firm types and where they can
used in Tekla EPM.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.
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Add companies to the address book
To add new companies to the address book and define their properties, do the
following:

1. At the bottom left corner of the Address Book dialog box, click New.

2. On the General of the Firm Details dialog box, select a suitable firm type
in the Firm Type list. 

Firm types help Tekla EPM to sort the list of companies in the address
book. For more information, see View firm types (page 171).

TIP You can add more than one firm type for a company. For example, a
steel detailer can be added as both a detailer for Project
Management and as a supplier for purchase orders.

3. Type a name and a code for the company. 

The company code can be any value. For example, you can use the
accounting code of the company.

Note that you cannot use the same company code for two companies that
have the same firm type.

4. Select a primary currency type for the company.

5. If necessary, modify the credit limit of the company, and add any
additional notes regarding the company.

6. Open the Addresses tab.

7. Click New Address.

8. Type a description for the address and enter other necessary contact
information. 

Sometimes, it might be useful to have multiple addresses for a client. For
example, if a client has different production control jobs, they can have
multiple jobsite addresses that you should ship materials to. In these
situations, you can use the jobsite names or job numbers as the
descriptions of the jobsite addresses.

Remember to add the jobsite contacts on the Contacts tab. For more
information, see Add new contacts to the address book (page 173).

9. Select one of the available check boxes to define if the address is a
shipping or mailing address.

10. Select the Active check box. 

If you do not select the Active check box, the address will not be available
for use anywhere in Tekla EPM.

11. Click Save Address.
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12. On the Contacts tab, add contacts for the company. 

For more information, see Add new contacts to the address book
(page 173).

13. Click Save.

The Firm Details dialog box closes. The new company is saved to the address
book.

See also

Modify company or contact properties (page 174)

Add contacts to the address book
You can add new contact persons either when adding or modifying company
properties, or in the Address Book - Contacts dialog box. You can also view
all existing contacts by clicking the Contacts tab at the bottom of the Address
Book dialog box.

You can also import contacts to the address book. For more information, see
Import contacts to the address book (page 174).

Add a new contact person in the company properties
1. In the Firm Details dialog box, go to the Contacts tab.

2. Click New Contact.

3. Type the name and contact information of the new contact person.

4. If the contact person is an inspector, select the Inspector check box and
add an inspector ID.

5. Select the Active check box. 

If you do not select the Active check box, you cannot select the contact
person anywhere in Tekla EPM.

6. To save the contact person and add the contact person to the list of
contacts, click Add Contact.

7. In the Default Contact list, select a default contact person for the
company.

8. Click Save. 

The Firm Details dialog box closes.

Add a new contact person in the contact list
1. At the bottom of the Address Book, click Contacts.
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2. In the lower-left corner of the Address Book - Contacts dialog box, click
New.

3. In the Contact Details dialog box, select the firm type and company for
the new contact person. 

4. Type the contact person's name and contact information.

5. If the contact person is an inspector, select the Inspector check box and
add an inspector ID.

6. Select the Active check box. 

If you do not select the Active check box, you cannot select the contact
person anywhere in Tekla EPM.

7. Click Save.

The Contact Details dialog box closes. The new contact person is added to
the list of contacts.

Modify company or contact properties
You can modify the properties of existing companies and contacts in the
Address Book dialog box. For example, this can be useful when you need to
update phone numbers, or shipping and mailing addresses.

1. At the bottom of the Address Book dialog box, click Properties. 

The General tab of the Firm Details dialog box opens.

2. On the various tabs, modify the company properties according to your
needs. 

For example, you can change the firm type or company code, update the
addresses saved for the company, or create new contacts.

3. Click Save.

The company and contact details are updated, and the Firm Details dialog
box closes.

Import contacts to the address book
You can import contacts from your Microsoft Outlook address book or a
Microsoft Excel worksheet to Tekla EPM.

Import contacts from Microsoft Outlook
Before you import contacts from Microsoft Outlook, verify that the contacts
are listed with the companies in the manner that you want them to appear in
Tekla EPM.

1. In the Address Book dialog box, click the Address Book ribbon tab.
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2. On the menu, select Import Outlook Contacts. 

The Select Contacts to Import dialog box opens.

Tekla EPM reads the list of contacts in Microsoft Outlook, and the contacts
appear on the Included side of the dialog box.

3. In the lefthand pane, select the contacts folder from which you want to
import contacts.

4. If you want to include the contacts in the sub-folders of the selected
folder, ensure that the Include Sub-Folder Contacts check box is
selected.

5. Click the arrow buttons to move the contacts that you want to import to
the Included list.

6. Click Save.

The selected Microsoft Outlook contacts are imported to the address book in
Tekla EPM. The Import Outlook Contacts closes.

Import companies or contacts from Microsoft Excel
1. Click the File ribbon tab in the upper-left corner of the Tekla EPM window.

2. On the File menu, select Import.

3. In the navigation tree on the left side of the Import dialog box, select
Address Book.

4. Below Address Book, select if you want to import companies (Firms) or
contacts.

5. Click the ... button.

6. In the Open dialog box, browse to find the Microsoft Excel worksheet that
you want to import, and select it.

7. Double-click the file, or click Open.

8. To import the file, click Import. 

If the Microsoft Excel worksheet contains unnecessary fields, Tekla EPM
asks you if the fields can be ignored in the import.

9. To ignore the unnecessary fields, click Yes.

Tekla EPM imports the companies or contacts in the selected Microsoft Excel
worksheet.

If any import errors occur, you can see the error details at the bottom of the
Import dialog box. To see further details about errors in the import, click
Open Import Log.
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Export companies or contacts
You can export the current list of companies or contacts in the Address Book
and save the list as a Microsoft Excel worksheet or a text file.

1. In the Address Book dialog box, click the Address Book ribbon tab.

2. On the menu, select either Export Firms or Export Contacts.

3. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla EPM saves the file to the Export folder.

4. If necessary, change the file name.

5. If necessary, select another file format in the Save as type list.

6. Click Save.

The list of companies or contacts is exported and saved to the selected
location.

Delete companies or contacts from the address book
To keep the address book up to date, you may need to delete unnecessary
and outdated companies and contacts.

1. Do one of the following according to your needs:

• To delete a company, select the company in the Address Book dialog
box.

• To delete a contact, select the contact in the Address Book - Contacts
dialog box.

2. Click Delete in the lower-right corner of the dialog box.

3. To permanently delete the company or contact from the address book,
click Yes in the confirmation dialog box.

4.4 Manage taxes and currencies
Before you start working in Tekla EPM, you should set the necessary tax rates
and currencies. You can also create tax groups that contain multiple tax rates.

For more information, see the following links:

Create, modify, or delete tax rates (page 177)

Create, modify, or delete tax groups (page 178)

Add, modify, or delete currencies (page 179)
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Create, modify, or delete tax rates
Use the Tax Rates dialog box to define all individual taxes used in your
projects. For example, the state sales tax may consists of a city tax rate and a
county tax rate, and you should enter each tax rate separately. If necessary,
you can group the associated tax rates into tax groups. In addition to adding
tax rates, you can modify and delete existing tax rates.

1. Click the Maintenance ribbon tab.

2. On the menu, select Tax Rates.

3. In the Tax Rate Maintenance dialog box, do any of the following: 

To Do this
Add a new tax rate a. Click New.

b. In the Abbreviation field, type an
abbreviation code.

The abbreviation code is visible in lists where
you can select the tax rate to be applied.

c. In the Description field, type a description for
the tax rate.

d. Define the state, county, city, and tax rate.

e. In the Tax Rate Applies To section, select
what the tax rate is applied to.

You can also define an up to amount and
select whether the tax rate is cascading.

f. To save the new tax rate, click Add.
Modify a tax rate a. Select the tax rate that you want to modify.

b. Modify the abbreviation, description, state,
county, city, and tax rate according to your
needs.

c. In the Tax Rate Applies To section, select
what the tax rate is applied to.

You can also define an up to amount and
select whether the tax rate is cascading.

d. Click Edit to save the changes.
Delete a tax rate Note that you cannot delete tax rates that are used

somewhere in Tekla EPM.

a. Select the tax rate that you want to delete.

b. Click Delete.

c. To permanently delete tax rate, click Yes.
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4. When you are finished, do either of the following according to your needs:

• To close the dialog box, click the Close button (X) in the upper-right
corner.

• To group the existing tax rates, click Tax Group Maintenance at the
lower-right corner of the dialog box.

See also

Create, modify, or delete tax groups (page 178)

Create, modify, or delete tax groups
Creating tax groups that contain multiple tax rates can be helpful for record
keeping. For example, city, county, and state tax rates can be combined into
one group. Tax groups are available in the Purchasing and Order Entry
modules. Creating tax groups is optional, so if you wish, you can define and
use single tax rates instead.

1. To access Tax Group Maintenance, do one of the following:

• Click the Maintenance ribbon tab and in the menu, select Tax
Groups.

• At the bottom right corner of the Tax Rate Maintenance dialog box,
click Tax Group Maintenance.

2. In the Tax Group Maintenance dialog box, do any of the following: 

To Do this
Create a new tax group a. Click New.

b. In the Abbreviation field, type an
abbreviation code.

The abbreviation code will be used in lists
where you can select the tax group.

c. In the Description field, type a description for
the tax group.

d. If necessary, type the state, country, or city
that the tax group applies to.

e. Click Add to save the tax group and add it to
the list.

The new tax group is automatically selected.

f. To select the tax rates that you want to add to
the tax group, click Included Tax Rates.
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To Do this
g. Click the arrow buttons to move the tax rates

that you want to include in the tax group to
the Included list.

h. Click OK.

The selected tax rates are added to the selected
tax group.

Modify a tax group a. Select a tax group in the list.

b. Modify the abbreviation, description, state,
county, and city according to your needs.

c. If necessary, click Included Tax Rates to
modify the tax rates included in the tax group.

d. Click the arrow buttons to move the tax rates
that you want to include in the tax group to
the Included list.

e. Click Edit to save the changes.
Delete tax groups Note that you cannot delete tax groups that are

used somewhere in Tekla EPM.

a. Select a tax group in the list.

b. Click Delete.

c. To permanently delete tax group, click Yes in
the confirmation dialog box.

3. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Create, modify, or delete tax rates (page 177)

Add, modify, or delete currencies
In the Currencies dialog box, you can add currencies that you need to use in
Tekla EPM. You can also set the default currency, modify or delete existing
currencies, and modify exchange rates.

To manage the available currencies, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Currencies.

The Currencies dialog box opens.
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Add a currency
1. In the Currencies dialog box, click New.

2. Define the currency properties: 

Option Description
Abbreviation The abbreviation of the currency. For example, EUR

is the abbreviation for euros.

The abbreviation is used in lists where you need to
select a currency.

Type the abbreviation in the Abbreviation field.
Description The currency name. For example, Euros.

Type the currency name in the Description field.
Display Prefix The currency code or symbol that is displayed

before the sum.

Type the currency code in the Display Prefix field.
Display Suffix The currency code or symbol that is displayed after

the sum.

Type the currency code in the Display Suffix field.
Decimal Places The number of decimal places in the currency.

Type the number in the Decimal Places field.

3. If you want to make the new currency the default currency option, select
the Default Currency check box.

4. Click Add.

The new currency is added to the list.

Now, you can modify the exchange rate of the new currency to other
currencies.

Modify an exchange rate
1. In the Currencies dialog box, select the currency whose exchange rates

you want to modify. 

The exchange rates of the selected currency are displayed in the lower-
right corner of the dialog box.

2. Double-click the exchange rate that you want to modify.

3. In the Currency Exchange Rate dialog box, define the exchange rates
from and to the selected currency. 

You can also only define the first exhange rate and automatically calculate
the second one by selecting the Calculate Inverse check box.
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4. Click Save.

Repeat steps 1 to 5 for all necessary exchange rates.

Set the default currency
By default, the default currency in Tekla EPM is US dollars. However, you can
change the default currency according to your needs.

1. In the Currencies dialog box, select the currency that you want to set as
the default option.

2. Select the Default Currency check box.

3. Click Edit to save the changes.

The selected currency is set as the default option.

Note that the Default Currency column of the selected currency now says
Yes.

Modify a currency
1. In the Currencies dialog box, select the currency that you want to modify.

2. Modify the currency properties according to your needs: 

Option Description
Abbreviation The abbreviation of the currency. For example, EUR

is the abbreviation for euros.

The abbreviation is used in lists where you need to
select a currency.

Type the abbreviation in the Abbreviation field.
Description The currency name. For example, Euros.

Type the currency name in the Description field.
Display Prefix The currency code or symbol that is displayed

before the sum.

Type the currency code in the Display Prefix field.
Display Suffix The currency code or symbol that is displayed after

the sum.

Type the currency code in the Display Suffix field.
Decimal Places The number of decimals in the currency.

Type the number in the Decimal Places field.

3. Click Edit to save the changes..
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Delete a currency
Note that deleting a currency is permanent and cannot be undone.

You cannot delete currencies that are currently used somewhere in Tekla EPM.

1. In the Currencies dialog box, select the currency that you want to delete.

2. Click Delete.

3. To permanently delete the selected currency, click Yes in the confirmation
dialog box.

4.5 Import files to Tekla EPM
You can import various types of files to Tekla EPM. You can import jobs,
requisitions, purchase orders, companies or contacts to the address book,
inventory or inventory history information, assemblies, material dimensions,
labor, and pricing information.

You can import the following file types:

• ASCII files

• BIF files

• IFC files

• KISS files

• KSTK files

• Microsoft Excel worksheets

• SSC files

• txt files

• XML files

Note that the file types that you can import depend on the location and
module into which you are importing the files.

1. Click the File ribbon tab in the upper-left corner of the Tekla EPM window.

2. On the File menu, select Import. 
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3. In the navigation tree on the left side of the Import dialog box, select the
location where you want to import a file.

4. Below the location, select the file type that you want to import. 

If a file type is not available below the selected location, you cannot
import that type of a file to the selected location.

For additional help on some import options, you can click the Help button
in the Import dialog box.

5. Click the ... button.

6. In the Open dialog box, browse to find the file that you want to import,
and select it.

7. Double-click the file, or click Open.

8. To import the file, click Import. 

Some import locations have a Test Import button. By clicking Test
Import, you can preview the effects of the import.

What happens next depends on the imported file and the information
within it. You may need to translate shapes and grades, modify the job
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information, or select if the new information replaces the information in
an existing job.

If any import errors occur, you can see the error details at the bottom of
the Import dialog box.

See the following example about importing a production control job.

Example: Import a new production control job

1. Open the Import dialog box.

2. In the navigation tree, select Production Control --> KISS .

3. Click Import.

4. In the Production Control Job Edit, type the job number and define other
necessary job information.

If you want to import drawings along with the production control job, you
can either select an existing job in the Project Management Job list, or
create a new project management job in step 6.
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TIP When you first import a job, type a release number in the Release #
field. This way, if you import new items into the job later, Tekla EPM
will increase the initial release number.

5. Click Save.

6. If you want to create a related project management job with the same job
number, click Yes in the confirmation dialog box.

If you do not want to create a related project management job, click No.

If you do not create or link a related project management job to the
imported production control job, you will not be able to import any
related drawings.

If you have selected the Prompt to confirm import fields option in the
Company Standards dialog box in the Production Control module, a
dialog box opens, allowing you to select the information that is imported.
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7. Click the arrow buttons to move the information that you want to import
to the production control job to the Included list.

8. Click OK.

9. In the Import dialog box, click ... to select the drawing folder and CNC file
folder, and define the drawing file prefix and suffix, and the CNC file
extension.

NOTE If you do not define a drawing file prefix or suffix, Tekla EPM
expects that the drawing file names match the Tekla EPM drawing
numbers exactly. If you use some text in the drawing file name
before or after the drawing number, you should write this text as
the drawing file prefix or the drawing file suffix.

For example, if you use the job number before the drawing
number in job C23487, you should define the drawing name
prefix as C23847-. This way, Tekla EPM can recognize the drawing
by matching the remaining part of the file name. For example, the
file name of drawing 100 vould be C23847-100.pdf.

You can also use the wildcard character (*) if the prefix or suffix is
not exactly the same for every file. For example, when importing
drawing revisions, the revision number changes. The first revision
of a file might be C23847-100-r1.pdf, but later revisions of the
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drawing could also be imported at the same time. In this case, it
could be useful to define the drawing file suffix as r*.

Note that if you did not create or link a related project management job
(page 728) to the imported production control job, drawings cannot be
imported.

10. Click OK.

The import begins. Tekla EPM alerts you if any files, such as drawings, are
missing.

Note that CNC files are not stores as individual files, but in a table within the
Tekla EPM database. If you export CNC files with nesting results or nesting
requests, the CNC files are recreated from the database.

You can see the number of the successfully and unsuccessfully imported items
in the Import dialog box.

See also

Import assemblies and parametric assemblies (page 187)

Translate unknown shapes and grades (page 188)

Import assemblies and parametric assemblies
Besides labor time, you can also import assemblies and parametric
assemblies. To be imported, the assemblies and parametric assemblies need
to be saved as text files. You can use the imported assemblies and parametric
assemblies in any estimating job.

1. Click the File ribbon tab in the upper-left corner of the Tekla EPM window.

2. On the File menu, select Import.

3. In the navigation tree on the left side of the Import dialog box, select one
of the following depending on the assembly type:
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• Assemblies --> Assemblies

• Assemblies --> Parametric Assemblies

4. Click the ... button.

5. In the Open dialog box, browse to find the text file that you want to
import.

6. Select the file and click Open.

7. Click Import.

8. View the status of the import process. 

If necessary, you can view the import details and errors in a text file by
clicking the Open Import Log button.

9. To close the dialog box, click the Close button (X) in the upper-right
corner.

Translate unknown shapes and grades
When you are importing files, such as drawings, to Tekla EPM, sometimes the
shapes and grades in the imported files do not match the shapes and grades
in Tekla EPM. In these cases, Tekla EPM does not recognize the shapes and
grades. To solve the issue, you need to create an item association that allows
Tekla EPM to identify the shapes and grades.

We recommend that your administrator sends a list of shapes and grades
used in Tekla EPM to the detailers, so that you can ensure that the same
abbreviations are used in the shop detail drawing bill of materials.

If you need to create an item association during the import process, the
Translate Shapes/Grades dialog box opens automatically.

1. In the Translate Shapes/Grades dialog box, select the item that needs to
be translated.

2. Click the arrow on the right side of the New Shape list, and select the
shape abbreviation used in Tekla EPM.

3. If necessary, click the arrow on the right side of the New Grade list, and
select the grade abbreviation used in Tekla EPM.

4. Click Set Shape/Grade. 

Repeat steps 1 to 4 for all items that are listed in the Translate Shapes/
Grades dialog box.

If you save a shape or grade abbreviation, the shape or grade will not
appear in the Translate Shapes/Grades dialog box when you import files
in the future. You should only save the shape and grave abbreviations if
the detailer has no intention of conforming to the abbreviations used in
Tekla EPM.
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5. When you have translated all necessary shapes and grades, click OK to
close the dialog box and continue the import.

NOTE The dimensions matching the properties of the shape are added for
the shape during the import. Remember to review the dimensions
that are added during the import to ensure that the properties of the
shape are completely defined in the Shapes/Grades/Sizes database.

See also

Import files to Tekla EPM (page 182)

4.6 Create, modify, and delete automated events
By creating automated events, you can have Tekla EPM perform operations
either on demand or automatically according to a set schedule. For example,
you can create automatic reports to stay up to date on the progress of a
project.

1. Click the Maintenance ribbon tab.

2. On the menu, select Automated Events.

The Automated Events dialog box opens.

Note that the Tekla EPM Remote Server must be running in order for
automated events to run as scheduled. For more information on starting the
Tekla EPM Remote Server, see Set up the Tekla EPM Remote Server (page 33).
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If the Tekla EPM Remote Server is running normally, the message at the top of
the dialog box is black.

If the Tekla EPM Remote Server is not running, the message at the top of the
dialog box is highlighted in red and warns you that automated events will not
be run as scheduled.

Define the outgoing email settings
You need to define the outgoing email settings to receive automatic reports or
failure notifications by email.

1. In the Automated Events dialog box, click the Automated Events ribbon
tab.

2. On the menu, select Outgoing Email Settings.

3. On the Outgoing SMTP Server tab of the Automated Event Email
Settings dialog box, select the Enable Outgoing Email check box.

4. Define the host, port, username, password, and sender name and email
address.

5. To test the outgoing email server settings, click Test.

6. On the Failure Notifications tab, type the email addresses to which you
want to send failure notifications.

7. Click Save to save the settings.

Create a report event
1. In the Automated Events dialog box, click New Event.

2. In the Automated Event Details dialog box, type a title and a description
for the event.

3. In the Event Type list, select Report.

4. If you have created a report event, define the event properties as follows:

a. Click the Event Properties button. 
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The Report Event Properties dialog box opens.

b. In the Report Group list at the top of the Report Event Properties
dialog box, select the group to which the reports that you want to
save or send belong.

c. Select the report list that contains the desired report.

d. Click the Select Reports button.

e. In the Select Reports dialog box, click the arrow buttons to move the
reports that you want to include in the automated event to the
Included list.

f. Click OK. 

The selected reports are added to the list on the left.

g. To filter the reports to only include particular items, click Set Filters.

h. To add fields that are not included in the report, click Additional
Report Parameters, and type the missing field names and their
values. 

The format for adding fields is FieldName=Value. For example, to
add a field for cost center and set the value to A123, type 
CostCode=A123.

Note that you need to separate each parameter with a semicolon (;).

i. To change the name of the report file, click Set Export Filename,
type the desired name, and click OK. 

You can view the placeholders available for file names and folders on
the Save to Directory of the Report Event Properties dialog box.
You can use these placeholders in the file names of reports to ensure
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that other files are not overwritten and that the event does not fail
because a report with the same file name is open.

j. At the bottom of the dialog box, select if you want to show the
company logo in the report files, and if you want to compress the
reports into a .zip file.

k. In the Export Format list, select if you want to send or save the
reports as PDF files, Microsoft Excel worksheets, or text files.

l. To send the report by email, on the Send Email tab, select firm type,
company name, and contact person, and click Add Recipient. 

You can add more recipients by selecting a new firm type, company
name, and contact person, and clicking Add Recipient again.

Note that the company and contact person need to exist in the
Address Book. The contact person also needs to have an email
address in the Address Book.

m. To save the report in a folder, on the Save to Directory tab, click
the ... button, select the folder where you want to save the file, and
click OK.

n. To save the settings of the report event, click OK at the bottom of the
Report Event Properties dialog box.

5. Set the reporting frequency: 

To Do this
Create an automated
event that repeats with a
particular interval

a. In the Repeat Type list, select Interval.

The Interval tab opens, allowing you to define
the desired interval.

b. In the Interval Units list, select if the interval
is measured in hours, days, or weeks.

c. In the Value field, type the number of hours,
days, or weeks.

Create an automated
event that repeats on
particular days of the
week

a. In the Repeat Type list, select Scheduled.

The Scheduled tab opens on the bottom half
of the dialog box, allowing you to define the
schedule.

b. Click Add.

c. In the Schedule on list at the top of the
Automated Event Schedule, select Day of
Week.

The Day of Week tab opens.

d. Select check boxes next to the days when you
want to run the automated event.
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To Do this
e. In the Run At lists, select the time when you

want to run the report.

f. Click Save to save the event schedule.

The Automated Event Schedule dialog box
closes.

Create an automated
event that repeats on a
particular day of the
month

a. In the Repeat Type list, select Scheduled.

The Scheduled tab opens, allowing you to
define the schedule.

b. Click Add.

c. In the Schedule on list at the top of the
Automated Event Schedule, select Day of
Month.

The Day of Month tab opens.

d. Define the day number.

If you type 31, the automated event runs on
the last date of each month, including the
months with less than 31 days.

e. In the Run At lists, select the time when you
want to run the report.

f. Click Save to save the event schedule.

The Automated Event Schedule dialog box
closes.

6. To allow Tekla EPM to perform the event automatically, ensure that the
Event Enabled check box is selected.

7. Click Save to create the automated event.

Create an automated Trimble Connect synchronization
event
1. In the Automated Events dialog box, click New Event.

2. In the Automated Event Details dialog box, type a title and a description
for the event.

3. In the Event Type list, select Publish to Trimble Connect.

4. To send an email if publishing the information to Trimble Connect fails:

a. Click Failure Notifications.
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b. If you have not yet defined the outgoing email settings, do so on the
Outgoing SMTP Server tab. 

You need to select the Enable Outgoing Email check box and define
the host, port, user name, password, sender name, and sender email
address. You can also test the outgoing email server settings by
clicking Test.

c. On the Failure Notifications tab, type the email addresses to which
you want to send a message if the automated database optimization
fails. 

Note that you need to type each email address on a separate line.

d. Click Save.

5. Click Event Properties.

6. Select which actions happen when the automated event is run: 

• Publish to Organizer: Publish jobs to Trimble Connect Organizer.

• Publish to Status Sharing: Publish jobs to Trimble Connect Status
Share.

• Push Projects: Publish project management jobs to the selected
applications.

You can select which jobs should be published by clicking Set Filter.

• Push Estimates: Publish estimating jobs to the selected applications.

You can select which jobs should be published by clicking Set Filter.

• Push Production Control Jobs: Publish production control jobs to the
selected applications.

You can select which jobs should be published by clicking Set Filter.

7. Click Save to save the actions to be published and the applied filters.

8. To allow Tekla EPM to perform the event automatically, ensure that the
Event Enabled check box is selected.

9. Click Save to save the automated event.

Create an automated database optimization event
1. In the Automated Events dialog box, click New Event.

2. In the Automated Event Details dialog box, type a title and a description
for the event.

3. In the Event Type list, select Optimize Database Tables.

4. To send an email if the database optimization fails:

a. Click Failure Notifications.
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b. If you have not yet defined the outgoing email settings, do so on the
Outgoing SMTP Server tab. 

You need to select the Enable Outgoing Email check box and define
the host, port, user name, password, sender name, and sender email
address. You can also test the outgoing email server settings by
clicking Test.

c. On the Failure Notifications tab, type the email addresses to which
you want to send a message if the automated database optimization
fails. 

Note that you need to type each email address on a separate line.

d. Click Save.

5. Set the reporting frequency: 

To Do this
Create an automated
event that repeats with a
particular interval

a. In the Repeat Type list, select Interval.

The Interval tab opens, allowing you to define
the desired interval.

b. In the Interval Units list, select if the interval
is measured in hours, days, or weeks.

c. In the Value field, type the number of hours,
days, or weeks.

Create an automated
event that repeats on
particular days of the
week

a. In the Repeat Type list, select Scheduled.

The Scheduled tab opens on the bottom half
of the dialog box, allowing you to define the
schedule.

b. Click Add.

c. In the Schedule on list at the top of the
Automated Event Schedule, select Day of
Week.

The Day of Week tab opens.

d. Select check boxes next to the days when you
want to run the automated event.

e. In the Run At lists, select the time when you
want to run the report.

f. Click Save to save the event schedule.

The Automated Event Schedule dialog box
closes.

Create an automated
event that repeats on a

a. In the Repeat Type list, select Scheduled.

The Scheduled tab opens, allowing you to
define the schedule.
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To Do this
particular day of the
month

b. Click Add.

c. In the Schedule on list at the top of the
Automated Event Schedule, select Day of
Month.

The Day of Month tab opens.

d. Define the day number.

If you type 31, the automated event runs on
the last date of each month, including the
months with less than 31 days.

e. In the Run At lists, select the time when you
want to run the report.

f. Click Save to save the event schedule.

The Automated Event Schedule dialog box
closes.

6. To allow Tekla EPM to perform the event automatically, ensure that the
Event Enabled check box is selected.

7. Click Save to create the automated event.

Create an automated database backup
1. In the Automated Events dialog box, click New Event.

2. In the Automated Event Details dialog box, type a title and a description
for the event.

3. In the Event Type list, select Database Backup.

4. To send an email if the database backup fails:

a. Click Failure Notifications.

b. If you have not yet defined the outgoing email settings, do so on the
Outgoing SMTP Server tab. 

You need to select the Enable Outgoing Email check box and define
the host, port, user name, password, sender name, and sender email
address. You can also test the outgoing email server settings by
clicking Test.

c. On the Failure Notifications tab, type the email addresses to which
you want to send a message if the automated database backup fails. 

Note that you need to type each email address on a separate line.

d. Click Save.
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5. Set the reporting frequency: 

To Do this
Create an automated
event that repeats with a
particular interval

a. In the Repeat Type list, select Interval.

The Interval tab opens, allowing you to define
the desired interval.

b. In the Interval Units list, select if the interval
is measured in hours, days, or weeks.

c. In the Value field, type the number of hours,
days, or weeks.

Create an automated
event that repeats on
particular days of the
week

a. In the Repeat Type list, select Scheduled.

The Scheduled tab opens on the bottom half
of the dialog box, allowing you to define the
schedule.

b. Click Add.

c. In the Schedule on list at the top of the
Automated Event Schedule, select Day of
Week.

The Day of Week tab opens.

d. Select check boxes next to the days when you
want to run the automated event.

e. In the Run At lists, select the time when you
want to run the report.

f. Click Save to save the event schedule.

The Automated Event Schedule dialog box
closes.

Create an automated
event that repeats on a
particular day of the
month

a. In the Repeat Type list, select Scheduled.

The Scheduled tab opens, allowing you to
define the schedule.

b. Click Add.

c. In the Schedule on list at the top of the
Automated Event Schedule, select Day of
Month.

The Day of Month tab opens.

d. Define the day number.

If you type 31, the automated event runs on
the last date of each month, including the
months with less than 31 days.

e. In the Run At lists, select the time when you
want to run the report.
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To Do this
f. Click Save to save the event schedule.

The Automated Event Schedule dialog box
closes.

6. To allow Tekla EPM to perform the event automatically, ensure that the
Event Enabled check box is selected.

7. Click Save to create the automated event.

Create an automated inventory sync event
Inventory can be synchronized to Tekla EPM from either ProNest or
SigmaNest.

1. In the Automated Events dialog box, click New Event.

2. In the Automated Event Details dialog box, type a title and a description
for the event.

3. In the Event Type list, select ProNest Inventory Sync or SigmaNest
Inventory Sync .

4. To send an email if the automated inventory sync fails:

a. Click Failure Notifications.

b. If you have not yet defined the outgoing email settings, do so on the
Outgoing SMTP Server tab. 

You need to select the Enable Outgoing Email check box and define
the host, port, user name, password, sender name, and sender email
address. You can also test the outgoing email server settings by
clicking Test.

c. On the Failure Notifications tab, type the email addresses to which
you want to send a message if the automated inventory sync fails. 

Note that you need to type each email address on a separate line.

d. Click Save.

5. Set the reporting frequency: 

To Do this
Create an automated
event that repeats with a
particular interval

a. In the Repeat Type list, select Interval.

The Interval tab opens, allowing you to define
the desired interval.

b. In the Interval Units list, select if the interval
is measured in hours, days, or weeks.

c. In the Value field, type the number of hours,
days, or weeks.
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To Do this
Create an automated
event that repeats on
particular days of the
week

a. In the Repeat Type list, select Scheduled.

The Scheduled tab opens on the bottom half
of the dialog box, allowing you to define the
schedule.

b. Click Add.

c. In the Schedule on list at the top of the
Automated Event Schedule, select Day of
Week.

The Day of Week tab opens.

d. Select check boxes next to the days when you
want to run the automated event.

e. In the Run At lists, select the time when you
want to run the report.

f. Click Save to save the event schedule.

The Automated Event Schedule dialog box
closes.

Create an automated
event that repeats on a
particular day of the
month

a. In the Repeat Type list, select Scheduled.

The Scheduled tab opens, allowing you to
define the schedule.

b. Click Add.

c. In the Schedule on list at the top of the
Automated Event Schedule, select Day of
Month.

The Day of Month tab opens.

d. Define the day number.

If you type 31, the automated event runs on
the last date of each month, including the
months with less than 31 days.

e. In the Run At lists, select the time when you
want to run the report.

f. Click Save to save the event schedule.

The Automated Event Schedule dialog box
closes.

6. To allow Tekla EPM to perform the event automatically, ensure that the
Event Enabled check box is selected.

7. Click Save to create the automated event.
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Create an automated cut list import event
Inventory can be synchronized to Tekla EPM from ProNest, SigmaNest, or
Peddinghaus Raptor.

1. In the Automated Events dialog box, click New Event.

2. In the Automated Event Details dialog box, type a title and a description
for the event.

3. In the Event Type list, select of the following based on the software you
use: 

• ProNest Cut List Import

• SigmaNest Cut List Import

• Peddinghaus iDSTV+ Cut List Import

4. To send an email if the automated cut list import fails:

a. Click Failure Notifications.

b. If you have not yet defined the outgoing email settings, do so on the
Outgoing SMTP Server tab. 

You need to select the Enable Outgoing Email check box and define
the host, port, user name, password, sender name, and sender email
address. You can also test the outgoing email server settings by
clicking Test.

c. On the Failure Notifications tab, type the email addresses to which
you want to send a message if the automated cut list import fails. 

Note that you need to type each email address on a separate line.

d. Click Save.

5. If you selected the Peddinghaus iDSTV+ Cut List Import option, click
Event Properties, and browse to find and select the directory from which
you want to import iDSTV+ files that contain cut information.

6. Set the reporting frequency: 

To Do this
Create an automated
event that repeats with a
particular interval

a. In the Repeat Type list, select Interval.

The Interval tab opens, allowing you to define
the desired interval.

b. In the Interval Units list, select if the interval
is measured in hours, days, or weeks.

c. In the Value field, type the number of hours,
days, or weeks.
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To Do this
Create an automated
event that repeats on
particular days of the
week

a. In the Repeat Type list, select Scheduled.

The Scheduled tab opens on the bottom half
of the dialog box, allowing you to define the
schedule.

b. Click Add.

c. In the Schedule on list at the top of the
Automated Event Schedule, select Day of
Week.

The Day of Week tab opens.

d. Select check boxes next to the days when you
want to run the automated event.

e. In the Run At lists, select the time when you
want to run the report.

f. Click Save to save the event schedule.

The Automated Event Schedule dialog box
closes.

Create an automated
event that repeats on a
particular day of the
month

a. In the Repeat Type list, select Scheduled.

The Scheduled tab opens, allowing you to
define the schedule.

b. Click Add.

c. In the Schedule on list at the top of the
Automated Event Schedule, select Day of
Month.

The Day of Month tab opens.

d. Define the day number.

If you type 31, the automated event runs on
the last date of each month, including the
months with less than 31 days.

e. In the Run At lists, select the time when you
want to run the report.

f. Click Save to save the event schedule.

The Automated Event Schedule dialog box
closes.

7. To allow Tekla EPM to perform the event automatically, ensure that the
Event Enabled check box is selected.

8. Click Save to create the automated event.
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Create a production status export event
You can export the production statuses of particular projects from Tekla EPM
to another Tekla product, SDS/2, or Advance Steel.

1. In the Automated Events dialog box, click New Event.

2. In the Automated Event Details dialog box, type a title and a description
for the event.

3. In the Event Type list, select Production Status Export.

4. To send an email if the automated production status export fails:

a. Click Failure Notifications.

b. If you have not yet defined the outgoing email settings, do so on the
Outgoing SMTP Server tab. 

You need to select the Enable Outgoing Email check box and define
the host, port, user name, password, sender name, and sender email
address. You can also test the outgoing email server settings by
clicking Test.

c. On the Failure Notifications tab, type the email addresses to which
you want to send a message if the production status export fails. 

Note that you need to type each email address on a separate line.

d. Click Save.

5. To define the details of the automated event, click Event Properties.

6. If you want to export the production statuses of only particular projects,
set filters:

a. Click Set Filter.

b. In the Project Management Report Filters dialog box, select a filter
type in the Type list, and click Select.

c. In the Filter dialog box, click the arrow buttons to move the jobs or
job groups whose statuses you want to export to the Included list.

d. Click OK to save the filter. 

Repeat steps a to b to d to set all necessary filters.

e. When you have set all necessary filters, click OK to apply the filters.

7. In the Export Recipient list, select the software to which you want to
export the production status information.

8. Click ... on the right side of the Export Directory field, browse to and
select the folder where you want to export the production status
information, and click OK.

9. If you want to include a time stamp in the file name, select Include
Timestamp in Export Filename check box.

10. Click Save to save the event details.
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11. Set the reporting frequency: 

To Do this
Create an automated
event that repeats with a
particular interval

a. In the Repeat Type list, select Interval.

The Interval tab opens, allowing you to define
the desired interval.

b. In the Interval Units list, select if the interval
is measured in hours, days, or weeks.

c. In the Value field, type the number of hours,
days, or weeks.

Create an automated
event that repeats on
particular days of the
week

a. In the Repeat Type list, select Scheduled.

The Scheduled tab opens on the bottom half
of the dialog box, allowing you to define the
schedule.

b. Click Add.

c. In the Schedule on list at the top of the
Automated Event Schedule, select Day of
Week.

The Day of Week tab opens.

d. Select check boxes next to the days when you
want to run the automated event.

e. In the Run At lists, select the time when you
want to run the report.

f. Click Save to save the event schedule.

The Automated Event Schedule dialog box
closes.

Create an automated
event that repeats on a
particular day of the
month

a. In the Repeat Type list, select Scheduled.

The Scheduled tab opens, allowing you to
define the schedule.

b. Click Add.

c. In the Schedule on list at the top of the
Automated Event Schedule, select Day of
Month.

The Day of Month tab opens.

d. Define the day number.

If you type 31, the automated event runs on
the last date of each month, including the
months with less than 31 days.

e. In the Run At lists, select the time when you
want to run the report.
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To Do this
f. Click Save to save the event schedule.

The Automated Event Schedule dialog box
closes.

12. To allow Tekla EPM to perform the event automatically, ensure that the
Event Enabled check box is selected.

13. Click Save to create the automated event.

Create an API log check event
Several Tekla EPM integrations call for the API. The commands in these
integrations are recorded in the API log. The API Log Check event searches
the API log to find any failed commands since the last log check, and sends an
email with the failed entries to the selected email addresses.

1. In the Automated Events dialog box, click New Event.

2. In the Automated Event Details dialog box, type a title and a description
for the event.

3. In the Event Type list, select API Log Check.

4. To send an email if the API log check fails:

a. Click Failure Notifications.

b. If you have not yet defined the outgoing email settings, do so on the
Outgoing SMTP Server tab. 

You need to select the Enable Outgoing Email check box and define
the host, port, user name, password, sender name, and sender email
address. You can also test the outgoing email server settings by
clicking Test.

c. On the Failure Notifications tab, type the email addresses to which
you want to send a message if the API log check fails. 

Note that you need to type each email address on a separate line.

d. Click Save.

5. To send a list of failed entries in the API log in an email:

a. Click Event Properties.

b. Type the email addresses to which you want to send the list of failed
entries in the API log. 

Note that you need to type each email address on a separate line.

c. Click Save.

6. To allow Tekla EPM to perform the event automatically, ensure that the
Event Enabled check box is selected.

Start using Tekla EPM 204 Create, modify, and delete automated events



7. Click Save to create the automated event.

Run an automated event manually
1. In the Automated Events dialog box, select the automated event that you

want to run.

2. Click Run Event Now.

3. To confirm running the event, click Yes in the confirmation dialog box. 

The event is run. Note that the event ID is highlighted with yellow in the
Automated Events dialog box.

The Status dialog box opens, showing the progress of the event.

4. When the event has been run, click OK to close the Status dialog box.

If the event has been run successfully, the Last Run column displays the latest
run time on a green background.

You can view the details of the last run by clicking the Last Event Status
button.

Copy an automated event
1. In the Automated Events dialog box, select the automated event that you

want to copy.

2. Click Copy Event.

3. In the Automated Event Details dialog box, type a title and a description
for the copied event.

4. Modify any other event properties according to your needs.

5. Click Save to save the properties of the copied event.

Modify an automated event
1. In the Automated Events dialog box, select the automated event that you

want to modify.

2. Click Event Properties.

3. In the Automated Event Details dialog box, modify the title and the
description for the event.

4. In the Event Type list, change the type of event according to your needs.
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5. Modify the event properties and the reporting frequency as needed. 

For example, if you do not want Tekla EPM to perform the event
automatically, clear the Event Enabled check box.

6. Click Save to update the automated event.

View the run history of an automated event
1. In the Automated Events dialog box, select the automated event whose

entire run history you want to view.

2. Click Event Properties.

3. In the Automated Event Details dialog box, click Result History.

4. In the Results dialog box, review the result history of the automated
event. 

If an error has occurred during a run, the Error Message column of the
run is highlighted in red, and a brief description of the error is displayed.

5. To view more details about a particular run and its errors, select the run
and click Details.

6. To close the Results dialog box, click the Close button (X) in the upper-
right corner.

Delete an automated event
Note that deleting an automated event is permanent and cannot be undone.

1. In the Automated Events dialog box, select the automated event that you
want to delete.

2. Click Delete Event.

3. To permanently delete the automated event, click Yes in the confirmation
dialog box.

4.7 Customize Tekla EPM
You can customize different information in Tekla EPM, including the display
and input fields in various dialog boxes, the menu options for contextual
ribbon tabs, report lists, and reports. You can also create module-wide filters
that can be used for all jobs in a particular Tekla EPM module.

For more information, see the following links:

Customize display fields (page 207)

Customize input fields (page 209)
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Customize menu options (page 212)

Create and modify module-wide filters (page 216)

Create customized report lists (page 217)

Create customized reports (page 222)

Switch information to metric or imperial mode (page 224)

Customize display fields
You can customize the fields in the display area of Combining, Estimating,
Inventory, Project Management, Production Control, and Purchasing
dialog boxes. For example, you can change the column names and locations,
move columns up and down, or adjust the column width or alignment.

For some modules, you can modify the display fields of the dialog boxes
separately. For example, in the Purchasing module, you can customize the
display fields separately for purchase orders and requisitions. Similarly, in
Project Management, you can modify the display fields of drawings, change
orders, RFIs, and journal entries separately.

1. Click the Maintenance ribbon tab.

2. On the menu, go to the desired module and select a suitable Edit Display
Fields option.

3. In the Display Fields dialog box, click Edit Types.

4. In the left-hand list, select the set of settings that you want to modify.

5. Click the arrow buttons to move the fields that you want to show to the
Included list. 

The fields marked with an asterisk (*) are required fields that need to
always be in the Included list.

6. According to your needs, do any of the following. 

Note that all options may not be available when customizing the display
fields in different modules.

To Do this
Change the
order of the
display fields

a. In the Included Fields list, select the field that you want
to move.

b. Click the Move Up and Move Down buttons to change
the position of the field.

Note that the top item in the list will be the column to
the far left of the display area in the module.

Change the
sort order of

a. In the Included Fields list, select the field whose sort
order you want to change.
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To Do this
the display
fields

b. Click the Sort Order + and Sort Order - to increase or
decrease the sort value of the field.

Modify display
field names,
widths, and
alignment

NOTE Be careful when customizing the names of display
fields. Significant changes to the field names can
prevent you from following the instructions given in
the user guide or by the Tekla EPM support.

a. In the Included Fields list, select the field that you want
to modify.

b. Click Properties.

c. Type the desired values in the Display Name and Field
Width fields.

The display name appears in the column header, and
the field width defines the width of the associated
column.

d. Select an alignment option in the Alignment list.

The alignment affects the text alignments within the
associated column.

e. Click OK to save the changes.
Highlight the
input field
corresponding
the selected
display field

• At the top of the dialog box, select the Highlight Input
of Clicked Cell check box.

When you work in a dialog box and click a display field, the
corresponding input field is highlighted.

Select how
main pieces are
highlighted in
the Production
Control
module

• At the top of the dialog box, select an option in the
Highlight Main Piece list.

For example, if you select Bold & Italic, you can quickly
identify main pieces at a glance. If you do not want main
pieces to be highlighted in any way, select None.

Add display
types

a. In the lower-left corner of the dialog box, click New.

b. Enter a name for the new set of settings in the
Description field.

c. Click Add.

d. In the left-hand list, select the new set of settings.

e. Modify the settings according to your needs.

f. Click Save.

The changes you made are saved to the new set of
settings.
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To Do this
Revert to the
default settings

• At the bottom of the dialog box, click Set to Default.

7. Click Save to save the changes and then, click the Close button (X) in the
upper-right corner to close the dialog box. 

The fields of the dialog box are updated and will be shown the next time
you open the module.

8. In the Type list, select which settings you want to use by default in the
associated dialog box. 

For example, you can select a set of personalized settings that you have
created.

9. Click Save.

See also

Customize input fields (page 209)

Customize input fields
You can customize the fields in the input area of the Combining, Estimating,
Inventory, Project Management, Production Control, and Purchasing
dialog boxes according to your needs. For example, you can change the places
of input fields, modify their names, change the field widths, and skip fields or
preserve the value of fields when adding more items.

For some modules, you can modify the input fields of the dialog boxes
separately. For example, in the Purchasing module, you can customize the
input fields separately for purchase orders and requisitions. Similarly, in
Project Management, you can modify the input fields of drawings, change
orders, RFIs, and journal entries separately.

1. Click the Maintenance ribbon tab.

2. On the menu, go to the desired module and select a suitable Edit Input
Fields option.

3. In the Input Fields dialog box, click Edit Types.

4. In the left-hand list, select the set of settings that you want to modify.

5. Click the arrow buttons to move the fields that you want to show to the
Included list. 

The fields marked with an asterisk (*) are required fields that need to
always be in the Included list.
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6. According to your needs, do any of the following: 

To Do this
Select if you
want to
confirm all
changes

• At the top of the dialog box, select the Prompt on Edit
check box.

Whenever you make changes in the associated dialog box, a
confirmation dialog box appears and asks you to confirm
the changes. If you do not want to have to confirm all
changes, do not select the check box.

Change the
order of the
input fields

a. In the Included Fields list, select the field that you want to
move.

b. Click the Move Up and Move Down buttons to change the
position of the field.

The item at the top of the list will be the top field in the
dialog box.

Change the
input field
names

NOTE Be careful when customizing the names of input fields.
Significant changes to the field names can prevent you
from following the instructions given in the user guide
or by the Tekla EPM support.

a. In the Included Fields list, select the field that you want to
modify.

b. Click Set Display Name.

c. Type a new name in the field.

d. Click OK to save the new name.
Skip input
fields when
using the
tab key in
input

a. In the Included Fields list, select the field that the users
can skip.

b. Select the Skip Field check box.

The selected field can now be skipped when inputting
information using the tab key. In order to add information
to a skipped field, you need to click the field.

Preserve the
value of a
field when a
new item is
added

a. In the Included Fields list, select the field whose value you
want to preserve for new items.

b. Click the Carry Over: No button.

The button name changes to Carry Over: Yes.

For example, if you allow carrying over the Shape field,
Tekla EPM uses the same shape for new items until you
manually select a different one.

NOTE Some fields cannot be carried over because the
data in these fields is unique for each item.
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To Do this

To clear the field when adding new items, click the Carry
Over button again. The button name changes back to
Carry Over: No.

Keep the
additional
labor when
a new item
is added

Note that the Carry Over Additional Labor check box is only
available when customizing the input fields in the Estimating
module.

• At the top of the dialog box, select the Carry Over
Additional Labor check box.

Tekla EPM uses the same additional labor for new items
until you manually select a different one.

Keep the
standard
clips when a
new item is
added

Note that the Carry Over Standard Clips check box is only
available when customizing the input fields in the Estimating
module.

• At the top of the dialog box, select the Carry Over
Standard Clips check box.

Tekla EPM uses the same standard clips for new items until
you manually select a different one.

Change the
font size of
the input
fields

• In the Font Size field, type a new font size.

Change the
input area
width

• In the Input Area Width field, type the width in pixels.

Change the
navigation
tree width

• In the Navigation Tree Width field, type the width in
pixels.

To make the navigation tree narrower, type a value that is
smaller than the current one, and to make it wider, type a
greater value.

Add input
types

a. In the lower-left corner of the dialog box, click New.

b. Enter a name for the new set of settings in the
Description field.

c. Click Add.

d. In the left-hand list, select the new set of settings.

e. Modify the settings according to your needs.

f. Click Save.

The changes you made are saved to the new set of
settings.
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To Do this
Revert to the
default
settings

• At the bottom of the dialog box, click Set to Default.

7. Click Save to save the changes and then, click the Close button (X) in the
upper-right corner to close the dialog box. 

The fields of the dialog box are updated and will be shown the next time
you open the module.

8. In the Type list, select which settings you want to use by default in the
associated dialog box. 

For example, you can select a set of personalized settings that you have
created.

9. Click Save.

See also

Customize display fields (page 207)

Customize menu options
You can customize the drop-down menu options available in the Combining,
Estimating, Inventory, Production Control, and Purchasing modules. For
example, you can add or modify the options visible in the menu, and define
shortcuts to access the different menu commands.

For the Purchasing module, you can customize the menu items separately for
purchase orders and requisitions.

NOTE Be careful when customizing the menu options. Significant changes to
the menu options can prevent you from following the instructions
given in the user guide or by the Tekla EPM support.

1. Click the Maintenance ribbon tab.

2. On the menu, go to the desired module and select Menu Setup . 

The Menu Setup Types dialog box opens.

The dialog box contains two types of items:

• Text items that serve as headings that group different commands.

• Action items (marked with *), which are commands in the menu.

Note that the current menu items of the module match the options in the
Included list.

3. Click Edit Types.
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4. To create personalized menu setup settings, click New. 

Creating personalized settings is useful because you can use a menu
setup that meets your personal needs, while the default settings remain
untouched.

5. In the Description field, type a name for the personalized settings.

6. To start customizing the menu, click Save.

7. In the left-hand list, select the settings that you want to customize.

8. According to your needs, do any of the following: 

To Do this
Add a text item
to the menu

Text items serve as headings under which you can place
action items, or items that are marked with an asterisk (*).

a. In the Included list, select the item under which you
want to add a text item.

b. Click Add Text Item.

c. Type text for the item.

This text will be visible in the drop-down menu.

d. Click the new text item in the Included list to select it.

e. To add action items under the text item, click an action
item in the Not Included list to select it.

f. Click > to add the item under the new text item.

The action item is moved under the text item.
Add a line to
separate menu
items

a. In the Included list, select the text item under which
you want to add the line.

b. Click Add Line.
Change the
order of the
menu items

a. In the Included list, select the item that you want to
move in the menu.

b. Click the Up and Down buttons to change the position
of the menu item.

Add a shortcut a. In the Included list, select the item to which you want
to add a shortcut.

b. In the Shortcut list, select a shortcut that you want to
use to access the menu item.

c. Click Update.
Change the
name of a menu
item

a. In the Included list, select the menu item that you
want to rename.

b. Click the Edit Text button.

c. Type a new name for the menu item.

Start using Tekla EPM 213 Customize Tekla EPM



To Do this
d. Click OK.

9. Click Save to save the changes and then, click the Close button (X) in the
upper-right corner to close the dialog box.

10. In the Type list, select the settings that you want to use when working in
the associated module.

11. Click Save.

The menu items are updated to match the changes that you made.

Customize the layout of a dialog box
Use the Customize grid command to customize how and what information is
displayed in different dialog boxes in Tekla EPM. For example, you can add
new columns, change the column headers and column placement, and add
spaces between rows and columns.

1. Open the desired dialog box.

2. Right-click anywhere in the display area of the dialog box.

3. In the context menu, click Customize grid.

4. To create a customized layout, in the Grid Layout dialog box, click New
Layout.

5. Type a description for the layout.

6. Modify the following properties according to your needs: 

Option Description
Grid Mode Allows you to select if you want the job list to have

a fixed width or an automatically scaling width.

Click the arrow on the right side of Grid Mode
field, and select a suitable option in the list.

Number of rows per
record

Allows you to have more than one row for each
job, or record. By adding rows, you can either place
the job information on multiple rows.

Type the desired number of rows in the Number
of rows per record field.

Default for all users When selected, the layout that you are adding or
modifying will be used as the default layout for all
Tekla EPM users.

Current row The row on which you are adding fields. The
Current row only applies if the value in the
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Option Description
Number of rows per record field is greater than
1.

Click the arrow on the right side of Current row
field, and select a row number in the list.

Fixed Columns Allows you to freeze a desired number of columns
from the top of the list, so that you can see them
all the time when you scroll across different
columns.

Type the number of columns that you want to
freeze in the Fixed Columns field.

7. In the Available Fields list, select the columns that you want to include in
the dialog box, and click the arrow buttons to move them to the Included
Fields list.

8. According to your needs, do any of the following: 

To Do this
Add an empty column • On the right side of the dialog box, click Add

Empty.

An empty entry appears at the bottom of the
list. This means that the empty column is the
rightmost column in the selection dialog box.

If necessary, you can still modify the location of
the empty column.

To remove the empty field, move it to the
Available Fields list.

Change the order of
columns

a. In the Included Fields list, click the column
that you want to move left or right.

b. Click the Move Up and Move Down buttons to
move the column according to your needs.

Note that the top field represents the leftmost
column in the selection dialog box. Similarly,
the bottom field represents the rightmost
column in the dialog box.

Change the sort order of
columns

a. In the Included Fields list, click the column
whose sort order you want to change.

b. Click the Sort Order + and Sort Order - to
increase or decrease the sort value of the field.

Modify the column
name, width, style, and
alignment

a. In the Included Fields list, click a column to
select it.

b. Click Properties.
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To Do this
c. Type the desired values in the Display Name

and Width fields.

The display name appears in the column
header and the field width defines the width
of the associated column.

d. To modify the style of the column header, in
the Style section, select any check boxes
according to your preferences.

e. Select an alignment option in the Alignment
list.

The alignment affects the text alignments
within the associated column.

f. If you want to hide all values in the column,
select the Hide Display check box.

g. Click OK to save the changes.

9. To save the customized layout, click Save Layout.

10. To use the layout in the selection dialog box, click Apply Layout. 

You can revert to the default layout or the current layout at any time by
clicking the Use Default State and Use Current State buttons.

Create and modify module-wide filters
You can create module-wide filters that are available for all jobs in a particular
Tekla EPM module. Module-wide filters are available for the Combining,
Estimating, Production Control, Project Management, and Purchasing
modules. In the Purchasing module, you can create module-wide filters
separately for requisitions and purchase orders.

To start managing module-wide filters:

1. Click the Maintenance ribbon tab.

2. On the menu, go to the desired module or job type, and select Global
Filter Types. 

For example, to create filters for requisitions, select Requisitions -->
Global Filter Types.

The Filter Types dialog box opens.

Create module-wide filters
1. In the Filter Types dialog box, click New.
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2. In the Filter Type Description field, type a description for the filter.

3. Select a filter type in the Type list, and click Select.

4. Click the arrow buttons to move the items that you want to include in the
filter to the Included list.

5. Click OK. 

Repeat steps 3 to 5 to define all values that you want to include in the
filter.

6. When you have added all necessary values, click Add.

The new filter is saved for the related Tekla EPM module.

To use the filter:

1. In an open job, click the contextual ribbon tab.

For example, in an estimating job, click the Estimating ribbon tab.

2. On the menu, select Filter.

3. In the Filter Types list, select the new filter.

Modify module-wide filters
1. In the Filter Type list, select the filter that you want to modify.

2. If necessary, change the description in the Filter Type Description field.

3. Select a filter type in the Type list, and click Select.

4. Click the arrow buttons to move the items that you want to include in the
filter to the Included list.

5. Click OK. 

Repeat steps 3 to 5 to define all values that you want to include in the
filter.

6. When you have made the necessary changes, click Save.

Delete module-wide filters
1. In the Filter Type list, select the filter that you want to delete.

2. Click Delete.

3. To permanently delete the filter, click Yes.
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Create customized report lists
You can create customized report lists for different Tekla EPM users, so that
each user can view their most used reports by default. You can also add user-
defined reports in the report lists.

Note that report lists need to be created separately for each Tekla EPM
module.

1. In any Tekla EPM job, click the associated ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. To only include particular information in the reports, in the Report Filters
dialog box, select a filter type in the Type list, and click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the information that you want to
include to the Included list.

• Type the maximum and minimum values for the items that you want
to include.

5. Click OK.

6. Depending on the dialog box that opens, do the following:

• In the Report Selection dialog box, click Edit Report Types.

• In the Report Progress dialog box, click Edit.

The Report Types dialog box opens.
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Create a report list
1. At the bottom of the Report Types dialog box, click New.

2. Type a description for the report type list. 

For example, you can type the user's name.

3. If you have created multiple companies in the Company Information
dialog box, click the arrow on the right side of the Company Setup list
and select the company that you want to include when creating reports.

4. Click the arrow buttons to move the reports that you want to include in
the report list to the list on the right side of the dialog box. 

The reports on the left side of the dialog box are not displayed in the
report list.

5. To modify the reports in the list, do any of the following: 

To Do this
Change the report name The report name determines what the report is

called in the Report Selection or the Report
Progress dialog box.

a. Select the report in the list on the right side of
the dialog box.

b. Click Set Name.

c. In the Enter Value dialog box, type a new
name for the report.

d. Click OK to save the new report name.
Change the report title The report title is displayed at the top of the report

when you view, print, or export the report.

a. Click Set Title.

b. In the Enter Value dialog box, type a new
name for the report.

c. Click OK to save the new report title.
Move the report up or
down in the report list

a. Click the Move Up and Move Down buttons
until the report is in the desired location in the
report list.

Change the default
number of printed
copies

a. Select the report in the list on the right side of
the dialog box.

b. Click the + and - buttons until the report has
the desired number of copies.

Change the printer used
when printing the report

a. Select the report in the list on the right side of
the dialog box.

b. Click Select Printer.
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To Do this
c. In the Select Printer dialog box, click a printer

to select it.

d. Click OK to save the printer settings.
Create a custom report
and add it to the report
list

a. Click User-Defined Reports.

b. In the User-Defined Reports dialog box, click
New.

c. Select the report that you want to use as the
basis of the user-defined report.

d. Click Select Base Report.

e. Define the report name and title.

The report name determines what the report
is called in the Report Selection or the
Report Progress dialog box.

The report title is displayed at the top of the
report when you view, print, or export the
report.

f. Click Add.

g. To close the User-Defined Reports dialog
box, click the Close button (X) in the upper-
right corner.

h. Click the arrow buttons to move the custom
report to the list on the right side of the
Report Types dialog box.

6. Click Add.

The report list can now be selected in the left-side pane of the Report
Selection dialog box or the Report List list in the Report Progress dialog box.

Set the default report list
A default report list is the report list initially displayed in the Report Selection
or Report Progress dialog box. To change the default report list, do the
following:

1. In the left-hand pane of the Report Types dialog box, select the report list
that you want to set as the default option.

2. Click Set as Default.

3. To confirm using the selected report list as the default option, click Yes in
the confirmation dialog box.
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Modify a report list
1. In the left-hand pane of the Report Types dialog box, select the report list

that you want to modify.

2. If you have created multiple companies in the Company Information
dialog box, click the arrow on the right side of the Company Setup list
and select the company that you want to include when creating reports.

3. Click the arrow buttons to move the reports that you want to include in
the report list to the list on the right side of the dialog box. 

The reports on the left side of the dialog box are not displayed in the
report list.

4. To modify the reports in the list, do any of the following: 

To Do this
Change the report name The report name determines what the report is

called in the Report Selection or the Report
Progress dialog box.

a. Select the report in the list on the right side of
the dialog box.

b. Click Set Name.

c. In the Enter Value dialog box, type a new
name for the report.

d. Click OK to save the new report name.
Change the report title The report title is displayed at the top of the report

when you view, print, or export the report.

a. Click Set Title.

b. In the Enter Value dialog box, type a new
name for the report.

c. Click OK to save the new report title.
Move the report up or
down in the report list

a. Click the Move Up and Move Down buttons
until the report is in the desired location in the
report list.

Change the default
number of printed
copies

a. Select the report in the list on the right side of
the dialog box.

b. Click the + and - buttons until the report has
the desired number of copies.

Change the printer used
when printing the report

a. Select the report in the list on the right side of
the dialog box.

b. Click Select Printer.

c. In the Select Printer dialog box, click a printer
to select it.
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To Do this
d. Click OK to save the printer settings.

5. Click Edit to save the changes.

To create customized reports and add them to report lists in Tekla EPM, see
Create customized reports (page 222).

Delete a report list
Note that deleting a report list is permanent and cannot be undone.

1. In the left-hand pane of the Report Types dialog box, select the report list
that you want to delete.

2. Click Delete.

3. To permanently delete the report list, click Yes in the confirmation dialog
box.

Create customized reports
Reports are template files that are used to display the filtered information
from the Tekla EPM database. Tekla EPM automatically looks for the template
first in the Custom Report folder set in the Default Directories dialog box,
and after that, in the C:\Program Files (x86)\Tekla EPM\Reports
folder. You can add a customized report to Tekla EPM by selecting an existing
report that you want to use as the basis of the new report, and adding a new
template file name in Tekla EPM.

Save the new report template in the custom report folder overwriting the
report file name created for the new report that was displayed in the user
defined report window. Now your new report is available.

1. Open the Report Selection dialog box where you can see the report that
you want to use as the basis of the customized report.

2. In the upper-left corner of the dialog box, click Edit Report Types.

3. At the lower-right corner of the Report Types, click User-Defined
Reports. 
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4. In the User-Defined Reports dialog box, click New.

5. In the Select Base Report dialog box, double-click the report that you
want to use as the basis of the new report. 

The base report should contain all the correct tables and information for
the new report. This can be achieved by modifying an existing report.

In most cases, either the user who modified the base report or the report
that you received tell you which base report you should select.

When you have selected the base report, the file name of the base report
appears at the bottom of the User-Defined Reports dialog box.
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6. Type the desired name and title for the new report.

7. In the Filename field, type the desired file name for the new report.

8. Click Add.

9. To close the User-Defined Reports dialog box, click the Close button (X)
in the upper-right corner.

10. In the Report Types dialog box, click the > button to move the customized
report to the Included list. 

11. Click Edit to save the changes.

12. Save the new report template in the Custom Report folder with the file
name that you defined in the User-Defined Reports dialog box.

The customized report is now available in Tekla EPM.

See also

Create customized report lists (page 217)

Switch information to metric or imperial mode
You can choose to display material dimensions, lengths, weights, prices, or all
previously mentioned information in either imperial or metric units in various
dialog boxes in Tekla EPM.

1. In an open dialog box, click the contextual ribbon tab on the right side of
the ribbon.

2. On the menu, select Switch To Metric/Imperial Mode.
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3. On the extended menu, click an item whose mode you want to switch. 

If you select the Switch To Metric Mode or Switch To Imperial Mode
option, all information in the dialog box is switched to the mode that is
not currently active.
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5 Create advance bills of
materials

Use the Combining module in Tekla EPM to create and import advance bills of
materials, or combining jobs. You can either add combining jobs manually or
import them as Microsoft Excel worksheets, or KISS or CIS/2 files. The
information in the imported files is automatically transferred into the
applicable fields of the Combining module.

Once the materials have been entered in the Combining module, you can
combine and re-combine them using different material lengths. Then, you can
compare the different combinations.

You can also send the combining materials to a requisition for pricing, or to a
purchase order. Tekla EPM then marks the items that are sent to purchasing,
so that they cannot be sent to purchasing again.

NOTE Before you start working in the Combining module, remember to set up the
module (page 227) according to your needs.

See also

Set up the Combining module (page 227)

Open the Combining module (page 234)

Find a combining job (page 235)

Create a combining job (page 236)

Open a combining job (page 241)

Filter information in the Combining dialog box (page 242)

Copy a page of combining items (page 251)

Manage combining items (page 245)

Combine materials in the Combining module (page 251)

Load combining items into purchasing (page 263)

View all changes in a combining job (page 243)
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Export a combining job to KISS (page 266)

View or print combining reports (page 266)

5.1 Set up the Combining module
In Combining Maintenance, you can create and modify the settings used
when working in the Combining module. For example, you can set up the
display and the input order listing views in Combining Maintenance. In
addition to setting custom views, you can modify the menu setup and add
keyboard shortcuts to make working more efficient.

For more information, see the following links:

Define company standard settings for Combining (page 227)

Manage combining jobs (page 231)

Define company standard settings for Combining
In the Company Standards dialog box, you can create default settings that
become the company standard settings used in each combining job. If
necessary, you can change the settings on a job by job basis.

1. Click the Maintenance ribbon tab.

2. On the menu, select Combining --> Company Standards .

3. In the Combining Company Standards dialog box, adjust the following
settings according to your needs: 

Option Description
Job # Increment Allows you to select the default option for automatic

job numbering. The options are:

• Increment from Last Job #:

When you create a new job, Tekla EPM uses the
next available job number after the latest job
number created.

• Increment from Largest Job #: Tekla EPM uses
the next available job number after the largest job
number created.

• Don't Increment: Automatic job numbering is not
used.

You can modify the job number when you create a
new job.
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Option Description
Mark Input Type Allows you to select which format is used when

defining mark numbers.

The Any Input and Any Input - Logical Sort options
allows you to use any format when defining marks.
The difference between the two options is that the
Any Input - Logical Sort sorts the items in a different
way.

Auto-Increment When selected, Tekla EPM automatically populates
the new mark number with the next largest available
mark number when you are adding items in the
Combining dialog box.

Auto-Increment
From Last Entered
Value

When selected, Tekla EPM automatically populates
the new mark number with the next mark number
from the latest added mark number when you are
adding items in the Combining dialog box.

Allow Blank When selected, Tekla EPM allows blank mark
numbers.

Allow Duplicate When selected, Tekla EPM allows duplicate mark
numbers.

Keep Job Selection
Screen Open

When selected, the Select Combining Job dialog box
stays open after a job has been opened. Otherwise,
the Select Combining Job dialog box will close when
you open a combining job.

Item Increment Sets the auto-increment for item numbers.

Using the default auto-increment of 10 allows items to
be added in the list according to your needs, without
having to renumber the other items in the job.

For example, if items should be initially numbered as
10, 20, 30, ..., the input increment should be set to 10.
If auto-increment of item numbers is not necessary,
type 1 in the Item Increment field.

Job # Regular
Expression

Allows the use of regular expressions to enforce a
desired format for the job numbers.

For more detailed instructions on job number regular
expressions, click Regular Expression Help.

4. Click Save.

The changes you made are saved. You can further modify the company
standards by clicking the Input/Display Units, Combining Optimizations,
and Suppliers tabs.
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Define input and display units for Combining
You can use either metric or imperial units for displaying and entering sizes,
lengths, weights, and prices in the Combining module. In addition, you can
select how you want to enter the data for the length of the piece.

1. In the Combining Company Standards dialog box, click the Input/
Display Units button.

2. In the Input/Display Units dialog box, select the units and the length
input types in the available lists. 

Note that there are multiple options depending on the required precision
and the desired input method.

3. Click OK.

4. Remember to click Save in the Combining Company Standards to
update the input and display units.

After saving the settings, the Combining Company Standards dialog box
closes.

Define default suppliers for Combining
You can define the desired suppliers, or pricing data sets, for angles, beams,
plates, rods, tubes, and other material. This way, you can use material pricing
from the selected supplier pricing data sets for each material group.

1. In the Combining Company Standards dialog box, click the Suppliers
button.

2. In the Suppliers dialog box, select suppliers for each material group in the
available lists.

3. Click OK.

4. Remember to click Save in the Combining Company Standards dialog
box to update the supplier settings.

See also

Define company standard settings for Combining (page 227)

Define combining optimizations for the Combining module
You can define company-level settings for multing and plate nesting for new
combining jobs. The combining optimizations can be adjusted on a job by job
basis.

1. At the bottom of the Combining Company Standards dialog box, click
Combining Optimizations.

2. To use material grade substitutions with the optimization settings when
performing a combining run, on the General Settings tab of the
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Combining Setup dialog box, select the Use Grade Substitutions check
box. 

Grade substitutions must be set in the Shape / Grade / Size
Maintenance dialog box. If the grade substitutions are not set, the
material grades in the combining run and in the supplier pricing data set
or the inventory need to match each other exactly.

3. Click the arrow buttons to move the optimization options that you want to
use to the Optimizations Included list. 

The options are:

• Inventory Exact-Match (In Stock): Use this option for inventory items
in stock that are an exact match without the use of kerf or clamp
allowance.

• Inventory Exact-Match (On Order): Use this option for inventory
items that are on purchase orders and have not yet been received and
that are an exact match without the use of kerf or clamp allowance.

• Inventory Least-Scrap (On Order): Use this option for inventory
items that are on purchase orders and have not yet been received and
that will provide the least amount of scrap.

• Inventory Least-Scrap (In Stock): Use this option for inventory items
in stock that will provide the least amount of scrap.

• Warehouse Least-Scrap: Use this option to give preference to
warehouse items that will provide the least amount of scrap.
Warehouse items will only be used when they provide less scrap than
the available inventory items.

• Warehouse Force Inventory: Use this option to force the use of
inventory regardless of the amount of scrap, no matter where it is
located in the Optimizations Included list. This option is the opposite
of Warehouse Least-Scrap.

Note that you can only include Warehouse Least-Scrap or
Warehouse Force Inventory, not both.

4. Use the Move Up and Move Down buttons to modify the order of the
optimizations. 

The order is important while performing a combining run.

5. Click the Mult Settings - Linear Material tab to open it.

6. In Multing Software, select the multing software that you are using.

7. If you want to apply the material kerf settings defined in Shape / Grade /
Size Maintenance to the combining as part of the cutting pattern, select
the Apply Kerf check box.

8. Open the Plate Nesting Settings tab.

9. In the Plate Nesting Software list, click the plate nesting software that
you are using to select it.
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10. In the Shear Cut Optimization list, click a suitable shear cut option to
select it. 

The selected option determines the plate allowance to be used with the
combining:

• Use None when cutting plate on a burn table.

• Use Shear Cut - First Cut Along Length or Shear Cut - First Cut
Along Width to alert Tekla EPM that the nesting needs to allow for
that type of cut first. Then, the nesting will allow for all subsequent
cuts to be made with that condition.

11. If the material grain direction is unimportant and you want Tekla EPM to
create the best possible optimization of a plate, select the Rotate Plates
for Best Fit check box.

12. If necessary, select the Apply Kerf check box. 

For more details, see step 7.

13. Click Save.

14. Remember to click Save in the Combining Company Standards dialog
box to update the combining optimizations.

When you have saved the settings, the Combining Company Standards
dialog box closes.

See also

Define company standard settings for Combining (page 227)

Manage combining jobs
In Job Maintenance, you can manage existing combining jobs. You can copy,
renumber, merge, export, and delete combining jobs, and set up job groups.

1. Click the Maintenance ribbon tab.

2. In the menu, select Combining --> Job Maintenance .

3. In the Select Combining Job dialog box, select the job that you want to
manage.

4. At the bottom of the dialog box, click one of the available buttons to
manage the job.

The options are:

• Delete

• Copy

• Renumber

• Merge
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• Export

• Set Group Name

For more information, see the following links:

Delete combining jobs (page 232)

Copy a combining job (page 232)

Renumber a combining job (page 233)

Merge combining jobs (page 233)

Export combining jobs (page 233)

Set job groups for combining jobs (page 234)

Delete combining jobs
You can delete unnecessary combining jobs at any time. Note that the jobs are
deleted permanently. If you want to use jobs for reference later, we
recommend that you export the jobs before deleting them.

Note that users with administrative rights can create a KISS file to restore a
deleted combining job within 30 days from deleting the job.

1. In the Select Combining Job dialog box, select the job that you want to
delete.

2. At the bottom of the dialog box, click Delete.

3. To delete the combining job, click Yes in the confirmation dialog box.

See also

Manage combining jobs (page 231)

Export combining jobs (page 233)

Copy a combining job
You can copy an existing job to use it as the base of a new similar job. Copying
an existing job makes creating the new job quicker, as you do not have to set
all properties manually or create items one by one.

1. In the Select Combining Job dialog box, select the job that you want to
copy.

2. At the bottom of the dialog box, click Copy.

3. Type a number for the new job.

4. Click OK.

Tekla EPM creates a new job based on the selected job. You can modify the
properties of the new job in the Combining module.
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See also

Manage combining jobs (page 231)

Renumber a combining job
You can renumber a job to re-establish the desired item number increments.
To renumber items in an existing combining job, do the following:

1. In the Select Combining Job dialog box, select the job that you want to
renumber.

2. At the bottom of the dialog box, click Renumber.

3. In the Select the pages to renumber dialog box, click the arrow buttons
to move the pages that you want to renumber to the Included list.

4. Click OK.

5. In the Starting item # field, type a new starting number.

6. In the Item increment field, type the desired numbering increment. 

For example, use 1 for single digit (1, 2, 3, ...), 5 for increments of five (5,
10, 15, ...), and 10 for increments on ten (10, 20, 30, ...).

7. To renumber the job, click OK.

See also

Manage combining jobs (page 231)

Merge combining jobs
You can create a new job by merging two existing jobs.

1. In the Select Combining Job dialog box, select the jobs that you want to
merge. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. At the bottom of the dialog box, click Merge.

3. Type a number for the new job.

4. Click OK.

The new job appears in the list of jobs.

See also

Manage combining jobs (page 231)
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Export combining jobs
Export jobs before deleting them to make the jobs available for future
reference.

1. In the Select Combining Job dialog box, select the job that you want to
export.

2. At the bottom of the dialog box, click Export.

3. In the Save As dialog box, browse to the folder where you want to save
the file.

4. Use the automatically generated name or type a new one.

5. Click Save.

The exported file is saved to the selected folder.

See also

Manage combining jobs (page 231)

Set job groups for combining jobs
By setting job groups, you can provide a sorting method for combining jobs.
For example, you can create job groups for commercial or industrial work, or
by month or year.

1. In the Select Combining Job dialog box, select the jobs for which you
want to set job groups.

2. At the bottom of the dialog box, click Set Group Name.

3. Select if you want to update the primary group or the secondary group.

4. Type a name for the group.

5. Click OK.

See also

Manage combining jobs (page 231)

5.2 Open the Combining module
To create advance bills of material, you need to open the Combining module:

• Click the Combining button at the upper-left corner of the Tekla EPM
window. 
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The Select Combining Job dialog box opens.

You can see all existing combining jobs. Next, you can create a new combining
job, or open or modify an existing combining job.

See also

Find a combining job (page 235)

Create a combining job (page 236)

Open a combining job (page 241)

Find a combining job
Use search to find a specific combining job in the Select Combining Job dialog
box.

1. At the top left corner of the Tekla EPM window, click Combining. 
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2. In the Select Combining Job dialog box, click the Combining ribbon tab.

3. On the menu, select Find Job, or press Ctrl+F on the keyboard.

4. In the Enter Value dialog box, click the arrow on the right side of the
Select a combining job list, and select a combining job number.

5. Click OK.

The selected job is highlighted in the Select Combining Job dialog box. To
open the job, double-click it, or click Open.

NOTE Jobs whose statuses are set to Closed are not shown by default. To
show closed jobs, select the Show Closed Jobs check box.

Create a combining job
You can create a combining job to Tekla EPM by simply defining the job
number, job date, and shipping date, and then saving the new job. However,
you can also further adjust the combining job properties to meet your needs:
you can modify the combining optimizations, suppliers, and input and display
units. The changes will override the company standard settings for the current
combining job.

To add a new combining job, do the following:

• At the bottom of the Select Combining Job dialog box, click Add.

The Combining Job Edit dialog box opens on the General tab.
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Note that you can also modify the combining job settings on the Customer
and Input Options tabs.

Define general, customer, and input settings
1. On the General tab, define the following details according to your needs: 

Note that the fields marked with an asterisk (*) are mandatory.

Option Description
Job Date * The date on which the bid is due.

Tekla EPM automatically uses the date when you
create the job, but you can select a different date
in the associated calendar.

Shipping Date * The date on which the job will be shipped.

Tekla EPM automatically uses the date when you
create the job, but you can select a different date
in the associated calendar.

Job # * A unique number for the combining job.

Note that the job number cannot be modified after
the job has been created.

Job Description The description of the combining job.
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Option Description
Job Location The town or city where the job takes place.
Job Status Select if the job is still in progress (Open), or if the

job has already been finished (Closed).

You can filter the Select Combining Job dialog
box, so that only open jobs are shown.

Job Group One or two job groups that help you identify and
sort combining jobs. For example, the year of the
job can be used as a job group.

Either type a job group directly in the blank field, or
click the arrow on the right side of the field to
select an existing job group.

Comment Type any additional comments on the job.
Project Management
Job

The project management job that is linked to the
estimating job.

By linking combining and project management
jobs to each other, you can share nesting results
with the Project Management module. This way,
you can save data transfer time.

2. On the Customer tab, add any relevant customer information.

3. On the Input Options tab, adjust how information can be entered in the
combining job. 

Option Description
Mark Input Type Allows you to select which format is

used when defining mark numbers.

The Any Input and Any Input -
Logical Sort options allow you to use
any format when defining marks. The
difference between the two options is
that the Any Input - Logical Sort
sorts the items in a different way.

Auto-Increment When selected, Tekla EPM
automatically populates the new
mark number with the next available
mark number when you are adding
items in the Combining dialog box.

Auto-Increment From Last Entered
Value

When selected, Tekla EPM
automatically populates the new
mark number with the next mark
number from the last added mark
number.
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Option Description
Allow Blank When selected, Tekla EPM allows

blank mark numbers.
Allow Duplicate When selected, Tekla EPM allows

duplicate mark numbers.

4. Do one of the following:

• To create the new job without further modifying the settings, click
Save.

• Click the Combining Optimizations, Suppliers, and Input/Display
Units buttons to further modify the properties of the new job.

Modify combining optimizations
1. In the Combining Job Edit dialog box, click Combining Optimizations 

The General Settings tab of the Combining Setup dialog box opens.

2. To use material grade substitutions with the optimization settings when
performing a combining run, on the General Settings tab of the
Combining Setup dialog box, select the Use Grade Substitutions check
box. 

Grade substitutions must be set in the Shape / Grade / Size
Maintenance dialog box. If the grade substitutions are not set, the
material grades in the combining run and in the supplier pricing data set
or the inventory need to match each other exactly.

3. Click the arrow buttons to move the optimization options that you want to
use to the Optimizations Included list. 

The options are:

• Inventory Exact-Match (In Stock): Use this option for inventory items
in stock that are an exact match without the use of kerf or clamp
allowance.

• Inventory Exact-Match (On Order): Use this option for inventory
items that are on purchase orders and have not yet been received and
that are an exact match without the use of kerf or clamp allowance.

• Inventory Least-Scrap (On Order): Use this option for inventory
items that are on purchase orders and have not yet been received and
that will provide the least amount of scrap.

• Inventory Least-Scrap (In Stock): Use this option for inventory items
in stock that will provide the least amount of scrap.

• Warehouse Least-Scrap: Use this option to give preference to
warehouse items that will provide the least amount of scrap.
Warehouse items will only be used when they provide less scrap than
the available inventory items.
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• Warehouse Force Inventory: Use this option to force the use of
inventory regardless of the amount of scrap, no matter where it is
located in the Optimizations Included list. This option is the opposite
of Warehouse Least-Scrap.

Note that you can only include Warehouse Least-Scrap or
Warehouse Force Inventory, not both.

4. Use the Move Up and Move Down buttons to modify the order of the
optimizations. 

The order is important while performing a combining run.

5. Click the Mult Settings - Linear Material tab to open it.

6. If you want to apply the material kerf settings defined in Shape / Grade /
Size Maintenance to the combining as part of the cutting pattern, select
the Apply Kerf check box.

7. Open the Plate Nesting Settings tab.

8. In the Shear Cut Optimization list, click a suitable shear cut option to
select it. 

The selected option determines the plate allowance to be used with the
combining:

• Use None when cutting plate on a burn table.

• Use Shear Cut - First Cut Along Length or Shear Cut - First Cut
Along Width to alert Tekla EPM that the nesting needs to allow for
that type of cut first. Then, the nesting will allow for all subsequent
cuts to be made with that condition.

9. If necessary, select the Apply Kerf check box. 

For more details, see step 6.

10. If the material grain direction is unimportant and you want Tekla EPM to
create the best possible optimization of a plate, select the Rotate Plates
for Best Fit check box.

11. Click Save.

12. Remember to click Save in the Combining Job Edit dialog box to save the
changes.

The combining optimization settings are saved for the new job.

Modify suppliers
1. In the Combining Job Edit dialog box, click the Suppliers button.

2. In the Suppliers dialog box, select suppliers for each material group in the
available lists.

3. Click OK.
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4. Remember to click Save in the Combining Job Edit dialog box to save the
changes.

Modify the input and display units
1. In the Combining Job Edit dialog box, click Input/Display Units.

2. In the Input/Display Units dialog box, select the units and the length
input types in the available lists. 

Note that there are multiple options depending on the required precision
and the desired input method.

3. Click OK.

4. Remember to click Save in the Combining Job Edit dialog box to save the
changes.

Open a combining job
To view the details and add new items to a combining job, you need to open it
in the Combining dialog box.

1. At the top left corner of the Tekla EPM window, click Combining. 

2. In the Select Combining Job dialog box, click the job that you want to
open in the navigation tree on the left, or use the Find Job command. 

NOTE Jobs whose statuses are set to Closed are not shown by default.
To show closed jobs, select the Show Closed Jobs check box.
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3. Double-click the job, or select it and click Open.

The combining job opens in the Combining dialog box.

The materials are listed in the display area at the center of the dialog box.

You can add or modify information for items in the input area on the right
side.

To customize the Combining dialog box according to your preferences, see
the instructions in Define company standard settings for combining
(page 227).

See also

Find a combining job (page 235)

Filter information in the Combining dialog box
You can create filter settings to only show certain types of items in the
Combining dialog box.

1. In the Combining dialog box, click the Combining ribbon tab.

2. On the menu, select Filter.

3. To only display specific types of items, in the Combining Filters dialog
box, select a filter type in the Type list, and click Select.
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4. Use the arrows at the center to move the items that you want to show to
the Included side of the dialog box. 

The items in the Included list will be shown when you apply the filter.

5. Click OK. 

If you want to further filter the information displayed in the Combining
dialog box, repeat steps 3 to 5 for different items. Note that only items
that match the items in the Included list will be available when setting
more filters.

If you want to clear all filter settings, click Reset.

6. To save commonly used filters, do the following:

a. Click Filter Types in the lower-left corner.

b. Click New.

c. Type a description for the filter type.

d. Create the filter settings. 

For more information, see steps 3 to 5.

e. Click Add.

f. To close the dialog box, click the Close button (X) in the upper-right
corner. 

The newly created filter type is selected in the Filter Types list.

g. To apply the filter type, click Set.

7. According to your needs, do one of the following:

• To use the filter, click Apply Filter.

• To use the filter in the job and save it until a new filter is set or the
filter is cleared, click Apply Filter & Save.

Note that the filter will remain in use even if you close and re-open the
job. After you clear the filters, the filter settings cannot be used again.

Only the items that you selected are shown in the Combining dialog box. To
show all items again, click Clear Filters.

To delete all saved filters, click Reset at the bottom right corner of the Filter
dialog box.

View all changes in a combining job
To see all changes that have been made to the data in a combining job, you
can create a specific type of report, called List Of Changes.

1. In the Combining dialog box, click the Combining ribbon tab.

2. On the menu, select List Of Changes.

3. In the List Of Changes Report Filters dialog box, do any of the following: 
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To Do this
Filter changes by user a. Select the User filter type and

click Select.

b. Click the arrow buttons to move
the users whose changes you
want to view to the Included list.

c. Click OK.
Filter changes by date a. Select the Transaction Date

filter type and click Select.

b. Do one of the following:

• Enter the start (Minimum)
and end (Maximum) dates.

• Select the Expression check
box for the start or end date.
Then, select the base date
and select how many more or
less days will be taken into
account.

c. Click OK.

4. Click Make Report.

5. In the Report Progress dialog box, do one of the following: 

To Do this
View the list of changes • Click View.

The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF
buttons at the top of the Tekla EPM Report
Viewer window to email the report via Microsoft
Outlook.

Print the list of changes a. In the Report Selection dialog box, change
the number of the printed copies by clicking
the + and - buttons.

b. If necessary, click Select Printer, select which
device you want to use for printing, and click
OK.

You can also select Default Printer to always
use the default printer with this report, or No
Printer to reset the current printer.

c. Click Print.

d. Click Yes.
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To Do this
Export the list of
changes

a. Click Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Browse to the location where you want to save
the exported file, and click Save.

e. Modify the file name according to your needs.

f. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email check box.

g. To open the file after exporting it, select the
Open Exported Document check box.

h. Click Export.

6. To close the dialog box, click the Close button (X) in the upper-right
corner.

5.3 Manage combining items
You can manage combining items in many ways: add new ones, copy or
modify existing ones, and delete unnecessary ones. You can modify existing
combining items in a bill of materials either one by one or as a group. In
addition, you can choose to modify items of a certain shape, or select the
items to modify in the Combining dialog box. You can also copy a page of
combining items onto a new page in the job.

For more information, see the following links:

Add a combining item (page 245)

Modify a single combining item (page 248)

Modify multiple combining items (page 248)

Modify selected combining items (page 249)

Modify the shape, grade, dimension, or length of combining items (page 250)

Modify the shape, grade, dimensions, or length of selected combining items
(page 250)

Copy a page of combining items (page 251)
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Add a combining item
To add a new material item to a combining job:

1. At the bottom of the Combining dialog box, click New.

2. Define the item properties. 

NOTE The visible input fields and their order depend on the settings
that you have defined in the Input Fields dialog box that you can
access via Maintenance --> Combining --> Edit Input Fields .

The properties marked with an asterisk (*) in the following table are
mandatory information.

Option Description
Item * The item number.

You can modify the item number manually or use
the item number automatically determined by
Tekla EPM.

Default item increments are set in Combining
Company Standards dialog box, but you can
modify them for each job. We recommend leaving
spaces between items, so that you can later add
items between existing items.

If necessary, you can reset the item number
intervals in Job Maintenance.

Quantity * The number of pieces to be added.

Use the numeric keypad in the quantity field to
add, multiply, divide, or subtract numbers to adjust
the quantity.

Shape * The material shape of each piece.

Either click the arrow on the right side of the
Shape field to select the shape, or type the shape
indicator in the field (for example, HSS).

Grade * The material grade of each piece.

Depending on the shape, the grade can also be
mandatory information.

Either click the arrow on the right side of the
Grade list to select the grade, or type the grade
indicator in the field.

Dimensions * The material dimension, or material size, of each
piece.

Depending on the shape, the dimension can also
be mandatory information.
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Option Description
Click the Dimensions field to select an available
material dimension, and double-click the desired
dimension in the list.

TIP You can also use a custom material
dimension. Note that the dimension is not
automatically added to the material
database.

To use a custom dimension, do the following:

a. Click in the Dimensions field.

b. Click Add Size.

c. Define the dimension properties.

d. Click Save.

You can now select the dimension and use it.

Length The length of each piece.

Default length input settings are set in Company
Standards, but you can modify them for each job.

Mark # The mark number of the item.

Enter maximum 25 characters. The maximum
number of characters also depends on the Mark
Input Type setting that you have selected in the
Combining Company Standards dialog box.

Reference # A reference number that links the items in the
advanced bill of materials, or the combining job, to
production control items.

When you load materials from a combining job to
Purchasing, this reference number is used. Later,
when the purchased items are received and
imported to Production Control, they will have
the same reference number.

You can enter maximum 255 characters in the
Reference # field.

Category, Sub-Category A class used for sorting items within a job.
Categories and sub-categories can be used for
filtering the information in the Combining dialog
box.

The available categories and sub-categories are
created in Combining Company Standards.
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Option Description
If necessary, you can also assign quantity
multipliers to sub-categories.

Click the arrow on the right side of the Category or
Sub-Category field and select an existing category,
or type a new category in the field.

Sequence The sequence number assigned to the item.

Click the arrow on the right side of the Sequence
field to select a sequence number, or type the
number in the field.

Comment An optional comment that you can type for the
item.

3. Click Add.

See also

Manage combining items (page 245)

Modify a single combining item
You can modify a single combining item in a bill of materials directly in the
Combining dialog box.

1. In the upper navigation tree or the display area, click the item that you
want to modify. 

The properties of the selected item appear on the right side of the dialog
box.

2. Modify the properties according to your needs. 

For example, you can select another category in the Category list or
change the number in the Quantity field.

3. Click Edit to save the changes.

The properties of the selected combining item are saved and updated to the
Combining dialog box.

Modify multiple combining items
Use the Global Edit command to make specific changes to the properties of
all or multiple items in a combining job at one go. This way, you can save time,
as you do not need to change the properties of each item individually.

1. In the Combining dialog box, click the Combining ribbon tab.
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2. In the drop-down menu, select Global Edit --> Global Edit. 

The Combining Global Edit Filters dialog box opens.

3. To only modify specific types of items, select a filter type in the Type list,
and click Select.

4. In the Filter dialog box, click the arrow buttons to move the items whose
properties you want to modify to the Included list.

5. Click OK. To further limit the items to be modified, repeat steps 3 to 5 for
all necessary filter types.

6. At the bottom of the Combining Global Edit Filters dialog box, OK.

7. In the Global Edit dialog box, select check boxes next to the properties
that you want to update. 

You can also use the Un-check All and Check Changed Fields buttons to
quickly clear or select check boxes.

8. Modify the selected properties in the Global Edit dialog box according to
your needs. 

For example, you can change the category of the items by selecting an
option in the Category list, or type a comment for the items.

9. Click Update.

The Global Edit dialog box closes. The changes you made to the combining
item properties are updated to the Combining dialog box.

Modify selected combining items
Use the Global Edit Selected command to select a group of combining items
in a bill of materials and modify their properties at one go.

1. In the Combining dialog box, select the items that you want to modify. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Combining ribbon tab.

3. On the menu, select Global Edit --> Global Edit Selected .

4. In the Global Edit dialog box, select check boxes next to the properties
that you want to update. 

You can also use the Un-check All and Check Changed Fields buttons to
quickly clear or select check boxes.

5. Modify the selected properties in the Global Edit dialog box according to
your needs. 

For example, you can change the category of the items by selecting an
option in the Category list, or type a comment for the items.
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6. Click Update.

The changes you made to the combining item properties are updated to the
Combining dialog box.

Modify the shape, grade, dimension, or length of combining
items
Use the Global Edit By Shape command to modify the shape, grade,
dimension, or length of the selected or filtered items in the Combining dialog
box.

1. In the Combining dialog box, click the Combining ribbon tab.

2. On the menu, select Global Edit --> Global Edit By Shape .

3. In the Shape list at the top of the Combining Global Edit Filters dialog
box, select the shape.

4. To only modify specific types of items, select a filter type in the Type list,
and click Select.

5. In the Filter dialog box, click the arrow buttons to move the items whose
properties you want to modify to the Included list.

6. Click OK. 

To further limit the items to be modified, repeat steps 4 to 6 for all
necessary filter types.

7. At the bottom of the Combining Global Edit Filters dialog box, OK.

8. In the Global Edit dialog box, select check boxes next to the properties
that you want to update. 

You can also use the Un-check All and Check Changed Fields buttons to
quickly clear or select check boxes.

9. Modify the selected properties in the Global Edit dialog box according to
your needs. 

For example, you can change the category of the items by selecting an
option in the Category list, or type a comment for the items.

10. Click Update.

The changes you made to the combining item properties are updated in the
Combining dialog box.
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Modify the shape, grade, dimensions, or length of selected
combining items
Use the Global Edit By Shape command to modify the shape, grade,
dimension, or length of the selected items in the Combining dialog box.

1. In the Combining dialog box, select the items that you want to modify.

2. Click the Combining ribbon tab.

3. On the menu, select Global Edit --> Global Edit Selected By Shape .

4. In the Global Edit dialog box, select check boxes next to the properties
that you want to update. 

You can also use the Un-check All and Check Changed Fields buttons to
quickly clear or select check boxes.

5. Modify the selected properties in the Global Edit dialog box according to
your needs.

6. Click Update.

The changes you made to the combining item properties are updated to the
Combining dialog box.

Copy a page of combining items
Use the Copy Page command to copy all items on a page of the combining job
onto a new page.

1. In the Combining dialog box, select any item that is on the page that you
want to copy.

2. Click the Combining ribbon tab.

3. On the menu, select Copy Page.

4. In the Copy Page dialog box, type the new page number in the New Page
# field.

5. Click Copy.

The copied items are added to the Combining dialog box.

5.4 Combine materials in the Combining module
To mult and nest materials in the Combining dialog box, use the Combine
command. You can then save and review the combining results.

1. In the Combining dialog box, click the Combining ribbon tab.
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2. On the menu, select Combine. 

The Select Combining Run dialog box opens. When you are performing
the first combining run for a combining job, the list in the dialog box is
empty.

3. Click a desired combining option to select it. 

The options are:

• Mult: combines linear items, like beams and angles.

• Nest: combines items that have area, like plates or gratings.

• Mult & Nest: combines all items.

The Combining Run Filters dialog box opens.

NOTE Filtering items is optional, so you can skip steps 4 to 7 if you do
not want to filter out items from the combining run.

4. To only combine specific types of materials, select a filter type in the Type
list, and click Select.

5. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the items that you want to combine to
the Included list.

• Type the maximum and minimum values for the items that you want
to combine.

6. Click OK to apply the filter. 

Repeat steps 4 to 6 for each filter type that you want to set.

7. In the Combining Run Filters dialog box, click OK.

8. To ensure that you are using the correct settings, click the Optimizations,
INV Filter, and Suppliers buttons. 

If necessary, you can modify the settings.

9. To combine the materials, click the button at the bottom of the
Combining Run Filters dialog box, or press F4.

Tekla EPM combines the materials. After the combining process is finished, the
Combining Run Results dialog box opens.

• Piece mark items included with the selected stock lengths are displayed at
the lower-left section of the dialog box.

• Combining results are shown in both the display area and in the summary
grid at the lower-right section of the dialog box.
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• The material cost represents the pricing of the materials in the pricing
database that was used in the combining run.

TIP You can save the combining run to view it later and compare it with
another combining run. To do so, click Save Combining Run at the
bottom of the Combining Run Results dialog box. No cut lists are
generated when you save the combining run.

See also

Rename a combining run (page 253)

Compare combining runs (page 261)

View combining run filter settings (page 253)

Modify run-specific pricing information (page 254)

Recombine all items (page 258)

Recombine items of a shape (page 258)

Recombine items of a material grade (page 259)

Recombine a material dimension (page 260)

Update combining information and recombine all items (page 260)

Export materials for combining (page 78)

Rename a combining run
When you save a combining run, Tekla EPM automatically uses the date/time
stamp as the combining run name. You can also rename the combining run.
Renaming the combining run makes it easier to identify a specific combining
run when you want to compare combining runs.

1. In the Combining Run Results dialog box, click the Run Description
button.

2. In the Enter Value dialog box, type a new name for the combining run.

3. Click OK.

The name is updated. You can see the combining run name in the Run
Description button at the bottom of the Combining Run Results dialog box.

View combining run filter settings
You can view which filter settings are used in the current combining run. Note
that you cannot modify the filter settings of the combining run.

1. In the Combining Run Results dialog box, click the Combining Run
ribbon tab.
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2. On the menu, select View Filters.

3. In the Combining Run Filters dialog box, do one or more of the following:

• To view the optimization settings used for the combining run, click
Optimizations.

• To view the combining run inventory filter setting used for the
combining run, click INV Filter.

• To view the supplier settings used for the combining run, click
Suppliers.

4. When you have viewed the settings, click the Close button (X) in the
upper-right corner of the dialog box. 

The Combining Run Filters dialog box closes.

Modify run-specific pricing information
After performing the first combining run, you can modify length options that
are only used in that specific combining job. For example, L 3 x 3 x ¼ materials
have 40'0 and 20'0 lengths. If you only want to combine the 20'0 lengths, you
need to delete the 40'0 lengths from Run-Specific Pricing Maintenance. Any
changes that you make will override the values in the global pricing database,
but only for the current combining run.

You can also modify a group of items in the combining run at one go. For more
information, see Modify a group of items in run-specific pricing maintenance
(page 256).

1. In the Combining Run Results dialog box, click the Combining Run
ribbon tab.

2. On the menu, select Run-Specific Pricing Maintenance.

3. In the Pricing Maintenance dialog box, do any of the following according
to your needs: 

To Do this
Add material shapes,
grades and dimensions

a. At the bottom of the dialog box, click Add.

b. In the Shape list, select the shape.

c. Click the Dimensions field and select the
dimensions that you want to add.

d. In the Grade list, select the grades that you
want to add.

e. Click Save.

The shape, its dimensions, and grades are added
to the navigation tree.
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To Do this
Modify existing material
shapes, grades, and
dimensions

a. In the navigation tree, click the material
dimension that you want to modify.

b. At the lower-left corner of the dialog box, click
Edit.

c. In the Shape list, select the shape.

d. Click the Dimensions field, and select the new
dimensions in the dialog box that appears.

e. In the Grade list, select the new grades.

f. Click Save.

The shape, its dimensions, and grades are updated
to the navigation tree.

Add lengths or sizes a. In the navigation tree, click the material
dimension for which you want to add lengths.

b. Click New under the Normal Price field.

c. Type the length and price.

d. Click Add.

The length is added to the list of lengths.
Modify or delete lengths a. In the navigation tree, click the material

dimension that you want to modify or delete.

b. In the list of lengths, select a length.

c. Do one of the following:

• To modify the length, type a new length
and price, and click Edit.

• To permanently delete the length, click
Delete, and in the confirmation dialog box,
click Yes.

Change the pricing of a
length

a. In the navigation tree, select the material
dimension whose pricing you want too
change.

b. In the list on the right side of the dialog box,
select a length.

c. Do any of the following:

• To modify the special price, type a new
value in the Special Price field, and click
Save.
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To Do this
• To modify the normal price, type a new

value in the Normal Price field, and click
Edit.

You can also adjust the quantity and
lengths of the material. To change the
quantity to unlimited, type an asterisk (*) in
the Quantity field. Click Edit to save the
changes.

The pricing of the length is updated.
Delete unnecessary
material dimensions

a. In the navigation tree, select the material
dimension that you want to delete.

b. At the bottom of the dialog box, click Delete.

c. In the confirmation dialog box, click Yes to
confirm deleting the dimension.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

The changes are saved for the current combining run. Now, you need to
recombine the materials to update the combining results.

See also

Recombine all items (page 258)

Recombine items of a shape (page 258)

Recombine items of a material grade (page 259)

Recombine a material dimension (page 260)

Update combining information and recombine all items (page 260)

Modify a group of items in run-specific pricing maintenance
You can modify the properties of a group of items while you are in the Pricing
Maintenance dialog box. For example, you can only make certain lengths
available for combining by using the Set Lengths option. Any changes that
you make will override the values in the global pricing database, but only for
the current combining run.

For information on how to access the Pricing Maintenance dialog box, see
Modify run-specific pricing information (page 254).

1. In the Pricing Maintenance dialog box, click the Pricing ribbon tab.

2. On the menu, select Global Edit.
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3. In the Shape list at the top of the Pricing Global Edit dialog box, select
the shape whose grades and dimensions you want to modify. 

The grades and dimensions of the shape appear in the dialog box.

4. In the Grades section, click the arrow buttons to move the grades that
you want to modify to the Included list.

5. In the Dimensions section, click the arrow buttons to move the
dimensions that you want to modify to the Included list.

6. In the lower-right corner, select an option. 

The options are:

• Increase By Percentage: Increases the prices of the selected items by
a specific percentage.

• Decrease By Percentage: Decreases the prices of the selected items
by a specific percentage.

• Increase By Amount: Increases the prices of the selected items by a
certain sum.

• Decrease By Amount: Decreases the prices of the selected items by a
certain sum.

• Set Amount: Sets the prices of the selected items to a specific sum.

• Set Quantity: Allows Tekla EPM to only use a specific number of the
selected lengths.

• Set Lengths: Allows you to add lengths for the selected items either
one by one or as a range.

• Set Lengths (No Price): Allows you to add lengths for the selected
items either one by one or as a range. No pricing information is added.

New fields appear at the bottom of the dialog box.

7. Modify the values in the fields according to your needs.

8. Click Save.

9. To close the dialog box, click the Close button (X) in the upper-right
corner.

The changes are saved for all selected material grades and dimensions. Now,
you need to recombine the materials

Example: Change combining lengths of angles

In this example, we will modify all angles so that the only available length for
combining is 20 inches.

1. In the Shape list at the top of the Pricing Global Edit dialog box, select L.

2. Click the double arrow buttons to move all grades and dimensions to the
Included list.
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3. Select the Set Lengths option button.

4. Click New.

5. Leave the Quantity field blank to allow Tekla EPM to use an unlimited
quantity of the length.

6. Length field, enter 20'0".

7. In the Normal Price field, enter a price.

For example, set the price to $25,50/CWT.

8. Click Add.

9. Click Save

Now, the only angle length available in recombining is 20'0".

See also

Recombine all items (page 258)

Recombine items of a shape (page 258)

Recombine items of a material grade (page 259)

Recombine a material dimension (page 260)

Update combining information and recombine all items (page 260)

Recombine all items
If the combining results need to be changed to fit specific material
applications, such as different material lengths or plate sizes, you need to
recombine items. The Recombine All command recombines all items in the
previous combining run.

1. In the Combining Run Results dialog box, click the Combining Run
ribbon tab.

2. On the menu, select Recombine All.

3. In the first confirmation dialog box, click Yes to recombine all items.

4. In the second confirmation dialog box, click Yes to save the previous
combining run or No to recombine materials without saving the
combining run. 

By saving the previous combining run, you can compare the differences
between the previous combining run and the new one.

Tekla EPM performs the combining run and reloads the information that you
selected. The materials recombine to the lengths changed in Run-Specific
Pricing Maintenance.
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Recombine items of a shape
To recombine materials after adding new items, use the Recombine Shape
command in the Combining Run Results dialog box.

1. In the Combined navigation tree, click the + sign to show available
material shapes.

2. Click the material shape to which you have added items. 

Only the items of the selected shape are shown.

3. Click the items that you want to recombine to select them. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

4. Click the Combining Run ribbon tab.

5. On the menu, select Recombine Shape.

6. In the first confirmation dialog box, click Yes to recombine the selected
shape.

7. In the second confirmation dialog box, click Yes to save the previous
combining run or No to recombine materials without saving the
combining run. 

By saving the previous combining run, you can compare the differences
between the previous combining run and the new one.

Tekla EPM recombines the selected items.

Recombine items of a material grade
To recombine materials after changes have been made to material grades, use
the Recombine Grade command in the Combining Run Results dialog box.

1. In the Combined navigation tree, click the + sign under a material shape
to show available material grades.

2. Click a material grade to select it. 

Only the selected material grade is shown.

3. Click the items that you want to recombine to select them. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

4. Click the Combining Run ribbon tab.

5. On the menu, select Recombine Grade.

6. In the first confirmation dialog box, click Yes to recombine the selected
grade.
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7. In the second confirmation dialog box, click Yes to save the previous
combining run or No to recombine materials without saving the
combining run. 

By saving the previous combining run, you can compare the differences
between the previous combining run and the new one.

Tekla EPM recombines the selected items.

Recombine a material dimension
When changes have been made to a material dimension in the combining
material list, use the Recombine Size command to recombine the dimension.
Note that you need to have the Combining Run Results dialog box open.

1. In the Combined navigation tree, click the + sign, and select a material
dimension. 

Only the selected material dimension is shown.

2. Click the Combining Run ribbon tab.

3. On the menu, select Recombine Size. 

A confirmation dialog box appears, asking if you want to recombine the
selected dimension.

4. In the first confirmation dialog box, click Yes to recombine the selected
dimension.

5. In the second confirmation dialog box, click Yes to save the previous
combining run or No to recombine materials without saving the
combining run. 

By saving the previous combining run, you can compare the differences
between the previous combining run and the new one.

Tekla EPM recombines the selected material dimension.

Update combining information and recombine all items
When new materials have been added, or material pricing has changed, use
the Reload Information & Recombine All command. Tekla EPM will then
update the material and pricing information and perform a new combining
run.

Note that all run-specific information will be lost if you use the Reload
Information & Recombine All command.

1. In the Combining Run Results dialog box, click the Combining Run
ribbon tab.
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2. On the menu, select Reload Information & Recombine All. 

A confirmation dialog box appears, asking if you want to recombine all
items.

3. In the first confirmation dialog box, click Yes to confirm recombining all
items.

4. In the second confirmation dialog box, click Yes to save the previous
combining run or No to recombine materials without saving the
combining run. 

By saving the previous combining run, you can compare the differences
between the previous combining run and the new one.

5. In the third confirmation dialog box, click Yes to reload and update the
items to be recombined, or No to not reload and update the items.

6. In the fourth confirmation dialog box, click Yes to reload and update the
pricing information, or No to keep the current pricing information.

Tekla EPM performs the combining run and reloads the information that you
selected.

Compare combining runs
You can view and compare the changes that were made from one combining
run to another. This is useful for comparing drops for the use of different
stock lengths or pricing differences between two vendors.

Note that you must have saved a previous combining run to compare it with
the current combining run.

1. In the Combining Run Results dialog box, click the Combining Run
ribbon tab.

2. On the menu, select Compare With a Previously Saved Run.

3. In the Select Combining Run dialog box, click a previously saved
combining run in the list to select it.

4. Click Compare. 

The Combining Run Compare dialog box opens, displaying the
information of both combining runs. Any differences are marked with an
asterisk (*).

5. In the navigation tree in the left-hand pane, click a material size to select
it.

6. View the differences for the size in the different combining runs.

7. To close the comparison view, click the Close button (X) in the upper-right
corner of the Combining Run Compare dialog box.
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View, print, or export combining run reports
You can create different kinds of reports based on the combining run results.
You can then view, print, or export the reports according to your needs.

1. In the Combining Run Results dialog box, click the Combining Run
ribbon tab.

2. On the menu, select Reports.

3. To only include particular shapes, grades, or dimensions in the reports, in
the Combining Run Report Filters dialog box, select a filter type in the
Type list, and click Select.

4. In the Filter dialog box, click the arrow buttons to move the shapes,
grades, and dimensions that you want to include to the Included list.

5. Click Make Report.

6. In the Report Selection dialog box, select the report.

7. If you want to include your company's logo in the report, select Show
Company Logo.

8. Do any of the following according to your needs: 

To Do this
View the report • Click View.
Print the report a. In the Report Selection dialog box, change the

number of the printed copies by clicking the +
and - buttons.

b. If necessary, click Select Printer, select which
device you want to use for printing, and click OK.

You can also select Default Printer to always
use the default printer with this report, or No
Printer to reset the used printer.

c. Click Print.

d. Click Yes.
Export the report a. Click Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Browse to the location where you want to save
the exported file, and click Save.

e. Modify the file name according to your needs.
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To Do this
f. To attach the exported file to a Microsoft

Outlook email and send it to a recipient, select
the Attach to Email check box.

g. To open the file after exporting it, select the
Open Exported Document check box.

h. Click Export.

See also

Combine materials in the Combining module (page 251)

5.5 Load combining items into purchasing
Load materials in a bill of materials into a requisition or a purchase order, so
that they can be purchased. You can either load all combining items into a
requisition or a purchase order, or select the items that you want to load.

Note that Tekla EPM only allows you to load the same materials into
purchasing once.

When the materials are sent to purchasing, Tekla EPM populates the reference
number for both the combining job items and the purchasing items. However,
the combining items and the purchasing items are not linked.

See also

Load all combining items into a requisition (page 263)

Load selected combining items into a requisition (page 264)

Load all combining items into a purchase order (page 265)

Load the selected combining items into a purchase order (page 265)

Load all combining items into a requisition
To load all items in a bill of materials into a requisition, use the Load Material
Into Requisition command.

1. In the Combining dialog box, click the Combining ribbon tab.

2. On the menu, select Purchasing --> Load Material Into Requisition .

3. In the Select Requisition dialog box, select a requisition and click OK. 

If necessary, you can also create a new requisition and load the items into
it.

4. Click OK.
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5. In the Purchasing Import Filters, do one of the following: 

To Do this
Load all items • Click Import.
Filter out items
that you do
not want to
load

a. On the left side of the dialog box, select a filter type in
the Type list, and click Select.

b. Click Select.

c. Click the arrow buttons to move the items that you want
to load to the requisition to the Included list.

The items on the Not Included side will not be sent to
purchasing.

d. Repeat the process for different filter types until you
have filtered out all unnecessary items.

e. Click Import.

6. In the Import Items dialog box, click OK to return to the Combining
dialog box.

Items are sent to the selected requisition. To view and use the requisition,
open the Purchasing module and go to the Requisitions tab.

Load selected combining items into a requisition
Use the Load Selected Material Into Requisition command to select the
items in a bill of materials that you want to load into a requisition.

1. In the Combining dialog box, select the items that you want to load. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Combining ribbon tab.

3. On the menu, select Purchasing --> Load Selected Material Into
Requisition .

4. In the Select Purchase Order dialog box, select a purchase order and
click OK. 

If necessary, you can also create a new purchase order and load the items
into it.

5. Click OK

6. Click OK to close the Import Items dialog box.

Items are sent to the selected requisition. To view and use the requisition,
open the Purchasing module and go to the Requisitions tab.
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Load all combining items into a purchase order
Use the Load Material Into Purchase Order command to load all items in a
bill of materials into a purchase order.

1. In the Combining dialog box, click the Combining ribbon tab.

2. On the menu, select Purchasing --> Load Material Into Purchase
Order .

3. In the Select Purchase Order dialog box, select a purchase order and
click OK. 

If necessary, you can also create a new purchase order and load the items
into it.

4. Click OK

5. In the Purchasing Import Filters, do one of the following: 

To Do this
Load all items • Click Import.
Filter out items
that you do
not want to
load

a. On the left side of the dialog box, select a filter type in
the Type list, and click Select.

b. Click Select.

c. Click the arrow buttons to move the items that you want
to load to the requisition to the Included list.

The items on the Not Included side will not be sent to
purchasing.

d. Repeat the process for different filter types until you
have filtered out all unnecessary items.

e. Click Import.

6. Click OK to close the Import Items dialog box.

Items are loaded into the selected purchase order. To view and use the
purchase order, go to the Purchasing module and open the Purchase Orders
tab.

Load the selected combining items into a purchase order
Use the Load Selected Material Into Purchase Order command to select the
items in a bill of materials that are loaded into a purchase order.

1. In the Combining dialog box, select the items that you want to load. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.
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2. On the menu, select Purchasing --> Load Selected Material Into
Purchase Order .

3. In the Select Purchase Order dialog box, select a purchase order and
click OK. 

If necessary, you can also create a new purchase order and load the items
into it.

4. Click OK

5. Click OK to close the Import Items dialog box.

Items are loaded into the selected purchase order. To view and use the
purchase order, go to the Purchasing module and open the Purchase Orders
tab.

5.6 Export a combining job to KISS
One way to save a combining job for later use is exporting it to KISS.

1. In the Combining dialog box, click the Combining ribbon tab.

2. On the menu, select Export to KISS.

3. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla EPM saves the file to the Export folder.

4. If necessary, change the file name.

5. Click Save.

A copy of the file is saved in the KISS format.

5.7 View or print combining reports
You can view or print reports that show different information about the
combining job. You can create different kinds of reports and filter the items in
the reports in several ways.

1. In the Combining dialog box, click the Combining ribbon tab.

2. In the menu, select Reports. 

The Report Filters dialog box opens.

3. To only include specific materials in the reports, in the Report Filters
dialog box, select a filter type in the Type list, and click Select.

4. In the Filter dialog box, click the arrow buttons to move the material
items that you want to include in the reports to the Included list.
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5. Click OK. 

To further limit the included items, repeat steps 3 to 5 for all necessary
filter types in the Report Filters dialog box.

6. Click Make Report.

7. In the Report Selection dialog box, click the report that you want to
create.

8. Do one or both of the following: 

To Do this
View the report • In the Report Selection dialog box, click View.

You can use the Email Excel and Email PDF
buttons at the top of the Tekla EPM Report
Viewer window to email the report via Microsoft
Outlook.

Print the report a. In the Report Selection dialog box, change
the number of the printed copies by clicking
the + and - buttons.

b. Click Print.

c. In the Select Printer dialog box, click a printer
to select it.

d. Click OK.

9. To close the dialog box, click the Close button (X) in the upper-right
corner.
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6 Create estimates

Use the Estimating module to create and modify estimates in Tekla EPM. You
can add different items to your estimates, including accessories and
assemblies. You can also mult and nest the material in an estimate, send
material to purchasing, or export the estimate to KISS, among many other
options.

NOTE Before you start working in the Estimating module, ensure that you have
adjusted estimating settings to meet the standards of your shop. For more
information, see Set up the Estimating module (page 269).

See also

Set up the Estimating module (page 269)

Open the Estimating module (page 368)

Create an estimating job (page 370)

Find an estimating job (page 369)

Open an estimating job (page 377)

Modify an estimating job (page 396)

Store document references for an estimating job (page 388)

Add an estimating item (page 401)

Copy and multiply estimating items (page 414)

Modify estimating items (page 417)

View the labor times of items (page 381)

Delete an estimating item (page 419)

Add an assembly (page 411)

Add a parametric assembly (page 412)

Create, modify, and delete production codes (page 419)

Calculate the total material cost (page 388)
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Recalculate an estimate (page 388)

View all changes in an estimating job (page 384)

Import files to and export files from the Estimating module (page 430)

Use Trimble Connect with an estimating job (page 435)

Combine materials in the Estimating module (page 439)

Load estimating materials into purchasing (page 423)

Load materials into another estimate (page 426)

Load materials into Production Control (page 428)

Create a proposal (page 440)

View, email, export, and print estimating reports (page 385)

6.1 Set up the Estimating module
Before you start to create estimates and proposals in the Estimating module,
we recommend that you take the time to set it up carefully. Once you have
created and adjusted all necessary options, standard estimating items, and
settings, working in the Estimating module is easier and more efficient.

To access the different Estimating Maintenance commands, do the
following:

1. Click the Maintenance ribbon tab.

2. On the menu, go to Estimating.

For more information, see the following links:

Create, modify, and delete accessories (page 276)

Create and manage parametric assemblies (page 282)

Adjust cleaning types and cleaning costs (page 294)

Create, modify, and delete paint types (page 298)

Modify freight pricing (page 301)

Manage estimating jobs (page 303)

Adjust labor information (page 307)

Manage estimate statuses (page 353)

Adjust standard shop information (page 354)

Create and modify shop setups (page 361)

Define company standard settings for Estimating (page 270)

Create a standard proposal setup (page 365)
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Define company standard settings for Estimating
In the Estimating Company Standards dialog box, you can define the
standard data entry settings for the Estimating module. Among other things,
you can set the job numbering and the default material finish of items, create
fabrication categories and sub-categories, select material suppliers, define
galvanizing costs including freight, and select the size input and display units.
Yyou can also modify these settings on a job by job basis in the Estimating
module.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Company Standards .

3. In the Estimating Company Standards dialog box, adjust the following
options according to your needs: 

Option Description
Job # Increment Allows you to select the default option for

automatic job numbering. The options are:

• Increment from Last Job #:

When you create a new job, Tekla EPM uses the
next available job number after the latest job
number created.

• Increment from Largest Job #: Tekla EPM uses
the next available job number after the largest
job number created.

• Don't Increment: Automatic job numbering is
not used.

You can modify the job number when you create a
new job.

Default Finish The most typical material finish for most
estimating jobs and items.

Item Increment Sets the auto-increment for item numbers.

Using the default auto-increment of 10 allows
items to be added in the list according to your
needs, without having to renumber the other items
in the job.

Keep Job Selection
Screen Open

When selected, the Select Estimating Job dialog
box stays open after a job has been selected.

Report Pricing -
Automatically Select
Last Combining Run

When selected, Tekla EPM automatically uses the
pricing used in the last saved combining run.

Create estimates 270 Set up the Estimating module



Option Description
Imports - Use Piece
Mark as Part #

When selected, imported piece marks are
automatically used as part number items in the
estimating material list.

Imports - Use as
Production Code

Select whether you want to use assembly main
marks, piece marks, drawing descriptions, or
assembly descriptions as production codes.

TIP If you use piece marks as production codes,
you can ensure that each item in a
production control job matches the same
item in a linked estimating job. This
guarantees that the corresponding items
have the same labor times.

Job # Regular
Expression

Allows the use of regular expressions to enforce a
desired format for the job numbers.

4. Click the buttons at the bottom of the dialog box to modify galvanizing
settings (page 271), fabrication categories and sub-categories (page 272),
input and display units (page 273), combining optimizations (page 274),
and suppliers (page 275).

5. When you have defined all necessary settings, click Save.

Define default galvanizing settings
You can define default galvanizing costs and freight settings used in all
estimating jobs. Whenever an item in an estimating job is marked as
galvanized, these default costs are applied to it.

1. At the bottom of the Estimating Company Standards dialog box, click
Galvanizing. 

The Galvanizing dialog box opens.

2. Define the cost per pound, minimum cost, and freight cost.

3. In Trailer Capacity, type the trailer capacity. 

If you type 0 in the field, the freight cost value will be the total cost. If you
enter a greater value, the freight cost value will be the cost per truck.

4. Define the labor prep cost as price per pound.

5. In the Weight - Percent Added field, define the percentage of galvanizing
weight to be added for each galvanized item. 

The percentage is only used to calculate the galvanizing cost. It does not
affect the weights of galvanized items in the Estimating module or
reports.

6. Click OK.
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7. In the Estimating Company Standards dialog box, click Save.

The default galvanizing settings are updated.

Note that you can also set job-specific galvanizing settings that override the
default galvanizing settings.

Create categories and sub-categories for Estimating
Categories are user-defined keywords that you can use for sorting, tracking,
and reporting. Creating categories also helps you to quickly identify the items
in your estimating jobs. For example, you can categorize jobs by fabrication
type. In addition to manually creating categories, you can choose to use
existing categories used in Steel Erection Bid Wizard. To further filter items,
you can also add sub-categories.

Note that you can also create new categories and sub-categories manually
when creating or modifying an estimating job.

Add a category

1. At the bottom of the dialog box, click the Categories button.

2. In the Company Categories dialog box, do any of the following according
to your needs: 

To Do this
Add a new category
manually

a. Click New.

b. In the Category field, type a name for the
category.

For example, Skewed beam.

c. Click Add.

The new category is added to the Category
list.

Repeat steps a to c for all new categories.
Add categories used in
Steel Erection Bid Wizard

a. Click Add SEBW Categories.

b. click the arrow buttons to move the categories
that you want to add to the Included list.

c. Click OK.

The categories are added to the Category list.

NOTE If you need to modify or delete a category, click a category to
select it in the Category list and either:

• Click Edit, change the category name, and click Edit again.

Create estimates 272 Set up the Estimating module



• Click Delete and then, click Yes to confirm deleting the
category.

3. In the Estimating Company Standards dialog box, click Save to update
the categories.

The Estimating Company Standards dialog box closes. The categories are
saved for the Estimating module.

Add a sub-category

1. At the bottom of the Estimating Company Standards dialog box, click
the Sub-Categories button.

2. In the Company Sub-Categories dialog box, click New.

3. In the Sub-Category field, type a name for the sub-category.

4. Click Add. 

The new sub-category is added to the Sub-Category list.

Repeat steps 1 to 4 for all new sub-categories.

NOTE If you need to modify or delete a sub-category, click a sub-
category to select it in the Sub-Category list and either:

• Click Edit, change the sub-category name, and click Edit again.

• Click Delete and click Yes to confirm deleting the sub-
category.

You can also add multipliers for sub-categories in the
Estimating module.

5. In the Estimating Company Standards dialog box, click Save to update
the categories.

The Estimating Company Standards dialog box closes. The sub-categories
are saved for the Estimating module.

Define default input and display units for Estimating
You can use either metric or imperial units for displaying and entering sizes,
lengths, weights, and prices in the Estimating module. In addition, you can
select how you want to enter the length and thickness for an item.

1. At the bottom of the Estimating Company Standards dialog box, click
Input/Display Units.

2. In the Input/Display Units dialog box, select the units and the length
input types in the available lists. 

Note that there are multiple options depending on the required precision
and the desired input method.
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3. Click OK.

The input and display units are saved as default units used for new estimating
jobs. If necessary, you can also adjust the units used in individual jobs. For
more information, see Define input and display units for an estimating job
(page 375).

Define default combining optimizations for Estimating
Define company-level settings for multing and nesting in the Estimating
module. If necessary, you can later change the settings job by job.

1. At the bottom of theEstimating Company Standards dialog box, click
Combining Optimizations.

2. To use material grade substitutions with the optimization settings when
performing a combining run, on the General Settings tab of the
Combining Setup dialog box, select the Use Grade Substitutions check
box. 

Grade substitutions must be set in the Shape / Grade / Size
Maintenance dialog box. If the grade substitutions are not set, the
material grades in the combining run and in the supplier pricing data set
or the inventory need to match each other exactly.

3. Click the arrow buttons to move the optimization options that you want to
use to the Optimizations Included list. 

The options are:

• Inventory Exact-Match (In Stock): Use this option for inventory items
in stock that are an exact match without the use of kerf or clamp
allowance.

• Inventory Exact-Match (On Order): Use this option for inventory
items that are on purchase orders and have not yet been received and
that are an exact match without the use of kerf or clamp allowance.

• Inventory Least-Scrap (On Order): Use this option for inventory
items that are on purchase orders and have not yet been received and
that will provide the least amount of scrap.

• Inventory Least-Scrap (In Stock): Use this option for inventory items
in stock that will provide the least amount of scrap.

• Warehouse Least-Scrap: Use this option to give preference to
warehouse items that will provide the least amount of scrap.
Warehouse items will only be used when they provide less scrap than
the available inventory items.

• Warehouse Force Inventory: Use this option to force the use of
inventory regardless of the amount of scrap, no matter where it is
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located in the Optimizations Included list. This option is the opposite
of Warehouse Least-Scrap.

Note that you can only include Warehouse Least-Scrap or
Warehouse Force Inventory, not both.

4. Use the Move Up and Move Down buttons to modify the order of the
optimizations. 

The order is important while performing a combining run.

5. Click the Mult Settings - Linear Material tab to open it.

6. In Multing Software, select the multing software that you are using.

7. If you want to apply the material kerf settings defined in Shape / Grade /
Size Maintenance to the combining as part of the cutting pattern, select
the Apply Kerf check box.

8. Open the Plate Nesting Settings tab.

9. In the Plate Nesting Software list, click the plate nesting software that
you are using to select it.

10. In the Shear Cut Optimization list, click a suitable shear cut option to
select it. 

The selected option determines the plate allowance to be used with the
combining:

• Use None when cutting plate on a burn table.

• Use Shear Cut - First Cut Along Length or Shear Cut - First Cut
Along Width to alert Tekla EPM that the nesting needs to allow for
that type of cut first. Then, the nesting will allow for all subsequent
cuts to be made with that condition.

11. If the material grain direction is unimportant and you want Tekla EPM to
create the best possible optimization of a plate, select the Rotate Plates
for Best Fit check box.

12. If necessary, select the Apply Kerf check box. 

For more details, see step 7.

13. Click Save.

See also

Define company standard settings for Estimating (page 270)
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Define default suppliers for Estimating
You can define different suppliers for angles, beams, plates, rods, tubes, and
other material used in the Estimating module. This way, you can use material
pricing from the selected supplier databases by material group.

You can manage the available suppliers in Pricing Maintenance. To make
suppliers available in the Suppliers dialog box, the suppliers will first need to
be added in Pricing Maintenance.

1. At the bottom of the Estimating Company Standards dialog box, click
Suppliers.

2. In the Suppliers dialog box, select suppliers for each material group in the
available lists.

3. Click OK.

Create, modify, and delete accessories
Accessories are frequently used items that can be added to any estimate. For
example, stiffeners, gussets, base and cap plates, and embeds are good
examples of accessories. We recommend that you create all necessary
accessories at once before starting to create estimates, so that working in the
Estimating module is as quick and efficient as possible.

We recommend that you create, modify, and delete accessories in Accessory
Maintenance. You can also create accessories in an estimating job, but these
job-specific accessories cannot be saved to the accessory library, so they
cannot be reused in other estimating jobs.

To access the Accessory Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Accessory Maintenance .

The Accessory Maintenance dialog box opens.
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Create an accessory
The information that you enter for the accessory identifies the accessory
together with the material cost and the required labor time.

1. Click New.

2. If necessary, type a part number for the accessory. 

Assigning part number allows you to add an accessory to an estimating
item simply by selecting it in the item properties. Part numbers also make
identifying accessories easier. However, note that if you add an item to
the estimate by selecting the part number, you cannot modify the
properties of the accessory in the estimating job.

3. Type a description for the accessory.

4. Determine the remaining properties of the accessory: 

Option Description
Quantity The number of accessories per item to which they

are added.
Shape The material shape of the accessory.
Dimensions The material size of the accessory.
Length The length of the accessory.
Grade The material grade of the accessory.
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Option Description
Type The labor code of the accessory.
Extra The estimate extras applied to the accessory.

To add estimate extras, double-click the Extra
field.

Holes The number of holes in the accessory.
Web Holes The number of web holes in the accessory.
Stiffeners The number of stiffeners in the accessory.
Copes The number of copes in the accessory.
MHrs/Pc The number of man hours spent on the accessory.
Manual Cost The cost for the accessory that you can enter

manually.

The manual cost is optional, and it overrides the
pricing information in the pricing database.

MainPc When selected, the item to which the accessory is
added is considered a main piece.

Comment An optional and additional comment on the
accessory.

Erect Hrs The number of man hours spent on erecting the
accessory.

Erect Cost The cost of erecting the accessory.
Prod. Code The production code applied to the accessory.
Camber The camber size used with the accessory.
Holes w/o Bo The number of holes per piece in the accessory. No

bolts will be added.
Top Flg Holes, Bot Flg
Holes

The number of top flange holes or bottom flange
holes per accessory.

Welded Studs The number of welded studs per accessory.
Detailing Hrs The number of hours spent on erecting the

accessory.
Detailing Cost The amount of money used for erecting the

accessory.
Cost/Pc A cost per piece that is added to the material cost

of the accessory.

NOTE The visible input fields and their order partially depend on the
settings that you have defined in Estimating Maintenance. You
can modify the input fields and their order via Maintenance -->
Estimating --> Edit Input Fields .
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5. If necessary, select the linked material shapes and sizes to which the
accessory can be added by clicking Edit. 

Selecting linked material shapes and sizes is optional. However, limiting
the use of the accessory to the selected material shapes and sizes makes
working easier, as you do not need to scroll through all existing accessory
options whenever you want to add an accessory. If you do not select
linked material shapes, the accessory can be added to all material items.

6. In the Filter dialog box, click the arrow buttons to move the desired
material shapes and sizes to the Included list. 

Note that there are also lists at the bottom of the Filter dialog box that
allow you to select the material shapes.

7. Click OK.

8. Click Add to save the accessory.

Example: Create a stiffener for W12 beams

Note that the following example uses imperial units.

1. Click New.

2. Set the properties as follows:

a. Part #: W12m
b. Description: W12 Stiffener
c. Quantity: 1
d. Shape: PL
e. Dimensions: 5/16 x 4
f. Length: 0'-11
g. Grade: A36
h. Type: W (Baffle)

3. Click Edit and link the accessory to the range W 12 x 14 - W 12 x 152.

4. Click OK.

5. Click Add to save the accessory.

Copy accessories
1. In the accessory list, select the accessories that you want to copy. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.
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2. Click Copy. 

Copies of the selected accessories are added to the list in the Accessory
Maintenance dialog box.

3. If necessary, define part numbers for the copied accessories.

4. Modify the properties of the copied accessories according to your needs.

5. Click Save to update the accessories.

Modify an accessory
1. In the accessory list, select the accessory that you want to modify.

2. Modify the properties according to your needs.

3. Click Save to update the accessory.

Modify multiple accessories at once
1. In the accessory list, select the accessories that you want to modify. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Global Edit - Selected.

3. In the Global Edit dialog box, select check boxes next to the properties
that you want to update. 

You can also use the Un-check All and Check Changed Fields buttons to
quickly clear or select check boxes.

4. Modify the selected properties in the Global Edit dialog box according to
your needs.

5. Click Update.

Delete an accessory
1. In the accessory list, select the accessories that you want to delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Delete.

3. To permanently delete the accessories, click Yes in the confirmation
dialog box.

View, customize, print, and export accessory reports
Accessory reports show lists of existing accessories and accessory parts. You
can view the reports, print them, or export them to another file format. You
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can also create a customizable copy of the accessory reports and modify it
according to your needs.

1. In the Accessory Maintenance dialog box, click the Accessory
Maintenance ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. In the Report Selection dialog box, select the report that you want to
view, customize, print, or export.

4. Do one or more of the following: 

To Do this
View the report • In the Report Selection dialog box, click View.

The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF
buttons at the top of the Tekla EPM Report
Viewer window to email the report via Microsoft
Outlook.

Customize the report a. At the top right corner of the dialog box, click
Design.

A customizable copy of the report opens.

b. Customize the report according to your needs.
Print the report a. In the Report Selection dialog box, change

the number of the printed copies by clicking
the + and - buttons.

b. Click Print.

c. To confirm printing the selected report, click
Yes in the confirmation dialog box.

d. In the Select Printer dialog box, click a printer
to select it.

e. Click Print or press F2 on the keyboard.
Export the report a. In the Report Selection dialog box, click

Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Modify the file name according to your needs.

e. Browse to the location where you want to save
the exported file, and click Save.

f. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email check box.
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To Do this
g. To open the file after exporting it, select the

Open Exported Document check box.

h. In the Report Selection dialog box, click
Export.

5. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Create, modify, and delete accessories (page 276)

Create and manage parametric assemblies
Parametric assemblies can be any fabricated items that may vary in height,
width, or length, or according to any other variables that you define. For
example, stairs, ladders, and handrails are common parametric assemblies
can be created in Tekla EPM. Existing parametric assemblies can be added to
an estimate while working in the Estimating dialog box.

See also

Create a parametric assembly (page 282)

Example parametric assembly: Roof ladder without cage (page 288)

Modify a parametric assembly (page 292)

Import assemblies and parametric assemblies (page 187)

Export parametric assemblies (page 293)

Delete a parametric assembly (page 294)

Create a parametric assembly
You can use parametric assemblies in any estimating job, and modify the
variable values according to your needs. Tekla EPM calculates the parametric
assembly according to the values you have given.

Note that all information entered in the Parametric Assembly dialog box will
be added to the estimate when the parametric assembly is selected.

TIP To see a concrete example of creating a parametric assembly, see Example
parametric assembly: Roof ladder without cage (page 288).

To create parametric assemblies, do the following:

1. Create and name the assembly template

1. Click the Maintenance ribbon tab.
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2. On the menu, select Estimating Maintenance --> Parametric Assembly
Maintenance . 

3. In the Select Parametric Assembly dialog box, click Add.

4. Name the parametric assembly.

5. To use an existing parametric assembly as the basis for the new one,
select the parametric assembly in the Template list. 

Copying the information from an existing parametric assembly speeds up
creating a parametric assembly. However, you can also create the
parametric assembly from scratch.

6. Click Add.
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2. Create variables, items, and formulas

Variables define the parametric calculations to be used.

1. In the Parametric Assembly dialog box, click the Parametric Assembly
ribbon tab.

2. On the menu, select Parametric Assembly Variables. 

3. In the Parametric Assembly Variables dialog box, click New.

4. Enter a name and description for the variable.

5. Select a suitable variable type:

• Integer Number: a whole number. The Integer Number variable type
is normally used for quantity type calculations where no fractions are
required.

• Decimal Number: a decimal number. The Decimal Number variable
type has various uses.

• Length - Feet, Inches, Fractions - Meters: length. The correct input
format is determined in the name of the variable type.

• Length - Inches, Fractions - Millimeters: length. The correct input
format is determined in the name of the variable type.

• Length - Decimal Feet - Meters: length. The correct input format is
determined in the name of the variable type.

• Length - Inches, Fractions - Millimeters: length. The correct input
format is determined in the name of the variable type.

• Dimension: allows you to change the dimension of the material by
adding another variable. For example, you can have one material
dimension for a short span and one for a long span in the assembly.
The length applied to the span variable then determines which
dimension variable is used. The dimension variable can also be set
when adding the parametric assembly to an estimating job.
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• Property from EST Line Item: uses the selected property of the
estimating item that was selected when the parametric assembly was
added to the estimating job.

• Property from Assembly Line Item: uses the selected property of an
item within the parametric assembly. Note that you need to select the
desired property in the Property list, and type the item number in the
From Item # field.

6. If necessary, define a default value for the variable.

7. Click Add. 

Repeat steps 3 to 5 to add all necessary variables.

8. To close the Parametric Assembly Variables dialog box, click the Close
button (X) in the upper-right corner.

9. To add items to the parametric assembly, click New at the bottom of the
Parametric Assembly dialog box.

10. Create a comment as the first item in the parametric assembly:

a. Set Quantity to 1 and press Enter.

b. Set Shape to CO and press Enter.

c. In the Description field, type the parametric assembly name and
press Enter.

d. Click Add.

Adding a comment as the first item of the parametric assembly makes it
easier to recognize the parametric assembly in an estimating job.

11. To add another item, click New.

12. Enter properties for the item.

13. For properties that vary in the assembly, click the Formula button and
define a formula using the previously created variables. 

For more information on creating formulas, see Create formulas
(page 286).

14. If you need to add additional labor or clips to the item, click Additional
Labor & Clips and determine their properties. 

Additional labor operations could be, for example, welding, burning,
punching, or drilling. You can either determine the properties manually,
or use formulas to use conditions for the additional labor and clips.

Note that standard clips will be added according to the selected labor
code when you add the parametric assembly to an estimate.

15. Once you have determined all necessary properties for the item, click
Add. 

Repeat steps 9 to 12 to add the remaining items to the parametric
assembly.
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3. Test the parametric assembly

We recommend that you test all parametric assemblies that you have created
to verify that the calculations work as expected.

1. While in the Parametric Assembly dialog box, click the Parametric
Assembly ribbon tab.

2. On the menu, select Test Parametric Assembly. 

3. In the Parametric Assembly - Variables dialog box, enter a value for a
variable and click Set Value. 

For example, you could set the Ladder Length variable created in our
example to 20'-0 and Ladder Width to 1'-6".

Repeat step 3 for each variable in the parametric assembly.

4. Click Calculate Parametric Assembly. 

You can now see the results of the calculations. Verify that the
information is correct.

5. To view the additional labor and clips that were added for the selected
item when creating the parametric assembly, click Additional Labor &
Clips.

6. To close the results, click the Close button (X) in the upper-right corner.

7. Do one of the following:

• To re-test the calculations, set new values for the variables.

• To close the Parametric Assembly - Variables dialog box, click the
Close button (X) in the upper-right corner.

Create formulas
In the Formula dialog box, you can create formulas that Tekla EPM uses to
calculate values. For example, you can create a formula to define the cost of
an estimate extra, or to define the size of an angle used in a parametric
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assembly. You can access the Formula dialog box by clicking the Formula
button on the right side of a field.

The formula functions allow you to add the following things to the formula:

• Standard Variables: the properties of a material item.

• Additional Variables: any previously added variables related to the
parametric assembly or the estimate extra.

• IF / THEN / ELSE / ENDIF statements

• The CEILING, FLOOR, and ROUND rounding functions.

The CEILING function always rounds up, the FLOOR function always
rounds down, and the ROUND function rounds up at half and down by less
than half.

• Several trigonometry functions, such as SIN, COS, and HYP.
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Example formula: Calculate the cost of an estimate extra

In this example, we want the estimate extra to add a cost of $100 if the length
of the item is less than or equal to 40'. If the length is greater than 40', the
added cost should be $150.

In this case, we need the following formula:

IF ([Length] <= 40') THEN (100) ELSE (150) ENDIF
1. In the Estimate Extra dialog box, select the Cost Expression option, and

click Formula.

2. In the Formula dialog box, click the IF / THEN / ELSE / ENDIF button.

3. Go to the parenthesis after IF.

4. In the Additional Variables list, select Length.

5. Click Add Variable.

[Length] appears inside the parenthesis after IF.

6. Enter a space after [Length].

7. After the space, type <=40'
8. Go to the parenthesis after THEN.

9. Type 100
10. Go to the parenthesis after ELSE.

11. Type 150
The formula is now ready.

12. Click OK to close the Formula dialog box and use the formula in the
estimate extra.

Example parametric assembly: Roof ladder without cage
The following example describes creating a roof ladder as a parametric
assembly in Tekla EPM. The example can be helpful when you are learning to
create parametric assemblies yourself.

1. Create a description for the parametric assembly

1. Click New and create an item with the following properties: 

• Shape: CO
• Description: Roof ladder (no cage)

2. Click Add.
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2. Create variables for calculating the ladder length and the number of rungs
and collection clips

To create variables for calculating appropriate length, and the number of
rungs and connection clips for the ladder, do the following:

1. Click the Parametric Assembly ribbon tab.

2. On the menu, select Parametric Assembly Variables.

3. Create the following variables without adding default values: 

• Overall length of the ladder

• Variable Name and Variable Description: Ladder Length
• Variable Type: Length – Feet, Inches, Fractions –

Meters
• Overall width of the ladder

• Variable Name and Variable Description: Ladder Width
• Variable Type: Length – Feet, Inches, Fractions –

Meters
4. To close the Parametric Assembly Variables dialog box, click the Close

button (X) in the upper-right corner.

3. Create side rails

1. Click New and create an item with the following properties: 

• Quantity: 2
• Shape: FB
• Dimensions: ½ x 3

2. To create a formula for calculating the length, click Formula next to
Length.

3. In the Formula dialog box, do the following:

a. Clear the existing text in the box at the top of the dialog box.

b. In the Additional Variables list, select Ladder Length.

c. Click Add Variable.

d. To have the ladder project beyond the landing elevation, type + and
the length in feet and inches without a space between. 

The formula should now read approximately: [Ladder Length]
+3'6.

e. Click OK to save the length formula and return to the Parametric
Assembly dialog box. 

Note that whenever a property is calculated with a formula, it is
marked with (F) in the Parametric Assembly dialog box.
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4. Click Add.

4. Create the rungs

1. Click New.

2. To create a formula for calculating the number of rungs, click Formula
next to Quantity. 

We want to calculate the number of rungs determined by the ladder
length, starting 6 inches above the landing. The result should then be
divided by 1'-0.

3. In the Formula dialog box, do the following:

a. Clear the existing text in the box at the top of the dialog box.

b. In the Parametric Assembly Variables list, select Ladder Length.

c. Click Add Variable.

d. Type +6".

e. Add parentheses () around [Ladder Length]+6".

f. Type /12" directly after the right parenthesis.

g. Click OK to save the length formula and return to the Parametric
Assembly dialog box.

4. Set the shape and dimension properties of the rungs as follows: 

• Shape: RD (round bar)

• Dimensions: ¾"
5. To create a formula for calculating the length of the rungs, click Formula

next to Length.

6. In the Formula dialog box, do the following:

a. Clear the existing text in the box at the top of the dialog box.

b. In the Parametric Assembly Variables list, select Ladder Width.

c. Click Add Variable.

d. Click OK to save the length formula and return to the Parametric
Assembly dialog box.

7. Click Add.

5. Create the connection clips

1. Click New.

2. To create a formula for calculating the number of clips , click Formula
next to Quantity. 

We want to calculate the number of clips based on the length of the
ladder.
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3. In the Formula dialog box, do the following:

a. Clear the existing text in the box at the top of the dialog box.

b. Type CEILING.

c. Type the left parenthesis (.

d. In the Parametric Assembly Variables list, select Ladder Length.

e. Click Add Variable.

f. After the variable, type /6').

g. To calculate enough clips for both sides, type *2.

h. To include the first and last clips for both rails, type +2. 

The calculation should read CEILING([Ladder Length]/6’)*2+2.
This means that Tekla EPM calculates the total ladder length divided
by 6’-0, rounds it to the nearest foot, multiplies the result by 2, and
then adds 2 more connection clips.

i. Click OK to save the length formula and return to the Parametric
Assembly dialog box.

4. Set the shape and dimension properties as follows: 

• Shape: FB
• Dimensions: 3/8 x 4

5. Click Add.
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6. View the result

You can now view the result and test the parametric assembly.

For more information on testing a parametric assembly, see Create a
parametric assembly (page 282).

Modify a parametric assembly
Existing parametric assemblies can be modified later on. You can rename the
parametric assembly, or modify the items that form the parametric assembly
or the variables used in calculations.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating Maintenance --> Parametric Assembly
Maintenance .

3. In the Select Parametric Assembly dialog box, select the desired
parametric assembly that you want to modify.

4. Do any of the following: 

To Do this
Change the name of the
parametric assembly

a. At the bottom of the Select Parametric
Assembly dialog box, click Set Name.

b. Type a new name for the assembly.
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To Do this
c. Click OK.

Modify items a. At the bottom of the Select Parametric
Assembly dialog box, click Open.

b. Select the item that you want to modify.

c. Modify the properties of the item according to
your needs.

Among other things, you can change the
quantity, shape, dimensions, or length of the
item.

d. Click Edit to save the changes.
Modify variables a. At the bottom of the Select Parametric

Assembly dialog box, click Open.

b. Click the Parametric Assembly ribbon tab.

c. On the menu, select Parametric Assembly
Variables.

d. Select the variable that you want to modify.

e. Modify the variable name, description, variable
type, and default value according to your
needs.

f. Click Edit to save the changes.

5. To close the Select Parametric Assembly dialog box, click the Close
button (X) in the upper-right corner.

See also

Create a parametric assembly (page 282)

Example parametric assembly: Roof ladder without cage (page 288)

Delete a parametric assembly (page 294)

Export parametric assemblies
You can export a parametric assembly as a text file.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating Maintenance --> Parametric Assembly
Maintenance .

3. In the Select Parametric Assembly dialog box, select the parametric
assembly that you want to export. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.
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4. Click the Parametric Assembly ribbon tab.

5. On the menu, select Export Selected Parametric Assemblies.

6. In the Save As dialog box, browse to the location where you want to save
the text file.

7. Name the text file.

8. Click Save. 

The parametric assembly is saved in the selected location as a text file.

9. To close the dialog box, click the Close button (X) in the upper-right
corner.

Delete a parametric assembly
You can delete any parametric assemblies that you do not use. Note that
deleting a parametric assembly cannot be reversed, so a deleted assembly can
no longer be used in Tekla EPM.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating Maintenance --> Parametric Assembly
Maintenance .

3. In the Select Parametric Assembly dialog box, select the parametric
assembly that you want to delete.

4. Click Delete.

5. To permanently delete the selected parametric assembly, click Yes in the
confirmation dialog box.

Adjust cleaning types and cleaning costs
Tekla EPM contains multiple standard cleaning types that you can use in the
Estimating module. In the Cleaning Maintenance dialog box, you can review
the existing cleaning types, and modify the cleaning types and cleaning costs
to meet your needs. You can also add new cleaning types, and set the default
cleaning type used in all future estimating jobs.

1. Click the Maintenance ribbon tab.

2. On the menu, go to Estimating Maintenance --> Cleaning
Maintenance . 
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The Cleaning Maintenance dialog box opens, showing the existing clean
types.

TIP If necessary, you can change the units in the dialog box from
imperial to metric or the other way around. Click the Cleaning
Maintenance ribbon tab, and in the menu, select a suitable Switch
To Metric/Imperial Mode command.

3. Do any of the following: 

To Do this
Add a new cleaning type a. Click New.

b. In the Cleaning Type field, type
an abbreviation for the cleaning
type.

c. Type a description for the
cleaning type.

d. Type the cleaning rate and the
amount of abrasive use.

e. To set the cleaning type as the
default cleaning type for new

Create estimates 295 Set up the Estimating module



To Do this
estimating items, select the
Default check box.

If necessary, you can also change
the default cleaning type for each
existing estimating job manually
by modifying the estimating jobs
one by one (page 396).

f. Click Add.
Modify a cleaning type a. Select the cleaning type in the

list.

b. Modify the cleaning type
abbreviation, description,
cleaning rate, or amount of
abrasive use.

c. To set the cleaning type as the
default cleaning type for new
estimating items, select the
Default check box.

If necessary, you can also change
the default cleaning type for each
existing estimating job manually
by modifying the estimating jobs
one by one (page 396).

d. Click Save.
Delete a cleaning type a. Select the cleaning type in the

list.

b. Click Delete.

c. To permanently delete the
cleaning type, click Yes.

4. Click Save.

Note that you can create cleaning systems that contain various cleaning types.
For more information, see Create and apply clean systems (page 296).

Create and apply clean systems
Clean systems allow you to apply more than one cleaning type to estimating
items. You can create global estimating jobs which can be used for all new
estimating jobs, or job-specific clean systems.
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Create global clean systems
1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Cleaning Maintenance.

3. In the Cleaning Maintenance dialog box, click Clean Systems.

4. Click New Clean System.

5. Type a description for the cleaning system.

6. Use the arrow buttons to move the cleaning types that you want to
include in the clean system to the Included list.

7. To add or reduce the times each cleaning type requires, change the value
in the Quantity field.

8. If you only want to apply the cleaning system if cleaning is included in the
labor code of the item, select the Check Labor Code For Include
Cleaning check box.

9. To set the clean system as the default clean system used for new items,
select the Default check box.

10. Click Add Clean System.

Note that the labor times and costs for cleaning need to be set in Cleaning
Maintenance.

Create job-specific clean systems
1. In the Select Estimating Job dialog box, do one of the following:

• To add a cleaning system for a new estimating job, click New.

• To add a cleaning system for an existing estimating job, select it in the
list, and click Edit.

2. In the Estimate Job Edit dialog box, open the Clean Systems tab.

3. Click New Clean System.

4. Type a description for the cleaning system.

5. Use the arrow buttons to move the cleaning types that you want to
include in the clean system to the Included list.

6. To add or reduce the times each cleaning type requires, change the value
in the Quantity field.

7. If you only want to apply the cleaning system if cleaning is included in the
labor code of the item, select the Check Labor Code For Include
Cleaning check box.

8. To set the clean system as the default clean system used for new items,
select the Default check box.
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9. Click Add Clean System.

Note that the labor times and costs for cleaning need to be set in Cleaning
Maintenance.

Apply clean systems to estimating items
If you cannot see the Clean System field in an estimating job, modify the
visible input fields via Maintenance --> Estimating --> Edit Input Fields .

Whether or not you select the Carry Over option for the Clean System field
determines if new items initially use the default clean system or the clean
system used for the previously created item.

1. Open the estimating job.

2. Do one of the following: 

To apply the clean
system to

Do this

One item a. In the Estimating dialog box, select an item.

b. Select a clean system in the Clean System list.

c. Click Edit to save the changes.
Multiple items a. In the Estimating dialog box, click the

Estimating ribbon tab.

b. On the menu, select Global Edit --> Global
Edit

c. To only modify specific types of items, in the
Estimating Global Edit Filters dialog box,
select a filter type in the Type list, and click
Select.

d. Select a clean system in the Clean System list.

e. Click Update.

Create, modify, and delete paint types
In the Paint Maintenance dialog box, you can add, modify, and delete paint
types that you want to use in estimating jobs. We recommend that you only
add paint types that are regularly used in your shop to Paint Maintenance. If
a paint type is only used in a particular estimating job, you can create a job-
specific paint type instead.

To access the Paint Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating Maintenance --> Paint Maintenance .

The Paint Maintenance dialog box opens.
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Create a new paint type
1. In the Paint Maintenance dialog box, click New to add a new paint type.

2. Type a description, manufacturer, container size, cost, coverage, and
thickness for the paint type.

3. If the painting process requires more time than usually, enter a labor
multiplier value. 

The labor multiplier helps Tekla EPM to calculate the labor correctly.

4. Click Add. 

The new painting type is added to the list.

Repeat steps 3 to 6 to add all regularly used paint types.

When you have created the necessary paint types, you can also create paint
systems using the paint types. For more information, see Create paint systems
(page 300).

Modify a paint type
1. In the Paint Maintenance dialog box, select the paint type that you want

to modify.

2. Modify the properties of the paint type according to your needs.
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3. Click Save.

Delete a paint type
1. In the Paint Maintenance dialog box, select the paint type that you want

to delete.

2. At the bottom of the dialog box, click Delete.

3. To permanently delete the selected paint type, click Yes in the
confirmation dialog box.

Create paint systems
By using paint systems, you can apply more than one coat of paint for an
estimating job. When you select a paint system in an estimating job, Tekla EPM
calculates the applicable costs and adds them to the estimate. Note that
globally available paint systems need to be created before creating the
estimating jobs where you want to use them. Otherwise, the paint systems will
not be available.

1. While in the Paint Maintenance dialog box, click the Paint Maintenance
ribbon tab.

2. Open the Paint Systems ribbon tab.

3. Do any of the following: 

To Do this
Add a new paint system a. Click New.

b. Type a description for the paint
system.

c. Click the arrow buttons to move
the paint types that you want to
include to the Paints Included
list.

d. To change the number of coats,
select an included paint type and
type a new value in the Quantity
field.

e. If you want to set the paint
system as the default paint
system for new estimating jobs,
select the Default check box.

f. Click Add Paint System.
Modify a paint system a. Select the paint system in the list.
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To Do this
b. Change the description, included

paints, or the number of paint
coats according to your needs.

c. If you want to set the paint
system as the default paint
system for new estimating jobs,
select the Default check box.

d. Click Save Paint System.
Delete a paint system a. Select the paint system in the list.

b. Click Delete Paint System.

c. To permanently delete the paint
system, click Yes.

Note that you can also create job-specific paint systems. For more information,
see Create job-specific paint systems (page 374).

Modify freight pricing
In the Freight Maintenance dialog box, you can modify freight pricing used in
Estimating. The freight information that you set in the Freight Maintenance
dialog box can be applied to all estimates.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating Maintenance --> Freight Maintenance .
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3. To change the costs of inbound freight and purchased items, in the
Freight section of the Freight Maintenance dialog box, modify the trailer
capacity, jobsite freight costs, and minimum freight charges.

4. To update the inbound freight costs, click Save at the bottom of Freight
section.

5. Select or clear the Jobsite Freight $/CWT or Jobsite Freight $/KG check
box according to your needs:

When the Jobsite
Freight $/CWT or

Jobsite Freight $/KG
check box is...

It means that...

selected • Tekla EPM calculates freight as dollar per
hundredweight or per kilogram.

• When the total shipping weight is less than the
trailer capacity, the Freight Partial Truck
multipliers are added to the total calculation for
Freight Per CWT/KG.

cleared • Tekla EPM calculates freight as dollar per mile
(the Freight Per Mile value is used).

• When Freight Per Mile is less than Minimum
Freight Charge Per Job, the Minimum Freight
Charge Per Job is used instead.
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Add or update the weight range and multiplier for different load sizes
The Freight Partial Truck options are used together with the Jobsite Freight
$/CWT/Freight Per CWT/KG options when the Jobsite Freight $/CWT/Jobsite
Freight $/KG check box is selected.

The Freight Partial Truck pricing also initiates a multiplier to the Freight Per
Mile cost.

• Do any of the following: 

To Do this
Add a new weight range
and multiplier

1. In the Freight Partial Truck section, click
New.

2. Type the minimum and maximum weight.

3. In the Multiplier field, type the base load cost
multiplier.

The multiplier value is used to calculate the
Freight Per Mile cost for loads that fall within
the weight range.

4. Click Add.
Modify an existing
weight range and
multiplier

1. In the Freight Partial Truck section, click to
select a distance in the list.

2. Modify the weight range or the multiplier
value.

3. Click Edit to save the changes.

Add or update freight pricing per hundedweight or kilogram
• Do any of the following: 

To Do this
Add new pricing
for a distance

1. In the Freight Per CWT/KG section, click New.

2. Define values for minimum miles, maximum miles,
and cost.

3. Click Add.
Modify the pricing
of an existing
distance

1. In the Freight Per CWT/KG section, click to select a
distance in the list.

2. Modify the cost.

3. Click Edit to save the changes.
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Manage estimating jobs
You can manage existing estimating jobs in different ways. You can copy,
renumber, merge, export, and delete combining jobs, and set job groups and
job statuses.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Job Maintenance .

3. In the Estimating Job Maintenance dialog box, select the jobs that you
want to modify. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

4. At the bottom of the dialog box, click any of the available buttons. 

The options are:

• Delete

• Copy

• Renumber

• Merge

• Export

• Set Group Name

• Set Job Status

5. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Delete estimating jobs (page 304)

Copy an estimating job (page 305)

Renumber an estimating job (page 305)

Merge estimating jobs (page 306)

Export estimating jobs (page 306)

Set job groups for estimating jobs (page 306)

Set job statuses for estimating jobs (page 307)

Delete estimating jobs
You can delete unnecessary estimating jobs at any time in Job Maintenance.
Note that the jobs are deleted permanently. If you want to use estimating jobs
for reference later, we recommend that you export the estimating jobs before
deleting them.
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1. In the Estimating Job Maintenance dialog box, select the jobs that you
want to delete. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

2. At the bottom of the dialog box, click Delete.

3. To permanently delete the estimating job, click Yes in the confirmation
dialog box.

See also

Export estimating jobs (page 306)

Copy an estimating job
If necessary, you can copy an existing job to use it as the basis for a similar
new job. Copying an existing job makes creating the new job quicker, as you
do not have to set all properties manually, or create items one by one.

1. In the Estimating Job Maintenance dialog box, select the job that you
want to copy.

2. At the bottom of the dialog box, click Copy.

3. Type a number for the new job.

4. Click OK.

Tekla EPM creates a new job based on the selected job. You can modify the
properties of the new job in the Estimating module.

See also

Manage estimating jobs (page 303)

Renumber an estimating job
You can renumber a job to re-establish the desired item number increments.
To renumber items in an existing estimating job, do the following:

1. In the Estimating Job Maintenance dialog box, select the job that you
want to renumber.

2. At the bottom of the dialog box, click Renumber.

3. In the Select the pages to renumber dialog box, click the arrow buttons
to move the pages that you want to renumber to the Included list.

4. Click OK.

5. In the Starting item # field, type a new starting number.
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6. In the Item increment field, type the desired numbering increment. 

For example, use 1 for single digit (1, 2, 3, ...), 5 for increments of five (5,
10, 15, ...), and 10 for increments on ten (10, 20, 30, ...).

7. To renumber the job, click OK.

Merge estimating jobs
You can create a new job by merging two existing jobs. For example, merging
jobs can be useful when you have separate estimating jobs in the same
project.

1. In the Estimating Job Maintenance dialog box, select the jobs that you
want to merge. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

2. At the bottom of the dialog box, click Merge.

3. Type a number for the new job.

4. Click OK.

See also

Manage estimating jobs (page 303)

Export estimating jobs
Export jobs before deleting them to make the jobs available for future
reference. Note that in Tekla EPM, only estimating jobs can be exported to
KISS files.

1. In the Estimating Job Maintenance dialog box, select the job that you
want to export. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

2. At the bottom of the dialog box, click Export.

3. In the Save As dialog box, browse to the folder where you want to save
the file.

4. Use the automatically generated name or type a new one.

5. Click Save.

If you have selected multiple jobs, repeat steps 3 to 5 for each job.
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Set job groups for estimating jobs
Job groups allow you to identify and sort projects that are similar. For
example, you can create job groups for commercial or industrial work, or by
year. Assigning job groups to jobs makes it easier to sort a long list of jobs.

1. In the Estimating Job Maintenance dialog box, select the jobs for which
you want to set job groups. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

2. At the bottom of the dialog box, click Set Group Name.

3. Select if you want to update the primary group or the secondary group.

4. Type a name for the group.

5. Click OK.

See also

Manage estimating jobs (page 303)

Set job statuses for estimating jobs
The job status determines if a job is still in progress (Open) or finished
(Closed). By setting statuses for estimating jobs, you can view only the current
jobs in the Select Estimating Job dialog box. Any finished jobs will be hidden
by default.

1. In the Estimating Job Maintenance dialog box, select the jobs whose
status you want to change. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

2. At the bottom of the dialog box, click Set Job Status.

3. Select the new job status in the list.

4. Click OK.

Note that only open jobs are available in Tekla EPM Go.

See also

Manage estimating jobs (page 303)

Open an estimating job (page 377)

Modify an estimating job (page 396)
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Adjust labor information
Before you start working in the Estimating module, we recommend that you
view the information in the Tekla EPM labor database, including labor groups,
labor codes, and material-specific labor times. If necessary, you can then
adjust this information to reflect the labor data of your shop.

NOTE Before making changes to the labor information, we recommend that you
export the labor information and save it in a text file. This way, you can re-
import the information later, if necessary.

1. Click the Maintenance ribbon tab.

2. On the menu, go to Estimating --> Labor Maintenance .

3. Select the desired menu command.

For more information, see the following links:

Calculating labor time (page 308)

Create assemblies (page 311)

View, rename, copy, and delete assemblies (page 314)

Adjust labor times for column splices (page 315)

Adjust labor times for copes, punches, and stiffeners (page 316)

Create estimate extras (page 316)

View extrapolation factors (page 320)

Adjust labor codes (page 321)

Create, modify, and delete labor groups (page 326)

Create, modify, and delete labor operations (page 329)

Adjust labor standards (page 332)

Adjust quantity and weight labor factors (page 337)

Manage standard clips (page 339)

Adjust labor times for burning (page 341)

Adjust labor times for drilling (page 344)

Adjust labor times for punching (page 347)

Adjust labor times for welding (page 350)

Calculating labor time
The labor database consists of different elements that work together to
calculate accurate labor times. See the purposes of each labor element:
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Labor rates

Labor rates are hourly rates for specific fabrication functions, such as
detailing, erecting, and shop labor.

Labor rates are assigned to different labor groups.

For instructions on adjusting labor rates, see Create and modify labor rates
(page 360).

Labor groups

Labor groups bring together the assigned labor times and the hourly labor
rates. A labor group can be described as a bucket where you put labor time
and assign a labor rate.

The labor group is assigned to the labor operations. The labor from the labor
operation is then summarized in the labor group, and a labor rate is applied.

For instructions on adjusting labor groups, see Create, modify, and delete
labor groups (page 326).

Labor operations

Labor operations bring together the labor group and the extrapolation factor.

A labor operation is assigned an extrapolation factor and the time defined in
the labor standard. Based on this information, Tekla EPM calculates the
amount of labor based on the properties of the material.

Labor operations can be assigned through labor codes, estimate extras, or in
some cases, additional labor.

To use a labor operation in an estimating job, you need to add it to a labor
code in Labor Codes.

The labor time used for each labor operation is determined in Labor
Standards Maintenance. For more information, see Adjust labor standards
(page 332).

For instructions on adjusting labor operations, see Create, modify, and delete
labor operations (page 329).
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Labor codes

Labor codes group labor operations together with formulas that calculate
burn, drill, punch, and weld time, the material and labor for standard clips.

The estimating items that do not belong to any material group, such as
comments, hardware, and buy-out items, are not included in labor codes.

Labor codes also include the assignment of shop or field bolts, including the
cleaning and splicing when those operations are required.

For instructions on adjusting labor codes, see Adjust labor codes (page 321).

See the default labor codes in Tekla EPM in the following image:
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Create assemblies
You can create a library of commonly used assemblies, or bid items, that you
can use in all estimating jobs. Assemblies can contain multiple items with
different shapes, dimensions, finishes and categories, as well as accessories
and parametric assemblies. By adding an assembly to your estimating job, you
are actually adding all these items at once.
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1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Maintenance --> Assemblies .

3. In the Select Assembly dialog box, click Add.

4. Type a name for the assembly, and click OK. 

The Assembly Maintenance dialog box opens.

The summary on top of the dialog box shows the quantity, length, weight,
surface area, and work time in man hours for each of the selected items,
all of the selected items, all items visible in the job, and the entire job. The
summary also displays the pounds per man hour and man hours per ton
calculations for the selected items, all items visible in the job, and the
entire job.

Use the Find button to find items of a specific shape, material grade, or
material dimension, or a particular item in the assembly. For instructions,
see Find estimating items (page 413).

Use the navigation tree on the left side of the dialog box to only view
particular items. For instructions, see View only particular items or pages
in the Esimating dialog box (page 378).

5. Click New to add the first item to the assembly.

6. Create a comment item as the header line of the assembly:

a. Set Shape to CO.

b. Click the Dimensions field.

c. Type a description for the assembly, and press Enter.
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d. Click Add

7. To add more items:

a. Click New.

b. Define the quantity, shape, dimensions, and other properties for the
item that you are adding.

c. Click Add.

8. To add additional labor and clips to an item:

a. Select the item in the item list.

b. Expand the Additional Labor and Clips section.

c. Click Edit.

d. In the Assembly Item dialog box, click New under Additional Labor
or Clips, depending on the type of item you are adding.

e. Define the item properties.

f. Click Add.

g. To close the dialog box, click the Close button (X) in the upper-right
corner.

9. To add accessories or parametric assemblies to the assembly: 

To Do this
Add an accessory a. Click the Assembly

Maintenance ribbon tab.

b. On the menu, select Add
Accessory.

c. In the Select Accessory dialog
box, select the accessory that you
want to add.

d. Use the check boxes under the
accessory list to select if you want
to use the finish and category of
the original item, or set the
category as the accessory
description.

e. Click Add Selected.

The accessory is added to the
assembly.

Add a parametric assembly a. Click the Assembly
Maintenance ribbon tab.

b. On the menu, select Add
Parametric Assembly.
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To Do this
c. Double-click the parametric

assembly that you want to add.

d. If necessary, in the Parametric
Assembly - Variables dialog box,
set values for the variables.

e. Click Calculate Parametric
Assembly.

f. Click Add Parametric Assembly.

The parametric assembly is added to
the assembly.

10. When the assembly is ready, click the Close button (X) in the upper-right
corner.

The assembly is now available for all estimating jobs. You can also see the
assembly in the Select Assembly dialog box.

You can also create job-specific assemblies. For more information, see Add an
assembly (page 411).

See also

View, rename, copy, and delete assemblies (page 314)

View, rename, copy, and delete assemblies
You can view, rename, and delete both globally available and job-specific
assemblies in the Assembly Maintenance dialog box. Furthermore, you can
copy job-specific assemblies to the assembly library, so that they will be
available in all estimating jobs.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Maintenance --> Assembly
Maintenance . 

The Assembly Maintenance dialog box opens.

You can view the existing global assemblies in a list on the left side, and
the job-specific assemblies on the right side.

3. According to your needs, do any of the following: 

To Do this
Rename an assembly a. Select an assembly in either of the lists.

b. Type a new name in the empty field under the
list.

c. Click Rename.
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To Do this
Delete an assembly a. Select an assembly in either of the lists.

b. Click Delete under the list.

c. To permanently delete the assembly, click Yes
in the confirmation dialog box.

Copy a job-specific
assembly to the
assembly library

a. In the Job list, click to select the estimating job
from which you want to copy an assembly.

b. Select the assembly that you want to copy.

c. Click <Copy.

The assembly is now available for all estimating
jobs.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Create assemblies (page 311)

Adjust labor times for column splices
In Column Splices Maintenance, you can adjust the labor times for different
times of column splices. These labor times will be used in all estimates by
default. If necessary, create new column splice types or modify the existing
ones.

To use column splices, you need to add them to labor codes. For more
information, see Adjust labor codes (page 321).

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Maintenance --> Column
Splices .

3. In the Column Splices Maintenance dialog box, do any of the following: 

To Do this
Create a new column
splice type

a. Click New.

b. In the Type field, enter a letter indicator.

c. Type a description and define the labor time in
man hours.

d. Click Add.
Modify an existing
column splice type

a. Select a column splice type in the list.

b. Modify the letter indicator, description, and
labor time according to your needs.
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To Do this
c. Click Edit to save the changes.

Delete a column splice
type

a. Select a column splice type in the list.

b. Click Delete.

c. To permanently delete the column splice type,
click Yes in the confirmation dialog box.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Adjust labor times for copes, punches, and stiffeners
In Cope Punch Stiffener, adjust the default labor times for the layout of
copes, punches, and stiffeners. For stiffeners, you can also adjust the fit-up
time. The labor times that you define will be used in all estimating jobs.

• To define the labor time used for cutting the cope, see Adjust labor times
for burning (page 341).

• To modify cope and stiffener weld settings, see Modify labor operation
settings (page 356).

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Maintenance --> Cope /
Punch / Stiffeners .

3. In the Cope Punch Stiffener dialog box, type labor times for the different
copes, punches, and stiffeners.

4. Click Save.

Create estimate extras
Create estimate extras to add costs and labor for commonly used special
items when there are no applicable labor codes in Tekla EPM. Estimate extras
allow you to add as much labor and cost to a single item in an estimating job
as needed. Estimate extras are often used for all labor done outside of your
shop. For example, you can create estimate extras for items such as camber,
rolling, and forming.

1. Click the Maintenance ribbon tab

2. On the menu, select Estimating --> Labor Maintenance --> Estimate
Extras .

The Estimate Extra dialog box opens.
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Create an estimate extra

1. In the Estimate Extra dialog box, click New. 

NOTE To create copy of an estimate extra and use it as the basis of a
new one, select the existing estimate extra in the list and click
New - Carry Over.

2. In the Code field, type an abbreviation that helps you identify the estimate
extra. 

The abbreviation will be shown when you apply estimate extras to
estimating items.

3. Type a description, group, and sub-group for the estimate extra. 

Groups and sub-groups are only used for filtering the estimate extras in
the dialog box.

4. Click Add.

5. Click the other tabs to enter more information about the estimate extra. 

According to your needs, see any of the following instructions:

Add labor code formulas

You can add new labor code formulas in the Labor Code Maintenance dialog
box. For more information, see Adjust labor codes (page 321).

For more information on creating formulas, see Create formulas (page 286).

1. Open the Labor Code Formulas tab.

2. Click New Formula.
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3. In the Formula list, select an existing labor code formula.

4. Do one of the following:

• In the Quantity field, enter the number of times the formula is used
for the estimate extra.

• Click Formula on the right side of the Quantity field and create a
quantity formula.

5. Click Add Formula. 

Add as many formulas as necessary to define the extra labor.

6. Click Save at the bottom of the dialog box.

Add child estimate extras

Child estimate extras allow you to add more than one labor operation to the
main estimate extra item. In practice, this means that you can group many
labor functions together into one estimate extra.

1. Open the Child Estimate Extras tab.

2. Click New Child Extra.

3. In the Child Estimate Extra list, select an existing estimate extra that you
want to add as a child item for the current estimate extra.

4. Do one of the following:

• In the Quantity field, enter the number of times the formula is used
for the estimate extra.

• Click Formula on the right side of the Quantity field and create a
quantity formula.

5. Click Add Child Extra.

6. Repeat steps 1 to 5 to add all necessary child estimate extras.

7. Click Save at the bottom of the dialog box.

Add costs

1. Open the Cost tab.

2. According to your needs, do any of the following: 

To Do this
Add a fixed cost a. Select the Cost Value option.

b. Type the cost in the Cost Value field.

TIP If you want to change the units, right-
click in the Cost Value field and select
the new units.
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To Do this
Enter a formula for
calculating the cost

a. Select the Cost Expression option.

b. Click Formula.

c. Build the formula by entering the necessary
elements and adding variables.

d. Click OK.

3. To assign the cost to a specific category, select an option in the Cost
Directed To list.

4. Click Save at the bottom of the dialog box.

Add labor times for a labor group

1. Open the Labor tab.

2. Click New Labor.

3. In the Labor Group list, select the labor group for which you want to add
labor times regarding the estimate extra.

4. Do any of the following: 

To Do this
Add a fixed amount of labor time a. Select the Man Hours Value

option.

b. Type the labor time in the Man
Hours Value field.

TIP If you want to change the
units, right-click in the Man
Hours Value field and
select the new units.

Add an expression to calculate the
labor time

a. Click the Man Hours Expression
option.

b. Click Formula.

c. Build the formula by entering the
necessary elements and adding
variables.

d. Click OK.

5. Click Add Labor.

6. Click Save at the bottom of the dialog box.

Add welding, burning, punching, or drilling

1. Open the Additional Operations tab.
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2. Click New Operation.

3. In the Operation list, select the labor operation.

4. In the Type list, select if the operation is manual, semi-automatic, or
automatic.

5. Enter values or create formulas for Quantity, Thickness, and Length.

6. Click Add Operation.

7. Click Save at the bottom of the dialog box.

Add labor code operations

Labor code operations allow you to add the same operations for the selected
estimate extra that are used for labor codes.

1. Open the Labor Code Operations tab.

2. Click New Operation.

3. Select the material group and the operation in the appropriate lists.

4. Type a quantity in the Quantity field, or click Formula to define a formula
that calculates the quantity.

5. Click Add Operation.

6. Click Save at the bottom of the dialog box.

View extrapolation factors
Extrapolation factors are variables that Tekla EPM uses in calculating the labor
times when labor applied to the materials. Extrapolation factors work together
with labor operations and labor groups to properly apply labor times listed in
labor standards. Extrapolation factors are also specific to certain labor
operations.

You cannot create any additional extrapolation factors, but simply view the
existing ones.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Maintenance -->
Extrapolation Factors .

3. In the Extrapolation Factor Maintenance dialog box, view the
extrapolation factors.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Create, modify, and delete labor groups (page 326)

Create, modify, and delete labor operations (page 329)
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Adjust labor standards (page 332)

Adjust labor codes
Labor codes group labor operations together with formulas. View the labor
codes applied to different material groups in Labor Code Maintenance. You
can also add more labor codes for common labor, such as adding sloped clips
for bolted connections. In the Estimating module, you can use a labor code
for an item by selecting it in the Type list.

To access the Labor Code Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Maintenance --> Labor
Codes .

The Labor Code Maintenance dialog box opens.

Labor codes are always used by certain material groups, or types of shapes.
You can view the labor codes by material group by scrolling the labor code list.

In the Operations section, you can set the number of times an operation is
done within the labor code, or how many times the labor data from labor
standards is entered for each item. When the Qty column is blank, the
operation does not belong to the selected labor code.

In the Formulas section, you can see the formulas applied to calculating weld,
burn, drill, and punch times, along with the labor times spent for standard
clips. You can then set the number of times a formula is applied. When the
Qty column is blank, the formula is not applied.
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The preloaded labor codes

Change the default labor code of a material group

1. Scroll to find the material group.

2. Scroll to find and select the labor code that you want to set as the default
option.
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3. Select the Default Labor Code check box.

4. At the bottom of the dialog box, click Save.

The selected labor code is now used by default for the material group in the
Estimating module.

Add a new labor code

1. At the bottom of the Labor Code Maintenance dialog box, click New.

2. In the Material Group list, select the material for which the new code is
added. 

The labor code will only be available for the selected material group.

3. Type an abbreviation and description for the labor code.

4. If you want to add a column splice to the labor code, select an option in
the Column Splice list.

5. To include cleaning in the labor code, select the Include Cleaning check
box.

6. To set the new labor code as the default labor code for the material
group, select the Default Labor Code check box.

7. On the Operations tab, ensure that the necessary operations are
included to the labor code. 

If necessary, use the Quantity (+) and Quantity (-) buttons above the list
to add or subtract the number of operations.

8. On the Formula tab, ensure that the necessary formulas are applied. 

If necessary, use the Quantity (+) and Quantity (-) buttons above the list
to add or subtract the number of formulas.

9. Click Add.

The new labor code is created and is available in the Estimating module.

Add or subtract operations and formulas

1. Scroll to find and select the material group.

2. Scroll to find and select the labor code.

3. Select the operation or formula whose quantity you want to modify in the
labor code.

4. Above the list, click Quantity (+) or Quantity (-) to change the quantity.

5. Click Save.
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Add column splices to a labor code

You can apply column splices to any labor code. Tekla EPM calculates the labor
time used in the column splice automatically.

1. Scroll to find and select the material group.

2. Scroll to find and select the labor code.

3. In the Column Splice list, select the column splice type that you want to
use for the labor code.

4. Click Save.

Column splices are added to the labor code.

Note that the required splice materials need to be added manually in the
Estimating module.

Add cleaning to a labor code

1. In the Material Group list, select the material group.

2. In the Labor Code list, select the labor code.

3. Select the Include Cleaning check box.

4. Click Save.

Add, modify, and delete formulas

1. Click the Labor Code Maintenance ribbon tab.

2. On the menu, select Formula Maintenance. 

The Formula Maintenance dialog box opens. The existing formulas are
displayed in the list on the left of the dialog box.

Each formula type includes options for quantity, weld, thickness and
length.

3. Do any of the following: 

To Do this
Create a new formula a. Click New Formula.

b. In the Formula Type list, select an option.

The formula type that you select determines
the variables for which you need to enter
values on the right side of the dialog box.

For example, if you select Burn, you will need
to determine the quantity, burn operation,
thickness, and length.

c. For each variable, click the Edit Formula
button on the right side of the field, and type a
value or build a formula.
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To Do this
d. To save the formula, click Edit Formula at the

bottom of the dialog box.
Modify an existing
formula

a. Select the formula that you want to modify.

b. If necessary, in the Formula Type list, select a
different option.

c. For each variable, click the Edit Formula on
the right side of the field, and modify the value
or formula according to your needs.

d. To change the position of an operation in the
formula, select the operation, and move it by
clicking the Move Up and Move Down
buttons.

e. To save the changes, click Edit Formula at the
bottom of the dialog box.

Delete an existing
formula

Note that the formula will be permanently deleted
and cannot be used in any labor code.

a. Select the formula that you want to delete.

b. Click Delete.

c. To permanently delete the formula, click Yes
in the confirmation dialog box.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

View and print a list of labor codes

1. Click the Labor Code Maintenance ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. To only include particular material groups or labor codes, in the Labor
Code Report Filters dialog box, select a filter type in the Type list, and
click Select.

4. Click the arrow buttons to move the material groups or labor codes that
you want to include to the Included list.

5. Click OK.

6. Click Make Report.

7. In the Report Selection dialog box, do any of the following according to
your needs: 

To Do this
View the labor code
list

• Click View.
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To Do this
Print the labor code
list

a. In the Report Selection dialog box, change the
number of the printed copies by clicking the +
and - buttons.

b. If necessary, click Select Printer, select which
device you want to use for printing, and click OK.

You can also select Default Printer to always
use the default printer with this report, or No
Printer to reset the current printer.

c. Click Print.

d. Click Yes.
Export the labor code
list

a. Click Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Browse to the location where you want to save
the exported file, and click Save.

e. Modify the file name according to your needs.

f. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email check box.

g. To open the file after exporting it, select the
Open Exported Document check box.

h. Click Export.

8. To close the dialog box, click the Close button (X) in the upper-right
corner.

Create, modify, and delete labor groups
Labor groups define the different labor types being used in an estimating job.
All labor times, except for the erection and detailing times, defined in Tekla
EPM are assigned to a particular labor group. Tekla EPM already contains labor
groups for labor types such as cutting, cleaning, or loading. You can view and
modify the existing labor groups in the Labor Group Maintenance dialog box,
or add new ones according to the needs of your shop.

To access the Labor Group Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Maintenance --> Labor
Groups .

The Labor Group Maintenance dialog box opens.
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Create a labor group

1. Click New.

2. In the Labor Group field, type a number that is not used by any existing
labor group.

3. Type a description for the labor group.

4. In the Activity list, select which activity the new labor group is associated
to.

5. In the Labor Rate list, select which labor rate the new labor group is
associated to. 

The labor rates are created in Fabricator Information. For more
information, see Create and modify labor rates (page 360).

The cost of the labor appears on the right side of the Labor Rate list.

6. Click Add.

The new labor group is created. You can now assign different labor times, such
as burn time or manual labor time, to the labor group.

Modify a labor group

1. Select the labor group that you want to modify.
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2. Modify the labor group number, description, activity, and labor rate
according to your needs.

3. Click Edit to save the changes.

Delete a labor group

Deleting a labor group is permanent and cannot be undone.

1. Select the labor group that you want to delete.

2. Click Delete.

3. To permanently delete the labor group, click Yes in the confirmation
dialog box.

Modify miscellaneous labor groups

In the Miscellaneous Labor Group dialog box, you can determine in which
labor group specific operations, such as cleaning or manual labor, are
included.

1. Click the Labor Group Maintenance ribbon tab.

2. On the menu, select Miscellaneous Labor Groups.

3. In the available lists in the Miscellaneous Labor Group dialog box, select
to which labor groups the different labor times are assigned.

4. Click Save.

View, print, or export the labor group list

1. Click the Labor Group Maintenance ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. In the Report Selection dialog box, do any of the following according to
your needs: 

To Do this
View the labor group list • Click View.
Print the labor group list a. Change the number of printed copies by

clicking the + and - buttons.

b. If necessary, click Select Printer, select which
device you want to use for printing, and click
OK.

You can also select Default Printer to always
use the default printer with this report, or No
Printer to reset the current printer.

c. Click Print.

d. Click Yes.
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To Do this
Export the labor group
list

a. Click Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Browse to the location where you want to save
the exported file, and click Save.

e. Modify the file name according to your needs.

f. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email check box.

g. To open the file after exporting it, select the
Open Exported Document check box.

h. To export the labor group list, click Export.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Create, modify, and delete labor operations
Labor operations are operations that take place in the fabrication process,
such as unloading, painting, or moving material. A labor operation is assigned
an extrapolation factor and the time in the labor standard, so that Tekla EPM
can calculate the amount of labor based on the properties of the material. You
can view and modify the existing labor operations in Operation
Maintenance. You can also create new labor operations according to the
needs of your shop.

To modify the burn, drill, punch, and weld settings for labor operations, see
Modify labor operation settings (page 356).

To access the Operation Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Maintenance --> Labor
Operations .

The Operation Maintenance dialog opens.
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Create a labor operation

1. Click New.

2. In the Code field, type a number that is not in use by another labor
operation.

3. Type a description for the labor operation.

4. In the Labor Group list, click to select the labor group to which the labor
operation is assigned.

5. In the Extrapolation Factor list, click to select the variable used in
calculating labor times.

6. Click Add.

The new labor operation is created.

Note that before you can use the labor operation in estimating jobs, you need
to add it to a labor code in Labor Codes (page 321) and enter the labor time in
Labor Standard Maintenance (page 332).

Modify an existing labor operation

1. Select a labor operation in the list.

2. Modify the code, description, labor group, and extrapolation factor
according to your needs.

3. Click Edit to save the changes.

Delete a labor operation

Note that deleting a labor operation is permanent and cannot be undone.
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1. Select a labor operation in the list.

2. Click Delete.

3. To permanently delete the labor operation, click Yes in the confirmation
dialog box.

View, print, or export the labor operation list

The labor operation list shows how Tekla EPM applies labor for each material
group.

1. Click the Labor Operation Maintenance ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. To only include particular material groups in the labor operation list, in
the Labor Operation Report Filters dialog box, click Edit on the right
side of Material Group.

4. Click the arrow buttons to move the material groups that you want to
include to the Included list.

5. Click OK.

6. Click Make Report.

7. In the Report Selection dialog box, do any of the following according to
your needs: 

To Do this
View the labor operation
list

• Click View.

Print the labor operation
list

a. Change the number of printed copies by
clicking the + and - buttons.

b. If necessary, click Select Printer, select which
device you want to use for printing, and click
OK.

You can also select Default Printer to always
use the default printer with this report, or No
Printer to reset the current printer.

c. Click Print.

d. Click Yes.
Export the labor
operation list

a. Click Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Browse to the location where you want to save
the exported file, and click Save.
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To Do this
e. Modify the file name according to your needs.

f. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email check box.

g. To open the file after exporting it, select the
Open Exported Document check box.

h. To export the labor operation list, click Export.

8. To close the dialog box, click the Close button (X) in the upper-right
corner.

Adjust labor standards
In the Labor Standards Maintenance dialog box, you can view the labor time
spent in each material operation by material dimension and shape. If
necessary, you can modify the labor times, or add new labor times, shapes
and material dimensions. You can also delete shapes and the applied labor
time from Labor Standards.

NOTE Before making changes to labor standards, we recommend that you create a
new shop setup based on the original labor database. Then, modify the new
shop setup, so that the original labor information remains untouched.

To access Labor Standards Maintenance, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Standards .

The Labor Standards Maintenance dialog box opens.
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(1) You can browse the existing material shapes and dimensions on the
navigation tree on the left.

When you click a dimension in the navigation tree to select it, its labor times by
labor operation appear on the right side of the dialog box.

(2) The standard length and the number of standard clip holes of the selected
material dimension are displayed at the top of the dialog box.

According to your needs, see any of the following instructions:

View the compiled labor time of a dimension

NOTE Remember to view the compiled labor time by labor code before and
after making changes to the labor time by labor group.

1. Select the material dimension whose properties you want to view.

2. Click the Labor Standards Maintenance ribbon tab.
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3. On the menu, select View Labor Code Labor Values. 

The Labor Code dialog box opens.

The total labor time is shown at the top of the dialog box. The information
on shop bolts, field bolts, weld cost, and weld weight are shown at the
bottom of the dialog box. All these properties are added to an estimate
when the labor code is added for an item.

4. In the labor code list on the left, click a labor code to view the labor times
of the material dimension when that labor code is selected.

5. To view the labor operation times and the total man hours without
standard clips, clear the Include Standard Clips check box.

6. To close the dialog box, click the Close button (X) in the upper-right
corner.

7. If necessary, make changes to the labor times in the Labor Standards
Maintenance dialog box.

Add shapes and dimensions

1. At the bottom of the dialog box, click Add.

2. In the Shape list, select a shape.

3. In the Select the sizes to add dialog box, click the arrow buttons to move
the dimensions that you want to add to the Included list.

4. Click OK. 

The dimensions are added for the shape.

5. Use the Global Edit - Operations command to add labor times for the
new dimensions. 

For more information, see Copy labor times to multiple material
dimensions.

After the dimensions have been added, you also need to add their pricing and
combining length to the pricing database in Pricing Maintenance.

Modify the number of standard clip holes for a single dimension

1. In the shape list, select a shape and a material dimension.

2. In the Holes in Standard Clip field, type the desired number of holes.

3. Click Save.

Modify the number of standard clip holes for multiple dimensions

1. While in the Labor Standards Maintenance dialog box, click the Labor
Standards Maintenance ribbon tab.

2. On the menu, select Global Edit - Holes in Standard Clip.
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3. To automatically filter which shapes and operations are modified, select a
filter in the Filter Group list, or click Edit Filter Groups to create a new
filter.

4. On the Shapes section, use the arrows to move shapes whose standard
clip holes you want to modify to the Included list.

5. On the Dimensions section, use the arrows to move the dimensions
whose standard clip holes you want to modify to the Included list.

6. Click OK.

7. Type the desired number of holes in the Holes in Standard Clip field.

8. Click Save. 

The number of standard clip holes of the selected material shapes and
dimensions is updated.

Copy labor times to multiple dimensions

1. Change the labor times of labor operations for one dimension according
to your needs.

2. In the navigation tree, select the material dimension whose labor times
you want to copy to other dimensions.

3. Click the Labor Standards Maintenance ribbon tab.

4. On the menu, select Global Edit - Operations.

5. To automatically filter which shapes and operations are modified, select a
filter in the Filter Group list, or click Edit Filter Groups to create a new
filter.

6. On the Shapes section of the Global Edit - Operations dialog box, use
the arrows to move shapes whose labor times you want to modify to the
Included list.

7. On the Dimensions section, use the arrows to move the dimensions
whose labor times you want to modify to the Included list.

8. Click OK.

9. Click the arrow buttons to move the operations whose labor times you
want to copy to the Included list.

10. Click Save.

The labor times of the selected operations are copied for the material
dimensions that you selected.

Remove an individual material dimension

You can remove all labor standards connected to a material dimension. The
dimension will remain available in the Shapes / Grades / Sizes dialog box and
Pricing Maintenance, and you can add it back to Labor Standards
Maintenance at any time.
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NOTE If you remove a dimension from Labor Standards Maintenance, you
will need to add labor times for all items of the dimension manually
when you use that dimension in an estimating job.

1. Select the dimension that you want to remove.

2. At the bottom of the dialog box, click Delete.

3. To permanently delete the selected dimension, click Yes in the
confirmation dialog box.

Remove a shape and all of its dimensions

If necessary, you can remove all labor standards connected to a shape from
labor standards. The shape and dimensions will remain available in the
Shapes / Grades / Sizes dialog box and Pricing Maintenance. You can add
the shape and dimensions back to Labor Standards Maintenance at any
time.

NOTE If you remove a shape from Labor Standards Maintenance, you will
need to add labor times manually for all items that use the shape in
estimating jobs.

1. Select the shape that you want to remove.

2. At the bottom of the dialog box, click Delete.

3. To permanently delete the selected shape and all its dimensions, click Yes
in the confirmation dialog box.

Create labor standard reports

1. In the Labor Standards Maintenance dialog box, click the Labor
Standards Maintenance ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. To only show specific shapes or dimensions, select a filter type in the Type
list, and click Select.

4. Click the arrow buttons to move the shapes and dimensions that you
want to modify to the Included list.

5. Click OK.

6. Click Make Report.

7. In the Report Selection dialog box, do any of the following according to
your needs: 

To Do this
View the labor standards list • In the Report Selection dialog box, click

View.
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To Do this
Print the labor standards list a. In the Report Selection dialog box,

change the number of the printed
copies by clicking the + and - buttons.

b. If necessary, click Select Printer, select
which device you want to use for
printing, and click OK.

You can also select Default Printer to
always use the default printer with this
report, or No Printer to reset the
current printer.

c. Click Print.

d. Click Yes.
Export the labor standards list a. Click Export.

b. In the Export Format list, select an
export format.

c. Click Browse.

d. Browse to the location where you want
to save the exported file, and click Save.

e. Modify the file name according to your
needs.

f. To attach the exported file to a
Microsoft Outlook email and send it to a
recipient, select the Attach to Email
check box.

g. To open the file after exporting it, select
the Open Exported Document check
box.

h. To export the labor group list, click
Export.

8. To close the dialog box, click the Close button (X) in the upper-right
corner.

Adjust quantity and weight labor factors
Quantity and weight labor factors are used in extrapolation factors, which
affect the efficiency of labor for specific labor operations. For example, for
longer items, the efficiency may be greater than normal, and for heavy items,
the efficiency may decrease. In Quantity and Weight Labor Factor
Maintenance, you can add, modify, and delete these labor factors by material
group.
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To see which labor operations use the quantity and weight labor factors, refer
to the Operation Maintenance dialog box.

To open the Quantity and Weight Labor Factor Maintenance dialog box:

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Maintenance --> Quantity &
Weight Labor Factors .

The Quantity and Weight Labor Factor Maintenance dialog box opens.

The quantity labor factors are adjusted on the Quantity tab, whereas the
weight labor factors are adjusted on the Weight tab.

NOTE Quantity and weight labor factors are created separately for each shop setup
in Tekla EPM. To switch to another shop setup, see Change the active shop
setup (page 362). Remember to add the labor factors to each shop where they
are needed.

Add quantity or weight labor factors

Before you add labor factors, ensure that you are on the right tab. To add
quantity labor factors, you need to have the Quantity tab open. To add weight
labor factors, you need to have the Weight tab open.

1. In the Shop Setup list, select to which shop the labor factor will be added.

2. In the Material Group list, select the material group whose labor factors
you want to modify.
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3. In the Quantity or Weight field, type a value. 

This value defines the area for efficiency.

4. In the Percentage field, type the efficiency percentage. 

Increasing the efficiency percentage lowers the applied labor time for an
operation that contains quantity and weight extrapolation factors.

5. Click Add.

The new labor factor is added to the selected shop setup.

Modify quantity or weight labor factors

1. In either the Quantity or Weight list, select the labor factor that you want
to modify.

2. Modify the quantity or weight and percentage.

3. Click Save to update the labor factor.

Delete quantity or weight labor factors

1. On either the Quantity or Weight tab, select the labor factor that you
want to delete.

2. In the lower-right corner, click Delete.

3. To permanently delete the labor factor, click Yes in the confirmation
dialog box.

Manage standard clips
In Standard Clips Maintenance, you can modify existing standard clips, and
add material items and additional labor for weld, burn, drill, and punch to
standard clips. Note that standard clips are only used if you have selected the
Auto Clip-Angles check box in Fabricator Information. If necessary, you can
also modify the standard clips on a job by job basis.

To access the Standard Clips Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Maintenance --> Standard
Clips .

The Standard Clips Maintenance dialog box opens.
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You can see the labor time in man hours and the weight of the selected item in
the top right corner of the dialog box.

Modify the properties of standard clips

1. In the list on the left, select the standard clip.

2. On the right, modify the standard clip properties according to your needs. 

For example, you can change the material shape or the quantity of clips.
Note that even though the shape of the clip can be changed, you can only
change the shape within the original material group.

3. If you want to change the maximum number of holes in the clip, do the
following:

a. In the lower-left corner, click Set Max Clip Holes.

b. Type the maximum hole number.

c. Click Set Max Holes.

d. Click Yes to confirm changing the maximum number of holes.

Note that you cannot reduce the maximum number of holes if the
selected clip is used in an estimating job.

4. To update the standard clip properties, click Save below the list of
standard clips.
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Add additional labor or material items to a standard clip

1. In the list on the left, select the standard clip.

2. Under the Additional Labor list, click New.

3. Determine the quantity, operation, thickness, operation type, and length.

4. Click Add.

5. To update the standard clip properties, click Save below the list of
standard clips.

The additional labor is added to the clip. You can see the labor time of the
additional labor at the bottom right corner of the dialog box.

Modify additional labor or material items

1. In the list on the left, select the standard clip.

2. In the Additional Labor list, select the desired item.

3. Change the quantity, operation, thickness, operation type, or length.

4. To save the changes, click Save under the Additional Labor list.

5. To update the standard clip properties, click Save below the list of
standard clips.

Delete additional labor or material items

1. In the list on the left, select the standard clip.

2. In the Additional Labor list, select the desired item.

3. Click Delete to permanently delete the item.

4. To update the standard clip properties, click Save below the list of
standard clips.

Adjust labor times for burning
In Burn Maintenance, you can view, add, and modify burn time information
to match the time standards of your shop. If necessary, you can also add new
burn types or create a list of burn rates.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Maintenance --> Burn .

3. In the Burn Maintenance dialog box, do any of the following: 

To Do this

Add new burn rate a. Click New.

b. In the Shop Setup list, select the shop to
which you want to add the burn rate.
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c. In the Burn Type list, select how the
burning process is executed:

• Use Automatic for automated
equipment.

• Use Semi-Automatic for track
burners.

• Use Manualfor burning by hand
torch.

d. Determine the thickness and rate per
hour.

e. Click Add.
Modify an existing burn rate a. Select a burn rate in the list.

b. Modify the thickness and rate per hour.

c. Click Edit to save the changes.
Delete a burn rate a. Select a burn rate in the list.

b. Click Delete.

c. To permanently delete the burn rate,
click Yes in the confirmation dialog box.

See also

Add burn types (page 342)

View, print, or export a burn rate list (page 343)

Add burn types
If your shop uses other burn types than the existing ones, you can add the
missing burn types in Burn Type Maintenance. Then, you can use the new
burn types in your estimating jobs.

1. In the Burn Maintenance dialog box, click the Burn Maintenance ribbon
tab.

2. On the menu, select Burn Type Maintenance.

3. In the Burn Type Maintenance dialog box, click New.

4. Add a description and abbreviation for the burn type.

5. In the Labor Group list, select which labor group the burn type belongs
to. 

The selection determines where Tekla EPM saves the labor time used in
burning. Normally, burn times are saved to the Burn labor group.

6. Click Add. 
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The new burn type is created and will be available in Burn Maintenance.

Note that the new burn type will only be visible and available for filtering
in the Burn Maintenance dialog box once you create a burn rate with the
new burn type.

7. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Adjust labor times for burning (page 341)

View, print, or export a burn rate list
When you are making changes to burn times in Burn Maintenance, having a
list of the existing burn rates organized by burn type can be helpful. You can
either view the burn rate list in the Tekla EPM Report Viewer, print the list, or
export the list to another file format.

1. In the Burn Maintenance dialog box, click the Burn Maintenance ribbon
tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. Do any of the following: 

To Do this
View the burn rate list • In the Report Selection dialog

box, click View.
Print the burn rate list a. In the Report Selection dialog

box, change the number of the
printed copies by clicking the +
and - buttons.

b. If necessary, click Select Printer,
select which device you want to
use for printing, and click OK.

You can also select Default
Printer to always use the default
printer with this report, or No
Printer to reset the current
printer.

c. Click Print.

d. Click Yes.
Export the burn rate list a. Click Export.

b. In the Export Format list, select
an export format.

c. Click Browse.
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To Do this
d. Browse to the location where you

want to save the exported file,
and click Save.

e. Modify the file name according to
your needs.

f. To attach the exported file to a
Microsoft Outlook email and
send it to a recipient, select the
Attach to Email check box.

g. To open the file after exporting it,
select the Open Exported
Document check box.

h. Click Export.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Adjust labor times for burning (page 341)

Adjust labor times for drilling
In Drill Maintenance, you can view, add and modify drill time information to
match the time standards of your shop. You can also add new drill types or
create a list of drill rates. The drill times set in Drill Maintenance are used
when you directly apply them to an estimating job as additional labor.

The labor time entered in Drill Maintenance maintenance will be applied
according to the drill settings determined in the Fabrication Information -
Operations dialog box. For more information, see Modify labor operation
settings (page 356). Note that when the thickness that you have defined for
punching is greater than the punch capacity, Tekla EPM automatically switches
to drill times.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Maintenance --> Drill . 

The Drill Maintenance dialog box opens.

You can click an item in the navigation tree on the left to filter the drill
information that is displayed.

3. According to your needs, do any of the following: 

To Do this
Add a new drill rate a. Click New.
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To Do this
b. In the Shop Setup list, select the shop for

which you want to add the rate.

c. In the Drill Type list, select if drilling is done
automatically or manually.

d. Determine the thickness and the number of
holes per hour.

e. Click Add.

The new drill rate is added to the list.
Modify an existing drill
rate

a. Select the drill rate that you want to modify.

b. Modify the shop, drill type, thickness, and
holes per hour information.

c. Click Edit to save the changes.
Delete a drill rate a. Select the drill rate that you want to delete.

b. Click Delete.

c. To permanently delete the drill rate, click Yes
in the confirmation dialog box.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Add drill types (page 345)

View, print, or export the drill rate list (page 346)

Add drill types
If your shop uses other drill types than automatic and manual, you can add
the necessary drill types to Tekla EPM. Then, you can use the new drill types in
any estimating job.

1. In the Drill Maintenance dialog box, click the Drill Maintenance ribbon
tab.

2. On the menu, select Drill Type Maintenance.

3. In the Drill Type Maintenance dialog box, click New.

4. Add a description and abbreviation for the drill type.

5. In the Labor Group list, select which labor group the drill type belongs to. 

The selection determines where Tekla EPM saves the labor time used in
drilling. Normally, drill times are saved to the Punch labor group.

6. Click Add. 
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The new drill type is created and will be available in Drill Maintenance.

Note that the new drill type will only be visible and available for filtering in
the Drill Maintenance dialog box once you create a drill rate with the
new drill type.

7. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Adjust labor times for drilling (page 344)

View, print, or export the drill rate list
When you are making changes to drill times in Drill Maintenance, having a
list of the existing drill rates organized by drill type can be helpful. You can
either view the drill rate list in the Tekla EPM Report Viewer, print the list, or
export the list to another file format.

1. While in the Drill Maintenance dialog box, click the Drill Maintenance
ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. Do any of the following: 

To Do this
View the drill rate list • In the Report Selection dialog box, click

View.
Print the drill rate list a. In the Report Selection dialog box, change

the number of the printed copies by clicking
the + and - buttons.

b. If necessary, click Select Printer, select
which device you want to use for printing,
and click OK.

You can also select Default Printer to
always use the default printer with this
report, or No Printer to reset the current
printer.

c. Click Print.

d. Click Yes.
Export the drill rate list a. Click Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Browse to the location where you want to
save the exported file, and click Save.
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To Do this
e. Modify the file name according to your

needs.

f. To attach the exported file to a Microsoft
Outlook email and send it to a recipient,
select the Attach to Email check box.

g. To open the file after exporting it, select the
Open Exported Document check box.

h. Click Export.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Adjust labor times for drilling (page 344)

Adjust labor times for punching
In Punch Maintenance, you can view, add, and modify punch time
information to match the time standards of your shop. If necessary, you can
also add new punch types or create a list of punch rates. The punch times set
in Punch Maintenance are used when you directly apply them to an
estimating job as additional labor.

Note that when the material thickness exceeds the punch capacity, Tekla EPM
automatically switches to drill times. You can modify the punch capacity in the
Fabrication Information - Operations dialog box. For more information, see
Modify labor operation settings (page 356).

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Maintenance --> Punch
Maintenance .

3. In the Punch Maintenance dialog box, do any of the following according
to your needs. 

To Do this
Add a new punch rate a. Click New.

b. In the Shop Setup list, select the shop for which
you want to add the rate.

c. In the Drill Type list, select if punching is done
automatically or manually.

• Use Automatic for automated equipment.

• Use Manual for punch by an iron worker.

Create estimates 347 Set up the Estimating module



To Do this
d. Determine the thickness and the number of

holes per hour.

e. Click Add.

The new punch rate is added to the list.
Modify an existing
punch rate

a. Select the punch rate that you want to modify.

b. Modify the shop, punch type, thickness, and
holes per hour information.

c. Click Edit to save the changes.
Delete a punch rate a. Select the punch rate that you want to delete.

b. Click Delete.

c. To permanently delete the punch rate, click Yes
in the confirmation dialog box.

See also

Add punch types (page 348)

View, print, or export the punch rate list (page 349)

Add punch types
If your shop uses other punch types than the existing ones, you can add the
missing punch types in Punch Type Maintenance. Then, you can use the new
punch types in any estimating job.

1. While in the Punch Maintenance dialog box, click the Punch
Maintenance ribbon tab.

2. On the menu, select Punch Type Maintenance.

3. In the Punch Type Maintenance dialog box, click New.

4. Add a description and abbreviation for the punch type.

5. In the Labor Group list, select which labor group the punch type belongs
to. 

The selection determines where Tekla EPM saves the labor time used in
punching. Normally, punch times are saved to the Punch labor group.

6. Click Add. 

The new punch type is created and will be available in Punch
Maintenance.

Note that the new punch type will only be visible and available for filtering
in the Punch Maintenance dialog box once you create a punch rate with
the new punch type.

7. To close the dialog box, click the Close button (X) in the upper-right
corner.
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See also

Adjust labor times for punching (page 347)

View, print, or export the punch rate list
When you are making changes to punch times in Punch Maintenance, having
a list of the existing punch rates organized by punch type can be helpful. You
can either view the punch rate list in the Tekla EPM Report Viewer, print the
list, or export the list to another file format.

1. While in the Punch Maintenance dialog box, click the Punch
Maintenance ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. Do any of the following according to your needs: 

To Do this
View the punch rate list • In the Report Selection dialog

box, click View.
Print the punch rate list a. In the Report Selection dialog

box, change the number of the
printed copies by clicking the +
and - buttons.

b. If necessary, click Select Printer,
select which device you want to
use for printing, and click OK.

You can also select Default
Printer to always use the default
printer with this report, or No
Printer to reset the current
printer.

c. Click Print.

d. Click Yes.
Export the punch rate list a. Click Export.

b. In the Export Format list, select
an export format.

c. Click Browse.

d. Browse to the location where you
want to save the exported file,
and click Save.

e. Modify the file name according to
your needs.

f. To attach the exported file to a
Microsoft Outlook email and
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To Do this
send it to a recipient, select the
Attach to Email check box.

g. To open the file after exporting it,
select the Open Exported
Document check box.

h. Click Export.

See also

Adjust labor times for punching (page 347)

Adjust labor times for welding
In Weld Maintenance, you can view, add, and modify weld time information
to match the time standards of your shop. If necessary, you can also add new
weld types or create a list of weld rates. Weld times are used when included in
an estimating job within a labor code, but they may also be directly applied to
an estimating job as additional labor.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Maintenance --> Weld .

3. In the Weld Maintenance dialog box, do any of the following according to
your needs: 

To Do this
Add a new weld rate a. Click New.

b. In the Shop Setup list, select the shop for
which you want to add the rate.

c. In the Weld Type - Process list, select the
weld type and process.

• Use Automatic options for automated
equipment.

• Use Semi-Automatic options for wire
feed machines.

• Use Manual options for stick welding.

d. Determine the thickness, rate per hour,
material weight per foot, and cost per pound.

e. Click Add.

The weld rate is added to the list.
Modify an existing weld
rate

a. Select the weld rate that you want to modify.
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To Do this
b. Modify the shop, weld type and process,

thickness, rate per hour, weight, and cost
information according to your needs.

c. Click Edit to save the changes.
Delete a weld rate a. Select the weld rate that you want to delete.

b. Click Delete.

c. To permanently delete the weld rate, click Yes
in the confirmation dialog box.

See also

Add weld types (page 351)

View, print, or export a weld rate list (page 352)

Add weld types
If your shop uses other weld types than the existing ones, you can add the
missing weld types in Weld Type Maintenance. Then, you can use the new
weld types in your estimating jobs.

1. While in the Weld Maintenance dialog box, click the Weld Maintenance
ribbon tab.

2. On the menu, select Weld Type Maintenance. 

The Weld Type Maintenance dialog box opens.

3. Click New.

4. Type a type description, a type abbreviation, a process description, and a
process abbreviation for the weld type. 

The type description forms the first part of the weld type description,
while the process description forms the second part. The two parts of the
description are connected with a hyphen.

Similarly, the type abbreviation and the process abbreviation together
form the abbreviation of the weld type. The two parts of the abbreviation
are connected with a hyphen.

5. In the Labor Group list, select in which labor group the weld type belongs
to. 

The selection determines where Tekla EPM saves the labor time used in
welding. Normally, labor time spent on full penetration welding is saved to
the FpWeld labor group, while other weld times are saved to the Weld
labor group.

6. In the Weld Type Mapping field, type any weld descriptions that should
be mapped to this weld type when importing weld information. 

Type each additional weld description on a separate line.
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7. Click Add. 

The new weld type is created and will be available in Weld Maintenance.

Note that the new weld type will only be visible and available for filtering
in the Weld Maintenance dialog box once you create a weld rate with the
new weld type.

8. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Adjust labor times for welding (page 350)

View, print, or export a weld rate list
When you are making changes to weld times in Weld Maintenance, having a
list of the existing weld rates organized by weld type can be helpful. You can
either view the weld rate list in the Tekla EPM Report Viewer, print the list, or
export the list to another file format.

1. While in the Weld Maintenance dialog box, click the Weld Maintenance
ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. In the Report Progress dialog box, do one of the following: 

To Do this
View the weld rate
list

• In the Report Selection dialog box, click View.

Print the weld
rate list

a. In the Report Selection dialog box, change the
number of the printed copies by clicking the + and -
buttons.

b. If necessary, click Select Printer, select which device
you want to use for printing, and click OK.

You can also select Default Printer to always use the
default printer with this report, or No Printer to
reset the current printer.

c. Click Print.

d. Click Yes.
Export the weld
rate list

a. Click Export.

b. In the Export Format list, select an export format.

c. Click Browse.

d. Browse to the location where you want to save the
exported file, and click Save.

e. Modify the file name according to your needs.
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To Do this
f. To attach the exported file to a Microsoft Outlook

email and send it to a recipient, select the Attach to
Email check box.

g. To open the file after exporting it, select the Open
Exported Document check box.

h. Click Export.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Adjust labor times for welding (page 350)

Manage estimate statuses
Estimate statuses indicate the level of completion of estimate items. By using
estimate statuses, you can quickly view the situation of each estimating job.
You can also color-code the material items in an IFC model in Trimble Connect
for Windows according to their estimate statuses. Tekla EPM contains four
preloaded status indicators, but you can modify the list of statuses according
to your needs: you can add, modify, deactivate, and delete estimate statuses.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating Maintenance --> Estimate Status
Maintenance .

3. In the Estimate Status Maintenance dialog box, do any of the following: 

To Do this
Add a new estimate
status

a. Click New.

b. Type a description for the status.

c. In the Purpose list, select a purpose for the
status.

d. Click Add.
Set the default estimate
status

a. Select a status in the list.

b. Select the Default check box.

c. Click Save.

The new default estimate status is marked with an
asterisk (*).
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To Do this
Deactivate an estimate
status

If you deactivate an estimate status, it will no
longer be available for estimates. However, you
can activate the status again at any time.

a. Select a status in the list.

b. Clear the Active check box.

c. Click Save.

To re-activate the estimate status, select the Active
check box again.

Modify an existing
estimate status

a. Select a status in the list.

b. Modify the description, purpose, and other
properties according to your needs.

c. Click Save.
Delete an existing
estimate status

a. Select a status in the list.

b. At the bottom of the dialog box, click Delete.

c. To permanently delete the estimate status,
click Yes in the confirmation dialog box.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Color-code estimating items in the IFC model (page 437)

Adjust standard shop information
In Fabricator Information, you can adjust all standard shop information
according to your shop's actual hourly rates, pricing, equipment capacity, and
efficiency. When you set the standard shop information correctly, Tekla EPM
will be able to make more accurate calculations for your estimates. The sub
dialog boxes of Fabricator Information also allow you to modify shop
operations, labor rates, and markups percentages.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Fabricator Information . 
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3. In the Fabricator Information dialog box, modify the settings to match
your shop standards. 

In the following table, see details on some of the shop standard settings:

Option Description Further information
Auto Clip-Angles When selected, Tekla

EPM uses the standard
clip settings,
automatically adding the
labor and materials for
them according to the
labor code.

To modify the standard
clips, see Manage
standard clips
(page 339).

Identify [Items] Longer
Than

The maximum length
allowed for the named
items.

When the item length
exceeds this value, Tekla
EPM will add it into the
Problem Summary
Sheet report.

Maximum Quantity For
[Items]

The maximum number
allowed for the named
items.

When the item quantity
exceeds this value, Tekla
EPM will add it into the
Problem Summary
Sheet report.
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Option Description Further information
Shop Efficiency The shop efficiecy

percentage used in all
future estimating jobs.

The shop efficiency
percentage affects the
labor time and can be
used in different ways.
For example, it may be
useful to set a lower
percentage if your shop
is fabricating
miscellaneous items
instead of structural
ones.

Note that the shop
efficiency can be
manually changed for
each job. Existing
estimating jobs are not
affected by changing the
efficiency percentage.

If necessary, the
percentage can exceed
100 percent. For
example, changing the
shop efficiency to 125%
will reduce the standard
labor time by 20%,
whereas using the shop
efficiency of 75% will add
33% to the standard
labor time.

4. Modify labor operations according to your needs, or define markup
percentages.

NOTE Do not click Save until you have modified the labor operations and
markup percentages. Saving the settings closes the Fabricator
Information dialog box.

For more information, see the following links:

Modify labor operation settings (page 356)

Define markup percentages (page 358)

Modify labor operation settings
In the Fabricator Information Operation Form dialog box, you can modify
the punch and drill type and capacity for different items to match those of
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your shop. You can also determine how copes are burned and stiffeners are
executed.

Setting an operation as automated or manual directly affects the labor time in
Tekla EPM.

1. In the lower-left corner of the Fabricator Information dialog box, click
Operations.

2. At the top of the Fabricator Information Operation Form dialog box, do
one of the following according to your needs: 

• To consider the operation rate thickness as the minimum value of the
range, select he Consider the Burn/Drill/Punch/Weld rate thickness
as the minimum of the range check box.

• To consider the operation rate thickness as the maximum value of the
range, clear the Consider the Burn/Drill/Punch/Weld rate thickness
as the minimum of the range check box.

3. On the Angles, Beams, Plates, Tubes, and Other tabs, do the following:

a. In the Punch list, select if punching is done automatically or manually.

b. In the Punch Capacity field, type the thickness of the material. 
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If an estimate requires a greater capacity, Tekla EPM uses the drill
time information instead.

If the material group does not have a punch process, type 0/16 to
ensure that the drill operation is used instead.

c. In the Drill list, select if drilling is done automatically or manually.

4. On the Copes tab, use the Burn list to select if the burn process of copes
is manual, automated, or semi-automated.

5. On the Stiffeners tab, use the Weld list to select how the weld process of
stiffeners is handled.

6. Click OK.

The changes are saved, and the Fabricator Information Operation Form
dialog box closes.

See also

Adjust standard shop information (page 354)

Define markup percentages
While defining the standard shop information, you can also determine the
markup percentages that you want to use in Tekla EPM. The markup
percentages are divided into three different categories: overhead, profit, and
sales, general, and administration.
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1. At the bottom of the Fabricator Information dialog box, click Markups. 

The Markup dialog box opens.

The O.H. column stands for overhead markup percentages, and the S,
G&A column stands for sales, general, and administration markup
percentages.

2. Modify the markup percentages in any of the following ways: 

To Do this
Modify percentages one
by one

a. Click in the field that you want to modify.

b. Erase the existing percentage and type a new
one.

Apply the same markup
percentage to multiple
items at once

a. In the lower-right corner of the dialog box,
click Global Edit.

b. Click the arrow buttons to move the items that
you want to modify to the Included list.

c. Click OK.

d. Type the markup percentage that you want to
apply to all selected items.
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To Do this
e. Click OK.

The markup percentages of the selected items
are updated.

3. Click OK. 

The Markup dialog box closes.

4. Once you have finished modifying the properties, in the Fabricator
Information dialog box, click Save.

The changes are saved, and the Fabricator Information dialog box closes.

See also

Adjust standard shop information (page 354)

Create and modify labor rates
We recommend that you create different labor rates that match the
fabrication functions and rates of your shop. By modifying labor rates to
match those of your shop, you can ensure that Tekla EPM calculates the prices
in your estimates as accurately as possible.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Rates.

3. In the Labor Rates dialog box, do any of the following: 

To Do this
Add a new labor rate a. Click New.

b. Type a description and a price per hour.

c. Click Add.
Modify an existing labor
rate NOTE The Detailing and Erecting labor codes

cannot be renamed or deleted.

a. Select a labor rate in the list.

b. Modify the description and price per hour.

c. Click Edit to save the changes.
Delete a labor rate

NOTE The Detailing and Erecting labor codes
cannot be renamed or deleted.

a. Select a labor rate in the list.
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To Do this
b. Click Delete.

c. To permanently delete the labor rate, click Yes
in the confirmation dialog box.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

To modify where each labor rate is used, see Create, modify, and delete labor
groups (page 326).

The labor rate assignments will be used on all summary reports that show the
labor cost. For a breakdown of the labor rates, use the Labor Rate Summary
or the Summary Information - to Excel report option.

Create and modify shop setups
If your company has multiple shops, you can create additional labor
databases, called shop setups, in Tekla EPM. We also recommend that you
create an additional test shop if you are still learning to use Tekla EPM, so that
you do not accidentally make changes to the original shop.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating Maintenance --> Labor Maintenance --
> Shop Setup Maintenance . 
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3. To create a new shop setup, in the Shop Setup Maintenance dialog box,
click New.

4. In the Description field, type a name for the shop setup.

5. If you want to use an existing shop setup as the base of the new setup,
select it in the Copy From Shop Setup list.

6. Click Add.

The new shop setup is added to the list. You can now customize all the shop
settings according to your needs.

TIP To modify the name of an existing shop setup, select the shop setup,
rename it, and click Edit.

See also

Change the active shop setup (page 362)

Change the default shop setup (page 363)

Change the active shop setup
If you have created multiple shop setups, also called labor databases, in Tekla
EPM, you can modify the Estimating Maintenance properties of each shop
separately. If you want to modify a shop setup, you need to activate it first.
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1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating Maintenance --> Current Shop Setup . 

You can see the active shop setup in the Estimating Maintenance menu
after the Current Shop Setup text.

The Select Shop Setup dialog box opens.

3. Select a shop setup in the list.

4. Click OK.

The shop setup, or the labor database, is changed.

If necessary, you can also change the shop setup of an individual estimating
job while working in the Estimating module.

See also

Create and modify shop setups (page 361)

Change the default shop setup (page 363)

Change the default shop setup
The default shop setup is the default shop database used for all future
estimating jobs created in Tekla EPM. You can change the default shop setup
in Shop Setup Maintenance. Note that changing the default shop setup does
not change the settings of existing estimating jobs.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating Maintenance --> Labor Maintenance --
> Shop Setup Maintenance . 
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The Shop Setup Maintenance dialog box opens.

The current default shop setup is marked with an asterisk (*).

3. Select a shop in the list.

4. Click Set as Default.

5. To change the default shop setup, click Yes in the confirmation dialog box.

The default shop setup is updated. The new default shop is marked with an
asterisk (*).

See also

Change the active shop setup (page 362)

Create and modify shop setups (page 361)

Delete shop setups
You can delete any unnecessary shop setups in Shop Setup Maintenance.
For example,you can delete a test shop database that you no longer use. Note
that you cannot delete the current default shop, but you need to select a new
shop setup first.

1. Click the Maintenance ribbon tab.
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2. On the menu, select Estimating Maintenance --> Labor Maintenance --
> Shop Setup Maintenance . 

3. In the Shop Setup Maintenance dialog box, select the shop that you
want to delete.

4. Click Delete.

5. To permanently delete the shop, click Yes in the confirmation dialog box.

See also

Create and modify shop setups (page 361)

Create a standard proposal setup
In Proposal Setups, you can customize the content of bid proposals. Among
other things, you can create different sections for the proposals and add
entries for each section. We also recommend that you modify the existing
entries and delete unnecessary entries according to your needs. You can also
change the order of sections, and modify the titles and styles in the proposal
according to your needs. The sections and entries that you have set up are
used for creating an individual bid proposal based on each estimate.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Proposal Setups . 
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3. On the Main Setups tab of the Proposal Setups dialog box, determine
the signature name or title, price prefix, price suffix, and weight units. 

The Main Setups tab controls details that affect the entire proposal,
whereas the other tabs represent different sections of the proposal.

4. Click Save.

5. Do any of the following according to your needs: 

Option Description
Modify the appearance
of the proposal

a. On the Main Setups tab, click Open
Template.

The proposal template opens in Microsoft
Word. The items marked with << >> pull
information from Tekla EPM and can be
adjusted there, but the other information and
font types can be changed in Microsoft Word.

b. Make the necessary changes to the template.

c. In the Microsoft Word window, click File -->
Save .
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Option Description
d. Save the modified proposal as a custom report

in the default folder that your company uses
for custom reports.

You can verify the default folder by opening
the File menu and selecting Default
Directories.

Note that any changes made to the proposal
document outside of Tekla EPM are not available in
Tekla EPM.

Add a new entry a. Go to the section tab on which you want to
add the new entry.

b. At the bottom of the dialog box, click New.

c. Type the desired text in the space the bottom
of the dialog box.

d. Click Add.
Modify an entry a. Go to the section tab on which you want to

modify an entry.

b. Select the entry that you want to modify.

c. Change the entry text according to your
needs.

d. Click Edit to save the changes.
Move an entry up or
down in the proposal

a. Go to the section tab on which the desired
entry is located.

b. Select the entry that you want to move.

c. To move the entry, click the Move Up and
Move Down buttons at the bottom of the
dialog box.

Change the indentation
of an entry

a. Go to the section on which the desired entry is
located.

b. Select the entry that you want to move.

c. Click the Move Left and Move Right buttons
to shift the position of the item in the
proposal.

Delete an entry a. Go to the section tab from which you want to
delete an entry.

b. Select the entry that you want to delete.

c. Click Delete.

d. To permanently delete the entry, click Yes in
the confirmation dialog box.
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Option Description
Change the titles or
headings of the proposal

a. Go to the section tab whose titles or headings
you want to change.

b. Do any of the following:

• To change the main title of the section,
type a new title in the Title field and click
Set Title.

• To change the style of the headings, click
Attributes and select appropriate styles in
the lists. Then, click Save.

• To add a subtitle, click Attributes and type
a title in the Subtitle field. Then, click Save.

The subtitle appears under the title in the
proposal.

Add a section a. At the top of the dialog box, click Add Section.

b. Type a title for the section.

c. Click OK.

The new tab is added at the end of the
proposal setup.

Delete a section a. Go to the section tab that you want to delete.

b. At the top of the dialog box, click Delete
Section.

c. To permanently delete the section, click Yes in
the confirmation dialog box.

Move a section forward
or backward in the
proposal

a. Go to the desired section tab.

b. In the upper-right corner of the dialog box,
click Move Forward or Move Backward.

6. Click Save.

7. To close the dialog box, click the Close button (X) in the upper-right
corner.

6.2 Open the Estimating module
To start creating estimates, you need to open the Estimating module:

• At the top of the Tekla EPM window, click the Estimating button.
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The Select Estimating Job dialog box opens.

NOTE Jobs whose statuses are set to Closed are not shown by default. To
show closed jobs, select the Show Closed Jobs check box.

You can continue with adding a new estimating job, modifying the properties
of an existing estimating job, opening an estimating job, or viewing the
Document Index.

You can also customize the Select Estimating Job dialog box according to
your needs.

See also

Find an estimating job (page 369)

Create an estimating job (page 370)

Open an estimating job (page 377)

Modify an estimating job (page 396)

Store document references for an estimating job (page 388)

Delete estimating jobs (page 304)
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Find an estimating job
You can use the Find Job command in the Select Estimating Job dialog box to
find an estimating job that you want to open or modify.

Note that sometimes sorting estimating jobs by estimator, bid date, or other
properties in the navigation tree of the Select Estimating Job dialog box can
be quicker than using the Find Job command.

1. While in the Select Estimating Job dialog box, click the Estimating ribbon
tab.

2. On the menu, select Find Job. 

You can also press Ctrl+F to find a job when you are in the Select
Estimating Job dialog box.

3. Type the job name in the field, or click the arrow on the right side of the
field to select an option in the list.

4. Click OK.

The estimating job that you searched for is selected in the Select Estimating
Job dialog box. You can now open or modify it.

NOTE Jobs whose statuses are set to Closed are not shown by default. To
show closed jobs, select the Show Closed Jobs check box.

See also

Open an estimating job (page 377)

Modify an estimating job (page 396)

Create an estimating job
To create a new estimating job, do the following:

1. At the bottom of the Select Estimating Job dialog box, click Add. 
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2. On the General tab of the Estimate Job Edit dialog box, type the job
number. 

The job number cannot be changed after creating the estimating job. All
other details can be modified later.

3. Adjust the following properties according to your needs: 

Option Description
Estimator The name of the estimator.

You can sort estimating jobs based on the
estimator.

Date The date on which the bid is due.

Tekla EPM automatically uses the date when you
create the job, but you can select a different date
in the associated calendar.

Job Name The description of the estimating job.
Location The town or city where the job takes place.
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Option Description
Job Status Select if the job is still in progress (Open), or if the

job has already been finished (Closed).

You can filter the Select Estimating Job dialog
box, so that only open jobs are shown.

ERP Job # The accounting system job number.

Typing the accounting system job number in the
ERP Job # field allows you to link material items
properly when you export information to the
accounting system, such as Trimble Viewpoint.

Job Group One or two job groups that help you identify and
sort estimating jobs. For example, the year of the
estimating job can be used as a job group.

Either type a job group directly in the blank field, or
click the arrow on the right side of the field to
select an existing job group.

Comment Type any additional comments on the job.
Distance To Job The distance to the job site.

Tekla EPM uses the distance to calculate freight
costs if you have selected the Freight Per Mile
option in Freight Maintenance. For more
information, see Modify freight pricing (page 301).

Shop Drawing Cost The total cost of the shop drawings.

The value will be used in the fabrication summary
report.

Shop Drawing MHrs The total labor hours used in shop detail drawings.

The value will be used in the fabrication summary.
Costs will automatically include the Detailing labor
rate set in Labor Rates.

Shop Efficiency The efficiency percentage of the shop, used for
calculating labor times. Shop efficiency is
calculated by dividing the labor times accordingly.

For example, typing 75% would increase overall
labor times by 33.3%, whereas entering 125%
would reduce the labor times by 20%.

Note that the shop efficiency cannot be set to 0.
Shop Setup The labor database used for the estimating job.

Note that the Shop Setup is only available if more
than one shop setup has been created.

To use another labor database instead, click
Change Shop Setup and double-click the shop
that you want to use.
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Option Description
Default Finish The default finish used for new items in the

estimating job.

You can change the finish item by item.
Item Increment Sets the auto-increment for item numbers.

Using the default auto-increment of 10 allows
items to be added in the list according to your
needs, without having to renumber the other items
in the job.

Auto Clip-Angles When selected, Tekla EPM adds standard clips in
the estimating items according to their labor
codes.

When cleared, standard clips are not used.
Project Management
Job

The project management job that is linked to the
estimating job.

By linking estimating and project management
jobs to each other, you can share the labor and
material information with the Project
Management module. Among other details, all the
bid documents of the estimating job can be
automatically linked to the Project Management
job, which saves data transfer time.

Note that the related production control job needs
to be linked to the estimate separately in the
Production Control Job Edit dialog box.

To link a job, click the arrow on the right side of the
Project Management Job field, and select an
existing project management job in the list. The job
numbers do not need to match.

Trimble Connect
Project

The Trimble Connect project that is linked to the
current estimating job.

To link the estimating job to a Trimble Connect
project, click Link, select a project in the Link
Project to Trimble Connect dialog box, and click
Link Project. For more information, see Use
Trimble Connect with an estimating job (page 435).

4. On the Paints tab, create the paints used in the current estimating job: 

• To add a new paint type, click New Paint, define the paint properties,
and click Add.

• To modify a paint type, select the paint type, modify the properties,
and click Save Paint.
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• To delete a paint type from the estimating job, select the paint type
and click Delete Paint.

If you do not assign a paint system to the items on the Paint Systems tab,
all paints listed on the Paints tab will be applied to all painted items by
default. Assigning a paint system to an item in the estimating job
overrides the paints listed here. For more information on the properties
of paint types, see Create, modify, and delete paint types (page 298).

5. On the Paint Systems tab, create job-specific paint systems, if needed. 

For detailed instructions, see Create job-specific paint systems (page 374).

6. On the Clean Systems tab, create job-specific clean systems, if needed. 

For detailed instructions, see Create and apply clean systems (page 296).

7. If necessary, adjust the combining optimizations, galvanizing settings,
supplier information, input and display units, and markup percentages
according to your needs. 

For more information on the available settings, see Define default
combining optimizations for Estimating (page 274), Define and modify job-
specific galvanizing settings (page 375), Define suppliers for an estimating
job (page 376), Define input and display units for an estimating job
(page 375), and Define markup percentages (page 358).

8. Click Save.

The Estimate Job Edit dialog box closes. The estimating job is added to the list
in the Select Estimating Job dialog box.

See also

Create and apply clean systems (page 296)

Create job-specific paint systems (page 374)

Define input and display units for an estimating job (page 375)

Define and modify job-specific galvanizing settings (page 375)

Link an estimating job to a project management job (page 376)

Modify an estimating job (page 396)

Create job-specific paint systems
To create paint systems that are only used in the current estimating job, do
the following:

NOTE To use job-specific paint types in paint systems, you first need to
define them in the Estimate Job Edit dialog box.

1. While in the Estimate Job Edit dialog box, open the Paint Systems tab.

2. Click New Paint System.
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3. Type a description for the new paint system.

4. Use the arrows to move the paints that you want to include in the paint
system to the Included list.

5. Type the number of paint coats in the Quantity field.

6. If you want to set the paint system as the default paint system for new
items in the estimating job, select the Default check box.

If you cannot see the Paint System field in the estimating job, modify the
visible input fields via Maintenance --> Estimating --> Edit Input Fields .

See also

Modify an estimating job (page 396)

Create paint systems (page 300)

Define and modify job-specific galvanizing settings
In the Galvanizing dialog box, you can modify the pricing, minimum costs and
freight information that is applied to a galvanized item in a specific estimating
job. If you do not want to modify these settings for a single estimating job,
Tekla EPM will automatically use the galvanizing settings that you defined in
Estimating Company Standards.

1. In the Select Estimating Job dialog box, do one of the following:

• To define or modify galvanizing settings of a new estimating job, click
New.

• To define or modify galvanizing settings of an existing estimating job,
select the job in the list, and click Edit.

2. At the bottom of the Estimate Job Edit dialog box, click the Galvanizing
button.

3. In the Galvanizing dialog box, modify the galvanizing costs, the trailer
capacity, the labor prep costs per pound, and the weight percent added.

4. Click OK to save the changes.

5. Click Save in the Estimate Job Edit dialog box.

The changes that you made to galvanizing settings are saved for the selected
estimating job.

See also

Define default galvanizing settings (page 271)
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Define input and display units for an estimating job
You can use either metric or imperial units for displaying and entering sizes,
lengths, weights, and prices in a particular estimating job. In addition, you can
select how you want to enter the length and thickness of items.

Defining input and display units for each estimating job is not mandatory. If
you do not define job-specific input and display units, Tekla EPM uses the
default units defined in the Estimating Company Standards dialog box.

1. At the bottom of the Estimate Job Edit dialog box, click Input/Display
Units.

2. In the Input/Display Units dialog box, select the units and the length
input types in the available lists. 

Note that there are multiple options depending on the required precision
and the desired input method.

3. Click OK.

See also

Modify an estimating job (page 396)

Create an estimating job (page 370)

Define default input and display units for Estimating (page 273)

Define suppliers for an estimating job
You can define different suppliers for angles, beams, plates, rods, tubes, and
other materials used in a particular estimating job. Note that defining
suppliers for an estimating job is optional. If you do not define job-specific
suppliers, Tekla EPM uses the default suppliers defined in the Estimating
Company Standards dialog box.

You can manage the available suppliers in Pricing Maintenance. To make
suppliers available in the Suppliers dialog box, the suppliers will first need to
be added in Pricing Maintenance.

1. At the bottom of the Estimate Job Edit dialog box, click Suppliers.

2. In the Suppliers dialog box, select suppliers for each material group in the
available lists.

3. Click OK.

See also

Create an estimating job (page 370)

Modify an estimating job (page 396)

Define default suppliers for Estimating (page 275)
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Link an estimating job to a project management job
By linking an estimating job to a project management job, you can share the
labor and material information with the Project Management and
Production Control modules. This allows you to compare the estimate
information with the actual production information.

1. At the top of the Tekla EPM window, click the Estimating button.

2. In the Select Estimating Job dialog box, select the estimating job that you
want to link to a project management job.

3. Click Edit.

4. In the Estimate Job Edit dialog box, click the arrow on the right side of
the Project Management Job list, and select the desired project
management job in the list. 

The project names and job numbers do not need to match.

5. Click Save.

Note that you also need to link the production control job to the project
management job.

NOTE To unlink an estimating job from a project management job:

1. Erase the job number in the Project Management Job field.

2. Click Save.

See also

Link a production control job to an estimating job and a project management
job (page 728)

Open an estimating job
To open an existing estimating job, do the following:

1. At the top of the Tekla EPM window, click the Estimating button.

2. In the Select Estimating Job dialog box, select the job that you want to
open. 

NOTE Jobs whose statuses are set to Closed are not shown by default.
To show closed jobs, select the Show Closed Jobs check box.

3. Double-click the job, or click Open.
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The Estimating dialog box opens. View the components of the dialog box in
the following image:

(1) The summary: shows the quantity, length, weight, surface area, and work
time in man hours for each of the selected items, all of the selected items, all
items visible in the job, and the entire job.

The summary also displays the pounds per man hour and man hours per ton
calculations for the selected items, all items visible in the job, and the entire
job.

(2) The Find button: click to find items in the job. You can select if you want to
find items of a specific shape, material grade, or material dimension, or a
particular item in the job. For more information, see Find estimating items
(page 413).

You can now continue to adding new items, or modifying and deleting existing
items.
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View only particular material items or pages in the Estimating dialog
box
Use the navigation trees on the left side of the Estimating dialog box to only
view particular material items of a specific shape, grade, or size, or particular
pages of the estimating job.

1. In the Estimating dialog box, go to the navigation tree on the left.

2. Click + next to a main category in the navigation tree. 

The values for that category are shown.

For example, you can click + next to Finish to see the finish options that
are used in the current job.

3. Select a value. 

For example, to only show items who have been painted, select PNT.

Only the items that match the selected value are shown.

You can select more values or categories under the selected value, or under
another main category.

In the example below, only items flat bars with painted finish are shown.

To show all items in the job again, click one of the main categories, such as
Page or Finish.

See also

Filter information in the Estimating dialog box (page 380)
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Filter information in the Estimating dialog box
Use the Filter command to create filter settings that are commonly used in
the Estimating dialog box. For example, you can view labor totals by category
to check averages, or view the totals for items with a specific finish. You can
also save the filter settings for later use.

1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select Filter.

3. To filter the displayed items according to selected criteria, in the
Estimating Filters dialog box, select a filter type in the Type list, and click
Select. 

For some filter types, such as page, labor code, or comment, you can also
click Find and type the desired value in the blank field to use it. This way,
you do not have to scroll through all the available items.

4. In the Filter dialog box, click the arrow buttons to move the items that
you want to display to the Included list.

5. Click OK. 

If you want to further filter the information displayed in the Estimating
dialog box, repeat steps 3 to 5 for different items. Note that only items
that match the items in the Included list will be available when setting
more filters.

If you want to clear all filter settings, click Reset.

6. To save commonly used filters, do the following:

a. Click Filter Types in the lower-left corner.

b. Click New.

c. Type a description for the filter type.

d. Create the filter settings. 

For more information, see steps 3 to 5.

e. Click Add.

f. To close the dialog box, click the Close button (X) in the upper-right
corner. 

The newly created filter type is selected in the Filter Types list.

g. To apply the filter type, click Set.

7. According to your needs, do one of the following:

• To use the filter, click Apply Filter.
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• To use the filter in the job and save it until a new filter is set or the
filter is cleared, click Apply Filter & Save.

Note that the filter will remain in use even if you close and re-open the
job. After you clear the filters, the filter settings cannot be used again.

The Estimating Filters dialog box closes, and the Estimating dialog box is
filtered according to the filter settings you created.

TIP To display all information in the Estimating dialog box again, click Clear
Filters in the upper-left corner.

View estimating job details
You can view various details regarding an estimating job, including the labor
times of each material item and all changes made in the estimating job. You
can also create estimating reports that show the details of the job, and view,
email, or export the reports.

See also

View the labor times of items (page 381)

View all changes in an estimating job (page 384)

View, email, export, and print estimating reports (page 385)

View the labor times of items
Use the View Labor Details command to easily review the labor time of an
item or a group of items, as well as the labor time of the entire estimating job.
If necessary, you can override the labor time calculated by Tekla EPM and
enter the labor time manually instead.

1. In the Estimating dialog box, select the items whose labor details you
want to view. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Estimating ribbon tab.

3. On the menu, select View Labor Details. 

The Labor Details dialog box opens.

The labor estimated time used on the selected items, the displayed items,
and the total estimating job are viewed in a table, categorized by labor
group.

4. If you want to enter labor time manually, do the following:

a. In the table, select and right-click the labor time that you want to
override.

b. In the context menu, click Set Manual Override.
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c. Select if you want to enter the labor time in hours or minutes.

d. Enter the desired labor time in the Manual Override field.

e. Click Set Manual Override.

The items whose values have changed are highlighted with yellow. Other
items affected by the change are highlighted with blue.

If you want to remove the manual override and revert to the labor time
calculated by Tekla EPM, right-click the item and select Remove Manual
Override.

5. To close the dialog box, click the Close button (X) in the upper-right
corner.

To print, email, or export the information in the Labor Details dialog box,
create a Labor Detail report. For more information on creating reports, see
View, email, export, and print estimating reports (page 385).

View and modify the labor time of an item
In the Labor Diagnostic dialog box, you can view and modify the labor time of
an item. The labor time is divided into categories based on the different labor
operations used for the item.

1. In the Estimating dialog box, double-click the item whose labor time you
want to view. 

The Labor Diagnostic dialog box opens, displaying all labor time used on
the selected item.

In the navigation tree on the left, you can view all labor operations that
the selected item goes through. These labor operations are defined by the
labor code that is used. Each labor operation has buttons that allow you
to access the settings that affect how the labor operation is calculated.
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2. In the navigation tree, select a labor operation to view the labor operation
details.

3. According to your needs, do any of the following: 

To Do this
Add a labor time manually a. Right-click the labor time that you

want to modify.

b. In the context menu, click Set
Manual Override.

c. Select if you want to enter the
labor time in hours or minutes.

d. Enter the desired labor time in
the Manual Override field.

e. Click Set Manual Override.

The manual override is created. Note
that the override only applies to the
selected item, not other items of the
same shape, grade and size.

If you want to remove the manual
override and revert to the labor time
calculated by Tekla EPM, right-click
the item and select Remove Manual
Override.

View and modify labor codes, labor
operations, labor standards, or labor
factors

NOTE Modifying the following
settings will affect all new
estimating jobs.

• Click one of the buttons on the
right side of the dialog box:

• Click Labor Codes to modify
labor codes.

• Click Labor Operations to
modify the labor operations.

• Click Labor Standards to view
and modify labor times for
different material dimensions
and shapes.

• Click Labor Factors to modify
the extrapolation factors used
for specific labor operations.
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4. Click Recalculate. 

Tekla EPM applies the changed values.

5. To close the dialog box, click the Close button (X) in the upper-right
corner.

6. In the Estimating dialog box, click the Estimating ribbon tab.

7. On the menu, select Recalculate Estimate. 

Tekla EPM recalculates the current estimating job to ensure accurate total
values. The changes you made are applied to the estimating job.

View all changes in an estimating job
Tekla EPM records every change made in the system. This is useful because
you can view all changes made in the current estimating job at once. You can
filter the information to see changes made by a particular user, or on a
particular date. You can also print or export the list of changes.

1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select List Of Changes.

3. In the List Of Changes Report Filters dialog box, do any of the following: 

To Do this
Filter changes by user a. Select the User filter type and

click Select.

b. Click the arrow buttons to move
the users whose changes you
want to view to the Included list.

c. Click OK.
Filter changes by date a. Select the Transaction Date

filter type and click Select.

b. Do one of the following:

• Enter the start (Minimum)
and end (Maximum) dates.

• Select the Expression check
box for the start or end date.
Then, select the base date
and select how many more or
less days will be taken into
account.

c. Click OK.

4. Click Make Report.

5. In the Report Selection dialog box, do one of the following: 
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To Do this
View the list of changes • Click View.

The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF
buttons at the top of the Tekla EPM Report
Viewer window to email the report via Microsoft
Outlook.

Print the list of changes a. In the Report Selection dialog box, change
the number of the printed copies by clicking
the + and - buttons.

b. If necessary, click Select Printer, select which
device you want to use for printing, and click
OK.

You can also select Default Printer to always
use the default printer with this report, or No
Printer to reset the current printer.

c. Click Print.

d. Click Yes.
Export the list of
changes

a. Click Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Browse to the location where you want to save
the exported file, and click Save.

e. Modify the file name according to your needs.

f. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email check box.

g. To open the file after exporting it, select the
Open Exported Document check box.

h. Click Export.

6. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

View, email, export, and print estimating reports (page 385)

View, email, export, and print estimating reports
You can create multiple types of reports based on your estimating jobs. Some
examples of available reports are different estimates, fabrication summaries,
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job summaries, and material pricing reports. Once you have selected which
report you want to create, you can view, email, export, or print it, according to
your needs.

To create estimating reports, do the following:

1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. To only display certain items in the report, in the Report Filters dialog
box, select a filter type in the Type list, and click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the items that you want to include in
the reports to the Included list.

• Type the maximum and minimum values for the items that you want
to include in the reports.

5. Click OK.

Repeat steps 3 to 5 for every filter type that you want to use.

6. In the Use Pricing Data From list, select which pricing information you
want to use.

7. Click Make Report.

The Report Selection dialog box opens.

Note the purpose of the following buttons:

• If you want to include your company logo in the report, select the
Show Company Logo check box.

• If you want to modify the filters you set for the reports, click Change
Filters.

• If you want to modify the design of a report, select it and click Design.

• If you want to create a customized report list, click Edit Report Types.

According to your needs, see any of the following instructions:

View or email estimating reports

1. Select the report that you want to view. 

To select more than one report at a time, hold down the Ctrl key while
clicking reports in the list.

2. In the Report Selection dialog box, click View.

3. In the Tekla EPM Report Viewer window, view the report.
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4. If you want to attach the report to a Microsoft Outlook email, click either
Email Excel or Email PDF at the top of the window. 

Microsoft Outlook automatically opens and creates a new email. You can
then modify the message, add the recipient, and send the email.

5. Once you have viewed all necessary report details, click Close in the
upper-right corner of the Tekla EPM Report Viewer.

Print estimating reports

1. Select the report that you want to print. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the + and - buttons to increase or decrease the number of copies.

3. Click Print.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Tekla EPM prints the report.

Export estimating reports

1. Select the report that you want to export. 

To select more than one report at a time, hold down the Ctrl key while
clicking reports in the list.

2. In the Report Selection dialog box, click Export.

3. In the Export Format list, select an export format.

4. Click Browse.

5. Modify the file name according to your needs.

6. Browse to the location where you want to save the exported file, and click
Save.

7. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email check box.

8. To open the file after exporting it, select the Open Exported Document
check box.

9. In the Report Selection dialog box, click Export.

Tekla EPM saves the report to the selected location in the selected file format.

Calculate an estimating job
Use the Calculate Material Cost command to view the total material cost of
the displayed or selected estimating items, or use the Recalculate Estimate
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command to update the estimating job value after making changes to the
labor or material databases.

See also

Calculate an estimating job (page 387)

Recalculate an estimate (page 388)

Calculate the total material cost
To view the current total material cost of the displayed or selected items, use
the Calculate Material Cost command. Note that the total material cost does
not contain costs that have been applied to items by adding estimate extras.

1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select Calculate Material Cost. 

The Material Cost dialog box opens and displays the total material cost
of selected, displayed, and all items in the estimating job.

3. View the material costs.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Recalculate an estimate
By recalculating the entire estimating job, you can ensure accurate total value
even after making multiple changes to the labor and material databases.

1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select Recalculate Estimate.

3. To recalculate the estimate, click Yes in the confirmation dialog box.

Store document references for an estimating job
Document Index is where you can store documents for reference. When you
store documents in Document Index, each user with access to the estimating
job can view the documents, so it is easy to keep up-to-date on the estimating
job. You can save all bid documents, contract drawings and specifications, as
well as Microsoft Outlook emails, in Document Index.

To access Document Index, do the following:

1. In the Select Estimating Job dialog box, select the job whose document
references you want to view or modify.

2. Click Document Index, or press F8. If the estimating job is linked to a
project management job and a production control job, Tekla EPM asks
you if you want to open the Document Index dialog box related to the
linked project management job.
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3. According to your needs, do any of the following:

• To view and manage the document references of both the linked
project management job and the current estimating job, click Yes.

• To only view and manage the documents of the current estimating job,
click No.

If you clicked Yes, Tekla EPM asks if you want to view and manage the
documents in the linked production control job as well.

4. According to your needs, do any of the following:

• To view and manage the document references of the linked
production control job as well, click Yes.

• To only view and manage the documents of the current estimating job
and the linked project management job, click No.

The Document Index dialog box opens.

Next, you can either modify the available folders for document references, or
add, modify, delete, open, and email document reference files.

See also

Manage document reference categories (page 389)

Open a document reference (page 394)

Add document references (page 391)

Modify a document reference (page 395)

Attach a document reference to an email (page 396)

Delete a document reference (page 396)

Manage document reference categories
Use the Edit Categories command in Document Index to manage the
categories that you can use to organize document references. You can add
new categories, rename categories, and delete unnecessary categories. You
can also change the default folder where document references are saved.

1. At the bottom of the Document Index - By Category dialog box, click Edit
Categories.

2. In the Document Index - Edit Categories dialog box, do any of the
following: 

To Do this
Add a new category a. In the navigation tree at the top of the dialog

box, select the parent category for the new
category.

b. Click Add.
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To Do this
c. Type a name for the new category.

For example, Miscellaneous documents.

d. Click OK.

The new category is added to the list.
Rename a category a. In the navigation tree at the top of the dialog

box, select the category that you want to
rename.

b. Type a new name for the category.

c. Click OK.

The category name is updated.
Delete a category a. In the navigation tree at the top of the dialog

box, select the category that you want to
delete.

b. Click Delete.

Note that you cannot delete a category that
has sub-categories.

c. To permanently delete the category, click Yes
in the confirmation dialog box.

Change the default
folder where documents
are saved

When documents are added in Document Index,
the selected document can be either moved or
copied to the selected folder. This way, Tekla EPM
retains all documents that have been saved to
Document Index, even if the original documents
are moved or deleted.

The default folder for saving documents needs to
be in the Tekla EPM default folders, so that all
users can view the attached documents. Files
saved elsewhere than the default location cannot
be viewed by other Tekla EPM users.

a. Click Default Dir.

b. Do one of the following:

• Select the folder that you want to use as
the default folder.

• Click Make New Folder to add a new
folder under the currently selected one,
and click it to use it as the default folder.

c. Click OK.

3. To close the dialog box, click the Close button (X) in the upper-right
corner.
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Add document references
You can either upload completely new document references, such as
documents, Microsoft Outlook emails, and Microsoft Outlook email
attachments to Document Index, or add documents already loaded to
Document Index for the current job.

Add new documents

1. In the navigation tree of the Document Index - By Category dialog box,
select the category where you want to save the document.

2. Click Add Document Reference. 

If you are viewing the document references of multiple modules and have
not selected a module-specific category in the navigation tree, Tekla EPM
asks you for which module you want to save the file.

3. Select the desired module.

4. In the Document Index - Add Document Reference dialog box, click Add
File. 

You can also drag and drop files to the Document Index - Add
Document Reference dialog box. If you do so, skip steps 5 and 6.

5. In the Open dialog box, browse to find the document that you want to
add, and select the document.

6. Click Open. 

If you want to add more documents with the same settings, click Add
Additional File and repeat steps 4 to 6 for each document.

7. In the Add File dialog box, select the company and contact that provided
you with the document in the File Source lists. 

You can also drag and drop files to the Add File dialog box.

8. According to your needs, do one of the following:

• To compress multiple documents into one archive, select the
Compress Files into a Single Archive option.

• To leave the documents that you added uncompressed, select the
Leave Files Uncompressed option.

9. If you want to change the folder where the document is saved, click
Browse and select a new folder.

10. According to your needs, do one of the following:

• To move the original document to the selected folder, select the Move
File option.

• To copy the document to the selected folder but leave the original
untouched, select the Copy File (Leave Original) option.

11. Type a description for the attached document.
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12. Click Add File.

13. Type a description for the entire document reference. 

This description applies to all documents, emails, and email attachments
that you add.

14. When you have added all necessary documents, emails and email
attachments, click Add Document Reference.

The Document Index - Add Document Reference closes, and the documents
are added to Document Index. You can see all added documents in the list in
the Document Index - By Category dialog box.

Add a Microsoft Outlook email

1. In Microsoft Outlook, select the email that you want to add.

2. In the navigation tree of the Document Index - By Category dialog box,
select the category where you want to save the email.

3. Click Add Document Reference.

4. In the Document Index - Add Document Reference dialog box, click Add
Outlook Email. 

A copy of the email is added to Document Index.

The text of the email is added to the Description field.

5. Click Add File.

6. Type a description for the entire document reference. 

This description applies to all documents, emails, and email attachments
that you add.

7. When you have added all necessary documents, emails and email
attachments, click Add Document Reference.

The Document Index - Add Document Reference closes, and the emails are
added to Document Index.

Add an attachment from a Microsoft Outlook email

1. In Microsoft Outlook, select the email with the attachment that you want
to add.

2. In the navigation tree of the Document Index - By Category dialog box,
select the category where you want to save the attachment.

3. Click Add Document Reference.

4. In the Document Index - Add Document Reference dialog box, click Add
Outlook Attachments.

5. Browse to the folder where you want to save the email attachment, and
click the folder to select it.
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6. Click Open.

7. In the Add File dialog box, select the company and contact that provided
you with the email attachment in the File Source lists.

8. According to your needs, do one of the following:

• To compress multiple email attachments into one archive, select the
Compress Files into a Single Archive option.

• To leave the email attachments you added uncompressed, select the
Leave Files Uncompressed option.

9. Type a description for the email attachment.

10. Click Add File.

11. Type a description for the entire document reference. 

This description applies to all documents, emails, and email attachments
that you add.

12. When you have added all necessary documents, emails and email
attachments, click Add Document Reference.

The Document Index - Add Document Reference closes, and the email
attachments are added to Document Index.

Search for and add a document already in Document Index

To find and add documents for the current job that are already saved in
Document Index, use the Search command.

1. In the navigation tree of the Document Index - By Category dialog box,
select the category where you want to save the document.

2. Click Add Document Reference.

3. In the Document Index - Add Document Reference dialog box, click
Search.

4. In the Search dialog box, click Browse and select the folder where you
want to look for documents. 

TIP To also search from the sub-folders of the selected folder, select the
Sub-Directories check box.

5. To narrow the search, do one or more of the following:

• Type the document name, document size, and file name extension.

• In File Date, select the dates between which the document has been
created or downloaded onto your computer.

• In Date Loaded, select the dates between which the document has
been added to Document Index.
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• In the Source lists, select the contact and company that have provided
the document.

6. To include archived documents in the search, select the Include All
Archive Files check box.

7. Click Search. 

The search results appear at the top of the Search dialog box.

8. In the search results, double-click the document that you want to add.

The document is added to Document Index for the current job.

Browse for and add a document already in Document Index

To browse to and add documents to the current job that are already saved in
Document Index, use the Find By Directory command. You can also add new
documents, delete existing documents, rename documents and categories,
move documents to other folders, and open documents.

1. In the navigation tree of the Document Index - By Category dialog box,
select the category where you want to save the document.

2. Click Add Document Reference.

3. In the Document Index - Add Document Reference dialog box, click
Find By Directory.

4. In the navigation tree on the left of the Document Index - By Directory
dialog box, select a category. 

If you want to rename the selected category, you can click Rename
Directory, type a new name, and click OK.

The documents within the category are listed in the display area of the
dialog box.

5. Select a document.

6. In the lower-right corner, click Select. 

Note that besides adding an existing document to the current job, you can
also use the buttons at the bottom of the dialog box to:

• Add new documents (Add File).

• Delete a document (Delete File).

• Move a document to another folder within the document index folder
(Move File).

• Rename a document (Rename File).

• Open a document (Open File).

The document is added to Document Index for the current job.
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Open a document reference
Use the Open File command to open and view a document reference.

1. In the Document Index - By Category, select the document that you
want to open.

2. Click Open File.

The selected document opens.

See also

Add document references (page 391)

Modify a document reference (page 395)

Attach a document reference to an email (page 396)

Delete a document reference (page 396)

Modify a document reference
Use the Edit Document Reference command to modify the source and
description of a document in Document Index.

1. In the Document Index - By Category dialog box, select the document
that you want to modify.

2. Click Edit Document Reference.

3. In the Document Reference Details dialog box, click Filename.

4. In the File Details dialog box, modify the file source and description
according to your needs.

5. Click Save.

6. To close the File Details dialog box, click the Close button (X) in the
upper-right corner.

7. Modify the description according to your needs. 

Entering a description in the Document Reference Details dialog box will
override the description that you entered in the File Details dialog box.
This description will then appear in the Description column in the
Document Index - By Category dialog box.

8. Click Save.

9. To close the Document Reference Details dialog box, click the Close
button (X) in the upper-right corner.

See also

Add document references (page 391)

Open a document reference (page 394)

Delete a document reference (page 396)
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Attach a document reference to an email
Use the Email File command to create a new Microsoft Outlook email and
send a document to the desired recipients via email.

1. In the Document Index - By Category dialog box, select the document
that you want to send via email.

2. Click Email File. 

Microsoft Outlook opens. A new email with the selected document is
created, with the selected document attached to it.

3. Add recipients and modify the text of the email.

4. Send the email.

See also

Add document references (page 391)

Open a document reference (page 394)

Delete a document reference
Deleting a document reference from Document Index is permanent and
cannot be undone. If you delete a document reference, you or any other Tekla
EPM users will not be able to access the document reference or any
documents, emails, or attachments that it contains, from Document Index.

1. In the Document Index - By Category dialog box, select the document
reference that you want to delete.

2. Click Delete Document Reference.

3. To permanently delete the document reference, click Yes in the
confirmation dialog box.

See also

Add document references (page 391)

Modify a document reference (page 395)

Open a document reference (page 394)

Modify an estimating job
You can modify any properties of an estimating job later, except for the job
number.

1. In the Select Estimating Job dialog box, select the job that you want to
modify.

2. At the bottom of the dialog box, click Edit. 

Create estimates 396 Open the Estimating module



3. On the General tab of the Estimate Job Edit dialog box, modify the
estimating job properties according to your needs: 

Option Description
Estimator The name of the estimator.

You can sort estimating jobs based on the
estimator.

Date The date on which the bid is due.

Tekla EPM automatically uses the date when you
create the job, but you can select a different date
in the associated calendar.

Job Name The description of the estimating job.
Location The town or city where the job takes place.
Job Status Select if the job is still in progress (Open), or if the

job has already been finished (Closed).

You can filter the Select Estimating Job dialog
box, so that only open jobs are shown.
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Option Description
ERP Job # The accounting system job number.

Typing the accounting system job number in the
ERP Job # field allows you to link material items
properly when you export information to the
accounting system, such as Trimble Viewpoint.

Job Group One or two job groups that help you identify and
sort estimating jobs. For example, the year of the
estimating job can be used as a job group.

Either type a job group directly in the blank field, or
click the arrow on the right side of the field to
select an existing job group.

Comment Type any additional comments on the job.
Distance To Job The distance to the job site.

Tekla EPM uses the distance to calculate freight
costs if you have selected the Freight Per Mile
option in Freight Maintenance. For more
information, see Modify freight pricing (page 301).

Shop Drawing Cost The total cost of the shop drawings.

The value will be used in the fabrication summary
report.

Shop Drawing MHrs The total labor hours used in shop detail drawings.

The value will be used in the fabrication summary.
Costs will automatically include the Detailing labor
rate set in Labor Rates.

Shop Efficiency The efficiency percentage of the shop, used for
calculating labor times. Shop efficiency is
calculated by dividing the labor times accordingly.

For example, typing 75% would increase overall
labor times by 33.3%, whereas entering 125%
would reduce the labor times by 20%.

Note that the shop efficiency cannot be set to 0.
Shop Setup The labor database used for the estimating job.

Note that the Shop Setup is only available if more
than one shop setup has been created.

To use another labor database instead, click
Change Shop Setup and double-click the shop
that you want to use.

Default Finish The default finish used for new items in the
estimating job.

You can change the finish item by item.
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Option Description
Item Increment Sets the auto-increment for item numbers.

Using the default auto-increment of 10 allows
items to be added in the list according to your
needs, without having to renumber the other items
in the job.

Auto Clip-Angles When selected, Tekla EPM adds standard clips in
the estimating items according to their labor
codes.

When cleared, standard clips are not used.
Project Management
Job

The project management job that is linked to the
estimating job.

By linking estimating and project management
jobs to each other, you can share the labor and
material information with the Project
Management module. Among other details, all the
bid documents of the estimating job can be
automatically linked to the Project Management
job, which saves data transfer time.

Note that the related production control job needs
to be linked to the estimate separately in the
Production Control Job Edit dialog box.

To link a job, click the arrow on the right side of the
Project Management Job field, and select an
existing project management job in the list. The job
numbers do not need to match.

Trimble Connect
Project

The Trimble Connect project that is linked to the
current estimating job.

To link the estimating job to a Trimble Connect
project, click Link, select a project in the Link
Project to Trimble Connect dialog box, and click
Link Project. For more information, see Use
Trimble Connect with an estimating job (page 435).

4. On the Paints tab, modify the paints used in the current estimating job: 

• To add a new paint type, click New Paint, define the paint properties,
and click Add.

• To modify a paint type, select the paint type, modify the properties,
and click Save Paint.

• To delete a paint type from the estimating job, select the paint type
and click Delete Paint.

If you do not assign a paint system to the items on the Paint Systems tab,
all paints listed on the Paints tab will be applied to all painted items by

Create estimates 399 Open the Estimating module



default. Assigning a paint system to an item in the estimating job
overrides the paints listed here. For more information on the properties
of paint types, see Create, modify, and delete paint types (page 298).

5. On the Paint Systems tab, modify the job-specific paint systems, if
needed. 

For detailed instructions, see Create job-specific paint systems (page 374).

6. On the Clean Systems tab, modify the job-specific clean systems, if
needed. 

For detailed instructions, see Create and apply clean systems (page 296).

7. If necessary, adjust the combining optimizations, galvanizing settings,
supplier information, input and display units, and markup percentages
according to your needs. 

For more information on the available settings, see Define default
combining optimizations for Estimating (page 274), Define and modify job-
specific galvanizing settings (page 375), Define suppliers for an estimating
job (page 376), Define input and display units for an estimating job
(page 375), and Define markup percentages (page 358).

8. Click Save.

The Estimate Job Edit dialog box closes. The estimating job is updated to
match the changes that you made.

See also

Create job-specific paint systems (page 374)

Create and apply clean systems (page 296)

Define and modify job-specific galvanizing settings (page 375)

6.3 Manage estimating items
You can manage the material items in an estimating job in different ways.

For more information, see the following links:

Add materials to an estimating job (page 400)

Copy and multiply estimating items (page 414)

Modify estimating items (page 417)

Delete an estimating item (page 419)

Create, modify, and delete production codes (page 419)
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Add materials to an estimating job
In addition to manually added estimating items, you can add accessories,
assemblies, and parametric assemblies to estimating jobs.

See also

Add an estimating item (page 401)

Add an accessory (page 409)

Add an assembly (page 411)

Add a parametric assembly (page 412)

Add an estimating item
To add a new item to an estimating job, do the following:

1. At the bottom of the Estimating dialog box, click New.

2. Define the item properties. 

NOTE The visible input fields and their order depend on the settings
that you have defined in the Input Fields dialog box that you can
access via Maintenance --> Estimating --> Edit Input Fields .

The properties marked with an asterisk (*) in the following table are
mandatory information.

Option Description
Page * The number of the page on which the item is

added.

The page number can be used to color-code or
filter items in Trimble Connect. For more
information, see Use Trimble Connect with an
estimating job (page 435).

You can modify the page number manually or use
the page number automatically determined by
Tekla EPM.

Item * The item number.

You can modify the item number manually or use
the item number automatically determined by
Tekla EPM.

Default item increments are set in Company
Standards, but you can modify them for each job.
We recommend leaving spaces between items, so
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Option Description
that you can later add items between existing
items.

If necessary, you can reset the item number
intervals in Job Maintenance.

Quantity * The number of pieces to be added.

Use the numeric keypad in the quantity field to
add, multiply, divide, or subtract numbers to adjust
the quantity.

Shape * The material shape of each piece.

Either click the arrow on the right side of the
Shape field to select the shape, or type the shape
indicator in the field (for example, HSS).

Grade * The material grade of each piece.

Depending on the shape, the grade can also be
mandatory information.

Either click the arrow on the right side of the
Grade list to select the grade, or type the grade
indicator in the field.

Dimensions * The material dimension, or material size, of each
piece.

Depending on the shape, the dimension can also
be mandatory information.

Click the Dimensions field to select an available
material dimension, and double-click the desired
dimension in the list.

TIP You can also use a custom material
dimension. Note that the dimension is not
automatically added to the material
database.

To use a custom dimension, do the following:

a. Click in the Dimensions field.

b. Click Add Size.

c. Define the dimension properties.

d. Click Save.

You can now select the dimension and use it.
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Option Description
Length The length of each piece.

Default length input settings are set in Company
Standards, but you can modify them for each job.

Type The labor code applied to the item. Note that the
available labor codes depend on the material
group of the selected shape.

The labor code can be used to color-code or filter
items in Trimble Connect.

Click the arrow on the right side of the Type field
to select a labor code, or type the labor code
abbreviation in the field.

Extra The estimate extra applied to the item. Estimate
extras are additional costs and labor that you can
add to an estimating item. Estimate extras can also
contain formulas that calculate the additional costs
and labor.

To apply estimate extras to the item, do one of the
following:

• To apply one estimate extra to the item, click
the arrow on the right side of the Extra field to
select the extra that you want to apply.

• To apply multiple extras to the item, double-
click in the Extra field, and click the arrow
buttons to move the desired extras to the
Included list.

Holes, Web Holes, Top
Flg Holes, Bot Flg Holes

The number of the holes, web holes, top flange
holes, or bottom flange holes per piece. Bolts are
automatically added for beams and tubes with
holes.

When you define the number of holes, Tekla EPM
automatically adds the labor time spent on holes
to the item.

Holes w/o Bo The number of holes per piece. No bolts will be
added.

When you define the number of holes, Tekla EPM
automatically adds the labor time spent on holes
to the item.
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Option Description
Stiffeners The number of stiffeners per piece.

When you define the number of stiffeners, Tekla
EPM automatically calculates and adds the labor
time spent on stiffeners to the item.

Note that you need to add the material for the
stiffeners separately because such material is not
added automatically.

Copes The number of copes per piece.

When you define the number of stiffeners, Tekla
EPM automatically calculates and adds the labor
time spent on copes to the item.

MHrs/Pc The number of man hours per piece.

This time will be added to the labor time already
calculated by Tekla EPM.

Manual Cost A cost that replaces the material cost of the item in
reports.

TIP If necessary, you can change and convert the
units by right-clicking in the Manual Cost
field. Select a suitable option in the context
menu.

Finish The finish type of the item. The default options are
Painted, Unpainted, and Galvanized.

The finish type can be used to color-code or filter
items in Trimble Connect. For more information,
see Use Trimble Connect with an estimating job
(page 435).

You can apply paint systems to an item whose
finish type is Painted to use other finishes than
the standard ones.

Category, Sub-Category A class used for sorting items within a job.
Categories and sub-categories can be used for
filtering the information in the Estimating dialog
box and color-coding or filtering items in Trimble
Connect.

The available categories and sub-categories are
created in Estimating Company Standards.
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Option Description
If necessary, you can also assign quantity
multipliers to sub-categories.

Click the arrow on the right side of the Category or
Sub-Category field and select an existing category,
or type a new category in the field.

MainPc When selected, indicates that the item is a main
piece in an assembly. When cleared, indicates that
the item is not a main piece.

Marking items as main pieces allows you to
consider whole assemblies in fabrication. If you
use main pieces, you can create reports that show
the properties for each main piece, or assembly.

Selecting the MainPc check box is optional, but be
consistent: either select the check box for all main
pieces in the estimating job, or do not select it for
any of them.

Comment An optional comment that you can type for the
item.

Erect Hrs The number of hours spent on erecting the item.
Erect Cost The amount of money used for erecting the item.
Status The estimate status of the item. The status

indicates the level of completion of the item.

The status can be used to color-code or filter items
in Trimble Connect. For more information, see Use
Trimble Connect with an estimating job (page 435).

Detailing Cost The amount of money used for erecting the item.

The Detailing Cost field is identical with the Erect
Cost field.

Detailing Hrs The number of hours spent on erecting the item.

The Detailing Hrs field is identical with the Erect
Hrs field.

Prod. Code The production code applied to the item.

Production codes group items so that you can
apply man hour per ton and per labor group
percentages to items in the linked production
control job.

The production code can be used to color-code or
filter items in Trimble Connect. For more
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Option Description
information, see Use Trimble Connect with an
estimating job (page 435).

Production codes group similar items together
within jobs.

Sequence The sequence number assigned to the item.

The sequence can be used to color-code or filter
items in Trimble Connect. For more information,
see Use Trimble Connect with an estimating job
(page 435).

Click the arrow on the right side of the Sequence
field to select a sequence number, or type the
number in the field.

Clean System The clean system applied to the item.

Click the arrow on the right side of the Clean
System field to select an existing clean system.

Paint System The paint system applied to an item whose finish
type is Painted.

Click the arrow on the right side of the Paint
System field to select an existing clean system.

If no paint system is selected for a painted item,
the default paints defined in the Estimate Job Edit
dialog box are applied. For more information, see
Modify an estimating job (page 396).

Cost/Pc A cost per piece that is added to the material cost
of the item.

Welded Studs The number of welded studs per piece.

The price per welded stud is defined in Fabricator
Information for a typical stud price.

You can also add welded studs as separate items.
Tekla EPM will then price them accordingly.

Camber The camber size used with the item.

Type the labor time used in cambers in the
MHrs/Pc field.

Do not define the cost of cambers in the Manual
Cost field. The cost entered in the Manual Cost
overrides the material cost of cambers. Instead,
you can type the cost in the Cost/Pc field.

Part # The part number that identifies the accessory item.

The selected part number populates the applicable
fields with the information from Accessory
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Option Description
Maintenance. The applicable fields need to be
modified in the Accessory Maintenance dialog
box.

PRC Unit Cost, PRC
Cost, PRC Date

Fields that show the current pricing information of
the selected item from the selected supplier.

If no date is displayed in the PRC Date field, the
material does not exist in the selected supplier's
pricing data set.

Double-click one of the fields to open the Pricing
Maintenance dialog box and enter pricing
information.

3. If necessary, apply additional labor and clips to the item. 

For more information, see Apply additional labor and clips (page 407).

4. Click Add.

The item is added to the display area.

See also

Apply additional labor and clips (page 407)

Modify a single estimating item (page 417)

Copy estimating items (page 415)

Delete an estimating item (page 419)

Apply additional labor and clips
You can apply additional labor operations, such as welding or burning, or
standard clips to an estimating item.

To apply additional labor and clips, do the following:

1. In the Estimating dialog box, select the item to which you want to apply
additional labor or clips.

2. In the lower-right corner of the dialog box, expand the Additional Labor
and Clips section.

3. Click Edit, or press Shift+F4.

The Estimating Item dialog box opens.

You can add additional labor on the left side of the dialog box, and clips on the
right side of the dialog box. To apply additional labor or clips, see the following
sets of instructions.

Apply additional labor

1. In the Additional Labor section of the dialog box, click New.
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2. In the Quantity field, enter the number of operations that you want to
add.

3. In the Operation list, select which labor operation you want to add.

4. To define the material thickness, do either of the following:

• Type the desired material thickness in the Thickness field.

• In the list on the right side of the Thickness field, select Thickness to
apply the thickness defined in the material dimensions.

Note that the available options for thickness depend on the shape of the
selected item. If the selected item is a beam, the list on the right side of
Thickness allows you to select if the applied thickness is the flange
thickness or the web thickness.

5. Select the operation type in the Type list.

6. If necessary to define the length, do either of the following:

• Type the desired length in the Length field.

• In the list on the right side of the Length field, select an option to
apply a value defined in the material dimensions.

Note that the available options for length depend on the shape of the
selected item. If the selected item is a beam, the list on the right side of
Length allows you to select if the applied thickness is the flange thickness
or the web thickness.

7. Click Add. 

The additional labor operations are added to the list and applied to the
selected item.

You can view the labor time, cost, and weight associated with the
additional labor at the bottom of the Additional Labor section in the
Estimating Item dialog box.

8. To close the Estimating Item dialog box, click X in the upper-right corner.

Apply clips

The available clips are standard clips defined in Standard Clips Maintenance.
For more information, see Manage standard clips (page 339).

1. In the Clips section of the dialog box, click New.

2. In the Quantity field, enter the number of clips that you want to add.

3. Select the shape, clip, and finish in the available list.

4. If you set the clip finish to Painted, select the paint system in the Paint
System list.

5. If necessary, select a cleaning system for the clip in the Clean System list.

6. Click Add. 
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The clips are added to the list and applied to the selected item.

You can view the labor time associated with the clips and the clip weights
in the list at the bottom of the Clips section in the Estimating Item dialog
box.

7. To close the Estimating Item dialog box, click X in the upper-right corner.

Add an accessory
Accessories are commonly used items that you can add to items in your
estimating jobs. You can create accessories for items such as stiffeners, base
plates, or embeds. Accessories can also be linked to specific material shapes
and sizes, so that they can only be added to items of that shape and size. To
add an accessory to an item, use the Add Accessory command.

Note that a you can also add an accessory by typing the part number of the
accessory in the Part # field.

1. In the Estimating dialog box, select the item for which you want to add an
accessory.

2. Click the Estimating ribbon tab.

3. On the menu, select Add Accessory. 

The Select Accessory dialog box opens.

If the accessory list is empty, there are no accessories linked to the
selected material shape and size. In these cases, you can either create a
new accessory in (page 276), or create a job-specific accessory (page 409).

4. In the accessory list, select the accessory that you want to add.

5. Select or clear the check boxes at the bottom of the dialog box according
to your needs.

6. Click Add Selected.

The Select Accessory dialog box closes.

The accessory is added as the last item of the selected page in the Estimating
dialog box.

Note that accessories have the same input fields and properties as other
estimating items. In addition, accessories have a description.

Create a job-specific accessory
You can create accessories that are only used within the current estimating
job. Remember that all labor and material costs associated with the accessory
will be added to the estimating job.

NOTE We recommend that you create, modify, and delete accessories in
Accessory Maintenance. You can also create accessories in an
estimating job, but these job-specific accessories cannot be saved to
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the accessory library, so they cannot be reused in other estimating
jobs.

1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select Job-Specific Accessory Maintenance.

3. In the Accessory Maintenance dialog box, click New.

4. If you want to use the accessory multiple times in the current estimating
job, enter a part number.

5. Type a description for the accessory.

6. Enter the remaining properties for the accessory: 

Option Description
Quantity The number of accessories per item to which they

are added.
Shape The material shape of the accessory.
Dimensions The material size of the accessory.
Length The length of the accessory.
Grade The material grade of the accessory.
Type The labor code of the accessory.
Extra The estimate extras applied to the accessory.

To add estimate extras, double-click the Extra
field.

Holes The number of holes in the accessory.
Web Holes The number of web holes in the accessory.
Stiffeners The number of stiffeners in the accessory.
Copes The number of copes in the accessory.
MHrs/Pc The number of man hours spent on the accessory.
Manual Cost The cost for the accessory that you can enter

manually.

The manual cost is optional, and it overrides the
pricing information in the pricing database.

MainPc When selected, the item to which the accessory is
added is considered a main piece.

Comment An optional and additional comment on the
accessory.

Erect Hrs The number of man hours spent on erecting the
accessory.

Erect Cost The cost of erecting the accessory.
Prod. Code The production code applied to the accessory.
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Option Description
Camber The camber size used with the accessory.
Holes w/o Bo The number of holes per piece in the accessory. No

bolts will be added.
Top Flg Holes, Bot Flg
Holes

The number of top flange holes or bottom flange
holes per accessory.

Welded Studs The number of welded studs per accessory.
Detailing Hrs The number of hours spent on erecting the

accessory.
Detailing Cost The amount of money used for erecting the

accessory.
Cost/Pc A cost per piece that is added to the material cost

of the accessory.

7. Click Add. 

The accessory is added to the list, and you can add it in the current
estimating job.

You can also use the other buttons at the bottom of the Accessory
Maintenance to modify the job-specific accessories:

• Click Edit to modify the selected accessory.

• Click Copy to create a new accessory based on the selected accessory.

• Click Delete to permanently delete the selected accessory.

• Click Global Edit Selected to modify the properties of multiple
selected accessories at once.

8. To close the dialog box, click the Close button (X) in the upper-right
corner.

9. Add the accessory to an item in the estimating job. 

For more information, see Add an accessory (page 409).

Add an assembly
Assemblies are commonly used bid items that can contain multiple pieces with
different shapes, labor codes, finishes, and other properties, as well as
accessories and parametric assemblies. By adding the assembly to your
estimating job, you can add all these pieces at once. We recommend that you
add assemblies at the end of the page in an estimating job.

Note that assemblies often begin with a comment line that describes and
labels the assembly. This makes it easier to recognize assemblies.

1. Scroll to the end of the page in the Estimating dialog box.

2. Click the Estimating ribbon tab.
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3. On the menu, select Add Assembly.

4. In the Add Assembly dialog box, type the number of assemblies you want
to add in the Quantity field.

5. If you want to be able to select from assemblies that are available for all
jobs, ensure that the Show Global Assemblies check box is selected. 

If the Show Global Assemblies check box is not selected, you can only
select assemblies that have been added in the current estimating job.

6. Do one of the following:

• In the Assembly list, select the assembly that you want to add.

If you have selected the Show Global Assemblies check box, the
Assembly list contains all assemblies that are available in Assembly
Maintenance.

• If you want to create a new assembly, click New, type a name for the
assembly, and click OK. For further instructions, see Create assemblies
(page 311).

NOTE The new assembly will initially only be available in the current
estimating job, but you can later add it to the assembly library.
For instructions, see View, rename, copy, and delete
assemblies (page 314).

• If you want to modify an existing assembly, select the assembly in the
Assembly list, and click Edit.

7. If you want to assign a sub-category to the assembly, select the Set Sub-
Category check box, and select an option in the Sub-Category list. 

Assigning a sub-category to the assembly allows you to easily identify and
filter assemblies.

8. Click Add Assembly.

The Add Assembly dialog box closes, and the assembly is added at the end of
the item list in the current estimating job.

Add a parametric assembly
Use the Add Parametric Assembly command to add assemblies with
variables to an estimating job. These assemblies, called parametric
assemblies, may vary in height, width or length, so you can use them in
different situations. When you define the variable values, Tekla EPM calculates
the parametric assembly according to the defined values.

We recommend that you add assemblies at the end of the page in an
estimating job.

Note that parametric assemblies often begin with a comment line that
describess and labels the assembly.
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1. Scroll to the end of the page in the Estimating dialog box.

2. Click the Estimating ribbon tab.

3. On the menu, select Add Parametric Assembly. 

The Select Parametric Assembly dialog box opens, displaying all
parametric assemblies.

4. Select the parametric assembly that you want to add.

5. Click OK. 

The Parametric Assembly - Variables dialog box opens, displaying all
variables in the parametric assembly.

6. Select a variable in the list.

7. In the Value field, type a value for the variable.

8. Click Set Value. 

Repeat steps 6 to 8 for all variables.

9. Click Calculate Parametric Assembly. 

Tekla EPM calculates the parametric assembly. When the calculation
process is finished, the Parametric Assembly - Results dialog box opens.

10. Verify that the calculations are correct.

11. If you want to assign a sub-category to the parametric assembly, click the
arrow button on the right side of the Sub-Category list and select a sub-
category. 

Assigning a sub-category to the assembly allows you to easily identify and
filter assemblies.

12. Click Add Parametric Assembly.

The parametric assembly is added at the end of the estimating job.

Find estimating items
Use the Find button in to quickly find estimating items. You can search for
items by material shape, grade, and dimensions, or by page and item number.

1. In an open estimating job, click Find.

2. Do one of the following: 

To Do this
Find all items that have a particular
shape, grade, and dimensions

a. In the Find menu, select Find
Shape/Grade/Size.
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To Do this
b. In the Find dialog box, select the

right shape, grade, and
dimensions in the available lists.

You can also start typing the
shape, grade, or dimensions.
Tekla EPM will suggest options
that match what you have typed.

c. Click Find.

The Find dialog box closes. Only the
items that match your search are now
shown in the Estimating dialog box.

Find the right item on a particular
page of the estimating job

a. In the Find menu, select Find
Item.

b. In the Find dialog box, select the
right page number and item
number in the available lists.

You can also start typing the page
number or item number. Tekla
EPM will suggest options that
match what you have typed.

c. Click Find.

The Find dialog box closes. Only the
items that match your search are now
shown in the Estimating dialog box.

See also

Manage estimating items (page 400)

Copy and multiply estimating items
Creating an estimate becomes quicker when you use the available commands
for copying and multiplying items. By doing so, you can avoid having to enter
the same items one by one on different pages, and modifying the quantities of
items one by one.

For more information, see the following links:

Copy estimating items (page 415)

Copy a page of estimating items (page 415)

Copy and multiply a group of estimating items (page 415)

Multiply the quantity of the selected estimating items (page 416)
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Multiply the quantity of all estimating items in a sub-category (page 416)

Copy estimating items
You can copy estimating items in the Estimating dialog box and use them as
the basis of a similar item. Then, modify the properties of the new items
according to your needs. By copying items, you can save time and avoid
entering the same information multiple times in an estimating job.

1. In the Estimating dialog box, select the items that you want to copy. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Copy. 

Copies of the selected items appear at the bottom of the current page.

3. Adjust the properties of the new items according to your needs.

4. Click Edit to save the changes.

See also

Copy a page of estimating items (page 415)

Copy and multiply a group of estimating items (page 415)

Copy a page of estimating items
Use the Copy Page command to copy all items on a page of the estimating job
onto a new page.

1. In the Estimating dialog box, select any item on the page that you want to
copy.

2. Click the Estimating ribbon tab.

3. On the menu, select Copy Page.

4. In the Copy Page dialog box, type the new page number in the New Page
# field.

5. Click Copy.

Copy and multiply a group of estimating items
Use the Copy Special to copy a group of items on a page and multiply their
quantity while copying. You can either copy the items on the same page or on
another page.

1. In the lower navigation tree of the Estimating dialog box, select a page.

2. In the display area, select the items that you want to copy. 
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To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

3. Click Estimating.

4. On the menu, select Copy Special.

5. In the Qty Multiplier field, type a number by which all selected items will
be multiplied.

6. In the New Page # field, type a page name.

7. Click Copy.

The items are copied at the end of the selected page, and their quantity is
multiplied. To view the items, click the page number in the lower navigation
tree.

See also

Copy a page of estimating items (page 415)

Multiply the quantity of the selected estimating items
Use the Selected Items Multiplier command to multiply specific items in the
estimating job. This is a quick way to you can increase the quantity of multiple
estimating items at once.

1. In the Estimating dialog box, select the items that you want to multiply.

2. Click the Estimating ribbon tab.

3. On the menu, select Selected Items Multiplier.

4. In the Multiplier field, type the number by which you want to multiply the
selected items.

5. Click Save.

The quantities of the selected items are multiplied.

See also

Multiply the quantity of all estimating items in a sub-category (page 416)

Multiply the quantity of all estimating items in a sub-category
Use the Sub-Category Multipliers command to multiply the quantity of all
items that are associated with a specific sub-category in an estimating job.

1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select Sub-Category Multipliers. 

The Sub-Category Multipliers dialog box opens.

3. In the list, select a sub-category.
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4. In the Multiplier field, type the number by which you want to multiply the
quantity of items.

5. Click Save. 

The quantity of each item in the sub-category is multiplied.

6. To close the dialog box, click the Close button (X) in the upper-right
corner.

Note that the quantity of the items in the Quantity field of the Estimating
dialog box remains the same. The multiplication factor appears on the right
side of the Quantity field.

See also

Multiply the quantity of the selected estimating items (page 416)

Modify estimating items
You can either modify the items in estimating jobs one by one, or use the
different Global Edit commands to modify multiple items at one go.

For more information, see the following links:

Modify a single estimating item (page 417)

Modify multiple estimating items (page 417)

Modify the selected estimating items (page 418)

Modify a single estimating item
You can modify a single estimating item directly in the Estimating dialog box.

1. In the Estimating dialog box, select the item that you want to modify.

2. On the right side of the dialog box, modify the item properties. 

For example, change the quantity, adjust the labor time, or add additional
labor and clips.

3. Click Edit to save the changes.

See also

Modify multiple estimating items (page 417)

Modify the selected estimating items (page 418)

Modify multiple estimating items
Use the Global Edit command to modify the properties of all or multiple
estimating items at one go. This way, you can save time, as you do not need to
change the properties of each item individually.
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1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select Global Edit --> Global Edit.

3. To only modify specific types of items, in the Estimating Global Edit
Filters dialog box, select a filter type in the Type list, and click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the items that you want to modify to
the Included list.

• Type the maximum and minimum values for the items that you want
to modify.

5. Click OK. 

To further limit the item types that you want to modify, repeat steps 2 to 5
for all necessary filter types.

6. Modify the selected properties in the Global Edit dialog box according to
your needs. 

For example, you can change the category of the items by selecting an
option in the Category list, or type a comment for the items.

7. In the Global Edit dialog box, select check boxes next to the properties
that you want to update. 

You can also use the Un-check All and Check Changed Fields buttons to
quickly clear or select check boxes.

8. Click Update.

The changes you made to estimating item properties are updated to the
Estimating dialog box.

Modify the selected estimating items
Use the Global Edit Selected command to modify the properties of multiple
selected items in the estimating job. This way, you can save time, as you do
not need to change the properties of each item individually.

1. In the Estimating dialog box, select the items that you want to modify. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Estimating ribbon tab.

3. On the menu, select Global Edit --> Global Edit Selected .

4. Modify the selected properties in the Global Edit dialog box according to
your needs. 

For example, you can change the category of the items by selecting an
option in the Category list, or type a comment for the items.
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5. In the Global Edit dialog box, select check boxes next to the properties
that you want to update. 

You can also use the Un-check All and Check Changed Fields buttons to
quickly clear or select check boxes.

6. Click Update.

The properties of the selected estimating items are updated to the Estimating
dialog box.

Delete an estimating item
You can delete one or multiple unnecessary items from an estimating job.
Note that deleting the items is permanent and cannot be undone.

1. In the Estimating dialog box, select the item that you want to delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Delete or press F2 on the keyboard.

3. To permanently delete the items, click Yes in the confirmation dialog box.

Create, modify, and delete production codes
Use production codes to group similar items together within estimating jobs. If
necessary, you can then override the man hours of all items that production
code. Production codes also allow you to link estimating items to production
control job items. This way, the Production Control module can use estimate
information, such as man hours, and you can view project details and parts
easily.

Production codes can be as broad or as specific as you like. For example, you
can use one production code for the entire estimating job to add the labor
estimates to the production control job. The man hours will then be calculated
based on all work that must be done for the entire job. However, you can also
set every piece mark to have its own production code, so that man hours in
the estimating job and in the production control job match for each item.

To access the Production Codes dialog box, do the following:

1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select Production Codes.

The Production Codes dialog box opens.
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You can filter the production codes that are displayed by selecting an option in
the Show Production Codes list at the top of the dialog box. The options are:

• Global: production codes that can be used in all jobs in both Production
Control and Estimating.

• Estimate-Specific: production codes that can only be used within a specific
estimating job and the linked production control job. These are the
production codes that you can create in the current dialog box.

• In Use: production codes that are used.

You can also create a report that lists all production codes used in an
estimating job. The report is called Production Code Summary. For more
information on creating reports, see View, email, export, and print estimating
reports (page 385).

According to your needs, see any of the following instructions:

Create a production code
Note that you can only create production codes for the current estimating job
in the Production Codes dialog box. Globally available production codes are
created in Global Production Code Maintenance.

1. At the bottom of the dialog box, click New.

2. Name the production code and type a description.

3. Do any of the following: 

To Do this
Use the estimated labor
times of items within

The man hours associated with the production
codes are only used in Production Control.
Production codes do not affect or apply labor to
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To Do this
the production code in
Production Control

estimating items. The purpose of the man hours is
to pull labor information from the estimate in the
form of man hours per ton and labor percentages
by labor group.

• In the Aggregate Units list, select a calculation
option.

Override the estimated
labor time of items
within the production
code in Production
Control

NOTE Manually overriding man hours applies an
aggregate unit, man hours per ton, that can
be applied to production control items.
However, if the manual override is used,
the labor information does not include
labor group percentages. Therefore, the
labor group percentages cannot be applied
to any production control stations. Further,
the information cannot be applied to tasks
in the project schedule and to resources
that feed information to the production
schedule. Manually overriding man hours
can also prevent you from comparing the
linked production control job with the
estimating job.

a. Select the Override Man Hours check box.

b. Type the labor time in the field on the right
side of the check box.

TIP To change the units, right-click in the field
and select a suitable option in the
context menu.

4. Click Add.

Modify a production code
1. Select the production code that you want to modify.

2. Modify the production code properties according to your needs.

3. Click Save to update the production code properties.

Delete a production code
1. Select the production code that you want to delete.

2. Click Delete.
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3. In the confirmation dialog box, click Yes to permanently delete the
production code.

Apply a production code
To apply an existing production code to the estimating job:

1. Ensure that you have the Prod. Code display and input fields visible in the
Estimating dialog box. 

If not, do the following:

a. Go to Maintenance --> Estimating --> Edit Display Fields .

b. Move the Production Code field to the Included Fields list.

c. Click Save.

d. Go to Maintenance --> Estimating --> Edit Input Fields and repeat
steps b and c.

e. Re-open the estimating job.

2. Click the Estimating ribbon tab.

3. On the menu, select Global Edit --> Global Edit .

4. To only apply the production code to specific types of items, in the
Estimating Global Edit Filters dialog box, select a filter type in the Type
list, and click Select.

5. In the Filter dialog box, click the arrow buttons to move the items whose
properties you want to modify to the Included list.

6. Click OK to apply the filter.

7. In the Estimating Global Edit Filters dialog box, click OK-

8. In the Global Edit dialog box, select the check box on the left side of Prod.
Code.

9. In the Prod. Code list, select the production code that you want to use for
the selected item types.

10. Click Update.

11. To update the production code for the selected items, click Yes in the
confiramtion dialog box.

12. Repeat steps 2 to 10 to assign a production code for each item in the
estimating job.

See also

Create, modify, and delete production codes (page 419)
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Load estimating materials to other modules
You can load the material items in an estimate to another estimate, a
requisition or a purchase order, or a production control job.

See also

Load materials into another estimate (page 426)

Load estimating materials into purchasing (page 423)

Load materials into Production Control (page 428)

Load estimating materials into purchasing
You can load material items in an estimating job into a purchase order or a
requisition. Either send material items into a purchase order in order to
purchase the items, or send material items to a requisition in order to get
pricing information from suppliers and apply the received pricing to the
estimating items.

You can either load all estimating items into a requisition or a purchase order,
or select the items that you want to load to purchasing.

Load all estimating items into a requisition
Use the Load Material Into Requisition command to load all material in an
estimating job into a requisition. This way, you can get pricing information
from a supplier and apply it to the estimate-specific pricing. You can either add
the items into an existing requisition or create a new one.

1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select Purchasing --> Load Material Into Requisition .

3. In the Select Purchase Order dialog box, select a purchase order and
click OK. 

If necessary, you can also create a new purchase order and load the items
into it.

4. In the Purchasing Import Filters, do one of the following: 

To Do this
Load all items • Click Import.
Filter out items
that you do
not want to
load

a. On the left side of the dialog box, select a filter type in
the Type list, and click Select.

b. Click Select.

c. Click the arrow buttons to move the items that you want
to load to the requisition to the Included list.

The items on the Not Included side will not be sent to
purchasing.
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To Do this
d. Repeat the process for different filter types until you

have filtered out all unnecessary items.

e. Click Import.

5. Click OK to close the Import Items dialog box. the Estimating dialog box.

Items are sent to the selected requisition. To view and use the requisition,
open the Purchasing module and go to the Requisitions tab.

See also

Load all estimating items into a purchase order (page 424)

Load the selected estimating items into a requisition (page 425)

Load all estimating items into a purchase order
Use the Load Material Into Purchase Order command to load all estimating
material items into a purchase order. You can either add the items into an
existing purchase order or create a new one.

1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select Purchasing --> Load Material Into Purchase
Order .

3. In the Select Purchase Order dialog box, select a purchase order and
click OK. 

If necessary, you can also create a new purchase order and load the items
into it.

4. In the Purchasing Import Filters, do one of the following: 

To Do this
Load all items • Click Import.
Filter out items
that you do
not want to
load

a. On the left side of the dialog box, select a filter type in
the Type list, and click Select.

b. Click Select.

c. Click the arrow buttons to move the items that you want
to load to the requisition to the Included list.

The items on the Not Included side will not be sent to
purchasing.

d. Repeat the process for different filter types until you
have filtered out all unnecessary items.

e. Click Import.
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5. Click OK to close the Import Items dialog box. the Estimating dialog box.

Items are loaded into the selected purchase order. To view and use the
purchase order, go to the Purchasing module and open the Purchase Orders
tab.

See also

Load all estimating items into a requisition (page 423)

Load the selected estimating items into a requisition
Use the Load Selected Material Into Requisition command to select the
items in an estimating job that are loaded into a requisition. This way, you can
get pricing information from a supplier and apply it to the estimate-specific
pricing. You can either add the items into an existing purchase order or create
a new requisition.

1. In the Estimating dialog box, select the items that you want to load. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Estimating ribbon tab.

3. On the menu, select Purchasing --> Load Selected Material Into
Requisition .

4. In the Select Requisition dialog box, select a requisition and click OK. 

If necessary, you can also create a new requisition and load the items into
it.

5. Click OK to close the Import Items dialog box. the Estimating dialog box.

Items are sent to the selected requisition. To view and use the requisition,
open the Purchasing module and go to the Requisitions tab.

See also

Load all estimating items into a requisition (page 423)

Load the selected estimating items into a purchase order (page 425)

Load the selected estimating items into a purchase order
Use the Load Selected Material Into Purchase Order command to select the
items in an estimating job that are loaded into a purchase order. You can
either add the items into an existing purchase order or create a new one.

1. In the Estimating dialog box, select the items that you want to load. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Estimating ribbon tab.

Create estimates 425 Manage estimating items



3. On the menu, select Purchasing --> Load Selected Material Into
Purchase Order .

4. In the Select Purchase Order dialog box, select a purchase order and
click OK. 

If necessary, you can also create a new purchase order and load the items
into it.

5. Click OK to close the Import Items dialog box. the Estimating dialog box.

Items are loaded into the selected purchase order. To view and use the
purchase order, go to the Purchasing module and open the Purchase Orders
tab.

See also

Load all estimating items into a purchase order (page 424)

Load the selected estimating items into a requisition (page 425)

Load materials into another estimate
Use the Load Material Into Estimate and Load Selected Material Into
Estimate commands to copy material from an estimating job to either
another existing estimating job or to a new one. These commands are
particularly useful when more than one person is working on a bid, or when
you are making pricing breakouts on adds or deducts. You can load all items
into another estimating job or select the items that you want to load manually.

NOTE To create pricing for the added material, you need to delete the copied items
manually from the original location. Tekla EPM does not automatically remove
items from any estimate.

Load all or filtered items into an estimate

1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select Load Material --> Load Material Into Estimate .

3. In the Select Estimating Job dialog box, do either of the following: 

To Do this
Load the material into
an existing estimating
job

• Double-click the estimating job to which you
want to load the material.

Load the material into a
new estimating job

a. Click Add.

b. In the Estimate Job Edit dialog box, type a job
number.
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To Do this
c. Define any other necessary properties for the

new estimating job.

Note that you can also change the estimating
job properties later.

d. Click Save.

e. Double-click the new estimating job in the
Select Estimating Job dialog box.

4. In the New Page # field, type the page where you want to copy the
material.

5. Click OK.

6. To only load specific types of items, in the Estimating Import Filters
dialog box, select a filter type in the Type list, and click Select.

7. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the items that you want to load to the
Included list.

• Type the maximum and minimum values for items that you want to
load.

8. Click OK. 

To further limit the items to be loaded, repeat steps 6 to 9 for the
necessary filter types.

9. Click Import.

Tekla EPM loads all or filtered items into the selected estimating job. You can
see the progress of the process in the Import Items dialog box. After loading
the material has finished, click OK to close the Import Items dialog box.

Load selected items into an estimate

1. In the Estimating dialog box, select the items that you want to load to
another estimate. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Estimating ribbon tab.

3. On the menu, select Load Material --> Load Selected Material Into
Estimate .

4. In the Select Estimating Job dialog box, do either of the following: 
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To Do this
Load the material into
an existing estimating
job

• Double-click the estimating job to which you
want to load the material.

Load the material into a
new estimating job

a. Click Add.

The Estimate Job Edit dialog box opens.

b. Type a job number.

c. Enter any other necessary properties for the
new estimating job.

Note that you can also change the estimating
job properties later.

d. Click Save.

e. Double-click the new estimating job in the
Select Estimating Job dialog box.

5. In the New Page # field, enter the page where you want to copy the
material.

6. Click OK.

Tekla EPM loads the selected items into the selected estimating job. You can
see the progress of the process in the Import Items dialog box. After loading
the material has finished, click OK to close the Import Items dialog box.

Load materials into Production Control
Use the Load Material Into Production Control and Load Selected Material
Into Production Control commands to send items from the currently open
estimating job to a new or existing production control job.

Load all items into a production control job

1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select Load Material Into Production Control.

3. In the Select Production Control Job dialog box, do one of the following: 

To Do this
Load the items to an
existing production
control job

• Select the production control job in the list.

Load the items to a new
production control job

a. Click Add.

b. In the Production Control Job Edit dialog box,
type a job number.
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To Do this
c. Modify the other properties of the production

control job according to your needs.

Note that you can also modify the properties
later.

d. Click Save.

e. To create the production control job, click Yes
in the confirmation dialog box.

The Production Control Job Edit dialog box
closes.

f. Select the new production control job in the
list.

4. If you want to use the item number as the piece mark in the production
control job, select the Use Item # as Piece Mark check box at the bottom
of the dialog box.

5. Click OK. 

The Estimating Import Filters dialog box opens.

6. To only load specific types of items, in the Estimating Import Filters
dialog box, select a filter type in the Type list, and click Select.

7. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the items that you want to load to the
Included list.

• Type the maximum and minimum values for items that you want to
load.

8. Click OK. 

To further limit the items to be loaded, repeat steps 6 to 9 for the
necessary filter types.

9. Click Import.

The material is loaded into the selected production control job. After the
process is finished, click OK to close the Import Items dialog box.

Load selected items into a production control job

1. In the Estimating dialog box, elect the items that you want to load to a
production control job. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Estimating ribbon tab.
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3. On the menu, select Load Selected Material Into Production Control.

4. In the Select Production Control Job dialog box, do one of the following: 

To Do this
Load the items to an
existing production
control job

• Select the production job in the list.

Load the items to a new
production control job

a. Click Add.

b. In the Production Control Job Edit dialog box,
type a job number.

c. Modify the other properties of the production
control job according to your needs.

Note that you can also modify the properties
later.

d. Click Save.

e. To create the production control job, click Yes
in the confirmation dialog box.

f. Select the production job in the list.

5. If you want to use the item number as the piece mark in the production
control job, select the Use Item # as Piece Mark check box at the bottom
of the dialog box.

6. Click OK.

The material is loaded into the selected production control job. After the
process is finished, click OK to close the Import Items dialog box.

6.4 Import files to and export files from the Estimating
module
Use the import commands to import useful files to the Estimating module.
The compatible file types contain IFC files, CIS2 files, KISS files, Bluebeam files,
and Microsoft Excel worksheets. You can also export an estimating job to the
KISS format to save a copy of it before making any changes due to pricing
changes or revisions, or export labor database information to view the
currently set labor times.

See also

Import files to the Estimating module (page 431)

Export an estimating job to KISS (page 432)

Export labor information (page 432)
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Import files to the Estimating module
You can import several file types into the Estimating module. You can import
IFC files, KISS files, Bluebeam files, and Microsoft Excel worksheets.

1. Click the File ribbon tab in the upper-left corner of the Tekla EPM window.

2. On the File menu, select Import.

3. In the navigation tree of the Import dialog box, click the desired import
option under Estimating. 

4. To select the file that you want to import, click the ... button in the upper-
right corner of the dialog box.

5. Browse to find the file, and click Open. 

Note that you can click the Test Import button to test importing a KISS
file before actually importing it. This way, you can ensure that all
information will be imported successfully.

6. Click Import. 

What happens next depends on the type of file that you are importing. For
example, when you are importing an Microsoft Excel worksheet, the
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Import Field Map dialog box asks you to connect the Microsoft Excel
columns with the Tekla EPM standard fields.

Note that you should only save your field mapping selections if you are
absolutely sure that you will continue to use the same mapping. This is
because the Import Field Map dialog box may not open in the future
when you import new files that match the previously saved mapping.

After you have done so, the import continues.

Once the import is completed, a message appears at the bottom of the
Import dialog box.

7. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Export an estimating job to KISS (page 432)

Export an estimating job to KISS
Exporting an estimating job to KISS allows you to archive a copy of the
estimating job.

1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select Export to KISS.

3. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla EPM saves the file to the Export folder.

4. If necessary, change the file name.

5. Click Save.

A copy of the file is saved in the KISS format.

See also

Import files to the Estimating module (page 431)

Export labor information
Use the Export Labor command to create a text file with the values set in a
labor database. Exporting labor information allows you to view the currently
set labor times.

1. Click the File ribbon tab in the upper-left corner of the Tekla EPM window.

2. On the File menu, select Export Labor.
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3. If you have created multiple labor databases, in the Shop Setup dialog
box, select the shop whose labor information you want to export.

4. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla EPM saves the file to the Export folder.

5. If necessary, change the file name.

6. Click Save.

The labor database information is converted to a text file and saved in the
selected location.

If necessary, you can import the labor information to a different Tekla EPM
database.

See also

Import labor information to Tekla EPM (page 433)

Import labor information to Tekla EPM
To import labor information from a text file to Tekla EPM, do the following:

1. Click the File ribbon tab in the upper-left corner of the Tekla EPM window.

2. On the File menu, select Import.

3. In the navigation tree on the left side of the Import dialog box, select
Labor --> ASCII . 
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4. Click the ... button.

5. In the Open dialog box, browse to find the text file that you want to
import.

6. Select the file and click Open.

7. Click Import.

8. If you have created multiple labor databases, in the Select Shop Setup
dialog box, select the labor database to which you want to import the
labor information.

9. Click OK.

10. In the confirmation dialog box, do one of the following:

• To confirm deleting the current labor information and replacing it
entirely with the imported information, click Yes.

• To only replace the information included in the imported file, click No.

Use this option to import text files that only contain part of the labor
information.
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11. In the Import dialog box, view the status of the import process. 

If necessary, you can view the import details and errors in a text file by
clicking the Open Import Log button.

12. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Export labor information (page 432)

6.5 Use Trimble Connect with an estimating job
You can view the estimating job information in IFC models using Trimble
Connect. You can interact with the model in several ways. For example, you
can color-code items in IFC models, or select the same items simultaneously in
an IFC model and in the estimating job.

We recommend that you start the estimating job by importing an IFC file from
Tekla Structures. The IFC file includes GUIDs, unique identifiers that match the
identifiers in the IFC model. The necessary IFC settings for Tekla Structures can
be downloaded from Tekla Warehouse.

Before you can view the job information in Trimble Connect, your Tekla EPM
administrator needs to set up the Trimble Connect integration settings.

See also

Link an estimating job to Trimble Connect (page 435)

Color-code estimating items in the IFC model (page 437)

Select the same items in the estimating job and in the IFC model (page 438)

Visualize jobs with Trimble Connect Organizer and Trimble Connect Content
Browser (page 815)

Link an estimating job to Trimble Connect
Before you can view the estimating job information in Trimble Connect for
Windows, you need to link the job to a Trimble Connect project. You can either
link the job to an existing project or create a new project.

Note that if an estimating job is linked to a project management job, the
Trimble Connect project is managed through the project management job. In
this case, you need to link the project management job to Trimble Connect.
The link is then applied to any linked estimating jobs. The Trimble Connect
project cannot be modified when you access it through the estimating job.

1. In the Estimating dialog box, right-click anywhere in the display area.
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2. In the context menu, click Model Interface. 

A message appears, telling you that the current job is not linked to a
Trimble Connect project.

3. Click OK to close the message. 

4. In the Link Project to Trimble Connect dialog box, do one of the
following: 

To Do this
Link the job to an
existing Trimble Connect
project

a. To display the available Trimble Connect
projects, click Sync Projects.

b. Select the desired project, and click Link
Project.

Create a new Trimble
Connect project and link
the job to it

a. Click Add Project to Trimble Connect.

b. In the Add Users to Project dialog box, click
the arrow buttons to move the users that
participate in the project to the Included list.

c. Click OK.

Tekla EPM creates a Trimble Connect project
with the same name and information as the
current job.
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To Do this
d. In the Status dialog box, review the creation

process of the Trimble Connect project.

A message appears, telling you that the project
has been created successfully.

e. Click OK to close the message.

f. In Trimble Connect for Windows, press the
Back button to exit the empty 3D view.

g. In the Explorer side pane on the left, click the
Add File button.

h. In the Add Files dialog box, browse to find the
IFC model.

i. Select the IFC model and click Open.

The IFC model is imported to Trimble Connect for
Windows.

The estimating job and the Trimble Connect project are now linked.

Unlink an estimating job from Trimble Connect
1. In the Select Estimating Job dialog box, select the job that you want to

unlink.

2. At the bottom of the dialog box, click Edit.

3. In the Estimate Job Edit dialog box, click Link on the right side of the
Trimble Connect Project field.

4. In the Link Project to Trimble Connect dialog box, click Unlink project.

5. To close the dialog box, click the Close button (X) in the upper-right
corner.

6. In the Estimate Job Edit dialog box, click Save.

Color-code estimating items in the IFC model
To color-code items in the IFC model according to their properties, use the
Colorize command in the Model Viewer Interface dialog box. For example,
you can color-code items according to their category or finish. You can also set
filters to only color-code particular items in the model. By using a filter, for
example, you could first filter the items by their category, and then color-code
the items in that category by their finish.

1. In the Estimating dialog box, right-click anywhere in the display area.

2. In the context menu, click Model Interface.
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3. If necessary, in the Model Viewer Interface dialog box, filter the items
that you want to color-code:

a. Click Set Filters.

b. In the Estimating Filters dialog box, select a filter type in the Type
list, and click Select.

c. In the Filter dialog box, do one of the following depending on the
filter type: 

• Click the arrow buttons to move the items that you want to display
in the model to the Included list.

• Type the maximum and minimum values for the items that you
want to display in the model.

d. Click OK. 

Repeat steps b to d for all filter types that you want to set.

e. Click Apply Filter.

4. Click the arrow on the right side of the Colorize By list and select a
property in the list.

5. Click Colorize.

The items in the IFC model are color-coded according to the selected property.

To revert to the original colors in the IFC model, click Reset in the Model
Viewer Interface dialog box.

See also

Select the same items in the estimating job and in the IFC model (page 438)

Select the same items in the estimating job and in the IFC
model
When you have linked an estimating control job to Trimble Connect, you can
select an item that is selected in one of the software simultaneously in the
other one. Do the following:

1. In the Estimating dialog box, right-click anywhere in the display area.

2. In the context menu, do one of the following:

• To select the item that is selected in the estimating job also in the IFC
model, select Select in Model.

• To select the item that is selected in the IFC model also in the
estimating job, select Select from Model.

See also

Color-code estimating items in the IFC model (page 437)
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6.6 Combine materials in the Estimating module
Use the Combine command to mult and nest materials in the Estimating
dialog box. You can then save and review the combining results.

1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select Combine. 

The Select Combining Run dialog box opens. When you are performing
the first combining run for a combining job, the list in the dialog box is
empty.

3. Click a desired combining option to select it. 

The options are:

• Mult: combines linear items, like beams and angles.

• Nest: combines items that have area, like plates or gratings.

• Mult & Nest: combines all items.

The Combining Run Filters dialog box opens.

NOTE Filtering items is optional, so you can skip steps 4 to 7 if you do
not want to filter out items from the combining run.

4. To only combine specific types of materials, select a filter type in the Type
list, and click Select.

5. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the items that you want to combine to
the Included list.

• Type the maximum and minimum values for the items that you want
to combine.

6. Click OK.

7. To ensure that you are using the correct settings, click the Optimizations,
INV Filter, and Suppliers buttons. 

If necessary, you can modify the settings.

8. To combine the materials, click the button at the bottom of the
Combining Run Filters dialog box, or press F4.

• Piece mark items included with the selected stock lengths are displayed at
the lower-left section of the dialog box.

• Combining results are shown in both the display area and in the summary
grid at the lower-right section of the dialog box.

Create estimates 439 Combine materials in the Estimating module



• The material cost represents the pricing of the materials in the pricing
database that was used in the combining run.

To save the combining run for comparing it with another one, you can click
Save Combining Run at the bottom of the Combining Run Results dialog
box.

See also

Rename a combining run (page 253)

Compare combining runs (page 261)

View combining run filter settings (page 253)

Modify run-specific pricing information (page 254)

Recombine all items (page 258)

Recombine items of a shape (page 258)

Recombine items of a material grade (page 259)

Recombine a material dimension (page 260)

Update combining information and recombine all items (page 260)

Export materials for combining (page 78)

6.7 Create a proposal
Once you are happy with the estimate, you can create a proposal out of it.
Proposals are estimating bid letters whose setups you can modify according to
your needs. You can then save the proposals on your computer as Microsoft
Word documents, and print or send them to your client. After creating the first
proposal, you can also create revisions according to your client's needs.

The standard proposal setup is set in the Proposal Setups dialog box that you
can access via Maintenance --> Estimating --> Proposal Setups .

1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select Proposal. 

The Estimating Proposals dialog box opens. Here, you can create new
proposals, modify existing proposals, or delete unnecessary proposals.

3. To create a new proposal, click New.

4. Type a revision number and a title for the proposal. 

NOTE Steps 5 to 10 only apply when you are creating a first proposal
based on the estimating. When you create revisions, you can skip
these steps.
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5. In the available lists, select the date of the proposal, the firm type of the
recipient company, and the recipient company. 

You can only select recipient companies that have already been added to
the Address Book.

6. Click Add.

7. In the Select Sections dialog box, click the arrow buttons to move the
sections that you want to include in the proposal to the Included list.

8. Click OK. 

A dialog box appears, asking you to select which text items you want to
include in a section of the proposal.

9. Click the arrow buttons to move the items that you want to include in the
proposal to the Included list..

10. Click OK. 

Repeat steps 9 to 10 for all sections that you included.

The Estimating Proposal Setups dialog box opens.

11. In the Estimating Proposal Setups, do any of the following according to
your needs: 

To Do this
Display the price and
weight of the project in
the proposal

a. On the Main Setups tab, select the Show Price
and Show Weight check boxes.

b. Type the price and weight in the fields on the
right side of the check boxes.
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To Do this
Modify the appearance
of the proposal

a. On the Main Setups tab, click Open Template.

The proposal template opens in Microsoft
Word. The items marked with << >> pull
information from Tekla EPM and can be
adjusted there, but the other information and
font types can be changed in Microsoft Word.

b. Make the necessary changes to the template.

c. In the Microsoft Word window, click File -->
Save .

d. Save the modified proposal as a custom report
in the default folder that your company uses for
custom reports.

You can verify the default folder by opening the
File menu and selecting Default Directories.

Add a new entry a. Go to the section tab on which you want to add
the new entry.

b. At the bottom of the dialog box, click New.

c. Type the desired text in the space the bottom of
the dialog box.

d. Click Add.
Modify an entry a. Go to the section tab on which you want to

modify an entry.

b. Select the entry that you want to modify.

c. Change the entry text according to your needs.

d. Click Edit to save the changes.
Move an entry up or
down in the proposal

a. Go to the section tab on which the desired entry
is located.

b. Select the entry that you want to move.

c. To move the entry, click the Move Up and Move
Down buttons at the bottom of the dialog box.

Change the indentation
of an entry

a. Go to the section on which the desired entry is
located.

b. Select the entry that you want to move.

c. Click the Move Left and Move Right buttons to
shift the position of the item in the proposal.

Delete an entry a. Go to the section tab from which you want to
delete an entry.

b. Select the entry that you want to delete.

Create estimates 442 Create a proposal



To Do this
c. Click Delete.

d. To permanently delete the entry, click Yes in the
confirmation dialog box.

Change the titles or
headings of the
proposal

a. Go to the section tab whose titles or headings
you want to change.

b. Do any of the following:

• To change the main title of the section, type
a new title in the Title field and click Set
Title.

• To change the style of the headings, click
Attributes and select appropriate styles in
the lists. Then, click Save.

• To add a subtitle, click Attributes and type a
title in the Subtitle field. Then, click Save.

The subtitle appears under the title in the
proposal.

Add a section a. At the top of the dialog box, click Add Section.

b. Type a title for the section.

c. Click OK.

The new tab is added at the end of the proposal
setup.

Delete a section a. Go to the section tab that you want to delete.

b. At the top of the dialog box, click Delete
Section.

c. To permanently delete the section, click Yes in
the confirmation dialog box.

Move a section forward
or backward in the
proposal

a. Go to the desired section tab.

b. In the upper-right corner of the dialog box, click
Move Forward or Move Backward.

12. Click Save.

13. Click Make Proposal.

14. In the Save As dialog box, browse to the folder where you want to save
the proposal.

15. If necessary, change the file name.

16. Click Save.
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17. To close the dialog box, click the Close button (X) in the upper-right
corner.

We recommend that you save the exported proposals in the estimating
Document Index for future reference. For more information, see Store
document references for an estimating job (page 388).
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7 Set up and manage the
inventory

The Inventory module in Tekla EPM consists of two separate parts: inventory
and inventory history. In Inventory, you can take items from stock, return
them to stock, reserve items for a customer order, and so on. In Inventory
History, you can view the entire history of items in the inventory.

Any item in Tekla EPM becomes an inventory item when it is loaded into a
purchase order. Note that you cannot modify the properties of these types of
items as long as the items have not yet been received.

For more information, see the following links:

Define the default inventory settings (page 446)

Open the Inventory module (page 449)

Open Inventory History (page 454)

Add an item to the inventory (page 461)

Copy an inventory item (page 468)

Modify inventory items (page 469)

Take material from stock and return material to stock (page 472)

Move an item to another inventory location (page 474)

Delete inventory items (page 477)

Add, modify, and delete stock quantities to be maintained (page 479)

Store document references for the inventory (page 455)

Add inventory items to Order Entry (page 475)

Combine inventory items manually (page 477)

View inventory details (page 482)

Import and export inventory information (page 496)
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7.1 Define the default inventory settings
Before you start using the Inventory module for making orders, taking
material from stock, and so on, we recommend that you define default
settings for the Inventory module. Define the company standard settings and
the countries of origin, adjust the visible input and display fields of both
Inventory and Inventory History, and customize the drop-down menu
commands in the Inventory module.

For more information, see the following links:

Define company standard settings for Inventory (page 446)

Define the countries of origin (page 448)

Define company standard settings for Inventory
In the Inventory Company Standards dialog box, define the default settings
for the Inventory module.

1. Click the Maintenance ribbon tab.

2. On the menu, select Inventory --> Company Standards .

3. In the Inventory Company Standards dialog box, set the following
properties according to your needs: 

Option Description
Auto-Calc Part # When selected, Tekla EPM automatically enters a

part number for each item when new material is
received. When cleared, you need to enter the part
number manually.

Part # Format The part number format.

To change the part number format, click the arrow
on the right side of the Part # Format field, and
select an option in the list.

The options are:

• [PO#]-[Item#]-[Receive Count]-[RTS Count]:

The part number consists of the purchase order
number, purchase order item number, receive
count, and return to stock count.

Note that the receive count number does not
refer to the quantity received, but the
occurrence of receiving the material. The
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Option Description
returned to stock count number indicates how
many times the material has been cut.

For example, if the purchase order number was
123, the item number 50, quantity 5, and 2 are
received, the part number would be 123-50-1-0.
When the remaining 3 pieces were received, the
part number would be 123-50-2-0. If the length
of the material was 40’-0 and you took 25’-0 and
returned 15’-0 to inventory, the part number
would be 123-50-1-1.

• Sequential, Increments each receipt:

The part numbering starts from 00001, and
each time an item is received on a purchase
order, the item is assigned an incremented part
number (for example, 00002).

• Sequential, Increments each receipt, with
RTS count:

The part number consists of a sequential
number and the returned to stock count.

The part numbering starts from 00001, and
each time an item is received on a purchase
order, the item is assigned an incremented part
number (for example, 00002). The returned to
stock count indicates how many times the
material has been cut.

An example part number could be 00003-1.
Inventory History -
Default number of
days to view (0 for all)

Allows you to set a filter that defines the number
of days that items remain visible in the Inventory
History dialog box.

Note that you can clear the filter in the Inventory
History dialog box to display all items in the
inventory history again.

Enter a number in the field. To always display all
items in the Inventory History dialog box, enter 0.

Transaction History -
New Method

When selected, the Transaction History opens
more quickly.

We recommend that you do not clear the
Transaction History - New Method check box.

4. To adjust the units used in the Inventory module, click Input/Display
Units.
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5. In the Input/Display Units dialog box, select the units and the length
input types in the available lists. 

Note that there are multiple options depending on the required precision
and the desired input method.

6. Click OK.

7. At the bottom of the Inventory Company Standards dialog box, click
Save.

The default settings of the Inventory module are updated.

Define the countries of origin
In the Countries dialog box, you can add new countries of origin for items in
the inventory. If necessary, modify or delete any existing countries to match
the countries used by your company.

1. Click the Maintenance ribbon tab.

2. On the menu, select Inventory --> Countries of Origin .

3. In the Countries dialog box, do any of the following according to your
needs: 

To Do this
Add a new country a. Click New.

b. Type the country and an abbreviation for it.

Only the abbreviation will be shown when you
set a country of origin for an item in the
Inventory dialog box.

c. Click Add.

The new country is now available in the Inventory
dialog box.

Modify an existing
country

a. Select the country that you want to modify.

b. Modify the country and its abbreviation.

c. Click Edit to save the changes.
Delete a country a. Select the country that you want to delete.

b. Click Delete.

c. In the confirmation dialog box, click Yes to
permanently delete country.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.
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7.2 Open the Inventory module
To access the Inventory module, do the following:

• In the Tekla EPM dialog box, click the Inventory icon.

The Inventory dialog box opens. See the elements of the dialog box in the
following image:

(1) The summary grid shows the quantities, weights, and valuations of items in
stock and on order.

(2) The navigation trees on the left to select which items you want to view. The
upper navigation tree allows you to only view selected shapes, whereas the
lower navigation tree allows you to only view items in a selected job or
inventory location.

You can click + to expand the list. Then, click the items that you want to view in
the display area.

For detailed instructions, see View only particular material dimensions, jobs, or
locations in the Inventory dialog box (page 451).

(3) The display area lists all material items in the inventory.

(4) The leftmost unnamed column shows the statuses of different material
items. The status indicators consist of the following abbreviations:

• PO: Items are on a purchase order
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• O: Items are on order (not yet received)

• R: Items are reserved for a job

• C: Items have been combined

For example, items labeled PO-O-R-C have been combined and are on a
purchase order, have been reserved for a job, and have not yet been received.

Items without any status indicator in this column are open stock items and
were entered manually.

(5) Zero quantity items are placeholders for items that have been received on
a purchase order, but have not been finalized yet. Zero quantity items cannot
be modified in the inventory, and the combining details table below the input
area does not display any information about whether items are properly
linked to production control jobs.

Using zero quantity items in the inventory allows Tekla EPM to properly modify
the base pricing if the pricing in the purchase order is modified after the
materials have been received and split into different line items.

You can hide the zero quantity items by creating and saving a filter that
excludes these items. This way, you will not mistake them for additional
material items in the inventory. For more information, see Filter information in
the Inventory dialog box (page 452).

(6) The input area allows you to add information for existing or new items. It
also displays the properties of an item selected in the display area.

Note that properties of items that are on a purchase order or that are
placeholders with zero quantity cannot be modified, so the input fields
become inactive if you select them in the display area.

You can modify the available fields in the Edit Input Fields dialog box.

(7) The combining details table shows the parts to be cut from the item
selected in the display area.

Note that under the combining details table, you can see if the items that are
combined to the selected inventory item are properly linked to a production
control job.

See also

View only particular material dimensions, jobs, or locations in the Inventory
dialog box (page 451)

Filter information in the Inventory dialog box (page 452)

Search for items in the Inventory dialog box (page 453)

Add an item to the inventory (page 461)

Modify inventory items (page 469)

Take material from stock and return material to stock (page 472)

Delete inventory items (page 477)

Set up and manage the inventory 450 Open the Inventory module



View only particular material dimensions, jobs, or locations
in the Inventory dialog box
Use the navigation trees on the left side of the Inventory dialog box to only
view particular material dimensions, items reserved for specific jobs, and
items in specific inventory locations.

• In the Inventory dialog box, do any of the following: 

To Do this
View items of the
selected shape, grade,
and material dimension

1. In the upper navigation tree, click + to show all
shapes in the estimating job.

2. In the upper navigation tree, click a shape
indicator.

3. Optionally, select a material grade and
dimension as well.

Only items of the selected shape, grade, and
material dimension are shown in the display area.

View items of all shapes • Click All Items at the top of the upper
navigation tree.

View items reserved for
a particular job

1. In the lower navigation tree, click + to show all
jobs.

2. Click to select a job number.

Only items reserved for that job number are
shown in the display area.

View all open stock
items

1. In the lower navigation tree, click + on the left
side of All Jobs to show all jobs.

2. Click the blank branch directly under All Jobs.

Only items that are not received for any job are
shown in the display area.

View items in all jobs • In the lower navigation tree, click All Jobs.
View items in a specific
inventory location

1. In the lower navigation tree, click + on the left
side of All Locations to show all jobs.

2. Click the location.

Only items in that inventory location are shown in
the display area.

View items without
inventory location

1. In the lower navigation tree, click + on the left
side of All Locations to show all jobs.

Set up and manage the inventory 451 Open the Inventory module



To Do this
2. Click the blank branch directly under All

Locations.

Only items that have not been assigned an
inventory location are shown in the display area.

View items in all
locations

• In the lower navigation tree, click All Locations.

The current selections in the navigation trees are shown above the navigation
trees.

Note that the navigation trees also work together, so that you can also limit
the displayed information also by selecting items in both navigation trees. For
example, you can view items of a specific dimension in a specific job or
inventory location.

See also

Filter information in the Inventory dialog box (page 452)

Search for items in the Inventory dialog box (page 453)

Filter information in the Inventory dialog box
Use the Filter command to only show the desired items in the Inventory
dialog box. Filters can be handy for viewing specific inventory materials. You
can reset the applied filters at any time by clicking Clear Filters at the upper-
left corner of the dialog box, so that all items are displayed again.

Note that using filters only affects the way you see the Inventory dialog box,
so you cannot accidentally change other users' settings.

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Filter. 

The Inventory Filters dialog box opens.

3. To filter the displayed items according to selected criteria, select a filter
type in the Type list, and click Select. 

For some filter types, such as location, reference number, or heat
number, you can also click Find and type the desired value in the blank
field to use it. This way, you do not have to scroll through all the available
items.

4. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the items that you want to display to
the Included list..
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• Type the maximum and minimum values for the items that you want
to display.

5.

6. Click OK. 

If you want to further filter the information displayed in the Inventory
dialog box, repeat steps 3 to 5 for different items.

If you want to clear all filter settings, click Reset.

7. To save commonly used filters, do the following:

a. Click Filter Types in the lower-left corner.

b. Click New.

c. Type a description for the filter type.

d. Create the filter settings. 

For more information, see steps 3 to 5.

e. Click Add.

f. To close the dialog box, click the Close button (X) in the upper-right
corner. 

The newly created filter type is selected in the Filter Types list.

g. To apply the filter type, click Set.

8. According to your needs, do one of the following:

• To use the filter, click Apply Filter.

• To use the filter in the job and save it until a new filter is set or the
filter is cleared, click Apply Filter & Save.

Note that the filter will remain in use even if you close and re-open the
job. After you clear the filters, the filter settings cannot be used again.

The Estimating Filters dialog box closes, and the Inventory dialog box is
filtered according to the settings you made.

To display all information in the Inventory dialog box again, click Clear Filters
in the upper-left corner.

Search for items in the Inventory dialog box
Use the different Find commands in the Inventory dialog box to quickly find
the needed material items. You can search for items by material shape, grade,
or size, heat number, or serial number.
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Search for items by material shape, grade, or size
1. At the top of the Inventory dialog box, click Find Shape/Grade/Size, or

press Ctrl+F5.

2. Select the material shape, and optionally grade and dimensions in the
appropriate lists. 

You can also type the shape, grade, and dimensions in the appropriate
fields.

3. Do any of the following:

• To find items with the selected material shape, click Find Shape.

• To find items with the selected material shape and grade, click Find
Grade.

• To find items with the selected material shape and dimensions, click
Find Size.

Only items that match your search are displayed in the Inventory dialog box.
The selected material shape, grade, and dimensions are shown above the
navigation trees on the left side of the dialog box.

To view all items again, click All Items in the upper navigation tree.

Search for an item by heat number
1. At the top of the Inventory dialog box, click Find Heat #.

2. Select the heat number in the list, or type it in the field.

3. Click Find Heat #.

The item with the selected heat number is selected the Inventory dialog box.

Search for an item by serial number
1. At the top of the Inventory dialog box, click Find Serial #.

2. Select the serial number in the list, or type it in the field.

3. Click Find Serial #.

The item with the selected serial number is selected the Inventory dialog box.

Open Inventory History
In the Inventory History dialog box, you can view all material that has been
taken from stock for a job.

1. While in the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Inventory History. 
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TIP If you hold down Shift when selecting the Inventory History
command, the Inventory History opens in a new dialog box. This
way, you can view the inventory and the inventory history at the
same time.

The Inventory History dialog box opens.

TIP Use the navigation trees on the left of the dialog box to filter which items
are visible. For example, to only show items in a specific job, click a job
number in the lower navigation tree.

To return to the Inventory dialog box, do the following:

1. Click the Inventory ribbon tab.

2. On the menu, select Inventory.

7.3 Store document references for the inventory
Document Index is where you can store documents for reference. When you
store documents in Document Index, each user that has access to inventory
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can view them, so it is easy to keep up-to-date. You can save all heat
documents, as well as Microsoft Outlook emails and their attachments, in
Document Index.

To access Document Index in the Inventory module, do the following:

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Document Index.

The Document Index - By Category dialog box opens. Next, you can either
modify the available folders for document references, or add, modify, delete,
open, and email document reference files.

See also

Manage document reference categories (page 389)

Add document references to the inventory (page 456)

Open a document reference (page 394)

Modify a document reference (page 395)

Attach a document reference to an email (page 396)

Delete a document reference (page 396)

Add document references to the inventory
You can either upload completely new document references, such as files,
emails, and email attachments to Document Index, or add files that are
already loaded to Document Index to the list of inventory document
references.

Add new files
1. In the navigation tree of the Document Index - By Category dialog box,

select the category where you want to save the document.

2. Click Add Document Reference.

3. In the Document Index - Add Document Reference dialog box, click Add
File.

4. In the Open dialog box, browse to find the document that you want to
add, and select the document.

5. Click Open. 

If you want to add more documents with the same settings, click Add
Additional File and repeat steps 4 to 6 for each document.
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6. In the Add File dialog box, select the company and contact that provided
you with the document in the File Source lists. 

You can also drag and drop files to the Add File dialog box.

7. According to your needs, do one of the following:

• To compress multiple documents into one archive, select the
Compress Files into a Single Archive option.

• To leave the documents that you added uncompressed, select the
Leave Files Uncompressed option.

8. According to your needs, do one of the following:

• To move the original document to the selected folder, select the Move
File option.

• To copy the document to the selected folder but leave the original
untouched, select the Copy File (Leave Original) option.

9. Type a description for the attached document.

10. Click Add File.

11. For heat documents, select the supplier, purchase order number, and
heat number in the available lists, or type new values in the fields. 

If you are adding a heat document for an item, note that the heat number
of the document reference must match the heat number of the item,
entered in the Inventory dialog box.

12. Type a description for the entire document reference. 

This description applies to all documents, emails, and email attachments
that you add.

13. When you have added all necessary documents, emails and email
attachments, click Add Document Reference.

The Document Index - Add Document Reference closes, and the documents
are added to Document Index. You can see all added documents in the list in
the Document Index - By Category dialog box.

Add a Microsoft Outlook email
1. In Microsoft Outlook, select the email that you want to add.

2. In the navigation tree of the Document Index - By Category dialog box,
select the category where you want to save the email.

3. Click Add Document Reference.

4. In the Document Index - Add Document Reference dialog box, click Add
Outlook Email. 

A copy of the email is added to Document Index.

The text of the email is added to the Description field.
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5. Click Add File.

6. Type a description for the entire document reference. 

This description applies to all documents, emails, and email attachments
that you add.

7. When you have added all necessary documents, emails and email
attachments, click Add Document Reference.

The Document Index - Add Document Reference closes, and the emails are
added to Document Index.

Add an attachment from a Microsoft Outlook email
1. In Microsoft Outlook, select the email with the attachment that you want

to add.

2. In the navigation tree of the Document Index - By Category dialog box,
select the category where you want to save the attachment.

3. Click Add Document Reference.

4. In the Document Index - Add Document Reference dialog box, click Add
Outlook Attachments.

5. Browse to the folder where you want to save the email attachment, and
click the folder to select it.

6. Click Open.

7. In the Add File dialog box, select the company and contact that provided
you with the document in the File Source lists.

8. According to your needs, do one of the following:

• To compress multiple documents into one archive, select the
Compress Files into a Single Archive option.

• To leave the documents that you added uncompressed, select the
Leave Files Uncompressed option.

9. Type a description for the email attachment.

10. Click Add File.

11. Select the supplier, purchase order number, and heat number in the
available lists, or type new values in the fields. 

If you are adding a heat document for an item, note that the heat number
of the document reference must match the heat number of the item
entered in the Inventory dialog box.

12. Type a description for the entire document reference. 

This description applies to all documents, emails, and email attachments
that you add.
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13. When you have added all necessary documents, emails and email
attachments, click Add Document Reference.

The Document Index - Add Document Reference closes, and the email
attachments are added to Document Index.

Search for and add a file already in Document Index
To find and add files that already exist in the document index directory to the
inventory side of Document Index, use the Search command.

1. In the navigation tree of the Document Index - By Category dialog box,
select the category where you want to save the file.

2. Click Add Document Reference.

3. In the Document Index - Add Document Reference dialog box, click
Search.

4. In the Search dialog box, click Browse and select the folder where you
want to look for documents. 

TIP To also search from the sub-folders of the selected folder, select the
Sub-Directories check box.

5. To narrow the search, do one or more of the following:

• Type the document name, document size, and file name extension.

• In File Date, select the dates between which the document has been
created or downloaded onto your computer.

• In Date Loaded, select the dates between which the document has
been added to Document Index.

• In the Source lists, select the contact and company that have provided
the document.

6. To include archived documents in the search, select the Include All
Archive Files check box.

7. Click Search. 

The search results appear at the top of the Search dialog box.

8. In the search results, double-click the document that you want to add.

9. Select the supplier, purchase order number, and heat number in the
available lists, or type new values in the fields. 

If you are adding a heat document for an item, note that the heat number
of the document reference must match the heat number of the item,
entered in the Inventory dialog box.
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10. Type a description for the entire document reference. 

This description applies to all documents, emails, and email attachments
that you add.

11. When you have added all necessary documents, emails and email
attachments, click Add Document Reference.

The file is added to the list of inventory documents in Document Index.

Browse for and add a file already in Document Index
To browse for and add files that already exist in the document index directory
to the inventory side of Document Index, use the Find By Directory
command. You can also add new files, delete existing files, rename folders and
files, move files to other folders, and open files.

1. In the navigation tree of the Document Index - By Category dialog box,
select the category where you want to save the file.

2. Click Add Document Reference.

3. In the Document Index - Add Document Reference dialog box, click
Find By Directory.

4. In the navigation tree on the left of the Document Index - By Directory
dialog box, select a category. 

If you want to rename the selected category, you can click Rename
Directory, type a new name, and click OK.

The documents within the category are listed in the display area of the
dialog box.

5. Select a document.

6. In the lower-right corner, click Select. 

Note that besides adding an existing document to the current job, you can
also use the buttons at the bottom of the dialog box to:

• Add new documents (Add File).

• Delete a document (Delete File).

• Move a document to another folder within the document index folder
(Move File).

• Rename a document (Rename File).

• Open a document (Open File).

7. Select the supplier, purchase order number, and heat number in the
available lists, or type new values in the fields. 

If you are adding a heat document for an item, note that the heat number
of the document reference must match the heat number of the item,
entered in the Inventory dialog box.
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8. Type a description for the entire document reference. 

This description applies to all documents, emails, and email attachments
that you add.

9. When you have added all necessary documents, emails and email
attachments, click Add Document Reference.

The file is added to the list of inventory documents in Document Index.

7.4 Manage inventory items
You can manage inventory items in multiple ways. After adding the necessary
inventory items, you can copy and modify the items according to your needs.
You can also take material from stocks and return the remaining material to
stock, reserve or send inventory items to customer orders, combine inventory
items, or delete unnecessary inventory items.

For more information, see the following links:

Add an item to the inventory (page 461)

Copy an inventory item (page 468)

Modify inventory items (page 469)

Take material from stock and return material to stock (page 472)

Add inventory items to Order Entry (page 475)

Combine inventory items manually (page 477)

Delete inventory items (page 477)

Add an item to the inventory
To add new items manually to the inventory, do the following:

1. In the Inventory dialog box, click New.

2. Modify the item properties according to your needs: 

The properties marked with an asterisk (*) in the following table are
mandatory information.

Option Description
Original Date * The date on which the item has

originally been added to inventory.

Click the arrow on the right side of
the Original Date field and select a
date in the calendar.
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Option Description
Quantity * The number of pieces to be added.

Use the numeric keypad in the
quantity field to add, multiply, divide,
or subtract numbers to adjust the
quantity.

Shape * The material shape of each piece.

Either click the arrow on the right side
of the Shape field to select the shape,
or type the shape indicator in the field
(for example, HSS).

Grade The material grade of each piece.

Depending on the shape, the grade
can also be mandatory information.

Either click the arrow on the right side
of the Grade list to select the grade,
or type the grade indicator in the
field.

Dimensions The material dimension, or material
size, of each piece.

Depending on the shape, the
dimension can also be mandatory
information.

Click the Dimensions field to select
an available material dimension, and
double-click the desired dimension in
the list.

TIP You can also use a custom
material dimension. Note that
the dimension is not
automatically added to the
material database.

To use a custom dimension, do
the following:

a. Click in the Dimensions
field.

b. Click Add Size.

c. Define the dimension
properties.
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Option Description

d. Click Save.

You can now select the
dimension and use it.

Length The length of each piece.

Default length input settings are set in
Company Standards, but you can
modify them for each job.

Base Price The base price of the material item.
We recommend that you use base
prices to create more detailed
reports.

Type the base price in the Base Price
field.

To change the base price units and
convert the current price to the
selected units, right-click the Base
Price field, and select an appropriate
option in the context menu.

On Order When selected, the material item is
on order and has not yet been
received. When cleared, the material
item is marked as received.

Items that are on order are marked
with an O in the leftmost column of
the Inventory dialog box.

Job No. Any job number. For example, you
can use the Job No. field to reserve
material for the shop or maintenance,
so that it cannot be used elsewhere.

Type any desired information in the
Job No. field.

Location The inventory location of the material
item.

Click the arrow on the right side of
the Location field and select a
location in the list, or type a new
location in the Location field.
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Option Description
Secondary Loc The secondary inventory location of

the material item.

Click the arrow on the right side of
the Secondary Loc field and select a
location in the list, or type a new
secondary location in the Secondary
Loc field.

For example, you can use secondary
locations to represent the inventory
sites or the date the location was
verified.

You can also use the Secondary Loc
field to provide a temporary location
for storing some pieces of a material
item. This way, you can split the
quantity of the material item without
affecting the location.

Stock Any stock information about the item.

Type any information in the Stock
field.

NOTE Use the Stock/Reorder
command to set stock
quantities to be maintained.
See Add, modify, and delete
stock quantities to be
maintained (page 479).

Reorder Any reordering information about the
item.

Type any information in the Reorder
field.

NOTE Use the Stock/Reorder
command to set stock
quantities to be maintained.
See Add, modify, and delete
stock quantities to be
maintained (page 479).
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Option Description
Heat # The heat number of the material

item.

Type the heat number in the Heat #
field.

Note that you need to type a heat
number for a material item before
attaching documents to it in
Document Index.

P.O. # The number of the purchase order
that contains the material item.

Type the purchase order number in
the P.O. # field.

Note that you need to type a
purchase order number for a material
item before attaching documents to it
in Document Index.

B/L # The bill of lading number or the
shipment number that the material
item was received on.

Type the number in the B/L # field.
Supplier The supplier of the material item.

Either type a supplier in the Supplier
field, or click the arrow on the right
side of the Supplier field and click the
supplier that you want to select.

Note that you need to type a supplier
for a material item before attaching
documents to it in Document Index.

Date Delivered The date when the material item has
arrived to inventory.

Do one of the following:

• Type the date in the Date
Delivered field.

The acceptable formats are
YYYY/MM/DD, YY/MM/DD,
MM/DD/YYYY, and MM/DD/YY.

• Click the arrow on the right side of
the Date Delivered field and
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Option Description
select the delivery date in the
calendar.

Note that the Date Delivered field is
only available if the On Order check
box is cleared.

Re Any comments or remarks that you
want to add about the material item.

Type the remarks in the Re field, or
click the arrow on the right side of the
Re field and click an existing
comment in the list to use it.

Reference Number A reference number that links items
in inventory or purchasing to the
production control job.

The reference number can be
different depending on the case:

• If an item is sent from Production
Control to Purchasing or
Inventory, Tekla EPM creates a
copy of the record, and the item is
linked to include the reference
number.

• If an item is sent to purchasing
from an advanced bill of material,
the system mark number or a
combination of the page number
and the item number in the
combining job (for example, 1-30)
becomes the reference number.

• If the item is sent to purchasing
later in the process, the reference
number is the mark or piece mark
number.

However, if the reference number
has been assigned in the
production control job, that
reference number is maintained in
the inventory as well.

We recommend that you do not type
information in the Reference
Number field when adding items to
the inventory manually.
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Option Description
Serial # The serial number of the material

item.

To add a serial number, click the
Serial # button. For more
information, see Define serial
numbers for an inventory item
(page 469).

Part Number The part number of the material item.

Type the part number in the Part
Number field.

To adjust part number settings, see
Define the default inventory settings
(page 446).

Lot # The lot identification assigned to the
material item in Production Control.

We recommend that you do not type
any information in the Lot # field
when you add inventory items
manually.

Note that if you type any information
manually in the Lot # field, the
information will be overwritten if you
combine or link material from
Production Control to the inventory
item.

Sequence The sequence number assigned to
the item in Production Control.

We recommend that you do not type
any information in the Sequence field
when you add inventory items
manually.

Note that if you type any information
manually in the Sequence field, the
information will be overwritten if you
combine or link material from
Production Control to the inventory
item.

Category

Sub-Category

Classes used for sorting items,
assigned to the item in Production
Control. Categories and sub-
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Option Description
categories can be used for filtering
information.

We recommend that you do not type
any information in the Category and
Sub-Category fields when you add
inventory items manually.

Note that if you type any information
manually in the Category or Sub-
Category field, the information will
be overwritten if you combine or link
material from Production Control to
the inventory item.

Country The country of origin of the material
item.

Click the arrow on the right side of
the Country field, and select a
country in the list.

The available countries can be
modified in the Countries dialog box.
For more information, see Define the
countries of origin (page 448).

Heat SN A property that ensures that heat
numbers are not duplicated.
However, duplications are extremely
rare, so using the Heat SN field is
optional.

If necessary, type a value in the Heat
SN field.

3. Click Add.

The new material item is added to the list in the Inventory dialog box.

Copy an inventory item
Copy a material item in the Inventory dialog box and use it as the basis of a
similar item. Then, adjust any properties according to your needs. By copying
items, you can save time and avoid entering the same data multiple times.

1. In the Inventory dialog box, click the material item that you want to copy.

2. At the bottom of the dialog box, click Copy.
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The item is copied and added in the list.

Note that not all values in the leftmost column are copied. For example, PO
indicates that the item has been sent to a purchase order, so it is not used for
new, manually added inventory items.

Modify inventory items
You can either modify items in inventory one by one, or use the different
Global Edit commands to modify multiple items at one go. Note that
inventory items that are on a purchase order or that are placeholders with
zero quantity cannot be modified, so the input fields become inactive if you
select them in the display area.

For more information, see the following links:

Modify multiple inventory items (page 470)

Modify selected inventory items (page 471)

Define serial numbers for an inventory item
You can add serial numbers for a material item in the Inventory dialog box.
Note that you can only add a serial number for items that have been marked
as received, and are not on order.

1. In the Inventory dialog box, click a material item to select it.

2. On the right side of the dialog box, click Serial # under the Reference
Number field.

3. In the Serial Numbers dialog box, do one of the following:

• To assign a different serial number for each piece of the material item,
select the Serialized option.

If you use or plan to use bar codes, do not select the Serialized option.
Using the Serialized option prevents displaying serial numbers in
some reports.

• To use the same serial number for all pieces of the material item,
select the Non-Serialized option.

4. Click Update.

5. Click New to define a new serial number.

6. Enter the serial number in the Serial # field.

7. Click Add. 

Repeat steps 5 to 7 for each serial number that you want to create.

If necessary, you can:

• Modify a serial number, and update it by clicking Save.
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• Delete a serial number by clicking Delete, and then, clicking Yes to
confirm.

8. To close the dialog box, click the Close button (X) in the upper-right
corner.

The serial numbers appear under the Serial # button in the Inventory dialog
box.

Modify a single inventory item
You can modify the properties of a single inventory item directly in the
Inventory dialog box.

Note that if you only want to modify some pieces in an item, you need to split
the item first. You can do so by either moving the desired quantity of pieces to
a different location or secondary location, or changing the reservation of the
quantity.

1. In the Inventory dialog box, select the item that you want to modify.

2. On the right side of the dialog box, modify the item properties according
to your needs.

3. Click Edit to save the changes.

See also

Modify selected inventory items (page 471)

Modify multiple inventory items (page 470)

Modify multiple inventory items
Use the Global Edit command to make specific changes to the properties of
all or multiple items in the inventory at one go. This way, you can save time, as
you do not need to change the properties of each item individually.

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Global Edit --> Global Edit .

3. To only modify specific types of items, select a filter type in the Type list,
and click Select.

4. In the Filter dialog box, click the arrow buttons to move the items whose
properties you want to modify to the Included list.

5. Click OK. 

To further limit the items to modify, repeat steps 3 to 5 for all necessary
filter types.

6. Click OK at the bottom of the Inventory Global Edit Filters dialog box.
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7. In the Global Edit dialog box, select check boxes next to the properties
that you want to update. 

You can also use the Un-check All and Check Changed Fields buttons to
quickly clear or select check boxes.

8. Modify the selected properties in the Global Edit dialog box according to
your needs. 

For example, you can change the category of the items by selecting an
option in the Category list, or type a comment for the items.

9. Click Update.

10. To update the selected properties, click Yes in the confirmation dialog
box.

The Global Edit dialog box closes. The changes you made to the inventory
item properties are updated to the Inventory dialog box.

See also

Modify selected inventory items (page 471)

Modify selected inventory items
Use the Global Edit Selected command to select a group of inventory items
and modify their properties at one go.

1. In the Inventory dialog box, select the items that you want to modify. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Inventory ribbon tab.

3. On the menu, select Global Edit --> Global Edit Selected .

4. In the Global Edit dialog box, select check boxes next to the properties
that you want to update. 

You can also use the Un-check All and Check Changed Fields buttons to
quickly clear or select check boxes.

5. Modify the selected properties in the Global Edit dialog box according to
your needs. 

For example, you can change the category of the items by selecting an
option in the Category list, or type a comment for the items.

6. Click Update.

The Global Edit dialog box closes. The changes you made to the inventory
item properties are updated to the Inventory dialog box.
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See also

Modify multiple inventory items (page 470)

Take material from stock and return material to stock
Use the TFS command to take materials from stock and cut them. Then, use
the RTS command to return the remaining lengths to stock.

1. In the Inventory dialog box, click items to select them. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click TFS, or press Shift+F7. 

Depending on whether the items are linked or combined to a job, one of
the following happens:

• If the items are not linked or combined to a job or you have selected
multiple items that are linked or combined to a job, the Take From
Stock dialog box opens.

• If a single item is selected and it is linked or combined to a job, a
confirmation dialog box appears.

3. Do one of the following: 

To Do this
Take from stock one or
multiple items that are
not linked or combined
to a job

a. In the Take From Stock dialog box, type the
quantity of pieces and the job number.

Note that if you have selected multiple items,
Tekla EPM automatically takes all available
pieces from stock.

b. If necessary, modify the category, sub-
category, sequence, lot number, and release
number.

c. Click TFS to take the material from stock.

d. In the RTS section of the dialog box, type the
quantity, width, length, location, and job
number of items that you want to return to
stock.

e. Click RTS to return the remaining material
lengths to stock.

f. Click Apply.
Take from stock multiple
items that are linked or
combined to a job

a. In the Take From Stock dialog box, type the
job number.
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To Do this
b. If necessary, modify the category, sub-

category, sequence, lot number, and release
number.

c. To return all drop left from cutting to stock,
select the Return Drop of Combined Items
to Stock check box.

d. Click TFS to take the material from stock.
Take from stock a single
item that is linked or
combined to a job

a. To update the linked production control when
taking the material from stock, click Yes in the
confirmation dialog box.

b. In the Enter Value dialog box, do one of the
following:

• Type the date in the Enter Value field.

The acceptable formats are YYYY/MM/DD,
YY/MM/DD, MM/DD/YYYY, and MM/DD/YY.

• Click the arrow on the right side of the
Date Required field and select the date in
the calendar.

c. Click OK.

d. To confirm taking the material item from
stock, click Yes in the confirmation dialog box.

e. In the TFS dialog box, do one of the following:

• To close the dialog box and return to the
Inventory dialog box, click Close.

• To view or print TFS reports, click Reports.

For more information, see View and print
TFS reports (page 494).

Take selected materials from stock
Use the TFS - Selected command to take selected inventory items from stock,
cut them, and move the cut lengths into the inventory history. The remaining
drop remains in the inventory. Once the materials have been taken from
stock, you can view or print different reports for the materials.

1. In the lower navigation tree of the Inventory dialog box, select a job
number. 

Only the items within the selected job are displayed in the display area.

2. Click the Inventory ribbon tab.
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3. On the menu, select Production Control --> TFS - Selected . 

The Enter Value dialog box opens.

4. Enter a date for taking the materials from stock.

5. Click OK.

6. To take the selected materials from stock, click Yes in the confirmation
dialog box. 

The selected items are taken from stock. You can see the progress in the
TFS dialog box. Wait until the process is completed.

7. Do any of the following: 

To Do this
View or print a report on
the TFS process

a. Click Reports.

The Report Progress dialog box opens.

b. Select the report that you want to print or
view.

c. Do any of the following:

• To view the report, click View.

• To print the report, click Print, select the
printer, and click OK.

d. To close the Report Progress dialog box, click
the Close button (X) in the top right corner.

Close the TFS dialog box • Click Close.

Move an item to another inventory location
Use the Move command to move a single inventory item to another inventory
location.

1. In the Inventory dialog box, select the item whose location you want to
change.

2. Click Move, or press Shift+F8. 

The Move dialog box opens.

3. In the Quantity field, enter the number of pieces that you want to move.

4. Click the arrow on the right side of the Location list and select the new
location.

5. If necessary, click the arrow on the right side of the Sec Location list to
select a secondary location.
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6. Click Move, or press F4.

The selected quantity of items is moved to the selected location.

Add inventory items to Order Entry
Use the Add Selected to Order and Quick Quote commands to add items to
Order Entry. The Add Selected to Order command reserves the selected
items for a customer order, whereas the Quick Quote command adds the
selected items directly into a quote or a customer order. Note that you can
only add unreserved items to Order Entry.

Reserve items for a customer order
1. In the Inventory dialog box, select the items that you want to load to a

customer order. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Inventory ribbon tab.

3. On the menu, select Order Entry --> Add Selected to Order .

4. In the Select Quote/Order dialog box, select the customer order to which
you want to load the items.

5. Click OK.

The Select Quote/Order dialog box closes. The items are reserved for the
selected customer order.

Send items to a customer order
1. In the Inventory dialog box, select the items that you want to add to a

quote or customer order. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Inventory ribbon tab.

3. On the menu, select Order Entry --> Quick Quote . 

The Quick Quote dialog box opens. The properties of the selected items
are visible in the Details section of the dialog box.

4. In the Customer Name list, select the customer company. 

Note that the customer must already be saved in the Address Book.

Tekla EPM automatically fills in the customer code and the default contact.

5. If necessary, in the Contact list, select another contact person.
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6. According to your needs, do any of the following: 

To Do this
Send items to an existing quote or
customer order

a. Click Save to Quote/Order.

The Select Quote/Order dialog
box opens.

b. Select the quote or order to
which you want to send the
items.

c. Click OK.

The items are sent to the selected
quote or order.

Send items to a new quote a. Click Save to New Quote.

b. To create a new quote and send
the selected items to it, click Yes
in the confirmation dialog box.

c. In the Quote dialog box, modify
the quote according to your
needs.

For more information, see Create
a quote or an order (page 943).

d. Click Save Quote Information.

e. To close the dialog box, click the
Close button (X) in the upper-
right corner.

Send items to a new customer order a. Click Save to New Order.

b. To create a new order and send
the selected items to it, click Yes
in the confirmation dialog box.

c. In the Order dialog box, modify
the order according to your
needs.

For more information, see Create
a quote or an order (page 943).

d. Click Save Order Information.

e. To close the dialog box, click the
Close button (X) in the upper-
right corner.

7. To close the Quick Quote dialog box, click the Close button (X) in the
upper-right corner.
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Delete inventory items
You can delete unnecessary material items from inventory. Note that deleting
the items is permanent and cannot be undone.

You can still view the deleted items in the transaction history. For more
information, see View the transaction history in the Inventory module
(page 490).

1. In the Inventory dialog box, click the items that you want to delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Delete.

3. To permanently delete the inventory item, click Yes in the confirmation
dialog box.

Combine inventory items manually
You can manually combine items in the Inventory dialog box by activating the
manual combine mode. You can select pieces to combine them into a stock
length, or uncombine pieces from a stock length.

Switch to the manual combine mode
1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Switch to Manual Combine Mode.

The Inventory dialog box changes to the manual combine mode. New buttons
appear at the bottom of the dialog box to enable adding and removing
combined items from the selected inventory item.

You can now combine inventory items manually.

Combine materials
Use the Add Items command to combine materials into a selected stock
length.

1. In the Inventory dialog box, click a stock length to select it.

2. At the bottom of the dialog box, click Add Items. 

The Add Item dialog box opens. You can see all available uncombined
materials that can be combined to the selected stock length. If the dialog

Set up and manage the inventory 477 Manage inventory items



box is blank, no materials are available to be combined to the selected
stock length.

Note that the available materials come from requisitions. If the items that
you want to combine are in a production control job, you need to add
them to a requisition before you can combine them manually.

3. In the Add Item dialog box, click an uncombined item to select it.

4. If necessary, modify the quantity of inventory items that you are
combining materials to. 

If the quantity is greater than 1, the materials should be multiples of that
quantity in order to be displayed and selected in the Add Item dialog box.

5. To allow material grade substitutions, select the Use Grade Substitutions
check box.

6. Click Add.

The selected material items are combined to the selected stock length.

Uncombine materials
Use the Remove Item to uncombine material items from a selected stock
length.

1. In the Inventory dialog box, click a stock length to select it.

2. At the bottom of the dialog box, click Remove Item. 

If the selected stock length is not combined, the Remove Item button is
not available.

3. In the Remove Item dialog box, use the arrow buttons to move the
materials that you want to uncombine to the Included list. 

To only move one piece of the selected item, click the Qty 1 buttons.

4. Click OK.

5. In the confirmation dialog box, do one of the following:

• To simply uncombine the pieces, click No.

Select the No option if you are removing items to clear the material of
items that are no longer linked.

• To uncombine the pieces and return the items to the requisition from
which they were loaded to a purchase order, click Yes.
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The items are held in the requisition to be recombined and purchased,
or combined into a different stock length.

If the requisition no longer exists or the material item was never on a
requisition, Tekla EPM asks you to select a requisition or add a new
one.

The confirmation dialog box and the Remove Item dialog box close. The
pieces are uncombined from the selected stock length.

Switch back to the input mode
1. Click the Inventory ribbon tab.

2. On the menu, select Switch to Input Mode.

The Inventory dialog box changes back to the input mode.

7.5 Add, modify, and delete stock quantities to be
maintained
In the Stock/Reorder dialog box, you can add, modify, and delete stock
quantities that should always be maintained in inventory. This way, Tekla EPM
can alert you when you need to reorder items.

To access the Stock/Reorder dialog box, do the following:

• At the top of the Inventory dialog box, click Stock/Reorder.

The Stock/Reorder dialog box opens, displaying previously created records.

Note that the items in the Stock/Reorder dialog box are color-coded:

• Green items are equal or above the required stock quantity.

• Yellow items are below the required stock quantity.

• Red items are below both the required stock quantity and the required
reorder quantity.

Add a new stock record
1. At the bottom of the Stock/Reorder dialog box, click Add New Record. 

The Stock/Reorder - Add dialog box opens.

2. Select the shape, dimensions, grade, and length to be ordered.

3. If necessary, in the Location list, select the location where the items will
be stored. 

Note that if you select a location, the record only applies to the quantities
of items in the assigned location.
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4. In the Stock Qty field, enter the stock quantity that should be maintained.

5. In the Reorder Qty, enter the quantity at which Tekla EPM prompts you to
reorder the item.

6. Click Add.

The Stock/Reorder - Add dialog box closes, and the new record is added to
the list in the Stock/Reorder dialog box.

Modify stock records
1. In the list in the Stock/Reorder dialog box, click the record that you want

to modify. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Modify the values in the Stock Qty and Reorder Qty fields according to
your needs.

3. Click Save.

Delete stock records
1. In the list in the Stock/Reorder dialog box, click the record that you want

to delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Delete Selected.

3. To permanently delete the record, click Yes in the confirmation dialog
box.

Load stock items to a requisition
1. In the list in the Stock/Reorder dialog box, click the items that you want

to send to a requisition. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Requisition.
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3. In the Select Requisition dialog box, do one of the following according to
your needs: 

To Do this
Add the items into a new
requisition

a. Click Add.

b. Modify the requisition number and description
according to your needs.

c. If necessary, modify other requisition
properties.

d. Click Save.

e. Select the new requisition in the list.

f. Click OK.
Add the items into an
existing requisition

a. Select a requisition in the list.

b. Click OK.

The items are loaded to the selected requisition.

Load stock items to a purchase order
1. In the list in the Stock/Reorder dialog box, click the items that you want

to send to a purchase order. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Purchase Order.

3. In the Select Purchase Order dialog box, do any of the following
according to your needs: 

To Do this
Add the items into a new
requisition

a. Click Add.

b. Modify the purchase order number according
to your needs.

c. Add vendor details for the purchase order.

d. If necessary, modify other purchase order
properties.

e. Click Save.

f. Select the new purchase order in the list.

g. Click OK.
Add the items into an
existing requisition

a. Select a purchase order in the list.
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To Do this
b. Click OK.

The items are loaded to the selected purchase order. In the Stock/Reorder
dialog box, the items are color-coded to reflect the purchase activity.

7.6 View inventory details
You can view different details of inventory materials, including the heat
documents attached to items, the location of barcoded materials, the total
value of inventory materials, and the transaction history. You can also view TFS
report and inventory reports, and print or export them according to your
needs.

For more information, see the following links:

View heat documents attached to inventory items (page 482)

View the location of barcoded materials (page 484)

View the value of inventory materials (page 486)

View the transaction history in the Inventory module (page 490)

View and print TFS reports (page 494)

View, print, and export inventory reports (page 494)

View heat documents attached to inventory items
Use the Check Heat Documents command to view if inventory items have
heat documents attached to them. You can also save or print the available
heat documents, or create reports on the items that have or do not have heat
documents.

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Check Heat Documents.

3. To limit the item types whose heat documents you want to check, in the
Inventory - Check Heat Documents dialog box, select a filter type in the
Type list, and click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

a. Click the arrow buttons to move the items whose heat documents
you want to view to the Included list.

b. Type the maximum and minimum values for the items whose heat
documents you want to view.
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5. Click OK. 

To further limit the item types, repeat steps 3 to 5 for all necessary filter
types.

6. Click Check Heat Documents. 

All inventory items that match the filters that you set are displayed. If an
item has attached heat documents, you can see the number of the heat
documents in the Docs column. If an item does not have attached heat
documents, the Docs column is highlighted with red.

7. According to your needs, do any of the following: 

To Do this
Update heat document
information

• Click Refresh.

Any new or modified information is updated.
Add, modify, and delete
heat documents in
Document Index

a. Click Open Document Index.

Document Index opens. For more information,
see Store document references for the inventory
(page 455).

Save heat documents a. Do one of the following:

• To only save particular heat documents,
click the item whose documents you want
to save, and click Save Documents -->
Save Documents - Selected .

• To save all available heat documents, click
Save Documents --> Save Documents -
All .

b. In the Browse For Folder dialog box, browse
to an empty folder where you want to save the
heat document information.

c. Click OK.

A report of the heat documents opens.
Print heat documents a. Do one of the following:

• To only print particular heat documents,
click the items whose documents you want
to print, and click Print Documents -->
Print Documents - Selected .

• To print all available heat documents, click
Print Documents --> Print Documents -
All .

b. In the Select Printer dialog box, click a printer
to select it.
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To Do this
c. Click OK.

All or the selected heat documents are printed.
Create reports a. Do one of the following:

• To create a report only containing
particular items, click the items to select
them, and click Reports --> Reports -
Selected .

• To create a report containing all items, click
Reports --> Reports - All .

b. In the Report Selection dialog box, click the
report that you want to create.

c. Do one of the following:

• To view the report, click View.

• To print the report, change the number of
copies by clicking the + and - buttons, and
click Print.

• To export the report, click Export, modify
the export format, file name, and location,
and click Export again.

8. To close the dialog box, click the Close button (X) in the upper-right
corner.

View the location of barcoded materials
Use the Location Sweep command to create location sweep reports, which
show the location of yard materials that have been identified by barcodes.
Note that the Location Sweep command is only available for items with serial
numbers.

To access the Inventory Location Sweeps dialog box, do the following:

1. While in the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Barcode --> Location Sweep .

The Inventory Location Sweeps dialog box opens.

According to your needs, do any of the following.

View the location of barcoded materials
1. Click New Location Sweep.
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2. To only view locations of specific types of materials, select a filter type in
the Type list, and click Select.

3. In the Filter dialog box, click the arrow buttons to move the materials that
you want to include in the location sweep to the Included list. 

To further limit the materials included, you can repeat steps 2 to 3 for all
necessary filter types.

4. Click Make Report.

5. In the Report Selection dialog box, select the report that you want to
view.

6. In the Report Selection dialog box, click View. 

The location sweep report opens in Tekla EPM Report Viewer.

Delete a location sweep
1. Select an existing location sweep in the Inventory Location Sweeps

dialog box.

2. Click Delete Location Sweep.

3. To permanently delete the location sweep, click Yes in the confirmation
dialog box.

Cancel remaining items from a location sweep
1. Select an existing location sweep in the Inventory Location Sweeps

dialog box.

2. Click Cancel Remaining.

3. To cancel the remaining items, click Yes in the confirmation dialog box.

Complete the location sweep and move remaining items
1. Select an existing location sweep in the Inventory Location Sweeps

dialog box.

2. Click Complete - Move Remaining.

3. To complete the location sweep and move the remaining items, click Yes
in the confirmation dialog box.

View, print or export reports of an existing location sweep
1. Select an existing location sweep in the Inventory Location Sweeps

dialog box.

2. Click Reports - Selected.
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3. In the Report Selection dialog box, select the report that you want to
view, print, or export.

4. According to your needs, do any of the following: 

To Do this
View the report • In the Report Selection dialog

box, click View.
Print the report a. In the Report Selection dialog

box, change the number of the
printed copies by clicking the +
and - buttons.

b. Click Print.

c. In the Select Printer dialog box,
click a printer to select it.

d. Click OK.
Export the report a. In the Report Selection dialog

box, click Export.

b. In the Export Format list, select
an export format.

c. Click Browse.

d. Browse to the location where you
want to save the exported file,
and click Save.

e. Modify the file name according to
your needs.

f. To attach the exported file to a
Microsoft Outlook email and
send it to a recipient, select the
Attach to Email check box.

g. To open the file after exporting it,
select the Open Exported
Document check box.

h. In the Report Selection dialog
box, click Export.

The location sweep report is saved to
the selected location.

View the value of inventory materials
Use the Valuation command to view the value of materials in inventory. You
can view the value either by date and time, by date, or by archive.
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1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Valuation and one of the following options:

• Valuation by Date/Time: shows the current value of materials in
stock or on order, or the value of materials on a specific date and time.

• Valuation by Date: shows the value of material on a specific date.

• Valuation from Archive: shows the valuation of materials in an
archive file.

According to your needs, see one of the following sets of instructions.

View the current material value in inventory or the material value on a
specific date and time
1. On the menu, select Valuation --> Valuation by Date/Time .

2. In the Archive Date/Time dialog box, do one of the following:

• To view the material values on a specific date and time, select the date
and time in the appropriate lists, and click OK.

• To view the current material values, click Use Current Inventory.

3. To only include specific types of items in the valuation report, in the
Inventory Report Filters dialog box, select a filter type in the Type list,
and click Select.

4. click the arrow buttons to move the item types that you want to include to
the Included list.

5. Click OK.

6. Click Make Report.

7. In the Report Selection dialog box, select the report that you want to
view, print, or export.

8. According to your needs, do any of the following: 

To Do this
View the report • In the Report Selection dialog

box, click View.

The Tekla EPM Report Viewer
opens.

Print the report a. In the Report Selection dialog
box, change the number of the
printed copies by clicking the +
and - buttons.

b. Click Print.

c. In the Select Printer dialog box,
click a printer to select it.
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To Do this
d. Click OK.

Export the report a. In the Report Selection dialog
box, click Export.

b. In the Export Format list, select
an export format.

c. Click Browse.

d. Browse to the location where you
want to save the exported file,
and click Save.

e. Modify the file name according to
your needs.

f. To attach the exported file to a
Microsoft Outlook email and
send it to a recipient, select the
Attach to Email check box.

g. To open the file after exporting it,
select the Open Exported
Document check box.

h. In the Report Selection dialog
box, click Export.

9. To close the dialog box, click the Close button (X) in the upper-right
corner.

View the material value on a specific date
1. On the menu, select Valuation --> Valuation by Date . 

The Inventory Valuation dialog box opens, showing the valuation of
material in stock and on order on the current date.

2. In the Date list, select the date whose inventory valuation you want to
view.

3. Click OK. 

The valuation on the bottom of the dialog box updates.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

View the value from an archive file
1. On the menu, select Valuation --> Valuation from Archive .

2. In the Open dialog box, browse to find and click to select the archive file
that you want to use.
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3. Click Open.

4. In the Select dialog box, select if you want to view inventory reports or
inventory location reports.

5. In the Report Selection dialog box, select the report that you want to
view, print, or export.

6. According to your needs, do any of the following: 

To Do this
View the report • In the Report Selection dialog

box, click View.

The Tekla EPM Report Viewer
opens.

Print the report a. In the Report Selection dialog
box, change the number of the
printed copies by clicking the +
and - buttons.

b. Click Print.

c. In the Select Printer dialog box,
click a printer to select it.

d. Click OK.
Export the report a. In the Report Selection dialog

box, click Export.

b. In the Export Format list, select
an export format.

c. Click Browse.

d. Browse to the location where you
want to save the exported file,
and click Save.

e. Modify the file name according to
your needs.

f. To attach the exported file to a
Microsoft Outlook email and
send it to a recipient, select the
Attach to Email check box.

g. To open the file after exporting it,
select the Open Exported
Document check box.

h. In the Report Selection dialog
box, click Export.

7. To close the dialog box, click the Close button (X) in the upper-right
corner.
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View the transaction history in the Inventory module
Use the Transaction History dialog box to view all transactions made in the
Inventory dialog box. You can also view further transaction details and item
history, and view or print different transaction history reports.

View the transaction history of an item
1. In either the Inventory or Inventory History dialog box, click the

Inventory ribbon tab.

2. On the menu, select Transaction History. 

The Transaction History dialog box opens with the Transaction List tab
open.

3. To filter the transactions shown in the list:

a. In the Filters section of the Transaction History dialog box, click Edit
next to a filter type. 

The available filter types are the transaction date, the user that made
the transaction, the transaction type, and the operation type.

You can also click Find to search for the right user, transaction type,
or opertaion type.

b. Do one of the following: 

• For transaction date, enter the start and end dates to define a
range within which the transactions have taken place.

• For user, transaction type, and operation type, use the arrow
buttons to move the desired items to the Included list.

c. Click OK.

4. To view more information about a transaction, do the following:

a. Click to select the transaction in the list on the Transaction List tab.

b. Click the Transaction Details tab to view the details of the selected
transaction.

c. Click the Item History tab to view the item history of the selected
transaction.

According to your needs, see any of the following instructions:

Find a transaction by transaction number
1. On the Transaction List tab, click Find Transaction #.

2. Enter the transaction number in the field.
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3. Click OK.

The transaction with the selected transaction number is selected on the
Transaction List tab.

Create transaction history reports
1. Click the Transaction History ribbon tab.

2. On the menu, select Reports.

3. To only include specific items in the transaction history report, select a
filter type in the Type list, and click Select.

4. Do one of the following:

• For dates, select the start and end dates in the calendar to define a
range within which the transactions have taken place.

You can also select the Expression check box to create expressions
that allow you to set the base date and the number of days before or
after that date.

• For other filter types, use the arrow buttons to move the desired items
to the Included list.

5. Click OK.

6. Click Make Report.

7. In the Report Selection dialog box, select the report that you want to
view or print.

8. Do any of the following: 

To Do this
View the report • In the Report Selection dialog

box, click View.
Print the report a. In the Report Selection dialog

box, change the number of the
printed copies by clicking the +
and - buttons.

b. If necessary, click Select Printer,
select which device you want to
use for printing, and click OK.

You can also select Default
Printer to always use the default
printer with this report, or No
Printer to reset the current
printer.

c. Click Print.

d. Click Yes.
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To Do this
Export the report a. Click Export.

b. In the Export Format list, select
an export format.

c. Click Browse.

d. Browse to the location where you
want to save the exported file,
and click Save.

e. Modify the file name according to
your needs.

f. To attach the exported file to a
Microsoft Outlook email and
send it to a recipient, select the
Attach to Email check box.

g. To open the file after exporting it,
select the Open Exported
Document check box.

h. Click Export.

View all changes in the transaction history
Tekla EPM records every change made in the system. This is useful because
you can view all changes made in the transaction history of items in a
purchase order. You can then filter the information to see changes made by a
particular user or on a particular date. If necessary, you can also print the list
of changes.

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select List Of Changes.

3. In the List Of Changes Report Filters dialog box, do any of the following: 

To Do this
Filter changes by user a. Select the User filter type and

click Select.

b. Click the arrow buttons to move
the users whose changes you
want to view to the Included list.

c. Click OK.
Filter changes by date a. Click Edit on the right side of the

Date section.

b. Enter the start (Min) and end
(Max) dates.
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To Do this
c. Click OK.

4. Click Make Report.

5. In the Report Selection dialog box, do any of the following: 

To Do this
View the list of changes • Click View.

The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF
buttons at the top of the Tekla EPM Report
Viewer window to email the report via Microsoft
Outlook.

Print the list of changes a. In the Report Selection dialog box, change
the number of the printed copies by clicking
the + and - buttons.

b. If necessary, click Select Printer, select which
device you want to use for printing, and click
OK.

You can also select Default Printer to always
use the default printer with this report, or No
Printer to reset the current printer.

c. Click Print.

d. Click Yes.
Export the list of
changes

a. Click Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Browse to the location where you want to save
the exported file, and click Save.

e. Modify the file name according to your needs.

f. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email check box.

g. To open the file after exporting it, select the
Open Exported Document check box.

h. Click Export.

6. To close the dialog box, click the Close button (X) in the upper-right
corner.
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View and print TFS reports
Use the TFS - Reports Only command to view and print reports for items that
have been or could be taken from stock. TFS reports show the cut details, but
no items are actually cut or taken from stock when you use the TFS - Reports
Only command.

1. In the lower navigation tree of the Inventory dialog box, select a job
number. 

Only the items within the selected job are displayed in the display area.

2. Click the Inventory ribbon tab.

3. On the menu, select Production Control --> TFS - Reports Only .

4. In the TFS dialog box, click Reports.

5. In the Report Progress dialog box, select the report that you want to view
or print.

6. According to your needs, do any of the following: 

To Do this
View the report • In the Report Selection dialog box, click View
Print the report a. In the Report Selection dialog box, change

the number of the printed copies by clicking
the + and - buttons.

b. Click Print.

c. In the Select Printer dialog box, click a printer
to select it.

d. Click OK.

7. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Take material from stock and return material to stock (page 472)

Take selected materials from stock (page 473)

View, print, and export inventory reports
You can create different inventory reports, such as subtotal reports, shape
summaries, or receiving tickets.

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.
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3. In the Inventory Report Filters dialog box, select either the Inventory
Report or Inventory Location Report option according to your needs.

4. To only include specific items in the report, select a filter type in the Type
list, and click Select.

5. In the Filter dialog box, click the arrow buttons to move the items that
you want to include in the report to the Included list.

6. Click OK.

7. If you want to view the inventory situation of a previous date in the
reports, do the following:

a. Click From Archive.

b. Select the archive date and time in the applicable lists.

c. Click OK.

8. To view barcode audit reports in the Report Selection dialog box, select
the Barcode Audit check box.

9. Click Make Report.

10. In the Report Selection dialog box, click the report that you want to view,
print, or export.

According to your needs, see one of the following sets of instructions.

View inventory reports
1. In the Report Selection dialog box, click View. 

The Tekla EPM Report Viewer dialog box opens, displaying the selected
report.

2. In Tekla EPM Report Viewer, do any of the following according to your
needs: 

To Do this
Move between pages • Click the arrows at the top of

Tekla EPM Report Viewer.
Go to a specific page of the report • Type the page number in the

empty field at the top of Tekla
EPM Report Viewer.

Find a text in the report a. Click the binocular icon.

b. In the blank field, type the text
that you want to find.

c. Click Find Next.

Any matching text is highlighted
with a red box.
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To Do this
Zoom in or out • Click the magnifying glass icon and

select the zoom value in the list.

Print inventory reports
1. In the Report Selection dialog box, change the number of the printed

copies by clicking the + and - buttons.

2. Click Print.

3. In the Select Printer dialog box, click a printer to select it.

4. Click OK.

Export inventory reports
1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Browse to the location where you want to save the exported file, and click
Save.

5. Modify the file name according to your needs.

6. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email check box.

7. To open the file after exporting it, select the Open Exported Document
check box.

8. In the Report Selection dialog box, click Export.

The report is saved to the selected location.

7.7 Import and export inventory information
You can import inventory information or a cut list to Tekla EPM, or export
inventory information from Tekla EPM to KSTK, ProNest, Timberline, and XML
format.

For more information, see the following links:

Export inventory information to the KSTK format (page 497)

Export inventory transactions to Timberline (page 497)

Export inventory to SigmaNest (page 498)

Export inventory information to XML (page 498)

Synchronize inventory information with ProNest (page 498)
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Import inventory information from an HTML file (page 499)

Import ProNest cut lists to Tekla EPM (page 499)

Archive jobs (page 500)

Export inventory information to the KSTK format
Use the Export to KSTK command to save inventory information in the KSTK
format.

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Export to KSTK.

3. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla EPM saves the file to the Export folder.

4. If necessary, change the file name.

5. Click Save. 

A message opens, showing where the inventory information was saved.

6. Click OK to close the message.

Export inventory transactions to Timberline
Use the Export Inventory Transactions to Timberline command to export
inventory information to the Timberline accounting software. Note that
Timberline must be open, so that it can receive the inventory information.

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Export Inventory Transactions to Timberline. 

The Export Inventory Transactions to Timberline dialog box opens.

3. In the Export From Transaction # and To (leave blank for all) fields,
enter the numbers of the first and last transactions that you want to
export.

4. In the Job # Export Option list, select how you want the job number to be
exported.

5. Enter the general ledger code.

6. To not export material that has been received directly to inventory history,
select the Ignore material received directly to inventory history check
box.

7. Click Export Transactions.

The selected transactions are exported to Timberline.
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Export inventory to SigmaNest
We recommend that you regularly export the Tekla EPM inventory to
SigmaNest to keep the Tekla EPM inventory and SigmaNest in sync.

Before you can export inventory information to SigmaNest, you need to set up
Tekla EPM to work with SigmaNest. For more information, see SigmaNest
Integration.

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Export --> Export to SigmaNest. 

NOTE If you cannot see the Export to SigmaNest option, ensure that
you have enabled SigmaNest:

a. On the Maintenance menu, select Integration Settings -->
SigmaNest.

b. In the SigmaNest Settings dialog box, ensure that the
Enable SigmaNest for Plate Nesting check box is selected.

The inventory information in Tekla EPM is exported to SigmaNest. You can
view the process in the Status dialog box.

3. When the synchronization process is completed, click OK to close the
Status dialog box.

Export inventory information to XML
Use the Export to XML command to save inventory information in an XML file.

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Export --> Export to XML .

3. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla EPM saves the file to the Export folder.

4. If necessary, change the file name.

5. Click Save. 

The Status dialog box opens, showing the status of the export process.

6. When the export is completed, click OK to close the Status dialog box.

The file is saved to the location you selected.
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Synchronize inventory information with ProNest
Use the Sync with ProNest command to synchronize Tekla EPM inventory
information with ProNest and update the cut lists in ProNest. We recommend
that you synchronize the two software regularly.

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Export --> Sync with ProNest . 

The inventory information in Tekla EPM is exported to ProNest to
synchronize the two software. You can view the process in the Status
dialog box.

3. When the synchronization process is completed, click OK to close the
Status dialog box.

You can now view the inventory information exported from Tekla EPM in
ProNest.

Import inventory information from an HTML file
Use the Inventory From HTML command to import inventory information
from an HTML file to Tekla EPM.

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Import --> Inventory From HTML .

3. In the Open dialog box, browse to find and select the HTML file that you
want to import.

4. Click Open.

The inventory information is imported to Tekla EPM.

Import ProNest cut lists to Tekla EPM
You can import cut lists available in the ProNest nesting software to Tekla
EPM. By importing cut lists, you receive information on the scrap of a ProNest
nesting process to inventory.

Before sending cut lists to Tekla EPM, send the nest to CNC in ProNest.

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Import --> ProNest Cut List . 

Tekla EPM imports the cut lists that are available in ProNest.

3. When the import is completed, click Open Import Log to view, print, or
save the import log.
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4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Once a cut list is imported, it can be cut in Tekla EPM. This way, you can
remove the used plate from inventory and add the proper scrap.

See also

Synchronize inventory information with ProNest (page 498)

Archive jobs
Use the Archive Jobs command to export jobs from Inventory History and
save them as KSTK or TXT files.

1. In the Inventory History dialog box, click the Inventory History ribbon
tab.

2. On the menu, select Export --> Archive Jobs .

3. In the Select Jobs to Archive dialog box, click the arrow buttons to move
the jobs that you want to archive to the Included list.

4. If you want to delete the jobs from inventory history after archiving them,
select Yes in the Purge Archived Jobs list.

5. Click OK.

6. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla EPM saves the file to the Export folder.

7. If necessary, change the file name.

8. If necessary, select another file format in the Save as type list.

9. Click Save. 

A message opens, showing you the location and the file where the
archived jobs have been saved.

10. Click OK to close the message.
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8 Manage projects

The Project Management module brings together all information regarding
the project: the information from the related estimating jobs or combining
jobs, and the materials, hours, weight, sequencing and tracking from the
related production control job. You can bring information from multiple
estimating jobs, combining jobs, and production control jobs to the project
management job. In Project Management, you can add drawings and journal
entries, create transmittals or requests for information, and assign tasks to
Tekla EPM users.

NOTE Before you start working in the Project Management module, ensure that
you have adjusted the project management settings according to your needs.

For more information, see the following links:

Open the Project Management module (page 529)

Create a project management job (page 530)

Open a project management job (page 532)

Store document references for a project management job (page 534)

Manage and assign project tasks (page 536)

Manage companies in the project (page 556)

Manage drawings (page 537)

Manage transmittals (page 558)

Manage requests for information (page 572)

Manage the project journal (page 587)

Manage change orders (page 594)

Manage the project task list (page 604)

Manage the project check list (page 608)

View and adjust the project schedule (page 613)

Manage contract and invoicing information (page 657)
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View, print, or export the project summary (page 671)

Import and export project management information (page 666)

View, print, or export project management reports (page 669)

8.1 Set up the Project Management module
Before you start to use the Project Management module, we recommend
that you take the time to customize the properties and available items
according to your needs. Once you have created and modified all necessary
items and settings, working in the Project Management module is easier and
more efficient.

When setting up the Project Management module, you can:

• Customize the display and input fields in the Drawing Log, Transmittals,
RFIs, Journal, and Change Orders dialog boxes.

• Create, modify, and delete the resources that are available in the
production schedule.

• View and filter the production schedule.

• Create, modify, and delete calendars that are available for the project
schedule.

• Modify the project schedule settings.

• Create templates that you can apply to quickly create a baseline for the
project schedule.

• Define the standard settings used in the Project Management module.

• Create, modify, and delete approval statuses available for drawings.

• Create, modify, and delete common steps that are available for all project
management jobs.

• Delete project management jobs.

• Rename project management jobs.

• Set job groups for project management jobs.

• Create, modify, and delete methods that are available for sending
documents.

• Create, modify, and delete items that are commonly used in transmittals.

• Create, modify, and delete commonly used purposes for transmittals.

• Create, modify, and delete pieces of text that are commonly used in
transmittals.
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• Create reports for all or a group of project management jobs.

Many of the settings and selections can be saved by user. This way, each user
can adjust Tekla EPM to meet their individual needs and preferences without
changing the default settings.

For more information, see the following links:

Create, modify, and delete schedule calendars (page 515)

Modify the project schedule settings (page 506)

Create, modify, and delete schedule templates (page 507)

Define company standard settings for Project Management (page 503)

Create, modify, and delete approval statuses (page 517)

Create, modify, and delete common steps for project management jobs
(page 518)

Manage project management jobs (page 520)

Create, modify, and delete methods for sending documents (page 522)

Create, modify, and delete transmittal items (page 523)

Create, modify, and delete transmittal purposes (page 523)

Create, modify, and delete commonly used text items for transmittals
(page 524)

View, print, or export project reports (page 527)

Define company standard settings for Project Management
In the Project Company Standards dialog box, you can create settings that
become the company default settings that are used for new project
management jobs. If necessary, you can change the settings job by job.

1. Click the Maintenance ribbon tab.

2. On the menu, select Project Management --> Company Standards .

3. In the Project Company Standards dialog box, adjust the following
settings according to your needs: 

Option Description
Job # Increment Allows you to select the default option

for automatic job numbering. The
options are:

• Increment from Last Job #:

When you create a new job, Tekla
EPM uses the next available job
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Option Description
number after the latest job
number created.

• Increment from Largest Job #:
Tekla EPM uses the next available
job number after the largest job
number created.

• Don't Increment: Automatic job
numbering is not used.

Drawing Number Input Type Allows you to select the input format
for drawing numbers.

Drawing File Prefix By default, Tekla EPM expects that the
names of drawing files match the
drawing numbers. The Drawing File
Prefix option allows you to determine
the prefix that appears in the names
of all drawing files that are imported.

Determining a drawing file prefix is
optional. However, the drawing file
prefix can help you to ensure that the
correct files are imported from the
selected folder.

For example, drawing files might
consist of the job number followed by
a dash and the drawing number. In
this case, drawing 100 could be
named C12345-100.pdf. In
consequence, the drawing file prefix
would be C12345-.

If the drawing file prefix varies, you
can use an asterisk (*) as a wildcard
character. For example, if the prefix of
some drawing files that you want to
import was not C12345, you could set
the drawing file prefix to *-.

Type the acceptable prefix in the
Drawing File Prefix field.

Drawing File Suffix By default, Tekla EPM expects that the
names of drawing files match the
drawing numbers. The Drawing File
Suffix option allows you to determine
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Option Description
the suffix that appears in the names
of all drawing files that are imported.

Determining a drawing file suffix is
optional. However, the drawing file
suffix can help you to ensure that the
correct files are imported from the
selected folder.

For example, drawing files might
include a revision number after the
drawing number. In this case, the file
name of the first revision of drawing
100 could be C12345-100-r1.pdf.
In consequence, the drawing file
suffix would be -r1.

If the drawing file suffix varies, you
can use an asterisk (*) as a wildcard
character. For example, if some
drawing files had different revision
numbers, you could set the drawing
file suffix to -r*.

Type the acceptable suffix in the
Drawing File Suffix field.

Transmittal Recipients Available Allows you to select which companies
can be selected as transmittal
recipients.

Click the arrow on the right side of
the Transmittal Recipients
Available list and select an option.

Transmittal Recipient Selection Allows you to select which
information is displayed for the
companies in the Recipient list.

Click the arrow on the right side of
the Transmittal Recipient Selection
list and select either the firm code or
the firm name.

Keep Job Selection Screen Open When selected, the Select Project
Management Job dialog box stays
open after a job has been opened.
Otherwise, the selection screen closes
when you open a job.

Update Production Control
Approval Status

When selected, the approval statuses
of shop drawings that are used in
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Option Description
Production Control are
automatically updated.

Resources - Use Period Ending Date When selected, the date that is shown
in production schedules for resources
is the last date of a period. This
option only applies when the scale of
the schedule is set to week or month.
For example, February 2019 would be
shown as 2/28/2019 in the mm/dd/
yyyy format.

When cleared, the date that is shown
is the first date of a period. In this
case, February 2019 would be shown
as 2/1/2019 in the mm/dd/yyyy
format.

For more information, see Modify
resource capacity (page 770).

Job # Regular Expression Allows the use of regular expressions
to enforce a desired format for the
job numbers.

For more detailed instructions on job
number regular expressions, click
Regular Expression Help.

4. Click Save to update the company standard settings.

Set up schedules
Before creating project and production schedules, we recommend that you
adjust the schedule settings according to your needs. You can also create the
necessary schedule calendars and schedule templates, and modify or delete
the existing ones.

For more information, see the following links:

Modify the project schedule settings (page 506)

Create, modify, and delete schedule calendars (page 515)

Create, modify, and delete schedule templates (page 507)

Modify the project schedule settings
In the Schedule Settings dialog box, you can set the default settings for
project schedules. You can define settings for accessing and remaining in the
edit mode, and set the default project breakdown levels and fields.
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1. Click the Maintenance ribbon tab.

2. On the menu, select Project Management --> Schedule Settings .

3. On the Edit Mode tab of the Schedule Settings dialog box, adjust the
following settings: 

Option Description
Edit Mode
Timeout

The number of seconds that a user can be in the edit
mode without making changes before the edit mode
times out.

The edit mode ensures that Tekla EPM users do not make
conflicting changes if they work on the project schedule
simultaneously.

Type the desired number of seconds in the Edit Mode
Timeout field.

Auto-Acquire
Edit Mode

When selected, Tekla EPM no longer asks you if you want
to access the edit mode when making changes. This
means that all changes to the project schedule are made
without confirmation, provided that no other Tekla EPM
users are currently in the edit mode and modifying the
same project schedule.

4. Click the Project Breakdown tab to open it.

5. To define the available breakdown levels and fields, click the arrows next
to the breakdown fields, and select suitable options in the list. 

By default, two levels of breakdown items (sequences and lot numbers)
are available. To make more levels available, select options in the Default
Breakdown Field 3, Default Breakdown Field 4, and Default
Breakdown Field 5 lists. If you do not want a breakdown level to be
available, select None.

For example, to enable categories as the breakdown level below lots,
select Category in the Default Breakdown Field 3 list.

6. Click Save.

The changes you made are saved as default settings for all new project
schedules. If necessary, you can adjust the breakdown levels and fields on a
job by job basis.

See also

View and adjust the project schedule (page 613)

Create, modify, and delete schedule templates
In the Schedule Templates dialog box, you can create, modify, and delete
templates that are used as the basis of project schedules with pre-determined
tasks and settings. Creating schedule templates saves time when creating
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project schedules, because you can easily apply the template to any project
schedule. When the template is applied to the project schedule, you can
modify the tasks according to your needs.

To access the Schedule Templates dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Project Management --> Schedule Templates .

Create a schedule template

1. Click New Template.

2. In the Template Description field, type a name for the new template.

3. Click Add Template. 

The template is added to the list on the left side of the dialog box.

4. To add tasks to the template, do the following:

a. Click New Task. 
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b. In the Schedule Template Task dialog box, type a description for the
task.

c. Modify the task properties according to your needs: 

Option Description
Parent Task If the task you are creating is a sub-task, for an

existing task, you need to select the main task.

Click the arrow on the right side of Parent Task
field, and select a task in the list. If you are creating
a top-level task, select None.

Note that you cannot modify the task type,
duration, or original estimate time of a main task if
you add a sub-task.

Task Type Specifies the behavior of the task on the Gantt
Chart tab. The available task types are:

• Start/End: an action to be performed over a
period of time. Properties include the start
date, end date, and duration.

Start/end tasks can be directly re-sized an
moved on the Gantt Chart tab.

• Summary: takes the aggregate values from its
sub-tasks. The start date of a summary task is
automatically set to the earliest date of the sub-
tasks. The end date is set to the latest sub-task
end date, and the percent completed is
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Option Description
aggregated based on the status summary
method.

Summary tasks cannot be re-sized on the
Gantt Chart tab directly. However, the sub-
tasks can be re-sized and moved, and the
summary main task will re-sized and moved
accordingly.

• Milestone: an event in the schedule. For
example, a project kickoff meeting can be a
milestone task. The end date and the start date
are always the same, and the duration is set to
one day.

Apply Breakdown
Links

When selected, the links set in the project schedule
are added between sub-tasks. For example, any
links set between sequences 1, 2, and 3 would be
added.

Duration The expected number of working days to complete
a task.

The duration can only be adjusted if the task type
is set to Start/End.

Type the number of days in the Duration field.
Original Estimate The time originally estimated for the entire main

task or a sub-task. The hours will automatically be
distributed among the sub-tasks on the Gantt
chart.

Type the time in man hours in the Original
Estimate field.

Status Link The information that affects the status of the task
when the project schedule is updated. The
available options are:

• Drawings Approved: the number of drawings
with the Approved status.

• Material Purchased: the production material
that is linked to material that is either in stock
or on order.

• Material Received: the production material
that is linked to material that is in stock.

• TFS: the production material that has been cut.

• Production Completed: the production
material that has been assigned a route and
has completed all stations in that route.
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Option Description
• Production Progress: the production material

that has been assigned a route and has
completed some stations in that route.

• Station Progress: the production material that
has been assigned a route that includes the
selected station and has completed that
station.

• Shipping Destination Progress: the
production material that has been assigned a
shipping route that includes the selected
destination and has completed that destination.

• Shipping Completed: the production material
that has completed all assigned shipping
destinations.

Status Summary
Method

The method that determines how the percentage
completed of a main task will be calculated from
the sub-tasks. Each option specifies the weight that
is given to each sub-task in the calculation. The
available options are:

• No Factor: no weight is given to the individual
sub-tasks. The percentage completed of the
main task is an average of the sub-tasks.

• By Quantity: the percentage completed is
weighed by the quantity of each sub-task.

• By Weight: the percentage completed is
weighed by the weight of each sub-task.

• By Duration: the percentage completed is
weighed by the duration of each sub-task.

Resource An object with a time-based capacity to be added
on a production schedule, and the resource by
which station work will be executed.

Linking a task from the project schedule to a
resource connects the project and production
schedules.

Click the arrow on the right side of Resource list,
and select a resource in the list.

d. Click Add.

e. Select the new task in the navigation tree.

f. In the Link Tasks section of the dialog box, define dependencies
between two tasks. 
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By creating links, you can make the schedule cascade from one task
to another.

Note that:

• A task cannot link to itself.

• A link cannot be created between a task and one of its sub-tasks.

• Duplicate links are not allowed. There can be only one link
between a pair of tasks.

• Link cycles are not allowed. For example, if a link is created from
task 1 to task 2, a link cannot be created from task 2 to task 1.

• When you use links, and the duration of an item changes, the
positions of all linked items also changes. Do not link items that
need to remain static, or are independent from other items in the
schedule.

Do any of the following:

To Do this
Add a link that ends with
the current given task

Note that if a previous snapshot is displayed
instead of the current project schedule
information, you cannot add a predecessor link.

1. Click New Predecessor Link.

2. Click the arrow on the right side of Link From
list, and in the list, select the starting task of
the link.

3. Click the arrow on the right side of upper
Position field, and in the list, select if the link
originates from the start or end of the starting
task.

4. Click the arrow on the right side of lower
Position field, and in the list, select if the link
ends at the start or finish of the second task.

5. In the Minimum Interval field, type the
minimum number of working days between
the two tasks.

The minimum interval is enforced in the Gantt
chart. The later task cannot be moved earlier
in the Gantt chart than the value in the
Minimum Interval field determines.

6. Click Add.
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To Do this
7. In the confirmation dialog box, click Yes.

For example, to define that shipping must start
when the fabrication is finished, select Shipping
and set the link a follows:

• Link From: Fabrication

• Upper Position: Finish

• Lower Position: Start

• Minimum Interval: 0 days
Add a link that begins
with the current task

Note that if a previous snapshot is displayed
instead of the current project schedule
information, you cannot add a successor link.

1. Click New Successor Link.

2. Click the arrow on the right side of the upper
Position field, and in the list, select if the link
originates from the start or end of the starting
task.

3. Click the arrow on the right side of the Link To
field, and in the list, select the task that is the
ending point of the link.

4. Click the arrow on the right side of the lower
Position field, and in the list, select if the link
ends at the start or finish of the second task.

5. In the Minimum Interval field, type the
minimum number of working days between
the two tasks.

The minimum interval is enforced in the Gantt
chart. The later task cannot be moved earlier
in the Gantt chart than the value in the
Minimum Interval field determines.

6. Click Add.

7. In the confirmation dialog box, click Yes.

For example, to define that shipping must start
when the fabrication is finished, select Fabrication
and set the link a follows:

• Upper Position: Finish

• Link To: Shipping

• Lower Position: Start

• Minimum Interval: 0 days
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To Do this
View and modify link
properties

1. Click Link Properties.

2. Modify the starting task, ending task, the task
positions, and interval according to your
needs.

3. Click Save to update the link properties.
Delete a link 1. Click a link in the list to select it.

2. Click Delete Link.

3. In the confirmation dialog box, click Yes to
permanently delete the links.

g. To save the links, click Save.

h. To close the Schedule Template Task dialog box, click the Close
button (X) in the upper-right corner.

Repeat steps a to i for all tasks that you want to add to the template.

5. In the Schedule Templates dialog box, click Save Template.

Modify a schedule template

1. In the list on the left of the Schedule Templates dialog box, select the
template that you want to modify.

2. Do any of the following: 

To Do this
Add a task to the
schedule template

See Create a schedule template.

Modify an existing task a. In the Template Tasks list, select the task that
you want to modify.

b. Click Properties.

c. In the Schedule Template Task, modify the
task description, properties, and links
according to your needs.

For more information on task properties and
links, see Create a schedule template.

d. Click Save to save the changes.
Move a task earlier or
later in the schedule
template

a. In the Template Tasks list, select the task that
you want to move earlier or later in the
schedule template.

b. Click the Move Up and Move Down to change
the location of the task.
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To Do this
Delete a task from the
schedule template

Note that deleting a task from the schedule
template is permanent and cannot be undone.

a. In the Template Tasks list, select the task that
you want to delete.

b. Click Delete Task.

c. To permanently delete the task, click Yes in
the confirmation dialog box.

3. Click Save Template to save the changes.

Delete a schedule template

Note that deleting a schedule template is permanent and cannot be undone.

1. In the list on the left of the Schedule Templates dialog box, select the
template that you want to delete.

2. Click Delete Template.

3. To permanently delete the schedule template, click Yes in the
confirmation dialog box.

Create, modify, and delete schedule calendars
Schedule calendars determine the working days in a project schedule. By
default, Tekla EPM uses a schedule calendar with a five-day working week
from Monday to Friday, excluding national holidays. If necessary, in the
Schedule Calendars dialog box, you can create additional schedule calendars.
For example, this can be useful if your shop has a seven-day working week.
You can also modify or delete the existing schedule calendars, and select
which schedule calendar is used as the default option.

To access the Schedule Calendars dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Project Management --> Schedule Calendars .

You can view the existing schedule calendars on the left side of the Schedule
Calendars dialog box.

Create a schedule calendar

1. Click New.

2. In the Calendar Description field, type a name for the new calendar.

3. Select the check box next to each weekday that you want to mark as a
working day. 

Note that in the calendar at the bottom of the dialog box, the non-working
days are bolded.
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4. Click Add.

The new schedule calendar is added to the list on the left side of the dialog
box. If necessary, you can now add working day exceptions to the schedule
calendar.

Add working day exceptions

If necessary, you can add working day exceptions to a schedule calendar. For
example, you can set national holidays as non-working days, or set a particular
Saturday or Sunday as a working day.

1. In the list on the left side of the Schedule Calendars dialog box, click the
calendar to which you want to add working day exceptions.

2. At the bottom of the dialog box, click Working Day Exceptions.

3. In the Schedule Calendar - Working Day Exceptions dialog box, click
New.

4. Type a description for the working day exception.

5. If you want the date to be a working day, select the Is Working Day check
box.

6. Select the exception date in the calendar.

7. Click Add.

The working day exception is added to the list on the left side of the Schedule
Calendar - Working Day Exceptions dialog box.

If necessary, you can select a working day exception in the list, and then either:

• Modify the working day exception by changing its properties and clicking
Edit.

• Delete the working day exception by clicking Delete, and then Yes to
confirm.

Set a schedule calendar as the default option

The current default schedule calendar is marked with an asterisk (*) in the list
on the left side of the Schedule Calendars dialog box. If you want to use
another calendar as the default option, do the following:

1. In the list on the left side of the Schedule Calendars dialog box, click the
calendar that you want to set as the default option.

2. Click Set as Default.

3. In the confirmation dialog box, click Yes to set the selected calendar as
the default option in all new project schedules.

The selected calendar is set as the default option and marked with an asterisk
(*).
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Modify a schedule calendar

1. In the list on the left side of the Schedule Calendars dialog box, click the
calendar that you want to modify.

2. In the Calendar Description field, modify the name of the calendar.

3. Select the check box next to each weekday that you want to mark as a
working day.

4. Click Edit to save the changes.

Delete a schedule calendar

Deleting a schedule calendar is permanent and cannot be undone. Note that
the default calendar cannot be deleted.

1. In the list on the left side of the Schedule Calendars dialog box, click the
calendar that you want to delete.

2. Click Delete.

3. In the confirmation dialog box, click Yes to permanently delete the
calendar.

Create, modify, and delete approval statuses
In the Approval Status dialog box, you can create, modify, or delete approval
statuses for drawings. The Approval Status dialog box is available through
both the Production Control module and the Project Management module.

To access the Approval Status dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Production Control --> Approval Status
Maintenance or Project Management --> Approval Status
Maintenance .

The Approval Status dialog box opens. You can view all existing approval
statuses.

Create an approval status option
1. Click New.

2. In the Approval Status field, type an abbreviation for the new approval
status.

3. In the Description field, type a description for the new approval status.

4. If you wish, in the Purpose list, select if items with the status option are
approved or on hold. 
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No matter how many approval statuses you create, the only available
purpose options are Approved and Hold.

Approved means that drawings are ready for fabrication. The Approved
purpose is used as the status link in the project schedule.

whereas Hold means that the drawings are not ready for fabrication.
Items with the Hold option can move through fabrication processes, but
they will be highlighted in red, and warning pop ups will appear during
processing updates. Any loads that contain items with the Hold purpose
option cannot be shipped.

5. Click Add.

Modify an existing approval status
1. In the list, click the approval status that you want to modify.

2. Modify the approval status abbreviation, description, and purpose
according to your needs.

3. Click Edit to save the changes.

Delete an approval status
Note that deleting an approval status is permanent and cannot be undone.

1. In the list, click the approval status that you want to delete.

2. Click Delete.

3. In the confirmation dialog box, click Yes to permanently delete the
approval status.

Create, modify, and delete common steps for project
management jobs
In the Check List Item Maintenance dialog box, you can create, modify, and
delete check list items. Check list items are steps that are commonly
performed in project management jobs, such as receiving a signed contract
from the client. The check list items that you create in the Check List Item
Maintenance dialog box are automatically available for all future project
management jobs. However, you need to add them manually to existing
project management jobs.

To access the Check List Item Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.
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2. On the menu, select Project Management --> Check List Item
Maintenance .

The check list items created in the Check List Item Maintenance dialog box
serve as reminders in each project management job. Tekla EPM also records
the date when each of these tasks are completed and the user who performs
the tasks.

Create a check list item
1. Click New.

2. In the Description field, type a description for the item. 

For example, Get signed contract from the client.

3. Click Add.

The check list item is now available for all project management jobs, and you
can be assigned it to particular users' task lists within the projects.

To add the new check list item to an existing project management job, you
need to do the following:

1. Open the project management job.

2. Click the Project Management ribbon tab.

3. On the menu, select Check List.

4. In the Check List dialog box, click the Check List ribbon tab.

5. On the menu, select Add Additional Check List Items.

6. In the Add Check List Items dialog box, click the arrow buttons to move
the items that you want to add to the Included list.

7. Click Add.

8. In the Check List dialog box, click Save.

Modify a check list item
1. In the list, select the check list item that you want to modify.

2. Modify the item description according to your needs.

3. Click Edit to save the changes.

Change the position of a check list item
1. In the list, select the check list item that you want to move up or down in

the list of tasks.

2. Click the Position (+) and Position (-) buttons to move the item to the
desired position.
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Delete a check list item
Note that deleting a check list item is permanent and cannot be undone.

1. In the list, select the check list item that you want to delete.

2. Click Delete.

3. To permanently delete the check list item, click Yes in the confirmation
dialog box.

Manage project management jobs
In the Project Maintenance dialog box, you can manage existing project
management jobs. You can delete and rename jobs, or set up job groups for
sorting project management jobs.

To access the Project Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Project Management --> Job Maintenance .

3. In the Project Maintenance dialog box, select the jobs that you want to
manage.

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

4. At the bottom of the dialog box, click any of the available buttons.

The options are:

• Delete

• Rename

• Set Group Name

For more information, see the following links:

Delete project management jobs (page 520)

Rename a project management job (page 521)

Set job groups for project management jobs (page 521)

Manage projects 520 Set up the Project Management module



Delete project management jobs
You can delete unnecessary project management jobs at any time in the
Project Maintenance dialog box.

Note that deleting a project management job is permanent and cannot be
undone.

1. In the Project Maintenance dialog box, select the project that you want
to delete.

2. At the bottom of the dialog box, click Delete.

3. To permanently delete the selected job, click Yes in the confirmation
dialog box.

Rename a project management job
Do the following to rename an existing project management job:

1. In the Project Maintenance dialog box, select the job that you want to
rename.

2. At the bottom of the dialog box, click Rename.

3. Type a new name for the job.

4. Click OK.

Set job groups for project management jobs
Job groups allow you to identify and sort projects that are similar. For
example, you can create job groups based on the year or the project manager
name. Assigning job groups to jobs makes it easier to sort a long list of jobs.

1. In the Project Maintenance dialog box, select the jobs for which you
want to create a job group. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

2. At the bottom of the dialog box, click Set Group Name.

3. Select if you want to update the primary group or the secondary group.

4. Type a name for the group.

5. Click OK.

Set up transmittals
Before you start creating transmittals, we recommend that you create the
necessary methods for sending documents, transmittal items, transmittal
purposes, and commonly used text for transmittals.
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For more information, see the following links:

Create, modify, and delete methods for sending documents (page 522)

Create, modify, and delete transmittal items (page 523)

Create, modify, and delete transmittal purposes (page 523)

Create, modify, and delete commonly used text items for transmittals
(page 524)

Create, modify, and delete methods for sending documents
In the Sent Via Maintenance dialog box, you can create, modify, and delete
methods for sending documents. Sending methods allow you to mark how a
document was sent to the recipient when you are creating transmittals. For
example, documents can be sent via email, fax, or mail. You can also set the
default method for sending documents.

To access the Sent Via Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Project Management --> Sent Via Maintenance .

Create a sending method

1. Click New.

2. Type a description for the sending method.

3. Click Add.

Modify a sending method

1. In the list, select the sending method that you want to modify.

2. Modify the description according to your needs.

3. Click Edit to save the changes.

Set the default sending method

The current default sending method is marked with an asterisk (*). Note that
you can also select another sending method for each document that you send.

1. In the list, select the sending method that you want to set as the default
option.

2. Click Set as Default.

3. To confirm using the sending method as the default option, click Yes in
the confirmation dialog box.

The selected sending method is set as the default option and marked with an
asterisk (*).
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Delete a sending method

Note that deleting a sending method is permanent and cannot be undone.

1. In the list, select the sending method that you want to delete.

2. Click Delete.

3. To permanently delete the sending method, click Yes in the confirmation
dialog box.

Create, modify, and delete transmittal items
In the Transmittal Item Maintenance dialog box, you can create, modify, and
delete commonly used items that are sent with a transmittal. These items also
appear in the transmittal document. Creating transmittal items saves time,
because you do not have to type each item manually when you create a
transmittal in the Transmittals dialog box. Instead, you can select existing
transmittal items in the Items list.

To access the Transmittal Item Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Project Management --> Transmittal Item
Maintenance .

Create a transmittal item

1. Click New.

2. Type a description for the transmittal item.

3. Click Add.

Modify a transmittal item

1. In the list, select the transmittal item that you want to modify.

2. Modify the item description.

3. Click Edit to save the changes.

Delete a transmittal item

Note that deleting a transmittal item is permanent and cannot be undone.

1. In the list, select the transmittal item that you want to delete.

2. Click Delete.

3. To permanently delete the transmittal item, click Yes in the confirmation
dialog box.
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Create, modify, and delete transmittal purposes
In the Transmittal Purpose Maintenance dialog box, you can create, modify,
and delete commonly used purposes for sending transmittals. The purpose of
the transmittal appears on the transmittal document and informs the
recipient why the document has been sent. Creating transmittal purposes
saves time, because you do not have to type the purposes manually each time
that you create a transmittal in the Transmittals dialog box. Instead, you can
select existing transmittal purposes in the Purpose list.

To access the Transmittal Purpose Maintenance dialog box, do the
following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Project Management --> Transmittal Purpose
Maintenance .

Create a transmittal purpose

1. Click New.

2. Type a description fot the transmittal purpose.

3. Click Add.

Modify a transmittal purpose

1. In the list, select the transmittal purpose that you want to modify.

2. Modify the purpose description according to your needs.

3. Click Edit to save the changes.

Delete a transmittal purpose

Note that deleting a transmittal purpose is permanent and cannot be undone.

1. In the list, select the transmittal purpose that you want to delete.

2. Click Delete.

3. To permanently delete the transmittal purpose, click Yes in the
confirmation dialog box.

Create, modify, and delete commonly used text items for transmittals
In the Transmittal Standard Text Maintenance dialog box, you can create,
modify, and delete commonly used text items that can be added to transmittal
documents. For example, a text item can contain information on how quickly
the recipient should react to the transmittal. Creating text items saves time,
because you do not need to type the text each time you create a similar
transmittal in the Transmittals dialog box. Instead, you can select an
applicable text item in the Standard Text list.
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Note that you can only add one text item per transmittal.

To access the Transmittal Standard Text Maintenance dialog box, do the
following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Project Management --> Transmittal Standard
Text Maintenance .

See any of the following sets of instructions according to your needs.

Create a text item

1. Click New.

2. In the Description field, type a name for the text item. 

This name will appear in the Standard Text list of the Transmittals
dialog box.

3. In the Standard Text field, type the text that you want to include in the
text item.

4. Click Add.

Modify a text item

1. In the list, select the text item that you want to modify.

2. Modify the description and text according to your needs.

3. Click Edit to save the changes.

Delete a text item

Note that deleting a standard text item is permanent and cannot be undone.

1. In the list, select the text item that you want to delete.

2. Click Delete.

3. To permanently delete the text item, click Yes in the confirmation dialog
box.

Manage drawing logs
You can add your own drawing logs for different drawing types, such as
general arrangement drawings or part drawings. You can also modify existing
drawing logs, or delete unnecessary drawing logs from Tekla EPM.

Note that the drawing logs that you set up are available for all new project
management jobs. If you need to adjust the drawing logs used in an existing
project management job, see Adjust project-specific drawing settings and
drawing logs (page 539).

To start managing drawing logs:
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1. Click the Maintenance ribbon tab.

2. On the menu, select Project Management --> Global Drawing Log
Maintenance.

The Drawing Log Maintenance dialog box opens.

Add a drawing log
1. At the bottom of the Drawing Log Maintenance dialog box, click New.

2. In the Drawing Type field, type the drawing type.

3. In the Drawing Log Name field, type a name for the drawing log.

4. In the PDC Link list, select the field in Production Control to which the
drawings are connected. 

Note that the PDC Link setting only applies to drawing log types with
assemblies or materials that have counterparts in Production Control.

5. In the Subdirectory Path field, type the path to the sub-folder under the
drawing default folder where the drawings in that drawing log are stored. 

Manage projects 526 Set up the Project Management module



For example, type Detail\Erection drawings
The default folder for storing drawings is set in the dialog box (page 69).

6. In the Drawing Log Mapping field, type which drawing types to direct to
the selected drawing log. 

Tekla EPM determines the drawing log where imported drawings are
stored based on the drawing types assigned to the drawings in the XML
file created with Tekla EPM Plugin for Tekla Structures, or with the Data
Transfer tool in SDS/2. By default, the drawing types in Tekla EPM match
the drawing types in Tekla Structures.

Note that you need to type each drawing type on a separate line.

7. Click Add.

Modify a drawing log
1. In the Drawing Log Maintenance dialog box, select the drawing log that

you want to modify.

2. Change the drawing log settings according to your needs.

3. Click Save.

Delete a drawing log
1. In the Drawing Log Maintenance dialog box, select the drawing log that

you want to delete.

2. Click Delete.

3. To permanently delete the drawing log, click Yes.

View, print, or export project reports
Use the Project Reports command to create reports that contain information
from a group of project management jobs. You can either view or print the
reports, or export the reports to another file format.

Create a project report
1. Click the Maintenance ribbon tab.

2. On the menu, select Project Management --> Project Reports .

3. In the Select Project dialog box, click the arrow buttons to move the
projects that you want to include in the report to the Included list.

4. To only include particular types of items in the report, in the Project
Management Report Filters dialog box, select a filter type in the Type
list, and click Select.
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5. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the items that you want to include to
the Included list.

• Type the maximum and minimum values for the items that you want
to include.

6. Click OK.

7. In the Report On section of the dialog box, select check boxes on the right
side of the information for which you want to create reports. 

For example, to create a drawing list, select the Drawings check box.

8. Click Make Report.

9. In the Report Selection dialog box, select the report that you want to
create.

View the report
• In the Report Selection dialog box, click View.

The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
EPM Report Viewer window to email the report via Microsoft Outlook.

Print the report
1. In the Report Selection dialog box, change the number of the printed

copies by clicking the + and - buttons.

2. Click Print.

3. To confirm printing the report, click Yes in the confirmation dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the report
1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Browse to the location where you want to save the exported file, and click
Save.

5. Modify the file name according to your needs.
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6. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email check box.

7. To open the file after exporting it, select the Open Exported Document
check box.

8. In the Report Selection dialog box, click Export.

8.2 Open the Project Management module
To start adding and modifying the information in a project, you need to open
the Project Management module:

• At the top of the Tekla EPM window, click the Project Management
button.

The Select Project Management Job dialog box opens.

NOTE Jobs whose statuses are set to Closed are not shown by default. To
show closed jobs, select the Show Closed Jobs check box.

Next, you can:

• View, add, and modify task list reminders.

• Create a new project management job.
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• Open or modify an existing project management job.

• Attach document to a project management job in Document Index.

• View and modify the project schedule of the selected project management
jobs.

See also

Create a project management job (page 530)

Open a project management job (page 532)

Store document references for a project management job (page 534)

Manage and assign project tasks (page 536)

View and adjust the project schedule (page 613)

Create a project management job
To create a project management job, do the following:

1. At the top of the Tekla EPM window, click the Project Management
button.

2. In the Select Project Management Job dialog box, click Add. 

3. At the top of the Project Edit: [New] dialog box, define the properties of
the new job. 

The properties marked with an asterisk (*) are mandatory.

Option Description
Job Number * The job name.

Type a suitable name in the Job Number field.
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Option Description
Job Date The job date. Tekla EPM automatically uses the

current date.

For example, you can select the date when your
company received the job, or the shipping date.

The job date is used as the initial start date of the
project in the project schedule.

Click the arrow on the right side of Job Date field,
and select a date in the calendar.

Job Description Any description of the job.

Type a description in the Job Description field.
Location The city or town of the project management job.

Type the appropriate location in the Location field.
Customer PO # The purchase order number of the customer

company, or the contract number.

Type the number in the Customer PO # field.
Job Status The job status shows whether the job is still in

progress (Open) or already closed (Closed).

In the Select Project Management Job dialog box,
you can choose to show only open jobs by clearing
the Show Closed Jobs check box.

ERP Job # The accounting system job number.

Typing the accounting system job number in the
ERP Job # field allows you to link material items
properly when you export information to an
accounting system, such as Trimble Viewpoint.

Job Group The job groups to which the current project
management job belongs.

Click the arrows on the right side of the Job Group
fields and select existing job groups in the list, or
type new job groups directly in the fields.

4. If necessary, modify the drawing settings of the new job:

a. Click the Drawing Setups button.

b. In the Drawing Setup dialog box, modify the drawing settings
according to your needs. 

NOTE The Drawing Number Input Type needs to be the same in
the project management job and the related production
control jobs.
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c. Click OK.

5. In the Project Contacts section, add all companies related to the new job
and their contact persons:

a. Click Add Contact.

b. In the Contact Properties dialog box, select the company type in the
Type list.

c. Do any of the following: 

To Do this
Add a company that has
been saved in the
Address Book

• In the Name list, select the company.

Add a new company 1. In the Name field, type the name of the new
company.

2. Press Enter on the keyboard.

3. To add the new company in the Address
Book, click Yes.

Note that you need to add the contacts for the new
company manually. To do so, click Edit on the right
side of the Name field. For detailed instructions,
see Manage companies in the project (page 556).

d. If necessary, type the title of your contact person in the Title field. 

For example, there might be a billing contact, a project manager, a
project engineer, and a site supervisor within the same company.

e. In the Ship To Address and Bill To Address lists, select the right
shipping and billing addresses.

f. In the Contact list, select the contact that you want to add. 

Note that the contact needs to be saved in the Address Book.

g. Click OK.

Repeat steps a to g for all companies that you want to add to the project.

6. Click Save to create the job.

You can now open the new project management job (page 532) and start
modifying it.

Note that you can link a project management job to a matching production
control job.

Open a project management job
To open a project management job:
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1. At the top of the Tekla EPM window, click the Project Management
button.

2. In the Select Project Management Job dialog box, select the job that you
want to open. 

NOTE Jobs whose statuses are set to Closed are not shown by default.
To show closed jobs, select the Show Closed Jobs check box.

3. Double-click the job, or click Open.
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The Project Management dialog box opens.

On the Project Settings tab, you can adjust the project details and contacts.

On the Summary tab, you can see an overview of the different areas in the
project.

You can start managing different project areas on either tab.

See also

Manage drawings (page 537)

Manage transmittals (page 558)

Manage requests for information (page 572)

Manage the project journal (page 587)

Manage change orders (page 594)

Manage the project task list (page 604)

Manage the project check list (page 608)

Manage contract and invoicing information (page 657)

View, print, or export the project summary (page 671)

Store document references for a project management job
Document Index is where you can store documents for reference. When you
store documents in Document Index, each user who has access to the project
management job can view them, so it is easy to keep up to date on the project.
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You can save any documents, as well as Microsoft Outlook emails, in
Document Index.

Note that all project management jobs have their own document references.

To access Document Index, do the following:

1. In the Select Project Management Job dialog box, select the job whose
document references you want to view or modify.

2. Click Document Index, or press F8.

The Document Index dialog box opens. Next, you can either modify the
available folders for document references, or add, modify, delete, open, and
email document reference files.

See also

Manage document reference categories (page 389)

Open a document reference (page 394)

Add document references (page 391)

Modify a document reference (page 395)

Attach a document reference to an email (page 396)

Delete a document reference (page 396)

8.3 Add and modify project information
You can add different types of information for projects, including drawings,
transmittals, requests for information (RFIs), journal entries, change orders,
tasks, and check lists. You can also modify the existing project information
according to your needs.

For more information, see the following links:

Manage and assign project tasks (page 536)

Manage companies in the project (page 556)

Manage drawings (page 537)

Manage transmittals (page 558)

Manage requests for information (page 572)

Manage the project journal (page 587)

Manage change orders (page 594)

Manage the project task list (page 604)

Manage the project check list (page 608)

Manage projects 535 Add and modify project information



Manage and assign project tasks
In the Task List Reminders dialog box, you can view all existing tasks in the
selected project and assign project tasks to Tekla EPM users. You can also
manage the project tasks according to your needs: add new tasks, and modify
or delete project tasks. Check list items can also be moved to the task list and
assigned to users.

To access the Task List Reminders dialog box, do the following:

1. In the lower-left corner of the Select Project Management Job dialog
box, click Task List Reminders.

The Task List Reminders dialog box opens, displaying the existing project
tasks.

According to your needs, see any of the following sets of instructions.

Create a project task
1. Click New.

2. Click the arrow on the right side of Job Number list and select a project
management job in the list.

3. Click the arrow on the right side of Author list and select the creator of
the project task in the list. 

The list contains all Tekla EPM users in your company.

4. Click the arrow on the right side of Assigned To list and select the user to
which you want to assign the task. 
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The list contains all Tekla EPM users in your company.

When a task has been assigned to a user, the Task List Reminders dialog
box automatically opens when the user signs in to Tekla EPM. When the
task is marked as completed, the Task List Reminders dialog box no
longer opens when the user signs in.

5. Click the arrow on the right side of Date Required list, and select the
deadline of the task in the calendar.

6. If necessary, click the arrow on the right side of the Date Completed list,
and select the date when the task was completed. 

Tekla EPM records the date and time when each task is completed.

7. Type a description for the task.

8. Click Add.

Modify a project task
You might need to modify an existing task later. For example, you can assign
the task to a different Tekla EPM user, or mark the task as completed.

1. In the list, select the project task that you want to modify.

2. Modify the job number, author, assignee, date required, date completed,
and description according to your needs.

3. Click Save.

Delete a project task
Note that deleting a project task is permanent and cannot be undone.

1. In the list, select the project task that you want to delete.

2. Click Delete.

3. To permanently delete the task, click Yes in the confirmation dialog box.

Manage drawings
You can store several types of drawings within the drawing logs in your project
management jobs. You can create customized drawing logs, add drawings,
search for and filter drawings, view or print drawings, create drawing reports,
and so on.

To open a drawing log:
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1. On the right side of an open project management job, click Drawing Log.

2. In the context menu, select which drawing log you want to open.

The All Drawing Logs option lists all drawings that are stored in any
drawing log.

The selected drawing log opens.

For more information, see the following links:

Adjust project-specific drawing settings and drawing logs (page 539)

Find a drawing (page 542)

Add, modify, and delete drawings (page 543)

Add, modify, and delete drawing revisions (page 548)

View a drawing (page 551)

Copy drawing files to another location (page 552)
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Add multiple drawings to a drawing log (page 545)

Modify multiple drawings (page 547)

Update the links to a drawing log (page 554)

Print drawings (page 553)

View the issue history of selected drawings (page 554)

View, print, or export drawing reports (page 554)

Adjust project-specific drawing settings and drawing logs
In the Drawing Setup dialog box, you can adjust the drawing settings related
to the current project management job. In addition, you can add, modify, and
remove drawing logs that are used in the project management job.

To manage project-specific drawing settings and drawing logs:

1. On the Project Settings tab of an open project management job, click
Drawing Setups.

The Drawing Setup dialog box opens.

Use the Drawing Settings tab to adjust the project drawing settings.
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Use the Drawing Logs tab to add, modify, and delete drawing logs.

Note that the changes that you make in the Drawing Setup dialog box are
only saved for the current project management job.

Adjust project drawing settings

1. On the Drawing Settings tab, adjust any of the following settings: 

Option Description
Drawing Number Input Type Allows you to select the input format

for drawing numbers.

Select a suitable option in the
Drawing Number Input Type list.

Drawing File Prefix By default, Tekla EPM expects that the
names of drawing files match the
drawing numbers. The Drawing File
Prefix option allows you to determine
the prefix that appears in the names
of all drawing files that are imported.

Determining a drawing file prefix is
optional. However, the drawing file
prefix can help you to ensure that the
correct files are imported from the
selected folder.

For example, drawing files might
consist of the job number followed by
a dash and the drawing number. In
this case, drawing 100 could be
named C12345-100.pdf. In
consequence, the drawing file prefix
would be C12345-.

If the drawing file prefix varies, you
can use an asterisk (*) as a wildcard.
For example, if the prefix of some
drawing files that you want to import
was not C12345, you could set the
drawing file prefix to *-.

Type the prefix in the Drawing File
Prefix field.

Drawing File Suffix By default, Tekla EPM expects that the
names of drawing files match the
drawing numbers. The Drawing File
Suffix option allows you to determine
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Option Description
the suffix that appears in the names
of all drawing files that are imported.

Determining a drawing file suffix is
optional. However, the drawing file
suffix can help you to ensure that the
correct files are imported from the
selected folder.

For example, drawing files might
include a revision number after the
drawing number. In this case, the file
name of the first revision of drawing
100 could be C12345-100-r1.pdf.
In consequence, the drawing file
suffix would be -r1. Note that the file
name extension is not included in the
drawing file suffix.

If the drawing file suffix varies, you
can use an asterisk (*) as a wildcard.
For example, if some drawing files
had different revision numbers, you
could set the drawing file suffix to -
r*.

Type the suffix in the Drawing File
Suffix field.

Update Production Control
Approval Status

When selected, the approval statuses
of production control items that
correspond to drawings in the project
management job are automatically
updated when the drawing approval
statuses are updated.

When cleared, the approval statuses
of production control items need to
be updated manually.

2. If necessary, manage the project-specific drawing logs on the Drawing
Logs tab.

3. To save the settings and close the dialog box, click OK.

Add a drawing log

1. On the Drawing Logs tab, click New.

2. In the Drawing Type field, type the drawing type.

3. In the Drawing Log Name field, type a name for the drawing log.
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4. In the PDC Link list, select the field in Production Control to which the
drawings are connected. 

Note that the PDC Link setting only applies to drawing log types with
assemblies or materials that have counterparts in Production Control.

5. In the Subdirectory Path field, type the path to the sub-folder under the
drawing default folder where the drawings in that drawing log are stored. 

For example, type Detail\Erection drawings
The default folder for storing drawings is set in the Default Directories
dialog box.

6. In the Drawing Log Mapping field, type which drawing types should be
directed to the selected drawing log. 

Tekla EPM determines the drawing log where imported drawings are
stored based on the drawing types assigned to the drawings in the XML
file created with Tekla EPM Plugin for Tekla Structures, or with the Data
Transfer tool in SDS/2. By default, the drawing types in Tekla EPM match
the drawing types in Tekla Structures.

Note that you need to type each drawing type on a separate line.

7. Click Add.

Modify a drawing log

1. On the Drawing Logs tab, select the drawing log that you want to modify.

2. Change the drawing log settings according to your needs.

3. Click Save.

The changes are saved to the current project management job.

Delete a drawing log

1. On the Drawing Logs tab, select the drawing log that you want to delete.

2. Click Delete.

3. To permanently delete the drawing log from the current project
management job, click Yes.

Find a drawing
Use the Find Drawing command to quickly find the desired drawing.

1. On the right side of an open project management job, click Drawing Log.
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2. In the context menu, select the drawing log in which the drawing is stored.

Note that the All Drawing Logs option opens a drawing log that lists all
drawings that you have added, so if you select that option, you can find
any drawing regardless of the drawing log where the drawing is stored.

3. In the open drawing log, click the Drawing Log ribbon tab.

4. On the menu, select Find Drawing.

5. In the Enter Value dialog box, click the arrow on the right side of the
Select drawing # field.

6. Start typing the drawing number in the Select drawing # field. 

Tekla EPM suggests drawings whose drawing numbers start in the same
way.

7. Press Enter to use the suggested drawing number.

8. Click OK, or press Enter again.

Tekla EPM selects the related drawing in the current drawing log.

If the related drawing is in the drawing log that is not currently open, Tekla
EPM will not find the drawing.

Add, modify, and delete drawings
Use drawing logs to manage and save the project drawings or PDF files. You
can add, modify, and delete drawings, or view the files attached to the stored
drawings. You can also attach drawings to transmittals and send them to
project parties.

To access drawing logs:

1. On the right side of an open project management job, click Drawing Log.

2. In the context menu, select the drawing log.

Note that the All Drawing Logs option opens a drawing log that lists all
drawings that you have added, so if you select that option, you can find
any drawing regardless of the drawing log where the drawing is stored.

Add a drawing

By following these instructions, you can add one drawing at a time. To add
multiple drawings at one go and attach files to the drawings while adding
them, see Add multiple drawings to a drawing log (page 545).

Note that the available input fields in the drawing log depend on the set input
fields.

1. Click New. 

The drawing number field is automatically populated with the next
available number.
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2. Modify the drawing number according to your needs. 

The drawing number can contain a maximum of 25 characters, depending
on the Mark Input Type option that you have selected in the Project
Company Standards dialog box.

3. Enter the drawing properties: 

Option Description
Description A written description of the drawing.

The description can contain a
maximum of 255 characters.

Approval Status The approval status of the drawing.
The available options are set in
Approval Status Maintenance.

Detailed By The person who has detailed the
drawing.

Drawing Date The date when the drawing has been
created.

Date Received The date when the drawing has been
received.

Category A category that can be used for
filtering drawings in the drawing log.
For example, you can create
categories for architectural or
structural drawings. You can then use
the drawing categories to filter which
drawings are visible in the drawing
log.

You can either select a category in the
Category list, or type a new category
in the Category field.

Re-Submit If you are re-submitting a drawing for
approval, select the Re-Submit check
box.

If you are submitting the drawing for
the first time, ensure that the Re-
Submit is not selected.

Issue Date The shop issue date of the drawing.
Package # The package number of the drawing.
Orig Rel# The original release number of the

drawing.
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4. Click Add.

The correct drawing file will automatically be attached to the drawing when it
is added to the default drawing folder (page 69) (by default, C:\Users
\Public\Documents\Tekla EPM\Drawing) in the correct job folder and
revision folder.

Modify a drawing

1. In the list, select the drawing that you want to modify.

2. On the right side of the dialog box, modify the drawing properties
according to your needs. 

To add revisions, see Add, modify, and delete drawing revisions
(page 548).

3. Click Save.

Delete a drawing

Note that deleting a drawing is permanent and cannot be undone.

1. In the list, select the drawing that you want to delete.

2. Click Delete.

3. To permanently delete the drawing, click Yes in the confirmation dialog
box.

Add multiple drawings to a drawing log
You can add multiple drawings at one go to any one of your drawing logs. Use
the Batch Insert command to add multiple drawings without attachments, or
the Batch Insert - From Files command to add multiple drawings with PDF
attachments.

To access drawing logs:

1. On the right side of an open project management job, click Drawing Log.

2. In the context menu, select the drawing log.

Note that the All Drawing Logs option opens a drawing log that lists all
drawings that you have added. If you select the All Drawing Logs option,
you can add drawings to any drawing log.

Add a batch of drawings without PDF attachments to a drawing log

1. In the open drawing log, click the Drawing Log ribbon tab.

2. On the menu, select Batch Insert.

3. In the Insert Drawings dialog box, go to the Add Range tab.

4. Enter the prefix and suffix of the drawing file names to be added. For
example, if your project name was C23847, the revision number was 1,
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and the drawing number was 100, your drawing name could be 
C23487-100-r1.pdf. In this drawing name, the file prefix would be 
C23847-, and the file suffix would be -r1. Note that the file extension is
not part of the file suffix.

5. In the Start Number field, type the number of the first drawing that you
want to add.

6. In the End Number field, type the number of the last drawing that you
want to add.

7. Define other properties for the drawings according to your needs.

8. Click Add.

The drawings are added to the drawing log.

Note that you will need to add any PDF attachments to the drawings manually.

Add drawings with PDF attachments to a drawing log

1. In the open drawing log, click the Drawing Log ribbon tab.

2. On the menu, select Batch Insert - From Files.

3. On the menu, select Batch Insert.

4. In the Insert Drawings dialog box, go to one of the following tabs: 

• To add all drawings with a particular prefix and suffix, go to the Add
Drawings tab.

• To add revisions to particular drawings, go to the Add Revisions tab.

5. On the right side of the Directory field, click ...

6. In the Browse For Folder dialog box, select the folder from which you
want to import the attachments.

7. Click OK.

8. To save copies of the drawings in the \Tekla EPM Documents\Drawing
folder, select the Copy Files into Drawing Directory check box. 

By copying the drawings to the \Tekla EPM Documents\Drawing
folder, you can ensure that Tekla EPM always finds the attached files, even
if you change their location on your computer.

9. Enter the prefix and suffix of the drawing file names to be added. For
example, if your project name was C23847, the revision number was 1,
and the drawing number was 100, your drawing name could be 
C23487-100-r1.pdf. In this drawing name, the file prefix would be 
C23847-, and the file suffix would be -r1. Note that the file extension is
not part of the file suffix.

10. Define other properties for the drawings according to your needs.
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11. Click Add From Files.

The drawings and their attachments are added to the drawing log. Notice that
Yes appears in the File column for each drawing, indicating that the drawings
have PDF files attached to them.

Modify multiple drawings
You can modify the properties of multiple drawings at one go with the Global
Edit command. You can modify all drawings, specific types of drawings, or the
drawings that are currently selected in the drawing log.

Modify all or specific types of drawings

1. On the right side of an open project management job, click Drawing Log.

2. In the context menu, select the drawing log in which the drawing is stored.

Note that the All Drawing Logs option opens a drawing log that lists all
drawings that you have added.

3. In the open drawing log, click the Drawing Log ribbon tab.

4. On the menu, select Global Edit.

5. To only modify specific types of drawings, in the Drawing Log Global Edit
Filters dialog box, select a filter type in the Type list, and click Select.

6. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the drawings that you want to modify
to the Included list.

• Type the maximum and minimum values for the drawings that you
want to modify.

For example, define the earliest and latest revision date for the
drawings.

7. Click OK to apply the filter. 

To further limit the drawing types that you want to modify, repeat steps 5
to 7 for all necessary filter types.

8. At the bottom of the Drawing Log Global Edit Filters dialog box, click OK.

9. In the Global Edit dialog box, select check boxes next to the properties
that you want to update.

10. Modify the selected properties in the Global Edit dialog box according to
your needs. 

For example, change the approval status, or select another drawing date.

11. Click OK.
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12. To confirm the changes that you made, click Yes in the confirmation
dialog box.

The modified drawing properties are updated in the drawing log.

Modify the selected drawings

1. On the right side of an open project management job, click Drawing Log.

2. In the context menu, select the drawing log in which the drawing is stored.

Note that the All Drawing Logs option opens a drawing log that lists all
drawings that you have added.

3. In the open drawing log, select the drawings that you want to modify. 

To select multiple drawings, hold down Ctrl.

To select a range of subsequent drawings, hold down Shift.

4. Click the Drawing Log ribbon tab.

5. On the menu, select Global Edit Selected.

6. In the Global Edit dialog box, select check boxes next to the properties
that you want to update.

7. Modify the selected properties in the Global Edit dialog box according to
your needs. 

For example, change the approval status or select another drawing date.

8. Click OK.

The modified drawing properties are updated in the drawing log.

Add, modify, and delete drawing revisions
You can add revisions for your drawings in any one of your drawing logs. You
can also modify existing revisions according to your needs, or delete
unnecessary revisions.

Add a single drawing revision

To add multiple drawing revisions, see Add multiple drawings to a drawing log
(page 545).

1. On the right side of an open project management job, click Drawing Log.

2. In the context menu, select the drawing log in which the drawing is stored.

Note that the All Drawing Logs option opens a drawing log that lists all
drawings that you have added, so you can add revisions to any drawing.

3. In the drawing list, select the drawing for which you want to add a
revision.

4. At the bottom of the drawing log, click Add Revision.
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5. In the Drawing Revisions dialog box, click New.

6. Type the revision number and a description of the revision.

7. Type appropriate names in the Revised By and Checked By fields.

8. Click the arrow on the right side of Date Revised and Date Received
fields, and select dates in the calendars.

9. Click the arrow on the right side of Date Checked field, and select a date
in the calendar.

10. Type a release number for the revision.

11. Click Save to add the revision.

The new drawing revision is added to the revision list. You can view the details
of all of the drawing's revisions by clicking Revision Details.

Note that because you did not attach a PDF file to the drawing revision, the
File column says No. If a PDF file has been attached to the drawing revision,
the File column has Yes in it, and you can double-click the drawing to view the
attached PDF file.

The correct PDF file will automatically be attached to the revision when it is
added to the default drawing folder (by default, C:\Users\Public
\Documents\Tekla EPM\Drawing) in the correct job folder and revision
folder.

Modify a drawing revision

Note that you can only modify one drawing revision for one drawing at a time.

1. On the right side of an open project management job, click Drawing Log.

2. In the context menu, select the drawing log in which the drawing is stored.

Note that the All Drawing Logs option opens a drawing log that lists all
drawings that you have added, so you can modify the revisions of any
drawing.

3. In the drawing list, select the drawing whose revisions you want to modify.

4. At the bottom of the drawing log, click Revision Details.

5. In the Drawing Revisions dialog box, select the revision that you want to
modify.

6. Modify the revision properties according to your needs.

7. Click Save to save the changes.

Modify multiple drawing revisions

1. On the right side of an open project management job, click Drawing Log.
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2. In the context menu, select the drawing log in which the drawings are
stored. 

Note that the All Drawing Logs option opens a drawing log that lists all
drawings that you have added, so you can modify the revisions of any
drawing.

3. In the drawing log, select the drawings whose revisions you want to
modify. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

4. Click the Drawing Log ribbon tab.

5. In the menu, select Global Edit Revisions.

6. In the Global Edit - Revisions dialog box, select which revisions you want
to update: 

• To update all revisions of the selected drawing, select Update All
Revisions.

• To update the latest revision of the selected drawing, select Update
Latest Revision.

• To update a particular revision number, select Update Revision #, and
type the revision number in the Revision # field.

7. Select the check boxes next to the properties that you want to update.

8. Modify the selected properties according to your needs. 

For example, select a Date Checked date and type a name in the
Checked By field.

9. Click Update.

Delete a drawing revision

Note that deleting a drawing revision is permanent and cannot be undone.

1. On the right side of an open project management job, click Drawing Log.

2. In the context menu, select the drawing log in which the drawing is stored.

Note that the All Drawing Logs option opens a drawing log that lists all
drawings that you have added, so you can modify the revisions to any
drawing.

3. In the drawing list, select the drawing whose revisions you want to modify.

4. At the bottom of the drawing log, click Revision Details.

5. In the Drawing Revisions dialog box, select the revision that you want to
delete.

6. Click Delete.
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7. To permanently delete the selected revision, click Yes in the confirmation
dialog box.

Delete multiple drawing revisions

1. On the right side of an open project management job, click Drawing Log.

2. In the context menu, select the drawing log in which the drawings are
stored. 

Note that the All Drawing Logs option opens a drawing log that lists all
drawings that you have added, so you can modify the revisions of any
drawing.

3. In the drawing log, select the drawings whose revisions you want to
delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

4. Click the Drawing Log ribbon tab.

5. In the menu, select Delete Revisions.

6. In the Delete Drawing Revision - Batch dialog box, select one of the
following options: 

• To delete the latest revisions of the selected drawings, select Delete
Latest Revision.

• To delete particular revisions of the selected drawings, select Delete
Revision #, and type the revision number in the Revision # field.

7. Click Delete.

8. To permanently delete the revisions, click Yes.

View a drawing
Use the Drawing Files command to open and view a specific drawing. Note
that only drawings that have files attached to them can be viewed.

1. On the right side of an open project management job, click Drawing Log.

2. In the context menu, select the drawing log in which the drawing is stored.

3. In the drawing log, select the drawing.

4. Do one of the following:

• Double-click the drawing.

• Click the Drawing Log ribbon tab, and in the menu, select Drawing
Files.

Manage projects 551 Add and modify project information



5. If the file has multiple revisions, in the Files dialog box, click the arrow on
the right side of the Revision list and select the revision that you want to
open. 

If you double-clicked a drawing to open it, the latest revision of the
selected drawing is automatically opened.

6. Click OK to open the drawing.

Copy drawing files to another location
Use the Copy Drawing Files and Copy Drawing Files - Selected commands to
copy the attached drawing files to another location, so that they can be issued
to the shop or field, or be printed.

To open a drawing log:

1. On the right side of an open project management job, click Drawing Log.

2. In the context menu, select the drawing log whose attached files you want
to copy. 

Note that the All Drawing Logs option opens a drawing log that lists all
drawings that you have added, so if you select that option, you can copy
any drawing files regardless of the drawing log where they are stored.

Copy all drawing files in the current drawing log

1. In the open drawing log, click the Drawing Log ribbon tab.

2. On the menu, select Copy Drawing Files.

3. To only copy particular drawing files, in the Copy Files Filter dialog box,
select a filter type in the Type list, and click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type: 

• Click the arrow buttons to move the drawings whose attached files you
want to copy to the Included list.

• Type the maximum and minimum values for the drawings whose
attached files you want to copy.

5. Click OK.

6. In the Browse For Folder dialog box, browse to and select the folder
where you want to copy the drawing files. 

The default location is the drawing default folder that has been set in the
Default Directories dialog box.

7. Click OK. 

The file-list text file opens in Microsoft Notepad, showing the drawing
files that were copied to the selected location.
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8. Ensure that all necessary drawings and files are listed in the file-list
text file.

9. To close Microsoft Notepad and return to the drawing log, click the Close
button (X) in the upper-right corner.

Copy drawing files attached to the selected drawings

1. In the open drawing log, select the drawings whose attached files you
want to copy. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Drawing Log ribbon tab.

3. On the menu, select Copy Drawing Files - Selected.

4. In the Browse For Folder dialog box, browse to and select the folder
where you want to copy the drawing files. 

The default location is the drawing default folder that has been set in the
Default Directories dialog box.

5. Click OK. 

The file-list text file opens in Microsoft Notepad, showing the drawing
files that were copied to the selected location.

6. Ensure that all necessary drawings and files are listed in the file-list
text file.

7. To close Microsoft Notepad and return to the drawing log, click the Close
button (X) in the upper-right corner.

Print drawings
Use the Print Drawings - Selected command to print one or multiple
drawings that are stored in a drawing log. Note that you can only print
drawings that have attached files.

1. In the open drawing log, select the drawings that you want to print. 

To select multiple drawings, hold down Ctrl.

To select a range of subsequent drawings, hold down Shift.

2. Click the Drawing Log ribbon tab.

3. On the menu, select Print Drawings - Selected.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

6. In the Enter Value dialog box, type the number of the printed copies.

7. Click OK to print the drawings.
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Update the links to a drawing log
Use the Refresh command to update the links to the drawing log. If you have
recently attached files to drawings manually, you can also use the Refresh
command to see the newly attached files in the drawing log. The attached files
are also updated when you close and re-open a drawing log.

1. On the right side of an open project management job, click Drawing Log.

2. In the context menu, select the drawing log. 

Note that the All Drawing Logs option opens a drawing log that lists all
drawings that you have added.

3. In the open drawing log, click the Drawing Log ribbon tab.

4. On the menu, select Refresh.

The links to the current drawing log are updated.

View the issue history of selected drawings
Use the Issue History - Selected command to view the entire activity history
of the selected drawings. Among other things, the issue history shows the
transmittals in which the drawings are included.

1. On the right side of an open project management job, click Drawing Log.

2. In the context menu, select the drawing log in which the drawings are
stored. 

Note that the All Drawing Logs option opens a drawing log that lists all
drawings that you have added.

3. In the open drawing log, select the drawings.

4. Click the Drawing Log ribbon tab.

5. On the menu, select Issue History - Selected.

6. In the Drawing Issue History dialog box, view the activity of the selected
drawings.

7. To close the dialog box, click the Close button (X) in the upper-right
corner.

View, print, or export drawing reports
You can create reports based on the information in drawing logs. For example,
you can create a drawing list, or a report on the drawing issue history. You can
then view, print, or export the created reports. Use the Reports command to
create a report on all drawings in the drawing log or on the drawings that
match specific filters, or use the Reports - Selected command to create a
report on the drawings that you select in the drawing log.
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Create a drawing report

1. On the right side of an open project management job, click Drawing Log.

2. In the context menu, select the drawing log whose information you want
to include in the report. 

Note that the All Drawing Logs option opens a drawing log that contains
the information of all drawings that you have added.

3. In the drawing log, do one of the following: 

To Do this
Create reports on all
drawings or on specific
drawing types

a. Click the Drawing Log ribbon tab.

b. On the menu, select Reports.

c. To only create drawing reports, at the bottom
of the Project Management Report Filters
dialog box, ensure that only the Drawings
check box is selected.

d. To only include specific types of drawings in
the reports, in the Project Management
Report Filters dialog box, select a filter type in
the Type list, and click Select.

e. In the Filter dialog box, do one of the
following depending on the filter type:

• Click the arrow buttons to move the
drawing properties that you want to
include in the report to the Included list.

• Type the maximum and minimum values
for the drawings that you want to include.

f. Click OK.

To further limit the types of drawings that are
included in the reports, repeat steps c to f for
all necessary filter types.

g. Click Make Report.
Create reports on the
currently selected
drawings

a. In the drawing log, select the drawings that
you want to include in the reports.

To select multiple items, hold down Ctrl.

To select a range of subsequent drawings,
hold down Shift.

b. Click the Drawing Log ribbon tab.

c. On the menu, select Reports - Selected.

4. In the Report Selection dialog box, select the report that you want to
view, print, or export.
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View the drawing report

• In the Report Selection dialog box, click View.

The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
EPM Report Viewer window to email the report via Microsoft Outlook.

Print the drawing report

1. In the Report Selection dialog box, change the number of the printed
copies by clicking the + and - buttons.

2. Click Print.

3. To confirm printing the report, click Yes in the confirmation dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the drawing report

1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Browse to the location where you want to save the exported file, and click
Save.

5. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email check box.

6. To open the file after exporting it, select the Open Exported Document
check box.

7. In the Report Selection dialog box, click Export.

Manage companies in the project
To share project information with the other parties of the project, you need to
add the parties to the project management job. Use the Add Contact
command to add the necessary companies and contacts to the project. You
can also modify the existing companies and contact persons, or remove any
unnecessary companies from the project.
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Add a company contact
1. In the Project Contacts section of the Project dialog box, click Add

Contact.

2. In the Contact Properties dialog box, select the company type in the
Type list.

3. Do any of the following: 

To Do this
Add a company that has
been saved in the
Address Book

• In the Name list, select the company.

Add a new company a. In the Name field, type the name of the new
company.

b. Press Enter on the keyboard.

c. To add the new company in the Address
Book, click Yes.

Note that you need to add the contacts for the new
company manually. To do so, click Edit on the right
side of the Name field. For detailed instructions,
see Add contacts to the address book (page 173).

4. If necessary, type the title of your contact person in the Title field.

5. In the Ship To Address and Bill To Address lists, select the right shipping
and billing addresses.
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6. In the Contact list, select the contact that you want to add. 

Note that the contact needs to be saved in the Address Book.

7. Click OK.

Modify a contact
1. In the Project Contacts section of the Project dialog box, select the

contact.

2. Click Properties.

3. If necessary, change the company by selecting another company in the
Name list.

4. If necessary, change the title of your contact person in the Title field.

5. In the Ship To Address and Bill To Address lists, select the right shipping
and billing addresses.

6. In the Contact list, select the contact person that you want to use. 

Note that the contact needs to be saved in the Address Book.

If you want to change the contact details of a contact person, you need to
do so in the Address Book.

7. Click OK.

Remove a company from the project
Removing a company from the project is permanent and cannot be undone. If
you remove a company, you will no longer be able to send project documents
to the company.

1. In the Project Contacts section of the Project dialog box, select the
contact.

2. Click Remove Contact.

3. To permanently delete the contact from this project, click Yes.

Manage transmittals
Transmittals are cover sheets to which drawings can be attached in order to
be sent. Tekla EPM records the time when a drawing has been issued and is to
be returned, and marks drawings that are overdue or outstanding.

To access the Transmittal dialog box, do any of the following:

• On the right side of the Project dialog box, click the Transmittals button.

• On the Summary tab of the Project dialog box, click + in the upper-right
corner of the Transmittals section, and select which transmittals you want
to see.
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The Transmittal dialog box opens.

For more information, see the following links:

Create, modify, and delete transmittals (page 559)

View transmittals (page 567)

Print transmittals (page 568)

Mark drawings in a transmittal as received (page 569)

Send a transmittal via email (page 569)

Create, modify, and delete transmittals
Use the Transmittal dialog box to manage transmittals. You can create new
transmittals, attach drawings to transmittals, modify the properties of existing
transmittals, or delete unnecessary transmittals.
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Create a transmittal

1. At the bottom of the Transmittal dialog box, click New. 

The next available transmittal number is populated in the Transmittal #
field.

2. If necessary, modify the transmittal number.

3. Define the properties for the transmittal. 

The items that are marked with an asterisk (*) in the following table are
mandatory.

Option Description
Date * The date of the transmittal.

Click the arrow on the right side of the Date field,
and select the date in the calendar.

Recipient * The company and contact person that will receive
the transmittal once it is ready.

Note that the available companies and contact
persons are set in the Project Company
Standards dialog box.

Click the arrow on the right side of the leftmost
Recipient list, and select the recipient company in
the list.
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Option Description
Title * The title that will appear at the top of the

transmittal.

In the Title field, type a title for the transmittal.
Sending * Allows you to define how the drawings are sent to

the recipient.

Click the arrow on the right side of the Sending list,
and select one of the following options:

• Enclosed: the drawings are sent enclosed in the
transmittal.

• Under Separate Cover: the drawings are sent
under a separate cover.

Type * Allows you to define if the recipient needs to
return the drawings.

Click the arrow on the right side of the Type list,
and select one of the following options:

a. To Be Returned: the recipient needs to return
the drawings by a specific date.

b. For Issue Only: the recipient does not need to
return the drawings.

Items * The types of the items that are sent with the
transmittal. If necessary, you can select multiple
options.

The options are set in the Transmittal Item
Maintenance dialog box.

To add items to the transmittal, do the following:

a. Click the Items field.

b. In the Select Items dialog box, click the arrow
buttons to move the types of items to be
included in the transmittal to the Included list.

c. Click OK.
Purpose * The purposes of sending the transmittal. For

example, transmittals can be sent to be approved
or for pricing. If necessary, you can select multiple
purposes.

The options are set in the Transmittal Purpose
Maintenance dialog box.

The Select Purposes dialog box opens
automatically when you click OK in the Select
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Option Description
Items dialog box. In the dialog box, do the
following:

a. Click the arrow buttons to move the purposes
for sending the transmittal to the Included
list.

b. Click OK.
# of Prints The number of prints included in the transmittal.

Type a number in the # of Prints field.
Prints to Return If Type is set to To Be Returned, define the

number of prints to be returned.

Type a number in the Prints to Return field.
# of Sepias The number oincluded in the transmittal.

Type a number in the # of Sepias field.
Sepias to Return If Type is set to To Be Returned, define the

number of sepias to be returned.

Type a number in the Sepias to Return field.
Sent By The sender of the transmittal.

Do one of the following:

• Click the arrow on the right side of the Sent By
list, and select a previously defined sender in
the list.

• Type a new sender name in the Sent By field.

The name is saved and will be available for
future transmittals.

Copy To The people who receive a copy of the transmittal.

Do one of the following:

• Click the arrow on the right side of the Copy To
list, and select a previously defined name in the
list.

• Type a new name in the Sent By field.

The name is saved and will be available for
future transmittals.

Remarks Any remarks that you want to add to the
transmittal.

Type the remarks in the Remarks field.
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Option Description
Standard Text The text items that you want to include in the

transmittal. You can only select one option.

The text items are set in the Transmittal
Standard Text Maintenance dialog box.

Click the arrow on the right side of the Standard
Text list, and select an option in the list.

Return Date * If Type is set to To Be Returned, define the date
by which the drawings should be returned.

Remember to add a return date for returned
drawings, so that they do not appear as overdue.

Click the arrow on the right side of the Return
Date field, and select a date in the list.

4. To attach drawings to the new transmittal, do the following:

a. At the bottom of the dialog box, click Drawings.

b. At the bottom of the Transmittal Drawings dialog box, click Add
Drawings.

c. In the Add Transmittal Drawings dialog box, click the arrow buttons
to move the drawings that you want to attach to the Included list. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

d. Click Add.

e. To close the dialog box, click the Close button (X) in the upper-right
corner.

You can see the attached drawings in the lower-right corner of the
Transmittal dialog box.

5. Click Add.

Modify a transmittal

Modify a transmittal to change its properties. For example, you should add a
return date for returned drawings, so that they do not appear as overdue.

1. In the Transmittal dialog box, select the transmittal that you want to
modify.

2. Modify the properties for the transmittal. 
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The items that are marked with an asterisk (*) in the following table are
mandatory.

Option Description
Date * The date of the transmittal.

Click the arrow on the right side of the Date field,
and select the date in the calendar.

Recipient * The company and contact person that will receive
the transmittal once it is ready.

Note that only the companies that have been
added for the project in the Project Management
dialog box and their contact persons are available
in the Recipient lists.

Click the arrow on the right side of the leftmost
Recipient list, and select the recipient company in
the list.

Click the arrow on the right side of the rightmost
Recipient list, and select the contact person in the
list.

Title * The title that will appear at the top of the
transmittal.

In the Title field, type a title for the transmittal.
Sending * Allows you to define how the drawings are sent to

the recipient.

Click the arrow on the right side of the Sending list,
and select one of the following options:

• Enclosed: the drawings are sent enclosed in the
transmittal.

• Under Separate Cover: the drawings are sent
under a separate cover.

Type * Allows you to define if the recipient needs to
return the drawings.

Click the arrow on the right side of the Type list,
and select one of the following options:

a. To Be Returned: the recipient needs to return
the drawings by a specific date.

b. For Issue Only: the recipient does not need to
return the drawings.
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Option Description
Items * The types of the items that are sent with the

transmittal. You can select multiple options.

The options are set in the Transmittal Item
Maintenance dialog box.

To add items to the transmittal, do the following:

a. Click the Items field.

b. In the Select Items dialog box, click the arrow
buttons to move the types of items to be
included in the transmittal to the Included list.

c. Click OK.
Purpose The purposes of sending the transmittal. For

example, transmittals can be sent to be approved
or for pricing. If necessary, you can select multiple
purposes.

The options are set in the Transmittal Purpose
Maintenance dialog box.

The Select Purposes dialog box opens
automatically when you click OK in the Select
Items dialog box. In the dialog box, do the
following:

a. Click the arrow buttons to move the purposes
for sending the transmittal to the Included
list.

b. Click OK.
# of Prints The number of prints included in the transmittal.

Type a number in the # of Prints field.
Prints to Return If Type is set to To Be Returned, define the

number of prints to be returned.

Type a number in the Prints to Return field.
# of Sepias The number of prints included in the transmittal.

Type a number in the # of Sepias field.
Sepias to Return If Type is set to To Be Returned, define the

number of sepias to be returned.

Type a number in the Sepias to Return field.
Sent By The sender of the transmittal.

Do one of the following:

• Click the arrow on the right side of the Sent By
list, and select a previously defined sender in
the list.
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Option Description
• Type a new sender name in the Sent By field.

The name is saved and will be available for
future transmittals.

Copy To The people who receive a copy of the transmittal.

Do one of the following:

• Click the arrow on the right side of the Copy To
list, and select a previously defined name in the
list.

• Type a new name in the Sent By field.

The name is saved and will be available for
future transmittals.

Remarks Any remarks that you want to add to the
transmittal.

Type the remarks in the Remarks field.
Standard Text The text items that you want to include in the

transmittal. You can only select one option.

The text items are set in the Transmittal
Standard Text Maintenance dialog box.

Click the arrow on the right side of the Standard
Text list, and select an option in the list.

Return Date * If Type is set to To Be Returned, define the date
by which the drawings should be returned.

Remember to add a return date for returned
drawings, so that they do not appear as overdue.

Click the arrow on the right side of the Return
Date field, and select a date in the calendar.

3. To attach drawings to the new transmittal, do the following:

a. At the bottom of the dialog box, click Drawings.

b. In the Transmittal Drawings dialog box, do any of the following: 

• To add new drawings, click Add drawings, select the drawings,
and click Add.

• To set shop issue date, select the drawings and click Set Shop
ISsue Date. Then, select the date in the calender and click OK.

• To return drawings, select the drawings and click Return. Then,
select the approval status and return date, and click Update.

Note that if this is not the first time that these drawings have been
returned, you should select the Re-Submit check box.
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• To cancel returning drawings, select the drawings and click Un-
Return. Then, select the approval status and click OK.

• To remove drawings from the transmittal, select the drawings and
click Remove Selected drawings.

c. To close the dialog box, click the Close button (X) in the upper-right
corner.

You can see the attached drawings in the lower-right corner of the
Transmittal dialog box.

4. Click Save.

Delete transmittals

1. In the Transmittal dialog box, select the transmittals that you want to
delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Delete.

3. To permanently delete the transmittals, click Yes in the confirmation
dialog box.

View transmittals
Use the View Selected Transmittals command to view the selected
transmittals in the Tekla EPM Report Viewer.

1. In the Transmittal dialog box, select the transmittals that you want to
view. 

To select multiple transmittals, hold down Ctrl.

To select a range of subsequent transmittals, hold down Shift.

2. Click the Transmittal ribbon tab.

3. On the menu, select View Selected Transmittals.

4. In the View Transmittal dialog box, select or clear the following check
boxes according to your needs: 

To Do this
Show Company Logo (If
Exists)

When selected, your company logo is visible in the
transmittal.
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To Do this
Combine Drawings When selected, consecutive drawing numbers are

combined, so that the drawing numbers are
displayed as 1 – 3, instead of 1, 2, 3.

To be combined, the drawings need to have the
same dates, revisions, and descriptions, and be in
a series.

5. In the Report Selection dialog box, click View.

The transmittal opens in the Tekla EPM Report Viewer.

In the Tekla EPM Report Viewer, you can email the transmittal as a Microsoft
Excel worksheet or a PDF file, export it to another file format, or print it.

Print transmittals
Use the Print Selected Transmittals to print one or multiple transmittals
related to the current project management job.

1. In the Transmittal dialog box, select the transmittals that you want to
print. 

To select multiple transmittals, hold down Ctrl.

To select a range of subsequent transmittals, hold down Shift.

2. Click the Transmittal ribbon tab.

3. On the menu, select Print Selected Transmittals.

4. On the Report Settings tab of the Print Transmittal dialog box, select or
clear the following check boxes according to your needs: 

To Do this
Show Company Logo (If
Exists)

When selected, your company logo is visible in the
transmittal.

Combine Drawings When selected, consecutive drawing numbers are
combined, so that the drawing numbers are
displayed as 1 – 3, instead of 1, 2, 3.

To be combined, the drawings need to have the
same dates, revisions, and descriptions, and be in
a series.

5. On the Printer Settings tab, type the number of copies in the Copies
field.

6. To set the printer, click Change Printer.

7. In the Select Printer dialog box, click a printer to select it.

8. Click OK.

9. Click Print.
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Mark drawings in a transmittal as received
When the recipient of the transmittal has returned the drawings, you should
mark the drawings as received in the Transmittal dialog box.

Note that you can only receive drawings in transmittals whose type is To Be
Returned.

1. In the Transmittal dialog box, click the transmittal whose drawings you
want to receive.

2. At the bottom of the dialog box, click Drawings.

3. In the Selected Drawings dialog box, click the arrow buttons to move the
returned drawings to the Included list.

4. Click Receive.

5. In the Receive Drawings dialog box, click the arrow on the right side of
the Date Returned field, and select the date in the calendar.

6. Click the arrow on the right side of Approval Status list, and select the
approval status of the drawings in the list.

7. If the drawings have been re-submitted for approval, select the Re-
Submit check box.

8. Click OK.

9. In the Selected Drawings dialog box, select all drawings in the Included
list. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

10. Click Set Shop Issue Date of Included Drawings.

11. Click the arrow on the right side of the date field, and select a date in the
calendar.

12. Click OK.

13. To close the Selected Drawings dialog box, click OK.

Send a transmittal via email
Use the Email Selected Transmittal command to send the selected
transmittals via email directly from the Transmittal dialog box.

Note that the Email Selected Transmittal command only works with
Microsoft Outlook, so you need to have Microsoft Outlook open before trying
to send a transmittal by email.

1. In the Transmittal dialog box, select the transmittals that you want to
send via email. 
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To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Transmittal ribbon tab.

3. On the menu, select Email Selected Transmittal. 

The Email Transmittal dialog box opens.

Note that the people who were marked as recipients of the transmittal
are automatically included in the Recipients Included list.

4. In the Email Transmittal dialog box, click the arrow buttons to move
additional recipients to the Recipients Included list.

5. If some of the recipients do not have an email address saved in the
Address Book, do the following:

a. Select the recipient in the Recipients Included list.

b. Click Contact Details.

c. Type the email address in the Email Address field.

d. Click Save.

6. Select or clear the following check boxes according to your needs: 

Option Description
Attach Drawing Files When selected, the drawing files that match the

items and purposes defined in the Transmittals
dialog box are attached to the transmittal.

Compress Drawing
Files

When selected, the drawing files are compressed
into a .zip package. The drawings are still separate
PDF files within the .zip package.

Note that the size of a .zip package may prevent
Microsoft Outlook from sending the transmittal via
email.

Show Company Logo (If
Exists)

When selected, your company logo is visible in the
transmittal.

Combine Drawings When selected, consecutive drawing numbers are
combined, so that the drawing numbers are
displayed as 1 – 3, instead of 1, 2, 3.

7. Click Email to send the email.

View, print, and export transmittal reports
You can create reports based on the transmittals related to the current
project. For example, you can create a report containing all existing
transmittals or all overdue transmittals. You can then view, print, or export the
created reports. Use the Reports command to create a report on all
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transmittals or transmittals that match specific filters, or use the Reports -
Selected command to create a report on the transmittals that are currently
selected in the Transmittals dialog box.

Create a transmittal report

1. In the Transmittal dialog box, click the Transmittal ribbon tab.

2. Do either of the following: 

To Do this
Create reports on all
transmittals or specific
types of transmittals

a. On the menu, select Reports.

b. To only create transmittal reports, at the
bottom of the Project Management Report
Filters dialog box, ensure that the
Transmittals check box is selected.

c. To only include specific types of transmittals in
the reports, in the Project Management
Report Filters dialog box, select a filter type in
the Type list, and click Select.

d. In the Filter dialog box, do one of the
following depending on the filter type:

• Click the arrow buttons to move the
transmittal properties that you want to
include in the report to the Included list.

• Type the maximum and minimum values
for the transmittals that you want to
include.

For example, select the earliest and latest
drawing date for the transmittals.

e. Click OK.

To further limit the transmittals that are
included in the reports, repeat steps b to d for
all necessary filter types.

f. To combine the drawing numbers of drawings
with the same dates, revisions, and
descriptions, select the Transmittal -
Combine Drawings check box.

g. Click Make Report.
Create reports on the
currently selected
transmittals

a. On the menu, select Reports - Selected.

3. In the Report Selection dialog box, select the report that you want to
view, print, or export.

Manage projects 571 Add and modify project information



View the transmittal report

• In the Report Selection dialog box, click View.

The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
EPM Report Viewer window to email the report via Microsoft Outlook.

Print the transmittal report

1. In the Report Selection dialog box, change the number of the printed
copies by clicking the + and - buttons.

2. Click Print.

3. To confirm printing the report, click Yes in the confirmation dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the transmittal report

1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Browse to the location where you want to save the exported file, and click
Save.

5. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email check box.

6. To open the file after exporting it, select the Open Exported Document
check box.

7. In the Report Selection dialog box, click Export.

Manage requests for information
Official requests for information, or RFIs, allow you to log the flow of
information between parties in construction projects. RFIs can be used to
clarify the design intent, get missing information, receive approval for
alternate methods or materials, get approved fixes for any conflicts in the
field, or get any other critical information to ensure that the project conforms
to the intent of the design team. You can save all RFIs and their responses to
Tekla EPM, so that everyone in the current project can keep track of the
project easily.

• Do any of the following: 

• On the right side of the Project dialog box, click the RFIs button.
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• On the Summary tab of the Project dialog box, click + in the upper-
right corner of the RFIs section, and select which requests for
information you want to see.

The Request For Information dialog box opens.

For more information, see the following links:

Create, modify, and delete requests for information (page 573)

View requests for information (page 581)

Print requests for information (page 582)

Import or export requests for information (page 583)

Save a request for information as a Microsoft Word document (page 584)

Send a request for information via email (page 584)

View, print, or export RFI reports (page 586)

Create, modify, and delete requests for information
Use the Request For Information dialog box to manage requests for
information, or RFIs. You can create new requests, add recipients for the
requests, attach files or emails to requests, modify the properties of existing
requests, or delete unnecessary requests.
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Note that requests by either your company or any other party in the project
can be recorded in the Request For Information dialog box.

Create a request

1. In the Request For Information dialog box, click New.

2. Define the properties of the request. 

The items that are marked with an asterisk (*) in the following table are
mandatory.

Option Description
Originator * The party that initiated the original

request.

Click the arrow on the right side of
the upper Originator list, and in the
list, select the originator company.

Click the arrow on the right side of
the lower Originator list, and in the
list, select the contact person that
initiated the request.

Note that only the companies that
have been added for the project in
the Project Management dialog box
and their contact persons are
available in the Originator lists.
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Option Description
Orig RFI # * The number of the original request

that was sent to your company.

Note that the Orig RFI # is only
available and mandatory if the
originator of the request is some
other party than your company.

Type the request number in the Orig
RFI # field.

Orig RFI Date * The date when the original request
was sent to your company.

Note that the Orig RFI Date is only
available and mandatory if the
originator of the request is some
other party than your company.

Click the arrow on the right side of
the Orig RFI Date list, and select a
date in the calendar.

RFI # * The number of the request or
response that you are sending.

Note that an RFI number can only be
used once.

Type the request number in the RFI #
field.

RFI Date * The date when you sent the request.

Click the arrow on the right side of
the RFI Date list, and select a date in
the calendar.

RFI Status Indicates if all necessary information
regarding the request has been
received.

Remember to close requisitions once
they have been responded to.

Click the arrow on the right side of
RFI Status list, and select one of the
following options:

• Open: all necessary information
has not been received.

• Closed: all necessary information
has been received.

Manage projects 575 Add and modify project information



Option Description

NOTE Setting the RFI status as
Closed does not close the
request, so the request can
still be shown as overdue.

To actually close the request,
you need to define a
response date when you
have received all necessary
information from the primary
recipient of the request.

Request Date * The date by which the requested
information should be received.

Click the arrow on the right side of
Request Date list, and select a date
in the calendar.

Subject * The subject of the request.

Type a subject in the Subject field.
Body * The body text of the request.

Type the text of the request in the
Body field.

3. To add recipients for the request, do the following:

a. Click anywhere in the Recipient table.

b. In the Recipients dialog box, click one of the following buttons: 

• New Primary Recipient: creates a primary recipient.

• New Carbon Copy Recipient: creates a recipient that receives a
copy of the original request.

c. Define the recipient properties: 

Option Description
To The recipient company and person.

Click the arrow on the right side of the leftmost To
list, and select the recipient company in the list.

Click the arrow on the right side of the rightmost
To list, and select the recipient in the list.

Note that only the companies that have been
added for the project in the Project Management
dialog box and their contact persons are available
in the Originator lists.
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Option Description
Their RFI # The recipient's request number.

Type a number in the Their RFI # field.
Date Sent The date when the request was sent to the

recipient.

Click the arrow on the right side of the Date Sent
field, and select a date in the calendar.

Sent Via The method with which the request was sent.

The available methods are set in Sent Via
Maintenance.

Click the arrow on the right side of the Sent Via
list, and select a sending method in the list.

Date Received The date when the first response from the
recipient was received.

Click the arrow on the right side of the Date
Received field, and select a date in the calendar.

Response Date The date when all necessary information was
received, and the request status could be set to
Closed.

The response date is included in RFI reports.

Click the arrow on the right side of the Response
Date field, and select a date in the calendar.

Response Details Any information regarding the response. The
response details are included in RFI reports.

Type details in the Response Details field.

d. To add the recipient, depending on the recipient type, click Add PR or
Add CC. 

Repeat steps b to d for all necessary recipients.

e. To close the Recipients dialog box, click the Close button (X) in the
upper-right corner.

4. In the Request For Information dialog box, click Add to create the
request.

5. To attach files to the new request, do the following:

a. Select the request in the list.

b. Click Attached Files.

c. In the RFI Files dialog box, click New.

d. In the Document Index - Add Document Reference dialog box, add
a file, a Microsoft Outlook email, or Microsoft Outlook email
attachments. 
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e. Click the arrow on the right side of the leftmost RFI list, and select the
related request in the list.

f. Click the arrow on the right side of the rightmost RFI list, and select if
the attachment is a request or a response.

g. Type a description for the attached file.

h. Click Add Document Reference. 

Repeat steps c to h for all necessary attachments.

i. In the RFI Files dialog box, click Save.

j. To close the RFI Files dialog box, click the Close button (X) in the
upper-right corner.

Modify a request

Modify a request to change its properties. For example, you should close a
request after receiving all necessary information.

1. In the Request For Information dialog box, select the request that you
want to modify.

2. Modify the request properties according to your needs: 

Option Description
Originator The party that initiated the original

request.

Click the arrow on the right side of
the upper Originator list, and in the
list, select the originator company.

Click the arrow on the right side of
the lower Originator list, and in the
list, select the contact person that
initiated the request.

Note that only the companies that
have been added for the project in
the Project Management dialog box
and their contact persons are
available in the Originator lists.

Orig RFI # The number of the original request
that was sent to your company.

Note that the Orig RFI # is only
available and mandatory if the
originator of the request is some
other party than your company.

Type the request number in the Orig
RFI # field.
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Option Description
Orig RFI Date The date when the original request

was sent to your company.

Note that the Orig RFI Date is only
available and mandatory if the
originator of the request is some
other party than your company.

Click the arrow on the right side of
the Orig RFI Date list, and select a
date in the calendar.

RFI # The number of the request or
response that you are sending.

Note that an RFI number can only be
used once.

Type the request number in the RFI #
field.

RFI Date The date when you sent the request
or a response to the request.

Click the arrow on the right side of
the RFI Date field, and select a date in
the calendar.

RFI Status Indicates if all necessary information
regarding the request has been
received.

Remember to close requisitions once
they have been responded to.

Click the arrow on the right side of
the RFI Status list, and select one of
the following options:

• Open: all necessary information
has not been received.

• Closed: all necessary information
has been received.

Request Date The date by which the requested
information should be received.

Click the arrow on the right side of
the Request Date list, and select a
date in the calendar.

Subject The subject of the request.

Type a subject in the Subject field.
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Option Description
Body The body text of the request.

Type the text of the request in the
Body field.

3. To add recipients for the request, do the following:

a. Click anywhere in the Recipient table.

b. In the Recipients dialog box, modify the recipient properties
according to your needs: 

Option Description
To The recipient company and person.

Click the arrow on the right side of the leftmost To
list, and select the recipient company in the list.

Click the arrow on the right side of the rightmost
To list, and select the recipient in the list.

Note that only the companies that have been
added for the project in the Project Management
dialog box and their contact persons are available
in the Originator lists.

Their RFI # The recipient's request number.

Type a number in the Their RFI # field.
Date Sent The date when the request was sent to the

recipient.

Click the arrow on the right side of the Date Sent
field, and select a date in the calendar.

Sent Via The method with which the request was sent.

The available methods are set in Sent Via
Maintenance.

Click the arrow on the right side of the Sent Via
list, and select a sending method in the list.

Date Received The date when the first response from the
recipient was received.

Click the arrow on the right side of the Date
Received field, and select a date in the calendar.

Response Date The date when all necessary information was
received, and the request status could be set to
Closed.

The response date is included in RFI reports.

Click the arrow on the right side of the Response
Date field, and select a date in the calendar.
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Option Description
Response Details Any information regarding the response. The

response details are included in RFI reports.

Type details in the Response Details field.

c. Click Edit to save the changes. 

If necessary, you can also delete recipients by selecting them, clicking
Delete, and clicking Yes to confirm.

d. To close the Recipients dialog box, click the Close button (X) in the
upper-right corner.

4. To modify the files that are attached to the request, do the following:

a. Select the request in the list.

b. Click Attached Files.

c. In the RFI Files dialog box, select an attachment and modify its
description according to your needs.

d. If necessary, click the arrow on the right side of the list that is next to
the description, and select if the attachment is related to a request or
a response.

e. Click Save. 

If necessary, you can also delete attached files by selecting them,
clicking Delete, and clicking Yes to confirm.

f. To close the RFI Files dialog box, click the Close button (X) in the
upper-right corner.

Delete a request

Note that deleting a request is permanent and cannot be undone.

1. In the Request For Information dialog box, select the request that you
want to delete.

2. Click Delete.

3. To permanently delete the request, click Yes in the confirmation dialog
box.

View requests for information
Use the View Selected RFIs command to open the currently selected requests
for information in Tekla EPM Report Viewer.

1. In the Request For Information dialog box, select the requests that you
want to view. 

To select multiple requests, hold down Ctrl.

To select a range of subsequent requests, hold down Shift.
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2. Double-click one of the selected requests.

3. In the View RFI dialog box, select or clear the following check boxes
according to your needs: 

Option Description
Show Company Logo (If
Exists)

When selected, your company logo is visible in the
requests.

Include Impact Text When selected, Tekla EPM includes text regarding
the importance of the requested information and
the delay that may be caused if the response is not
sent on time.

4. If necessary, in the Additional Pages field, type the number of pages you
want to add to the request for the attachments to be included.

5. In the Author field, type the name of the author. 

If you do not type a name in the Author field, Tekla EPM uses the name of
your company instead.

6. To view the request, click View Request.

The selected requests open in Tekla EPM Report Viewer.

In the Tekla EPM Report Viewer window, you can send the requests via email
either as PDF files or Microsoft Excel worksheets, print the requests, or export
the requests and save them in another file format.

See also

Print requests for information (page 582)

Send a request for information via email (page 584)

Print requests for information
Use the Print Selected RFIs command to print one or multiple requests for
information.

1. In the Request For Information dialog box, select the requests that you
want to print. 

To select multiple requests, hold down Ctrl.

To select a range of subsequent requests, hold down Shift.

2. Click the Request For Information ribbon tab.

3. On the menu, select Print Selected RFIs.
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4. In the Print RFI dialog box, select or clear the following check boxes
according to your needs: 

Option Description
Show Company Logo (If
Exists)

When selected, your company logo is visible in the
requests.

Include Impact Text When selected, Tekla EPM includes text regarding
the importance of the requested information and
the delay that may be caused if the response is not
sent on time.

5. If necessary, in the Additional Pages field, type the number of pages you
want to add to the request for the attachments to be included.

6. In the Author field, type the name of the author. 

If you do not type a name in the Author field, Tekla EPM uses the name of
your company instead.

7. In the Copies field, type the number of printed copies.

8. Click Change Printer.

9. In the Select Printer dialog box, click a printer to select it.

10. Click OK.

11. Click Print RFI.

See also

Send a request for information via email (page 584)

Import or export requests for information
You can import or export requests for information. Use the XML file format
when exporting requests, so that the requests can easily be imported back to
Tekla EPM by another party in the current project.

Import requests

1. In the Request For Information dialog box, click the Request For
Information ribbon tab.

2. On the menu, select Data Exchange --> Import .

3. In the Open dialog box, browse to find the file that you want to import.

4. Double-click the file that you want to import, or click Open.

5. In the Import Tekla EPM Exchange File dialog box, review the import
progress.

6. When the import process is completed, click Close.
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Export requests

1. In the Request For Information dialog box, click the request that you
want to export.

2. On the menu, select Data Exchange --> Export Selected RFIs .

3. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla EPM saves the file to the Export folder.

4. If necessary, change the file name.

5. Click Save.

Save a request for information as a Microsoft Word document
Use the Make Word Document command to save a request for information
as a Microsoft Word document.

1. In the Request For Information dialog box, select the request that you
want to save as a Microsoft Word document.

2. Click the Request For Information ribbon tab.

3. On the menu, select Make Word Document.

4. In the Save As dialog box, browse to the folder where you want to save
the file.

5. If necessary, change the file name.

6. Click Save.

See also

Import or export requests for information (page 583)

Send a request for information via email
Use the Email Selected RFI command to send the currently selected request
for information via email.

Note that the Email Selected RFI command only works with Microsoft
Outlook, so you need to have Microsoft Outlook open before trying to send a
transmittal by email.

1. In the Request For Information dialog box, select the requests that you
want to send via email.

2. Click the Request For Information ribbon tab.

3. On the menu, select Email Selected RFI. 

The Email RFI dialog box opens.

Note that the recipients and attachments defined in the Request For
Information are automatically added to the Recipients Included list.
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4. Click the arrow buttons to move additional recipients to the Recipients
Included list.

5. If some of the recipients do not have an email address saved in the
Address Book, do the following:

a. Select the recipient in the Recipients Included list.

b. Click Contact Details.

c. Type the email address in the Email Address field.

d. Click Save.

6. Click the arrow buttons to move the attachments that you want to include
in the email to the Attachments Included list.

7. Select or clear the following check boxes according to your needs: 

Option Description
Attach Tekla EPM data
exchange file

When selected, the request information is
converted to an XML file, which another Tekla EPM
user can import to Tekla EPM. This can be useful if
other parties in the project use Tekla EPM as well.

Show Company Logo (If
Exists)

When selected, your company logo is visible in the
request.

Note that the Show Company Logo (If Exists)
check box is only available if the Attach PDF
export of the RFI check box is selected.

Include Impact Text When selected, Tekla EPM includes a notice
regarding the importance of the requested
information and the delay that may be caused if
the response is not sent on time.

Note that the Show Company Logo (If Exists)
check box is only available if the Attach PDF
export of the RFI check box is selected.

8. If necessary, in the Additional Pages field, type the number of pages you
want to add to the request for the attachments to be included. 

Note that the Additional Pages field is only available if the Attach PDF
export of the RFI check box is selected.

9. In the Author field, type the name of the author. 

If you do not type a name in the Author field, Tekla EPM uses the name of
your company instead.

10. Click Email.

See also

Save a request for information as a Microsoft Word document (page 584)
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Import or export requests for information (page 583)

View, print, or export RFI reports
You can create reports based on the existing requests for information, or RFIs.
For example, you can create a report containing all the overdue RFIs or the RFI
details. You can then view, print, or export the created reports. Use the
Reports command to create a report on all requests or requests that match
specific filters, or use the Reports - Selected command to create a report on
the requests that you select in the Request For Information dialog box.

Create an RFI report

1. In the Request For Information dialog box, click the Request For
Information ribbon tab.

2. Do either of the following: 

To Do this
Create reports on all
RFIs or specific types of
RFIs

a. On the menu, select Reports.

b. To only create RFI reports, at the bottom of
the Project Management Report Filters
dialog box, ensure that only the RFIs check
box is selected.

c. To only include specific types of requests in
the reports, in the Project Management
Report Filters dialog box, select a filter type in
the Type list, and click Select.

d. In the Filter dialog box, do one of the
following depending on the filter type:

• Click the arrow buttons to move the
request properties that you want to include
in the report to the Included list.

• Type the maximum and minimum values
for the requests that you want to include.

For example, you can define the earliest
and latest date for the requests that you
want to include.

e. Click OK.

To further limit the requests that are included
in the reports, repeat steps b to d for all
necessary filter types.

f. Click Make Report.
Create reports on the
currently selected RFIs

a. On the menu, select Reports - Selected.
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3. In the Report Selection dialog box, select the report that you want to
view, print, or export.

View the RFI report

• In the Report Selection dialog box, click View.

The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
EPM Report Viewer window to email the report via Microsoft Outlook.

Print the RFI report

1. In the Report Selection dialog box, change the number of the printed
copies by clicking the + and - buttons.

2. Click Print.

3. To confirm printing the report, click Yes in the confirmation dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the RFI report

1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Browse to the location where you want to save the exported file, and click
Save.

5. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email check box.

6. To open the file after exporting it, select the Open Exported Document
check box.

7. In the Report Selection dialog box, click Export.

Manage the project journal
The project journal allows you to keep a chronological record of the project. In
the Journal dialog box, you can add journal entries regarding emails,
telephone conversations, or any other project information that needs to be
recorded. By adding journal entries, you can ensure that everyone in the
project knows the relevant details about the project.

• To open the project journal, on the right side of the Project dialog box,
click the Journal Entries button.
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The Journal dialog box opens.

For more information, see the following links:

Add, modify, and delete journal entries (page 588)

View, print, and export project journal reports (page 592)

Add, modify, and delete journal entries
Use the Journal dialog box to manage and record journal entries related to
the project. You can add new journal entries, attach files or emails to journal
entries, modify existing journal entries, or delete journal entries.
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Add a journal entry

1. In the Journal dialog box, click New.

2. Define the properties of the journal entry: 

The items that are marked with an asterisk (*) in the following table are
mandatory information.

Option Description
Entry # * The number of the journal entry.

Tekla EPM automatically populates the Entry #
field with the next available entry number.

If necessary, type a different number in the Entry
# field.

Entry Date * The date of the recorded event.

By default, Tekla EPM suggests the current date.

If necessary, click the arrow on the right side of
the Entry Date field, and select a date in the
calendar.

Entry Time * The time of the recorded event.

By default, Tekla EPM suggests the current time.

If necessary, type another time in the Entry Time
fields.
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Option Description
Author * The creator of the journal entry.

Click the arrow on the right side of the Author list,
and select a user in the list.

Note that only Tekla EPM users in your company
are available in the list.

Contact The project party related to the recorded event.
For example, the contact person with whom you
had a telephone conversation and their company.

Note that only the companies that have been
added for the project in the Project Management
dialog box and their contact persons are available
in the Contact lists.

Click the arrow on the right side of the leftmost
Contact list, and select the related company in the
list.

Click the arrow on the right side of the rightmost
Contact list, and select the contact person in the
list.

Subject * The subject of the journal entry.

Type the subject in the Subject field.
Body The details of the journal entry.

Type any relevant information in the Body field.

3. Click Add.

4. To attach a file to the new journal entry, do the following:

a. Select the new journal entry.

b. Click Attached Files.

c. In the Journal Entry Files dialog box, click New.

d. In the Document Index - Add Document Reference dialog box, add
a file, a Microsoft Outlook email, or Microsoft Outlook email
attachments. 

For more information, see Add document references (page 391).

e. Click the arrow on the right side of the leftmost Journal Entry list,
and select the journal entry to which you want to attach the file.

f. Type a description for the attached file.

g. Click Add Document Reference. 

Repeat steps c to g for to add all necessary attachments.

h. In the Journal Entry Files dialog box, click Save.
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i. To close the Journal Entry Files dialog box, click the Close button (X)
in the upper-right corner.

Modify a journal entry

1. In the Journal dialog box, select the journal entry that you want to modify.

2. Modify the journal entry properties according to your needs: 

Option Description
Entry # The number of the journal entry.

Tekla EPM automatically populates the Entry #
field with the next available entry number.

If necessary, type a different number in the Entry
# field.

Entry Date The date of the recorded event.

By default, Tekla EPM suggests the current date.

If necessary, click the arrow on the right side of
the Entry Date field, and select a date in the
calendar.

Entry Time The time of the recorded event.

By default, Tekla EPM suggests the current time.

If necessary, type another time in the Entry Time
fields.

Author The creator of the journal entry.

Click the arrow on the right side of the Author list,
and select a user in the list.

Note that only Tekla EPM users in your company
are available in the list.

Contact The project party related to the recorded event.
For example, the contact person with whom you
had a telephone conversation and their company.

Note that only the companies that have been
added for the project in the Project Management
dialog box and their contact persons are available
in the Contact lists.

Click the arrow on the right side of the leftmost
Contact list, and select the related company in the
list.

Click the arrow on the right side of the rightmost
Contact list, and select the contact person in the
list.

Manage projects 591 Add and modify project information



Option Description
Subject The subject of the journal entry.

Type the subject in the Subject field.
Body The details of the journal entry.

Type any relevant information in the Body field.

3. Click Edit to save the changes.

4. To modify the files that are attached to the journal entry, do the following:

a. Select the journal entry whose attached files you want to modify.

b. Click Attached Files.

c. In the Journal Entry Files dialog box, select an attachment and
modify its description according to your needs.

d. Click Save. 

If necessary, you can also delete attached files by selecting them,
clicking Delete, and clicking Yes to confirm.

e. To close the Journal Entry Files dialog box, click the Close button (X)
in the upper-right corner.

Delete journal entries

1. In the Journal dialog box, select the journal entries that you want to
delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Delete.

3. To permanently delete the journal entries, click Yes in the confirmation
dialog box.

View, print, and export project journal reports
You can create reports based on the existing journal entries. For example, you
can create a report containing all journal entries, or the authors of journal
entries. You can then view, print, or export the created reports. Use the
Reports command to create a report on all journal entries or journal entries
that match specific filters, or use the Reports - Selected command to create a
report on the journal entries that are currently selected in the Journal dialog
box.

Create a project journal report

1. In the Journal dialog box, click the Journal ribbon tab.

2. Do either of the following: 
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To Do this
Create reports on all
journal entries or
specific types of journal
entries

a. On the menu, select Reports.

b. To only create journal reports, at the bottom
of the Project Management Report Filters
dialog box, ensure that only the Journal
Entries check box is selected.

c. To only include specific types of journal entries
in the reports, in the Project Management
Report Filters dialog box, select a filter type in
the Type list, and click Select.

d. In the Filter dialog box, do one of the
following depending on the filter type:

• Click the arrow buttons to move the journal
entry properties that you want to include in
the report to the Included list.

• Type the maximum and minimum values
for the journal entries that you want to
include.

For example, define the earliest and latest
date for the journal entries that you want
to include.

e. Click OK.

To further limit the journal entries that are
included in the reports, repeat steps b to d for
all necessary filter types.

f. Click Make Report.
Create reports on the
currently selected
journal entries

a. On the menu, select Reports - Selected.

3. In the Report Selection dialog box, select the report that you want to
view, print, or export.

View the journal report

• In the Report Selection dialog box, click View.

The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
EPM Report Viewer window to email the report via Microsoft Outlook.

Print the journal report

1. In the Report Selection dialog box, change the number of the printed
copies by clicking the + and - buttons.
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2. Click Print.

3. To confirm printing the report, click Yes in the confirmation dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the journal report

1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Browse to the location where you want to save the exported file, and click
Save.

5. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email check box.

6. To open the file after exporting it, select the Open Exported Document
check box.

7. In the Report Selection dialog box, click Export.

Manage change orders
Change orders can be any changes made to the original contract that affect
the project schedule and costs. You can manage the change orders related to
the current project management project in the Change Order dialog box.

1. To open the Change Orders dialog box, do any of the following: 

• On the right side of the Project dialog box, click the Change Orders
button.

• On the Summary tab of the Project dialog box, click + in the upper-
right corner of the Change Orders section, and select which change
orders you want to see.
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The Change Order dialog box opens.

For more information, see the following links:

Create, modify, and delete change orders (page 595)

View change orders (page 601)

Print change orders (page 602)

View, print, or export change order reports (page 602)

Create, modify, and delete change orders
Use the Change Order dialog box to manage and record changes requested
and made to the original contract. You can create new change order requests,
attach files or emails to change order requests, modify existing change order
requests, or delete change order requests.

NOTE The items in the Change Order dialog box are not change orders for contract
purposes. Instead, the items represent the change order requests made
regarding the project.
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Create a change order

1. At the bottom of the Change Order dialog box, click New.

2. Define the properties of the change order. 

The items that are marked with an asterisk (*) in the following table are
mandatory.

Option Description
CO # * The number of the change order.

Tekla EPM automatically populates the CO # field
with the next available number. You can change
the number, if needed.

CO Date * The date when the change order was sent.

Click the arrow on the right side of the CO Date
field, and select a date in the calendar.

To * The recipient company and person of the change
order.

Click the arrow on the right side of the leftmost To
list, and select the recipient company in the list.

Click the arrow on the right side of the rightmost
To list, and select the recipient in the list.

Note that only the companies that have been
added for the project in the Project Edit dialog box
and their contact persons are available in the To
lists.
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Option Description
Supplier The supplier that is affected by the change order.

Click the arrow on the right side of the Supplier
list, and select a supplier in the list.

Note that only the companies with the firm type
Supplier that have been added for the project in
the Project Management dialog box are available
in the Supplier lists.

Since the supplier is normally the fabricator, you
may need to copy your company as a supplier in
the project. For more information, see Manage
companies in the project (page 556).

Subject * The subject of the change order, visible in the
change order document.

Type the subject in the Subject field.
Description Of Change The description of the change that should be

made.

Type a description in the Description Of Change
field.

Change Has Added The number of calendar days, work days, weeks, or
months that the change has added to the project
duration. The time entered here will be displayed
in the project schedule.

In the Change Has Added field on the left, type the
desired number.

Then, right-click the Change Has Added field, and
select the unit of time in the list.

Change Will Cause The total sum that making the change will add to
the project costs or subtract from the project costs.

Type the costs in the Change Will Cause field.
Change Requested By The source that requested making the change. For

example, this can be a party in the project, a
document, or a response to an RFI.

Type a value in the Change Requested By field.
Request Date The date when the change was requested.

Click the arrow on the right side of Request Date
field, and select a date in the calendar.

Answered Date The date when the supplier has replied to the
change order.

Click the arrow on the right side of Answered Date
field, and select a date in the calendar.
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Option Description
Approved When selected, the change order has been

approved.

Remember to select the Approved check box
when the change order has been approved. When
you do so, the change order is sent to Contract &
Invoicing.

Sent Via * The method with which the change order has been
sent.

The options available in the Sent Via list are set in
the Sent Via Maintenance dialog box.

Click the arrow on the right side of the Sent Via
list, and select a sending method in the list.

Author * The Tekla EPM user who created the change order.

Click the arrow on the right side of the Author list,
and select a user in the list.

Only the Tekla EPM users in your company are
available in the Author list.

Contract Item The item in the project contract that the change
order is linked to. For more information, see Add
and modify contract information (page 658).

The Contract Item field is not included in the
Change Orders dialog box by default. You can add
the Contract Item field by modifying the input
fields for change orders.

Click the arrow on the right side of Contract Item
list, and select the contract item.

3. To attach files to the new change order, do the following:

a. At the bottom of the dialog box, click Attached Files.

b. In the Change order dialog box, click New.

c. In the Document Index - Add Document Reference dialog box, add
a file, a Microsoft Outlook email, or Microsoft Outlook email
attachments. 

d. Click the arrow on the right side of the Change Order list, and select
the change order to which you want to attach the file.

e. Type a description for the attached file.

f. Click Add Document Reference. 

Repeat steps c to g for all necessary attachments.

g. Click Save.
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h. To close the Change order dialog box, click the Close button (X) in
the upper-right corner.

You can see the number of attached files in the upper-right corner of the
Change Order dialog box.

4. Click Save.

Modify a change order

1. In the Change Order dialog box, select the change order that you want to
modify.

2. Modify the properties of the change order: 

Option Description
CO # The number of the change order.

Tekla EPM automatically populates the CO # field
with the next available number. You can change
the number according to your needs.

CO Date The date when the change order was sent.

Click the arrow on the right side of the CO Date
field, and select a date in the calendar.

To The recipient company and person of the change
order.

Click the arrow on the right side of the leftmost To
list, and select the recipient company in the list.

Click the arrow on the right side of the rightmost
To list, and select the recipient in the list.

Note that only the companies that have been
added for the project in the Project Management
dialog box and their contact persons are available
in the To lists.

Supplier The supplier that is affected by the change order.

Click the arrow on the right side of the Supplier
list, and select a supplier in the list.

Note that only the companies with the firm type
Supplier that have been added for the project in
the Project Management dialog box are available
in the Supplier lists.

Subject The subject of the change order, visible in the
change order document.

Type the subject in the Subject field.
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Option Description
Description Of Change The description of the change that should be

made.

Type a description in the Description Of Change
field.

Change Has Added The number of calendar days, work days, weeks, or
months that the change has added to the project
duration. The time entered here will be displayed
in the project schedule.

In the Change Has Added field on the left, type the
desired number.

Then, click the arrow on the right side of the
Change Has Added list, and select the unit of time
in the list.

Change Will Cause The total sum that making the change will add to
the project costs or subtract from the project costs.

Type the costs in the Change Will Cause field.
Change Requested By The party that requested making the change.

Type a name in the Change Requested By field.
Request Date The date when the change was requested.

Click the arrow on the right side of the Request
Date field, and select a date in the calendar.

Answered Date The date when the supplier has approved or
rejected the change order.

Click the arrow on the right side of the Answered
Date field, and select a date in the calendar.

Approved When selected, the change order has been
approved.

Remember to select the Approved check box
when the change order has been approved, so that
Tekla EPM will not mark the change order as
overdue.

Sent Via The method with which the change order has been
sent.

The options available in the Sent Via list are set in
the Sent Via Maintenance dialog box.

Click the arrow on the right side of the Sent Via
list, and select a sending method in the list.
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Option Description
Author The Tekla EPM user who created the change order.

Click the arrow on the right side of the Author list,
and select a user in the list.

Only the Tekla EPM users in your company are
available in the Author list.

3. To modify the files attached to the change order, do the following:

a. Select the change order.

b. At the bottom of the dialog box, click Attached Files.

c. In the Change order dialog box, select an attachment and modify its
description according to your needs.

d. Click Save to save the changes. 

If necessary, you can also delete attached files by selecting them,
clicking Delete, and clicking Yes to confirm.

To attach new files, see Create a change order.

e. To close the Change order dialog box, click the Close button (X) in
the upper-right corner.

Delete change orders

Note that deleting change orders is permanent and cannot be undone.

1. In the Change Order dialog box, select the change orders that you want
to delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Delete.

3. To permanently delete the change orders, click Yes in the confirmation
dialog box.

View change orders
Use the View Selected Change Orders command to view the currently
selected change orders in Tekla EPM Report Viewer.

1. In the Change Order dialog box, select the change orders that you want
to view. 

To select multiple change orders, hold down Ctrl.

To select a range of subsequent change orders, hold down Shift.

2. Click the Change Orders ribbon tab.

3. On the File menu, select View Selected Change Orders.
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4. To display your company logo in the change order, in the View Change
Order dialog box, select the Show Company Logo (If Exists) check box. 

To add a company logo, see Define and modify company information
(page 63).

5. Click View.

The selected change orders open in Tekla EPM Report Viewer.

In the Tekla EPM Report Viewer window, you can send the change orders via
email as either PDF files or Microsoft Excel worksheets, print the change
orders, or export the change orders and save them in another file format.

See also

Print change orders (page 602)

View, print, or export change order reports (page 602)

Print change orders
Use the Print Selected Change Orders to print one or multiple change orders
at one go.

1. In the Change Order dialog box, select the change orders that you want
to print. 

To select multiple change orders, hold down Ctrl.

To select a range of subsequent change orders, hold down Shift.

2. Click the Change Orders ribbon tab.

3. On the menu, select Print Selected Change Orders.

4. On the Report Settings tab of the Print Change Order dialog box, select
the Show Company Logo (If Exists) check box to display your company
logo in the change order.

5. On the Printer Settings tab, type the number of copies to be printed in
the Copies field.

6. To set the printer, click Change Printer.

7. In the Select Printer dialog box, click a printer to select it.

8. Click OK.

9. In the Print Change Order dialog box, click Print.

See also

View, print, or export change order reports (page 602)
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View, print, or export change order reports
You can create reports based on the existing change orders. For example, you
can create a report of all change orders or a report on overdue change orders.
You can then view, print, or export the created reports. Use the Reports
command to create a report on all change orders or change orders that match
specific filters, or use the Reports - Selected command to create a report on
the change orders that are currently selected in the Change Order dialog box.

Create a change order report

1. In the Change Order dialog box, click the Change Orders ribbon tab.

2. Do either of the following: 

To Do this
Create reports on all
change orders or
specific types of change
orders

a. On the menu, select Reports.

b. To only create change order reports, at the
bottom of the Project Management Report
Filters dialog box, ensure that only the
Change Orders check box is selected.

c. To only include specific types of change orders
in the reports, in the Project Management
Report Filters dialog box, select a filter type in
the Type list, and click Select.

d. In the Filter dialog box, do one of the
following depending on the filter type:

• Click the arrow buttons to move the
change order properties that you want to
include in the report to the Included list.

• Type the maximum and minimum values
for the change orders that you want to
include.

For example, define the earliest and latest
dates for the change orders that you want
to include.

e. Click OK.

To further limit the change orders that are
included in the reports, repeat steps b to d for
all necessary filter types.

f. Click Make Report.
Create reports on the
currently selected
change orders

a. On the menu, select Reports - Selected.

3. In the Report Selection dialog box, select the report that you want to
view, print, or export.
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View the change order report

• In the Report Selection dialog box, click View.

The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
EPM Report Viewer window to email the report via Microsoft Outlook.

Print the change order report

1. In the Report Selection dialog box, change the number of the printed
copies by clicking the + and - buttons.

2. Click Print.

3. To confirm printing the report, click Yes in the confirmation dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the change order report

1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Browse to the location where you want to save the exported file, and click
Save.

5. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email check box.

6. To open the file after exporting it, select the Open Exported Document
check box.

7. In the Report Selection dialog box, click Export.

Manage the project task list
The task list items in the Task List dialog box serve as reminders for the user
that they have been assigned project tasks. The items on your task list can also
be assigned to other users. If you have unfinished tasks on your task list, the
Task List dialog box opens automatically when you sign in to Tekla EPM. You
can also access the Task List dialog box manually:

• Do either of the following: 

• On the right side of the Project dialog box, click the Task List button.

• On the Summary tab of the Project dialog box, click + in the upper-
right corner of the Task List section, and select which task list items you
want to see.

Manage projects 604 Add and modify project information



For more information, see the following links:

Create, modify, and delete task list items (page 605)

View, print, and export task list reports (page 607)

Create, modify, and delete task list items
Use the Task List dialog box to create, modify, and delete task list items. You
can add completion dates for tasks that have been completed, or re-assign
tasks to other Tekla EPM users.

Create a task list item

1. In the Task List dialog box, click New.

2. Define the task list item properties. 

The items that are marked with an asterisk (*) in the following table are
mandatory information.

Option Description
Author The Tekla EPM user that created the task list item.

Click the arrow on the right side of the Author list,
and select a user in the list.

Assigned To The Tekla EPM user to whom the task list item is
assigned.

Click the arrow on the right side of the Assigned
To list, and select a user in the list.
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Option Description
Date Required The date by which the task list item should be

completed.

Click the arrow on the right side of the Date
Required field, and select a date in the calendar.

Date Completed The date when the task was completed.

Click the arrow on the right side of the Date
Completed field, and select a date in the calendar.

Description * The description of the task list item.

Type the task description in the Description field.

3. Click Add.

Modify a task list item

By modifying a task list item, you can change its properties. For example, add
completion dates for tasks that have been completed.

1. In the Task List dialog box, select the task list item that you want to
modify.

2. Modify the task list item properties: 

Option Description
Author The Tekla EPM user that created the task list item.

Click the arrow on the right side of the Author list,
and select a user in the list.

Assigned To The Tekla EPM user to whom the task list item is
assigned.

Click the arrow on the right side of the Assigned
To list, and select a user in the list.

Date Required The date by which the task list item should be
completed.

Click the arrow on the right side of the Date
Required field, and select a date in the calendar.

Date Completed The date when the task was completed.

Click the arrow on the right side of the Date
Completed field, and select a date in the calendar.

Description The description of the task list item.

Type the task description in the Description field.

3. Click Edit to save the changes.
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Delete task list items

Note that deleting task list items is permanent and cannot be undone.

1. In the Task List dialog box, select the task list items that you want to
delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Delete.

3. To permanently delete the task list items, click Yes in the confirmation
dialog box.

View, print, and export task list reports
Use the Reports command in the Task List menu to create a report out of the
task list. You can decide to include all tasks list items in the current project, or
only overdue or open task list items.

Create a task list report

1. In the Task List dialog box, click the Task List ribbon tab.

2. On the menu, select Reports.

3. To only create task list reports, at the bottom of the Project
Management Report Filters dialog box, ensure that only the Task List
check box is selected.

4. To only include specific types of task list items in the reports, in the
Project Management Report Filters dialog box, select a filter type in the
Type list, and click Select.

5. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the task list item properties that you
want to include in the report to the Included list.

• Type the maximum and minimum values for the task list item that you
want to include.

6. Click OK 

To further limit the task list items that are included in the reports, repeat
steps 3 to 5 for all necessary filter types.

7. Click Make Report.

8. In the Report Selection dialog box, select the report that you want to
view, print, or export.
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View, print, and export task list reports
Use the Reports command in the Task List menu to create a report out of the
task list. You can decide to include all tasks list items in the current project, or
only overdue or open task list items.

View the task list report

• In the Report Selection dialog box, click View.

The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
EPM Report Viewer window to email the report via Microsoft Outlook.

Print the task list report

1. In the Report Selection dialog box, change the number of the printed
copies by clicking the + and - buttons.

2. Click Print.

3. To confirm printing the report, click Yes in the confirmation dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the task list report

1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Browse to the location where you want to save the exported file, and click
Save.

5. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email check box.

6. To open the file after exporting it, select the Open Exported Document
check box.

7. In the Report Selection dialog box, click Export.

Manage the project check list
Use the project check list to ensure that all steps in the current project are
completed. In the Check List dialog box, you can add previously created steps
to the project, or delete unnecessary steps.

• To access the project check list, do either of the following: 

• On the right side of the Project dialog box, click the Check List button.
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• On the Summary tab of the Project dialog box, click + in the upper-
right corner of the Check List section, and select which check list items
you want to see.

For more information, see the following links:

Add check list items (page 609)

Modify a check list item (page 610)

Send check list items to the task list (page 610)

Delete check list items from a project (page 611)

View, print, or export check list reports (page 611)

Add check list items
Use the Add Additional Check List Items to add previously created check list
items to the check list of the current project.

Note that to add new check list items, the items need to be created in the
Check List Item Maintenance dialog box.

1. In the Check List dialog box, click the Check List ribbon tab.

2. On the menu, select Add Additional Check List Items.

3. In the Add Check List Items dialog box, click the arrow buttons to move
the items that you want to include in the check list to the Included list.

4. Click Add.
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The selected check list items are added to the Check List dialog box.

Now, you can modify the properties of the new check list items, such as its
status and required date.

See also

Modify a check list item (page 610)

Delete check list items from a project (page 611)

Send check list items to the task list
If necessary, you can send items in the project check list to the task list of a
Tekla EPM user that participates in the current project.

1. In the Check List dialog box, select the check list items that you want to
send to the task list. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Check List ribbon tab.

3. On the menu, select Move Selected Check List Items to Task List.

4. Click the arrow on the right side of the Assign To list in the Move To Task
List and select to which user you want to assign the check list items.

5. Click Move.

The items are moved to the task list of the selected user.

The Notes fields of the items show that the items have been sent to the task
list of the selected user.

See also

Manage the project task list (page 604)

Modify a check list item
You can modify the properties of a check list item according to your needs. For
example, you might need to mark a check list item as completed, or modify
the date by which the item should be completed.

1. In the Check List dialog box, select the check list item that you want to
modify.

2. Modify the check list item properties: 
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Option Description
Date Required The date by which the check list item should be

completed.

Click the arrow on the right side of the Date
Required field, and select a date in the calendar.

Status The completion status of the check list item. The
options are Completed, Not Completed, and N/A
(not applicable).

Click the arrow on the right side of the Status list,
and select a status option in the list.

Completed By The Tekla EPM user who completed the check list
item.

Click the arrow on the right side of the Completed
By list, and select a user in the list.

Date Completed The date when the check list item was completed.

Click the arrow on the right side of the Date
Completed field, and select a date in the calendar.

Notes Any relevant notes about the check list item.

Type any information in the Notes field.

3. Click Save.

See also

Add check list items (page 609)

Delete check list items from a project (page 611)

Delete check list items from a project
Use the Delete Selected Check List Items command to delete check list
items that are not necessary for the current project.

1. In the Check List dialog box, select the check list items that you want to
delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Check List ribbon tab.

3. On the menu, select Delete Selected Check List Items.

4. To permanently delete the check list items, click Yes in the confirmation
dialog box.
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View, print, or export check list reports
Use the Reports command to create various check list reports. For example,
you can create reports that show the statuses of the check list items or the
dates when the check list items have been completed.

Create a check list report

1. In the Check List dialog box, click the Check List ribbon tab.

2. On the menu, select Reports.

3. To only create check list reports, at the bottom of the Project
Management Report Filters dialog box, ensure that only the Check List
check box is selected.

4. To only include specific types of check list items in the reports, in the
Project Management Report Filters dialog box, select a filter type in the
Type list, and click Select.

5. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the check list item properties that you
want to include in the report to the Included list.

• Type the maximum and minimum values for the check list items that
you want to include.

For example, define the earliest and latest completion date for the
check list items that you want to include.

6. Click OK 

To further limit the types of check list items that are included in the
reports, repeat steps 3 to 5 for all necessary filter types.

7. Click Make Report.

8. In the Report Selection dialog box, select the report that you want to
view, print, or export.

View the check list report

• In the Report Selection dialog box, click View.

The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
EPM Report Viewer window to email the report via Microsoft Outlook.

Print the check list report

1. In the Report Selection dialog box, change the number of the printed
copies by clicking the + and - buttons.

2. Click Print.

3. To confirm printing the report, click Yes in the confirmation dialog box.
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4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the check list report

1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Browse to the location where you want to save the exported file, and click
Save.

5. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email check box.

6. To open the file after exporting it, select the Open Exported Document
check box.

7. In the Report Selection dialog box, click Export.

8.4 View and adjust the project schedule
In the Project Schedule dialog box, you can create, view, and modify the
project schedule of the current project. Note that you can only access the
Project Schedule dialog box from a production control job if you have linked
the production control job to a project management job.

To access the Project Schedule dialog box, do one the following:

To Do this
Access the project
schedule from the
Project Management
module

• At the bottom of the Project Management
dialog box, click Project Schedule.

Access the project
schedule from the
Production Control
module

1. In the Production Control dialog box, click the
Production Control ribbon tab.

2. On the menu, select Project Schedule.

The Project Schedule dialog box opens. The same dialog box is available in
the Project Management module. Note that the Schedule Tasks dialog box
opens at the same time as well.
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The Project Schedule dialog box contains multiple tabs:

• On the Baseline Plan tab, you can set and modify the current project
baseline.

• On the Schedule Tasks tab, you can add, modify, move, and delete tasks
that are on the project schedule.

• On the Project Breakdown tab, you can divide a project into sub-tasks.
Usually, this is done by sequence or lot number, but it can also be done by
category, sub-category, or pay category.

• On the Gantt Chart tab, you can view and modify the dates and
completion percentages of different tasks.

For more information, see the following links:

Switch edit mode on and off (page 615)

Create, modify, and delete baseline plans (page 615)

Add, modify, and delete schedule tasks (page 622)

Add, modify, and delete breakdown items (page 629)

Apply a schedule template (page 643)

View changes in the project schedule and add savepoints (page 620)

Update the project schedule (page 644)

Add, modify, and view time tracking information (page 645)

Export the project schedule to XML format (page 650)

Modify the Gantt chart (page 635)
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Create a project schedule report (page 650)

Example: Create a project schedule (page 652)

Switch edit mode on and off
When working in the Project Schedule dialog box, you can only make changes
when you have the edit mode on. The edit mode ensures that Tekla EPM users
do not make conflicting changes if they work on the project schedule
simultaneously. While one has the edit mode on, no other user can make
changes to the project schedule of the same project. Other users can still view
the schedule.

Any time that you try to make changes to a project schedule after the timeout
time has been reached, a confirmation dialog box will open, asking if you want
to enter edit mode.

You can also switch the edit mode on or off by using a keyboard shortcut. Do
the following:

• To switch the edit mode on, press Ctrl+E on the keyboard.

The edit mode will stay on until you press Ctrl+E again or the timeout time is
reached. The timeout ensures that a user does not lock out others from
making changes to the project schedule for a long period of time.

Create, modify, and delete baseline plans
A baseline plan is a listing of schedule tasks, dependencies, and estimated
dates, that demonstrates the intent of a project. The actual progress is
compared against the baseline plan. A project can have multiple baseline
plans, so that you can explore different scenarios that show the effect that a
change would have on the schedule. You can set any baseline plan as the
current plan of the project at any time.

You cannot create, modify, or delete baselines if you are viewing a snapshot.
For more information about snapshots, see View changes in the project
schedule and add savepoints (page 620).

Create a baseline plan
1. In the Project Schedule dialog box, go to the Baseline Plan tab.

2. Click New Baseline. 
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3. In the Description field, type a description for the baseline plan. 

The first baseline plan will automatically be named as Initial
Baseline, but you can modify the name according to your needs.

4. If you want to use the baseline plan as the current baseline plan, select
the Is Current Baseline Plan check box.

5. If you want to assign resources to the baseline plan and include the
baseline plan in the production schedule, select the Include on
Production Schedule check box. 

If you do not want the baseline plan to be shown in the production
schedule and resource capacity, clear the Include on Production
Schedule check box. For example, this might be the case if the production
schedule is created only for quoting.

6. Click Add. 

The baseline is created. You can now further modify its properties.
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7. To select the calendar that determines the working days and non-working
days in the project, click the arrow on the right side of the Calendar field
and select a calendar in the list. 

To modify the available calendars, go to Maintenance --> Project
Management --> Schedule Calendars .

8. Modify the remaining baseline properties according to your needs. 

Option Description
Assembly Quantity The total number of assemblies in the project. This

value is automatically updated when you update
the status of the project schedule.

Type the total number of assemblies in the
Assembly Quantity field.

Part Quantity The total number of parts in the project.

This value is automatically updated when you
update the status of the project schedule.

Type the total number of parts in the Part
Quantity field.

Weight The total weight of the materials in the project.
This value is automatically updated when you
update the status of the project schedule.

Type the total weight in the Weight field.

9. To define the available breakdown levels, click the arrows next to the
breakdown fields in the Project Breakdown section of the dialog box. 

By default, two levels of breakdown items (sequences and lot numbers)
are available. To make more levels available, select options in the
Breakdown Field 3, Breakdown Field 4, and Breakdown Field 5 lists. If
you do not want a breakdown level to be available, select None.

For example, to enable categories as the breakdown level below lots,
select Category in the Breakdown Field 3 list.

10. Click Save.
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Copy the current schedule status to baseline columns

1. On the Baseline Plan tab, click Set Baseline.

2. In the confirmation dialog box, click Yes to set the baseline values.

The baseline is saved, and the baseline dates update in the blank columns.

Manage projects 618 View and adjust the project schedule



Change the current baseline plan

• On the Baseline Plan tab, click the arrow on the right side of the Select a
Baseline Plan field, and select the desired baseline in the list.

The new baseline plan is displayed in the Project Schedule dialog box.

View the total values and breakdown information of the project
• To display the total values of the project, on the Baseline Plan tab, click the

arrow on the left side of Summary Totals.

• To display the breakdown information of a task, select a task on Baseline
Plan tab, and the click the arrow on the left side of Breakdown Summary. 

The number of breakdown items and the average assembly quantity, part
quantity, and weight are displayed for the selected task.

• To select if actual total values, baseline total values, or both are displayed
for the totals and the breakdown summary, click the arrow on the right
side of the Show Totals list, and select an option in the list.

Modify a baseline plan

1. On the Baseline Plan tab, click Baseline Properties.

2. In the Baseline Plan dialog box, modify the baseline plan properties
according to your needs. 
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For more information on the properties, see Create a baseline plan.

3. Click Save to save the changes.

Delete a baseline plan
Deleting a baseline plan is permanent and cannot be undone.

1. On the Baseline Plan tab, click the baseline plan that you want to delete.

2. Click Delete Baseline.

3. In the confirmation dialog box, click Yes to permanently delete the
baseline.

View changes in the project schedule and add savepoints
Snapshots represent the baseline plan at previous points in time. Each time
you make a change to the project schedule, Tekla EPM automatically takes a
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snapshot. You can then use the snapshots to compare the project schedule at
two different points in time and view the impacts of changing the schedule.
You can also load existing snapshots to view the project schedule at a
particular point in time. If you want to mark the snapshot as a particularly
important point in time, you can record it as a savepoint.

1. Click the arrow on the left side of Snapshots to expand the Snapshots
section. 

You can see the currently displayed snapshot after Currently Viewing
Snapshot. If you are viewing the current project schedule, the value will
be [Current].

2. Do any of the following: 

To Do this
Load a snapshot a. Click the arrow on the right side of the

Schedule Snapshot field, and select a
snapshot in the list.

If you only want the list to display the
savepoints that have been recorded, select the
Only Show Savepoints check box.

b. Click Load Snapshot.

The Project Schedule dialog box displays the
project schedule at the selected point in time.

To view the current project schedule again, in the
Schedule Snapshot list, select [Current].

Record a savepoint a. In the Project Schedule dialog box, make any
changes.

b. Click Record Savepoint.

c. In the first confirmation dialog box, click Yes to
save the changes you made.

d. In the second confirmation dialog box, click
Yes to confirm entering edit mode.

When you are in the edit mode, other users
cannot make conflicting changes to the project
schedule.

e. In the Snapshot: Edit Mode dialog box, type a
description for the savepoint.

f. Ensure that the Is Savepoint check box is
selected.

g. Click Save.
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To Do this
h. In the third confirmation dialog box, click Yes

to confirm entering edit mode.

This way, no other user can make conflicting
changes to the project schedule at the same
time.

Add, modify, and delete schedule tasks
Schedule tasks are events that occur or actions that are taken during a project.
In the Schedule Tasks dialog box, you can add, modify, and delete schedule
tasks. Tasks can be organized into a hierarchy that contains main tasks and
sub-tasks. In this case, the statuses of the main tasks are aggregated from the
sub-tasks.

Add a task to the project schedule
1. In the Project Schedule dialog box, open the Schedule Tasks tab.

2. Click New. 

The Schedule Tasks dialog box opens. The tasks already in the schedule
are displayed in the navigation tree on the left-hand pane.

3. Type a description for the new task.

4. Modify the task properties according to your needs: 

The available properties are:

Option Description
Parent Task If the task you are creating is a sub-task, for an

existing task, you need to select the main task.

Click the arrow on the right side of Parent Task
field, and select a task in the list. If you are creating
a top-level task, select None.

Note that you cannot modify the task type,
duration, or original estimate time of a main task if
you add a sub-task.

Task Type Specifies the behavior of the task on the Gantt
Chart tab. The available task types are:

• Start/End: an action to be performed over a
period of time. Properties include the start
date, end date, and duration.

Start/end tasks can be directly re-sized an
moved on the Gantt Chart tab.
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Option Description
• Summary: takes the aggregate values from its

sub-tasks. The start date of a summary task is
automatically set to the earliest date of the sub-
tasks. The end date is set to the latest sub-task
end date, and the percent completed is
aggregated based on the status summary
method.

Summary tasks cannot be re-sized on the
Gantt Chart tab directly. However, the sub-
tasks can be re-sized and moved, and the
summary main task will re-sized and moved
accordingly.

• Milestone: an event in the schedule. For
example, a project kickoff meeting can be a
milestone task. The end date and the start date
are always the same, and the duration is set to
one day.

Sequence, Lot #, and
other breakdown
category check boxes

When selected, the task is divided into sub-tasks by
the breakdown category. This means that you have
to add the breakdown category for all items when
adding them.

Note that the project breakdown check boxes
cannot be selected or cleared when the task has
been added.

Apply Breakdown
Links

When selected, the links set in the project schedule
are added between sub-tasks. For example, any
links set between sequences 1, 2, and 3 would be
added.

When cleared, the links set between sub-tasks are
not added, even if they have been set in the project
schedule.

Duration The expected number of working days to complete
a task.

The duration can only be adjusted if the task type
is set to Start/End.

Type the number of days in the Duration field.
Original Estimate The time originally estimated for the entire main

task or a sub-task. The hours will automatically be
distributed among the sub-tasks on the Gantt
chart.

Type the time in man hours in the Original
Estimate field.
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Option Description
Status Link The information that affects the status of the task

when the project schedule is updated. The
available options are:

• Drawings Approved: the number of drawings
with the Approved status.

• Material Purchased: the production material
that is linked to material that is either in stock
or on order.

• Material Received: the production material
that is linked to material that is in stock.

• TFS: the production material that has been cut.

• Production Completed: the production
material that has been assigned a route and
has completed all stations in that route.

• Production Progress: the production material
that has been assigned a route and has
completed some stations in that route.

• Station Progress: the production material that
has been assigned a route that includes the
selected station and has completed that
station.

• Shipping Destination Progress: the
production material that has been assigned a
shipping route that includes the selected
destination and has completed that destination.

• Shipping Completed: the production material
that has completed all assigned shipping
destinations.

Click the arrow on the right side of Status Link
field, and select an option in the list.

Status Summary
Method

The method that determines how the percentage
completed of a main task will be calculated from
the sub-tasks. Each option specifies the weight that
is given to each sub-task in the calculation. The
available options are:

• No Factor: no weight is given to the individual
sub-tasks. The percentage completed of the
main task is an average of the sub-tasks.

• By Quantity: the percentage completed is
weighed by the quantity of each sub-task.
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Option Description
• By Weight: the percentage completed is

weighed by the weight of each sub-task.

• By Duration: the percentage completed is
weighed by the duration of each sub-task.

Click the arrow on the right side of Status
Summary Method field, and select a calculation
method in the list.

Resource An object with a time-based capacity to be added
on a production schedule, and the resource by
which station work will be executed.

Linking a task from the project schedule to a
resource connects the project and production
schedules.

Click the arrow on the right side of Resource list,
and select a resource in the list.

Assigned To The Tekla EPM user that who task is assigned to.

5. Click Add.

6. Select the new task in the navigation tree.

7. In the Link Tasks section of the dialog box, define dependencies between
two tasks. 

By creating links, you can make the schedule cascade from one task to
another.

Note that:

• A task cannot link to itself.

• A link cannot be created between a task and one of its sub-tasks.

• Duplicate links are not allowed. There can be only one link between a
pair of tasks.

• Link cycles are not allowed. For example, if a link is created from task 1
to task 2, a link cannot be created from task 2 to task 1.

• When you use links, and the duration of an item changes, the positions
of all linked items also changes. Do not link items that need to remain
static, or are independent from other items in the schedule.

Do any of the following:

To Do this
Add a link that ends with
the current given task

Note that if a previous snapshot is displayed
instead of the current project schedule
information, you cannot add a predecessor link.

a. Click New Predecessor Link.
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To Do this
b. Click the arrow on the right side of Link From

list, and in the list, select the starting task of
the link.

c. Click the arrow on the right side of upper
Position field, and in the list, select if the link
originates from the start or end of the starting
task.

d. Click the arrow on the right side of lower
Position field, and in the list, select if the link
ends at the start or finish of the second task.

e. In the Minimum Interval field, type the
minimum number of working days between
the two tasks.

The minimum interval is enforced in the Gantt
chart. The later task cannot be moved earlier
in the Gantt chart than the value in the
Minimum Interval field determines.

f. Click Add.

g. In the confirmation dialog box, click Yes.

For example, to define that shipping must start
when the fabrication is finished, select Shipping
and set the link a follows:

• Link From: Fabrication

• Upper Position: Finish

• Lower Position: Start

• Minimum Interval: 0 days
Add a link that begins
with the current task

Note that if a previous snapshot is displayed
instead of the current project schedule
information, you cannot add a successor link.

a. Click New Successor Link.

b. Click the arrow on the right side of the upper
Position field, and in the list, select if the link
originates from the start or end of the starting
task.

c. Click the arrow on the right side of the Link To
field, and in the list, select the task that is the
ending point of the link.

d. Click the arrow on the right side of the lower
Position field, and in the list, select if the link
ends at the start or finish of the second task.
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To Do this
e. In the Minimum Interval field, type the

minimum number of working days between
the two tasks.

The minimum interval is enforced in the Gantt
chart. The later task cannot be moved earlier
in the Gantt chart than the value in the
Minimum Interval field determines.

f. Click Add.

g. In the confirmation dialog box, click Yes.

For example, to define that shipping must start
when the fabrication is finished, select Fabrication
and set the link a follows:

• Upper Position: Finish

• Link To: Shipping

• Lower Position: Start

• Minimum Interval: 0 days
View and modify link
properties

a. Click Link Properties.

b. Modify the starting task, ending task, the task
positions, and interval according to your
needs.

c. Click Save to update the link properties.
Delete a link a. Click a link in the list to select it.

b. Click Delete Link.

c. In the confirmation dialog box, click Yes to
permanently delete the links.

8. To save the links, click Save.

9. If necessary, add notes about the task:

a. In the navigation tree on the left-hand pane, click the task to which
you want to add notes.

b. At the bottom of the dialog box, click Notes.

c. In the Notes dialog box, click New.

d. Type any notes about the task.

e. Click Add.

f. In the confirmation dialog box, click Yes.
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g. Click the Close button (X) to close the Notes dialog box.

Repeat the process for each task that you want to add.

Move a task earlier or later in the schedule
1. Select the task that you want to move.

2. Click the Move Up and Move Down buttons to move the task earlier or
later.

Modify a task
1. In the navigation tree on the left-hand pane, click the task that you want

to modify.

2. Modify the task properties and links according to your needs. 

For more information on the properties and links, see Add a link to the
project schedule.

3. Click Save to save the changes.

Delete a task
1. In the navigation tree on the left-hand pane, click the task that you want

to delete from the schedule.

2. Click Delete Task.

3. In the confirmation dialog box, click Yes to permanently delete the task.

Save schedule tasks as a schedule template
Schedule templates can contain all of the schedule items and attributes
required for a typical setup. By saving a set of schedule tasks as a schedule
template, you can apply the same schedule tasks in multiple jobs. The times
and other details can be modified for each project, but the tasks, child tasks,
and links remain the same.

1. In the Schedule Tasks dialog box, modify the schedule tasks to meet your
needs. 

For more information, see Add, modify, and delete schedule tasks
(page 622).

2. Click the Schedule Tasks ribbon tab.

3. On the menu, select Save As Template.

4. Type a description for the template.

5. Click OK to save the template. 

A message opens, telling you that the template is saved.
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6. Click OK to close the message.

Add, modify, and delete breakdown items
Schedule breakdown items allow you to divide a project into sub-tasks to
schedule and track the completion of tasks. Sequences and lots are often used
as breakdown items, so that tasks can be performed for each sequence and
lot separately. You can add new breakdown items, modify existing ones,
change the priorities of breakdown items, and delete any unnecessary
breakdown items.

Add a new breakdown item
Note that if you cannot add new breakdown items if you are currently viewing
a snapshot. For more information, see View changes in the project schedule
and add savepoints (page 620)

1. On the Project Breakdown tab of the Project Schedule dialog box, click
New. 
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2. In the Schedule Breakdown Item dialog box, define properties for the
new breakdown item. 

Option Description
Parent Breakdown
Item

If the breakdown item you are creating is a sub-
item for another existing breakdown item, you
need to select the main breakdown item.

Click the arrow on the right side of Parent
Breakdown Item field, and select a breakdown
item in the list. If you are creating a top-level
breakdown item, select None.

Note that the main breakdown item cannot be
changed after the breakdown item is added.

Sequence, Lot #,
Category, Sub-
Category, Pay Category

The breakdown value that associates the
breakdown item with the relevant project data.

Note that the breakdown value must match the
project data exactly. For example, the sequence
number in the Sequence field must be exactly the
same as in the production control job. Otherwise,
the project data cannot be updated properly.

Type the breakdown value in the field.
Description The description of the breakdown item. For

example, First floor beams and columns.

Type a description in the Description field.
Include in Task
Description

When selected, the breakdown item description
will be included in the task description in addition
to the breakdown value.

For example, if the description of sequence 6 is
Third Floor Beams, and the Include in Task
Description check box is selected, the description
of the resulting task in the Gantt chart will be
Sequence: 6 - Third Floor Beams. Instead, if
the Include in Task Description check box is
cleared, then the description of the task in the
Gantt chart will be Sequence: 6.

Assembly Quantity The total number of assemblies associated with
the breakdown item. This value is automatically
updated when you update the project schedule
status.

Type the total number of assemblies in the
Assembly Quantity field.

Part Quantity The total number of parts associated with the
breakdown item. This value is automatically
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Option Description
updated when you update the project schedule
status.

Type the total number of parts in the Part
Quantity field.

Weight The total material weight associated with the
breakdown item. This value is automatically
updated when you update the project schedule
status.

Type the total weight in the Weight field.

3. Click the Apply to Tasks tab to open it.

4. To select the schedule tasks to which the breakdown item is applied, do
one of the following:

• To apply the breakdown item to all schedule tasks, select the All check
box.

• To only apply the breakdown item to specific schedule task, click
Select, use the arrow buttons to move the desired tasks to the
Included list, and click OK.

When you apply the breakdown item to a task, the task becomes a
summary task with sub-tasks automatically created under it for each sub-
item.

5. Do any of the following to determine which links will be applied between
the sub-tasks:

a. According to your needs, do one of the following: 

• To create a link from the previous breakdown item to the current
one, select the Link from Previous Breakdown Item check box.

The Link from Previous Breakdown Item cannot be selected if
the current breakdown item is the first breakdown item or the
first sub-item under a main breakdown item.

• To create a link from any previous breakdown item with the same
main breakdown item to the current one, click the arrow on the
right side of the Link from Specific Breakdown Item field, and
select a breakdown item in the list.

Links will be created from the sub-task associated with that
breakdown item.

b. Click the arrow on the right side of the Link Type field and select a
link type in the list. 

The options are:

• Start-Start

• Finish-Start
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• Start-Finish

• Finish-Finish

c. In the Minimum Interval field, type the minimum number of
working days between the two sub-tasks.

For example, to create a link from the start of a sequence to the start of a
second sequence, the second sequence starting 5 working days after the
previous one, you should set the link details as follows:

• Link Type: Start-Start

• Minimum Interval: 5 days
6. Click Add.

The breakdown item and its link details are added to the project schedule. You
can see the breakdown item in the navigation tree on the left side of the dialog
box.

Modify a breakdown item
You cannot modify breakdown items if you are currently viewing a snapshot.
For more information, see View changes in the project schedule and add
savepoints (page 620).

1. On the Project Breakdown tab of the Project Schedule dialog box, click
the breakdown item that you want to modify.

2. Click Properties.

3. Modify the properties of the breakdown item according to your needs: 

Option Description
Sequence, Lot #,
Category, Sub-
Category, Pay Category

The breakdown value that associates the
breakdown item with the relevant project data.

Note that the breakdown value must match the
project data exactly. For example, the sequence
number in the Sequence field must be exactly the
same as in the production control job. Otherwise,
the project data cannot be updated properly.

Type the breakdown value in the field.
Description The description of the breakdown item. For

example, First floor beams and columns.

Type a description in the Description field.
Include in Task
Description

When selected, the breakdown item description
will be included in the task description in addition
to the breakdown value.

For example, if the description of sequence 6 is
Third Floor Beams, and the Include in Task
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Option Description
Description check box is selected, the description
of the resulting task in the Gantt chart will be
Sequence: 6 - Third Floor Beams. Instead, if
the Include in Task Description check box is
cleared, then the description of the task in the
Gantt chart will be Sequence: 6.

Assembly Quantity The total number of assemblies associated with
the breakdown item. This value is automatically
updated when you update the project schedule
status.

Type the total number of assemblies in the
Assembly Quantity field.

Part Quantity The total number of parts associated with the
breakdown item. This value is automatically
updated when you update the project schedule
status.

Type the total number of parts in the Part
Quantity field.

Weight The total material weight associated with the
breakdown item. This value is automatically
updated when you update the project schedule
status.

Type the total weight in the Weight field.

4. Click the Apply to Tasks tab to open it.

5. To modify the schedule tasks to which the breakdown item is applied, do
one of the following:

• To apply the breakdown item to all schedule tasks, select the All check
box.

• To only apply the breakdown item to specific schedule task, click
Select, use the arrow buttons to move the desired tasks to the
Included list, and click OK.

6. Do the following to modify which links will be applied between the sub-
tasks:

a. Do one of the following: 

• To create a link from the previous breakdown item to the current
one, select the Link from Previous Breakdown Item check box.

The Link from Previous Breakdown Item cannot be selected if
the current breakdown item is the first breakdown item or the
first sub-item under a main breakdown item.

• To create a link from any previous breakdown item with the same
main breakdown item to the current one, click the arrow on the
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right side of the Link from Specific Breakdown Item field, and
select a breakdown item in the list.

Links will be created from the sub-task associated with that
breakdown item.

b. Click the arrow on the right side of the Link Type field and select a
link type in the list. 

The options are:

• Start-Start

• Finish-Start

• Start-Finish

• Finish-Finish

c. In the Minimum Interval field, type the minimum number of
working days between the two sub-tasks.

7. Click Save to update the breakdown item properties.

Change the priority of a breakdown item
Moving breakdown items up or down in the list changes their priority. If you
move a breakdown item up, its priority is swapped with the previous
breakdown item, whereas if you move a breakdown item down, its priority is
swapped with the following breakdown item. For example, moving an item
with the priority 1.3 up would change its priority to 1.2.

You cannot move breakdown items up or down if you are currently viewing a
snapshot. For more information, see View changes in the project schedule and
add savepoints (page 620).

1. On the Project Breakdown tab of the Project Schedule dialog box, click
the breakdown item that you want to move.

2. Click the Move Up and Move Down buttons.

3. In the confirmation dialog box, click Yes to confirm moving the
breakdown item.

Delete a breakdown item
Note that deleting a breakdown item is permanent and cannot be undone. All
sub-items of the selected breakdown item are deleted as well.

You cannot delete a breakdown item if you are currently viewing a snapshot.
For more information, see View changes in the project schedule and add
savepoints (page 620).

1. On the Project Breakdown tab of the Project Schedule dialog box, click
the breakdown item that you want to delete.

2. Click Delete.
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3. In the confirmation dialog box, click Yes to permanently delete the
breakdown item.

Modify the Gantt chart
The chart on the Gantt Chart tab of the Project Schedule dialog box gives
you a visual representation of the schedule. You can modify the view of the
Gantt chart according to your needs by including and excluding items, and
scaling the chart. You can also move the tasks in the Gantt chart to move them
earlier or later in the project schedule.

To modify the Gantt chart, do the following:

1. In the Project Schedule dialog box, click the Gantt Chart tab to open it.

2. To enable modifying the information, click Enter Edit Mode in the lower-
left corner, or press Ctrl+E on the keyboard.

In the Gantt chart, you can see the following information:

• The left side of the tab shows the properties of schedule tasks.

• The right side of the tab shows the schedule tasks visually as bars on the
time line.

The tasks look different and behave differently depending on their task
type:

• Summary tasks (or main tasks) are displayed as orange bars. A
summary task cannot be re-sized directly. Instead, you can re-size and
move the sub-tasks to change the duration or dates of the summary
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task. When a summary task is moved earlier or later, the sub-tasks are
moved by the same number of days.

• Start/End tasks are displayed as blue bars. Start/End tasks can be re-
sized and moved in the Gantt chart.

• Milestone tasks are displayed as blue diamonds. Milestones can be
moved in the Gantt chart, but they cannot be re-sized.

• Links between tasks are represented by arrows from the predecessor tasks
to the successor tasks.

• Any cells that are highlighted with yellow can be modified.

Right-click anywhere in the Gantt chart to find shortcuts to more commands:

• Goto Task zooms to the beginning of the bar of the selected task.

• Time Tracking Summary opens the Time Tracking Summary dialog box.
For more information, see Add, modify, and view time tracking information
(page 645).

• Time Tracking Detail opens the Time Tracking Detail dialog box. For
more information, see Add, modify, and view time tracking information
(page 645).

• Time Tracking Input opens the New Time Tracking Record dialog box.
For more information, see Add, modify, and view time tracking information
(page 645).

• Production Schedule allows you to view the production schedule. For
more information, see View the production schedule (page 767).

• Date Filter allows you to select a date range that you want to see in the
Gantt chart. When you apply the filter, tasks that are at least partially within
the entered date range will be visible.

• Scale chart to options: scale the Gantt chart to day, week, or month,
according to your needs.

• Show Links/Hide Links shows or hides the links between tasks.

• Show Overview/Hide Overview shows or hides the overview section
above the Gantt chart.

• Expand All expands all summary tasks so that all sub-tasks are visible.

• Expand Summary expands the task hierarchy so that all summary tasks
are visible. Sub-tasks are not displayed.

• Expand Level expands the selected task and other tasks with the same
main task.

• Collapse All collapses all summary tasks.

• Save Image allows you to save the Gantt chart as a single image file.
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Modify the dates of tasks
1. Do one of the following:

• Click the Start or End cell of the task, and select a date in the calendar.

• Click the task bar, hold down the left mouse button, drag the task
earlier or later in the schedule, and release the left mouse button.

Note that:

• If the task has one or more predecessor links, the bar cannot be
moved earlier than the predecessor tasks and link intervals determine.

• If the task has one or more successor links, when the task is moved
later, the successor tasks will also be moved later, if that is necessary
to maintain the link interval.

Repeat this process for all tasks to move them in the correct locations.

2. Click Save.

Modify the duration of tasks
1. Do one of the following:

• Click the Duration cell of the task and type a new value in the cell.

• Move the mouse pointer over the beginning or the end of the task bar
until a two-headed arrow appears, drag the start or end position of the
bar earlier or later, and release the mouse button.

Note that:

• If the task has one or predecessor links, the bar cannot be changed to
start earlier than the predecessor tasks and link intervals determine.

• If the task has one or more successor links, when the task is changed
to end earlier, any successor tasks will be moved earlier by the same
number of days in order to keep their relative position the same.

• If the task has one or more successor links, when the task is changed
to end later, the successor tasks will be moved later, if that is
necessary to maintain the link interval.

2. Click Save.

Modify task properties
On the left side of the Gantt chart, you can modify the task properties, such as
the duration, completion percentage, or used resource.

Note that only cells that are highlighted with yellow can be modified.

1. On the left side of the dialog box, click a cell of the task.

2. Modify the value in the cell according to your needs.
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3. Click Save to update the project schedule.

Modify display settings
1. Click the arrow on the right side of Gantt Chart Display Settings to

expand the display settings. 

2. Modify the following options according to your needs: 

Option Description
Task ID The unique identifier of the task in the project

schedule.
Baseline Start Date,
Baseline End Date

The start and end dates of the task when the
baseline was set.

If the baseline has not been set, the BL Start and
BL End cells are blank.

Baseline Duration The duration of the task when the baseline was
set.

If the baseline has not been set, the BL Duration
cells are blank.

Baseline Quantity The quantity of the task when the baseline was set.

If the baseline has not been set, the BL Quantity
cells are blank.

Baseline Weight The weight of the task when the baseline was set.

If the baseline has not been set, the BL Weight
cells are blank.
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Option Description
Baseline Planned
Hours

The total planned hours of the task when the
baseline was set.

If the baseline has not been set, the BL Hours cells
are blank.

Actual Start Date The actual start date of the task in the project
schedule.

To change the start date, click the arrow on the
right side of the Start cell, and select a date in the
calendar.

When you change the start date, the task will move
to the selected date in the Gantt chart. The
duration of the task will remain the same, so the
task will not be resized.

Actual End Date The actual end date of the task in the project
schedule.

To change the end date, click the arrow on the
right side of the End cell, and select a date in the
calendar.

When you change the end date, the duration of the
task will change accordingly in the Gantt chart, and
the task will be re-sized.

Actual Duration The actual duration of the task in the project
schedule.

To change the duration, type a new value in the
Duration cell.

When you change the duration, the end task of the
task will change accordingly in the Gantt chart, and
the task will be re-sized.

Actual Quantity The quantity related to the task in the bill of
materials.

This value is set when you update the project
schedule (page 644).

Actual Weight The weight related to the task in the bill of
materials.

This value is set when you update the project
schedule (page 644).

Percent Completed The percentage of the task that is completed.

To change the percentage, click the % Comp cell
and type a percentage in the cell.

When you change the percentage, the percentage
completed of the main tasks will automatically be
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Option Description
updated based on the summary status method
task setting. For more information, see Add,
modify, and delete schedule tasks (page 622).

Original Estimate The number of original estimate hours applied to
the task.

If the task is divided by sequences, lots, or other
breakdown fields, the hours will be distributed to
the resulting tasks on the Gantt Chart, weighed by
duration.

To adjust the original estimate hours, click the
Orig. EST cell and type the number of hours in the
field.

When you adjust the original estimate hours, the
adjusted number of hours will appear in italics in
the Gantt Chart. The remaining hours will be
redistributed among the tasks that have not been
manually adjusted. You can return to the
automatic distribution of hours by clearing the
value in the Orig. EST cell.

Unreleased Hours The number of original estimate hours that have
not yet been released, calculated by the Percent
Released value.

For example, if the original estimate is 500 hours
and the task is 20% released, the number of
unreleased hours will be 400.

Planned Hours (Base
Hours)

The planned hours that have been released.

Tasks that have the Status Link option selected
will have this field updated automatically when the
project schedule status is updated (page 644). For
more information, see Add, modify, and delete
schedule tasks (page 622).

Adjustment Hours Allows you to manually adjust the planned hours.

To adjust the number of planned hours, click the
Adjustment cell, and type a value.

Percent Released The percentage of the original estimate hours that
have been released and that appear in the Base
Hours field. This field will update automatically
when the planned hours are updated.

For example, if the original estimate is 500 hours
and the planned hours is updated to 100 hours,
the percentage released is 20%. This will in turn
update the unreleased hours to 400.
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Option Description
Once all material associated with a task has been
released, the percent released may need to be
manually adjusted, so that no further unreleased
hours are included in the total planned hours. Let's
say that a task is broken out into 4 sequences and
the original estimate is 2,000 hours. If all 4
sequence tasks have the same duration, each one
will receive 500 of the original estimate hours. The
drawings are submitted for sequence 1, and after
the next status update, the planned hours are set
to 100 hours, which will update the percent
released to 20%. Since Tekla EPM does not know if
all of sequence 1 has been received, the remaining
unreleased hours will still be included in the total
planned hours calculation. If everything has in fact
been received for sequence 1, you can manually
set the percent to 100%, so that no further
unreleased hours will be included in the total
planned hours.

To adjust the percentage, click in the % Released
cell, and type a percentage in the cell. When you
manually adjust the released hours, the number
will appear in italics. When you have manually
adjusted the percentage released, the value will
not be automatically adjusted according to any
changes made to the planned hours. To return to
the automatic calculated value, clear the value in
the cell.

Total Planned Hours
(Plan Hours)

The total number of the unreleased hours, planned
hours, and adjustment hours for the task.

Linked Hours The number of hours updated according to the
Status Link option. For example, the Production
Progress, Production Completed, and Station
Progress options will update the linked Linked
Hours with the hours entered in Piece Tracking.
For more information, see Add, modify, and delete
schedule tasks (page 622).

To adjust the number of linked hours, click the
Linked Hours cell, and type the number of hours.

Regular Hours The regular hours associated with the task,
entered in time tracking. For more information, see
Add, modify, and view time tracking information
(page 645).

Overtime Hours The overtime and double overtime hours
associated with the task, entered in time tracking.
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Option Description
For more information, see Add, modify, and view
time tracking information (page 645).

Total Hours The total hours worked on the task, coming from
either the linked hours or the regular and overtime
hours from time tracking.

To ensure that the time is not duplicated, the time
tracking hours override the linked hours. If the
number of either regular or overtime hours is
greater than zero, the total hours will be set to the
regular hours plus the overtime hours. If the
number of both regular and overtime hours is
zero, the total hours will be set to the linked hours.

Utilization Percent The utilization percentage is calculated as the
percentage of the total hours compared to the
total planned hours.

For example, if the number of total planned hours
is 500 and the number of total hours is 200, the
utilization percentage will be 40%.

If the utilization percentage is over 5% greater than
the percentage of the task completed, the
utilization percentage will be highlighted in red. In
this example, if the percent completed is 35% or
less, the utilization percentage of 40% will be
highlighted in red.

Assigned to User The user who is responsible for the task. For more
information, see Add, modify, and delete schedule
tasks (page 622).

To change the assigned user, click the arrow on the
right side of the Assigned To cell and select a user
in the list.

Resource The resource that the task has been assigned to
for production scheduling purposes. For more
information, see Add, modify, and delete schedule
tasks (page 622) andView the production schedule
(page 767).

To change the resource, click the arrow on the
right side of the Resource cell and select a
resource in the list.

Predecessors The linked tasks that are immediate predecessors
of the task.

Successors The linked tasks that are immediate successors of
the task.
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Option Description
Show Links When selected, Tekla EPM shows task links as

arrows in the Gantt chart.
Show Overview When selected, Tekla EPM shows the overview

section above the Gantt chart.
Show Baseline Bars When selected, Tekla EPM shows the baseline

dates as a yellow bar on the Gantt chart as set
when the baseline was set.

The baseline overlay bars will not be shown if:

• The baseline has not been set.

• The task has the same start and end dates as
the baseline dates.

• The task has been added after the baseline was
set.

3. Click Save to update the Gantt chart.

Print a Gantt chart report
You can create and print a report that is an exact copy of the Gantt chart. Note
that all content that you have selected in the Gantt Chart Display Settings
section will be visible in the report as well.

1. In the lower-right corner of the Gantt Chart tab, click Report.

2. In the Print Review dialog box, click Setup... and adjust the paper size,
orientation, margins, and printer properties according to your needs.

3. Click Print.

4. When the report has been printed, click Close to close the Print Review
dialog box.

Apply a schedule template
Schedule templates can contain all of the schedule items and attributes
required for a typical setup. Existing schedules can be saved as templates, and
then applied to a new job using the Apply Template button. The schedule can
always be modified to fit the project requirements.
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1. Open the Schedule Tasks dialog box.

2. In the lower-right corner, click Apply Template.

3. In the Enter Value dialog box, click the arrow on the right side of the field,
and select the schedule template that you want to use.

4. Click OK. 

The schedule template is now applied to the project schedule.

5. Click the Close button (X) to close the Schedule Tasks dialog box.

Update the project schedule
When you update a project schedule, Tekla EPM collects all time and progress
status information on the current project in Production Control, Project
Management, and Purchasing. Once the update process is ready, all activity
is updated to the chart on the Gantt Chart tab. For example, if drawings have
been submitted and approved, the percentage completed for drawing
submittal will be updated.
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You can see the last time the project schedule was updated in the upper-right
corner of the Project Schedule dialog box, after Last Status Update.

1. In the upper-right corner of the Project Schedule dialog box, click
Update Status. 

The Status Update dialog box opens, displaying the progress of the
update process.

2. Once the update is completed, click the Close button (X) to close the
Status Update dialog box.

Add, modify, and view time tracking information
Use the time tracking commands to add time tracking records to a project
schedule, and to view and modify the existing time tracking records.

Add a time tracking record
1. In the Project Schedule dialog box, click the Project Schedule ribbon tab.

2. On the menu, select Time Tracking Input. 
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3. In the New Time Tracking Record dialog box, define the following
properties: 

Option Description
Employee The Tekla EPM user who is adding the record. Tekla

EPM automatically uses the user that is logged in,
but you can select another user as well.

Note that the Employee field is optional. If you do
not want the hours entered to be applied to a
specific employee, you can leave the field blank.

Click the arrow on the right side of Employee field,
and select a user in the list.

Project The project management job for which you are
adding the time record.

Click the arrow on the right side of Project field,
and select a project management job in the list.

Task The schedule task for which you are adding the
time record.

The Task field is optional. If you leave the field
blank, the time record will be applied to the project
as a whole.

Click the arrow on the right side of Task field, and
select a schedule task in the list.
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Option Description
Station The station for which you are adding the time

record.

The Station field is optional. If you leave the field
blank, the time record will be applied to the project
as a whole.

Click the arrow on the right side of Station field,
and select a station in the list.

Sequence The sequence for which you are adding the time
record.

The Sequence field is optional. If you leave the
field blank, the time record will be applied to the
project as a whole.

Click the arrow on the right side of Sequence field,
and select a sequence in the list.

Lot # The lot for which you are adding the time record.

The Lot # field is optional. If you leave the field
blank, the time record will be applied to the project
as a whole.

Click the arrow on the right side of Lot # field, and
select a lot number in the list.

4. Click the arrows on the right side of the Start and End fields, and select
the start and end dates and times in the calendar. 

Tekla EPM automatically calculates the number of working hours. The
calculation method that is used can be set in Time Tracking Settings.

5. If necessary, modify the working hours according to your needs:

a. In the Regular field, type the time that will be logged as regular hours
for the project, task, station, sequence, or lot.

b. In the OT and OT2 fields, type the time that will be logged as overtime
and double overtime hours for the project, task, station, sequence, or
lot.

c. In the Deduction field, type the time used for unpaid activities, such
as lunch. This time will not be logged against the project, task, station,
sequence, or lot.

If the start and end times and the hours that you added do not match,
you can adjust the difference by double-clicking the field where you added
hours. For example, if the difference between the start and end time is 2
hours and you enter 1.50 for regular hours, double-clicking the OT field
will set its value to 0.50.

If the total hours are less than the difference between the start and end
time, the difference will automatically be added as deduction hours.
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6. Click Save.

The record is added.

Note that Tekla EPM does not save the record if:

• Two time tracking records marked to the same Tekla EPM user overlap.

• A Tekla EPM user is selected and the total sum of regular, overtime, and
double overtime hours is greater than the difference in the start and end
time.

Modify, delete, or import time tracking records
1. In the Project Schedule dialog box, click the Project Schedule ribbon tab.

2. On the menu, select Time Tracking Detail. 

3. In the Time Tracking Filters dialog box, click the arrows on the right side
of the fields in the Start Date and End Date sections, and select the
minimum and maximum start and end dates in the calendars.

4. To only view and modify specific time tracking records, click the available
filtering buttons.

5. In the filter dialog box, click the arrow buttons to move the values that you
want to include to the Included list.

6. Click OK.

7. Click Apply Filter. 

The Time Tracking Detail dialog box opens, displaying all previously
created time tracking records.

To only view records that match particular criteria, you can select items in
the navigation tree on the left.

8. Do any of the following: 

To Do this
Modify a time tracking
record

a. Click Properties.

b. Modify the properties of the time tracking
record.

For more information, see Add a time tracking
record.

c. Click Save to update the time tracking record.
Import time tracking
records

a. Click the Time Tracking Detail ribbon tab.

b. On the menu, select Import Time Tracking
Records - Excel.

c. In the Open dialog box, browse to find the file
that you want to import.
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To Do this
d. Double-click the file.

e. In the Verify Excel Import Data dialog box,
verify the time tracking information.

f. If you want to exclude a row in Microsoft Excel,
hold down Alt and double-click a row.

g. Click OK.

h. In the Import Field Map dialog box, click an
import field in the list.

i. Select the corresponding field in the Tekla
EPM Field list and click Set Field Mapping.

j. Click OK.

The import starts.

k. When the import is completed, click Open
Import Log and view the import details.

l. Click the Close button (X) to close the import
log and the Import dialog box.

Delete time tracking
records

Note that deleting time tracking records is
permanent and cannot be undone.

a. In the Time Tracking Detail dialog box, click
the time tracking records that you want to
delete.

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold
down Shift.

b. Click the Time Tracking Detail ribbon tab.

c. On the menu, select Delete Selected Records.

d. In the first confirmation dialog box, click Yes.

e. In the second confirmation dialog box, click
Yes to permanently delete the tracking
records.

View a time tracking summary
1. In the Project Schedule dialog box, click the Project Schedule ribbon tab.

2. On the menu, select Time Tracking Summary.

3. In the upper-left corner of the Time Tracking Filters dialog box, select
the fields that you want to view in the time tracking summary. 

The selected fields will be columns in the summary.
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4. Click the arrows on the right side of the fields in the Start Date and End
Date sections, and select the minimum and maximum start and end
dates in the calendars.

5. To only view and modify specific time tracking records, click the available
filtering buttons.

6. In the filter dialog box, click the arrow buttons to move the values that you
want to include to the Included list.

7. Click OK.

8. Click Apply Filter. 

A dialog box opens, displaying a summary of the time tracking records
created.

9. View the time tracking information.

10. Do any of the following:

• To create a new time tracking record, click New.

For more information, see Add a time tracking record.

• To access the Time Tracking Detail dialog box, click Time Tracking
Detail.

For more information, see Modify, delete, or import time tracking
records.

• To close the dialog box, click the Close button (X) in the upper-right
corner.

Export the project schedule to XML format
You can export the project schedule and save it in the desired folder as an
XML file. You can select from two XML options: either the option used in
Primavera, or the option used in Microsoft Projects.

1. In the Project Schedule dialog box, click the Project Schedule ribbon tab.

2. On the menu, select Export, and then, select the preferred XML option.

3. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla EPM saves the file to the Export folder.

4. If necessary, change the file name.

5. Click Save.

The project schedule is saved in the selected location as an XML file.
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Create a project schedule report
You can create different project schedule reports according to your needs. You
can either view the completion percentage and duration of the schedule tasks,
or compare the changes made to schedule tasks from one baseline plan to
another.

1. In the Project Schedule dialog box, click the Project Schedule ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. Click the arrow on the right side of the Baseline Plan field of the
Schedule Report dialog box, and select the baseline plan that you want to
use in the report.

4. If you wish, add a snapshot of the selected baseline plan to the report by
clicking the arrow on the right side of the Snapshot field, and selecting a
snapshot in the list. 

If you only want to select from snapshots marked as savepoints, select the
Only Show Savepoints check box.

5. If you want to compare two different versions of the project schedule, do
the following:

a. Select the Run Comparison Report check box.

b. Click the arrow on the right side of the lower Baseline Plan field, and
select a baseline plan in the list.

c. Click the arrow on the right side of the lower Snapshot list, and select
a snapshot in the list. 

To be able to compare two versions of a project schedule, ensure that
you select a different baseline plan and snapshot than in the lists
above.

6. Click Make Report.

7. In the Report Selection dialog box, click the report that you want to view,
print, or export. 

For comparison, click the Comparison Report to view the tasks that have
changed between the two baseline plans.

8. According to your needs, do any of the following: 

To Do this
View the report • In the Report Selection dialog box, click View.

The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF
buttons at the top of the Tekla EPM Report
Viewer window to email the report via Microsoft
Outlook.
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To Do this
Print the report a. In the Report Selection dialog box, change

the number of the printed copies by clicking
the + and - buttons.

b. Click Print.

c. In the confirmation dialog box, click Yes to
confirm printing the report.

d. In the Select Printer dialog box, click a printer
to select it.

e. Click OK.
Export the report a. In the Report Selection dialog box, click

Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Browse to the location where you want to save
the exported file, and click Save.

e. Modify the file name according to your needs.

f. Click Save.

g. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email check box.

h. To open the file after exporting it, select the
Open Exported Document check box.

i. In the Report Selection dialog box, click
Export.

9. To close the dialog box, click the Close button (X) in the upper-right
corner.

Example: Create a project schedule
The following steps provide an example workflow for creating a project
schedule in the Project Schedule dialog box.

1. Apply a schedule template
Schedule templates can contain all of the schedule items and attributes
required for a typical setup. Existing schedules can be saved as templates, and
then applied to a new job using the Apply Template button. The schedule can
always be modified to fit the project requirements.
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1. Open the Schedule Tasks dialog box.

2. In the lower-right corner, click Apply Template.

3. In the Enter Value dialog box, click the arrow on the right side of the field,
and select the schedule template that you want to use.

4. Click OK. 

The schedule template is now applied to the project schedule.

5. Click the Close button (X) to close the Schedule Tasks dialog box.

2. Modify the schedule dates
1. Open the Gantt Chart tab. 
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2. Click Enter Edit Mode. 

Any information that is highlighted with yellow can be modified.

3. To modify what is shown in the chart, click the arrows on the left side of
Gantt Chart Display Settings and select the check boxes for items that
you want to show. 

For more information on the display settings, see Modify the Gantt chart
(page 635).

4. Click Save to update the view. 

You can also modify if the chart displays time as days, weeks, or months.
To do so, right-click anywhere in the chart, and select the suitable Scale
chart to option.

5. To modify the dates of tasks in the chart, do one of the following:

• Click the Start or End cell of the task, and select a date in the calendar.

• Click a task, hold down the left mouse button, drag the task to the right
location, and release the left mouse button.

Repeat this process for all tasks to move them in the correct locations.

6. Click Save.

3. Set the baseline
When tasks have been moved to the desired dates, you need to set the project
baseline. You can later compare the baseline duration to the actual duration
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during the project. The baseline also sends information to the production
schedule.

If you have modified the dates on the Gantt Chart tab, you can set the
baseline easily. Do the following:

1. Click the Baseline Plan tab to open it.

2. Click Set Baseline.

3. In the confirmation dialog box, click Yes to set the baseline values.

The baseline is saved, and the baseline dates update in the blank columns.

4. Add project breakdown information
Use the Project Breakdown to divide a project into sub-tasks in order to
schedule and track the completion of the task. For example, if your project has
sequences and lot numbers, they should be added as breakdown items. You
can also apply the breakdown items to the desired schedule tasks and link the
breakdown items to each other.

For more information, see Add, modify, and delete breakdown items
(page 629).

1. Open the Project Breakdown tab.

2. Click New.

3. In the Schedule Breakdown Item dialog box, enter the exact sequence
number in the Sequence field.

4. If necessary, add a description or other information about the breakdown
item.
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5. Click Add. 

Repeat steps 2 to 5 for all sequences.

6. To add a lot, do the following:

a. Click New.

b. Click the arrow on the right side of the Parent Breakdown Item field,
and select a sequence in the list.

c. In the the Lot # field, type the exact lot number.

d. Add a description or other information about the lot.

e. Click Add.

Repeat steps a to e for all necessary lots.

8.5 Define time tracking settings
In the Time Tracking Settings dialog box, you can define the settings that
control adding and modifying time tracking records.

1. Click the Maintenance ribbon tab.

2. On the menu, select Time Tracking Settings.

3. On the Standard Fields tab of the Time Tracking Settings dialog box,
modify the included fields as follows:
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a. If you want to display a field when adding a time tracking record and
allow the user to type information to the field, select the Show Field
check box next to the field.

b. If you want to make the field mandatory, select the Required check
box. 

The user needs to type information in a required field in order to add
a time tracking record.

c. To change the title of the field in the New Time Tracking Record
dialog box, type a new name in the Title field.

Repeat steps a to c for all necessary fields.

4. On the User Defined Fields tab, define any custom fields as follows:

a. If you want to display a field when adding a time tracking record and
allow the user to type information to the field, select the Show Field
check box next to the field.

b. If you want to make the field mandatory, select the Required check
box. 

The user needs to type information in a required field in order to add
a time tracking record.

c. To name the field, type a name in the Title field.

Repeat steps a to c to create all necessary fields.

5. To enable adding a time tracking record without start and end time, on
the Input Settings tab, select the Allow date entry only (without time)
check box.

6. On the Input Settings tab, select how Tekla EPM calculates the time:

• Compute start time from end time and hours: When you change
the times of an input record, the start time is automatically calculated
according to the end time and the total hours.

• Compute end time from start time and hours: When you change
the times of an input record, the end time is automatically calculated
according to the start time and the total hours.

• Compute hours from start time and end time: When you change
the start or end time, the regular hours are automatically calculated.

Note that you can select either Compute start time from end time and
hours or Compute end time from start time and hours, not both.

7. To save the time tracking settings, click Save.
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8.6 Manage contract and invoicing information
In the Contract & Invoicing dialog box, you can view the current contract and
invoice information, add new contract details and invoices, or modify contract
and invoice information. The values set in Contract & Invoicing are used in
the project schedule.

To access the contract and invoicing information:

• On the right side of the Project dialog box, click the Contract & Invoicing
button.

• On the Summary tab of the Project dialog box, click + at the upper-right
corner of the Contract & Invoicing section.

In the Contract & Invoicing dialog box, you can view the total sum of the
contract, approved change orders included in the contract or not included in
the contract, the sum that has been invoiced, and the sum that has not yet
been invoiced.

For more information, see the following links:

Add and modify contract information (page 658)

Create and modify invoices (page 661)

Add and modify contract information
Use the Contract Items dialog box to add new contract items to either the
original contract or a change order. Contract items represent parts of the
contract, such as detailing or materials. You can also modify, move, or delete
existing contract items. Furthermore, you can define and adjust the properties
of the project contract.

To access the Contract Items dialog box, do the following:

• In the Contract & Invoicing dialog box, click Contract.
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Add a contract item to the original contract
1. On the Contract Items tab of the Contract Items dialog box, click New

Contract Item.

2. In the Contract Item dialog box, type a description for the contract item. 

The description is used in project management reports.

3. Click the arrow on the right side of the Type list and select Original
Contract.

4. In the Amount field, type the costs of the contract item.

5. Click the arrow on the right side of the Schedule Task list, and select the
project schedule task that you want to link to the new contract item. 

When you link a contract item to a schedule task, Tekla EPM automatically
finds the completion percentage of the contract item from the project
schedule. This allows you to automatically calculate the amount to be
invoiced based on the completion percentage.

6. Type any additional notes about the contract item.

7. Click Save.

The new contract item is added to the list on the left-hand pane.

The Contract & Invoicing dialog box now shows the totals for the contract
and the sum to be invoiced.

You can now create invoices for the contract item. For more information, see
Create and modify invoices (page 661).

All invoices related to the contract item are displayed in the Invoices section,
below the contract item properties.

Add a contract item to a change order
1. On the Contract Items tab of the Contract Items dialog box, click New

Contract Item.

2. In the Contract Item dialog box, type a description for the contract item. 

The description is used in project management reports.

3. Click the arrow on the right side of the Type list and select Change Order.

4. Click the arrow on the right side of the Schedule Task list, and select the
project schedule task that you want to link to the new contract item. 

When you link a contract item to a schedule task, Tekla EPM automatically
finds the completion percentage of the contract item from the project
schedule. This allows you to automatically calculate the amount to be
invoiced based on the completion percentage.

5. Type any additional notes about the contract item.
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6. Click Save. 

The new contract item is added to the list on the left-hand pane.

7. To define the costs of the contract item, go back to the Project
Management dialog box, and click Change Orders.

8. In the Change Orders dialog box, select the change order that you want
to link to the contract item.

9. Click the arrow on the right side of the Contract Item list, and select the
new contract item.

10. Click Edit to save the changes.

When you return to the Contract Item dialog box, you can see that the costs
of the selected change order are now used in the Amount field for the
contract item. The selected change order is displayed in the Change Orders
section, below the contract item properties.

The net amount of the change order will also be visible in the Contract &
Invoicing dialog box.

Modify a contract item
1. On the left-hand pane of the Contract Item dialog box, select the

contract item that you want to modify.

2. Modify the description, type, amount, schedule task, and notes according
to your needs.

3. Click Save to update the contract item properties.

Move a contract item up or down
1. On the left-hand pane of the Contract Item dialog box, select the

contract item that you want to move.

2. Click the Move Up and Move Down buttons to move the item to the
desired position.

Delete a contract item
Deleting a contract item is permanent and cannot be undone.

Note that the contract items that have been invoiced cannot be deleted.

1. On the left-hand pane of the Contract Item dialog box, select the
contract item that you want to delete.

2. Click Delete.

3. To permanently delete the contract item, click Yes in the confirmation
dialog box.
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Adjust the contract properties
1. In the Contract Items dialog box, click the Other tab to open it.

2. Adjust the contract properties: 

Option Description
Contract # The contract number.

The contract number is displayed in the standard
AIA G702 invoice form.

Type the contract number in the Contract # field.
Contract For A brief description of the contract, displayed in the

standard AIA G702 invoice form.

Type a description in the Contract For field.
Retainage - Completed
Work

The percentage of the invoiced completed work
amount that is retained until the end of the
project. The default value is 10%.

Type a value in the Retainage - Completed Work
field.

Stored Materials The percentage of the invoiced stored materials
amount that is retained until the end of the
project. The default value is 10%.

Type a value in the Stored Materials field.
Notes Any additional notes or information about the

contract.

3. Click Save. 

A message appears, telling you that the information has been saved.

4. Click OK to close the message.

Create and modify invoices
In the Invoices dialog box, you can create new invoices for contract items,
modify or delete existing invoices, and create standard invoice documents or
invoice reports.

To access the Invoices dialog box, do the following:

• In the Contract & Invoicing dialog box, click Invoices.

Create an invoice
1. In the Invoices dialog box, click New Invoice.

2. At the top of the Invoices dialog box, define the invoice properties: 
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Properties marked with an asterisk (*) are mandatory information.

Option Description
Application # * An identification number used to identify the

invoice on the AIA G702 and AIA G703 reports.

When creating a new invoice, the Application #
field is automatically populated with the next
available number.

If necessary, type another number in the
Application # field.

Invoice # The invoice number used in your accounting
software.

Type the invoice number in the Invoice # field.
Date * The date when the invoice was created.

Click the arrow on the right side of the Date field,
and select a date in the calendar.

Period Start *, End * Dates that determine the date range during which
the worked that is billed on the invoice was
completed.

Click the arrows on the right side of the Period
Start and End fields, and select the start and end
dates in the calendars.

Retainage - Completed
Work

The retainage percent applied to the completed
work.

Type a value in the Retainage - Completed Work
field.

Note that when you create the final invoice, the
value needs to be set to 0%, so that the retainage
withheld from the previous invoices can be billed.

Stored Materials The retainage percent applied to the stored
materials.

Type a value in the Stored Materials field.

Note that when you create the final invoice, the
value needs to be set to 0%, so that the retainage
withheld from the previous invoices can be billed.

Created By * The Tekla EPM user who is creating the invoice.

When creating a new invoice, the default user is
the one that is currently logged in to Tekla EPM on
the current workstation.

If necessary, click the arrow on the right side of the
Created By list and select another user.
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Option Description
Invoice To * The company and contact person that will receive

the invoice.

Click the arrow on the right side of the leftmost
Invoice To list and select the company.

Click the arrow on the right side of the rightmost
Invoice To list and select the contact person.

Notes Any additional notes or information about the
invoice.

Type any information in the Notes field.

3. In the list in the middle of the Invoices dialog box, select the contract item
for which you want to create the invoice. 

Note that the properties at the bottom of the dialog box change according
to the selected contract item. If the contract item is linked to a schedule
task, the % Complete field is populated automatically.

4. Do one of the following:

• To apply the sum that is to be invoiced to the completed work
according to the completion percentage, click Apply to Completed
Work.

• To apply the sum that is to be invoiced to the stored materials
according to the completion percentage, click Apply to Stored
Materials.

• To manually determine the sum to be invoiced and apply it to the
completed work or the stored materials, type the sum in either the
Current - Completed Work field or the Stored Materials field.

• To set the sum to the full amount remaining, double-click the Current
- Completed Work field or the Stored Materials field.

The next material in the list of contract items is selected.

If necessary, to add the currently selected contract item to the invoice,
repeat step 4.

5. Click Save to save the invoice.

Modify an invoice
1. In the Invoices dialog box, select the invoice that you want to modify.

2. Click Properties.
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3. At the top of the Invoices dialog box, modify the invoice properties: 

Option Description
Application # An identification number used to identify the

invoice on the AIA G702 and AIA G703 reports.

When creating a new invoice, the Application #
field is automatically populated with the next
available number.

If necessary, type another number in the
Application # field.

Invoice # The invoice number used in your accounting
software.

Type the invoice number in the Invoice # field.
Date The date when the invoice was created.

Click the arrow on the right side of the Date field,
and select a date in the calendar.

Period Start, End Dates that determine the date range during which
the work that is billed on the invoice was
completed.

Click the arrows on the right side of the Period
Start and End fields, and select the start and end
dates in the calendars.

Retainage - Completed
Work

The retainage percent applied to the completed
work.

Type a value in the Retainage - Completed Work
field.

Note that when you create the final invoice, the
value needs to be set to 0%, so that the retainage
withheld from the previous invoices can be billed.

Stored Materials The retainage percent applied to the stored
materials.

Type a value in the Stored Materials field.

Note that when you create the final invoice, the
value needs to be set to 0%, so that the retainage
withheld from the previous invoices can be billed.

Created By The Tekla EPM user who is creating the invoice.

When creating a new invoice, the default user is
the one that is currently logged in to Tekla EPM on
the current workstation.

If necessary, click the arrow on the right side of the
Created By list and select another user.
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Option Description
Invoice To The company and contact person that will receive

the invoice.

Click the arrow on the right side of the leftmost
Invoice To list and select the company.

Click the arrow on the right side of the rightmost
Invoice To list and select the contact person.

Notes Any additional notes or information about the
invoice.

Type any information in the Notes field.

4. If necessary, do either of the following:

• To change if the invoiced amount is applied to the completed work or
the stored materials, click either Apply to Completed Work or Apply
to Stored Materials.

• To manually change the amount to be invoiced, type a new value in
the Current - Completed Work or the Stored Materials field.

5. Click Save to save the invoice.

Delete an invoice
Deleting an invoice is permanent and cannot be undone.

1. In the Invoices dialog box, select the invoice that you want to delete.

2. Click Properties.

3. In the lower-right corner of the Invoices dialog box, click Delete.

4. To permanently delete the invoice, click Yes in the confirmation dialog
box.

View, print, or export invoice documents or invoice reports
1. In the Invoices dialog box, click the Invoice ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. In the Report Selection dialog box, select the desired invoice report. 

The AIA G702 and AIA G703 reports are standard forms for creating
invoices.
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4. Do any of the following: 

To Do this
View the invoice
document or invoice
report

• In the Report Selection dialog box, click View.

The selected report or document opens in Tekla
EPM Report Viewer.

You can use the Email Excel and Email PDF
buttons at the top of the Tekla EPM Report
Viewer window to email the report via Microsoft
Outlook.

Print the invoice
document or invoice
report

a. In the Report Selection dialog box, change
the number of the printed copies by clicking
the + and - buttons.

b. Click Print.

c. To confirm printing the document or report,
click Yes in the confirmation dialog box.

d. In the Select Printer dialog box, click a printer
to select it.

e. Click OK.
Export the invoice
document or invoice
report

a. In the Report Selection dialog box, click
Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Modify the file name according to your needs.

e. Browse to the location where you want to save
the exported file, and click Save.

f. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email check box.

g. To open the file after exporting it, select the
Open Exported Document check box.

h. In the Report Selection dialog box, click
Export.

5. To close the dialog box, click the Close button (X) in the upper-right
corner.
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8.7 Import and export project management information
You can import drawing status information as an XML file, or export the
production status to an XML file or to Trimble Connect.

See also

Import drawing status information (page 667)

Export the production status to Tekla Structures or Advance Steel (page 667)

Export the production status to SDS/2 (page 668)

Publish the production status to Trimble Connect (page 669)

Import drawing status information
Use the Import command to import drawing status from an XML file to Tekla
EPM.

1. In the Project Management dialog box, click the Project Management
ribbon tab.

2. On the menu, select Import.

3. In the Open dialog box, browse to find the XML file that you want to
import.

4. Click the XML file to select it.

5. Click Open.

6. In the Import Tekla EPM Exchange File dialog box, view the import
status.

7. When the import process is completed, click the Close button to close the
Import Tekla EPM Exchange File dialog box.

Export the production status to Tekla Structures or
Advance Steel
You can export the production status of the current job as an XML file to either
Tekla Structures or Advance Steel.

1. Do one of the following: 

Option Description
Export the production
status from the
Production Control
dialog box

a. In the Production Control dialog box, click the
Production Control ribbon tab.

b. On the menu, select Export --> Export
Production Status to XML - Tekla Structures
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Option Description
or Export --> Export Production Status to
XML - Advance Steel .

Export the production
status from the Project
Management dialog
box

a. In the Project Management dialog box, click
the Project Management ribbon tab.

b. On the menu, select Data Exchange -->
Export Production Status to XML - Tekla
Structures or Data Exchange --> Export
Production Status to XML - Advance Steel .

2. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla EPM saves the file to the Export folder.

3. If necessary, change the file name.

4. Click Save.

The production status is saved in the selected location as an XML file.

See also

Export the production status to SDS/2 (page 668)

Export the production status to SDS/2
You can export the production status of the current job to SDS/2 as an XML
file.

1. Do one of the following: 

Option Description
Export the production
status from the
Production Control
dialog box

a. In the Production Control dialog box, click the
Production Control ribbon tab.

b. On the menu, select Export --> Export
Production Status to XML - SDS/2 .

Export the production
status from the Project
Management dialog
box

a. In the Project Management dialog box, click
the Project Management ribbon tab.

b. On the menu, select Data Exchange -->
Export Production Status to XML - SDS/2 .

2. In the SDS/2 Field Map dialog box, define SDS/2 import settings as
follows:

a. Click New Field.

b. In the SDS/2 Object list, select the SDS/2 object type.

c. In the SDS/2 Category list, select a software solution for member
properties.
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d. In the SDS/2 Field list, select the field to which the information is
exported in SDS/2.

e. In the Tekla EPM Field list, select the Tekla EPM field from which the
information is exported to the selected SDS/2 field.

f. Click New Field.

Repeat steps a to f to match all necessary SDS/2 and Tekla EPM fields to
each other.

If you want to save the SDS/2 import settings for later use, type a
description for the settings in the Description field, and click Save.

3. Click OK.

4. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla EPM saves the file to the Export folder.

5. If necessary, change the file name.

6. Click Save.

See also

Export the production status to Tekla Structures or Advance Steel (page 667)

Publish the production status to Trimble Connect
Use the Publish Status to Trimble Connect command to update the status of
a production control job manually to Trimble Connect.

You can also create a Publish to Trimble Connect automated event
(page 189) to update the production status to Trimble Connect automatically.

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Export --> Publish Status to Trimble Connect .

The production status is updated to Trimble Connect.

8.8 View, print, or export project management reports
You can create various reports containing information about the current
project management job. For example, you can create a list of transmittals, a
notice informing the recipient about overdue drawings, or a standard invoice.
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Create a project management report
1. In the Project Management dialog box, click the Project Management

ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. To only include specific items in the report, in the Project Management
Report Filters dialog box, select a filter type in the Type list, and click
Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the items that you want to include in
the report to the Included list.

• Type the maximum and minimum values for the items that you want
to include in the report.

5. Click OK.

6. At the bottom of the Project Management Report Filters dialog box,
select check boxes depending on which kind of reports you want to
create. 

For example, to only create drawing reports, select the Drawings check
box only.

7. Click Make Report.

8. In the Report Selection dialog box, select the report that you want to
view, print, or export.

View the report
• In the Report Selection dialog box, click View.

The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
EPM Report Viewer window to email the report via Microsoft Outlook.

Print the report
1. In the Report Selection dialog box, change the number of the printed

copies by clicking the + and - buttons.

2. Click Print.

3. To confirm printing the report, click Yes in the confirmation dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.
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Export the report
1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Browse to the location where you want to save the exported file, and click
Save.

5. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email check box.

6. To open the file after exporting it, select the Open Exported Document
check box.

7. In the Report Selection dialog box, click Export.

View, print, or export the project summary
Use the Project Summary command to view the project summary report of
project management jobs that are linked to one or more of the following
modules: Production Control, Combining, Estimating, and Purchasing.

By creating the project summary, you can:

• Compare the materials used in Production Control with the estimated
materials and the pre-purchased materials in Combining.

• View the total values for purchased materials, materials moved from other
jobs, and materials moved to scrap.

• View the current production status: see which materials are listed on a
purchase order and have not yet been received, which materials are in
stock but have not been processed, and which have been charged to the
job and taken from stock.

Create a project summary report
1. In the lower-right corner of the Project Management dialog box, click

Project Summary.

2. In the Report Selection dialog box, select the desired project summary
report. 

The Full Project Summary report provides a snapshot of the current
status of the project and the module components that are currently linked
to each other. It contains:

• A shape summary, which allows you to compare materials by shape.
The job progress is displayed by weight and cost. All items entered into
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the bill of materials in Production Control appear in the Production
Control column.

• A purchase order summary, which shows all the purchase orders
associated with the project management jobs.

• An inventory transfer summary, which shows materials transferred
from a different job into the current project management job.

• The production and shipping status summary report, which shows the
quantity of pieces that have been processed. The items are sorted by
the route assigned in Production Control. The production and
shipping status information is automatically updated when changes
are made.

The project summary reports also have reports for all the breakdown
areas, but these reports are not displayed by default. To customize the
displayed reports, click Edit Report Types in the Report Selection dialog
box.

View the project summary report
• In the Report Selection dialog box, click View.

The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
EPM Report Viewer window to email the report via Microsoft Outlook.

Print the project summary report
1. In the Report Selection dialog box, change the number of the printed

copies by clicking the + and - buttons.

2. Click Print.

3. To confirm printing the report, click Yes in the confirmation dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the project summary report
1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Browse to the location where you want to save the exported file, and click
Save.

5. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email check box.
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6. To open the file after exporting it, select the Open Exported Document
check box.

7. In the Report Selection dialog box, click Export.
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9 Manage the fabrication process

The Production Control module handles the entire fabrication process:
pulling the material from Purchasing and inventory cut lists, tracking the
production in the shop, filing quality control reports, and shipping materials.

Before you start working in the Production Control module, remember to
adjust the production control settings according to your needs. For more
information, see Set up the Production Control module (page 675).

For more information, see the following links:

Set up the Production Control module (page 675)

Open the Production Control module (page 724)

Find a production control job (page 725)

Open and view a production control job (page 729)

Create a production control job (page 725)

Store document references for a production control job (page 733)

Filter information in the Production Control dialog box (page 731)

Add a production control item (page 776)

Modify a production control job (page 734)

Modify production control items (page 782)

Add piece tracking and load tracking information and loads to the current
production control job (page 806)

Copy materials from one drawing to another (page 787)

Create, modify, and delete loads (page 800)

Track production by piece mark (page 805)

Take production control items from stock (page 796)

Combine materials in the Production Control module (page 788)

Import, view, or delete CNC files (page 774)

Review and adjust production control job information (page 740)
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View all changes in a production control job (page 737)

View and adjust the project schedule (page 613)

View the production schedule (page 767)

Use Trimble Connect with a production control job (page 810)

View, print, and export job-specific production control reports (page 772)

Send production control items to purchasing (page 789)

Export production control information (page 820)

Finalize a production control job (page 821)

9.1 Set up the Production Control module
Before you start to manage the fabrication process in the Production Control
module, we recommend that you take the time to customize the properties
and items according to your needs. Once you have created and modified all
necessary items and settings, working in the Production Control module is
easier and more efficient.

When setting up the Production Control module, you can:

• Define the company standard settings used in the Production Control
module.

• Modify the available display and input fields in the Production Control
dialog box.

• Modify the menu setup of the Production Control menu and create
shortcuts for menu items.

• Set up stations and routes for piece tracking.

• Enter information for piece tracking and loading trucks.

• View production status reports for either a single job or a group of jobs.

• View and print cut lists.

• View and print station summary reports and shipping lists.

• View and print different kinds of production control and purchasing
reports for either a single job or a group of jobs.

For more information, see the following links:

Define company standard settings for Production Control (page 676)

Define critical length and width differences (page 691)

Create, modify, and delete stations (page 692)

Create, modify, and delete routes (page 695)

Create, modify, and delete approval statuses (page 517)

Manage the fabrication process 675 Set up the Production Control module



Manage production control jobs (page 698)

Create, modify, and delete material finish options (page 701)

Create, modify, and delete global production codes (page 702)

Create, modify, and delete global shipping routes (page 704)

Manage cut lists (page 709)

Add piece tracking and load tracking information and loads to production
control jobs (page 715)

Review production statuses of jobs (page 719)

View or print purchasing reports (page 720)

View, print, or export production reports (page 722)

Define company standard settings for Production Control
In the Company Standards dialog box, you can create default settings that
become the user standard that is used in each production control job. You can
define settings regarding data input, material import settings, and reports. If
necessary, you can also change the settings on a job by job basis.

1. Click the Maintenance ribbon tab.

2. On the menu, select Production Control --> Company Standards .

The Company Standards dialog box opens on the General tab.

3. Modify the company standard settings on the General, Input Settings,
Import Settings, and Report Settings tabs according to your needs.

4. Click the buttons at the bottom of the Company Standards dialog box to
further modify company standard settings.

NOTE Do not click Save until you have modified all necessary settings.
Saving the settings closes the Company Standards dialog box.

Define general settings
• On the General tab, modify the following properties according to your

needs: 

Option Description
Job # Increment Allows you to select the default option for

automatic job numbering. The options are:

• Increment from Last Job #:

When you create a new job, Tekla EPM uses the
next available job number after the latest job
number created.
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Option Description
• Increment from Largest Job #: Tekla EPM uses

the next available job number after the largest
job number created.

• Don't Increment: Automatic job numbering is
not used.

You can modify the job number when you create a
new job.

Keep Job Selection
Screen Open

When selected, the Select Production Control Job
dialog box remains open after you have selected a
production control job.

Open to Filter
Selection

When selected, the Production Control Filters
dialog box automatically opens when you open a
production control job. In the Production Control
Filters dialog box, you can set filters to only show
the items that you want to see in the production
control job.

When you have set the filters, the job opens.
Job # Regular
Expression

Allows the use of regular expressions to enforce a
desired format for the job numbers.

When changes to PDC
break links to
combined INV material

Allows you to select how Tekla EPM handles
situations where a material link is broken between
Production Control and Inventory while
importing a revised or modified bill of materials.

Tekla EPM automatically unlinks all changed
material. This prevents cutting materials to
incorrect lengths.

The options are:

• Prompt to Uncombine the Unlinked INV
Material: Tekla EPM asks the user if the
materials should be immediately uncombined
or not, which is the first step of automatically
correcting cut lists. This is the default option.

• Always Uncombine the Unlinked INV
Material: Tekla EPM automatically uncombines
the unlinked materials.

• Never Uncombine the Unlinked INV
Material: Tekla EPM does not uncombine the
unlinked material, but leaves the combining
result as is. Instead, the user should perform
the necessary corrections manually.

Click the arrow on the right side of When changes
to PDC break links to combined INV material
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Option Description
field, and click a suitable option in the list to select
it.

TFS - Drop Job Reserve Allows you to select how Tekla EPM handles drop
material when a take from stock operation has
been performed. Note that you can select a
different option for an individual job, if necessary.

The options are:

• Keep reserved for the TFS job: Tekla EPM
keeps all drop material saved for the job until
you unreserve it manually. This is the default
option.

• Prompt for the new job reserve: in the in the
Cut Lists dialog box, Tekla EPM asks you
whether you want to reserve the drop material
for a job.

• Prompt to unreserve: Tekla EPM asks you
whether you want to unreserve the drop
material or not.

• Always unreserve: Tekla EPM automatically
unreserves all drop material and moves it to
open inventory, immediately available for use.
Scrap length materials go to inventory history.

Allow Cut List Grade
Substitution

When selected, Tekla EPM can use inventory stock
materials with another material grade in cut lists.

Note that Tekla EPM only allows grade
substitutions that have previously been set up in
the Shape / Grade / Size Maintenance dialog box.

Warn when creating a
cut list if parts are
missing CNC files

When selected, Tekla EPM alerts you when saving a
cut list that contains parts without CNC files.

Cut List Screens - Show
Date/Time Changed

When selected, the Cut Lists dialog box shows the
date and time when the cut lists were last changed.

Define input settings
On the Input Settings tab, select how Tekla EPM interprets and displays the
information in the Production Control module, whether the information is
from an imported bill of materials, or directly entered in the Production
Control dialog box.

1. Click the Input Settings tab to open it.

2. Modify the following settings according to your needs: 
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Option Description
Main Mark Input Type Allows you to select the input format for main

marks.

Click the arrow on the right side of Main Mark
Input Type field, and click a suitable option in the
list to select it.

Piece Mark Input Type Allows you to select the input format for piece
marks.

Click the arrow on the right side of Piece Mark
Input Type field, and click a suitable option in the
list to select it.

Drawing Number Input
Type

Allows you to select the input format for drawing
numbers.

Note that the input format of drawing numbers in
a production control job needs to match the input
format set in the linked project management job.
Otherwise, the drawings will not be available in the
Production Control module or in Tekla EPM Go.

Click the arrow on the right side of Drawing
Number Input Type field, and click a suitable
option in the list to select it. We recommend
selecting the Any Input - Logical Sort option.

Sequence Input Type Allows you to select the input format for
sequences.

Click the arrow on the right side of Sequence
Input Type field, and click a suitable option in the
list to select it.

Use Lot Numbers When selected, you can divide a sequence or
phase into subcategories within a production job
by using lot numbers.

It is highly recommended to select the Use Lot
Numbers option.

Note that selecting or clearing the Use Lot
Numbers check box only applies to new
production control jobs automatically. If necessary,
the Use Lot Numbers check box can be manually
selected or cleared for existing jobs as well.

Main Piece Case Allows you to select if you want to use uppercase
or lowercase letters, or both, for main mark
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Option Description
numbers. This makes recognizing the main pieces
easier.

Click the arrow on the right side of Main Piece
Case field, and click a suitable option in the list to
select it.

Accessory Piece Case Allows you to select if you want to use uppercase
or lowercase letters, or both, for piece mark
numbers. This makes recognizing the piece marks
easier.

Click the arrow on the right side of Accessory
Piece Case field, and click a suitable option in the
list to select it.

Main Member Instance
Tracking

When selected, the history of each individual
instance, or piece, within an item can be identified
and tracked through all production steps.

If you select the Main Member Instance Tracking
check box, instance tracking will be activated for all
new production control jobs. However, existing
jobs will not be affected. You can still activate or
deactivate the instance tracking of main piece
marks for each production job individually.

Accessory Part
Instance Tracking

When selected, the history of each individual
instance, or piece, within an item can be identified
and tracked through all production steps.

If you select the Accessory Part Instance
Tracking check box, instance tracking will be
activated for all new production control jobs.
However, existing jobs will not be affected. You can
still activate or deactivate the instance tracking of
piece mark items for each production job
individually.

Piece Mark Force Same
Info

When selected, the same information is forced to
accessories with the same piece marks. Selecting
the Piece Mark Force Same Info check box
prevents adding or importing items with the same
piece mark but different material information to
the production control job.

Note that the Piece Mark Force Same Info option
is connected to the Edit Line Item - Update
accessories with the same piece mark list. You
cannot select an option in the Edit Line Item -
Update accessories with the same piece mark
unless the Piece Mark Force Same Info check box
is selected.

Manage the fabrication process 680 Set up the Production Control module



Option Description
Edit Line Item - Update
accessories with the
same piece mark

Allows you to select how Tekla EPM accessories
with the same piece mark are updated when you
make changes to a line item. The options are:

• Prompt to update the other line items: Tekla
EPM alerts the user that there are other
accessories in the job that may need to be
updated, and allows you to update the other
accessories. This is the default option.

• Always update the other line items: Tekla
EPM automatically updates the other
accessories to match the changes you made.

• Never update the other line items: Tekla EPM
never updates the other accessories to match
the changes you made.

AutoCalc Drawing
Number

When selected, Tekla EPM enters a drawing
number into the drawing number field based on
the main mark. This option works correctly if the
first number of each shop detail drawing main
piece is the drawing number.

If the marking system that you use does not have
the drawing number as the first number of the
main mark, do not select the AutoCalc Drawing
Number check box.

Default Finish The default finish for items in production control
jobs.

The available finish options are set in the Finish
Maintenance dialog box.

You can change the finish for each main mark item
in a production control job. The finish of the main
mark item is also applied to all of the included
accessories.

Click the arrow on the right side of Default Finish
field, and click a suitable default option in the list to
select it.

Trailer Capacity The trailer capacity weight used by default when
shipping of fabricated material to the jobsite.

The trailer capacity can be changed for individual
loads, if needed. You can also modify the capacities
of specific trailers in the Load Tracking Settings
dialog box.

Type the weight in pounds in the Trailer Capacity
field.
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Option Description
Piece Tracking by Time When selected, allows you to make piece tracking

entries in that include the completion time, so that
you can tell in which shift an item was completed.
The completion time is also visible in piece tracking
reports.

Define import settings
On the Import Settings tab, set the default settings used when importing a
bill of materials into Production Control.

1. Click the Import Settings tab to open it.

2. Modify the following settings according to your needs: 

Option Description
When assembly has no
part with a piece mark
matching the main
mark

Allows you to select how Tekla EPM applies
comment lines in rare cases where a bill of
materials is imported to Production Control and
Tekla EPM cannot identify a main mark. The
options are:

• Don't add a comment line as the main piece:
Tekla EPM never adds the comment line as the
main piece. This is the default option because
most often, the main mark item in the bill of
materials is the largest single piece, whereas
the piece marks are the items that attach to the
main piece.

• Prompt to add a comment line as the main
piece: Tekla EPM asks you if you want to add a
comment line as the main piece. This allows
you to use the name of the item for main marks
instead of the material size.

• Always add a comment line as the main
piece: Tekla EPM always adds a comment line
as the main piece. This allows you to use the
name of the item for main marks instead of the
material size.

When there are
validation errors

Allows you to select how Tekla EPM handles
validation errors regarding shop detail drawings
when a bill of materials is imported to Production
Control. The options are:

• Continue the import without prompting the
user: Tekla EPM continues the import process
without notifying you about the validation
errors. However, you can view the validation
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Option Description
errors in the import log. This is the default
option, and it is useful when the user
performing the import process does not need
to know or make decisions on validation errors.

• Prompt the user to continue the import:
Tekla EPM asks you how the validation errors
should be handled while continuing the import.

• Don't continue the import: Tekla EPM stops
the import immediately when a validation error
is found. The user can then review the drawings
for issues by themselves.

Use as Production
Code

Allows you to select if you want to use assembly
main marks, piece marks, drawing descriptions,
assembly descriptions, reference numbers, or
none of the above as product codes.

Click the arrow on the right side of the Use as
Production Code field, and select a suitable option
in the list.

Use Piece Mark as
Production Code

When selected, Tekla EPM automatically assigns
piece marks as production codes.

Note that if you select the Use Piece Mark as
Production Code check box for a production
control job, you also need to use piece marks as
production codes in the estimating job that is
linked to the production control job.

Prompt to confirm
import fields

When selected, Tekla EPM asks you to confirm the
import fields while importing a bill of material into
Production Control.

By selecting the Prompt to confirm import fields
check box, you can exclude any fields whose values
you do not want to import.

Show supplemental
import file selection
(KISS, CIS/2, BIF)

When selected, Tekla EPM allows you to import
multiple supplementary files, such as bolt lists,
from a detailing software.

Define report settings
1. Click the Report Settings tab to open it.

2. If you want to select whether to use net or gross weight of materials for
each report, select the Prompt for weight type (net/gross) check box. 

The gross weight is the system weight as dimensioned in Tekla EPM,
whereas the net weight is loaded from the CNC files added for items. If
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CNC files have not been added for the items included in the report, the
net weight cannot be used in the report. Instead, the gross weight is used.

3. If you want to create cut list reports that show each quantity of inventory
listed separately, select the Cut List - Prompt to split cutting details to
a quantity of one check box. 

If the Cut List - Prompt to split cutting details to a quantity of one
check box is cleared, multiple inventory pieces with the same exact cutting
details are shown as a single inventory item in reports.

4. If you want to split cutting details to the quantity of one by default, select
the Default check box.

Define input and display units for Production Control
You can use either metric or imperial units for displaying and entering sizes,
lengths, weights, and price. In addition, you can select how you want to enter
the information for the length of the piece.

1. In the Company Standards dialog box, click the Input/Display Units
button.

2. In the Input/Display Units dialog box, select the units and the length
input types in the available lists. 

Note that there are multiple options depending on the required precision
and the desired input method.

3. Click Save.

4. Remember to click Save in the Company Standards dialog box to update
the input and display units.

The Company Standards dialog box closes. The input and display units are
saved for the Production Control module.

See also

Define company standard settings for Production Control (page 676)

Define combining optimizations for Production Control
You can define company-level settings for multing and plate nesting in the
Production Control module. If necessary, you can also change the settings
job by job.

1. In the Company Standards dialog box, click the Combining
Optimizations button.

2. To use material grade substitutions with the optimization settings when
performing a combining run, on the General Settings tab of the
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Combining Setup dialog box, select the Use Grade Substitutions check
box. 

Grade substitutions must be set in the Shape / Grade / Size
Maintenance dialog box. If the grade substitutions are not set, the
material grades in the combining run and in the supplier pricing data set
or the inventory need to match each other exactly.

3. If you want to only mult and nest material items that are in the same
sequence onto a given stock item, select the Combine Only Within
Sequence check box. 

Selecting the Combine Only Within Sequence check box might be useful
in medium or big jobs. However, selecting the Combine Only Within
Sequence check box is not recommended for small jobs.

4. Click the arrow buttons to move the optimization options that you want to
use to the Optimizations Included list. 

The options are:

• Inventory Exact-Match (In Stock): Use this option for inventory items
in stock that are an exact match without the use of kerf or clamp
allowance.

• Inventory Exact-Match (On Order): Use this option for inventory
items that are on purchase orders and have not yet been received and
that are an exact match without the use of kerf or clamp allowance.

• Inventory Least-Scrap (On Order): Use this option for inventory
items that are on purchase orders and have not yet been received and
that will provide the least amount of scrap.

• Inventory Least-Scrap (In Stock): Use this option for inventory items
in stock that will provide the least amount of scrap.

• Warehouse Least-Scrap: Use this option to give preference to
warehouse items that will provide the least amount of scrap.
Warehouse items will only be used when they provide less scrap than
the available inventory items.

• Warehouse Force Inventory: Use this option to force the use of
inventory regardless of the amount of scrap, no matter where it is
located in the Optimizations Included list. This option is the opposite
of Warehouse Least-Scrap.

Note that you can only include Warehouse Least-Scrap or
Warehouse Force Inventory, not both.

5. Use the Move Up and Move Down buttons to modify the order of the
optimizations. 

The order is important while performing a combining run.

6. Click the Mult Settings - Linear Material tab to open it.

7. In Multing Software, select the multing software that you are using.
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8. If you want to apply the material kerf settings defined in Shape / Grade /
Size Maintenance to the combining as part of the cutting pattern, select
the Apply Kerf check box.

9. Open the Plate Nesting Settings tab.

10. In the Plate Nesting Software list, click the plate nesting software that
you are using to select it.

11. In the Shear Cut Optimization list, click a suitable shear cut option to
select it. 

The selected option determines the plate allowance to be used with the
combining:

• Use None when cutting plate on a burn table.

• Use Shear Cut - First Cut Along Length or Shear Cut - First Cut
Along Width to alert Tekla EPM that the nesting needs to allow for
that type of cut first. Then, the nesting will allow for all subsequent
cuts to be made with that condition.

12. If necessary, select the Apply Kerf check box. 

For more details, see step 8.

13. If the material grain direction is unimportant and you want Tekla EPM to
create the best possible optimization of a plate, select the Rotate Plates
for Best Fit check box.

14. Click Save.

15. Remember to click Save in the Company Standards dialog box to update
the combining optimizations.

Define suppliers for Production Control
You can define the desired suppliers, or pricing data sets, for angles, beams,
plates, rods, tubes, and other material. This way, you can use material pricing
from the selected supplier pricing data sets for each material group.

1. In the Company Standards dialog box, click the Suppliers button.

2. In the Suppliers dialog box, select suppliers for each material group in the
available lists.

3. Click OK.

4. Remember to click Save in the Company Standards dialog box to update
the supplier settings.

The Company Standards dialog box closes. The supplier settings are saved as
company standards for the Production Control module.

See also

Define company standard settings for Production Control (page 676)

Manage the fabrication process 686 Set up the Production Control module



Define categories and sub-categories for Production Control
Categories are user-defined keywords that you can use for sorting, tracking,
and reporting. Creating categories also helps you to quickly identify the items
in your production control jobs. For example, you can categorize jobs by
fabrication type. In addition to manually creating categories, you can choose to
use existing categories used in Steel Erection Bid Wizard. To further filter
items, you can also add sub-categories.

Add categories

Note that in addition to creating pre-defined categories in the Company
Categories dialog box, you can also add categories to Tekla EPM by typing a
new category name in the Category field when adding or modifying an item in
a production control job.

Categories are considered a main breakdown item for project summaries and
project schedules.

1. In the Company Standards dialog box, click the Categories button..

2. In the Company Categories dialog box, click New.

3. In the Category field, type a name for the category.

4. Click Add. 

The new category is added to the Category list.

NOTE If you need to modify or delete a category, click a category to
select it in the Category list and either:

• Click Edit, change the category name, and click Edit again.

• Click Delete and then, click Yes to confirm deleting the
category.

5. In the Company Standards dialog box, click Save to update the sub-
categories.

The Company Standards dialog box closes. The categories are saved for the
Production Control module.

Add sub-categories

Note that in addition to creating pre-defined sub-categories in the Company
Categories dialog box, you can also add sub-categories to Tekla EPM by typing
a new sub-category name in the Sub-Category field when adding or modifying
an item in a production control job.

Sub-categories are considered a main breakdown item for project summaries
and project schedules.

1. In the Company Standards dialog box, click the Sub-Categories button.

2. In the Company Sub-Categories dialog box, click New.
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3. In the Sub-Category field, type a name for the sub-category.

4. Click Add. 

The new sub-category is added to the Sub-Category list.

Repeat steps 1 to 4 for all new sub-categories.

NOTE If you need to modify or delete a sub-category, click a sub-
category to select it in the Sub-Category list and either:

• Click Edit, change the sub-category name, and click Edit again.

• Click Delete and click Yes to confirm deleting the sub-
category.

You can also add multipliers for sub-categories in the
Estimating module.

5. In the Company Standards dialog box, click Save to update the sub-
categories.

The Company Standards dialog box closes. The sub-categories are saved for
the Production Control module.

Define pay categories for Production Control
Create pay categories to assign unit costs to fabricated items per pound. You
can use pay categories as report filters, so they can help you to sort
information in reports. Tekla EPM also contains specific shipping reports that
are designed to be used with pay categories.

Pay categories are considered a main breakdown item for project summaries
and project schedules.

1. In the Company Standards dialog box, click the Pay Categories button.

2. In the Pay Categories dialog box, do any of the following according to
your needs: 

To Do this
Create a new pay
category

a. Click New.

b. In the Pay Category field, type the pay
category name.

For example, Beams, Columns, or Bracing.

c. Type a description for the pay category.

For example, Light, Medium, or Heavy.

d. In the Lower Bound Unit Weight field, type
the lowest weight that is applicable to the pay
category.
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To Do this
e. In the Unit Price field, type a pricing per

hundredweight that is applicable for the
material type.

f. Click Add.
Modify an existing pay
category

a. In the list, click the pay category that you want
to modify.

b. Modify the pay category type, description, unit
weight, and unit price according to your
needs.

c. Click Edit to save the changes.
Delete a pay category Note that deleting a pay category is permanent

and cannot be undone.

a. In the list, click the pay category that you want
to delete.

b. Click Delete.

c. In the confirmation dialog box, click Yes to
permanently delete the pay category.

3. To close the dialog box, click the Close button (X) in the upper-right
corner.

4. In the Company Standards dialog box, click Save to update the pay
categories.

The Company Standards dialog box closes. The pay categories are available
in the Production Control module.

See also

Define company standard settings for Production Control (page 676)

Define load tracking settings
In the Load Tracking Settings dialog box, you can manage which fields and
options are available when adding loads in the Load Tracking dialog box.

Note that any changes made in the Load Tracking Settings dialog box are
applied to both new and existing production control jobs.

To access the Load Tracking Settings dialog box, do the following:

• At the bottom of the Company Standards dialog box, click the Load
Tracking Settings button.

The Load Tracking Settings dialog box opens. Click the tabs at the top of the
dialog box to modify the visibility of different items in the Load Tracking
dialog box.
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Adjust trailer number settings

1. Click the Trailer # tab to open it.

2. If you want to allow adding a trailer number in the Trailer # field, select
the Show Field check box. 

The Trailer # field will be available in the Load Tracking dialog box.

3. In the Title field, type the name that you want to use for the Trailer #
field.

4. If you want the trailer number to be mandatory information, select the
Value Required check box. 

The user cannot add a load without entering a trailer number.

5. To add trailer numbers that can be selected, do the following:

a. If necessary, select the Restrict to Preset List check box. 

Selecting the Restrict to Preset List prevents the users from typing
new values, and forces them to select a value in the list.

Leaving the Restrict to Preset List check box unselected allows the
users to type a new value or select a value in the list.

b. To create a new value, click New.

c. Type the value in the Trailer # field.

d. Type the trailer capacity weight in the Capacity field.

e. Click Add. 

Repeat steps b to e for all values that you want to add.

You can also select an existing value in the list and use the Edit and
Delete buttons to modify or delete the value.

Adjust the load tracking fields

The Carrier, Load Category 1, Load Category 2, Load Category 3, and
Shipped From tabs each represent a user-defined field that you can add to
the Load Tracking dialog box. The fields can be re-named and adjusted, so
that you get all the necessary fields and options.

1. Click one of the previously mentioned tabs to open it.

2. If you want to show the field and allow adding information to it, select the
Show Field check box.

3. In the Title field, type the name that you want to use for the field.

4. If you want the field to be mandatory, select the Value Required check
box. 

When the Value Required check box is selected, the user cannot add a
load without entering information in the field.

5. To add options that can be selected for the field, do the following:
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a. If necessary, select the Restrict to Preset List check box. 

Selecting the Restrict to Preset List prevents the users from typing
new values, and forces them to select an existing value.

Leaving the Restrict to Preset List check box unselected allows the
users to either type a new value or select an existing value.

b. To create a new value, click New.

c. Type the desired value in the related field.

d. Click Add. 

Repeat steps b to d for all values that you want to add.

You can also select an existing value in the list and use the Edit and
Delete buttons to modify or delete the value.

Adjust receiving date settings

1. Click the Date Received tab to open it.

2. If you want to allow selecting a receiving date in the Date Received list,
select the Show Field check box. 

The Date Received list will be available in the Load Tracking dialog box.

3. In the Title field, type the name that you want to use for the Date
Received field.

Close the Load Tracking dialog box

• Click OK at the bottom of the dialog box, or click the Close button (X) in the
upper-right corner.

Define critical length and width differences
If any change to a production control item is greater than the inventory record
linked to the production control item, the change is automatically considered
critical and will break the link to the inventory item. If the change is less than
the linked inventory record, you can allow the link to the inventory item to
remain up to the critical length and width differences that you set in the
Purchasing Standards dialog box.

1. Click the Maintenance ribbon tab.

2. On the menu, select Production Control --> Purchasing Standards .

3. In the Purchasing Standards dialog box, enter the maximum acceptable
width and length differences.
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4. Click Save.

The maximum acceptable width and length differences are saved. These
values are used in two types of situations:

Example 1: Comparing two bills of materials

At the beginning of a project, the steel detailer may send an advanced bill of
materials to be imported to the Combining module. The materials in the bill
of materials are then combined and purchased.

Later in the project, when the bill of materials is imported from the shop detail
drawings to Production Control, you can compare the two lists for material
differences. Tekla EPM will use the maximum values defined in the
Purchasing Standards dialog box to recognize critical differences, and
highlight them in red.

Example 2: Automatic linking of materials

When importing a revised bill of materials into an existing Production Control
job, Tekla EPM uses the maximum values defined in the Purchasing
Standards dialog box to determine which materials can be linked
automatically. Tekla EPM stops the automatic process of linking materials if
the differences exceed the maximum values.

Tekla EPM then alerts you that there are changes that have switched off the
automatic linking of materials, so that the you can manually review the
affected purchased items and make adjustments accordingly.

Manage stations and routes
Stations and routes define the steps that items in production go through in the
fabrication process. You can create new routes and stations, or modify and
delete the existing ones.

See also

Create, modify, and delete routes (page 695)

Create, modify, and delete stations (page 692)

Create, modify, and delete stations
Production stations and routes define the steps that an item in production
goes through in the fabrication process. Stations and routes are also used for
tracking labor time, the date a station is completed, and the batch ID for parts
to be fabricated in the job. In the Stations dialog box, you can create new
stations, or modify or delete the existing ones. You can also change how the
stations are displayed when creating routes.

To access the Stations dialog box, do the following:

1. Click the Maintenance ribbon tab.
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2. On the menu, select Production Control --> Station and Route Setup .

The Stations dialog box opens.

On the left-hand pane, you can view the existing stations.

On the right side of the dialog box, you can drag and drop the stations to
change the layout that is used in the Routes dialog box.

Create a station

1. Click New.

2. In the Station Details dialog box, modify the automatically generated
station number according to your needs.

3. Type a description for the new station. 

For example, Iron worker.

4. In the Type list, select if the station is a production station or a field
station. 

Production stations are steps the production that happen within the shop,
such as cutting. Field stations are steps that happen outside the shop,
such as erecting.

5. To assign labor groups to the new station, do the following:

a. Click the Labor Group tab to open it.

b. Click the Select Labor Groups button.
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c. In the Select labor groups to associate with this station dialog box,
click the arrow buttons to move the desired labor groups to the
Included list.

d. Click OK.

Assigning labor groups to a station can help you apply your own specific
determinations for labor applications. When you assign labor groups to a
station, Tekla EPM assigns all labor time from the assigned labor groups in
the linked estimating job to the station.

For example, if the labor time for cutting includes bringing the material
into the shop, labor groups GetPc (get piece) and Move can be assigned
to the Cut/Saw station. In this case, Tekla EPM would gather the labor
time for all these labor groups from the linked estimating job and use the
labor time in the project schedule.

6. Click Save.

The Station Details dialog box closes. The new station is added to the list on
the left-hand pane.

Note that the station has not yet been added to any routes. To do so, see
Create, modify, and delete routes (page 695).

Modify the size and position of stations

1. On the right side of the dialog box, do any of the following: 

To Do this
Move a station to a new
location

a. Click the station and hold down the left mouse
button.

b. Drag the mouse pointer to the location where
you want to move the station.

c. Release the left mouse button.
Resize a station a. Hover the edge of a station.

b. When a double-header arrow appears, hold
down the left mouse button.

c. Drag the mouse pointer to expand or reduce
the station according to your needs.

d. Release the left mouse button.

Repeat until the layout meets your needs.

2. Click Save Layout.

Modify a station

1. In the left-hand pane, click the station that you want to modify.

2. Click Properties.
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3. Modify the station number and description according to your needs.

4. On the Routes tab, view the routes that contain the selected station. 

To modify the routes, double-click the desired route. For detailed
instructions on modifying routes, see Create, modify, and delete routes
(page 695).

5. To modify the labor groups assigned to the station, do the following:

a. Click the Labor Group tab to open it.

b. Click the Select Labor Groups button.

c. In the Select labor groups to associate with this station dialog box,
click the arrow buttons to move the desired labor groups to the
Included list.

d. Click OK.

6. Click Save to update the station properties.

Delete a station

Note that deleting a station is permanent and cannot be undone. If a station is
used in a production control job or a route, it cannot be deleted.

1. In the left-hand pane, click the station that you want to delete.

2. Click Delete.

3. In the confirmation dialog box, click Yes to permanently delete the
station.

Create, modify, and delete routes
Production stations and routes define the steps that an item goes through in
the fabrication process. Often, items with different finishes have different
routes. In the Routes dialog box, you can create new routes, and modify or
delete existing ones according to your needs.

Note that you need to create all necessary stations before you can add them
to routes.

To access the Routes dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Production Control --> Station and Route Setup .

3. In the Stations dialog box, click Route Maintenance.
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You can see the existing routes on the left-hand pane of the Routes dialog
box.

On the right side of the dialog box, you can see all available stations. Yellow
arrows show the order of the stations on the route.

Create a new route

1. Click New.

2. In the Route field, type an abbreviation for the route. 

For example, you can abbreviate the route for painted parts as P.

3. Type a description for the route.

4. Click the arrow on the right side of TFS Station list, and select the station
that is used for cutting and charging materials to the production control
job. 

In reports, this station is where the material cutting is completed and the
drops are sent to their assigned location. This station will be marked as
completed when you take the item from stock.

5. If you track production with the Tekla EPM Go dashboard, expand the
Dashboard Productivity Station section, and select the stations after
which the item is considered complete. 

If you have both production and field stations on the selected route, there
are two lists: Production list for the station where the production is
considered complete, and Field list for the station where the field work is
considered complete.
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6. In the Route Type list, select which items can be assigned to the route: 

• Assembly: only main marks, or assemblies, can be assigned to the
route

• Part: only part marks, or accessory parts, can be assigned to the route

• Assembly & Part: both assemblies and accessories can be assigned to
the route.

7. If you selected Part or Assembly & Part as the route type, in the Join
With Assembly Option list, select when accessory parts should join the
assembly to which they belong: 

• Join with assembly for first station: The accessory part follows the
assembly route starting from the first station.

Note that if the part route and the assembly route have the same first
station, selecting Join with assembly for first station will mean that
the accessory part goes through the same station twice.

• Join with assembly for...: The accessory part joins the assembly route
before this station. Select the station in the list below.

• Join with assembly after...: The accessory part joins the assembly
route after this station. Select the station in the list below.

• Join with assembly after TFS station: The accessory part joins the
assembly route after the station that you selected in the TFS Station
list.

8. Select the included stations and adjust their order: 

• Click the Not in Route tab to see the stations that are not included in
the route, and double-click all stations that you want to include in the
order that they should appear in the route.

• Open the In Route tab to see the stations that are included in the
route.

To move a station earlier or later in the route, select the station and
click the Move Up and Move Down buttons.

9. Click Add.

The new route is now available for all production control jobs.

Modify a route

1. In the list on the left side of the Routes dialog box, select the route that
you want to modify.

2. Modify the route abbreviation, description, TFS station, route type, or join
with an assembly option.

3. To modify the included stations and their order, do the following: 
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• Click the Not in Route tab to see the stations that are not included in
the route, and double-click all stations that you want to include in the
order that they should appear in the route.

• Open the In Route tab to see the stations that are included in the
route.

To move a station earlier or later in the route, select the station and
click the Move Up and Move Down buttons.

4. If you track production with the Tekla EPM Go dashboard, expand the
Dashboard Productivity Station section, and select the stations after
which the item is considered complete. 

If you have both production and field stations on the selected route, there
are two lists: Production list for the station where the production is
considered complete, and Field list for the station where the field work is
considered complete.

5. Click Save to update the route.

Delete a route

Note that deleting a route is permanent and cannot be undone.

1. In the left-hand pane, select the route that you want to delete.

2. Click Delete.

3. In the confirmation dialog box, click Yes to permanently delete the
selected route.

Manage production control jobs
In Job Maintenance, you can manage existing production control jobs in
different ways. You can copy, export, and delete combining jobs, and set job
groups and job statuses.

To access the Job Maintenance dialog box, do the following.

1. Click the Maintenance ribbon tab.

2. On the menu, select Production Control --> Job Maintenance .

3. Select the jobs that you want to modify.

4. Select one of the available options: 

• Delete

• Copy

• Export

• Set Group Name

• Set Job Status
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For more information, see the following links:

Delete production control jobs (page 699)

Copy a production control job (page 699)

Export production control jobs (page 699)

Set job groups for production control jobs (page 700)

Set job statuses for production control jobs (page 701)

Delete production control jobs
You can delete any unnecessary production control jobs. Export jobs before
deleting them to make the jobs available for future reference.

1. In the Production Control Job Maintenance dialog box, select the jobs
that you want to delete. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

2. At the bottom of the dialog box, click Delete.

3. To permanently delete the estimating job, click Yes in the confirmation
dialog box.

See also

Export production control jobs (page 699)

Manage production control jobs (page 698)

Copy a production control job
You can copy an existing job to use it as the base of a new similar job. Copying
an existing job makes creating the new job quicker, as you do not have to set
all properties manually or create items one by one.

1. In the Production Control Job Maintenance dialog box, select the job
that you want to copy..

2. At the bottom of the dialog box, click Copy.

3. Type a number for the new job.

4. Click OK.

See also

Manage production control jobs (page 698)
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Export production control jobs
Export jobs before deleting them to make the jobs available for future
reference.

We recommend that you create backup copies of jobs to recover deleted jobs.
Users with administrator rights can recover deleted production control jobs. .

1. In the Production Control Job Maintenance dialog box, select the jobs
that you want to export. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

2. At the bottom of the dialog box, click Export.

3. In the Save As dialog box, browse to the folder where you want to save
the file.

4. Use the automatically generated name or type a new one.

5. Click Save.

If you have selected multiple jobs, repeat steps 3 to 5 for each job.

The selected production control job is saved as a Tekla EPM-specific type of
KISS file. The exported KISS files contain load and piece tracking information
that KISS files do not normally contain.

See also

Manage production control jobs (page 698)

Set job groups for production control jobs
Job groups allow you to identify and sort projects that are similar. For
example, you can create job groups for commercial or industrial work, or by
year. Assigning job groups to jobs makes it easier to sort a long list of jobs.

1. In the Production Control Job Maintenance dialog box, select the jobs
for which you want to set job groups. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

2. At the bottom of the dialog box, click Set Group Name.

3. Select if you want to update the primary group or the secondary group.

4. Type a name for the group.

5. Click OK.

See also

Manage production control jobs (page 698)
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Set job statuses for production control jobs
The job status determines if a job is still in progress (Open) or finished
(Closed). By setting job statuses for production control jobs, you can view only
the current production control jobs in the Select Production Control Job
dialog box and in Tekla EPM Go. Any closed jobs will be hidden by default.

1. In the Production Control Job Maintenance dialog box, select the jobs
whose status you want to change. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

2. At the bottom of the dialog box, click Set Job Status.

3. Select the new job status in the list.

4. Click OK.

Note that only open production control jobs are available in Tekla EPM Go.

See also

Manage production control jobs (page 698)

Open and view a production control job (page 729)

Modify a production control job (page 734)

Create, modify, and delete material finish options
In the Finish Maintenance dialog box, you can create, modify, or delete
material finish options. You can also select the shipping routes used for each
finish option.

To access the Finish Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Production Control --> Finish Maintenance .

Create a new finish option
1. Click New.

2. Type an abbreviation and a description for the new finish option.

3. If necessary, click the arrow on the right side of the Shipping Route list
and select the shipping route that you want to use for production control
items with the new finish option. 

Setting a shipping route for the finish is optional.

For more information on shipping routes, see Create, modify, and delete
global shipping routes (page 704).
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4. Click Add.

Modify an existing finish option
1. Click the finish option that you want to modify to select it.

2. Modify the abbreviation, description, and shipping route according to
your needs.

3. Click Save.

The properties of the finish option are updated.

Delete a finish option
Note that deleting a finish option is permanent and cannot be undone.

1. Click the finish option that you want to delete.

2. Click Delete.

3. In the confirmation dialog box, click Yes to permanently delete the finish
option.

Create, modify, and delete global production codes
In the Global Production Code Maintenance dialog box, you can create,
modify, and delete production codes that are available in all production
control and estimating jobs. Production codes group similar items in
estimating or production control jobs, so that Tekla EPM calculates the labor
times based on the production code. This means that using production codes
allows you to plan production more accurately.

Note that you can only adjust production codes in the Global Production
Code Maintenance dialog box, not labor times. Tekla EPM automatically
calculates the labor times for the items that have been assigned a production
code.

We recommend that you assign matching production codes to parts in both
Estimating and Production Control. This way, you can view the planned and
executed labor times in the project schedule.

To access the Global Production Code Maintenance dialog box, do the
following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Production Control --> Global Production Code
Maintenance .

The Global Production Code Maintenance dialo box opens.
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Create a production code
Note that you can only create production codes for the current estimating job
in the Production Codes dialog box. Globally available production codes are
created in Global Production Code Maintenance.

1. At the bottom of the dialog box, click New.

2. Name the production code and type a description.

3. Do any of the following: 

To Do this
Use the estimated labor
times of items within
the production code in
Production Control

The man hours associated with the production
codes are only used in Production Control.
Production codes do not affect or apply labor to
estimating items. The purpose of the man hours is
to pull labor information from the estimate in the
form of man hours per ton and labor percentages
by labor group.

• In the Aggregate Units list, select a calculation
option.

Override the estimated
labor time of items
within the production
code in Production
Control

NOTE Manually overriding man hours applies an
aggregate unit, man hours per ton, that can
be applied to production control items.
However, if the manual override is used,
the labor information does not include
labor group percentages. Therefore, the
labor group percentages cannot be applied
to any production control stations. Further,
the information cannot be applied to tasks
in the project schedule and to resources
that feed information to the production
schedule. Manually overriding man hours
can also prevent you from comparing the
linked production control job with the
estimating job.

a. Select the Override Man Hours check box.

b. Type the labor time in the field on the right
side of the check box.

TIP To change the units, right-click in the field
and select a suitable option in the
context menu.

4. Click Add.
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Modify a production code
1. Select the production code that you want to modify.

2. Modify the production code properties according to your needs.

3. Click Save to update the production code properties.

Delete a production code
1. Select the production code that you want to delete.

2. Click Delete.

3. In the confirmation dialog box, click Yes to permanently delete the
production code.

Create, modify, and delete global shipping routes
In the Shipping Route Maintenance dialog box, you can create, modify, and
delete shipping routes that are available for all production control jobs.
Shipping routes can be used to send items within a job to multiple shipping
destinations, including intermediate destinations, such as sending material to
an external galvanizer. Items can only be shipped from their current location
to the next assigned destination, not to the final destination. The initial
location of all items is the shop location. If no shipping route is assigned for
items, the items will be shipped from the shop to the jobsite. Items can either
be returned to the shop and be added to another load with other material
items, or shipped from the intermediate destination directly to the jobsite or
next destination.

To access the Shipping Route Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Production Control --> Global Shipping Route
Maintenance .

The Shipping Route Maintenance dialog box opens, displaying all existing
shipping routes that can be used in production control jobs.

Create a shipping route
1. Click New.

2. In the Shipping Route dialog box, type a description for the new shipping
route. 
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3. In the Join with Assembly Option list, select if and when the weight of an
accessory part is included in the shipping weight of the assembly. 

The options are:

• None: The weight of the accessory is not included in the shipping
weight of the assembly. If the Jobsite destination is in the shipping
route, select the None option.

• Join with assembly for first destination: The weight of the accessory
is joined to the shipping weight of the assembly for all of its
destinations except for the first one.

• Join with assembly for...: The weight of the accessory is included in
the shipping weight of the assembly for the destination that you select
in the Join with Assembly For list, and for any other destinations after
that one.

• Join with assembly after...: The weight of the accessory is included in
the shipping weight of the assembly for all destinations after the
destination you select in the Join With Assembly After list.

4. To adjust the destinations in the shipping route, do any of the following: 

To Do this
Add a new destination a. Click Add.

b. In the Destination Group field, do one of the
following:

• To create a new destination group, type a
description for it in the Destination Group
field.

• To modify an existing destination group,
click the arrow on the right side of the
Destination Group and select a
destination group.

Destination groups provide a list of available
destinations and are often best used by
containing all the similar destinations in a
single group. If shipping tickets are required
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To Do this
from a destination back to the shop, it is
recommended not to use the shop as an
additional group because that location is
already assigned a function, and using the
shop as a group may cause confusion.

Note that you cannot modify the firms in the
Jobsite destination group.

c. Modify the firms in the destination group
according to your needs:

• To add a firm, click Add Firm, select the
firm type and firm name, and click OK.

You can only select firms that are already
saved in the Address Book.

• To remove a firm from the destination,
click the firm, click Remove Firm, and click
Yes to confirm deleting the firm.

• To set a firm as the primary firm, click the
firm, and click Set Firm as Primary.

The primary firm will have the remaining
totals reported against it in production
statuses, production control reports, and
project summary reports. However, parts
assigned to the shipping route can be
shipped for any of the firms that you have
added.

d. Click Save Destination.
Modify a destination a. In the Destination list, click the destination

that you want to modify.

b. Click Properties.

c. Modify the firms of the destination according
to your needs.

d. Click Save Destination to update the
destination.

Remove a destination
from the shipping route

a. In the Destination list, click the destination
that you want to remove from the shipping
route.

b. Click Delete.
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To Do this
c. In the confirmation dialog box, click Yes to

remove the destination from the shipping
route.

Note that the shipping route can have any number of destinations, or no
destinations at all. If the Jobsite destination is present, it is always the last
destination on the shipping route. The Jobsite destination is the Ship To
address defined for each production control job in the Production
Control Job Edit dialog box.

5. To change the order of destinations in the shipping route, do the
following:

a. Click the destination that you want to move to an earlier or later
position on the shipping route.

b. Click the Move Up and Move Down buttons according to your needs.

Repeat steps a to b for all destinations that you want to move.

6. Click Save Route.

The new shipping route is now available in all production control jobs.

Copy a shipping route
Use the Copy command to create a new shipping route based on an existing
one.

1. In the list, select the shipping route that you want to use as the basis of a
new shipping route.

2. Click Copy.

3. In the Shipping Route dialog box, type a description for the new shipping
route.

4. Modify the shipping route properties according to your needs.

5. Click Save Route to create the new shipping route.

Modify a shipping route
1. In the list, select the shipping route whose properties you want to modify.

2. Click Properties. 
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3. In the Shipping Route dialog box, modify the shipping route properties
according to your needs.

4. Click Save Route to save the changes.

Delete a shipping route
Note that deleting a shipping route is permanent and cannot be undone.

1. In the list, select the shipping route that you want to delete.

2. Click Delete.

3. In the confirmation dialog box, click Yes to permanently delete the
shipping route.

Add, modify, and delete top text items for shipping tickets
In the Shipping Top Text Maintenance dialog box, you can create standard
memos, notes, or other text items to be added at the top of shipping tickets.

1. Click the Maintenance ribbon tab.

2. On the menu, select Production Control --> Shipping Top Text
Maintenance .

Create a top text item
1. At the bottom of the Shipping Top Text Maintenance dialog box, click

New.

2. In the Description field, type a name for the top text item.

3. In the Top Text field, type the information to be added at the top of the
shipping tickets.

4. Click Add.
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Modify a top text item
1. In the Shipping Top Text Maintenance dialog box, select the top text

item that you want to modify.

2. In the Description field, modify the item name according to your needs.

3. In the Top Text field, modify the top text according to your needs.

4. Click Edit to save the changes.

Delete a top text item
1. In the Shipping Top Text Maintenance dialog box, select the top text

item that you want to delete.

2. Click Delete.

3. To permanently delete the top text item, click Yes in the confirmation
dialog box.

Manage cut lists
Use the Cut Lists dialog box to create, modify, and delete cut lists for all
existing production control jobs. You can also lock cut lists and create cut list
reports in the Cut Lists dialog box.

To access the Cut Lists dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Production Control --> Cut Lists .

3. In the Select Production Control Jobs dialog box, do either of the
following:

• Click the arrows on the right side of the Job Group lists and select the
job groups whose cut lists you want to adjust.

• Click the arrow buttons to move the jobs whose cut lists you want to
adjust to the Included list.

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

4. Click OK.

The Cut Lists dialog box opens, displaying the cut lists related to the jobs that
you selected.
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The columns in cut lists can be highlighted with either green, yellow, or red:

• Status items highlighted in green are completed.

• Items highlighted with red or yellow need attention. For example, items
highlighted in red can be past the assigned due date, whereas items
highlighted with yellow may be missing information or need validation.

You can limit the visible cut lists by selecting a job, shape, main mark, piece
mark, sequence, or lot by clicking options in the navigation tree on the left.

The combining result for which items have been purchased needs to be
reviewed to verify that the saved cutting patterns are still valid. Items may
need to be recombined. After recombining, the changes need to be saved to
the current cut list.

Create a cut list
1. Click New Cut List.

2. In the Enter Value dialog box, click the arrow on the right side of the field,
and select the production control job for which you want to create the cut
list. 

The Production Control Purchasing Report Filters dialog box opens.

3. Select the items that you want to include in the cut list: 

When you are creating a new cut list, Tekla EPM by default filters the items
in the new cut list so that only items that are not yet assigned to a cut list
are included.

a. In the Production Control Purchasing Report Filters dialog box,
click Reset to reset the default filter.
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b. To limit the items included in the cut list, select a filter type in the
Type list, and click Select.

c. In the Filter dialog box, click the arrow buttons to move the items
that you want to include to the Included list.

d. Click OK.

To further limit the items in the cut list, repeat substeps b to d or all
necessary filter types.

4. Click Make Report.

5. In the Report Progress dialog box, click Save To Cut List. 

The new cut list is saved.

6. To close the dialog box, click the Close button (X) in the upper-right
corner.

View the details of a cut list
1. Select the cut list whose details you want to view.

2. Click Details. 

The cut list details open in a new dialog box.

3. Do any of the following: 

To Do this
View the details of a cut
list item

a. Click the cut list item whose details you want
to view.

b. Click Details.

c. When you have viewed the item details, click
the Close button (X) to close the item details.

Cut a cut list item a. Click the cut list item that you want to cut.

b. Click Cut.

Note that the required materials need to be in
stock.

c. In the Material used, define properties for the
used material.

d. In the Drop section, define the drop
properties.

e. In the Piece Tracking section, define the user
who cut the item, the hours used, and the
batch ID.
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To Do this
f. Click TFS.

The item is taken from stock and cut according to
the properties that you defined. The production
control job is updated with the date/time stamp of
the cut, and the Status column is highlighted with
green.

Delete a cut list item Note that deleting a cut list item is permanent and
cannot be undone.

a. Click the cut list item that you want to delete.

b. Click Delete.

c. In the confirmation dialog box, click Yes to
permanently delete the cut list item.

Change the name or required date of a cut list
1. Select the cut list whose name or date you want to modify.

2. Click Update Cut List.

3. According to your needs, do any of the following: 

To Do this
Change the name of the
cut list

a. In the menu, select Set Description.

b. In the Enter Value dialog box, type a new
name for the cut list.

c. Click OK.

The cut list name is updated in the Cut List
column.

Change the required
date of the cut list

a. In the menu, select Set Date Required.

b. In the Enter Value dialog box, click the arrow
on the right side of the field.

c. Select the new required date in the calendar.

d. Click OK.

The required date is updated in the Date Req
column.
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Validate cut list items
When material changes occur, items in the Val Req column may be
highlighted with yellow. This means that you need to verify that the items still
work with the cutting details, or validate the cut list.

1. Double-click the cut list that contains items that need to be validated.

2. Select the items that you want to validate.

3. At the bottom of the dialog box, click Validate.

Tekla EPM validates the cut list.

If stock lengths no longer work with the combined parts, the items in the Val
Req column are highlighted with red.

Re-validate cut list items
If the Inval column is highlighted with red, you need to re-validate cut list
items.

Re-validating parts consists of uncombining the purchased materials and
recombining them to correct the cutting details. Depending on the changes
that have occurred, you may need to combine the items to a different or
additional stock length of materials.

1. Double-click the cut list that contains items that need to be re-validated.

2. Select the items that you want to re-validate.

3. At the bottom of the dialog box, click Re-Validate.

Lock or unlock a cut list
• According to your needs, do one of the following:

• To lock a cut list, select the cut list and click Update Cut List --> Lock.

When a cut list is locked, its name in the Cut List column is highlighted
with red.

• To unlock a locked cut list, select the cut list and click Update Cut List --
> UnLock.

Share or unshare a cut list
• To share a cut list to other users, select the cut list and click Update Cut

List --> Share.

• To stop sharing a cut list to other users, select the cut list and click Update
Cut List --> Unshare.
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Export cut list to DSTV+
If you have enabled the DSTV+ integration, you can export cut list information
as a .zip package of CNC files that follow the DSTV+ file standard.

1. Select the cut list that you want to export.

2. Click DSTV+ Export.

3. Browse to and select the folder where you want to export the files.

4. If necessary, change the file name.

5. Click Save. The cut list information is exported to the selected folder. You
can see the export status in the Status dialog box.

6. To close the Status dialog box, click OK.

Next, you can extract the files from the .zip package and import the files to
the relevant machine, so that the machine will know how to cut the related
parts.

View, print, or export cut list reports
1. Select the cut lists for which you want to create reports. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Cut List Report.

3. In the Report Selection dialog box, click the report that you want to view
or print.

4. According to your needs, do any of the following: 

To Do this
View the cut list report • In the Report Selection dialog

box, click View.

The selected reports opens in Tekla
EPM Report Viewer.

Print the cut list report a. In the Report Selection dialog
box, change the number of the
printed copies by clicking the +
and - buttons.

b. If necessary, click Select Printer,
select which device you want to
use for printing, and click OK.

You can also select Default
Printer to always use the default
printer with this report, or No
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To Do this
Printer to reset the current
printer.

c. Click Print.

d. Click Yes.
Export a. Click Export.

b. In the Export Format list, select
an export format.

c. Click Browse.

d. Browse to the location where you
want to save the exported file,
and click Save.

e. Modify the file name according to
your needs.

f. To attach the exported file to a
Microsoft Outlook email and
send it to a recipient, select the
Attach to Email check box.

g. To open the file after exporting it,
select the Open Exported
Document check box.

h. Click Export.

5. To close the dialog box, click the Close button (X) in the upper-right
corner.

Delete a cut list
Deleting a cut list is permanent and cannot be undone.

1. In the list, click the cut list that you want to delete.

2. Click Delete Cut List.

3. In the confirmation dialog box, click Yes to permanently delete the cut list.

Add piece tracking and load tracking information and loads
to production control jobs
Use the Production/Shipping Entry dialog box to add information to any
product control job in Tekla EPM. You can add piece tracking information and
loads, ship and unship loads, and add piece marks to trucks.
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Note that the Production/Shipping Entry dialog box only allows you to add
one item at a time.

To open the Production/Shipping Entry dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Production Control --> Production/Shipping Entry .

The Production/Shipping Entry dialog box opens on the Piece Tracking
tab.
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Add piece tracking information
1. In the Action list, click the action that you want to perform. You can add

or delete items.

2. In the Job # list, click the production job for which you want to perform
the action.

3. In the appropriate lists, select the main mark, piece mark, sequence, lot
number, station, employee who is adding the information, and date. 

Note that the employee must be a Tekla EPM user.

4. In the Quantity field, enter the number of pieces being worked on.

5. In the Hours field, enter the man hours used for working on the item.

6. To perform the action, click Add or Delete.

The action is updated to the selected job. The action also appears in the
History list at the bottom of the Production/Shipping Entry dialog box.

Add loads, ship loads, and unship loads
1. Click the Trucks tab to open it.

2. In the Action list, click the action that you want to perform. 

You can add or validate, ship, or unship trucks.

3. In the Job # list, click the production job for which you want to perform
the action.

4. Select the load number, shipping date, and destination in the appropriate
lists.

5. If necessary, click View to view the items assigned to the selected load.

6. If the load needs to be returned, select the To Be Returned check box. 

The load must be returned even if the materials will not be physically
returned. Returning the loaded items allows the piece marks to be loaded
onto a new shipping ticket that contains items delivered to the job site.
This way, Tekla EPM can keep accurate records of when parts were
received and shipped.

7. To perform the action, click Add/Validate, Ship, or Un-Ship. 

The action is updated to the selected production control job. The action
also appears in the History list at the bottom of the Production/Shipping
Entry dialog box.

8. If necessary, view the shipping ticket:

a. Click Shipping Ticket.

b. In the Report Selection dialog box, select the report that you want to
view, print, or export.
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c. Do any of the following: 

To Do this
View the shipping ticket • In the Report Selection dialog box, click View.
Print the shipping ticket 1. In the Report Selection dialog box, change

the number of the printed copies by clicking
the + and - buttons.

2. Click Print.

3. In the Select Printer dialog box, click a printer
to select it.

4. Click OK.
Export the shipping
ticket

1. In the Report Selection dialog box, click
Export.

2. In the Export Format list, select an export
format.

3. Click Browse.

4. Browse to the location where you want to save
the exported file, and click Save.

5. Modify the file name according to your needs.

6. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email check box.

7. To open the file after exporting it, select the
Open Exported Document check box.

8. In the Report Selection dialog box, click
Export.

Add piece marks to trucks
1. Click the Load Tracking tab to open it.

2. In the Action list, click the action that you want to perform. 

You can add, delete, return, or unreturn items.

3. In the appropriate lists, select the main mark, piece mark, sequence, lot
number, load number, and date.

4. If necessary, click View to view the items assigned to the selected load.

5. In the Quantity field, enter the number of pieces that are worked on.

6. Click Add, Delete, Return, or Un-Return. 

The action is updated to the selected production control job. The action
also appears in the History list at the bottom of the Production/Shipping
Entry dialog box.
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7. If necessary, view the shipping ticket:

a. Click Shipping Ticket.

b. In the Report Selection dialog box, select the report that you want to
view, print, or export.

c. Do any of the following: 

To Do this
View the shipping ticket • In the Report Selection dialog box, click View.
Print the shipping ticket 1. In the Report Selection dialog box, change

the number of the printed copies by clicking
the + and - buttons.

2. Click Print.

3. In the Select Printer dialog box, click a printer
to select it.

4. Click OK.
Export the shipping
ticket

1. In the Report Selection dialog box, click
Export.

2. In the Export Format list, select an export
format.

3. Click Browse.

4. Browse to the location where you want to save
the exported file, and click Save.

5. Modify the file name according to your needs.

6. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email check box.

7. To open the file after exporting it, select the
Open Exported Document check box.

8. In the Report Selection dialog box, click
Export.

Review production statuses of jobs
Use the Production Status command to view the current production station
of items in a single production control job or a group of jobs.

1. Click the Maintenance ribbon tab.

2. On the menu, select Production Control --> Production Status .
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3. In the left-hand pane of the Production Status Filters dialog box, select
check boxes next the summary fields to include the related properties as
columns in the summary of the production statuses. 

Selecting summary field check boxes can make it easier to view the overall
production progress of multiple jobs.

4. To only view the status of specific types of items, select a filter type in the
Type list, and click Select. 

For example, to only view particular jobs, select Job # and click Select.

5. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the items that you want to view to the
Included list.

• Type the maximum and minimum values for the items that you want
to view.

6. Click OK. 

To further limit the visible items, repeat steps 3 to 5 for all necessary filter
types.

7. At the bottom of the Production Status Filters dialog box, select check
boxes next to the information that you want to show in the production
status summary. 

You can select to show the TFS status, weight, gross weight, assembly
weight, or gross assembly weight.

8. Click OK to view the production statuses of selected items.

The Production Status dialog box opens, displaying a summary of the
production statuses of items in the selected production control jobs.

If necessary, you can export the production status summary to Microsoft Excel
to save the production status information. Right-click in the display are of the
Production Status dialog box, and in the context menu, select Export to
Excel.

Create global production control reports
Global production control reports contain information from multiple
production control jobs. You can create either purchasing reports or
production reports.

See also

View or print purchasing reports (page 720)

View, print, or export production reports (page 722)
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View or print purchasing reports
Use the Purchasing Reports dialog box to create purchasing reports involving
all production control jobs.

Create a purchasing report

1. Click the Maintenance ribbon tab.

2. On the menu, select Production Control --> Purchasing Reports .

3. In the Select Production Control Jobs dialog box, click the arrow buttons
to move the production control jobs that you want to include in the
reports to the Included list. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

4. Click OK.

5. To limit the items that are included in the reports, in the Production
Control Purchasing Report Filters dialog box, select a filter type in the
Type list, and click Select.

6. In the Filter dialog box, do one of the following depending on the filter
type:

a. Click the arrow buttons to move the items whose heat documents
you want to view to the Included list.

b. Type the maximum and minimum values for the items whose heat
documents you want to view.

7. Click OK. 

To further limit the items in the reports, repeat steps 5 to 7 for all
necessary filter types.

8. Click the arrow on the right side of Weight Type field, and select the
weight type that you want to use in the report. 

Note that the Weight Type list is only visible if you have selected it on the
Report Settings tab of the Company Standards dialog box.

The net weight option is only available if CNC files have been loaded for
the items included in the report.

9. Click Make Report.

10. In the Report Progress dialog box, click the report that you want to view
or print. 

To modify the visible reports, click the Edit Report Types button.

View the report

• In the Report Selection dialog box, click View.
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The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
EPM Report Viewer window to email the report via Microsoft Outlook.

Print the report

1. In the Report Selection dialog box, change the number of the printed
copies by clicking the + and - buttons.

2. Click Print.

3. In the Select Printer dialog box, click a printer to select it.

4. Click OK.

5. To close the dialog box, click the Close button (X) in the upper-right
corner.

Save a cut list

1. Click Save Cut List.

2. In the Job # list, select the job.

3. In the Cut List Description field, either enter a description directly in the
field, or click the arrow on the right side of the field to select an option in
the list.

4. Click the arrow on the right side of the Date Required field, and click a
date in the calendar to select it.

5. If you do not want anyone to make changes to the cut list, select the Lock
Cut List check box.

6. Click Save To Cut List. 

Tekla EPM saves the cut list. You can view and modify the cut list in the
selected production control job and in the Tekla EPM Go web application.

7. Click OK to close the Message dialog box.

8. To close the dialog box, click the Close button (X) in the upper-right
corner.

View, print, or export production reports
Use the Reports command under Maintenance --> Production Control to
create reports that include information from all or several production control
jobs. The available reports include master shipping lists and station
summaries.

To create production control reports, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Production Control --> Reports .
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3. In the Select Production Control Jobs dialog box, click the arrow buttons
to move the jobs that you want to include in the reports to the Included
list..

4. Click OK.

5. To only include specific types of items in the reports, in the Production
Control Report Filters dialog box, select a filter type in the Type list, and
click Select.

6. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the items that you want to include in
the reports to the Included list.

• Type the maximum and minimum values for the items that you want
to include in the reports.

7. Click OK.

8. Click Make Report.

9. In the Report Selection dialog box, select the report that you want to
view, print, or export.

You can modify the visible report types by clicking Edit Report Types.

View a report

• In the Report Selection dialog box, click View.

The selected report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
EPM Report Viewer window to email the report via Microsoft Outlook.

Print a production report

1. In the Report Selection dialog box, change the number of the printed
copies by clicking the + and - buttons.

2. Click Print.

3. In the Select Printer dialog box, click a printer to select it.

4. Click OK.

5. To close the dialog box, click the Close button (X) in the upper-right
corner.

Export a production report

1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.
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4. Browse to the location where you want to save the exported file, and click
Save.

5. Modify the file name according to your needs.

6. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email check box.

7. To open the file after exporting it, select the Open Exported Document
check box.

8. In the Report Selection dialog box, click Export.

9.2 Open the Production Control module
To open Production Control, do the following:

• At the top of the Tekla EPM window, click the Production Control button. 

The Select Production Control Job dialog box opens. Next, you can create a
new production control job, open or modify an existing job, or view and
modify the documents attached to a job.

NOTE Jobs whose statuses are set to Closed are not shown by default. To
show closed jobs, select the Show Closed Jobs check box.
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See also

Find a production control job (page 725)

Create a production control job (page 725)

Open and view a production control job (page 729)

Store document references for a production control job (page 733)

Modify a production control job (page 734)

Find a production control job
Use the Find Job command to find the desired production control job among
various other jobs in the Select Production Control Job dialog box.

1. In the Select Production Control Job dialog box, click the Production
Control ribbon tab.

2. On the File menu, select Find Job.

3. In the Enter Value dialog box, either click the arrow on the right side of
the field to select a job in the list, or type the job number directly in the
field.

4. Click OK.

Tekla EPM selects the job in the Select Production Control Job dialog box.
You can now modify or open it.

NOTE Jobs whose statuses are set to Closed are not shown by default. To
show closed jobs, select the Show Closed Jobs check box.

See also

Open and view a production control job (page 729)

Modify a production control job (page 734)

Create a production control job
To create a new production control job, do the following:

1. At the bottom of the Select Production Control Job dialog box, click Add.

2. On the General tab of the Production Control Job Edit dialog box, type
the job number. 

Note that the job number cannot be changed later. All other production
job information can be modified later, if necessary.
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3. On the General tab, adjust the following properties according to your
needs: 

Option Description
Job Date The date your company received the job. Tekla

EPM automatically uses the current date.

If necessary, change the date by clicking the arrow
on the right side of the Job Date field and selecting
a date in the calendar.

Shipping Date The estimated shipping date of the job.

Click the arrow on the right side of the Shipping
Date field, and select a date in the calendar.

Job Description The description of the job.

Type a description in the Job Description field.
Job Location The city or town of the production control job.

Type the appropriate location in the Job Location
field.

Job Status Select if the job is still in progress (Open), or if the
job has already been finished (Closed).

You can filter the Select Estimating Job dialog
box, so that only open jobs are shown.

ERP Job # The accounting system job number.

Typing the accounting system job number in the
ERP Job # field allows you to link material items
properly when you export information to the
accounting system, such as Trimble Viewpoint.

Job Group The first and second job groups that the current
production control job belongs to.

Click the arrow on the right side of Job Group
fields and select existing job groups in the list, or
type new job groups directly in the blank fields.

Comment Comments on the job. The comments will be
visible in production control reports.

Type comments in the Comment field.
Shipping Comment Comments on the shipping of the job.

For example, you can add information on shipping
restrictions.

Project Management
Job

The project management job that is linked to the
production control job. Selecting an project
management job allows you to import useful
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Option Description
information from the selected project
management job.

The related project management job needs to be
linked to the production control job in order to
access the drawings in the Production Control
module.

You can also load general information from the
project management job to the production control
job. Tekla EPM will fill the related fields on the
General tab with information from the selected
project management job, and load the addresses
from the first company tab in the project
management job on the Sold To/Ship To tab.

To load information from a project management
job, do the following:

a. Click the arrow on the right side of Project
Management Job field, and select the project
management job in the list.

b. Click Load Info on the right side of the Project
Management Job field.

c. At the bottom of the dialog box, click Save.

d. To further modify the properties of the
production control job, click the production
control job to select it, and click Edit.

Estimate The estimating job that is linked to the production
control job. Selecting an estimating job allows you
to apply the labor from the estimating job to the
production control job.

Click the arrow on the right side of Estimate field,
and select the estimating job in the list.

You can also load general information from the
estimating job the production control job. Tekla
EPM will fill the related fields on the General tab
with information from the selected estimating job.

To load information from an estimating job, do the
following:

a. Click Load Info on the right side of the
Estimate field.

b. At the bottom of the dialog box, click Save.
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Option Description
c. To further modify the properties of the

production control job, click the production
control job to select it, and click Edit.

4. On the Sold To/Ship To tab, modify the client details: 

Note that only companies and contacts that have already been saved in
the Address Book as Client can be selected.

a. Click the arrow on the right side of Sold To field, and select the buyer
in the list.

b. Click the arrow on the right side of Ship To field, and select the
receiver in the list.

The contact information is automatically added to the blank fields, but you
can still modify the details according to your needs.

5. On the Input Settings tab, adjust the input settings used in the job. 

For more information on the available input settings, see Define company
standard settings for Production Control (page 676).

6. Click the buttons at the bottom of the Production Control Job Edit dialog
box to adjust the combining optimizations, suppliers, input and display
units, pay categories, and shipping routes used for the current job. 

For more information on the available settings, see the following links:

• Define combining optimizations for Production Control (page 684)

• Define suppliers for Production Control (page 686)

• Define input and display units for Production Control (page 684)

• Define pay categories for Production Control (page 688)

• Create, modify, and delete global shipping routes (page 704)

7. Click Save to create the job.

The Production Control Job Edit dialog box closes. The production control
job is added to the list in the Select Production Control Job dialog box.

Link a production control job to an estimating job and a project
management job
By linking a production control job to an estimating job and a project
management job, you can compare the estimated and actual working hours
and material information.

1. At the top of the Tekla EPM window, click the Production Control button.

2. In the Select Production Control Job dialog box, select the production
control job that you want to link to a project management job.

3. Click Edit.
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4. In the Production Control Job Edit dialog box, click the arrow on the right
side of the Project Management Job list and select the desired project
management job. 

The project name and job number do not need to match.

5. To load general information from the selected project management job to
the production control job, click Load Info. 

Tekla EPM fills the related fields on the General tab with information from
the selected project management job, and loads the addresses from the
first company tab in the project management job onto the Sold To/Ship
To tab.

6. Click Save.

7. Re-open the Production Control Job Edit dialog box.

8. Click the arrow on the right side of the Estimate list and select the desired
estimating job in the list. 

The job numbers do not need to match.

9. To load general information from the selected estimating job to the
production control job, click Load Info. 

Tekla EPM fills the related fields on the General tab with information from
the selected estimating job.

10. Click Save.

See also

Link a production control job to an estimating job and a project management
job (page 728)

Open and view a production control job
To view or modify the items in an existing production control job, you need to
open the job. Do the following:

1. In the Select Production Control Job dialog box, click the job that you
want to open. 

NOTE Jobs whose statuses are set to Closed are not shown by default.
To show closed jobs, select the Show Closed Jobs check box.

2. Double-click the job, or click Open at the bottom of the dialog box.

3. If the Open to Filter Selection check box has been selected in company
standards, set filters in the Production Control Filters dialog box to only
show the items that you want to see. 

For detailed instructions, see Filter information in the Production Control
dialog box (page 731).
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The Production Control dialog box opens.

View the elements in the dialog box in the following image:

(1)

The navigation tree allows you to view items by drawing number, shape,
sequence, or load.

Click + to expand a category, and click a sub-category to only display items of
that category.

(2)

By default, the summary shows the quantity, length, area, and weight of each
item, the current item and assembly, the selected items, all items shown in the
display area, and the entire job.

You can click the check box in the upper-left corner of the summary to select
for which items you want to show the summary.

(3)

Use the Find button to find items of a specific shape, material grade, or
material dimension, or a specific item in the production control job. For
instructions, see Find production control items (page 732).

(4)

The input section allows you to modify the information of new or selected
material items.

(5)
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The Sequence section shows the sequences of the selected item, and the Edit
Sequences button allows you to manage the sequences. For instructions, see
Manage sequences (page 785).

(6)

Information grid: allows you to view the overall situation of the material item:

• REQ: The number of pieces that are on a requisition and have not yet been
combined or purchased.

• INV: The number of pieces that have been combined in the production
control job and are currently listed in a purchase order.

• TFS: The number of pieces that have been taken from stock and are being
worked in the shop.

(7)

Links, Piece Tracking, Loads, and Production Status buttons allow you to
view and manage the item's station summary and the loading situation, and
view the production status and the linked material items in other modules. If
multiple items are selected, the information of the last selected item is shown.

For instructions, see View material links (page 749), Track production by piece
mark (page 805), Create, modify, and delete loads (page 800), and Review
the production statuses of items (page 748).

See also

Filter information in the Production Control dialog box (page 731)

Filter information in the Production Control dialog box
In the Production Control Filters dialog box, you can set filters that
determine which items are shown in a production control job. You can also
save the filter settings for later use.

If the Open to Filter Selection check box has been selected in the Production
Control company standard settings, the Production Control Filters dialog
box opens automatically when you open a production control job.

If the Open to Filter Selection check box has not been selected, open the
Production Control Filters dialog box as follows:

1. In an open production control job, click the Production Control ribbon
tab.

2. On the menu, select Filter.

In the Production Control Filters dialog box, set filters as follows:

1. To filter the displayed items according to selected criteria, select a filter
type in the Type list, and click Select.

2. In the Filter dialog box, click the arrow buttons to move the items that
you want to display to the Included list.
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3. Click OK. 

If you want to further filter the information displayed in the Estimating
dialog box, repeat steps 1 to 3 for different items. Note that only items
that match the items in the Included list will be available when setting
more filters.

If you want to clear all filter settings, click Reset.

4. To save commonly used filters, do the following:

a. Click Filter Types in the lower-left corner.

b. Click New.

c. Type a description for the filter type.

d. Create the filter settings. 

For more information, see steps 3 to 5.

e. Click Add.

f. To close the dialog box, click the Close button (X) in the upper-right
corner. 

The newly created filter type is selected in the Filter Types list.

g. To apply the filter type, click Set.

5. According to your needs, do one of the following:

• To use the filter, click Apply Filter.

• To use the filter in the job and save it until a new filter is set or the
filter is cleared, click Apply Filter & Save.

Note that the filter will remain in use even if you close and re-open the
job. After you clear the filters, the filter settings cannot be used again.

The Estimating Filters dialog box closes, and the Production Control dialog
box is filtered according to the settings you made.

To display all information in the Production Control dialog box again, click
Clear Filters in the upper-left corner.

Find production control items
Use the Find button in to quickly find items in an open production control job.
You can search for items by material shape, grade, and dimensions, or by page
and item number.

1. In an open production control job, click Find.

2. Do one of the following: 

To Do this
Find all items that have a particular
shape, grade, and dimensions

a. In the Find menu, select Find
Shape/Grade/Size.
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To Do this
b. In the Find dialog box, select the

right shape, grade, and
dimensions in the available lists.

You can also start typing the
shape, grade, or dimensions.
Tekla EPM will suggest options
that match what you have typed.

c. Click Find.

The Find dialog box closes. Only the
items that match your search are now
shown in the current production
control job.

Find the right item on a particular
page of the estimating job

a. In the Find menu, select Find
Item.

b. In the Find dialog box, select the
main mark and piece mark in the
available list.

You can also start typing the
main mark or piece mark. Tekla
EPM will suggest options that
match what you have typed.

c. Click Find.

The Find dialog box closes. Only the
items that match your search are now
shown in the Estimating dialog box.

See also

Manage production control items (page 776)

Store document references for a production control job
Document Index is where you can store documents for reference. When you
store documents in Document Index, each user who has access to the
production control job can view them, so it is easy to keep up-to-date on the
production control job. You can save heat documents, mill certifications, and
pricing quotes, as well as Microsoft Outlook emails, in Document Index.

To access Document Index, do the following:

1. In the Select Production Control Job dialog box, click to select the job
whose document references you want to view or modify.
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2. Click Document Index, or press F8.

The Document Index dialog box opens. Next, you can either modify the
available folders for document references, or add, modify, delete, open, and
email document reference files.

For more information, see the following links:

Manage document reference categories (page 389)

Add document references (page 391)

Open a document reference (page 394)

Modify a document reference (page 395)

Attach a document reference to an email (page 396)

Delete a document reference (page 396)

Modify a production control job
Use the Edit command in the Select Production Control Job dialog box to
modify the properties of a production control job. You can also adjust the
combining optimizations, suppliers, input and display units, pay categories,
and shipping routes that are used for the job.

1. In the Select Production Control Job dialog box, click the job that you
want to modify.

2. At the bottom of the dialog box, click Edit.

3. In the Production Control Job Edit dialog box, modify the production
control job settings according to your needs. 

The available properties are:

Option Description
Job Date The date your company received the job. Tekla

EPM automatically uses the current date.

If necessary, change the date by clicking the arrow
on the right side of the Job Date field and selecting
a date in the calendar.

Shipping Date The estimated shipping date of the job.

Click the arrow on the right side of the Shipping
Date field, and select a date in the calendar.

Job Description The description of the job.

Type a description in the Job Description field.
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Option Description
Job Location The city or town of the production control job.

Type the appropriate location in the Job Location
field.

Job Status Select if the job is still in progress (Open), or if the
job has already been finished (Closed).

You can filter the Select Estimating Job dialog
box, so that only open jobs are shown.

ERP Job # The accounting system job number.

Typing the accounting system job number in the
ERP Job # field allows you to link material items
properly when you export information to the
accounting system, such as Trimble Viewpoint.

Job Group The first and second job groups that the current
production control job belongs to.

Click the arrow on the right side of Job Group
fields and select existing job groups in the list, or
type new job groups directly in the blank fields.

Comment Comments on the job. The comments will be
visible in production control reports.

Type comments in the Comment field.
Shipping Comment Comments on the shipping of the job.

For example, you can add information on shipping
restrictions.

Project Management
Job

The project management job that is linked to the
production control job. Selecting an project
management job allows you to import useful
information from the selected project
management job.

The related project management job needs to be
linked to the production control job in order to
access the drawings in the Production Control
module.

You can also load general information from the
project management job to the production control
job. Tekla EPM will fill the related fields on the
General tab with information from the selected
project management job, and load the addresses
from the first company tab in the project
management job on the Sold To/Ship To tab.

To load information from a project management
job, do the following:
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Option Description
a. Click the arrow on the right side of Project

Management Job field, and select the project
management job in the list.

b. Click Load Info on the right side of the Project
Management Job field.

c. At the bottom of the dialog box, click Save.

d. To further modify the properties of the
production control job, click the production
control job to select it, and click Edit.

Estimate The estimating job that is linked to the production
control job. Selecting an estimating job allows you
to apply the labor from the estimating job to the
production control job.

Click the arrow on the right side of Estimate field,
and select the estimating job in the list.

You can also load general information from the
estimating job the production control job. Tekla
EPM will fill the related fields on the General tab
with information from the selected estimating job.

To load information from an estimating job, do the
following:

a. Click Load Info on the right side of the
Estimate field.

b. At the bottom of the dialog box, click Save.

c. To further modify the properties of the
production control job, click the production
control job to select it, and click Edit.

4. On the Sold To/Ship To tab, modify the client details: 

Note that only companies and contacts that have already been saved in
the Address Book as Client can be selected.

a. Click the arrow on the right side of Sold To field, and select the buyer
in the list.

b. Click the arrow on the right side of Ship To field, and select the
receiver in the list.

The contact information is automatically added to the fields, but you can
still modify the details according to your needs.

5. On the Input Settings tab, adjust the input settings used in the job. 

6. Click the buttons at the bottom of the Production Control Job Edit dialog
box to adjust the combining optimizations, suppliers, input and display
units, pay categories, and shipping routes used for the current job. 
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7. Click Save to update the job properties.

9.3 View production control job details
You can view multiple details regarding production control jobs, such as the
changes made to the jobs, and the production statuses and inspection
statuses of items. You can also view and adjust the project schedule and the
production schedule, or create production reports.

See also

View all changes in a production control job (page 737)

Review and adjust production control job information (page 740)

View and adjust the project schedule (page 613)

View the production schedule (page 767)

View, print, and export job-specific production control reports (page 772)

View all changes in a production control job
Tekla EPM records every change made in the system. This is useful because
you can view all changes made in the current production control job at once.
You can then filter the information to see changes made by a particular user
or on a particular date. If necessary, you can also print the list of changes.

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select History of Changes --> List Of Changes .

3. In the List Of Changes Report Filters dialog box, do any of the following: 

To Do this
Filter changes by user, revision
number, category, sub-category, or
pay category

a. Select the right filter type and
click Select.

b. Click the arrow buttons to move
the values that you want to see in
the list of changes to the
Included list.

c. Click OK.
Filter changes by date a. Select the Transaction Date

filter and click Select.
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To Do this
b. Select the start (Min) and end

(Max) dates in the calendar.

You can also select the
Expression check box for the
dates. This way, you can select
the base date and define how
many days before or after are
taken into account in the list of
changes.

c. Click OK.

4. Click Make Report.

5. In the Report Selection dialog box, do any of the following: 

To Do this
View the list of changes • Click View.

The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF
buttons at the top of the Tekla EPM Report
Viewer window to email the report via Microsoft
Outlook.

Print the list of changes a. In the Report Selection dialog box, change
the number of the printed copies by clicking
the + and - buttons.

b. If necessary, click Select Printer, select which
device you want to use for printing, and click
OK.

You can also select Default Printer to always
use the default printer with this report, or No
Printer to reset the current printer.

c. Click Print.

d. Click Yes.
Export the list of
changes

a. Click Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Browse to the location where you want to save
the exported file, and click Save.

e. Modify the file name according to your needs.
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To Do this
f. To attach the exported file to a Microsoft

Outlook email and send it to a recipient, select
the Attach to Email check box.

g. To open the file after exporting it, select the
Open Exported Document check box.

h. Click Export.

6. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

View all changes since importing the bill of materials (page 739)

View, print, and export job-specific production control reports (page 772)

View all changes since importing the bill of materials
Use the History of Changes command to view and review all changes that
have been made in a production control job since a bill of materials has been
imported.

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select History of Changes --> History of Changes .

3. In the History of Changes dialog box, select the items whose changes you
want to view in the available lists 

To view all items, clear all text from the lists.

4. Click OK.

5. To only include changes of specific properties, click the arrow buttons to
move the properties that you want to include to the Included list.

6. If necessary, filter the changes: 

To Do this
Filter changes by user a. In the Filters section, click Edit

on the right side of the User
filter.

b. Click the arrow buttons to move
the users whose changes you
want to view to the Included list.

c. Click OK.
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To Do this
Filter changes by date a. In the Filters section, click Edit

on the right side of the Date
filter.

b. Select the start (Min) and end
(Max) dates in the calendars.

c. Click OK.

7. In the lower-left corner of the dialog box, select check boxes to indicate if
you want to include changes related to sequences, piece tracking, or load
tracking.

8. Click View History of Changes. 

The history of changes appears. The items in the dialog box are color-
coded to show any changes that have been made:

• Items highlighted with green have not been changed since they were
imported.

• Items highlighted with yellow have been changed since they were
imported. The Type column shows how the items have changed.

9. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

View all changes in a production control job (page 737)

View, print, and export job-specific production control reports (page 772)

Review and adjust production control job information
Use the Review commands to view and adjust information regarding the
current production control job.

For more information, see the following links:

Manage job-specific cut lists (page 741)

Create, modify, and delete production codes used in a production control job
(page 746)

Review the production statuses of items (page 748)

View material links (page 749)

Add, modify, and review inspection test records (page 749)

Review the inspection statuses of items (page 758)

Create, modify, and delete job-specific shipping routes (page 759)

View and adjust TFS details (page 763)
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Compare the materials in a production control job and a combining job
(page 766)

Compare the labor hours in a production control job and an estimating job
(page 766)

Manage job-specific cut lists
Use the Cut Lists dialog box to create, modify, and delete cut lists for the
current production control job. You can also lock cut lists, and create cut list
reports in the Cut Lists dialog box.

To access the Cut Lists dialog box, do the following:

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Production Control --> Cut Lists .

The Cut Lists dialog box opens, displaying all cut lists saved for the current
job.

Items in cut lists can be highlighted with either green, yellow, or red:

• Status items highlighted in green are completed.

• Items highlighted with red or yellow need attention. For example, items
highlighted in red can be past the assigned due date, whereas items
highlighted with yellow may be missing information, or need validation.

You can limit the visible cut lists by selecting a shape, main mark, piece mark,
sequence, or lot by clicking options in the navigation tree on the left.

The combining result for which items have been purchased needs to be
reviewed to verify that the saved cutting patterns are still valid. Items may
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need to be recombined. After recombining, the changes need to be saved to
the current cut list.

Create a cut list

1. Click New Cut List.

2. In the Enter Value dialog box, click the arrow on the right side of the field,
and select the production control job for which you want to create the cut
list. 

The Production Control Purchasing Report Filters dialog box opens.

3. Select the items that you want to include in the cut list: 

When you are creating a new cut list, Tekla EPM by default filters the items
in the new cut list so that only items that are not yet assigned to a cut list
are included.

a. In the Production Control Purchasing Report Filters dialog box,
click Reset to reset the default filter.

b. To limit the items included in the cut list, select a filter type in the
Type list, and click Select.

c. In the Filter dialog box, click the arrow buttons to move the items
that you want to include to the Included list.

d. Click OK.

To further limit the items in the cut list, repeat substeps b to d or all
necessary filter types.

4. Click Make Report.

5. In the Report Progress dialog box, click Save To Cut List. 

The new cut list is saved.

6. To close the dialog box, click the Close button (X) in the upper-right
corner.

View the details of a cut list

1. Select the cut list whose details you want to view.

2. Click Details. 

The cut list details open in a new dialog box.

3. Do any of the following: 

To Do this
View the details of a cut
list item

a. Click the cut list item whose details you want
to view.

b. Click Details.
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To Do this
c. When you have viewed the item details, click

the Close button (X) to close the item details.
Cut a cut list item a. Click the cut list item that you want to cut.

b. Click Cut.

Note that the required materials need to be in
stock.

c. In the Material used, define properties for the
used material.

d. In the Drop section, define the drop
properties.

e. In the Piece Tracking section, define the user
who cut the item, the hours used, and the
batch ID.

f. Click TFS.

The item is taken from stock and cut according to
the properties that you defined. The production
control job is updated with the date/time stamp of
the cut, and the Status column is highlighted with
green.

Delete a cut list item Note that deleting a cut list item is permanent and
cannot be undone.

a. Click the cut list item that you want to delete.

b. Click Delete.

c. In the confirmation dialog box, click Yes to
permanently delete the cut list item.

Change the name or required date of a cut list

1. Select the cut list whose name or date you want to modify.

2. Click Update Cut List.

3. According to your needs, do any of the following: 

To Do this
Change the name of the
cut list

a. In the menu, select Set Description.

b. In the Enter Value dialog box, type a new
name for the cut list.

c. Click OK.

The cut list name is updated in the Cut List
column.
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To Do this
Change the required
date of the cut list

a. In the menu, select Set Date Required.

b. In the Enter Value dialog box, click the arrow
on the right side of the field.

c. Select the new required date in the calendar.

d. Click OK.

The required date is updated in the Date Req
column.

Validate cut list items

When material changes occur, items in the Val Req column may be
highlighted with yellow. This means that you need to verify that the items still
work with the cutting details, or validate the cut list.

1. Double-click the cut list that contains items that need to be validated.

2. Select the items that you want to validate.

3. At the bottom of the dialog box, click Validate.

Tekla EPM validates the cut list.

If stock lengths no longer work with the combined parts, the items in the Val
Req column are highlighted with red.

Re-validate cut list items

If the Inval column is highlighted with red, you need to re-validate cut list
items.

Re-validating parts consists of uncombining the purchased materials and
recombining them to correct the cutting details. Depending on the changes
that have occurred, you may need to combine the items to a different or
additional stock length of materials.

1. Double-click the cut list that contains items that need to be re-validated.

2. Select the items that you want to re-validate.

3. At the bottom of the dialog box, click Re-Validate.

Share or unshare a cut list

• To share a cut list to other users, select the cut list and click Update Cut
List --> Share.

• To stop sharing a cut list to other users, select the cut list and click Update
Cut List --> Unshare.
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Export cut list to DSTV+

If you have enabled the DSTV+ integration, you can export cut list information
as a .zip package of CNC files that follow the DSTV+ file standard.

1. Select the cut list that you want to export.

2. Click DSTV+ Export.

3. Browse to and select the folder where you want to export the files.

4. If necessary, change the file name.

5. Click Save. The cut list information is exported to the selected folder. You
can see the export status in the Status dialog box.

6. To close the Status dialog box, click OK.

Next, you can extract the files from the .zip package and import the files to
the relevant machine, so that the machine will know how to cut the related
parts.

Lock or unlock a cut list

• According to your needs, do one of the following:

• To lock a cut list, select the cut list and click Update Cut List --> Lock.

When a cut list is locked, its name in the Cut List column is highlighted
with red.

• To unlock a locked cut list, select the cut list and click Update Cut List --
> UnLock.

View, print, or export cut list reports

1. Select the cut lists for which you want to create reports. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Cut List Report.

3. In the Report Selection dialog box, click the report that you want to view
or print.

4. According to your needs, do any of the following: 

To Do this
View the cut list report • In the Report Selection dialog

box, click View.

The selected reports opens in Tekla
EPM Report Viewer.

Print the cut list report a. In the Report Selection dialog
box, change the number of the

Manage the fabrication process 745 View production control job details



To Do this
printed copies by clicking the +
and - buttons.

b. If necessary, click Select Printer,
select which device you want to
use for printing, and click OK.

You can also select Default
Printer to always use the default
printer with this report, or No
Printer to reset the current
printer.

c. Click Print.

d. Click Yes.
Export a. Click Export.

b. In the Export Format list, select
an export format.

c. Click Browse.

d. Browse to the location where you
want to save the exported file,
and click Save.

e. Modify the file name according to
your needs.

f. To attach the exported file to a
Microsoft Outlook email and
send it to a recipient, select the
Attach to Email check box.

g. To open the file after exporting it,
select the Open Exported
Document check box.

h. Click Export.

5. To close the dialog box, click the Close button (X) in the upper-right
corner.

Delete a cut list

Deleting a cut list is permanent and cannot be undone.

1. In the list, click the cut list that you want to delete.

2. Click Delete Cut List.

3. In the confirmation dialog box, click Yes to permanently delete the cut list.
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Create, modify, and delete production codes used in a production
control job
In the PDC Production Codes dialog box, you can create new production
codes for the production control job, or modify and delete existing production
codes. You can override the estimated man hours and use aggregate units to
calculate the planned labor time on a job. This labor time can then be used in
production schedules and project schedules.

To assign production codes to material items, use the Global Edit command.
For more information, see Modify multiple production control items
(page 782).

Open the PDC Production Codes dialog box

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Review --> Production Codes .

The PDC Production Codes dialog box opens.

Create a production code

1. Click New.

2. In the Production Code field, type an abbreviation for the production
code. 

For example, you can use B1 for beams or C1 for columns.

3. Type a description for the production code.

4. If you want to use aggregate units for the planned hours instead of the
original estimated hours, do the following:

a. Select the Override Man Hours check box.

b. Type the man hours in the field.

c. To change the aggregate units used, right-click the field and select the
suitable units in the context menu.

The estimated hours are always created in the estimate. They are not
overwritten by the production code properties.

The planned hours that you define here are automatically used in the
project schedule. However, if you link the production control to a
matching estimate, the estimated hours are automatically used in the
project schedule.

5. Click Add.

The new production code is added.

Modify a production code

1. Select the production code that you want to modify.
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2. Modify the production code name, description, man hours, and aggregate
units according to your needs.

3. Click Save to update the properties.

Delete a production code

Note that deleting a production code is permanent and cannot be undone.

1. Select the production code that you want to delete.

2. Click Delete.

3. In the confirmation dialog box, click Yes to permanently delete the
production code.

Review the production statuses of items
In the Production Status dialog box, you can review the production statuses
of main mark items in the current production control job.

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Review --> Production Status .

3. To only review the production statuses of particular items, in the
Production Status Filters dialog box, select a filter type in the Type list,
and click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the values that you want to review to
the Included list.

• Type the maximum and minimum values for the items that you want
to review.

5. Click OK. 

To further limit the items that you want to review, repeat steps 3 to 5 for
all necessary filter types.

6. Click check boxes next to the item properties that you want to view in the
left-hand pane and at the bottom of the dialog box.

7. If you do not want to view the production status of items without piece
tracking or load tracking, select the Exclude Accessories without Piece/
Load Tracking check box.

8. Click OK to view the production statuses of the selected items.

The Production Status dialog box opens, displaying the production stations,
field stations, and shipping conditions of items in the current production
control job.

The information is color-coded:
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• Completed stations and operations are highlighted with green. The
completion date is also displayed.

• All work that is in progress is highlighted with yellow.

• If no progress has been made regarding the station or operation, items are
highlighted with red.

Note that you can export the production status information as a Microsoft
Excel worksheet. Right-click anywhere in the display area of the Production
Status dialog box, and in the context menu, select Export to Excel.

View material links
The Links button in production control jobs allows you to view the properties
of the requisition, inventory, and inventory history materials to which the
selected production control items are linked.

1. Select items in the Production Control dialog box. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Links button near the lower-right corner. 

The Links dialog box opens, showing a list of all the linked material items
in other Tekla EPM modules.

3. To view one of the linked material items in its own location in Tekla EPM,
select the item and click Open at the Links dialog box, or double-click the
item.

See also

Review and adjust production control job information (page 740)

Add, modify, and review inspection test records
In the Test Records dialog box, you can run inspection tests and follow-up
tests, or modify and view the existing inspection test records. You can also
create reports that allow you to review if the inspection tests have been
successful or not.

To access the Test Records dialog box, do the following:

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Review --> Inspection Test Records .

The Test Records dialog box opens, displaying all existing inspection test
records.
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If you need to modify the setups of inspection tests, see Modify the setup of
an inspection test (page 754).

Add a new inspection test record

1. At the bottom of the dialog box, click Run Test.

2. Click the arrow on the right side of the Test Type, Category, and Test
Title fields, and select suitable options in the lists. 

The preloaded test types are:

• Assembly: the test subject is an assembly or a part flagged for piece
tracking in a production control job.

• Employee: the test subject is a Tekla EPM user.

• Environmental: a general test without a subject.

• Equipment: a general test without a subject.

• Fitting: a general test without a subject.

• General: a general test without a subject.

• Load: the test subject is a shipping load in a production control job.

• Part: the test subject is a part in a production control job.

• Training: a general test without a subject.

3. Click OK.

4. To determine the test subject, in the Test Subject section of the New
Inspection Test Record dialog box, do the following:
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a. Click the arrows on the right side of the available fields and select
suitable options in the lists.

b. Type values in the fields.

5. Define the inspection test record properties by using the available lists
and fields. 

The mandatory fields and lists depend on the test type that you selected.

6. If you want to save the same properties for the next records you add,
select the Carry Over check box in the lower-left corner. 

Note that if you close the New Inspection Test Record dialog box, you
can no longer use the properties of the latest inspection test record you
added.

7. Click Save.

The new inspection test record is added to the Test Records dialog box.

Add, modify, and review inspection test records
In the Test Records dialog box, you can run inspection tests and follow-up
tests, or modify and view the existing inspection test records. You can also
create reports that allow you to review if the inspection tests have been
successful or not.

To access the Test Records dialog box, do the following:

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Review --> Inspection Test Records .

The Test Records dialog box opens, displaying all existing inspection test
records.
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If you need to modify the setups of inspection tests, see Modify the setup of
an inspection test (page 754).

Filter inspection test records

1. At the top of the dialog box, click Set Filters.

2. In the Test Record Filters dialog box, do any of the following:

• On the Test Record and Test Subject tabs, click the available filter
buttons, and click the arrow buttons to move the values that you want
to display to the Included list.

• Click the Test Date button, click the arrows on the right side of the
minimum and maximum date lists, and select dates in the calendars.

If necessary, you can also create an expression for the date.

• On the Field Filters tab, click Add Field Filter, and click the arrow
buttons to move the fields that you want to display at the top of the
Test Records dialog box to the Included list.

3. Click OK.

4. Click Apply Filter.

The Test Records dialog box now only displays the information that you
selected.

Run a follow-up test

To record a follow-up test for a failed test record, do the following:

1. Click the inspection test record for which you want to add a follow-up test.
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2. Click Run Follow-Up Test.

3. In the New Inspection Test Record dialog box, modify the test
properties.

4. Click Save.

The follow-up test is added to the list in the Test Records dialog box.

Modify an inspection test record

1. Click the inspection test record that you want to modify in the list.

2. At the bottom of the dialog box, click Inspection Test Properties.

3. Modify the inspection test properties according to your needs.

4. Click Save to update the properties.

View, print, and export inspection test reports

You can create various reports based on inspection tests. You can check if the
inspection tests have been successful and find the problems by creating
reports by worker, parts, assemblies, sequence, location, test, categories and
sub-categories.

1. In the Test Records dialog box, click the Test Records ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. In the Report Selection dialog box, click the report that you want to
create.

4. According to your needs, do any of the following: 

Option Description
View the report • In the Report Selection dialog box, click View.

The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF
buttons at the top of the Tekla EPM Report
Viewer window to email the report via Microsoft
Outlook.

Print the report a. In the Report Selection dialog box, change
the number of the printed copies by clicking
the + and - buttons.

b. Click Print.

c. In the confirmation dialog box, click Yes to
print the selected report.

d. In the Select Printer dialog box, click a printer
to select it.

e. Click OK.
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Option Description
Export the report a. In the Report Selection dialog box, click

Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Browse to the location where you want to save
the exported file, and click Save.

e. Modify the file name according to your needs.

f. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email check box.

g. To open the file after exporting it, select the
Open Exported Document check box.

h. In the Report Selection dialog box, click
Export.

5. To close the dialog box, click the Close button (X) in the upper-right
corner.

Modify the setup of an inspection test
In the Inspection Test Setup dialog box, you can modify the testing
requirements that the inspector will use for each test.

To access the Inspection Test Setup dialog box, do the following:

• At the bottom of the Test Records dialog box dialog box, click Inspection
Test Properties.

To modify the testing requirements, do all of the following:

1. Modify the test properties

1. At the top of the Inspection Test Setup dialog box, modify the test
properties according to your needs.

2. Click the arrow on the right side of Test Type field, and select the test type
in the list. The preloaded test types are:

• Assembly: the test subject is an assembly or a part flagged for piece
tracking in a production control job.

• Employee: the test subject is a Tekla EPM user.

• Environmental: a general test without a subject.

• Equipment: a general test without a subject.

• Fitting: a general test without a subject.
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• General: a general test without a subject.

• Load: the test subject is a shipping load in a production control job.

• Part: the test subject is a part in a production control job.

• Training: a general test without a subject.

3. Type a unique title for the test. 

The title is automatically copied to the Category field.

4. In the Category field, do one of the following:

a. To create a new category, type the category name in the Category
field.

b. To use an existing category, click the arrow on the right side of the
Category field, and select an existing category in the list.

Categories are used to group similar tests together. For example, if you
have several weld tests, you can set the category to Weld for all of the
tests to make it easier to filter that group of tests.

5. Click the arrow on the right side of Production Station field, and select
the production station that will be marked as completed when a
successful or passed test record is added. 

Note that the Production Station option is only available if the test type
is set to Assembly.

6. If you only want main members to be used as test subjects, select the
Main Members Only check box. 

Note that the Main Members Only check box is only available if the test
type is set to Assembly.

7. In the Notes field, type any instructions for performing the test, or other
applicable notes. 

The text in the Notes field will be displayed when you add a new test
record.

8. Click Save Inspection Test to save the test setup.

2. Add new fields

1. In the Test Fields section of the Inspection Test Setup dialog box, click
New Field.

2. In the Field Name field of the Inspection Test Field Setup dialog box,
type the field name used in the test definition.

3. In the Title field, type the title of the field used in the New Inspection
Test Record dialog box.

4. In the Abbreviation field, type the text used in the column header of the
Test Records dialog box.
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5. In the Notes field, add any additional text or instructions regarding the
field.

6. Click the arrow on the right side of Field Type field and select a suitable
option:

• Boolean and Numeric are test types that require you to set pass and
fail criteria settings.

• Date, Text, Memo, and Drop-Down are test information options that
you can apply to the test types.

7. In the Number of Instances field, type the number of times the field will
be presented to the user when running the test.

8. In the Maximum Number of Instances field, type the maximum number
of times the field can be entered when running a test. 

If the value in Maximum Number of Instances is greater than the value
in Number of Instances, the user will have the option of adding
additional instances up to the maximum value.

9. If you only want the field to be used in follow-up test records, select the
Only for Follow-Up Test check box. 

For example, you can add a field whose type is Memo with the Only for
Follow-Up Test check box selected. This way, the inspector could type the
corrective action that was required to fix the problem in the field.

10. Click the different field type tabs in the middle of the dialog box to modify
their settings:

a. On the Boolean tab, select if entering information in the field will
indicate a failure or create a warning.

b. On the Numeric tab, select the minimum and maximum values that
may indicate a failure or create a warning, define the minimum and
maximum number of decimal places, define a prefix or a suffix for
the units of measure, and select if entering information in the field is
mandatory.

c. On the Date tab, select if entering information in the date field is
mandatory.

d. On the Text tab, select if entering information in the text field is
mandatory.

e. On the Memo tab, select if entering information in the memo field is
mandatory.

f. On the Drop-Down tab, select if the information is restricted to a list
of pre-defined options, if you want to use an existing data set as
available options, if the available options depend on another list, or if
entering information in the field is mandatory. 

You can also add new options for the list, or modify or delete the
available options.
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11. Click Save Field.

The field is added to the inspection test.

Repeat the process to create all necessary fields.

3. Modify, move, or delete fields

• In the Test Fields section of the Inspection Test Setup dialog box, do any
of the following according to your needs: 

To Do this
Modify an existing field 1. In the list, click the field that you want to

modify.

2. Click Properties.

3. In the Inspection Test Field Setup dialog box,
modify the field properties:

a. In the Field Name field, modify the field
name used in the test definition.

b. In the Title field, modify the title of the
field used in the New Inspection Test
Record dialog box.

c. In the field, type the text used in the
column header of the Test Records dialog
box.

d. In the Notes field, modify any additional
text or instructions regarding the field.

4. Click the arrow on the right side of Field Type
field and select a suitable option:

• Boolean and Numeric are test types that
require you to set pass and fail criteria
settings.

• Date, Text, Memo, and Drop-Down are
test information options that you can apply
to the test types.

5. Click the different tabs in the middle of the
dialog box, and adjust the settings according
to your needs.

6. Click Save Field.
Move a field up or down 1. In the list, click the field whose position you

want to change.

2. Click the Move Up and Move Down buttons to
change the location of the field.
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To Do this
Delete a field from the
test setup

Note that deleting a field from the test setup is
permanent and cannot be undone.

1. In the list, click the field that you want to
delete.

2. Click Delete.

3. In the confirmation dialog box, click Yes to
permanently delete the field from the test
setup.

4. Save the test and run a sample inspection test

When you have modified all necessary settings of the inspection test, save the
test and run a sample test by adding a test record. You can later delete the
sample test record.

1. Click Save Inspection Test.

2. In the Test Records dialog box, add a new test record by clicking Run
Test. 

For more information on adding a test record, see Add, modify, and
review inspection test records (page 749).

3. Ensure that the test works as intended. 

If the test does not work as intended, you can correct the errors by further
modifying the setup.

4. Click Save.

5. To delete the sample test, do the following:

a. Select the sample test in the list.

b. Click Test Record Details.

c. Click Delete.

d. In the confirmation dialog box, click Yes.

Review the inspection statuses of items
In the Inspection Status dialog box, you can view inspection records. If
necessary, you can also run inspection tests.

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Review --> Inspection Status . 

The Inspection Status dialog box opens, displaying a list of all main
members or accessories that have piece tracking enabled in the current
production control job. For main members, the Weight Each column
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includes the weight of accessories that do not have piece tracking
enabled.

If an item belongs to multiple sequences or lots, it will appear in the list
once for each sequence/lot combination.

On the right side of the Weight Each column, there are columns for each
category of inspection tests that have been run in the current job. The
numbers in the cells of these columns indicate the number of tests that
have been run. Follow-up tests count as one regardless of how many
times they have been run.

Items highlighted with red have critical failures for which no follow-up
tests have been run.

3. View the statuses of production control items. 

To find particular items, expand and click items in the navigation tree on
the left-hand pane. You will only see items that match your selections.

4. If necessary, do one of the following:

• To view all inspection test records, click the Inspection Test Records
button at the bottom of the dialog box.

• To add a new inspection test record, click Run Test.

For more information on inspection test records, see Add, modify, and
review inspection test records (page 749).

Create, modify, and delete job-specific shipping routes
Use the Shipping Route Maintenance dialog box to view and modify the
shipping routes used for load tracking in the current production control job.
You can also create new job-specific shipping routes or delete existing ones.
Shipping routes can be used to send items within a job to multiple shipping
destinations, including intermediate destinations, such as sending material to
an external galvanizer. Items that are returned from one destination can then
be shipped to another destination, if necessary.

Open the Shipping routes dialog box

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Review --> Shipping Routes .

The Shipping Route Maintenance dialog box opens, displaying all shipping
routes created for the current production control job.

Create a shipping route

1. Click New.
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2. In the Shipping Route dialog box, type a description for the new shipping
route. 

3. In the Join with Assembly Option list, select if and when the weight of an
accessory part is included in the shipping weight of the assembly. 

The options are:

• None: The weight of the accessory is not included in the shipping
weight of the assembly. If the Jobsite destination is in the shipping
route, select the None option.

• Join with assembly for first destination: The weight of the accessory
is joined to the shipping weight of the assembly for all of its
destinations except for the first one.

• Join with assembly for...: The weight of the accessory is included in
the shipping weight of the assembly for the destination that you select
in the Join with Assembly For list, and for any other destinations after
that one.

• Join with assembly after...: The weight of the accessory is included in
the shipping weight of the assembly for all destinations after the
destination you select in the Join With Assembly After list.

4. To adjust the destinations in the shipping route, do any of the following: 

To Do this
Add a new destination a. Click Add.

b. In the Destination Group field, do one of the
following:

• To create a new destination group, type a
description for it in the Destination Group
field.

• To modify an existing destination group,
click the arrow on the right side of the
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To Do this
Destination Group and select a
destination group.

Destination groups provide a list of available
destinations and are often best used by
containing all the similar destinations in a
single group. If shipping tickets are required
from a destination back to the shop, it is
recommended not to use the shop as an
additional group because that location is
already assigned a function, and using the
shop as a group may cause confusion.

Note that you cannot modify the firms in the
Jobsite destination group.

c. Modify the firms in the destination group
according to your needs:

• To add a firm, click Add Firm, select the
firm type and firm name, and click OK.

You can only select firms that are already
saved in the Address Book.

• To remove a firm from the destination,
click the firm, click Remove Firm, and click
Yes to confirm deleting the firm.

• To set a firm as the primary firm, click the
firm, and click Set Firm as Primary.

The primary firm will have the remaining
totals reported against it in production
statuses, production control reports, and
project summary reports. However, parts
assigned to the shipping route can be
shipped for any of the firms that you have
added.

d. Click Save Destination.
Modify a destination a. In the Destination list, click the destination

that you want to modify.

b. Click Properties.

c. Modify the firms of the destination according
to your needs.

d. Click Save Destination to update the
destination.

Remove a destination
from the shipping route

a. In the Destination list, click the destination
that you want to remove from the shipping
route.
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To Do this
b. Click Delete.

c. In the confirmation dialog box, click Yes to
remove the destination from the shipping
route.

Note that the shipping route can have any number of destinations, or no
destinations at all. If the Jobsite destination is present, it is always the last
destination on the shipping route. The Jobsite destination is the Ship To
address defined for each production control job in the Production
Control Job Edit dialog box.

5. To change the order of destinations in the shipping route, do the
following:

a. Click the destination that you want to move to an earlier or later
position on the shipping route.

b. Click the Move Up and Move Down buttons according to your needs.

Repeat steps a to b for all destinations that you want to move.

6. Click Save Route.

The shipping route is now available in the current production control job.

Copy a shipping route

Use the Copy command to create a new shipping route based on an existing
one.

1. In the list, select the shipping route that you want to use as the basis of a
new shipping route.

2. Click Copy.

3. In the Shipping Route dialog box, type a description for the new shipping
route.

4. Modify the shipping route properties according to your needs.

5. Click Save Route to create the new shipping route.

Modify a shipping route

1. In the list, select the shipping route whose properties you want to modify.

2. Click Properties. 
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3. In the Shipping Route dialog box, modify the shipping route properties
according to your needs.

4. Click Save Route to save the changes.

Delete a shipping route

Note that deleting a shipping route is permanent and cannot be undone.

Job-specific shipping routes cannot be deleted if any parts are assigned to
them.

1. In the list, select the shipping route that you want to delete.

2. Click Delete.

3. In the confirmation dialog box, click Yes to permanently delete the
shipping route.

View and adjust TFS details
Performing the TFS (take from stock) process tells Tekla EPM that materials
have been cut. Use the TFS Details dialog box to view TFS reports, save heat
documents attached to items, and reverse the TFS status of an item or a group
of items.

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Review --> TFS Details .

3. To only view the TFS details of particular items, the TFS Filters dialog box,
select a filter type in the Type list, and click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

a. Click the arrow buttons to move the values that you want to view to
the Included list.

b. Enter the maximum and minimum values for items whose TFS details
you want to view.

5. Click OK.
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6. Click Details. 

The TFS Details dialog box opens, displaying all heat documents attached
to the current job.

When heat documents are attached, the number of the documents is
displayed in the Docs column.

The items in the Docs column that are highlighted with red have no heat
documents attached.

7. In the TFS Details dialog box, do any of the following: 

To Do this
Update the information
in the TFS Details dialog
box

• Click Refresh.

View and attach
documents to items

• Click Open Document Index.

For more information on working in Document
Index, see Store document references for a
production control job (page 733).

Save attached
documents into a folder

a. Do one of the following:

• To save all documents attached to items in
the TFS Details dialog box, click Save
Documents --> Save Documents - All .

• To save the documents attached to
particular items, click the items for which
you want to create reports, and click Save
Documents --> Save Documents -
Selected .

b. Browse to and select the folder where you
want to save the documents, or click Make
New Folder to create a new one.

c. Click OK.

The attached documents are saved into the
selected folder.

Print attached
documents

a. Do one of the following:

• To print all documents attached to items in
the TFS Details details dialog box, click
Print Documents --> Print Documents -
All .

• To print documents attached to particular
items, click the items whose attached
documents you want to print, and click
Print Documents --> Print Documents -
Selected .
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To Do this
• In the Select Printer dialog box, click a

printer to select it.

• Click OK.
Create TFS reports a. Do one of the following:

• To create reports for all items in the TFS
Details dialog box, click Reports -->
Reports - All .

• To create a report for particular items, click
the items for which you want to create
reports, and click Reports --> Reports -
Selected .

b. In the Report Selection dialog box, click the
report that you want to view, print, or export.

c. Do one of the following:

• To view the report, click View.

You can use the Email Excel and Email
PDF buttons at the top of the Tekla EPM
Report Viewer window to email the report
via Microsoft Outlook.

• To print the report, click Print, click a
printer to select it, and click OK.

• To export the report, click Export, modify
the export properties, and click Export.

Reverse the TFS process Reversing the TFS process returns the selected
materials from inventory history to inventory. Note
that the materials will be returned as cut lengths,
not the original stock lengths.

a. Click the materials whose TFS process you
want to reverse.

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold
down Shift.

b. In the first confirmation dialog box, click Yes
to remove any record of the TFS process from
the selected materials.

c. In the second confirmation dialog box, click
Yes to return the selected materials in
inventory history as cut lengths.

d. Type the number of materials to be returned
to inventory.

Manage the fabrication process 765 View production control job details



To Do this
e. Click Reverse.

The materials are returned to inventory and
removed from the TFS Details dialog box.

8. To close the dialog box, click the Close button (X) in the upper-right
corner.

Compare the materials in a production control job and a combining
job
Use the Compare to Combining Job command to view if there are differences
between the production control job materials and a pre-purchased material
list in the Combining module.

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Review --> Compare to Combining Job .

3. In the Select Combining Job dialog box, double-click the combining job
that you want to use in the comparison. 

The Compare to Combining Job opens, displaying the similarities and
differences between the production control job and the combining job.

Matching items in the production control job and the combining job are
highlighted with green.

Items that do not match in the combining job and the production control
job are highlighted with red.

4. Review the comparison results. 

To only view particular items, modify the values at the top of the dialog
box and click Process to update the displayed items.

5. To view the comparison results as a report, click View Report. 

The comparison report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the
Tekla EPM Report Viewer window to email the report via Microsoft
Outlook.

See also

Compare the labor hours in a production control job and an estimating job
(page 766)
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Compare the labor hours in a production control job and an estimating
job
Use the Compare to Estimating Job command to view if there are differences
in the labor hours recorded in the current production control job and the
labor hours listed in an estimating job.

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Review --> Compare to Estimating Job .

3. In the Select Estimating Job dialog box, double-click the estimating job
that you want to use in the comparison. 

The Compare to Estimate dialog box opens, displaying the labor hours.

The labor hours of the estimate are displayed on the left sorted by labor
group.

The labor hours of the production control job are displayed on the right
sorted by production control station.

The totals appear at the bottom of the dialog box.

4. Review the comparison results.

5. To view the comparison results as a report, click View Report. 

The comparison report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the
Tekla EPM Report Viewer window to email the report via Microsoft
Outlook.

View the production schedule
Use the Production Schedule dialog box to view the projected hours for jobs
by week. The hours are loaded from the project schedule.

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Production Schedule.

3. In the Production Schedule Filters dialog box, filter the production
schedule information according to your needs:

a. Click the arrows on the right side of the Start and End fields, and
select suitable start and end dates in the calendars. 

The default time between the start and end dates is three months.

b. Click the arrow on the right side of the Scale field, and in the list,
select if you want to view the information by day, week, or month.
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c. To only include particular resources in the production schedule, click
Resource, and click the arrow buttons to move the resources that
you want to include to the Included list.

d. To only include particular jobs in the production schedule, click Job #,
click the arrow buttons to move the jobs that you want to include to
the Included list.

4. Click Apply Filter. 

The Production Schedule dialog box opens.

• On the left side, you can see the resources and any tasks assigned to
them. For each task assigned to a resource, the production schedule
shows the regular and overtime hours, the percentage completed, and
start and end dates. This information consists of the schedule task in
the project schedule and the production status information. To update
the information, click Update Status in the Project Schedule dialog
box.

• In the middle, you can view the default capacities of the resources and
the time for those resources by tasks. The default capacity for each
resource is displayed at the top in bold. Any hours highlighted with red
indicate that the station is over capacity. If necessary, you can modify
the resource capacity in the Resource Maintenance dialog box.

Below the resource, you can see the released and unreleased hours of
each task, and the regular and overtime hours. This information
reflects the information in the Resource Maintenance dialog box. To
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update the information, click Update Status in the Project Schedule
dialog box.

• On the right side, the sections represent a block of time by the scale
that you selected in step 3. The columns on the top display the
capacity, the hours planned against the resource, the percentage of
the capacity that is planned, and the actual hours used.

5. If necessary, do any of the following: 

To Do this
Change the filters or
scale of the production
schedule

Do either of the following:

• To change the filters that you set in step 3, click
the Set Filters button and modify the filters
according to your needs. Then, click Apply
Filter.

• Click  on the right side of the Resource / Task
column. Then, select the resources and tasks
that you want to see in the production
schedule, or type the resource or the task that
you want to see in the Filter For field.

View more or fewer
details about a resource
or a task

• On the left side of the dialog box, click + or - on
the left side of a resource or task.

When you click +, the task or the resource expands,
so that you can see the task or resource details by
the set project breakdown categories.

When you click -, the task or the resource collapses
and the details are hidden.

Collapse or expand all
tasks

a. Right-click anywhere in the production
schedule.

b. In the context menu, select Collapse All or
Expand All.

Modify a task a. Double-click a task at the lowest level of the
hierarchy.

b. In the Task Schedule dialog box, do any of the
following:

• To change the start or end date of the task,
click Set on the right side of the start or
end date, select a new date in the calendar,
and click OK.

• To move a task forward or backward in the
production schedule, click Move, select an
option in the menu, and click Yes to
confirm the changes.
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To Do this
• To modify the equally divided working

hours, click Manually Schedule, type the
number of manually scheduled hours, and
click OK.

Print the current
production schedule

a. Right-click anywhere in the production
schedule.

b. In the context menu, select Report.

The production schedule opens in the Print
Preview dialog box.

c. Adjust the printing settings according to your
needs, and click Print.

See also

Modify resource capacity (page 770)

Modify resource capacity
In the Resource Maintenance dialog box, you create, modify, and delete
resources used in the production schedule and the project schedule. You can
view and modify the applicable working hours per day, week, or month.

Open the Resource Maintenance dialog box

1. In the Production Schedule dialog box, click the Production Schedule
ribbon tab.

2. On the menu, select Resource Maintenance.

Add a resource

You can add resources in a variety of ways. It may be useful to have one
resource for the shop, or one for each of the several bays or shop sites.
Another task, like detailing, can have its own resource as well.

The capacity for each resource is entered by day and summarized by week or
by month.

When a task in the project schedule is assigned to a resource, the resource is
added to the production schedule with the same start and end dates. Planned
hours for the task are then distributed equally among the days in that
duration. You can change the distribution and allocation of the planned hours
manually.

1. Click New.

2. Type a description for the resource.

3. Click the arrow on the right side of the Calendar field and select a suitable
schedule calendar in the list.
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4. In the Default Capacity field, type the number of hours available to this
resource during a standard working day.

5. Click the arrow on the right side of Fixed Date field and select the date
after which adjustments to the schedule no longer affect the new
resource. 

For example, if the fixed date is set to Friday, any adjustments to the
schedule on the next Thursday will not affect it.

6. Click Add.

Modify a resource

1. In the list, select the resource that you want to modify.

2. Modify the description, calendar, default capacity, and fixed date
according to your needs.

3. In the Resource Utilization section, filter which capacity and utilization
information is displayed:

a. To modify the time range, click the arrows on the right side of the
start and end dates and select suitable dates.

b. Click the arrow on the right side of Scale field, and select if you want
to view the capacity and utilization information by day, week, or
month. When the scale is set to by week or month, the date displayed
for each record is by default the beginning date of each period. This
settings can be changed in Project Company Standards.

c. To update the view, click Reload.

d. If you want to open the production schedule for the selected
resource, click View.

4. To adjust the capacity of a date period, do the following:

a. In the Resource Utilization section, double-click a date.

b. In the Resource Capacity dialog box, select a date period. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

c. Type a new value in the Capacity field. 

If necessary, you can restore the default hours by clicking the Default
button.

d. To update the capacity of all selected date periods, click Update
Selected.

e. To close the dialog box, click the Close button (X) in the upper-right
corner.

5. In the Resource Maintenance dialog box, click Save to save the changes.
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Delete a resource

Deleting a resource is permanent and cannot be undone.

1. In the list, select the resource that you want to delete.

2. Click Delete.

3. In the confirmation dialog box, click Yes to permanently delete the
resource.

View, print, and export job-specific production control
reports
You can create various reports based on the information of the current
production control job, including cut lists, bills of materials, and master load
lists. Then, you can either view the report in Tekla EPM Report Viewer and
email it, print the report, or export the report to another file format.

Note that before creating a cut list, the materials need to be loaded into a
purchase order.

Create a report
1. In the Production Control dialog box, click the Production Control

ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. To only include specific types of items in the report, in the Production
Control Report Filters dialog box, select a filter type in the Type list, and
click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the items that you want to include in
the report to the Included list.

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

• Type the maximum and minimum values for the items that you want
to include in the report.

5. Click OK. 

To further limit the items included in the report, repeat steps 3 to 5 for all
necessary filter types.

6. To include the full assemblies of all included parts in the report, select the
Include Full Assembly of Filtered Parts check box.
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7. Click the arrow on the right side of Weight Type field, and select the
weight type that you want to use in the report. 

Note that the Weight Type list is only visible if you have selected it on the
Report Settings tab of the Company Standards dialog box.

8. Click Make Report.

9. In the Report Selection dialog box, click the report that you want to view,
print, or export.

View the report
• In the Report Selection dialog box, click View.

The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
EPM Report Viewer window to email the report via Microsoft Outlook.

Print the report
1. In the Report Selection dialog box, change the number of the printed

copies by clicking the + and - buttons.

2. Click Print.

3. In the confirmation dialog box, click Yes.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK to print the report.

6. To close the dialog box, click the Close button (X) in the upper-right
corner.

Export the report
1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Modify the file name according to your needs.

5. Browse to the location where you want to save the exported file, and click
Save.

6. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email check box.

7. To open the file after exporting it, select the Open Exported Document
check box.
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8. In the Report Selection dialog box, click Export. 

The report is saved in the selected export format.

9. To close the dialog box, click the Close button (X) in the upper-right
corner.

Import, view, or delete CNC files
In the CNC Files dialog box, you can import CNC files to Tekla EPM, and view
or delete the previously loaded CNC files that are associated with the current
production control job.

To access the CNC Files dialog box, do the following:

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select CNC Files.

The CNC Files dialog box opens.

Note that:

• By default, only the latest versions of all CNC files are shown. If you want to
show all versions of CNC files, clear the Latest Only check box in the
upper-left corner.

• You can use the navigation tree on the left side of the dialog box to only
show particular CNC files. Click + on the left side of any category to expand
the category and select a sub-category, or expand the sub-category to
further limit which files are shown. Only files that match the selected value
are shown.
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Import CNC files
1. At the bottom of the dialog box, click Load CNC Files.

2. In the Import dialog box, click ... to set the folder from which CNC files are
imported.

3. Browse to and select the folder.

4. Click OK.

5. Type the file extension used for CNC files in the selected folder.

6. Click OK to import the CNC files.

7. In the Enter Value dialog box, type a name for the group of CNC files, and
click OK. 

Tekla EPM imports all CNC files from the folder that you selected.

8. Review the import results and click Close.

View CNC files
1. Select the CNC files that you want to view in the list. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. At the bottom of the dialog box, click View Selected Files.

Note that Windows may ask you to select the application with which you want
to open the CNC files.

Save CNC files to another location
To save CNC files from Tekla EPM to your computer or a shared drive:

1. Do any of the following: 

• To select which CNC files you want to save, select the files and click
Save Selected Files.

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

• To save all files currently shown in the CNC Files dialog box, click Save
Displayed Files.

2. In the Browse for Folder dialog box, browse to and select the folder
where you want to save the files.
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3. Click OK.

The CNC files are saved in the selected folder.

Delete CNC files
Deleting a group of CNC files from Tekla EPM is permanent and cannot be
undone. Note that all files imported from the same folder are deleted at once.

1. Select any CNC file that belongs to the group that you want to delete.

2. At the bottom of the dialog box, click Delete Group.

3. In the confirmation dialog box, click Yes to permanently delete the
selected CNC files.

9.4 Manage production control items
You can manage production control items in many ways. add new production
control items, modify existing production control items, copy material items
from one drawing to another, take production control items from stock,
combine items, or send items to a purchase order or a requisition.

For more information, see the following links:

Add a production control item (page 776)

Modify production control items (page 782)

Copy materials from one drawing to another (page 787)

Take production control items from stock (page 796)

Combine materials in the Production Control module (page 788)

Send production control items to purchasing (page 789)

Add a production control item
To add an item to a production control job, do the following:

1. At the bottom of the Production Control dialog box, click New.

2. Define the item properties. 

NOTE The input fields and their order depend on the settings that you
have made in Production Control Maintenance.
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The properties marked with an asterisk (*) in the following table are
mandatory information.

Option Description
Main Mark * The main mark of the item.

The main mark is the number of the
main member to which accessory
items can be attached.

If an item has an identical main mark
and piece marks, Tekla EPM considers
the item a main member.

Either click the arrow on the right side
of the Main Mark field and select an
existing main mark in the list, or type
the name of the new main mark in
the field. You can enter a maximum
of 25 characters, depending on the
Mark Input Type option that you
have selected in the Company
Standards dialog box.

Piece Mark * The piece mark of the item.

Piece marks are used for the
accessory items that are attached to a
main member.

Type the name of the piece mark in
the Piece Mark field. You can enter a
maximum of 25 characters,
depending on the Mark Input Type
option that you have selected in the
Company Standards dialog box.

Approval Status The approval status of the item.

The available approval statuses are
set in the Approval Status dialog box
that you can access via Maintenance
--> Production Control --> Approval
Status Maintenance -

Click the arrow on the right side of
the Approval Status field, and select
an approval status in the list.

Drawing Number A property that is used as the drawing
number and the drawing name. You
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Option Description
can use the main mark as the drawing
number.

Either click the arrow on the right side
of the Drawing Number field and
select an existing drawing number in
the list, or type a new drawing
number in the field.

Quantity * The number of pieces to be added.

Type the number of pieces in the
Quantity field.

Shape * The material shape of each piece.
Dimensions * The material dimension, or material

size, of each piece.

Click the Dimensions field to select
an available material dimension, and
double-click the desired dimension in
the list.

TIP You can also use a custom
material dimension. Note that
the dimension is not
automatically added to the
material database.

To use a custom dimension, do
the following:

a. Click in the Dimensions
field.

b. Click Add Size.

c. Define the dimension
properties.

d. Click Save.

You can now select the
dimension and use it.

Grade * The material grade of each piece.

The default grade of the selected
shape is set in the Shape / Grade /
Size Maintenance dialog box.

Click the arrow on the right side of
the Grade field and select a material
grade in the list.
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Option Description
Length The length of each piece.

Type the length in the Length fields.
Finish The finish type of the item. The

default options are Painted,
Unpainted, and Galvanized.

Click the arrow on the right side of
the Finish field and select a material
finish in the list.

Route The item route defines the stations
that the item goes through in the
fabrication process.

The available route options are set in
the Routes dialog box.

Click the arrow on the right side of
the Route field and select a route in
the list.

Remark Any comments that you want to add
about the item.

Type any comments in the Remark
field.

Category, Sub-Category A class used for sorting items in a
production control job. You can filter
the information in the Production
Control dialog box by category or
sub-category. For example, you can
create categories based on the shop
where the item is created.

The available categories and sub-
categories are set in the Company
Categories and Company Sub-
Categories dialog boxes.

Click the arrow on the right side of
the Category or Sub-Category field
and select an existing category, or
type a new category in the field.

Pay Category The pay category assigned to the
item. Pay categories can be used to
assign unit costs to fabricated items
per pound.

The available pay categories are set in
the Pay Categories dialog box that

Manage the fabrication process 779 Manage production control items



Option Description
you can access via the Company
Standards dialog box.

Piece Tracking When selected, an accessory piece
within an item can be tracked by
piece mark. Main marks, or
assemblies, are tracked by default.

For more information on piece
tracking, see Track production by
piece mark (page 805).

Shipping Route The shipping route assigned to the
item.

Shipping routes can be used to send
items within a job to multiple
shipping destinations, including
intermediate destinations, such as
sending material to an external
galvanizer. The available shipping
routes are set in Shipping Route
Maintenance. For more information,
see Create, modify, and delete global
shipping routes (page 704).

Click the arrow on the right side of
the Shipping Route field and select a
shipping route in the list.

Load Tracking When selected, an accessory item can
be tracked by load and are viewed in
shipping reports. Main marks, or
assemblies, are tracked by default.

For more information on load
tracking, see Create, modify, and
delete loads (page 800).

Prod. Code The production code applied to the
item.

Production codes group items so that
you can apply man hour per ton and
per labor group percentages to items
in the linked production control job.

The production code can be used to
color-code or filter items in Trimble
Connect. For more information, see
Use Trimble Connect with an
estimating job (page 435).
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Option Description
Production codes group similar items
together within jobs.

Click the arrow on the right side of
the Prod. Code field and select a
production code in the list.

Instance Tr When selected, instance tracking can
be used for the item. This allows you
to see more details about the item.

Selecting the Instance Tr check box
may be useful in, for example, nuclear
jobs.

Reference Number A reference number that links items
in inventory or purchasing to the
production control job.

The reference number can be
different depending on the case:

• If an item is sent from Production
Control to Purchasing or
Inventory, Tekla EPM creates a
copy of the record, and the item is
linked to include the reference
number.

• If an item is sent to purchasing
from an advanced bill of material,
the system mark number or a
combination of the page number
and the item number in the
combining job (for example, 1-30)
becomes the reference number.

• If the item is sent to purchasing
later in the process, the reference
number is the mark or piece mark
number.

However, if the reference number
has been assigned in the
production control job, that
reference number is maintained in
the inventory as well.

Type the reference number in the
Reference Number field. You can
enter a maximum of 255 characters.
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3. Click Add.

The new item is added to the list in the Production Control dialog box.

See also

Modify production control items (page 782)

Modify production control items
You can modify the properties of production control items either one by one
or as a group.

For more information, see the following links:

Modify a single production control item (page 782)

Modify multiple production control items (page 782)

Modify the selected production control items (page 783)

Adjust sequences (page 784)

Modify a single production control item
You can modify a single production control item directly in the Production
Control dialog box.

1. In the Production Control dialog box, select the item that you want to
modify.

2. On the right side of the dialog box, modify the item properties. 

For example, change the quantity, enable load tracking, or select a new
shipping route. For more information on the available properties, see Add
a production control item (page 776).

3. Click Edit to save the changes.

See also

Modify multiple production control items (page 782)

Modify the selected production control items (page 783)

Adjust sequences (page 784)

Modify multiple production control items
Use the Global Edit command to modify the properties of multiple production
control items at one go.

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Modify Data --> Global Edit .
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3. To only update the properties of particular items, in the Production
Control Global Edit Filters dialog box, set filters:

a. Select a filter type in the Type

b. In the Filter dialog box, do one of the following depending on the
filter type: 

• Click the arrow buttons to move the items that you want to modify
to the Included list.

Type the maximum and minimum values for the items that you
want to modify.

c. Click OK. 

Repeat substeps to set all necessary filers.

4. At the bottom of the Production Control Global Edit Filters dialog box,
click OK.

5. In the Global Edit dialog box, select check boxes next to the properties
that you want to update. 

You can also use the Un-check All and Check Changed Fields buttons to
quickly clear or select check boxes.

6. Modify the selected properties in the Global Edit dialog box according to
your needs. 

For example, you can change the category of the items by selecting an
option in the Category list, or type a comment for the items.

7. Click Update to update the selected properties of the filtered production
control items.

See also

Modify the selected production control items (page 783)

Modify the selected production control items
Use the Global Edit Selected command to modify the properties of the
selected production control items.

1. In the Production Control dialog box, click the items that you want to
modify to select them. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Production Control ribbon tab.

3. On the menu, select Modify Data --> Global Edit Selected .
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4. In the Global Edit dialog box, select check boxes next to the properties
that you want to update. 

You can also use the Un-check All and Check Changed Fields buttons to
quickly clear or select check boxes.

5. Modify the selected properties in the Global Edit dialog box according to
your needs. 

For example, you can change the category of the items by selecting an
option in the Category list, or type a comment for the items.

6. Click Update to update the properties of the selected production control
items.

See also

Modify multiple production control items (page 782)

Adjust sequences
Using sequences and lots is a useful way to group, control, filter, and report on
items. Sequences and lots are also the most commonly used breakdown items
in project schedules. In Production Control, you can add items to different
sequences, and modify or update the sequences of items. You can also filter
the information in the Production Control dialog box by sequence.

For more information, see the following links:

Set and update sequences (page 784)

Manage sequences (page 785)

Remove all items from a sequence (page 786)

Add multiple items to a sequence (page 786)

Remove multiple items from sequences (page 787)

Set and update sequences
Use the Set Sequences command to set and update the sequences of main
mark items in a production control job. Note that you should set sequences
before combining materials for purchase.

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Modify Data --> Set Sequences .

3. In the Set Sequences dialog box, click the arrow buttons to move the
items that you want to add to the same sequence to the right side of the
dialog box.

4. If you only want to add a specific number of pieces to the sequence, select
the item on the right side of the dialog box and type a new value in the
Quantity to Update field.
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5. Select the Update Sequence check box and type the new sequence
number in the New Sequence field.

6. If you want to update the lot number as well, select the Update Lot #
check box and type the new lot number in the New Lot # field.

7. Click Update Sequences.

8. In the confirmation dialog box, click Yes to confirm setting the sequences. 

The sequences are set.

Repeat steps 3 to 8 for all items whose sequences you want to set.

9. To close the dialog box, click the Close button (X) in the upper-right
corner.

Manage sequences
You can add individual material items to a sequence, or remove some or all
pieces of a material from a sequence.

1. In the Production Control dialog box, select the main member item
whose sequences you want to modify.

2. In the lower-right corner of the dialog box, click Edit Sequences.

3. In the Sequences dialog box, do one of the following according to your
needs: 

To Do this
Add the item to a sequence a. In the Sequence Items section of

the dialog box, do one of the
following:

• To add the item to an existing
sequence, click the arrow on
the right side of the Sequence
field and select a sequence in
the list.

• To add the item to a new
sequence, type the number of
the new sequence in
Sequence field.

b. In the Quantity field, type the
number of pieces that you want
to add to the sequence.

c. Click Sequence.
Remove the item from a sequence a. In the Unsequence Items

section of the dialog box, type
the number of pieces to remove
from the sequence in the
Quantity field.
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To Do this
b. Click Unsequence.

c. In the confirmation dialog box,
click Yes to remove the pieces
from the sequence.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Remove all items from a sequence
Use the Unsequence All command to remove all pieces of a material item
from a sequence.

1. In the Production Control dialog box, select an item that has been
assigned to the sequence.

2. At the lower-right corner of the dialog box, click Edit Sequences.

3. In the Sequences dialog box, click Unsequence All.

4. In the confirmation dialog box, click Yes to remove all the sequenced
items from the sequence.

See also

Remove multiple items from sequences (page 787)

Add multiple items to a sequence
Use the Sequence All Selected to add mulitple selected production control
items to a sequence. Note that you can only use the Sequence All Selected
command if the items have not yet been added to another sequence.

1. In the Production Control dialog box, select the items that you want to
add to a sequence.

2. Click the Production Control ribbon tab.

3. On the File menu, select Modify Data --> Sequence All Selected .

4. In the Sequence All dialog box, do one of the following:

• To add the items to an existing sequence, click the arrow on the right
side of the Sequence field, and select a sequence in the list.

• To add the items to a new sequence, type a new sequence number in
the Sequence field.

5. Click Sequence All.

The items are added to the selected sequence.
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See also

Remove all items from a sequence (page 786)

Remove multiple items from sequences (page 787)

Remove multiple items from sequences
Use the Unsequence All Selected command to quickly remove the selected
production control items from sequences. Once the items have been removed
from the original sequences, you can add them to new sequences according to
your needs.

1. In the Production Control dialog box, select the items that you want to
remove from sequences. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Production Control ribbon tab.

3. On the menu, select Modify Data --> Unsequence All Selected .

4. In the confirmation dialog box, click Yes to unsequence the selected
items.

See also

Set and update sequences (page 784)

Remove all items from a sequence (page 786)

Copy materials from one drawing to another
Use the Copy Drawing command to copy materials from one drawing into
another drawing.

1. In the Production Control dialog box, click the item whose drawing you
want to copy.

2. Click the Production Control ribbon tab.

3. On the menu, select Modify Data --> Copy Drawing .

4. In the Copy Drawing dialog box, type a number for the new drawing.

5. Click OK.

6. Review the new mark numbers and change them according to your needs:

a. In the list, select the mark that you want to change.

b. Type a new mark number. 

Repeat steps a to b for all mark numbers that you want to adjust.
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7. Click Copy.

The Copy Drawing dialog box closes. The items in the original drawing are
copied to the new drawing.

Combine materials in the Production Control module
Use the Combine command to mult and nest materials in the Production
Control dialog box. You can then save and review the combining results.

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Combine. 

The Select Combining Run dialog box opens. When you are performing
the first combining run for a combining job, the list in the dialog box is
empty.

3. Click a desired combining option to select it. 

The options are:

• Mult: combines linear items, like beams and angles.

• Nest: combines items that have area, like plates or gratings.

• Mult & Nest: combines all items.

The Combining Run Filters dialog box opens.

NOTE Filtering items is optional, so you can skip steps 4 to 7 if you do
not want to filter out items from the combining run.

4. To only combine specific types of items, select a filter type in the Type list,
and click Select.

5. In the Filter dialog box, do one of the following depending on the filter
type:

a. Click the arrow buttons to move the items that you want to combine
to the Included list.

b. Type the maximum and minimum values for the items that you want
to combine.

6. Click OK. 

Repeat steps 4 to 5 for each filter type that you want to set.

7. To ensure that you are using the correct settings, click the Optimizations,
INV Filter, and Suppliers buttons. 

If necessary, you can modify the settings.

8. To be able to save the results of the combining run, ensure that the Use
PDC/PO Links check box is selected.
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9. To combine the materials, click the button at the bottom of the
Combining Run Filters dialog box, or press F4.

• Piece mark items included with the selected stock lengths are displayed at
the lower-left section of the dialog box.

• Combining results are shown in both the display area and in the summary
grid at the lower-right section of the dialog box.

• The material cost represents the pricing of the materials in the pricing
database that was used in the combining run.

TIP You can save the combining run results in multiple ways:

• To save the entire combining run for comparing it with another one,
click Save Combining Run at the bottom of the Combining Run
Results dialog box.

• To save particular results, use the navigation tree on the left to only
view necessary results,and click Save Displayed Results & Close at
the bottom of the Combining Run Results dialog box.

• To save selected results, click the results that you want to save and
click the Combining Run ribbon tab. Then, select Save Selected
Results,

See also

Rename a combining run (page 253)

Compare combining runs (page 261)

View combining run filter settings (page 253)

Modify run-specific pricing information (page 254)

Recombine all items (page 258)

Recombine items of a shape (page 258)

Recombine items of a material grade (page 259)

Recombine a material dimension (page 260)

Update combining information and recombine all items (page 260)

Export materials for combining (page 78)

Send production control items to purchasing
Use the Purchasing commands to send production control items to the
Purchasing module. You can send material items into requisitions or
purchase orders, link materials to requisitions or purchase orders, take
materials from stock in order to charge them to a job, create reports, and
finalize the production control job.

Manage the fabrication process 789 Manage production control items



For more information, see the following links:

Load all production control items into a requisition (page 791)

Load all production control items into a purchase order (page 790)

Load the selected production control items into a requisition (page 792)

Load the selected production control items into a purchase order (page 792)

Link materials in Production Control to Purchasing (page 793)

Unlink materials between Production Control and Purchasing (page 794)

Verify material links between Production Control and Purchasing (page 794)

Check purchase orders for received materials (page 795)

Take production control items from stock (page 796)

Finalize a production control job (page 821)

Load all production control items into a purchase order
Use the Load Material Into Purchase Order command to load all materials in
a production control job into a purchase order.

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Purchasing --> Load Material Into Purchase
Order .

3. In the Select Purchase Order dialog box, select a purchase order and
click OK. 

If necessary, you can also create a new purchase order and load the items
into it.

4. In the Purchasing Import Filters, do one of the following: 

To Do this
Load all items • Click Import.
Filter out items
that you do
not want to
load

a. On the left side of the dialog box, select a filter type in
the Type list, and click Select.

b. Click Select.

c. Click the arrow buttons to move the items that you want
to load to the requisition to the Included list.

The items on the Not Included side will not be sent to
purchasing.

d. Repeat the process for different filter types until you
have filtered out all unnecessary items.

e. Click Import.
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5. Click OK to close the Import Items dialog box. the Production Control
dialog box.

Materials are loaded into the selected purchase order. To view and use the
purchase order, go to the Purchasing module and open the Purchase Orders
tab.

See also

Load the selected production control items into a purchase order (page 792)

Load all production control items into a requisition
Use the Load Material Into Requisition command to load all material items
in a production control job into a requisition.

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Purchasing --> Load Material Into Requisition .

3. In the Select Requisition dialog box, select a requisition and click OK. 

If necessary, you can also create a new requisition and load the items into
it.

4. In the Purchasing Import Filters, do one of the following: 

To Do this
Load all items • Click Import.
Filter out items
that you do
not want to
load

a. On the left side of the dialog box, select a filter type in
the Type list, and click Select.

b. Click Select.

c. Click the arrow buttons to move the items that you want
to load to the requisition to the Included list.

The items on the Not Included side will not be sent to
purchasing.

d. Repeat the process for different filter types until you
have filtered out all unnecessary items.

e. Click Import.

5. Click OK to close the Import Items dialog box. the Production Control
dialog box.

Materials are sent to the selected requisition. To view and use the requisition,
open the Purchasing module and go to the Requisitions tab.

See also

Load the selected production control items into a requisition (page 792)
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Load the selected production control items into a purchase order
Use the Load Selected Material Into Purchase Order command to select the
material items in a production control job that you want to load into a
purchase order.

1. In the Production Control dialog box, select the items that you want to
load. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. On the menu, select Purchasing --> Load Selected Material Into
Purchase Order .

3. In the Select Purchase Order dialog box, select a purchase order and
click OK. 

If necessary, you can also create a new purchase order and load the items
into it.

4. Click OK to close the Import Items dialog box. the Production Control
dialog box.

Materials are loaded into the selected purchase order. To view and use the
purchase order, go to the Purchasing module and open the Purchase Orders
tab.

Load the selected production control items into a requisition
Use the Load Selected Material Into Requisition command to select the
materials in a production control job that you want to load into a requisition.

1. In the Production Control dialog box, select the items that you want to
load. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Production Control ribbon tab.

3. On the menu, select Purchasing --> Load Selected Material Into
Requisition .

4. In the Select Requisition dialog box, select a requisition and click OK. 

If necessary, you can also create a new requisition and load the items into
it.

5. If you only want to send the items in specific sequences or lots into the
requisition, in the Purchasing Import Filters dialog box, select a filter
type in the Type list, and click Select.
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6. In the Filter dialog box, click the arrow buttons to move the sequences
and lots whose items you want to load into the requisition to the
Included list.

7. Click OK to close the Import Items dialog box. the Production Control
dialog box.

Materials are sent to the selected requisition. To view and use the requisition,
open the Purchasing module and go to the Requisitions tab.

See also

Load all production control items into a requisition (page 791)

Link materials in Production Control to Purchasing
Use the Link Job command to link materials in Production Control to pre-
purchased advanced bill materials. Tekla EPM uses reference numbers to
match the materials across modules. Any unlinked materials, such as loose
pieces, will be loaded into a requisition or a purchase order to be purchased.

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Purchasing --> Link Job .

3. To limit which materials are linked, in the Link Filters dialog box, select a
filter type in the Type list, and click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

a. Click the arrow buttons to move the items whose heat documents
you want to view to the Included list.

b. Type the maximum and minimum values for the items whose heat
documents you want to view.

5. Click OK.

6. If necessary, select the If updating a cut list item, exclude from being
cut check box. 

By selecting the check box, you can ensure that Tekla EPM does not
invalidate the entire cut list when an item in the cut list is updated.
Updated items will be saved in the inventory to be processed later.

7. Click Link.

8. In the Link Items dialog box, click if you want to load material information
to a requisition or a purchase order.

9. Click the desired requisition or purchase order.

10. Click OK to load the materials.

11. Click OK to close the Link Items dialog box.
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See also

Unlink materials between Production Control and Purchasing (page 794)

Verify material links between Production Control and Purchasing (page 794)

Unlink materials between Production Control and Purchasing
Use the Un-Link Job command to unlink materials between Production
Control and Purchasing when you need to manually manage the materials.

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Purchasing --> Un-Link Job .

3. To only unlink specific types of materials, in the Un-Link Filters dialog
box, select a filter type in the Type list, and click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

a. Click the arrow buttons to move the items whose heat documents
you want to view to the Included list.

b. Type the maximum and minimum values for the items whose heat
documents you want to view.

5. Click OK.

6. Click Un-Link.

7. In the Un-Link Items dialog box, review the un-linking results.

8. Click OK to close the dialog box.

See also

Link materials in Production Control to Purchasing (page 793)

Verify material links between Production Control and Purchasing
Use the Verify Links command to verify that all material in Production
Control is currently linked to purchasing. Using the Verify Links command is
a quick way to verify that the material links between Production Control,
Requisitions, and Inventory are maintained. For example, using this
command can be useful when importing revised drawings.

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Purchasing --> Verify Links .

3. In the Verify Links dialog box, check that all material items are linked to
purchasing.

4. Click OK to close the dialog box.
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See also

Link materials in Production Control to Purchasing (page 793)

Unlink materials between Production Control and Purchasing (page 794)

Check purchase orders for received materials
Use the Check Material For TFS and Check Selected Material For TFS
commands to check purchase orders for received materials that will be used
for production control items.

Check purchase orders for all materials

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Purchasing --> TFS --> Check Material For TFS .

3. To only take specific materials from stock, in the TFS Filters dialog box,
select a filter type in the Type list, and click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the values that you want to take from
stock to the Included list.

• Type the maximum and minimum values for the items that you want
to take from stock.

5. Click OK.

6. Click TFS.

7. In the TFS dialog box, review the information and do any of the following:

• Click Close to close the dialog box.

• Click Reports and view or print TFS reports according to your needs.

For more information on viewing and printing reports, see View, print,
and export job-specific production control reports (page 772).

Check purchase orders for selected materials

1. In the Production Control dialog box, click the items whose availability
you want to check.

2. Click the Production Control ribbon tab.

3. On the menu, select Purchasing --> TFS --> Check Selected Material For
TFS .

4. In the TFS Filters dialog box, click TFS.

5. In the TFS dialog box, review the information and do one of the following:

• Click Close to close the dialog box.
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• Click Reports and view or print TFS reports according to your needs.

For more information on viewing and printing reports, see View, print,
and export job-specific production control reports (page 772).

Take production control items from stock
Use the TFS and TFS - Selected commands to take purchased material items
from the inventory and charge the purchased items to the current production
control job.

If you only want to take one item from stock, see Take a single cut list item
from stock (page 797).

Take all items from stock

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Purchasing --> TFS --> TFS .

3. To only take specific types of items from stock, in the TFS Filters dialog
box, select a filter type in the Type list, and click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the values that you want to take from
stock to the Included list.

• Type the maximum and minimum values for the items that you want
to take from stock.

5. Click OK.

6. Click TFS.

7. In the Enter Value dialog box, click the arrow on the right side of the field,
and select a date in the calendar.

8. Click OK to check which items are linked and which items are actually
available to be taken from stock.

9. To confirm taking all of the remaining items from stock, click Yes in the
confirmation dialog box.

10. In the TFS dialog box, review the information and do one of the following:

a. To close the dialog box, click Close.

b. To view or print TFS reports, click Reports. For more information on
viewing and printing reports, see View, print, and export job-specific
production control reports (page 772).
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Take the selected items from stock

Use the TFS - Selected command to only take selected items from stock in a
production control job. The purchased items will be taken from the inventory,
and the cost of the selected items will be charged to the current production
control job.

1. In the Production Control dialog box, click the items that you want to
take from stock to select them. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Production Control ribbon tab.

3. On the menu, select Purchasing --> TFS --> TFS - Selected .

4. To select the sequence and lot of the items that you want to take from
stock, in the TFS Filters dialog box, select a filter type in the Type list, and
click Select.

5. In the Filter dialog box, click the arrow buttons to move the sequences or
lots whose items you want to take from stock to the Included list.

6. Click OK.

7. In the TFS Filters dialog box, click TFS.

8. In the Enter Value dialog box, click the arrow on the right side of the field,
and select a date in the calendar.

9. Click OK to take the material from stock.

10. If you have selected multiple items, click Yes in the confirmation dialog
box to take the items from stock.

11. In the TFS dialog box, review the information and do one of the following:

a. To close the dialog box, click Close.

b. To view or print TFS reports, click Reports. For more information on
viewing and printing reports, see View, print, and export job-specific
production control reports (page 772).

Take a single cut list item from stock
Use the TFS Entry command to take a single cut list item from stock. Tekla
EPM will then process the cut list item and charge the purchased materials to
the job. Note that the necessary materials need to be received in the purchase
order before you can take them from stock.

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select TFS Entry.

3. To filter which items are shown:
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a. In the Production Control Purchasing Report Filters dialog box,
select a filter type in the Type list, and click Select.

b. In the Filter dialog box, click the arrow buttons to move the items
that you want to see to the Included list.

c. Click OK.

Repeat steps a to c to set all of the necessary filters.

4. Click Make Report.

5. In the TFS Entry, select the desired cut list in the Cut List Serial # list. 

Only the items on the selected cut list are shown in the list below.

Note that if any changes are made to the cut list, its serial number will no
longer be valid.

If you want to check the details of the selected cut list using reports, you
can click Reports in the upper-right corner.

6. In the list of items, select the item that you want to take from stock.

7. Click TFS.

8. In the Cut Lists dialog box, define the cut list properties and add drop
lengths according to your needs.

9. Click TFS to take the selected item from stock.

The item is removed from the inventory and charged to the current
production control job.

See also

Take production control items from stock (page 796)

View or print job-specific purchasing reports
You can create purchasing reports for a particular production control job.

Create job-specific purchasing report

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Purchasing --> Reports .

3. To limit the items that are included in the reports, in the Production
Control Purchasing Report Filters dialog box, select a filter type in the
Type list, and click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the values that you want to include in
the reports to the Included list.
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• Enter the maximum and minimum values for items that you want to
include in the reports.

5. Click OK. 

To further limit the items in the reports, repeat steps 5 to 7 for all
necessary filter types.

6. Click Make Report.

7. In the Report Progress dialog box, click the report that you want to view
or print.

View the purchasing report

• In the Report Selection dialog box, click View.

The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
EPM Report Viewer window to email the report via Microsoft Outlook.

Print the purchasing report

1. In the Report Selection dialog box, change the number of the printed
copies by clicking the + and - buttons.

2. Click Print.

3. In the Select Printer dialog box, click a printer to select it.

4. Click OK.

5. To close the dialog box, click the Close button (X) in the upper-right
corner.

Save a cut list

1. Click Save Cut List.

2. In the Job # list, select the job.

3. In the Cut List Description field, either enter a description directly in the
field, or click the arrow on the right side of the field to select an option in
the list.

4. Click the arrow on the right side of the Date Required field, and click a
date in the calendar to select it.

5. If you do not want anyone to make changes to the cut list, click the Lock
Cut List check box to select it.

6. Click Save To Cut List. 

Tekla EPM saves the cut list. You can use it in the selected production
control job and with Remote Link.

7. Click OK to close the Message dialog box.
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8. To close the dialog box, click the Close button (X) in the upper-right
corner.

9.5 Create, modify, and delete loads
In the Loads dialog box, you can create new truck loads for the current
production control job, assign materials to loads, and select shipping routes.
You can also modify and delete existing loads according to your needs.

Note that items and main marks can be shipped to multiple destinations.

To access the Loads dialog box, do the following:

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Load Tracking.

Add a new load
1. Click New Load.

2. On the Details tab of the Load Properties dialog box, modify the load
properties. 

NOTE The available field are set in the Load Tracking Settings dialog
box. There may be additional fields that are not listed in the

Manage the fabrication process 800 Create, modify, and delete loads



following table. For more information, see Define load tracking
settings (page 689).

Option Description
From The initial location of the load. The available

locations are set in Shipping Route Maintenance.

Click the arrow on the right side of From field and
select an option in the list.

Destination Group The available destinations for the load. The
available destinations are set in Shipping Route
Maintenance.

Click the arrow on the right side of Destination
Group field and select a destination in the list.

Load # The number of the load.

If necessary, type a new number in the Load #
field.

Trailer # The trailer number. The available trailers are set in
the Load Tracking Settings dialog box.

Click the arrow on the right side of Destination
Group field and select an option in the list, or type
the trailer number directly in the Trailer # field.

Carrier The carrier of the load. The available carriers are
set in the Load Tracking Settings dialog box.

Click the arrow on the right side of Carrier field
and select an option in the Carrier list, or type a
carrier name directly in the field.

Capacity The weight capacity.

Tekla EPM automatically adds the information
according to your other selections on the Details
tab.

3. On the Top Text tab, add top text to shipping tickets.

4. Click Save.

The load is added to the list in the Loads dialog box. Next, you need to add
materials to the load.

Pre-assign or add materials to a load
Note that only material that is available in the From location of the load and is
assigned to the next destination group can be added to a load.

Material items can also be pre-assigned to loads without actually loading the
items.
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1. In the list, click the load to which you want to add material.

2. Click Add Material.

3. In the Loads - Add Material dialog box, click the arrow buttons to move
the materials that you want to load to the Included list.

4. To only add some pieces of the item to the load, select a material in the
Included list and type the number of pieces to be loaded in the Qty field.

5. If necessary, modify the load number and loading date.

6. If you only want to pre-assign material items to the selected load and not
actually load the items, clear the Load on Assign check box in the lower-
left corner.

7. Click Add Material.

Ship a load
The loads that do not have a shipping date are highlighted in yellow in the
Loads dialog box. To ship a load, do the following:

1. In the list, click the load that you want to ship.

2. Click Load Properties.

3. Click Ship. 

If you accidentally ship a load, you can cancel the shipping by clicking Un-
Ship.

4. In the Enter Value dialog box, click the arrow on the right side of the
blank field, and select the shipping date in the calendar.

5. Click OK.

6. If necessary, add the receiving date by clicking the arrow on the right side
of the Date Received field, and select the receiving date in the calendar.

7. If you want to create a shipping ticket, do the following:

a. Click the Shipping Ticket button.

b. In the Report Selection dialog box, click a shipping ticket report to
select it.

c. View, print, or export the report according to your needs. 

For detailed instructions, see View, print, and export job-specific
production control reports (page 772).

8. Click Save.

9. To close the dialog box, click the Close button (X) in the upper-right
corner.

Manage the fabrication process 802 Create, modify, and delete loads



Modify a load
1. In the list, click the load that you want to modify.

2. Click Load Properties.

3. On the Details tab of the Load Properties dialog box, modify the load
properties according to your needs.

4. On the Top Text tab, modify the top text of shipping tickets according to
your needs.

5. On the Material tab, modify the materials in the load.

• To add new material to the load, click Add.

For more information, see Add materials to a load.

• To remove a material item from the load, click the material item, click
Remove, and click Yes to confirm.

• To load a material item, click Load.

6. On the Loaded tab, unload any material items fr by clicking Unload, and
then, clicking Yes to confirm.

7. If necessary, on the Additional tab, add additional items to the load: 

For example, a box of bolts can be added as an additional item.

a. Click Additional on Load.

b. Click New.

c. Type the description, quantity, weight per item, and the total weight.

d. Add any additional notes.

e. Click Add. 

Repeat steps a to e for all additional items that you need to add.

8. To change the shipping status of the load, click Ship or Un-Ship at the
bottom of the dialog box. 

When shipping a load, select the shipping date and click OK.

9. Click Save to update the load properties.

View the materials on a load
1. In the list, click the load whose assigned materials you want to view.

2. Click View Material.

3. In the Loads - Material dialog box, review the assigned materials and
their shipping date.

4. Click the Close button (X) to close the Loads - Material dialog box.
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View current load locations
1. At the bottom of the dialog box, click Current Locations.

2. In the Loads - Material Location dialog box, view the current location of
each material item in existing loads.

3. Click the Close button (X) to close the Loads - Material Location dialog
box.

Delete a load
Note that deleting a load is permanent and cannot be undone.

1. In the list, click the load that you want to delete.

2. Click Delete Load.

3. In the confirmation dialog box, click Yes to permanently delete the load.

Add production control items to loads
Use the Load All Selected command to add the selected production control
materials to a truck load.

1. In the Production Control dialog box, click the items that you want to
load to select them. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Production Control ribbon tab.

3. On the menu, select Modify Data --> Load All Selected .

4. In the Loads - Add Material dialog box, click the arrow buttons to move
the items that you want to load to the Included list.

5. If you only want to load a particular number of pieces, select the item in
the Included list and type the number of pieces to be loaded in the Qty
field.

6. Click the arrow on the right side of Load # field and click the load to which
you want to add the items. 

Note that you can only select loads that have already been added in the
Loads dialog box. For more information on adding loads, see Create,
modify, and delete loads (page 800).

The total capacity and weight of the load is displayed at the bottom of the
Loads - Add Material dialog box.
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7. If necessary, click the arrow on the right side of the Date Loaded field,
and select another loading date in the calendar.

8. Click Add Material.

The items are added to the selected load. The items will be marked as loaded
in the Loads dialog box.

9.6 Track production by piece mark
In the Piece Tracking dialog box, you can add tracking information by piece
mark. You can record the stations that the piece mark has completed, the
date, and the man hours used. Piece tracking records can also be added if the
station is set as the TFS station in a route or assigned to an inspection.

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Piece Tracking.

3. To record information for completed items, in the Station Summary
dialog box, click Add Completed.

4. In the Station - Add Completed dialog box, click the arrow on the right
side of the Station list, and select a station in the list.

5. Click the arrow buttons to move the items that have completed the
selected station to the Included list.

6. Click the arrow on the right side of the Completed By list and select the
user that is adding the piece tracking information.

7. Click the arrow on the right side of the Date field and select the
completion date in the calendar.

8. Type the number of working hours used, and select if the working hours
are calculated by piece or as a total.

9. If necessary, type the batch ID of the selected items in the Batch ID field.
For example, you can type the name of the employee who is adding the
piece tracking information.

10. To review the inspection test records of the items before completing
stations, click the Inspection button. For more information, see Add,
modify, and review inspection test records (page 749).

11. Click Add Material to save the piece tracking information.

12. To close the Station Summary dialog box, click the Close button (X) in
the upper-right corner.
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You can view the piece tracking information by creating a Production Status
dialog box. For more information, see Review the production statuses of items
(page 748).

You can also view piece tracking information by viewing any report with the
word Station or Stations in the title. For more information, see View, print,
and export job-specific production control reports (page 772).

Add piece tracking and load tracking information and loads
to the current production control job
Use the Production/Shipping Entry dialog box to add information to the
current product control job. You can add piece tracking information and loads,
ship and unship loads, and add piece marks to trucks.

Note that the Production/Shipping Entry dialog box only allows you to add
one item at a time.

To open the Production/Shipping Entry dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Production Control --> Production/Shipping Entry .

The Production/Shipping Entry dialog box opens on the Piece Tracking
tab.
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Add piece tracking information
1. In the Action list, click the action that you want to perform. You can add

or delete items.

2. In the Job # list, click the production job for which you want to perform
the action.
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3. In the appropriate lists, select the main mark, piece mark, sequence, lot
number, station, employee who is adding the information, and date. 

Note that the employee must be a Tekla EPM user.

4. In the Quantity field, enter the number of pieces being worked on.

5. In the Hours field, enter the man hours used for working on the item.

6. To perform the action, click Add or Delete.

The action is updated to the selected job. The action also appears in the
History list at the bottom of the Production/Shipping Entry dialog box.

Add loads, ship loads, and unship loads
1. Click the Trucks tab to open it.

2. In the Action list, click the action that you want to perform. 

You can add or validate, ship, or unship trucks.

3. In the Job # list, click the production job for which you want to perform
the action.

4. Select the load number, shipping date, and destination in the appropriate
lists.

5. If necessary, click View to view the items assigned to the selected load.

6. If the load needs to be returned, select the To Be Returned check box. 

The load must be returned even if the materials will not be physically
returned. Returning the loaded items allows the piece marks to be loaded
onto a new shipping ticket that contains items delivered to the job site.
This way, Tekla EPM can keep accurate records of when parts were
received and shipped.

7. To perform the action, click Add/Validate, Ship, or Un-Ship. 

The action is updated to the selected production control job. The action
also appears in the History list at the bottom of the Production/Shipping
Entry dialog box.

8. If necessary, view the shipping ticket:

a. Click Shipping Ticket.

b. In the Report Selection dialog box, select the report that you want to
view, print, or export.

c. Do any of the following: 

To Do this
View the shipping ticket • In the Report Selection dialog box, click View.
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To Do this
Print the shipping ticket 1. In the Report Selection dialog box, change

the number of the printed copies by clicking
the + and - buttons.

2. Click Print.

3. In the Select Printer dialog box, click a printer
to select it.

4. Click OK.
Export the shipping
ticket

1. In the Report Selection dialog box, click
Export.

2. In the Export Format list, select an export
format.

3. Click Browse.

4. Browse to the location where you want to save
the exported file, and click Save.

5. Modify the file name according to your needs.

6. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email check box.

7. To open the file after exporting it, select the
Open Exported Document check box.

8. In the Report Selection dialog box, click
Export.

Add piece marks to trucks
1. Click the Load Tracking tab to open it.

2. In the Action list, click the action that you want to perform. 

You can add, delete, return, or unreturn items.

3. In the appropriate lists, select the main mark, piece mark, sequence, lot
number, load number, and date.

4. If necessary, click View to view the items assigned to the selected load.

5. In the Quantity field, enter the number of pieces that are worked on.

6. Click Add, Delete, Return, or Un-Return. 

The action is updated to the selected production control job. The action
also appears in the History list at the bottom of the Production/Shipping
Entry dialog box.

7. If necessary, view the shipping ticket:

a. Click Shipping Ticket.
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b. In the Report Selection dialog box, select the report that you want to
view, print, or export.

c. Do any of the following: 

To Do this
View the shipping ticket • In the Report Selection dialog box, click View.
Print the shipping ticket 1. In the Report Selection dialog box, change

the number of the printed copies by clicking
the + and - buttons.

2. Click Print.

3. In the Select Printer dialog box, click a printer
to select it.

4. Click OK.
Export the shipping
ticket

1. In the Report Selection dialog box, click
Export.

2. In the Export Format list, select an export
format.

3. Click Browse.

4. Browse to the location where you want to save
the exported file, and click Save.

5. Modify the file name according to your needs.

6. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email check box.

7. To open the file after exporting it, select the
Open Exported Document check box.

8. In the Report Selection dialog box, click
Export.

9.7 Use Trimble Connect with a production control job
You can view the production control job information in an IFC model using
Trimble Connect. You can interact with the model in several ways: by sharing
the production status of items to Trimble Connect, color-coding items in the
IFC model, or selecting items in the IFC model or in the production control
jobs.

We recommend that you start the production control job by importing an XML
file from Tekla Structures. The XML file includes GUIDs, unique identifiers that
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match the identifiers in the IFC model. The necessary IFC settings for Tekla
Structures plugin can be downloaded from Tekla Warehouse.

Before you can view the job information in Trimble Connect, your Tekla EPM
administrator needs to set up the Trimble Connect integration settings.

See also

Link a production control job to Trimble Connect (page 811)

Color-code production control items in the IFC model (page 813)

Select the same items in the production control job and in the IFC model
(page 814)

Link a production control job to Trimble Connect
Before you can view the production control job information in Trimble
Connect for Windows, you need to link the job to a Trimble Connect project.
You can either link the job to an existing project or create a new project.

Note that if a production control job is linked to a project management job,
the Trimble Connect project is managed through the project management job.
In this case, you need to link the project management job to Trimble Connect.
The link is then applied to any linked production control and estimating jobs.
The Trimble Connect project cannot be modified when you access it through
the production control job.

1. In the Production Control dialog box, right-click anywhere in the display
area.

2. In the context menu, click Model Interface. 

A message appears, telling you that the current job is not linked to a
Trimble Connect project.

3. Click OK to close the message. 
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4. In the Link Project to Trimble Connect dialog box, do one of the
following: 

To Do this
Link the job to an
existing Trimble Connect
project

a. To display the available Trimble Connect
projects, click Sync Projects.

b. Select the desired project, and click Link
Project.

Create a new Trimble
Connect project and link
the job to it

a. Click Add Project to Trimble Connect.

b. In the Add Users to Project dialog box, click
the arrow buttons to move the users that
participate in the project to the Included list.

c. Click OK.

Tekla EPM creates a Trimble Connect project
with the same name and information as the
current job.

d. In the Status dialog box, review the creation
process of the Trimble Connect project.

A message appears, telling you that the project
has been created successfully.
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To Do this
e. Click OK to close the message.

f. In Trimble Connect for Windows, press the
Back button to exit the empty 3D view.

g. In the Explorer side pane on the left, click the
Add File button.

h. In the Add Files dialog box, browse to find the
IFC model.

i. Select the IFC model and click Open.

The IFC model is imported to Trimble Connect for
Windows.

The production control job and Trimble Connect project are now linked.

To unlink a production control job from the Trimble Connect project:

1. In the Select Production Control Job dialog box, select the job that you
want to unlink.

2. At the bottom of the dialog box, click Edit.

3. In the Production Control Job Edit dialog box, click Link on the right side
of the Trimble Connect Project field.

4. In the Link Project to Trimble Connect dialog box, click Unlink project.

5. To close the dialog box, click the Close button (X) in the upper-right
corner.

6. In the Production Control Job Edit dialog box, click Save.

See also

Use Trimble Connect with a production control job (page 810)

Color-code production control items in the IFC model (page 813)

Select the same items in the production control job and in the IFC model
(page 814)

Color-code production control items in the IFC model
To color-code items in the IFC model according to their properties, use the
Colorize command in the Model Viewer Interface dialog box. For example,
you can color-code items according to their production status or sequence.
You can also set filters to only color-code particular items in the model. By
using a filter, for example, you could first filter the items by their sequence,
and then color-code the items in that sequence by their production status.

1. In the Production Control dialog box, right-click anywhere in the display
area.
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2. In the context menu, click Model Interface.

3. If necessary, in the Model Viewer Interface dialog box, filter the items
that you want to color-code:

a. Click Set Filters.

b. In the Estimating Filters dialog box, select a filter type in the Type
list, and click Select.

c. In the Filter dialog box, do one of the following depending on the
filter type: 

• Click the arrow buttons to move the items that you want to display
in the model to the Included list.

• Type the maximum and minimum values for the items that you
want to display in the model.

d. Click OK. 

Repeat steps b to d for all filter types that you want to set.

e. Click Apply Filter.

4. Click the arrow on the right side of the Colorize By list and select a
property in the list.

5. Click Colorize.

The items in the IFC model are color-coded according to the selected property.

To revert to the original colors in the IFC model, click Reset in the Model
Viewer Interface dialog box.

See also

Select the same items in the production control job and in the IFC model
(page 814)

Select the same items in the production control job and in
the IFC model
When you have linked a production control job to Trimble Connect, you can
select an item that is selected in one of the software simultaneously in the
other one. Do the following:

1. In the Production Control dialog box, right-click anywhere in the display
area.

2. In the context menu, do one of the following:

• To select the item that is selected in the production control job also in
the IFC model, select Select in Model.

• To select the item that is selected in the IFC model also in the
production control job, select Select from Model.
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See also

Color-code production control items in the IFC model (page 813)

Visualize jobs with Trimble Connect Organizer and Trimble
Connect Content Browser
You can use Trimble Connect Organizer to visualize and group items on your
estimating jobs and production control jobs. You can select which fields in
Tekla EPM you want to use to categorize model objects that correspond to
your Tekla EPM items in the related IFC model, and highlight or color-code
model objects according to different criteria.

Prerequisites of using Trimble Connect Organizer:

• You need to have a Trimble Connect Business Premium license.

• Your estimating job and production control job need to be linked through
the Project Management module.

Note that your estimating job and production control job do not
necessarily need to be linked to the same Trimble Connect project.

• The jobs need to be linked to a Trimble Connect project.

Set up item categories for Trimble Connect Organizer
You can now set up the categories that you want to use in Trimble Connect
Organizer. The categories determine which criteria you can use to highlight
and color-code items in the linked estimating and production control jobs.

1. Click the Maintenance ribbon tab.

2. On the menu, select Integration Settings --> Trimble Connect
Organizer.

3. In the Trimble Connect Organizer Tree Mappings dialog box, create the
necessary item categories:

a. Click New.

b. In the Field Type list, select if you want to use a field from the
estimating job or the production control job.

c. In the Tekla EPM Field list, select the field that you want to use as an
item category in Trimble Connect Organizer.

d. In the Organizer Tree Name, type a name that Trimble Connect
Organizer will use for the item category. 

We recommend that you use clear names to ensure that you know
where the information in the category comes from. For example, if a
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category contains the shapes in the estimating job, you could name
the category Tekla EPM Estimating - Shape.

e. Click Add.

For example, you can create a category for production sequences in the
linked production control job. All sequences within the linked production
control job will be shown under this category, and you can highlight
individual sequences in the 3D model view.

Repeat steps a to e to create all necessary field mappings.

4. To close the Trimble Connect Organizer Tree Mappings dialog box, click
the Close button (X) in the upper-right corner.

Publish job information manually to Trimble Connect Organizer
• To upload job information to Trimble Connect Organizer: 

From Do this
An estimating job 1. Open the estimating job.

2. Click the Estimating ribbon tab.

3. On the menu, select Publish to Trimble
Connect Organizer.

A production control job 1. Open the production control job.

2. Click the Production Control ribbon tab.

3. On the menu, select Export --> Publish to
Trimble Connect Organizer.

The item information is uploaded to Trimble Connect Organizer, and will be
visible in the Organizer side pane in Trimble Connect for Browser.

You can also create an automated event that uploads the item information to
Trimble Connect Organizer automatically as often as you want.

Highlight selected items in Trimble Connect Organizer
1. To open Trimble Connect for Browser: 

• Go to https://3d.connect.trimble.com/.

• Click  Trimble Connect in the upper-right corner of Tekla EPM
Go.

2. Double-click the Trimble Connect project that is linked to the desired
estimating and production control jobs. 

The Trimble Connect project opens in the Trimble Connect 3D viewer.
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3. To open the Organizer side pane, click  Organizer in the Trimble
Connect side pane. 

4. In the Organizer side pane, expand the necessary categories and select
the categories whose items you want to highlight. 

To select more than one category at a time, hold down Ctrl when
selecting categories.

For example, you can select the labor code B - Bolted Clips On Both Ends
and sequence 1 to highlight and zoom to all items with labor code B that
belong to the production sequence 1.
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Color-code items with Trimble Connect Content Browser

1. In the Trimble Connect side pane, click  Data Table.

2. To configure what information is shown in Content Browser: 

a. At the top of the Content Browser pane, click the  Columns
button. 

b. If necessary, remove the current columns by clicking Remove All on
the right side of the Visible Columns list.

c. Find a column that you want to show in the Content Browser pane by
scrolling the All Columns list, or by typing a search word in the Filter
Columns field.

d. Select the column.

e. Hold down the left mouse button, drag the column to the Visible
Columns list, and release the left mouse button. 

Repeat steps c to e for all columns that you want to show.

f. To save your changes, click OK at the bottom of Column Picker.

3. To set how the items are grouped in the 3D model:

a. Select a column in Content Browser and hold down the left mouse
button.

b. Drag the column to the Group by box, and release the left mouse
button. 

Manage the fabrication process 818 Use Trimble Connect with a production control
job



The column name appears in the Group by box, and the objects are
sorted according to the selected criterion. By default, groups and
objects are shown in alphabetical order.

You can also drag another column to the Group by box. In this case,
the objects are sorted to both of the selected criteria.

If you want to reverse the order of the objects, click the column name
in the Group by box.

4. To color-code the items in the 3D view, at the top of Content Browser,

click  Colorize.

The objects on all rows of Content Browser are color-coded in the 3D view. The
color that is used for each row is shown on the right side of the row title.

In the following image, you can see items grouped and color-coded by
production sequence.
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9.8 Export production control information
You can export production control information, including the production
status, to multiple file formats. You can save the current production control
job as a KISS or CIS/2 file, export the production status to an XML file, or push
the production status to Trimble Connect.

For more information, see the following links:

Export a production control job to Kiss (page 820)

Export the production control job to a CIS/2 model (page 821)

Export the production status to Tekla Structures or Advance Steel (page 667)

Export the production status to SDS/2 (page 668)

Publish the production status to Trimble Connect (page 669)

Export a production control job to Kiss
To save the current production control job as a KISS file, do the following:

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Export --> Export to KISS .

3. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla EPM saves the file to the Export folder.
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4. If necessary, change the file name.

5. Click Save.

The file is saved to the selected location as a KISS file.

Export the production control job to a CIS/2 model
Use the Export to CIS/2 Model command to export a production control job
to CIS/2 file. Note that the Export to CIS/2 Model command is only available if
the production control job has originally been imported from a CIS/2 file.

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Export --> Export to CIS/2 Model .

3. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla EPM saves the file to the Export folder.

4. If necessary, change the file name.

5. Click Save. 

A message appears, showing the location where the CIS/2 file was saved.

9.9 Finalize a production control job
Use the Finalize command to prevent any further changes to a production
control job. After finalizing the production control job, you can no longer send
material to purchasing. The requisitioned items assigned to the job will be
deleted, and inventory items reserved for the job will be unreserved. Note that
finalizing a job is irreversible and cannot be undone.

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Purchasing --> Finalize .

3. If you are sure that you want to finalize the job, inthe Finalize Job dialog
box, click Finalize.
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10Manage requisitions and
purchase orders

In the Purchasing module, you can create two types of jobs: requisitions and
purchase orders. Requisitions list the required materials for multiple jobs,
whereas purchase orders represent the individual orders that you make from
vendors.

Before you start creating requisitions and purchase orders in the Purchasing
module, remember to adjust the settings of the Purchasing module according
to your needs.

For more information, see the following links:

Set up the Purchasing module (page 822)

Create and manage requisitions (page 842)

Create and manage purchase orders (page 875)

10.1 Set up the Purchasing module
The Purchasing module in Tekla EPM consists of two parts: requisitions and
purchase orders. Before starting to use Purchasing, we recommend that you
adjust the requisition and purchase order properties to meet the needs of
your company.

For more information, see the following links:

Define the requisition settings (page 822)

Define the purchase order settings (page 829)

Create, modify, or delete cost codes (page 841)
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Define the requisition settings
Before you start to use the Purchasing module, you need to separately define
the default settings and options used for requisitions and purchase orders.

For more information, see the following links:

Define company standard settings for requisitions (page 823)

View, print, or export global requisition reports (page 827)

Manage requisitions (page 828)

Define company standard settings for requisitions
In the Requisition Company Standards dialog box, you can create default
settings that become the company standard settings used in all future
requisitions. If necessary, you can change the settings for each individual
requisition.

1. Click the Maintenance ribbon tab.

2. On the menu, select Requisitions --> Company Standards .

3. In the Requisition Company Standards dialog box, adjust the settings
according to your needs: 

Option Description
Requisition #
Increment

Allows you to select the default option for
automatic numbering of requisitions. The options
are:

• Increment from Last Requisition #: When you
create a new requisition, Tekla EPM uses the
next available number after the latest
requisition number created.

• Increment from Largest Requisition #: Tekla
EPM uses the next available number after the
largest requisition number created.

• Don't Increment: Automatic numbering is not
used.

You can modify the requisition number when you
create a new requisition.

Item Increment Sets the auto-increment for item numbers.

The auto-increment allows the items to be added
in the list according to your needs, without having
to renumber the other items in the requisition.

For example, if items should be numbered as 10,
20, 30, ..., the input increment should be set to 10.
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Option Description
If the auto-increment of the item numbers is not
necessary, type 1 in the Item Increment field.

Keep Purchasing
Selection Screen Open

When selected, the Select Requisition/Purchase
Order dialog box stays open after a requisition has
been opened. Otherwise, the Select Requisition/
Purchase Order dialog box will close when you
open a requisition.

Job # Regular
Expression

Allows the use of regular expressions to create the
requisition number.

For more detailed instructions on the job number
regular expressions, click Regular Expression
Help.

4. Click Save.

The changes you made are saved. You can further modify the company
standards by clicking the Input/Display Units, Combining Optimizations,
and Suppliers buttons.

See also

Define default input and display units for requisitions (page 824)

Define combining optimizations for requisitions (page 824)

Define suppliers for requisitions (page 826)

Define default input and display units for requisitions
You can use either metric or imperial units for displaying and entering sizes,
lengths, weights, and prices in requisitions. In addition, you can select how you
want to enter the data for the length of the piece.

1. In the Requisition Company Standards dialog box, click the Input/
Display Units button.

2. In the Input/Display Units dialog box, select the units and the length
input types in the available lists. 

Note that there are multiple options depending on the required precision
and the desired input method.

3. Click OK.

4. Remember to click Save in the Requisition Company Standards dialog
box to update the input and display units.

When the settings are saved, the Requisition Company Standards dialog box
closes.

Manage requisitions and purchase orders 824 Set up the Purchasing module



Define combining optimizations for requisitions
You can define company-level settings for multing and plate nesting for new
requisitions. If necessary, the combining optimizations can be adjusted for
each individual requisition.

1. At the bottom of the Requisition Company Standards dialog box, click
Combining Optimizations.

2. To use material grade substitutions with the optimization settings when
performing a combining run, on the General Settings tab of the
Combining Setup dialog box, select the Use Grade Substitutions check
box. 

Grade substitutions must be set in the Shape / Grade / Size
Maintenance dialog box. If the grade substitutions are not set, the
material grades in the combining run and in the supplier pricing data set
or the inventory need to match each other exactly.

3. If you only want to mult and nest materials that are in the same sequence,
select the Combine Only Within Sequence check box. 

Selecting the Combine Only Within Sequence check box might be useful
in medium or big jobs, but we do not recommend selecting it for small
jobs.

4. Click the arrow buttons to move the optimization options that you want to
use to the Optimizations Included list. 

The options are:

• Inventory Exact-Match (In Stock): Use this option for inventory items
in stock that are an exact match without the use of kerf or clamp
allowance.

• Inventory Exact-Match (On Order): Use this option for inventory
items that are on purchase orders and have not yet been received and
that are an exact match without the use of kerf or clamp allowance.

• Inventory Least-Scrap (On Order): Use this option for inventory
items that are on purchase orders and have not yet been received and
that will provide the least amount of scrap.

• Inventory Least-Scrap (In Stock): Use this option for inventory items
in stock that will provide the least amount of scrap.

• Warehouse Least-Scrap: Use this option to give preference to
warehouse items that will provide the least amount of scrap.
Warehouse items will only be used when they provide less scrap than
the available inventory items.

• Warehouse Force Inventory: Use this option to force the use of
inventory regardless of the amount of scrap, no matter where it is
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located in the Optimizations Included list. This option is the opposite
of Warehouse Least-Scrap.

Note that you can only include Warehouse Least-Scrap or
Warehouse Force Inventory, not both.

5. Use the Move Up and Move Down buttons to modify the order of the
optimizations. 

The order is important while performing a combining run.

6. Click the Mult Settings - Linear Material tab to open it.

7. In Multing Software, select the multing software that you are using.

8. If you want to apply the material kerf settings defined in Shape / Grade /
Size Maintenance to the combining as part of the cutting pattern, select
the Apply Kerf check box.

9. Open the Plate Nesting Settings tab.

10. In the Plate Nesting Software list, click the plate nesting software that
you are using to select it.

11. In the Shear Cut Optimization list, click a suitable shear cut option to
select it. 

The selected option determines the plate allowance to be used with the
combining:

• Use None when cutting plate on a burn table.

• Use Shear Cut - First Cut Along Length or Shear Cut - First Cut
Along Width to alert Tekla EPM that the nesting needs to allow for
that type of cut first. Then, the nesting will allow for all subsequent
cuts to be made with that condition.

12. If the material grain direction is unimportant and you want Tekla EPM to
create the best possible optimization of a plate, select the Rotate Plates
for Best Fit check box.

13. If necessary, select the Apply Kerf check box. 

See step 8.

14. Click Save.

15. Remember to click Save in the Requisition Company Standards dialog
box to update the combining optimizations.

When the settings are saved, the Requisition Company Standards dialog box
closes.

Define suppliers for requisitions
You can define the desired suppliers, or pricing data sets, for angles, beams,
plates, rods, tubes, and other material. This way, you can use material pricing
from the selected supplier pricing data sets for each material group.
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1. In the Requisition Company Standards dialog box, click the Suppliers
button.

2. In the Suppliers dialog box, select suppliers for each material group in the
available lists.

3. Click OK.

4. Remember to click Save in the Requisition Company Standards dialog
box to update the supplier settings.

When the settings are saved, the Requisition Company Standards dialog box
closes.

View, print, or export global requisition reports
Use the Reports command under Maintenance --> Requisitions to create
reports that include information from all or several requisitions jobs. The
available reports include requests for pricing and various lists of requisitions.
You can then either view or print a report, or export a report and save it in
another file format.

To create requisition reports, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Requisitions --> Reports .

3. To only include specific requisitions in the reports, in the Requisition
Report Filters dialog box, select a filter type in the Type list, and click
Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the requisition properties that you
want to include in the reports to the Included list.

• Type the maximum and minimum values for the requisition properties
that you want to include in the reports.

5. Click OK. 

To further limit the requisitions included in the reports, repeat steps 3 to 5
for all filter types.

6. Click Make Report.

7. In the Report Selection dialog box, select the report that you want to
view, print, or export. 

To change the reports that are displayed in the Report Selection dialog
box, click Edit Report Types.

According to your needs, see any of the following instructions:
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View the requisition report

• In the Report Selection dialog box, click View.

The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
EPM Report Viewer window to email the report via Microsoft Outlook.

Print the requisition report

1. In the Report Selection dialog box, change the number of the printed
copies by clicking the + and - buttons.

2. Click Print.

3. To confirm printing the selected report, click Yes in the confirmation
dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the requisition report

1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Modify the file name according to your needs.

5. Browse to the location where you want to save the exported file, and click
Save.

6. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email check box.

7. To open the file after exporting it, select the Open Exported Document
check box.

8. In the Report Selection dialog box, click Export.

Manage requisitions
In Job Maintenance, you can delete or copy existing requisitions.

1. Click the Maintenance ribbon tab.

2. On the menu, select Requisitions --> Requisition Maintenance .

3. In the Job Maintenance dialog box, select any of the available options:

• Copy

• Delete
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See also

Copy a requisition (page 829)

Delete requisitions (page 829)

Delete requisitions
You can delete unnecessary requisitions at any time in Job Maintenance.

1. In the Job Maintenance dialog box, select the requisitions that you want
to delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. At the bottom of the dialog box, click Delete.

3. To delete the requisition, click Yes in the confirmation dialog box.

Copy a requisition
You can copy a requisition to use it as the base of a new similar requisition.
Copying a requisition makes creating the new requisition quicker, as you do
not have to set all properties manually or create items one by one.

1. In the Job Maintenance dialog box, select the requisition that you want to
copy.

2. Click Copy.

3. Type a number for the new job.

4. Click OK.

5. Define new job numbers for the jobs whose items are sent to the original
requisition:

a. In the New Job # field, type a new number for the job.

b. Click Set to save the new job number.

Repeat steps a to b for all necessary jobs.

Define the purchase order settings
Before you start to use the Purchasing module, you need to separately define
the default settings and options used for requisitions and purchase orders.

For more information, see the following links:

Define company standard settings for purchase orders (page 831)

View, print, or export global receiving reports (page 834)

Add, modify, or delete purchase order types (page 836)

Add, modify, and delete shipping methods for purchase orders (page 837)
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Add, modify, or delete payment terms for purchase orders (page 839)

Add, modify, or delete top text items (page 840)

Import, view, or delete advance shipment notices
In the Advance Shipment Notice dialog box, you can import advance
shipment notices from XML files to Tekla EPM. You can also view the shipment
details of an advance shipment notice, or delete any unnecessary advance
shipment notices.

1. Click the Maintenance ribbon tab.

2. On the menu, select Purchase Orders --> Advance Shipment Notices .

The Advance Shipment Notice dialog box opens.

Import an advance shipment notice

1. At the bottom of the Advance Shipment Notice dialog box, click Load
ASN.

2. In the Open dialog box, browse to find the XML file that you want to
import.

3. Select the file and click Open. 

If the order number in the XML file does not match any existing purchase
orders, the Enter Value dialog box opens.

4. Click the arrow on the right side of the list, and select the purchase order
to which you want to import the XML file.
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5. Click OK.

6. In the Load Advance Shipment Notice dialog box, view the progress of
the import process.

7. When the import is completed, click Close at the bottom of the dialog box.

The advance shipment notice has now been imported for the selected
purchase order. If necessary, you can view the details of the advance shipment
notice.

View the details of an advance shipment notice

1. In the Advance Shipment Notice dialog box, select the advance
shipment notice whose details you want to view.

2. Click Details.

3. View the advance shipment notice. 

Click the various tabs and buttons to show different details about the
advance shipment notice.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Delete an advance shipment notice

Note that deleting an advance shipment notice is permanent and cannot be
undone. This means that you need to re-import the XML file to view the
advance shipment notice again.

1. In the Advance Shipment Notice dialog box, select the advance
shipment notice that you want to delete.

2. Click Delete ASN.

3. To permanently delete the advance shipment notice, click Yes in the
confirmation dialog box.

Define company standard settings for purchase orders
In the Purchase Order Company Standards dialog box, you can create the
default settings that become the company standard settings, and the units
used in all new purchase orders. If necessary, you can change the settings for
each individual purchase order.

1. Click the Maintenance ribbon tab.

2. On the menu, select Purchase Orders --> Company Standards .
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3. On the General tab of the Purchase Order Company Standards dialog
box, adjust the settings according to your needs: 

Option Description
P.O. # Increment Allows you to select the default option for

automatic numbering of purchase orders. The
options are:

• Increment from Last P.O. #: When you create
a new purchase order, Tekla EPM uses the next
available number after the latest purchase
order number created.

• Increment from Largest P.O. #: Tekla EPM
uses the next available number after the largest
purchase order number created.

• Don't Increment: Automatic numbering is not
used.

'Purchase Order' Text Allows you to replace the word 'Purchase order' in
Tekla EPM with an alternative text. The alternative
text will be used wherever 'Purchase order' is
currently used in Tekla EPM.

Note that you need to close and re-open Tekla EPM
to update the purchase order text.

Type the desired text in the 'Purchase Order' Text
field.

'P.O.' Text Allows you to replace the abbreviation 'P.O.' in
Tekla EPM with an alternative text. The alternative
text will be used wherever 'P.O.' is currently used
in Tekla EPM.

Note that you need to close and re-open Tekla EPM
to update the P.O. text.

Type the desired text in the 'P.O.' Text field.
Item Increment Sets the auto-increment for item numbers.

The auto-increment allows the items to be added
in the list according to your needs, without having
to renumber the other items in the requisition.

For example, if items should be numbered as 10,
20, 30, ..., the input increment should be set to 10.
If auto-increment of item numbers is not
necessary, type 1 in the Item Increment field.

Keep Purchasing
Selection Screen Open

When selected, the Select Requisition/Purchase
Order dialog box stays open after a purchase
order has been opened. Otherwise, the Select
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Option Description
Requisition/Purchase Order dialog box will close
when you open a purchase order.

Generate Barcode
Images

When selected, Tekla EPM generates the necessary
barcode images for the Barcode Checklist report.

Note that you only need to select the Generate
Barcode Images check box if you are using a
customized version of the Barcode Checklist
report designed with Crystal Reports.

If you are using another version of the Barcode
Checklist report, the barcodes are automatically
generated as a part of the report, whether or not
the Generate Barcode Images check box is
selected.

QuickBooks - Export
PO Summary Only

When selected, purchase order items are exported
as a whole without any line item details.

P.O. # Regular
Expression

Allows the use of regular expressions to create the
purchase order number.

For more detailed instructions on job number
regular expressions, click Regular Expression
Help.

4. On the Receiving tab, select the check boxes next to the properties that
you want to define when receiving material items.

5. On the Default Remarks tab, do any of the following to define the
remarks added for all new purchase orders by default.

• Type the necessary remarks in the available fields.

• Click the arrow buttons on the right side of the available fields and
select previously set remarks.

For more information about managing remarks, see Add, modify, or
delete purchase order remarks (page 840).

6. On the Default Top Text tab, do any of the following to define the top
text added for all new purchase orders by default:

• Type a name for the top text item in the Description field, and type
any necessary information in the Top Text field.

• Click the arrow button on the right side of the Description list, and
select a previously set top text item.

For more information about managing top text items, Add, modify, or
delete top text items (page 840).

7. To adjust the input and display units used for purchase orders, click the
Input/Display Units button.
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8. In the Input/Display Units dialog box, select the units and the length
input types in the available lists. 

Note that there are multiple options depending on the required precision
and the desired input method.

9. Click OK.

10. In the Purchase Order Company Standards dialog box, click Save to
update the settings.

11. To close the dialog box, click the Close button (X) in the upper-right
corner.

View, print, or export global receiving reports
Use the Receiving Reports command to create receiving reports that contain
information from all or various purchase orders. You can then view or print
the reports, or export the reports and save them in another file format. For
example, you can create a purchase order summary, or a receiving list.

To create receiving reports, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Purchase Orders --> Receiving Reports .

3. To only include particular purchase orders in the reports, in the Purchase
Order Report Filters dialog box, select a filter type in the Type list, and
click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the purchase order properties that
you want to include in the report to the Included list.

• Type the maximum and minimum values for the purchase orders that
you want to include in the report.

5. Click OK. 

To further limit the properties of purchase orders that are included in
reports, repeat steps 3 to 5 for all necessary filter types.

6. To save commonly used filters, do the following:

a. Click Filter Types in the lower-left corner.

b. Click New.

c. Type a description for the filter type.

d. Create the filter settings. 

For more information, see steps 3 to 5.

e. Click Add.
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f. To close the dialog box, click the Close button (X) in the upper-right
corner. 

The newly created filter type is selected in the Filter Types list.

g. To apply the filter type, click Set.

Note that if you save a filter type in the Purchase Order Report Filters
dialog box, the saved filter type will also be available as a filter in the PO #
dialog box for all purchase orders.

7. Click Make Report.

8. In the Report Selection dialog box, select the report that you want to
view, print, or export. 

Note that all available receiving reports are not displayed by default. You
can customize the reports that are displayed in the Report Selection
dialog box by clicking Edit Report Types.

9. If you want to include the company logo and vendor code in the report,
select the Show Company Logo and Show Vendor Code check boxes. 

When the check boxes are cleared, the information is not included in the
report.

According to your needs, see any of the following instructions:

View the report

• In the Report Selection dialog box, click View.

The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
EPM Report Viewer window to email the report via Microsoft Outlook.

Print the report

1. In the Report Selection dialog box, change the number of the printed
copies by clicking the + and - buttons.

2. Click Print.

3. To confirm printing the selected report, click Yes in the confirmation
dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the report

1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.
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4. Modify the file name according to your needs.

5. Browse to the location where you want to save the exported file, and click
Save.

6. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email check box.

7. To open the file after exporting it, select the Open Exported Document
check box.

8. In the Report Selection dialog box, click Export.

Add, modify, or delete purchase order types
In the PO Type Maintenance dialog box, you can create new purchase order
types that meet the needs of your company. For example, recurring purchase
orders can have their own purchase order type. You can also select the default
purchase order type, modify existing purchase order types, and delete
unnecessary purchase order types.

To access the PO Type Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Purchase Orders --> PO Type Maintenance .

The PO Type Maintenance dialog box opens.

According to your needs, see any of the following instructions:

Create a purchase order type

1. At the bottom of the PO Type Maintenance dialog box, click New.

2. Type a description for the purchase order type.

3. Click Add.

Set a purchase order type as default

1. In the PO Type Maintenance dialog box, select the desired purchase
order type.

2. Click Set as Default.

3. To confirm setting the selected purchase order type as the default option,
click Yes in the confirmation dialog box.

Modify a purchase order type

1. In the PO Type Maintenance dialog box, select the purchase order type
that you want to modify.

2. Modify the description according to your needs.

3. Click Edit to save the changes.
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Delete a purchase order type

Note that deleting a purchase order type is permanent and cannot be undone.

1. In the PO Type Maintenance dialog box, select the purchase order type
that you want to delete.

2. Click Delete.

3. To permanently delete the purchase order type, click Yes in the
confirmation dialog box.

Add, modify, and delete shipping methods for purchase orders
In the Shipping Method Maintenance dialog box, you can add, modify, and
delete shipping method options that are available for the purchase orders
created in Purchasing. You can also select which shipping method you want
to use as the default option.

1. Click the Maintenance ribbon tab.

2. In the menu, select Purchase Orders --> Shipping Method
Maintenance .

3. In the Purchase Order Payment Term Maintenance dialog box, do any
of the following according to your needs: 

To Do this
Add a new shipping
method

a. Click New.

b. In the Description field, describe the new
shipping method.

c. Click Add to save the new shipping method
and add it to the list.

Set a default shipping
method

a. Select the desired shipping method.

b. Click Set as Default.

c. To confirm using the selected shipping
method as the default option, click Yes in the
confirmation dialog box.

The default shipping method is marked with
an asterisk (*). The same shipping method will
be used by default in the Purchasing module.

Modify a shipping
method

a. Select the shipping method that you want to
modify.

b. Modify the description.

c. Click Edit to save the changes.
Delete a shipping
method

a. Select a shipping method in the list.

b. Click Delete.
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To Do this
c. To permanently delete the shipping method,

click Yes in the confirmation dialog box.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Add, modify, or delete FOB shipping destinations
In the Purchase Order FOB Maintenance dialog box, you can create, modify,
and delete FOB (Free on Board) shipping destinations. You can also set a
default FOB shipping destination. The destinations set in the Purchase Order
FOB Maintenance dialog box are available for all purchase orders.

1. Click the Maintenance ribbon tab.

2. On the menu, select Purchase Orders --> FOB Maintenance .

The Purchase Order FOB Maintenance dialog box opens.

According to your needs, see any of the following instructions:

Create a FOB shipping destination

1. At the bottom of the Purchase Order FOB Maintenance dialog box, click
New.

2. Type a description for the shipping destination.

3. Click Add.

Set the default FOB shipping destination

The current FOB shipping method is marked with an asterisk (*). To change
the default option, do the following:

1. In the Purchase Order FOB Maintenance dialog box, select the desired
shipping destination.

2. Click Set as Default.

3. To confirm setting the selected shipping destination as the default option,
click Yes in the confirmation dialog box.

The new FOB shipping method is marked with an asterisk (*).

Modify a FOB shipping destination

1. In the Purchase Order FOB Maintenance dialog box, select the shipping
destination that you want to modify.

2. Modify the description according to your needs.

3. Click Edit to save the changes.
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Delete a FOB shipping destination

Note that deleting a FOB shipping destination is permanent and cannot be
undone.

1. In the Purchase Order FOB Maintenance dialog box, select the shipping
destination that you want to delete.

2. Click Delete.

3. To permanently delete the shipping destination, click Yes in the
confirmation dialog box.

Add, modify, or delete payment terms for purchase orders
You can add, modify, or delete the payment term options that are available for
all purchase orders created in Purchasing. In addition, you can set the default
payment term that will be used for all future purchase orders by default.

1. Click the Maintenance ribbon tab.

2. In the menu, select Purchasing --> Payment Term Maintenance .

3. In the Purchase Order Payment Term Maintenance dialog box, do any
of the following according to your needs: 

To Do this
Add a new payment
term

a. Click New.

b. In the Description field, type a description for
the payment term.

c. If necessary, in the Discount field, type a
discount percentage for the payment term.

d. Click Add to save the new payment term and
add it to the list.

Set a default payment
term

a. Select a payment term in the list.

b. Click Set as Default.

c. To confirm using the selected payment term
as the default option, click Yes in the
confirmation dialog box.

The default payment term is marked with an
asterisk (*). The same payment term will be
used by default for all future purchase orders.

Modify a payment term a. Select a payment term in the list.

b. Modify the description and the discount
percentage according to your needs.

c. Click Edit to save the changes.
Delete a payment term a. Select a payment term in the list.
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To Do this
b. Click Delete.

c. To permanently delete the payment term, click
Yes in the confirmation dialog box.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Add, modify, or delete purchase order remarks
In the Purchase Order Remark Maintenance dialog box, you can create
remarks for purchase orders. You can also modify existing remarks or delete
any unnecessary remarks. The remarks set in the Purchase Order Remark
Maintenance dialog box are available for all purchase orders that you create
or modify.

1. Click the Maintenance ribbon tab.

2. On the menu, select Purchase Orders --> Remark Maintenance .

The Purchase Order Remark Maintenance dialog box opens.

According to your needs, see any of the following instructions:

Create a remark

1. At the bottom of the Purchase Order Remark Maintenance dialog box,
click New.

2. In the Description field, type the remark. 

For example, MTRs required.

3. Click Add.

Modify a remark

1. In the Purchase Order Remark Maintenance dialog box, select the
remark that you want to modify.

2. In the Description field, modify the text according to your needs.

3. Click Edit to save the changes.

Delete a remark

1. In the Purchase Order Remark Maintenance dialog box, select the
remark that you want to delete.

2. Click Delete.

3. To permanently delete the remark, click Yes in the confirmation dialog
box.
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Add, modify, or delete top text items
Top text items are pieces of text that can be added at the top of purchase
orders. In the Purchase Order Top Text Maintenance dialog box, you can
add new top text items, or modify and delete existing top text items.

1. Click the Maintenance ribbon tab.

2. On the menu, select Purchase Orders --> Top Text Maintenance .

The Purchase Order Top Text Maintenance dialog box opens.

The top text items created in the Purchase Order Top Text Maintenance can
be set as default options that are added for all nex purchase orders. For more
information, see Define company standard settings for purchase orders
(page 831).

Create a top text item

1. At the bottom of the Purchase Order Top Text Maintenance dialog box,
click New.

2. In the Description field, type a name for the top text item.

3. In the Top Text field, type the information to be added at the top of the
purchase orders.

4. Click Add.

Modify a top text item

1. In the Purchase Order Top Text Maintenance dialog box, select the top
text item that you want to modify.

2. In the Description field, modify the item name according to your needs.

3. In the Top Text field, modify the top text according to your needs.

4. Click Edit to save the changes.

Delete a top text item

1. In the Purchase Order Top Text Maintenance dialog box, select the top
text item that you want to delete.

2. Click Delete.

3. To permanently delete the top text item, click Yes in the confirmation
dialog box.

Create, modify, or delete cost codes
You can use cost codes to keep track of specific costs and set them to match
your accounting system. In the Cost Code Maintenance dialog box, you can
create cost codes that are available for items in all requisitions and purchase
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orders. You can also modify the existing cost codes, and delete unnecessary
ones.

To access the Cost Code Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select either Requisitions --> Cost Codes or Purchase
Orders --> Cost Codes .

The Cost Code Maintenance dialog box opens.

According to your needs, see any of the following instructions:

Create a cost code
1. At the bottom of the Cost Code Maintenance dialog box, click New.

2. Type an abbreviation for the cost code.

3. Type a description for the cost code. 

For example, Structural fabrication.

4. Click Add.

Modify a cost code
1. In the Cost Code Maintenance dialog box, select the cost code that you

want to modify.

2. Modify the abbreviation and description according to your needs.

3. Click Edit to save the changes.

Delete a cost code
Note that deleting a cost code is permanent and cannot be undone. After
deleting the cost code, you cannot use the cost code for requisition items.

1. In the Cost Code Maintenance dialog box, select the cost code that you
want to delete.

2. Click Delete.

3. To permanently delete the cost code, click Yes in the confirmation dialog
box.

10.2 Create and manage requisitions
On the Requisitions part of the Purchasing module, you can create and
modify requisitions and material items within them. The purpose of creating
requisitions is having a list of the required materials for multiple jobs, so that
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you can optimize the use of similar materials. By creating requisitions, you can
quote the required materials from vendors and attach the material items to
purchase orders or existing inventory.

Requisitions also hold a copy of the production control record that is attached
to the stock materials. You can manually move the records to and from stock
items.

You can use and organize requisitions in different ways according to your
needs. To illustrate, you can either use a single requisition for all required
materials, or create separate requisitions for each phase and material type in
each job.

We recommend that you plan the numbering of requisitions carefully to help
you organize the requisitions in the future.

In requisitions, you can:

• Combine all or selected material items.

• Load material items into a purchase order.

• View the purchase history or change history of the requisition.

• Update the pricing information.

• Create an export requests for pricing.

• Import pricing information for requisitions.

• Create requisition reports.

For more information, see the following links:

Create a requisition (page 844)

Open a requisition (page 846)

Modify a requisition (page 848)

Store document references for a requisition (page 849)

Add a requisition item (page 850)

Copy a requisition item (page 854)

Modify requisition items (page 854)

Delete requisition items (page 859)

View the pricing history of a requisition item (page 859)

View all changes in a requisition (page 861)

Load requisition items into a purchase order (page 862)

Export a request for pricing (page 864)

Import pricing information to a requisition (page 866)

Update pricing information (page 869)

Combine items in the Requisition # dialog box (page 871)
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View, print, or export requisition-specific reports (page 873)

Delete requisitions (page 875)

Create a requisition
To create a new requisition where you can load and store material items, do
the following:

1. At the top of the Tekla EPM window, click the Purchasing button.

2. In the Select Requisition/Purchase Order dialog box, ensure that you
are on the Requisitions tab.

3. Click Add. 

4. On the General tab of the Requisition Edit dialog box, do either of the
following to define the requisition number.

• Type the desired requisition number in the Requisition # field.

• To use the next available number from a prefix as the requisition
number, type the desired prefix, double-click the Requisition # field,
and click Yes to confirm using the prefix.

For example, you can use a related job number as the prefix.

We recommend that you plan the numbering of requisitions carefully to
help you organize the requisitions in the future. The requisition number
cannot be changed later. All other requisition information can be modified
later, if necessary.
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5. Define the remaining requisition properties. 

The properties marked with an asterisk (*) are mandatory information.

Option Description
Requisition Date * The date of the requisition.

Tekla EPM automatically uses the current date. To
change the date, do one of the following:

• Type the date in the Requisition Date field.

The acceptable formats are YYYY/MM/DD,
YY/MM/DD, MM/DD/YYYY, and MM/DD/YY.

• Click the arrow on the right side of the
Requisition Date field and select a date in the
calendar.

Description Any description of the requisition.

Type a description in the Description field.
Requisition Group The groups where the requisition belongs to.

Setting requisition groups for the requisition helps
you to sort requisitions in the Select Requisition/
Purchase Order dialog box.

To set requisition groups, do one of the following:

• Type new requisition group names in the
Requisition Group fields.

• Click the arrows on the right side of the
Requisition Group fields, and select existing
requisition groups in the lists.

Item Increment Sets the auto-increment for item numbers in the
requisition.

The auto-increment allows the items to be added
in the list according to your needs, without having
to renumber the other items in the requisition.

For example, if items should be numbered as 10,
20, 30, ..., the input increment should be set to 10.
If the auto-increment of item numbers is not
necessary, type 1 in the Item Increment field.

6. On the Notes tab, type any notes about the requisition.

7. Click the buttons at the bottom of the Requisition Edit dialog box to
adjust the combining optimizations, suppliers, and input and display units.

For more information, see:

• Define combining optimizations for requisitions (page 824)
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• Define suppliers for requisitions (page 826)

• Define default input and display units for requisitions (page 824)

8. Click Save to create the requisition.

The Requisition Edit dialog box closes. The new requisition is added to the
Select Requisition/Purchase Order dialog box.

See also

Open a requisition (page 846)

Modify a requisition (page 848)

Store document references for a requisition (page 849)

Delete requisitions (page 875)

Open a requisition
To view and modify the material items in a requisition, you need to open the
requisition:

1. At the top of the Tekla EPM window, click the Purchasing button.

2. In the Select Requisition/Purchase Order dialog box, ensure that you
are on the Requisitions tab.

3. Select the requisition that you want to open.

4. Do one of the following:

• At the bottom of the dialog box, click Open.

• Double-click the selected requisition.
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The Requisition # dialog box opens. View the components of the dialog box in
the following image:

(1) The summary grid: shows the number of requisition items, their length,
square feet, weight, surface area, and cost for items for a single item, the
selected items, the displayed items, and the entire requisition.

(2) The mode switch button: the Requisition # dialog box has two modes: the
input mode and the manual combine mode. In the input mode, you can add
material items and modify them. In the manual combine mode, you can add
stock material items, and combine specific material items manually.

To change the mode, click the button in the upper-left corner.

(3) The display area: shows all material items in the requisition.

The visible columns and details can be modified in the Edit Display Fields
dialog box.

Note that a C in the leftmost column indicates that the material items have
been combined.

(4) The input area: allows you to add properties for new material items and
modify properties of the existing material items.

When you select an item in the display area, its properties automatically
populate the input fields.

The visible columns and details can be modified in the Edit Input Fields dialog
box.

(5) The navigation tree: allows you to only view specific items in the
requisition.
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Click + to expand and select options in the navigation tree. When you select an
option, only material items that match the selected properties are displayed in
the display area.

For example, you can expand Shape and select HSS to only display hollow
structural sections.

(6) Combining information grid: shows the pieces combined to the item that is
selected in the display area.

Note that you can see the number of pieces linked to Production Control in
the lower-right corner of the dialog box.

Modify a requisition
You can modify all properties of a requisition at any time, except for the
requisition number.

1. At the top of the Tekla EPM window, click the Purchasing button.

2. In the Select Requisition/Purchase Order dialog box, ensure that you
are on the Requisitions tab.

3. Select the requisition that you want to modify.

4. Click Edit.

5. On the General tab of the Requisition Edit dialog box, modify the
requisition properties according to your needs. 

The properties marked with an asterisk (*) are mandatory information.

Option Description
Requisition Date * The date of the requisition.

Tekla EPM automatically uses the current date. To
change the date, do one of the following:

• Type the date in the Requisition Date field.

The acceptable formats are YYYY/MM/DD,
YY/MM/DD, MM/DD/YYYY, and MM/DD/YY.

• Click the arrow on the right side of the
Requisition Date field and select a date in the
calendar.

Description Any description of the requisition.

Type a description in the Description field.
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Option Description
Requisition Group The groups where the requisition belongs to.

Setting requisition groups for the requisition helps
you to sort requisitions in the Select Requisition/
Purchase Order dialog box.

To set requisition groups, do one of the following:

• Type new requisition group names in the
Requisition Group fields.

• Click the arrows on the right side of the
Requisition Group fields, and select existing
requisition groups in the lists.

Item Increment Sets the auto-increment for item numbers in the
requisition.

The auto-increment allows the items to be added
in the list according to your needs, without having
to renumber the other items in the requisition.

For example, if items should be numbered as 10,
20, 30, ..., the input increment should be set to 10.
If the auto-increment of item numbers is not
necessary, type 1 in the Item Increment field.

6. On the Notes tab, modify the notes about the requisition.

7. Click the buttons at the bottom of the Requisition Edit dialog box to
adjust the combining optimizations, suppliers, and input and display units.

For more information, see:

• Define combining optimizations for requisitions (page 824)

• Define suppliers for requisitions (page 826)

• Define default input and display units for requisitions (page 824)

8. Click Save to update the requisition.

The Requisition Edit dialog box closes.

See also

Open a requisition (page 846)

Store document references for a requisition (page 849)

Delete requisitions (page 875)
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Store document references for a requisition
Document Index is where you can store documents for reference. When you
store documents in Document Index, each user that has access to the
requisition can view them, so it is easy to keep up to date on the requisition
status. You can save any documents, such as pricing quotes from vendors, and
Microsoft Outlook emails in Document Index.

To access Document Index, do the following:

1. At the top of the Tekla EPM window, click the Purchasing button.

2. In the Select Requisition/Purchase Order dialog box, ensure that you
are on the Requisitions tab.

3. Select the requisition for which you want to add document references.

4. Click Doc Ind.

The Document Index dialog box opens. Next, you can either modify the
available folders for document references, or add, modify, delete, open, and
email document reference files.

See also

Manage document reference categories (page 389)

Open a document reference (page 394)

Add document references (page 391)

Modify a document reference (page 395)

Attach a document reference to an email (page 396)

Delete a document reference (page 396)

Add a requisition item
Most items are added to requisitions by loading the material items from
combining, estimating, or production control jobs to requisitions. You can also
add new items to an open requisition manually.

1. In the Requisition # dialog box, click New.

2. Define the item properties. 

NOTE The visible input fields and their order can be modified in the
Input Fields dialog box that you can access via Maintenance -->
Requisitions --> Edit Input Fields .
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The properties marked with an asterisk (*) in the following table are
mandatory information.

Option Description
Item # * The number of the requisition item.

The Item # is automatically populated with the
next available item number, but you can modify
the item number according to your needs.

If necessary, type a new item number in the Item #
field.

Job # The number of the production control job to which
the material item is reserved.

Type the job number in the Job # field.
Quantity * The number of pieces to be added.

Use the numeric keypad in the quantity field to
add, multiply, divide, or subtract numbers to adjust
the quantity.

Shape * The material shape of each piece.

Either click the arrow on the right side of the
Shape field to select the shape, or type the shape
indicator in the field (for example, HSS).

Grade * The material grade of each piece.

Either click the arrow on the right side of the
Grade list to select the grade, or type the grade
indicator in the field.

Dimensions * The material dimension, or material size, of each
piece.

Click the Dimensions field to select an available
material dimension, and double-click the desired
dimension in the list.

TIP You can also use a custom material
dimension. Note that the dimension is not
automatically added to the material
database.

To use a custom dimension, do the following:

a. Click in the Dimensions field.

b. Click Add Size.

c. Define the dimension properties.
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Option Description

d. Click Save.

You can now select the dimension and use it.

Length The length of each piece.

Default length input settings are set in Company
Standards, but you can modify them for each job.

Base Price The base price of the material item. We
recommend that you use base prices to create
more detailed reports.

Type the base price in the Base Price field.

To change the base price units and convert the
current price to the selected units, right-click the
Base Price field, and select an appropriate option
in the context menu.

Reference Number The reference number that links the item to a
production control job.

The reference number can be different depending
on the case:

• If an item is sent from Production Control to
Purchasing or Inventory, Tekla EPM creates a
copy of the record, and the item is linked to
include the reference number.

• If an item is sent to purchasing from an
advance bill of materials, the reference number
is either the eventual mark number of the item,
or the page number along with the item
number.

• If the item is sent to purchasing later in the
process, the reference number is the mark or
piece mark number.

Date Required The date when the material item is due. Entering
the required date can be useful when creating
reports.

Do one of the following:

• Type the date in the Date Required field.

The acceptable formats are YYYY/MM/DD,
YY/MM/DD, MM/DD/YYYY, and MM/DD/YY.

• Click the arrow on the right side of the Date
Required field and select the date in the
calendar.
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Option Description
Date Promised The date when the supplier has promised to

deliver the material item. The Date Promised can
be useful in reports.

Do one of the following:

• Type the date in the Date Promised field.

The acceptable formats are YYYY/MM/DD,
YY/MM/DD, MM/DD/YYYY, and MM/DD/YY.

• Click the arrow on the right side of the Date
Promised field and select the date in the
calendar.

Mill Mark Any extra information about the item that the mill
has given you.

Type any information in the Mill Mark field.
Cost Code The cost code assigned to the item.

Click the arrow on the right side of the Cost Code
list, and select a cost code in the list.

For more information about cost codes, see
Create, modify, or delete cost codes (page 841).

Comment Any comments that you want to add about the
material item.

Type the comments in the Comment field.
PRC Supplier The supplier whose pricing the item uses.

To change the supplier, click the arrow on the right
side of the PRC Supplier list and select the
supplier in the list.

Lot # The lot identification number of the material item.

Type the lot number in the Lot # field.
Sequence The sequence number assigned to the item.

Type the sequence number in the Sequence field.
Category, Sub-Category A keyword used for sorting items in the

Requisition # dialog box. Categories and sub-
categories can be used for filtering information in
the Requisition # dialog box.

Type the desired keywords in the Category and
Sub-Category fields.

Purchasing Notes A longer description of the item. The Purchasing
Notes field can be useful for adding specifications
for buyout items.

3. Click Add.
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The new requisition item is added at the bottom of the requisition.

Note that if you added the new item while in the manual combine mode, the
item will belong to stock materials. The material items added in the manual
combine mode are marked with a C in the leftmost column.

See also

Copy a requisition item (page 854)

Modify a single requisition item (page 854)

Delete requisition items (page 859)

Copy a requisition item
You can copy a requisition item and use it as the basis of a similar item. By
copying items, you can save time and avoid entering the same information
multiple times in a requisition.

1. In the Requisition # dialog box, select the item that you want to copy.

2. At the bottom of the dialog box, click Copy. 

A copy of the item appears at the bottom of the requisition.

3. Adjust the properties of the new item according to your needs.

4. Click Edit to save the changes.

See also

Modify a single requisition item (page 854)

Modify requisition items
You can either modify items in requisitions one by one, or use the different
Global Edit commands to modify multiple items at one go.

For more information, see the following links:

Modify a single requisition item (page 854)

Modify multiple requisition items (page 855)

Modify the selected requisition items (page 856)

Modify the shape, grade, dimensions, or length of multiple requisition items
(page 857)

Modify the shape, grade, dimensions, or length of the selected requisition
items (page 858)
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Modify a single requisition item
You can modify the properties of requisition items one by one in the
Requisition # dialog box.

1. In the Requisition # dialog box, select the material item that you want to
modify.

2. On the right side of the dialog box, modify the properties of the item
according to your needs. 

For example, you can change the base price of the item or assign a cost
code to the item.

3. Click Save to update the item properties.

See also

Modify multiple requisition items (page 855)

Modify the selected requisition items (page 856)

Modify the shape, grade, dimensions, or length of multiple requisition items
(page 857)

Modify the shape, grade, dimensions, or length of the selected requisition
items (page 858)

Modify multiple requisition items
Use the Global Edit command to modify the properties of all or multiple
requisition items at one go. This way, you can save time, as you do not need to
change the properties of each item individually.

1. In the Requisition # dialog box, click the Requisition ribbon tab.

2. On the menu, select Global Edit --> Global Edit .

3. To only modify specific types of items, in the Requisition Global Edit
Filters dialog box, select a filter type in the Type list, and click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the items that you want to modify to
the Included list.

• Type the maximum and minimum values for the items that you want
to modify.

5. Click OK. 

To further limit the item types that you want to modify, repeat steps 3 to 5
for all necessary filter types.
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6. Modify the selected properties in the Global Edit dialog box according to
your needs. 

For example, you can change the category of the items by selecting an
option in the Category list, or type a comment for the items.

7. In the Global Edit dialog box, select check boxes next to the properties
that you want to update. 

You can also use the Un-check All and Check Changed Fields buttons to
quickly clear or select check boxes.

8. Click Update.

9. To confirm changing the properties of multiple items, click Yes in the
confirmation dialog box.

The changes you made to the item properties are updated to the Requisition
# dialog box.

See also

Modify a single requisition item (page 854)

Modify the selected requisition items (page 856)

Modify the shape, grade, dimensions, or length of multiple requisition items
(page 857)

Modify the shape, grade, dimensions, or length of the selected requisition
items (page 858)

Modify the selected requisition items
Use the Global Edit Selected command to modify the properties of the
selected items in the requisition. This way, you can save time, as you do not
need to change the properties of each item individually.

1. In the Requisition # dialog box, select the items that you want to modify. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Requisition ribbon tab.

3. On the menu, select Global Edit --> Global Edit Selected .

4. Modify the selected properties in the Global Edit dialog box according to
your needs. 

For example, you can change the category of the items by selecting an
option in the Category list, or type a comment for the items.

5. In the Global Edit dialog box, select check boxes next to the properties
that you want to update. 

You can also use the Un-check All and Check Changed Fields buttons to
quickly clear or select check boxes.
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6. Click Update.

The properties of the selected items are updated to the Requisition # dialog
box.

See also

Modify a single requisition item (page 854)

Modify multiple requisition items (page 855)

Modify the shape, grade, dimensions, or length of multiple requisition items
(page 857)

Modify the shape, grade, dimensions, or length of the selected requisition
items (page 858)

Modify the shape, grade, dimensions, or length of multiple requisition
items
Use the Global Edit By Shape command to modify the shape, grade,
dimensions, or length of all or multiple items in the Requisition # dialog box.

1. In the Requisition # dialog box, click the Requisition ribbon tab.

2. On the menu, select Global Edit --> Global Edit By Shape .

3. In the Shape list at the top of the Requisition Global Edit Filters dialog
box, select the shape.

4. To only modify specific types of items, select a filter type in the Type list,
and click Select.

5. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the items that you want to modify to
the Included list.

• Type the maximum and minimum values for the items that you want
to modify.

6. Click OK. 

To further limit the items that you want to modify, repeat steps 4 to 6 for
all necessary filter types.

7. Click OK.

8. Modify the selected properties in the Global Edit dialog box according to
your needs. 

For example, you can change the category of the items by selecting an
option in the Category list, or type a comment for the items.
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9. In the Global Edit dialog box, select check boxes next to the properties
that you want to update. 

You can also use the Un-check All and Check Changed Fields buttons to
quickly clear or select check boxes.

10. Click Update.

11. To confirm changing the properties of multiple items, click Yes in the
confirmation dialog box.

The properties of the selected items are updated to the Requisition # dialog
box.

See also

Modify a single requisition item (page 854)

Modify multiple requisition items (page 855)

Modify the selected requisition items (page 856)

Modify the shape, grade, dimensions, or length of the selected requisition
items (page 858)

Modify the shape, grade, dimensions, or length of the selected
requisition items
Use the Global Edit Selected By Shape command to modify the material
shape, grade, dimensions, or length of the selected items in an requisition.

1. In the Requisition # dialog box, select the items that you want to modify. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Requisition ribbon tab.

3. On the menu, select Global Edit --> Global Edit Selected By Shape .

4. Modify the selected properties in the Global Edit dialog box according to
your needs. 

For example, you can change the category of the items by selecting an
option in the Category list, or type a comment for the items.

5. In the Global Edit dialog box, select check boxes next to the properties
that you want to update. 

You can also use the Un-check All and Check Changed Fields buttons to
quickly clear or select check boxes.

6. Click Update.

The properties of the selected items are updated to the Requisition # dialog
box.

All other reference information of the items remains unchanged.
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See also

Modify a single requisition item (page 854)

Modify multiple requisition items (page 855)

Modify the selected requisition items (page 856)

Modify the shape, grade, dimensions, or length of multiple requisition items
(page 857)

Delete requisition items
You can delete any unnecessary items from the requisition. Note that deleting
requisition items is permanent and cannot be undone.

You can still see the deleted items in the list of changes. For more information,
see View all changes in a requisition (page 861).

1. In the Requisition # dialog box, select the requisition items that you want
to delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

Note that if the requisition item that you want to delete has been
combined, you first need to uncombine the item by clicking Uncombine.
The Delete button appears when the item has been uncombined.

2. At the bottom of the dialog box, click Delete.

3. To permanently delete the requisition items, click Yes in the confirmation
dialog box.

View the pricing history of a requisition item
Use the Purchase History command to view the pricing history of a material
item. You can filter the purchase history by various options, such as the
vendor, the requisition number, or the length.

1. In the Requisition # dialog box, select the material item whose pricing
history you want to view.

2. Click the Requisition ribbon tab.

3. On the menu, select Purchase History. 
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The Purchase Order History dialog box opens.

The top section of the dialog box allows you to filter the pricing history
information, whereas the bottom section shows the pricing history of the
material item.

4. If necessary, filter the pricing history by clicking arrows on the right side of
the different filter lists and selecting filtering options in the lists.

5. To update the pricing history to match the filters you set, click Load
History.

6. If you want to save the pricing history as a Microsoft Excel worksheet, do
the following:

a. Right-click anywhere in the display area of the Purchase Order
History dialog box.

b. In the context menu, select Export to Excel.

c. In the Save As dialog box, browse to the folder where you want to
save the file.

d. If necessary, change the file name.

e. Click Save.

If necessary, you can customize the layout of the Purchase Order History
dialog box to include only the when exporting the pricing history. For
more information, see Customize the layout of a dialog box (page 214).

7. To close the Purchase Order History dialog box, click the Close button
(X) in the upper-right corner.
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See also

View all changes in a requisition (page 861)

Update pricing information (page 869)

View all changes in a requisition
Tekla EPM records every change made in the system. This is useful because
you can view all changes made in the current requisition at once. You can filter
the information to see changes made by a particular user, or on a particular
date. You can also print the list of changes.

1. In the Requisition # dialog box, click the Requisition ribbon tab.

2. On the menu, select List Of Changes.

3. In the List Of Changes Report Filters dialog box, do any of the following: 

To Do this
Filter changes by user a. Select the User filter type and

click Select.

b. Click the arrow buttons to move
the users whose changes you
want to view to the Included list.

c. Click OK.
Filter changes by date a. Select the Transaction Date

filter type and click Select.

b. Do one of the following:

• Enter the start (Minimum)
and end (Maximum) dates.

• Select the Expression check
box for the start or end date.
Then, select the base date
and select how many more or
less days will be taken into
account.

c. Click OK.

4. Click Make Report.

5. In the Report Selection dialog box, do one of the following: 
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To Do this
View the list of changes • Click View.

The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF
buttons at the top of the Tekla EPM Report
Viewer window to email the report via Microsoft
Outlook.

Print the list of changes a. In the Report Selection dialog box, change
the number of the printed copies by clicking
the + and - buttons.

b. If necessary, click Select Printer, select which
device you want to use for printing, and click
OK.

You can also select Default Printer to always
use the default printer with this report, or No
Printer to reset the current printer.

c. Click Print.

d. Click Yes.
Export the list of
changes

a. Click Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Browse to the location where you want to save
the exported file, and click Save.

e. Modify the file name according to your needs.

f. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email check box.

g. To open the file after exporting it, select the
Open Exported Document check box.

h. Click Export.

6. To close the dialog box, click the Close button (X) in the upper-right
corner.

Load requisition items into a purchase order
Use the Load Material Into Purchase Order and Load Selected Material
Into Purchase Order commands to load material items from a requisition to
a purchase order. Use the Load Material Into Purchase Order command to
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load all requisition items into a purchase order, or use the Load Selected
Material Into Purchase Order command to select the items in a requisition
that are loaded into a purchase order. When you load material items into a
purchase order, the items become available in the inventory.

According to your needs, see any of the following instructions:

Load all items into a purchase order
1. In the Requisition # dialog box, click the Requisition ribbon tab.

2. On the menu, select Load Material Into Purchase Order.

3. In the Select Purchase Order dialog box, select a purchase order and
click OK. 

If necessary, you can also create a new purchase order and load the items
into it.

4. To only load specific types of items to the purchase order, in the
Purchasing Import Filters dialog box, select a filter type in the Type list,
and click Select.

5. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the properties of the items that you
want to load to the purchase order to the Included list.

• Type the maximum and minimum values for the items that you want
to load to the purchase order.

6. Click OK. 

To further limit which items are loaded to the purchase order, repeat
steps 4 to 6 for all necessary filter types.

7. Click Import.

8. Click OK to close the Import Items dialog box.

The material items are loaded to the selected purchase order, so they are no
longer visible in the Requisition # dialog box.

Load selected items into a purchase order
1. In the Requisition # dialog box, click the Requisition ribbon tab.

2. On the menu, select Load Selected Material Into Purchase Order.

3. In the Select Purchase Order dialog box, select a purchase order and
click OK. 

If necessary, you can also create a new purchase order and load the items
into it.
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4. In the Enter Value dialog box, type the quantity of pieces that you want to
load to the purchase order.

5. Click OK.

6. Click OK to close the Import Items dialog box.

Export a request for pricing
A request for pricing allows you to get pricing from multiple suppliers. Use the
Export Request for Pricing commands to save a request for pricing as an
Microsoft Excel worksheet or a steelXML file and send it to suppliers. You can
also attach the request for pricing to an email and send it to a supplier using
Microsoft Outlook. Once you receive responses, you can import the suppliers'
pricing information to Tekla EPM.

According to your needs, see any of the following instructions:

Save a request for pricing as a Microsoft Excel worksheet
1. In the Requisition # dialog box, click the Requisition ribbon tab.

2. On the menu, select Export Request for Pricing --> Export to Excel .

3. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla EPM saves the file to the Export folder.

4. If necessary, change the file name.

5. Click Save.

To modify the request for pricing in Microsoft Excel, see Modify pricing
information in Microsoft Excel (page 866).

Email a request for pricing as a Microsoft Excel worksheet
1. In the Requisition # dialog box, click the Requisition ribbon tab.

2. On the menu, select Export Request for Pricing --> Email Excel .

3. In the Select Contact dialog box, select the supplier, supplier code, and
contact person. 

Only companies whose type is set to Supplier and their contacts that are
saved in the Address Book are available.

Defining the information in the Select Contact dialog box is optional. You
can also define the information directly in the email when it is created.

4. In the Email field, type the email address of the contact person.

Manage requisitions and purchase orders 864 Create and manage requisitions



5. Click OK. 

Microsoft Outlook opens. The Microsoft Excel worksheet is attached to a
new email.

6. Modify the email according to your needs.

7. Send the email.

Save or email a request for pricing as an steelXML file
The Export to steelXML command works specifically with the steelXML
software. Use the Export to steelXML command to submit requests for
pricing to suppliers, so that the suppliers can give you prices that are specific
to the material information in the current requisition.

NOTE All items in the current requisition are included in the steelXML file
that is exported. If you need to submit some of the items to different
suppliers, you need to move those items to a different requisition.

1. In the Requisition # dialog box, click the Requisition ribbon tab.

2. On the menu, select Export Request for Pricing --> Export to steelXML .

3. In the Export Pricing dialog box, select the supplier, supplier code,
contact person, and the contact person's email address. 

Only companies whose type is set to Supplier and their contacts that are
saved in the Address Book are available.

Selecting options in the Export Pricing dialog box is optional.

4. If you want the supplier to combine the items on their available inventory
and provide the nesting results in the returned pricing, select the Request
Nested Results check box. 

If you have already combined the items within the requisition or if you are
ordering the items cut to length by the supplier, do not to select the
Request Nested Results check box.

5. According to your needs, do one of the following: 

To Do this
Save the steelXML file a. Click Export.

b. In the Save As dialog box, browse to the folder
where you want to save the file.

By default, Tekla EPM saves the file to the
Export folder.

c. If necessary, change the file name.

d. Click Save.

You can later send the steelXML file to suppliers
using your email service, if necessary.
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To Do this
Send the steelXML file by
email

a. In the Email field, type the email address of
the contact person.

b. Select the Attach to Email check box.

c. Click Export.

Microsoft Outlook opens. The steelXML file is
attached to a new email.

d. Modify the email according to your needs.

e. Send the email.

After the supplier has processed the file in steelXML and sent the file back to
you, you can import the steelXML results back to Tekla EPM. For detailed
instructions, see Import pricing information to a requisition (page 866).

Modify pricing information in Microsoft Excel
When you have saved or received a request for pricing as a Microsoft Excel
worksheet, you can modify the pricing in Microsoft Excel. After making the
changes, you or your client can import the pricing information back to Tekla
EPM.

1. In Microsoft Excel, type the prices for items in the Base Price column. 

To import the pricing information correctly, type the prices in the
following format: currency price/unit. For example, $56.99/CWT.

You only need to define the base prices of items. Tekla EPM calculates the
total price during the import.

2. If necessary, type the total prices for items in the Total Price field.

3. Save the Microsoft Excel worksheet.

See also

Export a request for pricing (page 864)

Import pricing information to a requisition (page 866)

Import pricing information to a requisition
Use the Import Requisition Pricing commands to import the pricing
information that you want to use in the current requisition from a steelXML
file or a Microsoft Excel worksheet. You can also import pricing from an email
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attachment that is either a Microsoft Excel worksheet or a steelXML file. New
pricing information can be imported multiple times, if necessary.

Note that if you want to re-use the imported pricing information later, you also
need to update the pricing information to a pricing database. For more
information, see Update pricing information (page 869).

Import pricing information from an Excel worksheet
1. In the Requisition # dialog box, click the Requisition ribbon tab.

2. On the menu, select Import Requisition Pricing --> Import Pricing From
Excel File .

3. In the Open dialog box, browse to find the worksheet from which you
want to import the pricing information.

4. Select the worksheet, and click Open. 

5. In the Verify Excel Import Data dialog box, verify that the information is
correct. 

If you want to exclude information on particular rows from being
imported, you can double-click the rows.

6. Click OK. 
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The Import Field Map dialog box opens. In the dialog box, the headings
of the Excel worksheet need to be mapped to the Tekla EPM standard
field headings.

7. If the values of an item in the Import Field and Tekla EPM Field columns
do not match or are not correct, do the following:

a. Select the unmatched Import Field value.

b. On the right side of the dialog box, select a suitable field in the Tekla
EPM Field list.

c. Click Set Field Mapping.

8. When you have mapped all fields together, click OK to continue.

9. In the Import dialog box, view the status of the import process. 

To view the import process as a text file, you can click Open Import Log.

10. To close the Import dialog box, click the Close button (X) in the upper-
right corner.

Import pricing information from an XML file
When you have received the steelXML results from a supplier, you can import
them to Tekla EPM.

1. In the Requisition # dialog box, click the Requisition ribbon tab.

2. On the menu, select Import Requisition Pricing --> Import Pricing From
steelXML File .

3. In the Open dialog box, browse to find the file from which you want to
import the pricing information.

4. Select the file, and click Open.
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5. In the Import dialog box, view the status of the import process. 

To view the import process as a text file, you can click Open Import Log.

6. To close the Import dialog box, click the Close button (X) in the upper-
right corner.

Import pricing information from an email attachment
Note that you can only import pricing information from email attachments if
you are using Microsoft Outlook.

1. In Microsoft Outlook, select the email whose attachments you want to
import.

2. In the Import dialog box, view the status of the import process. 

To view the import process as a text file, you can click Open Import Log.

3. To close the Import dialog box, click the Close button (X) in the upper-
right corner.

Update pricing information
Use the Update Pricing Maintenance command to update the pricing of
material items in a requisition to pricing maintenance as well. This way, the
pricing that you set in the requisition can be re-used in the future. You can
update the pricing information to either the global pricing or the estimate-
specific pricing.

1. In the Requisition # dialog box, select the material items whose current
pricing information you want to update. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. On the menu, select Update Pricing Maintenance. 
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3. In the Pricing Update dialog box, do one of the following: 

To Do this
Update pricing to the
global pricing

a. At the top of the dialog box, select the Update
Global Pricing option.

b. Click the arrow on the right side of the
Supplier to Update list and select the supplier
whose pricing information you want to
update.

Update pricing to the
estimate-specific pricing

a. At the top of the dialog box, select the Update
Estimate-Specific Pricing option.

b. Click the arrow on the right side of the
Estimate to Update list and select the
estimate whose pricing information you want
to update.

4. If you want to update the pricing of all material items within a previously
created global edit form, click the arrow on the right side of the Global
Edit Form list, and select the global edit form that you want to use.

5. Do one of the following to exclude items from being updated to the
pricing database:

• Select an item whose pricing information you do not want to update,
and click Exclude.
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• To exclude all items, click Exclude All.

You can re-include the excluded items by clicking the Include and Include
All buttons.

6. Click Update Pricing.

7. To confirm updating the pricing information, click Yes in the confirmation
dialog box.

The pricing information is updated to the selected location, and the Pricing
Update dialog box closes.

If the material shape, grade, or dimension does not exist in the pricing
maintenance database, it is added to the database when you update the
pricing.

See also

View the pricing history of a requisition item (page 859)

Combine items in the Requisition # dialog box
Use the Combine command to mult and nest requisition items. Combining
requisition items creates a list of materials that you can later send out for
pricing.

1. In the Requisition # dialog box, click the Requisition ribbon tab.

2. On the menu, select Combine. 

The Select Combining Run dialog box opens. When you are performing
the first combining run for a combining job, the list in the dialog box is
empty.

3. Click a desired combining option to select it. 

The options are:

• Mult: combines linear items, like beams and angles.

• Nest: combines items that have area, like plates or gratings.

• Mult & Nest: combines all items.

The Combining Run Filters dialog box opens.

NOTE Filtering items is optional, so you can skip steps 4 to 7 if you do
not want to filter out items from the combining run.

4. To only combine specific types of materials, select a filter type in the Type
list, and click Select.

5. In the Filter dialog box, do one of the following depending on the filter
type:
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• Click the arrow buttons to move the items that you want to combine to
the Included list.

• Type the maximum and minimum values for the items that you want
to combine.

6. Click OK to apply the filter. 

Repeat steps 4 to 6 for each filter type that you want to set.

7. To ensure that you are using the correct settings, click the Optimizations,
INV Filter, and Suppliers buttons. 

If necessary, you can modify the settings.

8. To combine the materials, click the button at the bottom of the
Combining Run Filters dialog box, or press F4.

• Piece mark items included with the selected stock lengths are displayed at
the lower-left section of the dialog box.

• Combining results are shown in both the display area and in the summary
grid at the lower-right section of the dialog box.

• The material cost represents the pricing of the materials in the pricing
database that was used in the combining run.

To save the combining run, click one of the following:

• Save Combining Run: saves the combining run as a snapshot that you can
later view by selecting it in the Select Combining Run dialog box. No cut
lists are generated.

• Save Displayed Results & Close: completes the requisition combining run,
saves the displayed combining run results, and returns to the Requisition
# dialog box.

The material items that were combined to existing inventory items are
removed from the requisition and disappear from the Requisition # dialog
box. The items that were combined to the supplier materials remain in the
requisition until you send the items to a purchase order.

See also

Combine requisition items manually (page 872)

Export materials for combining (page 78)

Combine requisition items manually
To combine the selected material lengths manually, you need to activate the
manual combine mode. You can then select pieces to combine them into a
specific material length, or uncombine pieces from a material length.

Note that you can only manually combine items that have been created
manually or by copying existing items in the manual combine mode. These
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items are marked with a C in the leftmost column of the Requisition # dialog
box.

1. In the upper-left corner of the Requisition # dialog box, click Manual
Combine Mode. 

The manual combine mode is activated.

2. Select the material item to which you want to combine new items.

3. At the bottom of the dialog box, click Add Items. 

The Add Item dialog box opens. You can see all available uncombined
materials that can be combined into the selected length.

Tekla EPM notifies you if there are no materials available to be combined.
In this case, you need to uncombine some previously combined material
items by selecting the items and clicking the Uncombine button at the
bottom of the Requisition # dialog box.

4. In the Add Item dialog box, click an uncombined item to select it.

5. If necessary, modify the quantity of inventory items that you are
combining materials to. 

If the quantity is greater than 1, the materials should be multiples of that
quantity in order to be displayed and selected in the Add Item dialog box.

6. To allow material grade substitutions, select the Use Grade Substitutions
check box.

7. Click Add.

The selected uncombined pieces are now combined into the selected material
item.

To return to input mode, click Input Mode in the upper-left corner of the
Requisition # dialog box.

See also

Combine items in the Requisition # dialog box (page 871)

View, print, or export requisition-specific reports
You can create various reports based on the current requisition. After creating
a report, you can view or print the report, or export the report and save it in
another file format.

To create requisition reports, do the following:

1. In the Requisition # dialog box, click the Requisition ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.
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3. To only include specific item types in the reports, in the Requisition
Report Filters dialog box, select a filter type in the Type list, and click
Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the item properties that you want to
include in the reports to the Included list.

• Type the maximum and minimum values for the item properties that
you want to include in the reports.

5. Click OK. 

To further limit the requisitions included in the reports, repeat steps 3 to 5
for all filter types.

6. Click Make Report.

7. In the Report Selection dialog box, select the report that you want to
view, print, or export.

According to your needs, see any of the following instructions:

View the report
• In the Report Selection dialog box, click View.

The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
EPM Report Viewer window to email the report via Microsoft Outlook.

Print the report
1. In the Report Selection dialog box, change the number of the printed

copies by clicking the + and - buttons.

2. Click Print.

3. To confirm printing the selected report, click Yes in the confirmation
dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the report
1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.
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4. Modify the file name according to your needs.

5. Browse to the location where you want to save the exported file, and click
Save.

6. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email check box.

7. To open the file after exporting it, select the Open Exported Document
check box.

8. In the Report Selection dialog box, click Export.

Delete requisitions
You can delete unnecessary requisitions in the Select Requisition/Purchase
Order dialog box.

NOTE When you delete a requisition, all material items in the requisition are
also deleted.

1. At the top of the Tekla EPM window, click the Purchasing button.

2. In the Select Requisition/Purchase Order dialog box, ensure that you
are on the Requisitions tab.

3. Select the requisitions that you want to delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

4. At the bottom of the dialog box, click Delete.

5. To permanently delete the requisitions, click Yes in the confirmation
dialog box.

10.3 Create and manage purchase orders
On the Purchase Orders part of the Purchasing module, you can create and
modify purchase orders and material items within the purchase orders.

We recommend that you plan the numbering of purchase orders carefully to
help you organize the purchase orders in the future.

You can also:

• Receive and un-receive materials.

• Filter the information displayed in the purchase order.

• Approve a purchase order, so that no further changes can be made.

• Finalize material items, so that no changes can be made to the items.
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• Un-finalize items to allow making changes to them again.

• Copy material items to another purchase order.

• View the pricing history of a material item.

• View the transaction history of a purchase order.

• View the heat documents attached to material items.

• View all changes made to a purchase order.

• Create purchase order reports and receiving reports, and view, print, or
export the created reports.

• Export purchase order information to a selected accounting software.

All material items on purchase orders are also visible in the inventory as items
that are on order.

For more information, see the following links:

Create a purchase order (page 877)

Open a purchase order (page 881)

Modify a purchase order (page 883)

Store document references for a purchase order (page 887)

Filter information in the PO # dialog box (page 887)

Add a purchase order item (page 888)

Copy a purchase order item (page 892)

Copy material items to another purchase order (page 893)

Modify purchase order items (page 893)

Receive purchase order items (page 898)

View heat documents attached to purchase order items (page 904)

Send purchase order items to a requisition (page 906)

Finalize purchase order items (page 908)

Delete purchase order items (page 909)

View all changes in a purchase order (page 910)

View the transaction history of a purchase order (page 912)

View the pricing history of a material item (page 906)

View, print, or export purchase orders and purchase order reports (page 914)

View, print, or export job-specific receiving reports (page 916)

Approve a purchase order (page 922)

Delete purchase orders (page 923)
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Create a purchase order
To create a new purchase order where material items can be stored, do the
following:

1. At the top of the Tekla EPM window, click the Purchasing button.

2. In the Select Requisition/Purchase Order dialog box, ensure that you
are on the Purchase Orders tab.

3. Click Add. 

4. On the General tab of the Purchase Order Edit dialog box, type the
purchase order number. 

We recommend that you plan the numbering of purchase orders carefully
to help you organize the purchase orders in the future. The purchase
order number cannot be changed later. All other purchase order
information can be modified later, if necessary.

5. Define the remaining general properties. 
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The properties marked with an asterisk (*) are mandatory information.

Option Description
P.O. Date * The date of the purchase order.

Tekla EPM automatically uses the current date. To
change the date, do one of the following:

• Type the date in the P.O. Date field.

The acceptable formats are YYYY/MM/DD,
YY/MM/DD, MM/DD/YYYY, and MM/DD/YY.

• Click the arrow on the right side of the P.O.
Date field and select a date in the calendar.

Reference # Type any reference number related to the
purchase order in the Reference # field.

Job Type any job number related to the purchase
order in the Job field.

Job Location Type any job location related to the purchase order
in the Job Location field.

Ordered By The Tekla EPM user in your company that created
the purchase order.

Click the arrow on the right side of the Ordered By
list, and select a user in the list.

P.O. Group The groups where the purchase order belongs to.

Setting purchase order groups for the purchase
order helps you to sort purchase orders in the
Select Requisition/Purchase Order dialog box.

To set purchase order groups, do one of the
following:

• Type new purchase order group names in the
P.O. Group fields.

• Click the arrows on the right side of the P.O.
Group fields, and select existing purchase
order groups in the lists.

Item Increment Sets the auto-increment for item numbers in the
purchase order.

The auto-increment allows the items to be added
in the list according to your needs, without you
having to renumber the other items in the
purchase order.

For example, if items should be numbered as 10,
20, 30, ..., the input increment should be set to 10.
If auto-increment of item numbers is not
necessary, type 1 in the Item Increment field.
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Option Description
P.O. Type The type of the purchase order.

The available options are set in PO Type
Maintenance. For more information, see Add,
modify, or delete purchase order types (page 836).

Click the arrow on the right side of the P.O. Type
list and select a type in the list.

Shipping Method The shipping method of the purchase order.

The available options are set in Purchase Order
Shipping Method Maintenance. For more
information, see Add, modify, and delete shipping
methods for purchase orders (page 837).

Click the arrow on the right side of the Shipping
Method list and select a method in the list.

F.O.B. The free on board shipping destination applied to
the purchase order.

The available options are set in Purchase Order
FOB Maintenance. For more information, see
Add, modify, or delete FOB shipping destinations
(page 838).

6. On the Vendor tab, select the vendor, the address, the contact person,
and the person with whom the purchase order has been confirmed. 

Note that only companies that are saved in the Address Book with the
firm type Supplier and their contact persons can be selected.

7. If you have added additional currencies to Tekla EPM, select the currency
and exchange rate date for the purchase order.

8. On the Ship To/Bill To tab, select the correct shipping and billing
addresses of your company. 

Note that only companies that are saved in the Address Book with the
Client or My Company company types can be selected.

If necessary, you can modify the information on the Ship To/Bill To tab
manually.

9. If necessary, click the arrows on the right side of the Inventory Location
and Secondary Location fields to define the inventory location of the
purchase order items.

10. On the Remarks tab, do either of the following:

• Click the arrows on the right side of the blank fields and select
previously created remarks in the lists.

• Type remarks in the blank fields.
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You can add up to four remarks. The available remark options are set in
the Purchase Order Remark Maintenance dialog box. For more
information, see Add, modify, or delete purchase order remarks
(page 840).

You can also set default remarks that are added for all new purchase
orders in the Purchase Order Company Standards dialog box. For more
information, see Define company standard settings for purchase orders
(page 831).

11. On the Top Text tab, to define which information you want to add at the
top of the purchase order, do either of the following:

• Click the arrow on the right side of the Description field, and select a
previously created top text item in the list.

The Top Text field is automatically populated.

• Type any necessary information in the Top Text field.

Note that any text you type manually in the Top Text is not saved, so it
cannot be re-used.

You can create top text items in the Purchase Order Top Text
Maintenance dialog box. For more information, see Add, modify, or
delete top text items (page 840).

You can also set default top text items that are added for all new
purchase orders in the Purchase Order Company Standards dialog box.
For more information, see Define company standard settings for purchase
orders (page 831).

12. On the Financial tab, define the freight and adjustment costs, the
payment terms, and the discount percentage used in the purchase order. 

The available payment term options are set in the Purchase Order
Payment Term Maintenance dialog box. For more information, see Add,
modify, or delete payment terms for purchase orders (page 839).

Note that the adjustment costs can also be negative.

13. If necessary, apply tax rates to the purchase order as follows:

a. On the Financial tab, click Tax Rates.

b. In the Select Tax Rates dialog box, click the arrow buttons to move
the tax rates that you want to apply to the purchase order to the
Included list.

c. Click OK.

You can create any necessary tax rates and tax groups by clicking the
Maintenance ribbon tab and selecting Tax Rates in the menu.

14. On the Other tab, add any applicable information to the blank fields. 

For example, you can add information about the maximum lift or the
unload instructions.
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15. If necessary, click the Input/Display Units button to adjust the units used
in the purchase order. 

For more information, see Define company standard settings for purchase
orders (page 831).

16. Click Save to create the purchase order.

The Purchase Order Edit dialog box closes, and the new purchase order is
added to the Select Requisition/Purchase Order dialog box.

See also

Open a purchase order (page 881)

Modify a purchase order (page 883)

Delete purchase orders (page 923)

Open a purchase order
To view and modify the material items in a purchase order, you need to open
the purchase order.

1. At the top of the Tekla EPM window, click the Purchasing button.

2. In the Select Requisition/Purchase Order dialog box, ensure that you
are on the Purchase Orders tab.

3. Select the purchase order that you want to open.

4. Do one of the following:

• At the bottom of the dialog box, click Open.

• Double-click the selected purchase order.
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The PO # dialog box opens:

(1) The summary grid: shows the following information number of purchase
order items, their length, square feet, weight, surface area, and cost for items.
These properties are shown for:

• a single piece of the selected item

• the selected items

• the currently displayed items

• the entire purchase order

(2) The mode switch button: the PO # dialog box has two modes: the input
mode and the receive mode. In the input mode, you can add new material
items and modify the existing ones. In the receive mode, you can mark
material items as received or rejected.

To change the mode, click the button in the upper-left corner.

(3) The display area: shows all material items in the purchase order.

The visible columns and details are set in the Display Fields dialog box. ou can
access the Display Fields dialog box via Maintenance --> Purchase Orders --
> Edit Display Fields .

You can also modify the visible columns and the dialog box layout by right-
clicking in the display area and selecting Customize grid in the context menu.

Note that a C in the leftmost column indicates that the material items have
been combined.
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(4) The input area: allows you to add properties for new material items and
modify properties of existing material items. You can mark material items as
received, rejected, or canceled.

When you select an item in the display area, its properties automatically
populate the input fields.

The visible columns and details are set in the Input Fields dialog box. You can
access the Input Fields dialog box via Maintenance --> Purchase Orders -->
Edit Input Fields .

(5) The navigation tree: allows you to only view specific items in the purchase
order.

Click + to expand and select options in the navigation tree. When you select an
option, only material items that match the selected properties are displayed in
the display area.

For example, you can expand Shape and select HSS to only display hollow
structural sections.

(6) Quantities received, rejected, and canceled: shows the material order
information of the item selected in the display area. You can view the quantity
of pieces that have been received, rejected, and canceled.

Modify a purchase order
You can modify all properties of a purchase order at any time, except for the
purchase order number.

1. At the top of the Tekla EPM window, click the Purchasing button.

2. In the Select Requisition/Purchase Order dialog box, ensure that you
are on the Purchase Orders tab.

3. Select the purchase order that you want to modify.

4. Click Edit.

5. On the General tab of the Purchase Order Edit dialog box, modify the
general properties. 

The properties marked with an asterisk (*) are mandatory information.

Option Description
P.O. Date * The date of the purchase order.

Tekla EPM automatically uses the current date. To
change the date, do one of the following:

• Type the date in the P.O. Date field.

The acceptable formats are YYYY/MM/DD,
YY/MM/DD, MM/DD/YYYY, and MM/DD/YY.
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Option Description
• Click the arrow on the right side of the P.O.

Date field and select a date in the calendar.
Reference # Type any reference number related to the

purchase order in the Reference # field.
Job Type any job number related to the purchase

order in the Job field.
Job Location Type any job location related to the purchase order

in the Job Location field.
Ordered By The Tekla EPM user in your company that created

the purchase order.

Click the arrow on the right side of the Ordered By
list, and select a user in the list.

P.O. Group The groups where the purchase order belongs to.

Setting purchase order groups for the purchase
order helps you to sort purchase orders in the
Select Requisition/Purchase Order dialog box.

To set purchase order groups, do one of the
following:

• Type new purchase order group names in the
P.O. Group fields.

• Click the arrows on the right side of the P.O.
Group fields, and select existing purchase
order groups in the lists.

Item Increment Sets the auto-increment for item numbers in the
purchase order.

The auto-increment allows the items to be added
in the list according to your needs, without you
having to renumber the other items in the
purchase order.

For example, if items should be numbered as 10,
20, 30, ..., the input increment should be set to 10.
If auto-increment of item numbers is not
necessary, type 1 in the Item Increment field.

P.O. Type The type of the purchase order.

The available options are set in PO Type
Maintenance. For more information, see Add,
modify, or delete purchase order types (page 836).

Click the arrow on the right side of the P.O. Type
list and select a type in the list.
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Option Description
Shipping Method The shipping method of the purchase order.

The available options are set in Purchase Order
Shipping Method Maintenance. For more
information, see Add, modify, and delete shipping
methods for purchase orders (page 837).

Click the arrow on the right side of the Shipping
Method list and select a method in the list.

F.O.B. The free on board shipping destination applied to
the purchase order.

The available options are set in Purchase Order
FOB Maintenance. For more information, see
Add, modify, or delete FOB shipping destinations
(page 838).

6. On the Vendor tab, select the vendor, the address, the contact person,
and the person with whom the purchase order has been confirmed. 

Note that only companies that are saved in the Address Book with the
firm type Supplier and their contact persons can be selected.

7. If you have added additional currencies to Tekla EPM, select the currency
and exchange rate date for the purchase order.

8. On the Ship To/Bill To tab, modify the shipping and billing addresses of
your company. 

Note that only companies that are saved in the Address Book with the
Client or My Company company types can be selected.

If necessary, you can modify the information on the Ship To/Bill To tab
manually.

9. If necessary, click the arrows on the right side of the Inventory Location
and Secondary Location fields to define the inventory location of the
purchase order items.

10. On the Remarks tab, do either of the following:

• Modify the remarks by typing in the fields.

• Click the arrows on the right side of the fields and select previously
created remarks in the lists.

You can add up to four remarks. The available remark options are set in
the Purchase Order Remark Maintenance dialog box. For more
information, see Add, modify, or delete purchase order remarks
(page 840).

11. On the Top Text tab, to modify the information that you want to add at
the top of the purchase order, do either of the following:
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• Click the arrow on the right side of the Description field, and select a
previously created top text item in the list.

The Top Text field is automatically populated.

• Type any necessary information in the Top Text field.

Note that any text you type manually in the Top Text is not saved, so it
cannot be re-used.

You can create top text items in the Purchase Order Top Text
Maintenance dialog box. For more information, see Add, modify, or
delete top text items (page 840).

You can also set default top text items that are added for all new
purchase orders in the Purchase Order Company Standards dialog box.
For more information, see Define company standard settings for purchase
orders (page 831).

12. On the Financial tab, modify the freight and adjustment costs, the
payment terms, and the discount percentage used in the purchase order. 

The available payment term options are set in the Purchase Order
Payment Term Maintenance dialog box. For more information, see Add,
modify, or delete payment terms for purchase orders (page 839).

Note that the adjustment costs can also be negative.

13. If necessary, modify the tax rates applied to the purchase order as
follows:

a. On the Financial tab, click Tax Rates.

b. In the Select Tax Rates dialog box, click the arrow buttons to move
the tax rates that you want to apply to the purchase order to the
Included list.

c. Click OK.

14. On the Other tab, modify the information to the blank fields. 

For example, you can add information about the maximum lift or the
unload instructions.

15. If necessary, click the Input/Display Units button to adjust the units used
in the purchase order. 

For more information, see Define company standard settings for purchase
orders (page 831).

16. Click Save to update the purchase order.

See also

Create a purchase order (page 877)

Open a purchase order (page 881)

Store document references for a purchase order (page 887)
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Delete purchase orders (page 923)

Store document references for a purchase order
Document Index is where you can store documents for reference. When you
store documents in Document Index, each user that has access to the
purchase order can view them, so it is easy to keep up to date on the purchase
order status. You can save any documents, such as packing slips and heat
documents, and Microsoft Outlook emails in Document Index.

NOTE You should always save heat documents in the Heat Documents
category in Document Index. The Heat Documents category differs
from other document categories in that it maintains a link to the heat
document for all items that share the same supplier, purchase order
number, and heat number.

To access Document Index, do the following:

1. At the top of the Tekla EPM window, click the Purchasing button.

2. In the Select Requisition/Purchase Order dialog box, ensure that you
are on the Purchase Orders tab.

3. Select the purchase order for which you want to add document
references.

4. Click Doc Ind.

The Document Index dialog box opens. Next, you can either modify the
available folders for document references, or add, modify, delete, open, and
email document reference files.

See also

Manage document reference categories (page 389)

Open a document reference (page 394)

Add document references (page 391)

Modify a document reference (page 395)

Attach a document reference to an email (page 396)

Delete a document reference (page 396)

Filter information in the PO # dialog box
Use the Filter command to create filters that are commonly used in the PO #
dialog box. For example, you can create filters to only display the items that
have been received. You can also save the filters for later use.

1. In the PO # dialog box, click the Purchase Order ribbon tab.
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2. On the menu, select Filter.

3. To filter the displayed items according to selected criteria, in the
Purchase Order Filters dialog box, select a filter type in the Type list, and
click Select. 

Note that if you have saved a filter in the Purchase Order Report Filters
dialog box when creating global receiving reports, the saved filter will also
be available as a filter in the PO # dialog box for all purchase orders.

4. In the Filter dialog box, click the arrow buttons to move the items that
you want to display to the Included list.

5. Click OK. 

If you want to further filter the information displayed in the PO # dialog
box, repeat steps 3 to 5 for different items.

If you want to clear all filter settings, click Reset.

6. To save commonly used filters, do the following:

a. Click Filter Types in the lower-left corner.

b. Click New.

c. Type a description for the filter type.

d. Create the filter settings. 

For more information, see steps 3 to 5.

e. Click Add.

f. To close the dialog box, click the Close button (X) in the upper-right
corner. 

The newly created filter type is selected in the Filter Types list.

g. To apply the filter type, click Set.

7. According to your needs, do one of the following:

• To use the filter, click Apply Filter.

• To use the filter in the job and save it until a new filter is set or the
filter is cleared, click Apply Filter & Save.

Note that the filter will remain in use even if you close and re-open the
job. After you clear the filters, the filter settings cannot be used again.

The Purchase Order Filters dialog box closes, and the PO # dialog box is
filtered according to the filter you applied.

TIP To display all information in the PO # dialog box again, click Clear Filters
at the top of the PO # dialog box.
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Add a purchase order item
Most items are added to purchase orders by loading the material items from
combining, estimating, or production control jobs to purchase orders. You can
also add new items to an open purchase order manually.

Note that all material items on purchase orders are also inventory items.

1. In the PO # dialog box, click New.

2. Define the item properties. 

NOTE The visible input fields and their order are set in the Input Fields
dialog box. To access the dialog box, go to Maintenance -->
Purchase Orders --> Edit Input Fields .

The properties marked with an asterisk (*) in the following table are
mandatory information.

Option Description
Requisition # The number of the requisition from which the item

was loaded to the purchase order, or the
requisition which the item can be sent back to, if
necessary.

Type the requisition number in the Requisition #
field.

Item # * The number of the purchase item.

The Item # is automatically populated with the
next available item number, but you can modify
the item number according to your needs.

If necessary, type a new item number in the Item #
field.

Job # The number of the production control job the
material item is reserved to.

Type the job number in the Job # field.
Quantity * The number of pieces to be added.

Use the numeric keypad in the quantity field to
add, multiply, divide, or subtract numbers to adjust
the quantity.

Shape * The material shape of each piece.

Either click the arrow on the right side of the
Shape field to select the shape, or type the shape
indicator in the field (for example, HSS).
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Option Description
Grade * The material grade of each piece.

Either click the arrow on the right side of the
Grade list to select the grade, or type the grade
indicator in the field.

Dimensions * The material dimension, or material size, of each
piece.

Click the Dimensions field to select an available
material dimension, and double-click the desired
dimension in the list.

TIP You can also use a custom material
dimension. Note that the dimension is not
automatically added to the material
database.

To use a custom dimension, do the following:

a. Click in the Dimensions field.

b. Click Add Size.

c. Define the dimension properties.

d. Click Save.

You can now select the dimension and use it.

Length The length of each piece.

Default length input settings are set in Company
Standards, but you can modify them for each job.

Base Price The base price of the material item. We
recommend that you use base prices to create
more detailed reports.

Type the base price in the Base Price field.

To change the base price units and convert the
current price to the selected units, right-click the
Base Price field, and select an appropriate option
in the context menu.

Reference Number The reference number that links the item to a
production control job.

The reference number can be different depending
on the case:

• If an item is sent from Production Control to
Purchasing or Inventory, Tekla EPM creates a
copy of the record, and the item is linked to
include the reference number.
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Option Description
• If an item is sent to purchasing from an

advance bill of materials, the reference number
is either the eventual mark number of the item,
or the page number along with the item
number.

• If the item is sent to purchasing later in the
process, the reference number is the mark or
piece mark number.

Date Required The date when the material item is due. Entering
the required date can be useful when creating
reports.

Do one of the following:

• Type the date in the Date Required field.

The acceptable formats are YYYY/MM/DD,
YY/MM/DD, MM/DD/YYYY, and MM/DD/YY.

• Click the arrow on the right side of the Date
Required field and select the date in the
calendar.

Date Promised The date when the supplier has promised to
deliver the material item. The Date Promised can
be useful in reports.

Do one of the following:

• Type the date in the Date Promised field.

The acceptable formats are YYYY/MM/DD,
YY/MM/DD, MM/DD/YYYY, and MM/DD/YY.

• Click the arrow on the right side of the Date
Promised field and select the date in the
calendar.

Mill Mark The mill mark that identifies the mill that produced
the steel. The mill mark usually consists of 4 letters
that are rolled into the material.

Type the mill mark in the Mill Mark field.
Cost Code The cost code assigned to the item.

Click the arrow on the right side of the Cost Code
list, and select a cost code in the list.

Comment Any comments that you want to add about the
material item.

Type the comments in the Comment field.
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Option Description
PRC Supplier The supplier warehouse whose pricing the item

uses.

To change the supplier, click the arrow on the right
side of the PRC Supplier list and select the
supplier in the list.

The PRC Unit Cost, PRC Cost, and PRC Date fields
are updated to show details about the pricing of
the selected pricing supplier.

Lot # The lot identification number of the material item.

The Lot # field is automatically populated by the
linked items in Production Control.

Sequence The sequence number assigned to the item.

The Sequence field is automatically populated by
the linked items in Production Control.

Category, Sub-Category A keyword used for sorting items in the PO #
dialog box. Categories and sub-categories can be
used for filtering information in the PO # dialog
box.

The Category and Sub-Category fields are
automatically populated by the linked items in
Production Control.

Purchasing Notes A longer description of the item. The Purchasing
Notes field can be useful for adding specifications
for buyout items.

3. Click Add.

The new material item is added at the end of the purchase order.

See also

Copy a purchase order item (page 892)

Modify purchase order items (page 893)

Receive purchase order items (page 898)

Send purchase order items to a requisition (page 906)

Finalize purchase order items (page 908)

Delete purchase order items (page 909)
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Copy a purchase order item
You can copy a purchase order item and use it as the basis of a similar item.
By copying items, you can save time and avoid entering the same information
multiple times in a purchase order.

1. In the PO # dialog box, select the item that you want to copy.

2. At the bottom of the dialog box, click Copy. 

A copy of the item appears at the bottom of the purchase order.

3. Adjust the properties of the new item according to your needs.

4. Click Edit to save the changes.

Copy material items to another purchase order
Use the Copy Selected to Another Purchase Order command to copy a
group of material items from one purchase order to another. When material
items are copied, the original items still remain in the current purchase order.

1. In the PO # dialog box, select the items that you want to copy. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Purchase Order ribbon tab.

3. On the menu, select Copy Selected to Another Purchase Order.

4. In the Select Purchase Order dialog box, select the purchase order to
which you want to copy the items. 

You can also create a new purchase order and copy the items to the new
purchase order. For more information, see Create a purchase order
(page 877).

5. Click OK.

The material items are copied to the selected purchase order.

See also

Copy a purchase order item (page 892)

Modify purchase order items
You can either modify items in purchase orders one by one, or use the
different Global Edit commands to modify multiple items at one go.

For more information, see the following links:

Modify a single purchase order item (page 894)

Modify multiple purchase order items (page 894)
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Modify the selected purchase order items (page 895)

Modify the shape, grade, dimensions, or length of multiple purchase order
items (page 896)

Modify the shape, grade, dimensions, or length of the selected purchase order
items (page 897)

Modify a single purchase order item
You can modify the properties of purchase order items one by one in the PO #
dialog box.

1. In the PO # dialog box, select the material item that you want to modify.

2. On the right side of the dialog box, modify the properties of the item
according to your needs. 

For example, you can change the base price of the item or assign a cost
code to the item.

3. Click Save to update the item properties.

See also

Modify multiple purchase order items (page 894)

Modify the selected purchase order items (page 895)

Modify the shape, grade, dimensions, or length of multiple purchase order
items (page 896)

Modify the shape, grade, dimensions, or length of the selected purchase order
items (page 897)

Modify multiple purchase order items
Use the Global Edit command to modify the properties of all or multiple
purchase order items at one go. This way, you can save time, as you do not
need to change the properties of each item individually.

1. In the PO # dialog box, click the Purchase Order ribbon tab.

2. On the menu, select Global Edit --> Global Edit .

3. To only modify specific types of items, in the Purchase Order Global Edit
Filters dialog box, select a filter type in the Type list, and click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the items that you want to modify to
the Included list.

• Type the maximum and minimum values for the items that you want
to modify.
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5. Click OK. 

To further limit the item types that you want to modify, repeat steps 2 to 5
for all necessary filter types.

6. Modify the selected properties in the Global Edit dialog box according to
your needs. 

For example, you can change the category of the items by selecting an
option in the Category list, or type a comment for the items.

7. In the Global Edit dialog box, select check boxes next to the properties
that you want to update. 

You can also use the Un-check All and Check Changed Fields buttons to
quickly clear or select check boxes.

8. Click Update.

9. To confirm changing the properties of multiple items, click Yes in the
confirmation dialog box.

The changes you made to the item properties are updated to the PO # dialog
box.

See also

Modify a single purchase order item (page 894)

Modify the selected purchase order items (page 895)

Modify the shape, grade, dimensions, or length of multiple purchase order
items (page 896)

Modify the shape, grade, dimensions, or length of the selected purchase order
items (page 897)

Modify the selected purchase order items
Use the Global Edit Selected command to modify the properties of the
selected items in the purchase order. This way, you can save time, as you do
not need to change the properties of each item individually.

1. In the PO # dialog box, select the items that you want to modify. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Purchase Order ribbon tab.

3. On the menu, select Global Edit --> Global Edit Selected .

4. Modify the selected properties in the Global Edit dialog box according to
your needs. 

For example, you can change the category of the items by selecting an
option in the Category list, or type a comment for the items.
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5. In the Global Edit dialog box, select check boxes next to the properties
that you want to update. 

You can also use the Un-check All and Check Changed Fields buttons to
quickly clear or select check boxes.

6. Click Update.

The properties of the selected items are updated to the PO # dialog box.

See also

Modify a single purchase order item (page 894)

Modify multiple purchase order items (page 894)

Modify the shape, grade, dimensions, or length of multiple purchase order
items (page 896)

Modify the shape, grade, dimensions, or length of the selected purchase order
items (page 897)

Modify the shape, grade, dimensions, or length of multiple purchase
order items
Use the Global Edit By Shape command to modify the shape, grade,
dimensions, or length of all or multiple items in the dialog PO # box.

1. In the PO # dialog box, click the Purchase Order ribbon tab.

2. On the menu, select Global Edit --> Global Edit By Shape .

3. In the Shape list at the top of the Purchase Order Global Edit Filters
dialog box, select the shape.

4. To only modify specific types of items, select a filter type in the Type list,
and click Select.

5. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the items that you want to modify to
the Included list.

• Type the maximum and minimum values for the items that you want
to modify.

6. Click OK. 

To further limit the items that you want to modify, repeat steps 4 to 6 for
all necessary filter types.

7. Click OK.

8. Modify the selected properties in the Global Edit dialog box according to
your needs. 

For example, you can change the category of the items by selecting an
option in the Category list, or type a comment for the items.
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9. In the Global Edit dialog box, select check boxes next to the properties
that you want to update. 

You can also use the Un-check All and Check Changed Fields buttons to
quickly clear or select check boxes.

10. Click Update.

11. To confirm changing the properties of multiple items, click Yes in the
confirmation dialog box.

The selected item properties are updated to the PO # dialog box.

See also

Modify a single purchase order item (page 894)

Modify multiple purchase order items (page 894)

Modify the selected purchase order items (page 895)

Modify the shape, grade, dimensions, or length of the selected purchase order
items (page 897)

Modify the shape, grade, dimensions, or length of the selected
purchase order items
Use the Global Edit Selected By Shape command to modify the material
shape, grade, dimensions, or length of the selected items in a purchase order.

1. In the PO # dialog box, select the items that you want to modify. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Purchase Order ribbon tab.

3. On the menu, select Global Edit --> Global Edit Selected By Shape .

4. Modify the selected properties in the Global Edit dialog box according to
your needs. 

For example, you can change the category of the items by selecting an
option in the Category list, or type a comment for the items.

5. In the Global Edit dialog box, select check boxes next to the properties
that you want to update. 

You can also use the Un-check All and Check Changed Fields buttons to
quickly clear or select check boxes.

6. Click Update.

The properties of the selected items are updated to the PO # dialog box.

All other reference information of the items remains unchanged.
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See also

Modify a single purchase order item (page 894)

Modify multiple purchase order items (page 894)

Modify the selected purchase order items (page 895)

Modify the shape, grade, dimensions, or length of multiple purchase order
items (page 896)

Receive purchase order items
You should mark all purchase order items that have been delivered as
received in the PO # dialog box. You can receive material items with or without
attaching heat documents or mill certifications to the items. Use the Receive
command to select the items that you want to receive and attach heat
documents to the items, or the Receive Displayed command to receive all
items currently displayed in the PO # dialog box without attaching heat
documents.

Receive specific items and attach heat documents
1. In the upper-left corner of the PO # dialog box, ensure that you are in the

receive mode. 

If not, click the Receive Mode button to activate the receive mode.

2. Select the items that you want to receive.

3. At the bottom of the dialog box, click Receive. 
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4. In the Receive dialog box, define the properties of the received items. 

Note that the available fields in the Receive dialog box are set on the
Receiving tab of the Purchase Order Company Standards dialog box.

Option Description
Date The date when the items were received.

Tekla EPM automatically uses the current date.

To change the date, do one of the following:

• Type the date in the Date field.

The acceptable formats are YYYY/MM/DD,
YY/MM/DD, MM/DD/YYYY, and MM/DD/YY.

• Click the arrow on the right side of the Date
field and select a date in the calendar.

Quantity The quantity of the pieces that are received. If
multiple items are received at once, the Quantity
field is unavailable and all pieces of the items are
received at once.

Type the quantity of the pieces in the Quantity
field.

Substitute Grade When selected, you can select a substitute grade
for the purchase order item. When cleared, Tekla
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Option Description
EPM always uses the original grade of the item
instead of a substitute grade.

If necessary, select the Substitute Grade check
box, and click the arrow on the right side of the
related field to select the substitute grade.

Inventory Location The inventory location of the material items.

Click the arrow on the right side of the Location
field and select a location in the list, or type a new
location in the Location field.

Secondary Loc The secondary inventory location of the material
items.

Click the arrow on the right side of the Secondary
Loc field and select a location in the list, or type a
new secondary location in the Secondary Loc field.

For example, you can use secondary locations to
represent different inventory sites.

Bill of Lading # The bill of lading number or the shipment number
that the material items were received on.

Type the number in the B/L # field.
Heat Number The heat number of the material items.

Type the heat number in the Heat # field.

Note that you need to type a heat number for a
material item before attaching documents to it in
Document Index.

Heat SN A property that ensures that heat numbers are not
duplicated. However, duplications are extremely
rare, so using the Heat SN field is optional.

If necessary, type a value in the Heat SN field.
Country of Origin The country of origin of the material items.

Click the arrow on the right side of the Country
field, and select a country in the list.

Finalize on Receive When selected, the received material items are
finalized when you receive them. This means that
you cannot make further changes to the items.

If material items are received but not finalized, the
item quantity changes to zero to update the
inventory records.

5. If necessary, you can attach heat documents to the items. Do the
following:

a. On the right side of the Heat Number dialog box, click Add Doc.
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b. Do any of the following: 

• In the Document Index - Add Document Reference dialog box,
click Add File.

• Drag and drop the heat document to the Document Index - Add
Document Reference dialog box.

If you drag and drop the heat document to the Document Index -
Add Document Reference dialog box, skip steps c and d.

c. In the Open dialog box, browse to find the document that you want
to add, and select the document.

d. Click Open. 

If you want to add more documents with the same settings, click Add
Additional File and repeat steps 4 to 6 for each document.

e. In the Add File dialog box, select the company and contact that
provided you with the document in the File Source lists.

f. According to your needs, do one of the following: 

• To compress multiple documents into one archive, select the
Compress Files into a Single Archive option.

• To leave the documents you added uncompressed, select the
Leave Files Uncompressed option.

g. According to your needs, do one of the following: 

• To move the original document to the selected folder, select the
Move File option.

• To copy the document to the selected folder but leave the original
untouched, select the Copy File (Leave Original) option.

h. Type a description for the documents you added.

i. Click Add File.

j. Type a description for the entire document reference. 

This description applies to all documents, emails, and email
attachments that you add.

k. Click Add Document Reference.

l. To close the Document Index - Add Document Reference dialog
box, click the Close button (X) in the upper-right corner.

6. In the Receive dialog box, click Receive.

The selected items are marked as received and have the selected heat
documents attached to them.
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Receive all displayed items without attaching heat documents
Note that any applied filters affect which items are displayed in the PO #
dialog box. For more information, see Filter information in the PO # dialog box
(page 887).

1. In the upper-left corner of the PO # dialog box, ensure that you are in the
receive mode. 

If not, click the Receive Mode button to activate the receive mode.

2. At the bottom of the dialog box, click Receive Displayed.

3. In the Receive dialog box, define the properties of the received items. 

Note that the available fields in the Receive dialog box are set on the
Receiving tab of the Purchase Order Company Standards dialog box.

Option Description
Date The date when the items were received.

Tekla EPM automatically uses the current date.

To change the date, do one of the following:

• Type the date in the Date field.

The acceptable formats are YYYY/MM/DD,
YY/MM/DD, MM/DD/YYYY, and MM/DD/YY.

• Click the arrow on the right side of the Date
field and select a date in the calendar.

Quantity The quantity of the pieces that are received. If
multiple items are received at once, the Quantity
field is unavailable and all pieces of the items are
received at once.

Type the quantity of the pieces in the Quantity
field.

Substitute Grade When selected, you can select a substitute grade
for the purchase order item. When cleared, Tekla
EPM always uses the original grade of the item
instead of a substitute grade.

If necessary, select the Substitute Grade check
box, and click the arrow on the right side of the
related field to select the substitute grade.

Inventory Location The inventory location of the material items.

Click the arrow on the right side of the Location
field and select a location in the list, or type a new
location in the Location field.
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Option Description
Secondary Loc The secondary inventory location of the material

items.

Click the arrow on the right side of the Secondary
Loc field and select a location in the list, or type a
new secondary location in the Secondary Loc field.

For example, you can use secondary locations to
represent different inventory sites.

Bill of Lading # The bill of lading number or the shipment number
that the material items were received on.

Type the number in the B/L # field.
Heat Number The heat number of the material items.

Type the heat number in the Heat # field.

Note that you need to type a heat number for a
material item before attaching documents to it in
Document Index.

Heat SN A property that ensures that heat numbers are not
duplicated. However, duplications are extremely
rare, so using the Heat SN field is optional.

If necessary, type a value in the Heat SN field.
Country of Origin The country of origin of the material items.

Click the arrow on the right side of the Country
field, and select a country in the list.

Finalize on Receive When selected, the received material items are
finalized when you receive them. This means that
you cannot make further changes to the items.

4. Click Receive.

All items that are currently displayed in the PO # dialog box are marked as
received.

Unreceive purchase order items
Use the Un-Receive command to cancel receiving any items that you have
accidentally marked as received.

Note that only items that have been marked as received can be unreceived.

1. In the upper-left corner of the PO # dialog box, ensure that you are in the
receive mode. 

If not, click the Receive Mode button to activate the receive mode.

2. Select the purchase order item that you want to unreceive.

3. Click the Purchase Order ribbon tab.
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4. On the menu, select Un-Receive.

5. In the Un-Receive dialog box, type the quantity of items that you want to
unreceive.

6. Click Un-Receive.

See also

Receive purchase order items (page 898)

View heat documents attached to purchase order items
Use the Check Heat Documents command to view the heat documents
attached to the purchase order items. You can also save or print the available
heat documents, or create reports on the items that have or do not have heat
documents attached to them.

1. In the PO # dialog box, click the Purchase Order ribbon tab.

2. On the menu, select Check Heat Documents. 

The Check Heat Documents dialog box opens.

Note that if the purchase order items do not have heat documents
attached to them, the Docs column is highlighted with red.

Manage requisitions and purchase orders 904 Create and manage purchase orders



3. In the Check Heat Documents dialog box, do any of the following: 

To Do this
Update heat document
information

• Click Refresh.

Any new or modified information is updated.
Add, modify, and delete
heat documents in
Document Index

a. Click Open Document Index.

Document Index opens. For more information,
see Store document references for the inventory
(page 455).

Save heat documents a. Do one of the following:

• To only save particular heat documents,
click the item whose documents you want
to save, and click Save Documents -->
Save Documents - Selected .

• To save all available heat documents, click
Save Documents --> Save Documents -
All .

b. In the Browse For Folder dialog box, browse
to an empty folder where you want to save the
heat document information.

c. Click OK.

A report of the heat documents opens.
Print heat documents a. Do one of the following:

• To only print particular heat documents,
click the items whose documents you want
to print, and click Print Documents -->
Print Documents - Selected .

• To print all available heat documents, click
Print Documents --> Print Documents -
All .

b. In the Select Printer dialog box, click a printer
to select it.

c. Click OK.

All or the selected heat documents are printed.
Create reports a. Do one of the following:

• To create a report only containing
particular items, click the items to select
them, and click Reports --> Reports -
Selected .

• To create a report containing all items, click
Reports --> Reports - All .

Manage requisitions and purchase orders 905 Create and manage purchase orders



To Do this
b. In the Report Selection dialog box, click the

report that you want to create.

c. Do one of the following:

• To view the report, click View.

• To print the report, change the number of
copies by clicking the + and - buttons, and
click Print.

• To export the report, click Export, modify
the export format, file name, and location,
and click Export again.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Store document references for a purchase order (page 887)

Send purchase order items to a requisition
Use the Send to REQ command to send purchase order items back to
requisitions. Note that only items that have not yet been received can be sent
back to a requisition. The items need to have the correct requisition numbers
defined in their Requisition # fields, so that Tekla EPM knows which
requisition it should be returned to.

1. In the PO # dialog box, select the material items that you want to send
back to a requisition. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. At the bottom of the dialog box, click Send to REQ.

3. To confirm returning the items to the requisition, click Yes in the
confirmation dialog box.

The selected items are returned to the requisition. These items are no longer
displayed in the PO # dialog box.

See also

Load requisition items into a purchase order (page 862)
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View the pricing history of a material item
Use the Purchase History command to view the pricing history of a material
item. You can filter the purchase history by various options, such as the
vendor, the requisition number, or the length.

1. In the PO # dialog box, select the item whose pricing history you want to
view.

2. Click the Purchase Order ribbon tab.

3. On the menu, select Purchase History. 

The Purchase Order History dialog box opens.

The top section of the dialog box allows you to filter the pricing history
information, whereas the bottom section shows the pricing history of the
material item.

4. If necessary, filter the pricing history by clicking arrows on the right side of
the different filter lists and selecting filtering options in the lists.

5. To update the pricing history to match the filters you set, click Load
History.

6. If you want to save the pricing history as a Microsoft Excel worksheet, do
the following:

a. Right-click anywhere in the display area of the Purchase Order
History dialog box.

b. In the context menu, select Export to Excel.

c. In the Save As dialog box, browse to the folder where you want to
save the file.
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d. If necessary, change the file name.

e. Click Save.

If necessary, you can customize the layout of the Purchase Order History
dialog box to include only the when exporting the pricing history. For
more information, see Customize the layout of a dialog box (page 214).

7. To close the Purchase Order History dialog box, click the Close button
(X) in the upper-right corner.

See also

View all changes in a purchase order (page 910)

Finalize purchase order items
Use the Finalize Selected Items and Finalize Displayed Items commands to
finalize purchase order items, so that no further can changes can be made to
the items. The Finalize Selected Items command finalizes the material items
that are currently selected in the PO # dialog box. The Finalize Displayed
Items finalizes the material items that are currently filtered to be shown in the
PO # dialog box.

If material items are received but not finalized, the item quantity changes to
zero to update the inventory records. When the purchase order items are
finalized, the link between the purchase order and the inventory is irreversibly
broken. Even if the items are later unfinalized, they are no longer linked to the
inventory.

Finalize the selected purchase order items
1. In the PO # dialog box, select the items that you want to finalize. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Purchase Order ribbon tab.

3. On the menu, select Finalize Selected Items.

4. To confirm finalizing the items, click Yes in the confirmation dialog box.

The selected items are finalized.

Note that the letter F appears in the leftmost column of the PO # dialog box to
indicate that the items are finalized.

If you need to make changes to finalized material items, you can unfinalize the
items. For more information Unfinalize purchase order items (page 909).
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Finalize all displayed purchase order items
To change which items are displayed in the PO # dialog box, see Filter
information in the PO # dialog box (page 887).

1. In the PO # dialog box, click the Purchase Order ribbon tab.

2. On the menu, select Finalize Displayed Items.

3. To confirm finalizing the items, click Yes in the confirmation dialog box.

The displayed items are finalized.

Note that the letter F appears in the leftmost column of the PO # dialog box to
indicate that the items are finalized.

If you need to make changes to finalized material items, you can unfinalize the
items. For more information Unfinalize purchase order items (page 909).

Unfinalize purchase order items
Use the Un-Finalize command to cancel finalizing purchase order items, so
that you can make any necessary changes to the items.

Note that when purchase order items are finalized, the link between the
purchase order and the inventory is irreversibly broken. Even if you unfinalize
the items, they are no longer linked to the inventory.

1. In the upper-left corner of the PO # dialog box, ensure that you are in the
receive mode. 

If not, click the Receive Mode button to activate the receive mode.

2. Select the items that you want to unfinalize.

3. On the File menu, select Un-Finalize.

4. To confirm unfinalizing the items, click Yes in the confirmation dialog box.

The selected items are unfinalized.

Note that the letter F has disappeared from the leftmost column of each item
in the PO # dialog box.

You can now make changes to the items according to your needs.

See also

Finalize purchase order items (page 908)
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Delete purchase order items
You can delete unnecessary purchase order items at any point. Note that
deleting items from a purchase is permanent and cannot be undone.

You can still see the deleted items in the list of changes and in the transaction
history. For more information, see View all changes in a purchase order
(page 910) and View the transaction history of a purchase order (page 912).

1. In the PO # dialog box, select the items that you want to delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. At the bottom of the dialog box, click Delete.

3. To permanently delete the items, click Yes in the confirmation dialog box.

The items are deleted from the purchase order.

View all changes in a purchase order
Tekla EPM records every change made in the system. This is useful because
you can view all changes made in the current purchase order at once. You can
filter the information to see changes made by a particular user, or on a
particular date. You can also print the list of changes.

1. In the PO # dialog box, click the Purchase Order ribbon tab.

2. On the menu, select List Of Changes.

3. In the List Of Changes Report Filters dialog box, do any of the following: 

To Do this
Filter changes by user a. Select the User filter type and

click Select.

b. Click the arrow buttons to move
the users whose changes you
want to view to the Included list.

c. Click OK.
Filter changes by date a. Select the Transaction Date

filter type and click Select.

b. Do one of the following:

• Enter the start (Minimum)
and end (Maximum) dates.

• Select the Expression check
box for the start or end date.
Then, select the base date
and select how many more or
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To Do this
less days will be taken into
account.

c. Click OK.

4. Click Make Report.

5. In the Report Selection dialog box, do one of the following: 

To Do this
View the list of changes • Click View.

The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF
buttons at the top of the Tekla EPM Report
Viewer window to email the report via Microsoft
Outlook.

Print the list of changes a. In the Report Selection dialog box, change
the number of the printed copies by clicking
the + and - buttons.

b. If necessary, click Select Printer, select which
device you want to use for printing, and click
OK.

You can also select Default Printer to always
use the default printer with this report, or No
Printer to reset the current printer.

c. Click Print.

d. Click Yes.
Export the list of
changes

a. Click Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Browse to the location where you want to save
the exported file, and click Save.

e. Modify the file name according to your needs.

f. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email check box.

g. To open the file after exporting it, select the
Open Exported Document check box.

h. Click Export.

6. To close the dialog box, click the Close button (X) in the upper-right
corner.
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See also

View the pricing history of a material item (page 906)

View the transaction history of a purchase order
Use the Transaction History dialog box to view all transactions in a purchase
order. You can also view further transaction details and item history, and view
or print different transaction history reports.

1. In the PO # dialog box, click the Purchase Order ribbon tab.

2. On the menu, select Transaction History. 

The Transaction History dialog box opens on the Transaction List tab.

3. To filter the displayed transactions, use the fields in the Estimating
Filters section of the dialog box:

a. Click Edit next to a filtering option. 

The available filtering criteria are the transaction date, the name of
the user that made the transaction, the transaction type, and the
operation type.

b. Do one of the following: 

• For transaction date, enter the start and end dates to define a
range within which the transactions have taken place.

• For user, transaction type, and operation type, use the arrow
buttons to move the desired items to the Included list.

Manage requisitions and purchase orders 912 Create and manage purchase orders



c. Click OK. 

To view all transactions again, click Reload.

4. To view more information about a transaction, do the following:

a. Click to select the transaction on the Transaction List tab.

b. Click the Transaction Details tab to view the details of the selected
transaction.

c. Click the Item History tab to view the item history of the selected
transaction.

Find a transaction by transaction number
1. On the Transaction List tab, click Find Transaction #.

2. Enter the transaction number in the field.

3. Click OK.

The transaction with the selected transaction number is selected on the
Transaction List tab.

Create transaction history reports
1. Click the Transaction History ribbon tab.

2. On the menu, select Reports.

3. To only include specific items in the transaction history report, select a
filter type in the Type list, and click Select.

4. Do one of the following:

• For dates, select the start and end dates in the calendar to define a
range within which the transactions have taken place.

You can also select the Expression check box to create expressions
that allow you to set the base date and the number of days before or
after that date.

• For other filter types, use the arrow buttons to move the desired items
to the Included list.

5. Click OK.

6. Click Make Report.

7. In the Report Selection dialog box, select the report that you want to
view or print.
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8. Do any of the following: 

To Do this
View the report • In the Report Selection dialog

box, click View.
Print the report a. In the Report Selection dialog

box, change the number of the
printed copies by clicking the +
and - buttons.

b. If necessary, click Select Printer,
select which device you want to
use for printing, and click OK.

You can also select Default
Printer to always use the default
printer with this report, or No
Printer to reset the current
printer.

c. Click Print.

d. Click Yes.
Export the report a. Click Export.

b. In the Export Format list, select
an export format.

c. Click Browse.

d. Browse to the location where you
want to save the exported file,
and click Save.

e. Modify the file name according to
your needs.

f. To attach the exported file to a
Microsoft Outlook email and
send it to a recipient, select the
Attach to Email check box.

g. To open the file after exporting it,
select the Open Exported
Document check box.

h. Click Export.

View, print, or export purchase orders and purchase order
reports
Use the Reports command to view, print, or the export purchase order, or to
create reports based on the current purchase order. For example, you can
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create a list of the items on the purchase order or a material receiving
checklist. You can then view or print the reports, or export the reports to save
them in another file format.

To create purchase order reports, do the following:

1. In the PO # dialog box, click the Purchase Order ribbon tab.

2. On the menu, select Reports.

3. In the Report Selection dialog box, select the report that you want to
view, print, or export. 

To customize the reports that are displayed in the Report Selection
dialog box, click the Edit Report Types.

4. If you want to include the company logo and vendor code in the report,
select the Show Company Logo and Show Vendor Code check boxes. 

When the check boxes are cleared, the information is not included in the
report.

According to your needs, see any of the following instructions:

View the report
• In the Report Selection dialog box, click View.

The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
EPM Report Viewer window to email the report via Microsoft Outlook.

Print the report
1. In the Report Selection dialog box, change the number of the printed

copies by clicking the + and - buttons.

2. Click Print.

3. To confirm printing the selected report, click Yes in the confirmation
dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the report
1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Modify the file name according to your needs.
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5. Browse to the location where you want to save the exported file, and click
Save.

6. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email check box.

7. To open the file after exporting it, select the Open Exported Document
check box.

8. In the Report Selection dialog box, click Export.

View, print, or export job-specific receiving reports
Use the Receiving Reports command to create receiving reports that contain
information from the current purchase order. You can then view or print the
reports, or export the reports and save them in another file format. For
example, you can create a purchase order summary, a barcode checklist, or a
receiving list.

To create receiving reports, do the following:

1. In the PO # dialog box, click the Purchase Order ribbon tab.

2. On the menu, select Receiving Reports.

3. To only include particular purchase orders in the reports, in the Purchase
Order Report Filters dialog box, select a filter type in the Type list, and
click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the purchase order properties that
you want to include in the report to the Included list.

• Type the maximum and minimum values for the purchase orders that
you want to include in the report.

5. Click OK. 

To further limit which properties the purchase orders in the reports
should match, repeat steps 3 to 5 for all necessary filter types.

6. Click Make Report.

7. In the Report Selection dialog box, select the report that you want to
view, print, or export. 

8. If you want to include the company logo and vendor code in the report,
select the Show Company Logo and Show Vendor Code check boxes. 

When the check boxes are cleared, the information is not included in the
report.

According to your needs, see any of the following instructions:
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View the report
• In the Report Selection dialog box, click View.

The report opens in Tekla EPM Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
EPM Report Viewer window to email the report via Microsoft Outlook.

Print the report
1. In the Report Selection dialog box, change the number of the printed

copies by clicking the + and - buttons.

2. Click Print.

3. To confirm printing the selected report, click Yes in the confirmation
dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the report
1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Modify the file name according to your needs.

5. Browse to the location where you want to save the exported file, and click
Save.

6. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email check box.

7. To open the file after exporting it, select the Open Exported Document
check box.

8. In the Report Selection dialog box, click Export.

Export purchase orders
You can export the items on your purchase orders to Trimble Viewpoint,
Timberline, or Sage 300 CRE accounting solutions. This way, you can avoid
entering PO information in multiple software
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Export the selected purchase orders to Viewpoint
You can export purchase orders to both Trimble Viewpoint Vista and Trimble
Viewpoint Spectrum.

Before you export the purchase order, ensure that:

• The company code of the vendor in the Tekla EPM Address Book matches
the vendor in Trimble Viewpoint

• The job number of the Tekla EPM purchase order matches the job number
in Trimble Viewpoint

• The Cost Code field in Tekla EPM purchase orders is mapped to the phase
in Trimble Viewpoint purchase orders.

1. Do any of the following: 

a. At the top of the Tekla EPM window, click the Purchasing button.

b. On the Maintenance menu, select Integrations --> Trimble
Viewpoint. Then, click Export on the Purchase Orders tab.

2. In the Select Requisition/Purchase Order dialog box, select the
purchase orders that you want to export. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

3. Click the Purchasing ribbon tab.

4. On the menu, select Export Purchase Orders --> Trimble Viewpoint -
Selected.

5. Click Yes to confirm exporting the selected purchase orders.

6. If you have selected the Prompt on export check boxes for any
properties in the Trimble Viewpoint Integration dialog box, ensure that
the values are correct, and click OK.

7. In the Save As dialog box, browse to the folder where you want to save
the exported purchase orders. 

By default, Tekla EPM saves the purchase orders in the Export folder.

8. If necessary, change the file name.

9. Click Save.

The exported purchase orders are saved as a .txt file in the folder that you
selected.

You can then import the .txt file to any Trimble Viewpoint solution according
to your needs.
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Export purchase orders with receiving transactions to Viewpoint
You can export purchase orders to both Trimble Viewpoint Vista and Trimble
Viewpoint Spectrum.

Before you export the purchase order, ensure that:

• The company code of the vendor in the Tekla EPM Address Book matches
the vendor in Trimble Viewpoint

• The job number of the Tekla EPM purchase order matches the job number
in Trimble Viewpoint

• The Cost Code field in Tekla EPM purchase orders is mapped to the phase
in Trimble Viewpoint purchase orders.

1. Do any of the following: 

a. At the top of the Tekla EPM window, click the Purchasing button.

b. On the Maintenance menu, select Integrations --> Trimble
Viewpoint. Then, click Export on the Receiving tab.

2. In the Select Requisition/Purchase Order dialog box, select the
purchase orders that you want to export. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

3. Click the Purchasing ribbon tab.

4. On the menu, select Export Purchase Orders --> Trimble Viewpoint -
Receiving.

5. In the Save As dialog box, browse to the folder where you want to save
the exported purchase orders. 

By default, Tekla EPM saves the purchase orders in the Export folder.

6. If necessary, change the file name.

7. Click Save.

The exported purchase orders are saved as a .csv file in the folder that you
selected.

NOTE To avoid errors, do not open an exported .csv file with Microsoft
Excel. If you do so, the formatting of information changes, and
the .csv file will fail to import to Trimble Viewpoint products.

Export purchase orders to Timberline or Sage 300 CRE
1. At the top of the Tekla EPM window, click the Purchasing button.

2. If you only want to export particular purchase orders, select them in the
Select Requisition/Purchase Order dialog box. 
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To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

3. Click the Purchasing ribbon tab.

4. On the menu, select Export Purchase Orders --> Timberline / Sage 300
CRE .

5. In the Export Purchase Orders to Timberline dialog box, define how you
want to import the items: 

Option Description
Export Received Items
Only

When selected, only items that have been received
in the inventory are exported.

When cleared, all items are exported.

You can define the range of dates between which
the exported items have been received. To do so,
enter the dates in the Date Received Minimum
and Maximum fields.

Export Selected
Purchase Orders Only

When selected, only items in the purchase orders
that are selected in the Select Requisition/
Purchase Order dialog box are exported.

When cleared, items in all purchase orders are
exported.

Date Received
Minimum

The earliest receiving date of the items that are
exported.

Note that this option is only available if the Export
Received Items Only check box is selected.

Maximum The latest receiving date of the items that are
exported.

Note that this option is only available if the Export
Received Items Only check box is selected.

Re-Export When selected, any purchase orders that have
been previously exported are ignored in the
export. This ensures that the same purchase
orders are not exported multiple times.

Date Format Allows you to select the date forma of the exported
file.

Job # Export Option Defines how the job number is shown in the
exported file. You can select to:

• Leave the job number unchanged and use the
original job number.

• Replace any digits after the first 4 digits with
zeros.
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Option Description
• Use both the job number and the existing

sequence numbers.
Replace Job # if Cost
Code Matches

When selected, the job number is replaced by a
piece of text that you define, if the job number
matches the cost code defined in the Cost Code
list.

When cleared, the job number is never replaced by
any text when the job is exported.

Cost Code The cost code that the job number needs to match
to be replaced. The replacement text is defined in
the Job # Replacement field.

Job # Replacement The text with which you to replace the job number.
Sort Lines Allows you to select how items are sorted in the

exported file. The options are:

• Item Details: the items are sorted by their
properties. This is the default option.

• Item # Only: the items are sorted by item
number.

Split Lines based on Allows you to select how items are split on
different lines in the exported file. The options are:

• Item Details Only: Items with similar
properties are considered the same item, and
therefore, the items are placed on the same
line.

• Item Details and Comments: Items that have
different information in the Comment field are
considered different items, and therefore, the
items are split on different lines.

Include Grade in
Description

When selected, the material grade is included in
the material description.

Export Filename The location where the exported file is saved and
the name of the exported file.

To modify the export location and the file name:

a. Click the ... button on the right side of the
Export Filename field.

b. In the Open dialog box, browse to the folder
where you want to save the file.

c. If necessary, change the file name.

d. Click Open.
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6. Click Export Purchase Orders.

The exported text file is saved in the folder that you selected.

Approve a purchase order
Approving a purchase order allows you to lock the purchase order, so that no
further changes can be made. If necessary, the order can still be unlocked to
allow making changes again.

1. In the PO # dialog box, click the Purchase Order ribbon tab.

2. On the menu, select Approve Purchase Order.

3. To confirm approving and locking the purchase order, click Yes in the
confirmation dialog box.

The text at the top of the PO # dialog box now shows that the purchase order
has been approved and locked, and the name of the user who approved and
locked the purchase order.

Note that purchase orders are also locked if you export them.

See also

Unlock a purchase order (page 922)

Finalize purchase order items (page 908)

Unfinalize purchase order items (page 909)

Unlock a purchase order
Use the Revoke Purchase Order Approval command to unlock the purchase
order to allow making changes to the purchase order.

1. In the PO # dialog box, click the Purchase Order ribbon tab.

2. On the File menu, select Revoke Purchase Order Approval.

3. To confirm revoking the purchase order approval, click Yes in the first
confirmation dialog box.

4. To unlock the purchase order, click Yes in the second confirmation dialog
box.

The purchase order is now unlocked. Users with access to the purchase order
can make any necessary changes to the purchase order.

See also

Approve a purchase order (page 922)

Finalize purchase order items (page 908)

Unfinalize purchase order items (page 909)
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Delete purchase orders
You can delete old and unnecessary purchase orders at any time. What
happens to the material items within the purchase order depends on their
receiving status.

Before deleting a purchase order, note that:

• Any material items in the purchase order that have not been received are
deleted when the purchase order is deleted.

• Any received material items in the purchase order remain in the inventory,
but are no longer linked to the deleted purchase order. These items
behave like finalized items. For more information, see Finalize purchase
order items (page 908).

You can still see the deleted items , even though the purchase order is deleted.

1. At the top of the Tekla EPM window, click the Purchasing button.

2. In the Select Requisition/Purchase Order dialog box, ensure that you
are on the Purchase Orders tab.

3. Select the purchase orders that you want to delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

4. Click Delete.

5. To permanently delete the purchase orders, click Yes in the confirmation
dialog box.

The selected purchase orders are deleted.
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11 Create and manage customer
orders

Use the Order Entry module to directly sell material from your inventory. In
Order Entry, you can create and manage customer orders, quotes, invoices,
payments, credits, deliveries, and returns.

NOTE Before you start working in the Order Entry module, remember to set
up the module (page 925).

The basic workflow in the Order Entry module is as follows:

1. Do one of the following:

• Create a quote or a quick quote for the customer, and once it gets
accepted, convert it into an order.

• Create an order.

2. Add details for the order.

3. Combine and allocate the material items in the order.

4. If necessary, add charges or order-specific credit for the customer.

5. Add invoices and deliveries.

6. If necessary, add returns.

See also

Set up the Order Entry module (page 925)

Open the Order Entry module (page 941)

Filter the order entry information (page 942)

Create a quote or an order (page 943)

Modify a quote or an order (page 954)

Convert a quote into an order (page 955)

Convert an order back into a quote (page 955)
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Delete a quote (page 956)

Add an invoice (page 956)

Add a payment (page 958)

Add a credit (page 958)

Add a delivery (page 959)

Add a return (page 960)

Create order or quote reports (page 960)

11.1 Set up the Order Entry module
In Order Entry Maintenance, you can create and modify the settings used
when working in the Order Entry module. For example, you can modify the
company standard settings, invoice categories, shipping methods, and
payment terms.

Remember to also set up the necessary tax rates and tax groups before you
start working in the Order Entry module.

For more information, see the following links:

Define company standard settings for Order Entry (page 925)

Create, modify, and delete charge processes (page 931)

Create, modify, and delete invoice categories (page 933)

Create, modify, and delete order and quote categories (page 934)

Create, modify, and delete price groups (page 935)

Create, modify, and delete payment methods (page 936)

Add, modify, and delete payment terms for customer orders (page 937)

Add, modify, and delete shipping methods for customer orders (page 939)

Create, modify, and delete territory options (page 940)

Define company standard settings for Order Entry
You can define default settings that become the company-level standard
settings used in each new order entry job. In company standard settings, you
can set default price groups and price levels, credit limits, backdating settings,
and QuickBooks tax codes.

To access the Company Standards dialog box, do the following:

1. Click the Maintenance ribbon tab.
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2. In the menu, select Order Entry --> Company Standards .

Now, you can manage the different company-level standard settings on the
different tabs of the Company Standards dialog box.

Remember to also set the combining optimizations, suppliers, and input and
display units that are used in the Order Entry module by default. For more
information, see:

• Define combining optimizations for Order Entry (page 929)

• Define input and display units for Order Entry (page 929)

• Define suppliers for Order Entry (page 931)

According to your needs, see any of the following instructions:

Define general order entry settings
1. Open the General tab.

2. Adjust the following options according to your needs: 

Option Description
New Customer -
Default Tax Group

The default tax group applied for new order entry
taxable items. The tax group can be changed job by job.

Restrict to
Inventory
Location

When selected, Tekla EPM limits the available stock
material selection to a specific inventory location.

Select the desired inventory location in the list on the
right side of the field. Inventory locations can be set and
reset in the Inventory module.

Allow Delivery of
Un-Invoiced
Material

When selected, Tekla EPM allows delivering materials
before invoicing.

NOTE You need to select the Allow Delivery of Un-
Invoiced Material option to view and use
delivery tickets before invoicing.

Allow Invoicing of
Material Not
Delivered

When selected, Tekla EPM allows creating invoices for
materials before they are delivered.

Keep Order
Selection Screen
Open

When selected, the order selection dialog box stays
open after a job has been selected.

Selection Screen -
Default number of
days to view

The number of days for which orders remain in the
Order Selection dialog box. This setting allows you to
filter out older orders.

To always display all orders, type 0.
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Option Description
Order # Increment The default option for automatic order numbering.

New orders are numbered according to the selected
option. However, you can modify the order number
according to your needs each time you create a new
order.

Item Increment The numbering system for items listed in an order.

Using the default auto-increment of 10 allows items to
be added in the list according to your needs, without
having to renumber the other items in the job.

Quote # Regular
Expression and
Order # Regular
Expression

Optional expressions used for pattern matching.

New Material -
Default Price

The default material cost applied to new quotes and
orders. The options are:

• No Default: no default price is set.

• Replacement Cost: the price defined in Pricing
Maintenance is used.

• Inventory Average: the inventory average price is
used.

• Inventory High: the highest inventory price is used.
Order -
Automatically
Allocate Inventory

When selected, Tekla EPM automatically uses material
items in the inventory for quotes and orders.

NOTE Do not click Save until you have modified all necessary settings.
Saving the settings closes the Company Standards dialog box.

Define price level settings
1. Open the Price Levels tab.

2. In the Number of Price Levels field, type the number of levels of pricing
that you want to use.

3. In the Default Price Group list, select the price group to be used by
default for new orders.

4. In the Default Price Level list, select the price level to be used by default
for new orders. 
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For more information on defining the pricing groups and pricing levels
used in Order Entry, see Add, modify, and delete price groups
(page 935).

NOTE Do not click Save until you have modified all necessary settings.
Saving the settings closes the Company Standards dialog box.

Set credit limit settings
1. Open the Credit Limit tab.

2. In the New Customer - Default Credit Limit field, type the default credit
limit for new customers. 

If you do not want to set a credit limit, type 0.

3. Select how Tekla EPM will react when a customer has exceeded their
credit limit. 

The options are:

• Allow without warning: Tekla EPM allows creating new orders
without warning

• Allow with warning: Tekla EPM allows creating new orders, but a pop-
up warning is displayed

• Allow with credit limit override: Tekla EPM allows new orders when
you override the customer's credit limit

• Don't allow: Tekla EPM does not allow any new orders for customers
that have exceeded their credit limit

NOTE Do not click Save until you have modified all necessary settings.
Saving the settings closes the Company Standards dialog box.

Define backdating settings
If you want to mark payments and other order entry activities as created on a
previous date, you can allow back-dating for the activities.

1. Open the Back-Dating tab.

2. Click to select the check boxes for each option for which you want to allow
back-dating order activity. 

If you do not want to allow backdating, do not select any check boxes.

NOTE Do not click Save until you have modified all necessary settings.
Saving the settings closes the Company Standards dialog box.
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Define QuickBooks sale tax codes
If you have connected the QuickBooks accounting software with Tekla EPM,
you can define the sales tax codes that are used when exporting invoices from
Tekla EPM to QuickBooks.

Note that you need to have exactly the same tax codes in both software.

1. Open the QuickBooks tab.

2. Type in the sales tax codes used for taxable and non-taxable items. 

NOTE Do not click Save until you have modified all necessary settings.
Saving the settings closes the Company Standards dialog box.

Define input and display units for Order Entry
You can define the input and display units used in the Order Entry module.

1. At the bottom of the Company Standards dialog box, click Input/Display
Units.

2. In the Input/Display Units dialog box, select the units and the length
input types in the available lists. 

Note that there are multiple options depending on the required precision
and the desired input method.

3. Click OK.

4. Remember to click Save in the Company Standards dialog box to update
the input and display units.

See also

Define company standard settings for Order Entry (page 925)

Define combining optimizations for Order Entry
You can define company-level settings for multing and plate nesting in the
Order Entry module. These settings define which combining methods are
utilized and in which order. You can combine, save, and compare various
combining run options until the desired result is achieved.

1. At the bottom of the Company Standards dialog box, click Combining
Setup.

2. To use material grade substitutions with the optimization settings when
performing a combining run, on the General Settings tab of the
Combining Setup dialog box, select the Use Grade Substitutions check
box. 

Grade substitutions must be set in the Shape / Grade / Size
Maintenance dialog box. If the grade substitutions are not set, the
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material grades in the combining run and in the supplier pricing data set
or the inventory need to match each other exactly.

3. Click the arrow buttons to move the optimization options that you want to
use to the Optimizations Included list. 

The options are:

• Inventory Exact-Match (In Stock): Use this option for inventory items
in stock that are an exact match without the use of kerf or clamp
allowance.

• Inventory Exact-Match (On Order): Use this option for inventory
items that are on purchase orders and have not yet been received and
that are an exact match without the use of kerf or clamp allowance.

• Inventory Least-Scrap (On Order): Use this option for inventory
items that are on purchase orders and have not yet been received and
that will provide the least amount of scrap.

• Inventory Least-Scrap (In Stock): Use this option for inventory items
in stock that will provide the least amount of scrap.

• Warehouse Least-Scrap: Use this option to give preference to
warehouse items that will provide the least amount of scrap.
Warehouse items will only be used when they provide less scrap than
the available inventory items.

• Warehouse Force Inventory: Use this option to force the use of
inventory regardless of the amount of scrap, no matter where it is
located in the Optimizations Included list. This option is the opposite
of Warehouse Least-Scrap.

Note that you can only include Warehouse Least-Scrap or
Warehouse Force Inventory, not both.

4. Use the Move Up and Move Down buttons to modify the order of the
optimizations. 

The order is important while performing a combining run.

5. Open the Plate Nesting Settings tab.

6. In the Shear Cut Optimization list, click a suitable shear cut option to
select it. 

The selected option determines the plate allowance to be used with the
combining:

• Use None when cutting plate on a burn table.

• Use Shear Cut - First Cut Along Length or Shear Cut - First Cut
Along Width to alert Tekla EPM that the nesting needs to allow for
that type of cut first. Then, the nesting will allow for all subsequent
cuts to be made with that condition.
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7. If the material grain direction is unimportant and you want Tekla EPM to
create the best possible optimization of a plate, select the Rotate Plates
for Best Fit check box.

8. Click Save.

9. Remember to click Save in the Company Standards dialog box to save
the combining optimizations.

See also

Define company standard settings for Order Entry (page 925)

Define suppliers for Order Entry
You can define the desired suppliers, or pricing data sets, for angles, beams,
plates, rods, tubes, and other material. This way, you can use material pricing
from the selected supplier pricing data sets for each material group.

1. In the Company Standards dialog box, click the Suppliers button.

2. In the Suppliers dialog box, select suppliers for each material group in the
available lists.

3. Click OK.

4. Remember to click Save in the Company Standards dialog box to update
the supplier settings.

See also

Define company standard settings for Order Entry (page 925)

Create, modify, and delete charge processes
While working in Order Entry, you should use different charge processes
depending on whether you are charging the customer for material, labor, or
both. The charge processes, standard charges, and applicable costs are
defined in Charge Process Maintenance.

NOTE While working on quotes and orders in the Order Entry module, you
can only change the price per item, not the type or description. This
means that you can enter the base costs in the Charge Processes
dialog box and change them according to your needs.

1. Click the Maintenance ribbon tab.

2. In the menu, select Order Entry --> Charge Process Maintenance . 
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3. In the Charge Processes dialog box, do any of the following: 

To Do this
Add a new charge
process

a. Click New.

b. In the Type list, select a suitable option.

The options are Material, Labor, and
Miscellaneous. Use the Miscellaneous option
when the charge applies to both material and
labor.

c. In the Description field, type a description for
the charge process.

For example, if the Type is Labor, the
description can be Cutting or Welding.

The description will appear in the Process
column in Order Entry.

d. In the Cost field, type the price per item.
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To Do this
e. Click Add to save the new charge process and

add it to the list.
Modify a charge process a. Select a charge process in the list.

b. Modify the type, description, and cost
according to your needs.

c. Click Edit to save the changes.
Delete a charge process a. Select a charge process in the list.

b. Click Delete.

c. To permanently delete the charge process,
click Yesin the confirmation dialog box.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Create, modify, and delete invoice categories
In the Invoice Category Maintenance dialog box, you can create a list of
standard invoice categories used for customer orders. The categories that you
define are available when creating invoices in the Order Entry module.

1. Click the Maintenance ribbon tab.

2. In the menu, select Order Entry --> Invoice Category Maintenance.

3. In the Invoice Categories dialog box, do any of the following according to
your needs: 

To Do this
Add a new invoice
category

a. Click New.

b. In the Category field, type a name for the
invoice category.

c. In the Description field, type a description for
the invoice category.

d. Click Add to save the new invoice category and
add it to the list.

Modify an invoice
category

a. Select the invoice category that you want to
modify.

b. Modify the name and description of the
invoice category.

c. Click Save to save the changes.
Delete an invoice
category

a. Select the invoice category that you want to
delete.
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To Do this
b. Click Delete.

c. To permanently delete the invoice category,
click Yes in the confirmation dialog box.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Create, modify, and delete order and quote categories
In the Order Category Maintenance dialog box, you can create a list of
standard categories for orders and quotes. For example, you can create
separate order categories for walk-in customers and regular customers. The
categories that you define are available in the Order dialog box for both
quotes and orders.

1. Click the Maintenance ribbon tab.

2. In the menu, select Order Entry --> Order Category Maintenance.

3. In the Order Categories dialog box, do any of the following according to
your needs: 

To Do this
Add a category a. Click New.

b. In the Category field, type a name for the
category.

c. In the Description field, type a description for
the category.

d. Click Add to save the new category and add it
to the list.

Modify an order
category

a. Select the order category that you want to
modify.

b. Modify the name and description of the
selected order category.

c. Click Save to save the changes.
Delete a category a. Select the category that you want to delete the

list.

b. Click Delete.

c. To permanently delete the category, click Yes
in the confirmation dialog box.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.
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Create, modify, and delete price groups
You can add, modify, and delete price groups that are available in the Order
Entry module. You can also define different price levels within price groups.
Price levels determine the level of markup that your company gets from each
order. Note that you can use any price level with any price group.

1. Click the Maintenance ribbon tab.

2. In the menu, select Order Entry --> Price Group Maintenance . 

3. In the Price Group Maintenance dialog box, do any of the following
according your needs: 

To Do this
Add a price group a. Click New.

b. In the Description field, type a description for
the price group.
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To Do this
c. To add price levels to the price group, type the

desired minimum order prices and markup
percentages in the available fields.

The minimum order prices and markups are
used for recovering costs and small orders. As
orders get larger, the amortization of costs
may set off the need for larger markups and
allow smaller minimum order prices.

d. Click Add to save the price group and add it to
the list.

Modify a price group a. Select the price group that you want to modify.

b. Modify the description and price levels
according to your needs.

c. Click Save to save the changes.
Delete a price group a. Select the price group that you want to delete.

b. Click Delete.

c. To permanently delete the price group, click
Yes in the confirmation dialog box.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Create, modify, and delete payment methods
You can add, modify, and delete payment method options available for new
payments in the Order Entry module. You can also select which payment
method you want to use as the default option used for new orders.

1. Click the Maintenance ribbon tab.

2. In the menu, select Order Entry --> Payment Method Maintenance.

3. In the Payment Method Maintenance dialog box, do any of the
following according to your needs: 

To Do this
Add a new payment
method

a. Click New.

b. In the Description field, type a description for
the payment method.

For example, Cash.

c. Click Add.

The new payment method is saved and added to
the list.

Create and manage customer orders 936 Set up the Order Entry module



To Do this
Set a payment method
as default

a. Select the payment method that you want to
set as the default option.

b. Click Set as Default.

c. To confirm using the selected payment
method as the default option, click Yes.

The default payment method is marked with
an asterisk (*). This payment method will be
used by default for new orders.

Modify a payment
method

a. Select the payment method that you want to
modify.

b. Modify the description of the payment
method.

c. Click Edit to save the changes.
Delete a payment
method

a. Select the payment method that you want to
delete.

b. Click Delete.

c. To permanently delete payment method, click
Yes.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Add, modify, and delete payment terms for customer
orders
You can add, modify, or delete the payment term options that are available for
all customer orders created in Order Entry. In addition, you can set the
default payment term that will be used for new customer orders.

1. Click the Maintenance ribbon tab.

2. In the menu, select Order Entry --> Payment Term Maintenance . 
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3. In the Payment Term Maintenance dialog box, do any of the following
according to your needs: 

To Do this
Add a new payment
term

a. Click New.

b. In the Description field, type a description for
the payment term.

c. If necessary, in the Discount field, type a
discount percentage for the payment term.

d. If you want to freeze a customer's credit when
an invoice is past the due date, select the
Credit Hold if Past Due check box.

e. In the Days to Past Due field, type the
number of days that an invoice can be past
due date before the customer's credit is
frozen.

f. Click Add to save the new payment term and
add it to the list.
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To Do this
Set a default payment
term

a. Select the payment term that you want to set
as the default option.

b. Click Set as Default.

c. To confirm using the selected payment term
as the default option, click Yes in the
confirmation dialog box.

The default payment term is marked with an
asterisk (*). This payment term will be used by
default for new customer orders.

Modify a payment term a. Select the payment term that you want to
modify.

b. Modify the payment term properties
according to your needs.

c. Click Edit to save the changes.
Delete a payment term a. Select the payment term that you want to

delete.

b. Click Delete.

c. To permanently delete the payment term, click
Yes in the confirmation dialog box.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Add, modify, and delete shipping methods for customer
orders
In the Shipping Method Maintenance dialog box, you can add, modify, and
delete shipping method options that are available for the customer orders
created in Order Entry. You can also select which shipping method you want
to use as the default option.

1. Click the Maintenance ribbon tab.

2. In the menu, select Order Entry --> Shipping Method Maintenance .

3. In the Shipping Method Maintenance dialog box, do any of the following
according to your needs: 

To Do this
Add a shipping method a. Click New.

b. In the Description field, type a description for
the new shipping method.
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To Do this
c. Click Add to save the new shipping method

and add it to the list.
Set a default shipping
method

a. Select a shipping method in the list.

b. Click Set as Default.

c. To confirm using the selected shipping
method as the default option, click Yes in the
confirmation dialog box.

The default shipping method is marked with an
asterisk (*). This shipping method is used by
default in the Order Entry module.

Modify a shipping
method

a. Select a shipping method in the list.

b. Modify the information in the Description
field.

c. Click Edit to save the changes.
Delete a shipping
method

a. Select a shipping method in the list.

b. Click Delete.

c. To permanently delete the shipping method,
click Yes in the confirmation dialog box.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Create, modify, and delete territory options
In Territory Maintenance, you can add, modify, and delete territory options
that are available for defining order information.

1. Click the Maintenance ribbon tab.

2. In the menu, select Order Entry --> Territory Maintenance.

3. In the Territories dialog box, do any of the following according to your
needs: 

To Do this
Create a new territory a. Click New.

b. In the Territory field, type a name for the
territory.

c. In the Description field, type a description for
the territory.

d. Click Add to save the new territory and add it
to the list.
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To Do this
Modify a territory a. Select the territory that you want to modify.

b. Modify the name and description of the
territory according to your needs.

c. Click Save to save the changes.
Delete a territory a. Select the territory that you want to delete.

b. Click Delete.

c. To permanently delete the territory, click Yes
in the confirmation dialog box.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

11.2 Open the Order Entry module
In the Order Entry module, you can create, modify, and delete orders, quotes,
invoices, payments, credits, deliveries, and returns. To open the Order Entry,
do the following:

1. In the upper-right corner of the Tekla EPM window, click the Order Entry
icon. 

The Order Entry dialog box appears. You can view the existing quotes,
orders, invoices, payments, credits, deliveries, and returns.

By default, the orders and quotes are visible for 30 days after their
creation. However, you can change this setting in the dialog box
(page 925) or use filters to view older quotes and orders (page 942).
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11.3 Filter the order entry information
You can select which orders and quotes you want to see in the Order Entry
dialog box. For example, you may want to view older orders that are hidden in
the initial view of the Order Entry dialog box.

1. At the top of the Order Entry dialog box, click the arrow button on the left
side of Filters. 

The Filters section expands.

If you want to see all orders created in the Order Entry module including
the completed orders, select the Show Completed Orders check box on
the right side of the Order Entry dialog box.

2. To apply a new filter, click Set Filters. 

The Order Filters dialog box opens.

3. Depending on what you want to filter out, click one of the available filter
buttons.

4. Click the arrow buttons to move the items that you want to display to the
Included list.

5. Click OK.

6. Click Apply Filter.

The orders and quotes displayed in the Order Entry dialog box are updated to
match the filters you set.

To clear the applied filters, close and re-open the Order Entry dialog box.
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11.4 Manage quotes and orders
You can create and manage both quotes and order in the Order Entry
module. The difference between quotes and orders is that you can add
invoices to orders, and send the materials on the orders to purchase orders.
Quotes are simply estimates that a customer can accept or reject, so they
cannot be invoiced.

See also

Create a quote or an order (page 943)

Modify a quote or an order (page 954)

Convert a quote into an order (page 955)

Convert an order back into a quote (page 955)

Delete a quote (page 956)

Create a quote or an order
Quotes and orders are created in the exact same way. Orders can be invoiced
and their materials can be sent to purchase orders, whereas quotes are simply
price estimates that the customer can accept or decline. Alternatively, you can
also create quotes in the Inventory module.

1. At the bottom of the Order Entry dialog box, click New Quote or New
Order. 
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2. If necessary, modify the quote or order number at the top of the Order
Information dialog box.

3. Enter a job description and the eventual customer purchase order
number.

4. In the Salesman list, select the salesman. 

All users listed in the Administration dialog box are available in the
Salesman list.

5. Select the quote or order date and the delivery date.

6. In the Customer Name list on the Customer/Terms/Settings tab, select
a company. 

All companies in the address book whose firm type is Customer are
available in the list. When you select the company, the default shipping
and billing addresses and the customer code are automatically added to
the dialog box. If necessary, you can select an alternative shipping or
billing address in the appropriate lists.

7. In the Contact list, select a contact person associated with the customer
company. 

TIP You can also add a contact person into the address book in the
current dialog box. Type a new name in the Contact field and click
the Add button that has appeared on the right side of the field.
Then, enter the contact information for the new contact person.

8. Select the tax group, order category, territory, shipping method, payment
terms, price group, and price level in the appropriate lists.

9. In the Item Increment field, type a value used for numbering materials in
the quote or order. 

Using the default auto-increment of 10 allows items to be added in the list
according to your needs, without having to renumber the other items in
the job.

10. To limit the available stock material selection to a certain inventory
location, select the Restrict to Inventory Location check box, and select
the inventory location in the list.

11. If necessary, you can click the buttons on the right to modify the input and
display units (page 929), combining optimizations (page 929), and
suppliers (page 931) of the current quote or order.

12. Go to the Notes tab to add notes regarding the quote or order. 

The notes will appear in quote and order reports.

13. Go to the Internal Notes tab to add private notes regarding the quote or
order.
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14. At the bottom of the dialog box, click Save Quote Information or Save
Order Information.

The quote or order is created and added to the Order Entry dialog box. You
can modify all properties later, if necessary.

The Details dialog box opens. You can add quote or order details regarding,
for example, materials, charges, and discounts.

See also

Add quote or order details (page 945)

Create a quick quote (page 954)

Copy quote or order information (page 953)

Add quote or order details
Once you have created a quote or an order, you need to add details for it. This
includes adding materials to be delivered to the customer, creating additional
charges, and adding the necessary discounts. For orders, you can also add
invoices, payments, credit, deliveries, and returns.

To access the Details dialog box, do one of the following:

• In the Quote dialog box, click Quote Details.

• In the Order dialog box, click Order Details.

The Details dialog box opens on the Total tab, where all quote or order
details and job activity are shown.
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See also

Add an invoice (page 956)

Add a payment (page 958)

Add a credit (page 958)

Add a delivery (page 959)

Add a return (page 960)

Add and combine materials

Note that even though you can allocate the material items on a quote, the
material items on the quote are actually combined only when you convert the
quote into an order. When a quote is converted into an order, the the
allocated material items of the quote are automatically reflected to the order.

1. Open the Material tab. 

2. To add materials to the list, click New.

3. Define the properties of the new material according to your needs:

a. Enter the item number, quantity, length, base price, and additional
drop price per item.

b. In the Shape, Dimensions and Grade lists, select the desired options.

c. If the item is taxable, select the Taxable check box.

d. If necessary, type a piece mark for the material. 

Adding piece marks can be useful if drawings are available.
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e. If necessary, enter any comments regarding the part you are adding. 

The comments will be visible in both the material list and reports.

f. To apply markup for the available costs, select the Markup check
box. 

Note that you do not need to select the Markup check box is you
want to use the replacement cost as markup.

g. Select the desired pricing option, and click Apply.

h. To confirm the markup, click Yes in the confirmation dialog box.

4. Click Add. 

Repeat steps 2 to 4 to add all necessary materials.

Note that as you add materials to the order or quote, the Material tab is
updated to show the total cost of the material.

5. To allocate the items, do any of the following: 

To Do this
Automatically combine
the material items and
move them to allocation

a. Click the Order Entry ribbon tab.

b. On the menu, select Quick Combine.

When you select Quick Combine, the
combining is performed according to the
combining optimizations set for Order Entry.

If you want to manually modify the combining
setup, select Combine instead.

When Tekla EPM has finished the combining
process, the Combining Run Results dialog
box opens.

c. Review the combining results to make sure
that they are satisfactory, and click Save
Combining Run.

d. To close the Combining Run Results dialog
box, click the Close button (X) in the upper-
right corner.

Allocate a material item
from the inventory

Material items can be allocated from the inventory
if there is an exact match for the items in stock. If
there is no exact match for the material item in the
inventory, you need to send the item to a purchase
order. For more information, see Send materials to
a purchase order (page 952).

a. Select the desired material item.
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To Do this
b. In the list in the lower-right corner of the

dialog box, select an inventory item that
matches the selected material item.

c. Click Allocate Inventory.

d. To confirm allocating the material item from
the inventory, click Yes in the confirmation
dialog box.

Allocate a material item
as an order to length
item

a. Select the desired material item.

b. At the bottom of the dialog box, click Allocate
Order to Length.

c. To confirm allocating material item as an
order to length item, click Yes in the
confirmation dialog box.

As you combine or allocate materials, the Allocation tab is updated to
show the percentage of materials that has been allocated.

6. To set the additional drop price per piece, select the item and click the Set
button in the This Item section of the dialog box.

7. To manually set the markup for the current margin, click the % button and
select an option in the context menu.

Modify the properties of allocated materials

1. Open the Allocation tab. 
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The allocated material items and the restock lengths are displayed.

2. Do any of the following according to your needs: 

To Do this
Split an allocated
material record

Use the Split command to separate a certain
quantity of pieces from an allocation record, so
that you can handle it differently from other
material. For example, you can set a different price
for the separated quantity.

a. Select the material record that you want to
split.

b. Click Split.

c. In the Enter Value dialog box, type the
quantity that you want to separate.

d. Click OK.

The split quantity is added to the list of allocated
material records.

Join allocated material
records

The Join command is used to re-join a split
allocation record.

Note that if you have made changes to one of the
split records, you cannot join the records back
together unless you change the properties back.
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To Do this
a. Select the material items that you want to join.

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold
down Shift.

b. Click Join.

The split material records are joined back together.
Ensure that the allocated
materials are available in
the inventory

• Click Verify.

Delete an allocated
material record to re-
combine them

a. Select the material record that you want to
delete.

b. Click Delete.

c. To confirm deleting the materials from the
Allocation tab, click Yes in the confirmation
dialog box.

You can now re-combine the items on the
Material tab.

Set price for an allocated
material record

a. Select the material record whose price you
want to modify.

b. Click Set Price.

c. In the Enter Value dialog box, define a new
price for the material item.

d. Click OK.
Send an allocated
material record to
purchasing

See Send material items to purchasing (page 952).

Add charges

1. Open the Charges tab. 

Create and manage customer orders 950 Manage quotes and orders



2. At the bottom of the dialog box, click New Charge.

3. Select a date for the new charge.

4. Enter the quantity of charges.

5. If necessary, select the material item to which the new charge is applied. 

Note that selecting the material item is optional. You can cancel any
charges for which you have not selected a material item.

6. Select the type of charge and the charge process. 

The available charge processes are defined in Charge Process
Maintenance. For more information, see Create charge processes
(page 931).

7. Enter the amount of money per charge. 

The amount will be multiplied by the quantity of charges.

8. If necessary, click to select the Taxable check box.

9. Click Add Charge. 

The charge is added for the material item and will be visible in the total
sum of the quote or order.

NOTE To modify or delete the existing charges, click to select the charge
and click either Edit Charge or Delete Charge.

Add discounts
If necessary, you can create discounts for an individual quote or order.
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1. Open the Discounts tab. 

2. At the bottom of the dialog box, click New Discount.

3. Select a date for the new discount.

4. Enter the quantity of discounts.

5. Select the charge type to which the discount is applied. 

The options are Material, Labor, and Miscellaneous.

6. Enter the amount of money per discount. 

The amount will be multiplied by the quantity of discounts.

7. If the discounts will be considered before the deduction of taxes, select
the Pre-Tax check box.

8. Click Add Discount. 

The discount is added for the charge type and will be visible in the total
sum of the quote or order.

Send material items to purchasing
Use the Send to PUR command to send material items on customer orders to
the Purchasing module. If you want to create invoices for materials that are
not allocated in the inventory, send the materials to a purchase order. If you
need to request quotes for materials, you should send the materials to a
requisition.

Note that materials that are on a quote cannot be sent to a purchase order.

1. Open the order and click Order Details.

Create and manage customer orders 952 Manage quotes and orders



2. In the Details dialog box, open the Allocation tab.

3. Select the material item that you want to send to purchasing. 

Note that only material items whose type is Not Purchased can be sent
to purchasing.

4. At the bottom right corner of the dialog box, click Send to PUR. 

A dialog box opens, asking if you want to send the material to a
requisition or a purchase order.

5. Select either Requisitions or Purchase Orders.

6. Double-click the purchase order or requisition to which you want to send
the material.

The materials are sent to the selected requisition or purchase order.

You can view and modify the requisition or purchase order in the Purchasing
module. If you have create an invoice for the materials in the Order Entry
module.

See also

Add quote or order details (page 945)

Add an invoice (page 956)

Copy quote or order information
Once you have existing quotes and orders in the Order Entry dialog box, you
can use them as the basis of new quotes and orders. You can then further
modify the quote or order details according to the customer's needs. This can
be useful when a customer makes an order that is similar to a previous one.

1. In the Order Entry dialog box, select the quote or order that you want to
use as the basis of the new quote or order.

2. Click the Order Entry ribbon tab.

3. On the menu, select Copy Quote/Order.

4. To confirm copying information from the selected quote or order, click
Yes in the confirmation dialog box.

5. Adjust the quote or order information and details according to your
needs.

6. At the bottom of the dialog box, click Save Quote Information or Save
Order Information.

See also

Create a quote or an order (page 943)

Add quote or order details (page 945)
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Create a quick quote
Quick quotes allow you to quickly enter line items for a quote or an order. You
can then either save the line items to an existing quote or order, or create a
new quote or order containing the line items.

You can also create quick quotes in the Inventory module by clicking the
Inventory ribbon tab and selecting Order Entry --> Quick Quote .

1. In the Order Entry dialog box, click the Order Entry ribbon tab.

2. On the menu, select Quick Quote.

3. In the Quick Quote dialog box, select the customer and contact.

4. Determine the quantity of items, the shape, dimensions, grade, length,
and the base price. 

Once you have selected the shape, grade, and dimension, you can select
the item from existing inventory items.

5. If the item is taxable, select the Taxable check box.

6. To apply markup to the item you created, select the Markup check box.

7. Do one of the following:

• To save the item to an existing quote or order, click Save to Quote/
Order, and double-click the desired quote or order.

• To create a new quote or order, click Save to New Quote or Save to
New Order, and enter the quote or order information and details.

See also

Add quote or order details (page 945)

Create a quote or an order (page 943)

Modify a quote or an order
You can modify all order and quote properties afterwards. For example, you
may need to change the customer information, the quote or job number, the
tax group and rate used, and the input and display units used.

1. In the Order Entry dialog box, select the order or quote and click Open. 
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2. Modify the customer information, tax groups, notes, and other
information according to your needs.

3. To save the changes, click Save Quote Information or Save Order
Information.

Convert a quote into an order
Converting quotes into orders is necessary in order to send materials to
purchase orders, add invoices for them, and add credit payments.

1. In the Order Entry dialog box, select the quote and click Open.

2. In the lower-right corner of the Quote dialog box, click Convert to Order.

3. To confirm converting the quote into an order, click Yes in the
confirmation dialog box.

The quote is converted into an order, and it will no longer appear in the list of
quotes. Note that the dialog box name changes into Order.

See also

Convert an order back into a quote (page 955)

Modify a quote or an order (page 954)
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Convert an order back into a quote
In Tekla EPM, you cannot delete orders. However, you can convert an order
back into a quote and delete the quote. To convert the order into a quote, do
the following:

1. In the Order Entry dialog box, click to select the order and click Open.

2. In the lower-right corner of the Order dialog box, click Convert to Quote.

3. To confirm converting the order back into a quote, click Yes in the
confirmation dialog box.

The order is converted back into a quote, and it will no longer appear in the list
of orders. Note that the name of the dialog box changes into Quote.

See also

Modify a quote or an order (page 954)

Delete a quote
You can delete rejected and unnecessary quotes from the Order Entry dialog
box.

NOTE Orders cannot be deleted. To delete an order, you first need to
convert the order into a quote. For more information, see Convert an
order back into a quote (page 955).

1. In the Order Entry dialog box, select a quote.

2. At the bottom of the dialog box, click Delete Quote.

3. To permanently delete the selected quote, click Yes in the confirmation
dialog box.

11.5 Add an invoice
After you have created a customer order and allocated the material items on
the order, you can create invoices for the order. Tekla EPM then allows you to
view the created invoice as a report, print it, and send it to the customer.

1. Do one of the following:

• At the bottom of the Order Entry dialog box, click New Invoice, and
double-click the order for which you want to add the invoice.

• In the Details dialog box, go to the Invoices tab, and click New
Invoice.
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2. In the New Invoice dialog box, select the invoice date and invoice
category. 

The available invoice categories are created in the Invoice Categories
dialog box that you can access via Maintenance --> Order Entry -->
Invoice Category Maintenance .

3. On the Material tab, select whether you want to invoice all material or the
material that is in stock. 

TIP If you want to invoice only a certain quantity of materials, type the
quantity in the Invoice Qty field.

4. On the Charges and Discounts tabs, select which charges and discounts
are applied to the current invoice.

5. If necessary, type notes for the invoice. 

The notes will be visible in the invoice.

6. Click Add Invoice. 

If you typed a value in the Deliver Qty field, Tekla EPM asks you to
confirm the delivery and materials.

7. In the confirmation dialog box, click Yes.

8. In the Report Selection dialog box, double-click Invoice to view the
invoice that you just created.

After creating the invoice, you can send it to the customer via Microsoft
Outlook email. To do so, click Email Excel or Email PDF in the upper-right
corner of the Tekla EPM Report Viewer.

You can also export the invoice to an external accounting software, if
necessary. For more information, see Export invoices to accounting software
(page 957).

Export invoices to accounting software
If you have connected an accounting software with Tekla EPM, you can export
any invoices created in the Order Entry module to the accounting software.
By exporting the invoices to your accounting software, you can make sure that
all invoices are found in the same location. Invoices can be exported to either
QuickBooks, Timberline, or Peachtree.

1. On the left side of the Order Entry dialog box, click Invoices. The Order
Entry dialog box only shows the existing invoices.

2. If you only want to export certain invoices, select them in the Order Entry
dialog box.

3. Click the Order Entry ribbon tab.
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4. On the menu, select Export, and select a suitable export option. You can
export either all invoices visible in the Order Entry dialog box or the
invoices that you have selected.

5. If you are exporting the invoices to Timberline or Peachtree, enter the
necessary details. For example, you may need to define the job name or
the date format.

6. Click Export.

The invoices are exported to the selected accounting software.

11.6 Add a payment
Once you receive a payment from a customer, remember to add the payment
for their order in the Order Entry module. When you record the payments to
Tekla EPM, it is easier for all Tekla EPM users to stay up to date on customer
orders.

1. Do one of the following:

• In the Order Entry dialog box, click New PaymentNew Payment, and
double-click the order for which you want to add the payment.

• In the Details dialog box, go to the Payments tab, and click New
Payment.

2. Select the payment date and payment method.

3. Enter the amount paid by the customer. 

You can see the remaining amounts to be invoiced and paid on the right
side of the dialog box.

4. If necessary, add notes for the payment. 

The notes will be visible in the Payment Details report.

5. Click Add Payment.

The Report Selection dialog box opens. If you want to view the payment
information, double-click Payment Details.

See also

Add an invoice (page 956)

11.7 Add a credit
If necessary, you can add an additional credit for the customer regarding a
specific customer order. Order-specific credits can be added regardless of the
customer's credit limit.
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1. Do one of the following:

• In the Order Entry dialog box, click New Credit, and double-click the
order for which you want to add the credit.

• In the Details dialog box, go to the Credits tab, and click New Credit.

2. Select the credit date and credit method.

3. Enter the amount of credit that you want to add for the customer.

4. If necessary, add notes on the credit.

5. Click Add Credit. 

Depending on the credit limit of the customer and the payments that are
due, confirmation dialogs may open.

6. If necessary, confirm that you want to add the current credit.

The credit is added for the customer, and the Report Selection dialog box
opens.

If you want to view the credit information, double-click Payment Details and
review the payment detail report.

11.8 Add a delivery
You can create deliveries for both quotes and orders. In order to create a
delivery, you need to determine the delivery date, quantity to deliver, shipping
method, and receiver.

1. At the bottom of the Order Entry dialog box, click New Delivery.

• In the Order Entry dialog box, click New Delivery, and double-click
the order for which you want to add the delivery.

• In the Details dialog box, go to the Deliveries tab, and click New
Delivery.

2. In the Delivery Date list, select a date.

3. Do one of the following:

• To deliver a certain quantity of material, in Qty to Deliver, type the
quantity.

• To deliver all material in stock, click Deliver All - In Stock.

4. Select a shipping method for the delivery.

5. In the Received By field, type the name of the receiver.

6. If necessary, add delivery notes.

7. At the bottom of the dialog box, click Add Delivery.
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8. To continue, click Yes in the confirmation dialog box. 

The Report dialog box opens, and the delivery information is added to the
selected quote or order.

9. To close the dialog box, click the Close button (X) in the upper-right
corner.

11.9 Add a return
If the customer returns some or all of the delivered materials in a customer
order, we recommend that you add a return. By recording the return in Tekla
EPM, you can ensure that the stock information is up to date and that other
Tekla EPM users are also aware of the return.

1. Do one of the following:

• At the bottom of the Order Entry dialog box, click New Return, and
double-click the order for which you want to add a return.

• In the Details dialog box, go to the Returns tab, and click New
Return.

2. Select the return date.

3. Enter the quantity of material to return and the restock and replace
information.

4. In the Returned By field, type the name of the returner.

5. If necessary, add notes about the return.

6. At the bottom of the dialog box, click Add Return.

7. In the Report Selection dialog box, do one of the following:

• View or print the return report.

• To close the dialog box, click the Close button (X) in the upper-right
corner.

The new return is added for the selected quote or order.

11.10 Create order or quote reports
You can create an order and quote report, view it, and email or print it for the
customer.

NOTE The Report Selection dialog box automatically shows only the reports
for the section of Order Entry dialog box in which you are working. To
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see a list of all reports, click Edit Report Types and move all reports to
the Included list.

1. In the Order Entry dialog box, select a quote or an order.

2. Click the Order Entry ribbon tab.

3. On the menu, select Reports.

4. In the Report Selection dialog box, select a report.

5. According to your needs, do any of the following: 

To Do this
View the report • At the bottom of the dialog box, click View.

The report opens in the Tekla EPM Report
Viewer. You can print, export, and email
reports also in the Tekla EPM Report Viewer
dialog box.

Print the report a. Use the + and - signs to modify the print
quantity.

b. If necessary, modify the printer options on the
right side of the dialog box.

c. At the bottom of the dialog box, click Print.

d. Select the printer that you want to use.

e. Click OK.
Export the report a. At the bottom of the dialog box, click Export.

The Export Options dialog box opens.

b. Select the export file format in the list.

c. To change the pre-defined file location and
name, click Browse, make the changes, and
click Save.

d. To email the exported file to a customer or
other person via Microsoft Outlook, select the
Attach to Email check box.

e. To open the exported file after the export,
select the Open Exported Document check
box.

f. Click Export.

6. To close the dialog box, click the Close button (X) in the upper-right
corner.
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Modify company properties................ 174
Modify contact properties....................174
View firm types......................................171

Adjust
Initial settings........................................ 114

Administration
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Modify.......................................................66
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Manage address book.......................... 169
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Modify workstations............................... 60
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Delete..................................................... 189
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Burn maintenance
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963



C
Change order reports

Export..................................................... 602
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Column splices
Adjust labor times.................................315
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Combine materials................................251
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Edit multiple items................................ 248
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Filter information.................................. 242
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Global Edit..............................................248
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Job maintenance................................... 232
Job maintenance............. 231,232,233,234
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Company information
Define....................................................... 63
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module-wide filters...............................216
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Validate........................................... 709,741
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Display fields
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Store document references for a
production control job......................... 733
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Drawing revisions
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Modify.....................................................548

Drawings
Manage...................................................537

Drawings
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Drawings
Open....................................................... 551
Print........................................................ 553

Drawings
Add..........................................................543
Batch insert............................................545
Create reports....................................... 554
Delete..................................................... 543
Find......................................................... 542
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View issue history..................................554

Drill
Adjust labor times.................................344

Drill maintenance
Adjust labor times.................................344
Export drill rate list................................346
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View drill rate list...................................346

Drill rate list
Export..................................................... 346
Print........................................................ 346
View........................................................ 346

Drill type maintenance
Add drill types........................................345

Drill types
Add..........................................................345

E
Edit mode

Switch off................................................615
Switch on................................................615
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Open....................................................... 377

Estimate extras
Create..................................................... 316

Estimate statuses
Add..........................................................353
Create..................................................... 353
Delete..................................................... 353
Edit.......................................................... 353
Modify.....................................................353
Set default..............................................353

Estimating
Change default shop setup..................363
Delete parametric assembly................294
Manage jobs.......................................... 303
View extrapolation factors................... 320

Estimating
Display units.......................................... 375
Input units..............................................375
Length input type..................................375
Thickness input type.............................375
Units........................................................375

Estimating combining optimizations
Adjust......................................................274
Define..................................................... 274
Modify.....................................................274

Estimating company standards
Adjust......................................................270
Define..................................................... 270
Modify.....................................................270

Estimating ................................................... 437
Add accessories.....................................276
Add accessory........................................409
Add item.................................................401
Add a parametric assembly................. 412
Add burn types......................................342
Add items............................................... 400
Add labor groups.................................. 326
Add shop setups................................... 361
Adjust labor codes................................ 321
Adjust labor standards......................... 332
Adjust labor information......................307
Adjust labor time for welding.............. 350
Adjust labor times for burning............ 341
Adjust labor times for punching..........347
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Adjust labor times for copes, punches,
and stiffeners.........................................316
Adjust standard shop information......354
Apply production code......................... 422
Calculate job.......................................... 387
Calculating labor time...........................308
Copy and multiply items...................... 414
Copy assemblies....................................314
Copy items............................................. 415
Copy a page of estimating items.........415
Copy and multiply items...................... 415
Create estimates................................... 268
Create accessories................................ 276
Create formulas.................................... 286
Create items...........................................400
Create job...............................................370
Create a proposal..................................440
Create and manage parametric
assemblies............................................. 282
Create and modify labor rates............ 360
Create clean systems............................296
Create cleaning systems...................... 296
Create estimate extras......................... 316
Create job categories and sub-categories
.................................................................272
Create job-specific accessory.............. 409
Create job-specific paint systems....... 374
Create labor groups..............................326
Create standard proposal setup......... 365
Create, modify, and delete labor
operations..............................................329
Create, modify, and delete production
codes...................................................... 419
Define and modify job-specific
galvanizing settings...............................375
Define combining optimizations......... 274
Define company standard settings.....270
Define default suppliers.......................275
Define input and display units............ 273
Define markup percentages................ 358
Delete accessories................................ 276
Delete items...........................................400
Delete item.............................................419
Delete assemblies................................. 314
Delete labor groups.............................. 326
Delete standard clips............................339
Document index....................................388
Document references...........................388

Edit items............................................... 417
Edit accessories..................................... 276
Edit labor groups...................................326
Email reports......................................... 385
Example parametric assembly............ 288
Export reports....................................... 385
Export jobs.............................................306
Export job to KISS..................................432
Export parametric assemblies.............293
Filter information.................................. 380
Find items...............................................413
Find job...................................................369
Import.....................................................431
Import files.............................................431
Import and export files.........................430
Labor codes........................................... 308
Labor groups......................................... 308
Labor operations...................................308
Labor rates.............................................308
Labor standards.................................... 308
Link job to a project management job....
376
Link job to Trimble Connect.................435
Load materials.......................................422
Load all estimating items into a
requisition..............................................423
Load all items into a purchase order..424
Load items into purchasing................. 423
Load materials into another estimate426
Load materials into Production control....
428
Load selected items into a purchase
order....................................................... 425
Load selected items into a requisition....
425
Man hour rates......................................308
Manage items........................................ 400
Manage estimate statuses................... 353
Manage standard clips......................... 339
Mhr rates................................................308
Modify items.......................................... 417
Modify job.............................................. 396
Modify accessories................................276
Modify cleaning types...........................294
Modify cleaning costs........................... 294
Modify freight pricing........................... 301
Modify items.......................................... 400
Modify labor groups............................. 326
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Modify multiple items...........................417
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Modify single item.................................417
Modify standard clips........................... 339
Multiply all items in a sub-category.... 416
Multiply selected items.........................416
Open job.................................................377
Open module.........................................368
Print burn rate list.................................343
Print reports.......................................... 385
Recalculate estimate.............................388
Rename assemblies..............................314
Save document references for a job.. 388
Select same items in job and in IFC
model......................................................438
Suppliers................................................ 376
View assemblies.................................... 314
View details............................................ 381
View reports...........................................385
View all changes in the transaction
history.....................................................492
View all changes made to an estimating
job........................................................... 384
View burn rate list................................. 343
View labor times of items.....................381
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accessory reports..................................280
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Multiply...................................................414

Estimating items
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Copy special...........................................415
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Load to requisition................................423
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View labor details..................................381
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Visualize..................................................815

Estimating job
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Estimating job .............................................388
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Edit item................................................. 417
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Estimating
Add materials........................................ 400
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Copy an estimating job.........................305
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298
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Delete shop setups............................... 364
Edit parametric assembly.................... 292
Merge jobs............................................. 306
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View and modify labor times...............382
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Export
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Viewpoint............................................... 917
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Production control job to KISS............ 820
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Shape......................................................117
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Firm types
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FOB shipping destinations
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Gantt chart
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Getting started
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Drawings................................................ 547
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Purchase order items........................... 894
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Selected estimating items....................418
Selected requisition items....................856
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